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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be 
used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

This document is protected under copyright law. An authorized licensee of Avid Media Composer, NewsCutter, or Symphony may 
reproduce this publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or 
distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or educational 
services to others. This document is supplied as a guide for Avid Media Composer, NewsCutter, or Symphony. Reasonable care has been 
taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical 
errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product 
specifications are subject to change without notice.

Copyright © 2021 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY 
NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT 
YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby 
granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and 
related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to 
the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT 
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use 
acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to 
endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED ``AS 
IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided " as is"  without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, 
provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. This software is provided " as is"  without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, 
and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, 
written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided " as 
is"  without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 
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Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice 
is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting 
documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED " AS IS" , WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER 
THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY 
OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other trademarks are 
the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, software applications, 
documentation and any other information relating to Nexidia Inc., and its products and services are the exclusive property of Nexidia Inc. 
or its licensors.  The Nexidia products and services described in these materials may be covered by Nexidia's United States patents: 
7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other patents pending and may be manufactured 
under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of 
“Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable for any damages 
resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of reseller’s products or the 
software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost 
profits, or damages resulting from loss of use or inability to use reseller’s products or the software for any reason including copyright or 
patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such 
damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to 
its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, 
Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow 
“frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to 
copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid 
Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial 
computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the 
U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant 
to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.
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Trademarks
Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, iNEWS, ISIS, Mbox, 
MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and all related 
product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or other countries. 
The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility for Avid products. All 
other trademarks are the property of their respective owners.  For a full list of Avid trademarks, see: http://www.avid.com/US/about-avid/
legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 
countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a 
registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained 
herein are the property of their respective owners. 

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
" The Big Swell"  — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.
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4

http://www.wildlifeworlds.com
http://www.avid.com/US/about-avid/legal-notices/trademarks
http://www.avid.com/US/about-avid/legal-notices/trademarks


Contents

Using This Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Symbols and Conventions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

If You Need Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Avid Training Services  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Chapter 1 Effects Concepts and Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Types of Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15

Real-Time Effects and Non-Real-Time Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Color Coding on Effect Icons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Understanding the Effect Palette  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19

Displaying and Adjusting the Effect Palette  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Working with Effects in HD and in Progressive Frame Projects . . . . . . . . . . . . . . . . . . . . . . .  21

Changing Timeline View Settings for Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23

Adjusting Trim Settings for Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Setting Effect Grid Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Setting Effect Aperture Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Chapter 2 Basics of Effects Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Applying Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Deleting Effects in a Sequence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30

Sizing Effects to Fit the Media  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Adjusting Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31

Updating and Reverting Existing Effects in Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34

Working with Effect Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Promoting Existing Effect Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Playing Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Basics of Effects Rendering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Chapter 3 Applying and Customizing Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

Applying Dissolve Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

Working with the Quick Transition Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50

Adjusting Transitions in the Timeline  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57

Modifying Transition Effects in the Timeline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58

Preserving Effect Transitions in the Timeline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  59

Replacing an Effect in Effect Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

Using the Effect Preview Monitor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  60

Stepping Through Field-Based Media  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68



Using the Effect Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68

Manipulating Effects Directly in the Effect Preview Monitor . . . . . . . . . . . . . . . . . . . . . . . . . .  78

Chapter 4 Working with Keyframes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80

Understanding Keyframes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  80

Track Types for Advanced Keyframes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

Viewing Advanced Keyframe Graphs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  82

Manipulating Advanced Keyframes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87

Controls and Settings for Advanced Keyframes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  114

Working with Standard Keyframes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119

Chapter 5 Playing Effects, Rendering Effects, and Managing Effect Media Files . . . . . .  122

Real-Time Playback of Video Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122

ExpertRender . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127

Creating and Using Render Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  134

Render Settings Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  135

Using Partial Render. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  137

Using 16-Bit Processing Support for Rendered Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  138

Ensuring the Quality Level of Precomputed Clips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  140

Rendering 3D Effects Using the HQ (Highest Quality) Option . . . . . . . . . . . . . . . . . . . . . . .  141

Managing Effect Media Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  142

Chapter 6 Working with Plug-In Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145

Understanding AVX Plug-Ins  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145

Freeing Memory Used by AVX 1.x Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146

Installing AVX Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146

Locating the AVX 1.x Plug-Ins Folder (Windows Only). . . . . . . . . . . . . . . . . . . . . . . . . . . . .  147

Updating and Promoting AVX Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  148

Assigning Multiple Tracks in Plug-in Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149

Using AVX Plug-In Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150

Using the Client Monitor to Preview a Plug-In Effect  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151

Troubleshooting AVX Plug-Ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151

Chapter 7 Creating and Customizing Motion Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153

Understanding Motion Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153

Creating Traditional Motion Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  154

Playing and Rendering Motion Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  160

Understanding Timewarp Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163

Creating Timewarp Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  165

Promoting a Traditional Motion Effect to Timewarp  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  166

Using the Motion Effect Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  167

Scaling a Graph Display in the Motion Effect Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  169

Using the Source Anchor Frame. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170
6



Using Adaptive Deinterlacing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170

Motion Effect Editor Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  171

Rendering Options for Timewarp Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174

Timewarp Speed Graph Reference  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  176

Timewarp Position Graph Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  177

Timewarp Effect Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  179

Understanding FluidMotion Timewarp Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  186

FluidMotion Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  186

Using FluidMotion Edit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  187

Example of Correcting FluidMotion Artifacts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  189

Timewarp Preset Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  192

FluidFilm Preset Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193

Setting Source and Output Options for Format Conversion with Timewarp Effects . . . . . . .  194

Chapter 8 Layered and Nested Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

Key Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

Working with Imported Graphics and Animation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  207

Nesting Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  209

Submaster Editing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  215

Collapsing Layers into a Submaster Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  216

Performing a Video Mixdown . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  218

Chapter 9 Working with Camera Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  220

Using the Reformat Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  220

Working with the Pan and Scan Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  221

Using Avid Pan & Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  230

Chapter 10 Motion Tracking and Stabilization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  240

Understanding Motion Tracking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  241

Workflow for Motion Tracking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  242

Effects and Effect Parameters That Use Tracking Data . . . . . . . . . . . . . . . . . . . . . . . . . . . .  243

Understanding the Tracking Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  244

Opening The Tracking Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  246

Tracking Window Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  246

Setting Up an Effect for Tracking  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  248

Preparing to Generate Tracking Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  249

Generating Tracking Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  257

Offset Tracking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  258

Understanding Tracking Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  260

Customizing the Display of Tracking Data  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  261

Setting the Reference Frame for a Tracker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  262

Understanding the SteadyGlide and Smoothing Options for Tracking . . . . . . . . . . . . . . . . .  263
7



Using SteadyGlide or Smoothing to Process Tracking Data  . . . . . . . . . . . . . . . . . . . . . . . .  264

Selecting, Deleting, and Moving Tracking Data Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  264

Moving Tracker Data Points Outside the Frame Boundary  . . . . . . . . . . . . . . . . . . . . . . . . .  267

Stretching a Range of Tracker Data Points  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  267

Limiting the Effect of Position Tracking Data to a Single Axis  . . . . . . . . . . . . . . . . . . . . . . .  268

Playing Effects That Use Tracking Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  269

Understanding Stabilizing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  270

Stabilizing an Image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  270

Reviewing and Adjusting a Stabilized Image . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  273

Guidelines for Using Multiple Trackers When Stabilizing . . . . . . . . . . . . . . . . . . . . . . . . . . .  274

Using the Region Stabilize Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  274

Making Adjustments to the Region Stabilize Region of Interest . . . . . . . . . . . . . . . . . . . . . .  276

Editing Segments That Use Tracking Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  276

Reusing Existing Tracking Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  277

Copying and Pasting Tracking Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  278

Examples of Effects Using Motion Tracking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  279

Chapter 11 Working with 3D Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  282

Understanding 3D Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  282

Applying the 3D Warp Effect. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  283

Using Xpress 3D Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  283

Promoting 2D Effects to 3D Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  284

Using Matte Keys with 3D Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  284

Real-Time Playback of 3D Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285

Understanding 3D Geometry and Degrees of Rotation  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285

Working with 3D Effects Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  287

Manipulating 3D Effects Directly . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  287

Applying 3D Effects: Examples. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288

Chapter 12 Creating Titles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  296

Opening the Title Tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  297

Using Marquee . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  298

Avid Titler+ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  298

Overview of Title Creation in the Title Tool  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  316

Installing Fonts for Use in the Title Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  317

Understanding the Title Tool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  317

Toolbar Reference for the Title Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  319

Using the Selection and Text Tools  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  320

Understanding the Drawing Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  321

Setting Up the Drawing Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  323

Creating Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  324

Sizing and Positioning Text Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  324
8



Editing a Text String . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  325

Formatting Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  325

Creating Graphic Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  329

Creating Rolling and Crawling Titles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  330

Modifying and Manipulating Title Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  335

Modifying Box Corners, Lines, and Borders on Title Objects . . . . . . . . . . . . . . . . . . . . . . . .  336

Understanding Color and Transparency Controls in the Title Tool . . . . . . . . . . . . . . . . . . . .  338

Selecting Colors and Setting Transparency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  340

Adding Shadows to Title Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  342

Adjusting Shadows on Title Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  343

Manipulating Title Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  344

Saving Titles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  347

Revising a Title in a Bin  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  349

Creating and Using Title Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  350

Saving and Recalling Title Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  351

Exporting a Title as a Graphics File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  354

Chapter 13 Editing with Titles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  355

Displaying Title Clips and Frames in Bins. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  355

Editing a Title into a Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  356

Removing a Title . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  359

Replacing a Title . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  360

Fading a Title  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  360

Setting Marks in a Rolling or Crawling Title  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  360

Trimming the Duration of Rolling and Crawling Titles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  360

Adjusting Title Effect Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  361

Revising a Title in a Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  362

Replacing Fill Tracks in a Title  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  364

Rendering Titles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  364

Re-creating Title Media. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  364

Troubleshooting Titles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  365

Chapter 14 Working with the SubCap Effect. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  368

Understanding the SubCap Effect  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  368

How the SubCap Effect Handles Caption Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  369

Applying the SubCap Effect  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  370

Entering Caption Text Directly in the Effect Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  372

Importing a Caption File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  372

Adding Information to a SubCap Effect. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  373

Editing Text in the Master Caption List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  374

Adjusting SubCap Effect Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  375

Synchronizing SubCap Effect Parameters and Information . . . . . . . . . . . . . . . . . . . . . . . . .  375
9



Exporting SubCap Effect Data to Caption Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  376

Working with Unicode Text in the SubCap Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  377

Working with SubCap Effect Stylesheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  378

Examples of SubCap Effect Parameter Adjustments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  379

Chapter 15 Intraframe Editing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  382

Understanding the Intraframe Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  382

Rendering Intraframe Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  383

Applying the Paint or AniMatte Effect to a Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  384

Effect Editor Reference for the Paint and AniMatte Effects  . . . . . . . . . . . . . . . . . . . . . . . . .  385

Using the Intraframe Drawing Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  387

Working with Vector-Based Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  396

Using the Previsualization Marker Tool for Film Projects . . . . . . . . . . . . . . . . . . . . . . . . . . .  404

Manipulating Intraframe Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  405

Layering, Grouping, and Locking Intraframe Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  408

Exporting a Matte Key Created With the AniMatte Effect . . . . . . . . . . . . . . . . . . . . . . . . . . .  410

Scratch Removal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  411

Intraframe Editing Examples. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  422

Working with the Blur Effect and Mosaic Effect  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  432

Chapter 16 PlasmaWipe Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  436

Understanding PlasmaWipe Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  436

Folder Structure for PlasmaWipe Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  438

Using PlasmaWipe Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  438

Creating Gradient Images for PlasmaWipe Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  439

Understanding PlasmaWipe Frame and Border Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . .  446

Applying and Adjusting PlasmaWipe Frame and Border Effects  . . . . . . . . . . . . . . . . . . . . .  447

Creating Custom PlasmaWipe Border and Frame Effects . . . . . . . . . . . . . . . . . . . . . . . . . .  448

Chapter 17 Effects Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  451

Blend Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  452

Box Wipes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  454

Conceal Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  454

Edge Wipes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  455

Film Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  456

Generator Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  458

Illusion FX Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  459

Image Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  465

Key Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  469

L-Conceal Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  472

Matrix Wipes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  473

Motion Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  474
10



Peel Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  475

PlasmaWipe Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  476

Push Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  476

Reformat Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  477

Sawtooth Wipes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  478

Shape Wipes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  479

Spin Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  481

Squeeze Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  482

Timewarp Effects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  483

Title Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  488

Xpress 3D Effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  489

Comparison of Similar Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  490

Chapter 18 Effects Parameter Reference  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  491

Color Parameter Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  491

Common 2D Effect Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  492

Film Effects Blowup Parameter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  501

Generator Effect Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  501

Illusion FX Effect Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  510

Image Effect Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  530

Key Effect Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  550

Motion Effect Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  565

Reformat Effect Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  568

FluidMotion Edit Parameters for Timewarp Effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  570

Rolling Title and Crawling Title Effect Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  572

3D Effect Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  573

Chapter 19 Understanding Color Correction Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  594

Overview of Color Correction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  594

Reasons for Making Color Corrections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  596

Entering and Exiting Color Correction Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  597

The Color Correction Monitors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  597

The Color Correction Tool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  603

Working with Color Correction Effect Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  618

(Media Composer | Symphony Option) Displaying Color Correction Information in the Timeline  
624

(Media Composer | Symphony Option) Understanding Color Correction Indicator Lines in the 
Timeline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  625

Chapter 20 Performing Color Corrections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  626

General Workflow for Making Color Corrections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  626

Using Automatic Color Corrections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  627

Using the Color Match Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  634
11



The HSL (Hue, Saturation, Luminance) Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  641

The Channels Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  655

(Media Composer | Symphony Option) The Levels Group . . . . . . . . . . . . . . . . . . . . . . . . . .  659

The Curves Group  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  670

(Media Composer | SymphonyOption) The Secondary Group . . . . . . . . . . . . . . . . . . . . . . .  680

Keyframing Color Corrections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  696

Working with the Waveform Monitors and Vectorscope Monitor  . . . . . . . . . . . . . . . . . . . . .  700

Applying Color Corrections to an Entire Sequence. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  706

Using the Color Correction Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  707

Chapter 21 (Media Composer | Symphony Option) Managing Color-Corrected Sequences . . 
715

Updating Color-Corrected Sequences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  715

Merging Color-Corrected Sequences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  716

Color Correction Merging Example. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  719

Flattening Color-Corrected Sequences. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  720

Removing Color Corrections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  721

Chapter 22 Color Correction Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  723

Guiding Principles for Color Correction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  723

Examples of Color Correction Problems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  728

Chapter 23 Safe Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  737

Overview of Safe Color Limits. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  737

Safe Color Settings Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  738

Understanding the Graphical View of Safe Color Settings . . . . . . . . . . . . . . . . . . . . . . . . . .  739

Understanding Safe Color Warnings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  740

Managing Safe Color Warnings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  741

Making Adjustments to Achieve Safe Color Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  742

Safe Color Limits with Waveform and Vectorscope Information. . . . . . . . . . . . . . . . . . . . . .  743

Working with the Safe Color Limiter Effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  745

Chapter 24 (Media Composer | Symphony Option) Spot Color Correction . . . . . . . . . . . .  748

Understanding the Spot Color Correction Effect. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  748

Making Corrections Using the Spot Color Correction Effect . . . . . . . . . . . . . . . . . . . . . . . . .  749

Using Paint Effect Modes for Color Adjustment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  750

Chapter 25 Using Avid Artist Color . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  752

Installing EuControl Software and Configuring the Avid Artist Color  . . . . . . . . . . . . . . . . . .  752

Using Artist Color  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  760

Editing Without Entering Color Correction Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  766

Avid Artist Color Soft Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  767

Customizing Avid Artist Color Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  769

Avid Artist Color Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  771

Controller Application Sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  773
12



Using This Guide

This guide provides conceptual information and step-by-step instructions for the effects and color 
correction features of your Avid® editing application. It also provides reference information for every 
effect and effect parameter available in your application.

Unless noted otherwise, the material in this document applies to the Windows® and macOS® 
operating systems. The majority of screen shots in this document were captured on a Windows 
system, but the information applies to both Windows and macOS systems. Where differences exist, 
both screen shots are shown.

n The documentation describes the features and hardware of all models. Therefore, your system might 
not contain certain features and hardware that are covered in the documentation.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n
A note provides important related information, reminders, recommendations, and 
strong suggestions.

c
A caution means that a specific action you take could cause harm to your 
computer or cause you to lose data.

w
A warning describes an action that could cause you physical harm. Follow the 
guidelines in this document or on the unit itself when handling electrical 
equipment.

n
A user tip provides a helpful hint that can aid users in getting the most from their 
system.

n
A shortcut shows the user keyboard or mouse shortcuts for a procedure or 
command.

> This symbol indicates menu commands (and subcommands) in the order you 
select them. For example, File > Import means to open the File menu and then 
select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list indicate 
that you perform one of the actions listed.

(Windows), (Windows 
only), (macOS), or (macOS 
only)

This text indicates that the information applies only to the specified operating 
system, either Windows or macOS.

Bold font Bold font is primarily used in task instructions to identify user interface items and 
keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.



If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published:

You should always check online for the most up-to-date release notes or ReadMe because 
the online version is updated whenever new information becomes available. To view these 
online versions, select ReadMe from the Help menu, or visit the Knowledge Base at 
www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are available 
24 hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join online 
message-board discussions.

Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and convenient. 
Avid understands that the knowledge you need to differentiate yourself is always changing, and Avid 
continually updates course content and offers new training delivery methods that accommodate your 
pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, please 
visit www.avid.com/support and follow the Training links, or call Avid Sales at 800-949-AVID 
(800-949-2843).

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the mouse 
action. For example, Command+Option+C or Ctrl+drag.

 | (pipe character) The pipe character is used in some Avid product names, such as MediaCentral | 
Production Management. In this document, the pipe is used in product names 
when they are in headings or at their first use in text.

Symbol or Convention Meaning or Action
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1 Effects Concepts and Settings

This chapter describes concepts you should understand before you begin creating effects and 
common settings adjustments that affect how you work with effects:

• Types of Effects

• Real-Time Effects and Non-Real-Time Effects

• Color Coding on Effect Icons

• Understanding the Effect Palette

• Displaying and Adjusting the Effect Palette

• Working with Effects in HD and in Progressive Frame Projects

• Changing Timeline View Settings for Effects

• Adjusting Trim Settings for Effects

• Setting Effect Grid Options

• Setting Effect Aperture Options

Types of Effects
You can divide the effects in Media Composer into a number of groupings, which are described in the 
remainder of this topic.

There is considerable overlap within these groupings. For example, Timewarp effects are one of the 
main types of motion effects in Media Composer, but they are also examples of segment effects. The 
following descriptions give you a basic understanding of the range of effects available, and an 
introduction to some of the terminology Avid uses in its effects documentation.

Transition Effects

You apply transition effects at the cut point between two video clips that are on the same track (the 
same video layer) in a sequence. Examples of transition effects are dissolves, fades, and wipes.

Segment Effects

You apply segment effects to an entire clip or group of clips in a sequence. For example, you might 
apply a Color Effect to several segments in a sequence to tint those segments, suggesting that the 
action they contain is taking place in the past. 

Segment effects fall into two subgroups:

• Single-layer

You apply a single-layer segment effect to a segment on one video track. A single-layer segment 
effect only needs one stream of video to create its effect. For example, the Mask effect lets you 
mask out some parts of the video in a segment, replacing it with a solid color.

• Multilayer



Types of Effects
You apply a multilayer segment effect to the top layer or a middle layer of segments that contain 
two or more video tracks that will play simultaneously. A multilayer segment effect requires 
more than one video stream to create its effect. For example, a Picture-in-Picture effect displays 
video from an upper video track inside video from a lower track.

Motion Effects

Motion effects manipulate the motion characteristics in a clip, for example, by freezing action or by 
varying the speed at which a clip plays. You create motion effects either by generating new clips with 
fixed motion characteristics, or by using the Timewarp effects to change the motion characteristics of 
clips already in a sequence. For information on motion effects, see “Creating and Customizing 
Motion Effects” on page 153.

Title Effects

Title effects contain text and graphic objects that you create with one of the title tools in Media 
Composer. You save title effects into bins as a special clip type, and edit them onto their own layers 
in a sequence, usually above all other video layers. For information on title effects, see “Creating 
Titles” on page 296.

2D Effects and 3D Effects

Effects in Media Composer are either 2D or 3D. 2D effects appear to be acting in the two dimensions 
of the screen the viewer is watching and do not give an impression of depth. 3D effects give an 
impression of depth, for example, by wrapping a video image around a sphere. Some Avid effects are 
2D only or 3D only, while others have both 2D and 3D versions, or can be promoted from 2D to 3D. 
For specific information on working with 3D effects, see “Working with 3D Effects” on page 282.

Nested Effects

You apply nested effects inside other effects on the same video layer. Effect nesting allows you great 
flexibility to apply multiple effects to the same segment in a sequence. For example, you might want 
to apply a color effect within an existing Picture-in-Picture effect. To do this, you can nest the color 
effect inside the Picture-in-Picture. For more information, see “Layered and Nested Effects” on 
page 196.

Key Effects

Key effects use specific rules to define how parts of one image show through another image. The 
best-known example of a key effect is a chroma key, for example, where an actor shot in front of a 
blue or green screen appears to be standing in front of another background. The key effect replaces 
the blue or green color in the foreground shot with parts of the background shot. For more 
information, see “Layered and Nested Effects” on page 196.

Camera Effects

Camera effects control aspect ratio, format, or the apparent motion of the camera. For example, 
Media Composer can reformat video media to different aspect ratios, allowing you to select the area 
of video that is preserved in the new aspect ratio. For more information, see “Working with Camera 
Effects” on page 220.
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Real-Time Effects and Non-Real-Time Effects
Motion Tracking and Stabilization Effects

Motion tracking lets you track the motion of an area in an image and then use the tracking data to 
control the motion of another effect. You can also use tracking to stabilize an image to compensate 
for camera motion. For more information, see “Motion Tracking and Stabilization” on page 240.

Intraframe Effects

Intraframe effects let you perform paint or animated matte effect operations within one or more 
individual frames in a clip. For example, you can identify part of an image with drawing tools and 
apply a blur to only that part of the image. You can also use this technique to repair scratches and 
other flaws on individual frames. For more information, see “Intraframe Editing” on page 382.

PlasmaWipe Effects

PlasmaWipe effects use gradient image bitmaps to create highly-customizable wipes and segment 
effects. You can use one of the many preset effects or create your own using new gradient images. 
For more information, see “PlasmaWipe Effects” on page 436.

AVX Plug-In Effects

Media Composer supports the Avid Visual Extensions (AVX™) standard. AVX is a cross-platform 
technology that allows software effect modules (plug-ins) to be dynamically linked to Media 
Composer. Some effects that Avid supplies with Media Composer use the AVX technology, while 
others do not. In general, you work in exactly the same way with both types.

Third-party developers use AVX to create effect plug-ins that you can purchase, install, and use to 
extend the effects functionality of Media Composer. Third-party AVX plug-in effects might have 
controls that look very similar to standard Avid effect controls, or they might have custom user 
interfaces.

For more information on working with third-party plug-ins, see “Working with Plug-In Effects” on 
page 145.

Real-Time Effects and Non-Real-Time Effects
Effects in Media Composer can be either real-time or non-real-time. A real-time effect is one that 
you can apply to a sequence and play without having to render it first. Rendering is a processing 
operation that Media Composer performs to merge effect layers, creating one stream of digital video 
for playback in real time. (Rendering takes time and creates a new media file that occupies drive 
space.) You must render non-real-time effects before you can play them back. You can preview non-
real-time effects, or play them as an outline, without rendering them.

A real-time effect has a small green dot in the Effect Palette and within the effect icon in the 
Timeline. Effects that you must render have a small blue dot within the effect icon in the Timeline. 
For more information, see “Color Coding on Effect Icons” on page 18.

You can create a sequence that has any number of real-time and non-real-time effects. However, there 
are limits on how many real-time effects Media Composer can play at once without rendering or 
otherwise reducing the amount of processing necessary during playback. For more information, see 
“Real-Time Playback of Video Effects” on page 122.
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Color Coding on Effect Icons
When you want to play a sequence that includes effects at full quality, you might have to render some 
of the effects. You will have to render any effect that is non-real-time, and you might need to render 
some of the effects that are normally real-time.

The exact number of effects that you must render for output depends on the following factors:

• Whether or not you have Avid input/output hardware attached to your system. If you do not have 
Avid input/output hardware attached, you must render all effects before you perform a digital 
cut.

• How complex your sequence is, and especially how your effects are layered on multiple video 
tracks. If you have Avid input/output hardware attached to your system, real-time effects might 
cause dropped frames during a digital cut. You can have Media Composer select and render real-
time effects that might cause dropped frames. For more information, see “Recording a Digital 
Cut to Tape (Remote Mode)” and “Recording a Digital Cut to Tape (Local Mode)” in the Help.

If you attempt to play or output a sequence that Media Composer cannot play in real-time, you can 
display information in the Timeline that shows where the demands of the sequence are preventing 
successful real-time play. For more information, see “Understanding Real-Time Playback 
Information in the Timeline” on page 123. You have several options for how to proceed in these 
circumstances:

• For playing alone, you can use the Video Quality menu or Video Display settings to ease the 
playback demands by reducing the display quality of the video. For more information, see 
“Options for Controlling Real-Time Effects Playback” on page 124.

• For output, where anything less than the best quality is not an option, you can use the 
ExpertRender feature to identify the minimum number of effects that you must render in order 
for the sequence to play in real time. For more information, see “ExpertRender” on page 127.

Color Coding on Effect Icons
Effect icons in the Effect Palette and in the Timeline display colored dots to help you determine 
whether an effect is real-time or non-real-time.

Real-time effects show a green dot. Real-time effects play in real time in a sequence, subject to the 
playback capabilities and constraints of your Media Composer. For more information, see “Real-
Time Playback of Video Effects” on page 122.

n Relationship color corrections (Symphony Option) are also real-time effects that display in the 
Timeline with a green dot. For more information, see “(Media Composer | Symphony Option) 
Displaying Color Correction Information in the Timeline” on page 624.

Non-real-time effects have no dot in the Effect Palette. In the Timeline, the effect icon shows a blue 
dot until you render the effect.
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Understanding the Effect Palette
In the Effect Palette (left), green dots indicate real-time effects. (Real-time effects might not be playable in real time 
depending on system resources and the complexity of your sequence.) Non-real-time effects have no dot in the Effect 
Palette. Non-real-time effects have a blue dot in the Timeline until they are rendered.

All colored dots disappear in the Timeline when you render effects.

Understanding the Effect Palette
The Effect Palette lists all transition and segment effects, and some motion effects, that are available 
for Media Composer. The Effect Palette is the primary tool that you use to apply effects to your 
sequences. For information on accessing the Effect Palette, see “Displaying and Adjusting the Effect 
Palette” on page 20.

The Effects Palette allows you to find and filter effects quickly and easily. Effects are divided into 
two categories for video (Filters and Transitions); and two categories for audio (Clip Effects and 
Track Effects).

There is also a Quick Find allowing you search for a specific effect. By default, the search is done on 
all categories, but you can refine this search by selecting the appropriate category.The left side of the 
Effect Palette displays a list of effect categories. The right side shows the various effects that are 
available for the currently selected effect category.
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Displaying and Adjusting the Effect Palette
The Effect Palette displays all of the effect categories available for Media Composer, including any 
third-party AVX plug-in effects you have installed. If you save any effect templates to a bin, and have 
that bin open, those templates also display in the Effect Palette. For reference information on all Avid 
effects, see “Effects Reference” on page 451.

Displaying and Adjusting the Effect Palette
This topic provides basic information on displaying and adjusting the Effect Palette. For information 
on the organization and purpose of the Effect Palette, see “Understanding the Effect Palette” on 
page 19.

To display the Effect Palette:

t Select Tools > Effect Palette (Ctrl + 8).

To resize the Effect Palette:

t Click the lower right corner of the palette, drag the palette to the size you want, and release the 
mouse button.

To display effect templates saved to a bin in the Effect Palette:

1. Open the bin containing the effect templates.

2. If the Effect Palette is not already open, select Tools > Effect Palette.

3. Click the bin name below the effect category list to view the effect templates in the bin.

In the following illustration, the bin named “Effect Templates” is selected below the effect 
category list and the templates in that bin appear on the right.
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Working with Effects in HD and in Progressive Frame Projects
To change the font

t Right click in the window, select Set font and change to the desired font and size. If the Effect 
Palette is the active window you can select Set Font on the Windows menu

Working with Effects in HD and in Progressive Frame 
Projects

Many video effects work the same way regardless of the project type or video format. This topic 
describes several situations where effect behavior varies depending on whether a project is SD or 
HD, or is interlaced or progressive.
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Working with Effects in HD and in Progressive Frame Projects
Effects Considerations for HD Projects

Effects that use square geometry automatically use the correct pixel aspect ratios. These effects 
include Titles, Box Wipes, and certain paint modes like Mosaic. Effects such as Color Correction, 
Color Effect, and Luma keys automatically use the correct color space (ITU-709 for HD).

n The Safe Color Limiter effect converts from 709 to 601 color space before limiting unsafe colors, and 
then converts back to 709 color space. For more information, see “Understanding the Safe Color 
Limiter Effect” on page 745.

Note the following:

• You do not need to generate 4:3 media for titles.

• Timewarp effects use a 60p input and output format in 720p/59.94 projects.

Effects Considerations for Progressive Frame Projects

Effects in progressive frame projects are frame based rather than field based, so their normal behavior 
is slightly different from effects in interlaced projects. In particular, temporal artifacts might appear 
in some effects under certain circumstances. This topic explains when temporal artifacts might 
appear and suggests ways to create effects that do not show perceptible temporal artifacts.

Effects that do not involve any movement across the screen — for example, masks, Color Effects, 
and dissolves — always look the same in progressive projects as they do in interlaced projects.

Effects that involve movement across the screen — for example, wipes, 3D shapes, or moving titles 
— might look different in 24p or 25p projects from their equivalents in interlaced projects for the 
following reasons:

• Because the effect uses 24 or 25 progressive frames per second (24p or 25p), motion across the 
screen is interpolated in 24 or 25 increments per second. (Contrast the 50 increments per second 
for a PAL interlaced project or the 60 increments per second for an NTSC interlaced project.) For 
example, the edge of a 1-second Horizontal Edge Wipe effect appears in 24 or 25 different 
positions across the screen. For effects of short duration in particular, this difference might be 
perceptible to the viewer.

• When the 24p or 25p media is output (to the interlaced Client monitor or as a digital cut), it is 
interlaced again and pulldown is inserted to achieve 60 fields per second (NTSC). Media 
Composer inserts pulldown by duplicating some of the existing frames to create the correct 
number of fields per second. Viewers might notice temporal artifacts created by this duplication 
process. This behavior is a normal result of the pulldown insertion process and is often 
perceptible in conventional transfers of films to video formats.

n PAL output with pulldown also duplicates certain frames but is less likely to exhibit perceptible 
temporal artifacts since fewer frames require duplication.

Motion effects that you create in 24p or 25p projects, such as Variable Speed effects, might also look 
different from motion effects that you create in interlaced projects. For more information on 24p or 
25p motion effects, see “Considerations for Motion Effects in Progressive Projects” on page 163.

n For more information on how Media Composer handles 24p or 25p material, see “Displaying 24p 
and 25p Media” in the Help.
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Changing Timeline View Settings for Effects
If an effect in a 24p or 25p project does not look completely smooth, do one or more of the following:

• Slow down the effect.

For example, a 2-second Horizontal Edge Wipe effect, while it is still performing at the same rate 
(24 increments per second), moves across the screen in 48 steps. These smaller movements make 
the wipe appear smoother to the viewer.

• Soften the edges of the effect.

The more the edges of the effect are blurred, the less noticeable are the movements between the 
increments of the effect.

• When working with moving titles, avoid small font sizes and sharp edges.

In a moving title such as a roll, lines of small text might move less smoothly than lines of larger 
text.

Changing Timeline View Settings for Effects
All effect icons display in the Timeline by default. You can change the Timeline settings to display 
all effect icons, all effect icons except Dissolve Effect icons, or no effect icons. If you change the 
setting to display no effect icons, you must reset it before you begin applying effects. The fewer 
effect icons you display, the faster Media Composer refreshes the screen.

To change the Timeline settings:

1. In the Timeline window, click the Fast Menu button, and then do one of the following:

t To display all effect icons in the Timeline, select Effect Icons.

t To display all effect icons except Dissolve icons, select Effect Icons and deselect Dissolve 
Icons.

t To display no effect icons, deselect Effect Icons. Dissolve Icons appears dimmed and is now 
unavailable.sd

2. (Option) To save your Timeline settings, click the Timeline View Menu button, select Save As.

Timeline View Menu button and menu below Timeline

The View Name dialog box opens.

3. Type a View name, and click OK.
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Adjusting Trim Settings for Effects
Adjusting Trim Settings for Effects
In Trim mode, you can control whether or not the effects you apply are computed immediately on the 
screen (that is, on-the-fly) or appear later when you render them. For example, viewing transitions as 
cuts (without rendering on-the-fly) can make trimming easier.

n For more information on changing Trim settings, see “Trim Settings Basics” in the Help.

To change the Trim settings for Render On-the-Fly:

1. Select File > Settings and click the User tab.

2. Double-click Trim.

The Trim Settings dialog box opens.

3. Click the Features tab, and then select or deselect Render On-The-Fly.

4. Click OK.

Setting Effect Grid Options
You can display a grid in the Effect Preview monitor in Effect mode to guide you as you create and 
adjust effects. For information on using the grid, see “Understanding the Effect Grid” on page 64.

The Grid Settings dialog box lets you customize the grid.

To set the default grid values, do one of the following:

t Select File > Settings, click the User tab and double-click Grid.

t If the effect you are working with has a Grid parameter group, right click the Other Options 
button and select Grid Settings.

The Grid Settings dialog box opens.

 For information on the Grid Settings options, see “Grid Settings” in the Help.

Setting Effect Aperture Options
In Media Composer, the Effect Aperture setting lets you control the number of horizontal lines of an 
image that are used to create an effect. For example, if you are working with DV media and notice 
black lines above and below Picture-in-Picture effects, you can instruct the system to ignore the lines 
by changing the effect aperture.

n The Effect Aperture feature applies only to NTSC projects.

For uncompressed and non-DV resolutions, Media Composer uses all 243 horizontal lines per field to 
display the image. For DV media, Media Composer uses 240 lines for the image and adds two black 
lines above the image and one black line below the image. The effect aperture lets you decide 
whether or not to use the three black lines when you create effects.

In a DV project the black lines can become visible when you create effects such as Picture-in-Picture 
or Squeeze effects.
24



Setting Effect Aperture Options
The following illustrations show four PIP effects. In the first illustration, which uses the default ITU 
601 aperture, you can clearly see the black lines between the effects. The second illustration displays 
the same media with the DV25 effect aperture — the black lines do not appear between the effects.

In a project that uses only DV media, it is useful to switch to the DV 25 aperture setting. In a project 
using uncompressed or mixed resolution media, use the ITU 601 aperture.

To change the effect aperture:

1. Select File > Settings and click the Project tab.

2. Double-click General.

The General Settings dialog box opens.
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Setting Effect Aperture Options
3. Select one of the following Effect Aperture options:

4. Click OK.

Option Description

ITU 601 (720x 486) Select this setting when you are using uncompressed media or 
mixed resolutions. This is the default setting.

DV25 (720 x 480) Select this setting when you are using DV media exclusively.
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2 Basics of Effects Editing

This chapter provides basic procedures for creating, adjusting, playing, and rendering effects:

• Applying Effects

• Deleting Effects in a Sequence

• Sizing Effects to Fit the Media

• Adjusting Effects

• Updating and Reverting Existing Effects in Sequences

• Working with Effect Templates

• Promoting Existing Effect Templates

• Playing Effects

• Basics of Effects Rendering

Applying Effects

You apply most effects to video material after you edit it into a sequence. This section describes basic 
methods for applying effects using the Effect Palette and the Fade Effect button.

You can also apply and adjust basic transition effects using the Quick Transition button and the 
Quick Transition dialog box. For more information, see “Working with the Quick Transition Dialog 
Box” on page 50

You can also create titles and some types of motion effects as new clips that you then edit into a 
sequence. For more information, see “Creating Titles” on page 296 and “Creating and Customizing 
Motion Effects” on page 153.

n You cannot apply effects to clips on a data (D1) track.

Applying Effects From the Effect Palette

You can apply effects either to transitions or to segments. Most effects are only suitable for one of 
these applications. For example, you cannot apply every effect in the Effect Palette to a transition. 
For more information on the use of an individual effect, see the reference information for the effect in 
“Effects Reference” on page 451.

To apply an effect to a single transition or to a single segment in the Timeline, do one of the 
following:

t Click the effect’s icon in the Effect Palette, drag the icon over the transition or segment in the 
Timeline, and release the mouse button.

t In Effect Mode, click the transition, and then double-click the effect’s icon in the Effect Palette.

t Select the segment in the Timeline, and then double-click the effect’s icon in the Effect Palette.



Applying Effects
For more information on selecting segments, see “Selecting and Deselecting Segments” in the 
Help.

If there is not enough incoming or outgoing media to apply a transition effect at its default 
length, the Insufficient Source dialog box opens. For more information, see “Sizing Effects to Fit 
the Media” on page 31.

To apply an effect to multiple transitions in the Timeline:

1. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

2. Click the first or last transition to which you want to apply the effect.

3. Click above the Timeline and begin dragging to activate a selection box. Continue to drag down 
and either to the left or right to include additional transitions in the selection.

4. Release the mouse button when the selection box includes all the transitions you want.

Media Composer highlights the transitions that you select, and the position indicator moves to 
the first transition.

5. (Option) Shift+click any transition to deselect it.

6. In the Effect Palette, double-click the icon for the effect that you want to apply to the transitions.

Media Composer applies the effect to the selected transitions in the Timeline.

If there is not enough incoming or outgoing media to apply the transition effect at its default 
length to one or more of the transitions, the Insufficient Source dialog box opens. For more 
information, see “Sizing Effects to Fit the Media” on page 31.

To apply an effect to multiple segments in the Timeline:

1. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.
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Applying Effects
2. Click above the Timeline and to the left of the leftmost segment that you want to select and begin 
dragging to the right and down to activate a selection box.

3. Continue to drag to the right until the selection box includes the rightmost segment that you want 
to select.

4. Release the mouse button.

Media Composer highlights the segments that you select.

5. (Option) Shift+click a segment to deselect it.

6. In the Effect Palette, double-click the icon for the effect that you want to apply to the segments.

Media Composer applies the effect to the selected segments in the Timeline.

Using the Fade Effect Button

You can use the Fade Effect button to create basic fades for segment effects.

The Fade Effect feature creates keyframes for the effect automatically. You can access the keyframes 
in the Effect Editor.

n The Fade Effect button appears in the FX tab of the Command palette. You can map the Fade Effect 
button to another location.  For more information, see “Mapping User-Selectable Buttons” in the 
Help.

To fade one or more segment effects in a sequence:

1. Select the segment effects in the Timeline:

t To fade a single segment effect, move the position indicator to the segment.

t To fade multiple segment effects, click the Segment mode button on the Timeline Palette, 
right-click to select the appropriate segment mode (Lift/Overwrite or Extract/Splice-in), and 
then Shift+click the segments.
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Deleting Effects in a Sequence
Segment mode button in the Timeline toolbar

2. Click the Fade Effect button.

The Fade Effect dialog box opens.

3. Type the number of frames to fade up and fade down, and click OK.

You can view the Fade effect by playing the segment or segments.

Deleting Effects in a Sequence
You can delete transition effects from a sequence in Source/Record mode, Trim mode, or Effect 
mode.

To delete a single effect:

1. Move the position indicator to the Timeline segment containing the effect’s icon.

2. If there are multiple tracks that contain effects at the same position in the Timeline, select only 
the track that contains the effect you want to delete.

In this example, only track V3 is selected.

3. Do one of the following:

t In Source/Record mode, click the Remove Effect button.

t In Effect mode, select the effect and press Delete.

t When trimming (for transition effects only), either press Delete or click the Remove Effect 
button.

Media Composer removes the effect.

n When you delete a rendered effect from a sequence, your do not delete the associated media file 
(precompute). To delete the effect’s media file, you must manually remove it from the drive. Media 
Composer operates this way so that you can undo the deletion of an effect or undo the change you 
made to an effect. For more information, see “Managing Effect Media Files” on page 142.

To delete multiple transition effects:

t In Effect mode, Shift+click each transition effect you want to delete, and then press Delete.
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Sizing Effects to Fit the Media
To delete multiple segment effects:

1. If you are not in Effect mode, click the Segment mode buttons in the Timeline toolbar.

Segment tools in the Timeline palette

2. Shift+click each segment that contains a segment effect you want to  delete.

3. Do one of the following:

t Click the Remove Effect button.

t Press Delete.

Sizing Effects to Fit the Media
Transition effects usually require additional frames of source media beyond those you edit into the 
sequence. For example, if a dissolve begins 15 frames before the cut point between clips, Media 
Composer needs 15 frames of video from before the cut point on the incoming clip to create the 
beginning of the dissolve.

When you edit and apply effects, be aware that you might need these extra frames. Editors usually 
allow for these extra frames by marking IN and OUT points on source clips far enough away from 
the beginning and end of the clip that extra frames are available for transition effects. These extra 
frames are commonly known as “handles.”

When you apply a transition effect from the Effect Palette and there are not enough extra source 
frames available for the effect to use, the Insufficient Source dialog box opens and indicates whether 
the source that has insufficient material is Media A (outgoing) or Media B (incoming).

You can choose to cancel the effect or have Media Composer resize the effect to fit the available 
media. The result might be a shorter transition effect, or an effect with a changed alignment. For 
example, if no extra frames are available before the cut to an incoming clip, a transition effect cannot 
start before the cut point, so its alignment must be “Starting at Cut.”

To automatically size an effect to fit the media:

t Click Size To Fit in the Insufficient Source dialog box.

Media Composer sets the duration of the effect to fit the available media. If you have selected an 
alignment, Media Composer attempts to preserve it.

To change the alignment or duration of the transition effect, see “Applying a Dissolve Effect 
Using the Transition Parameters” on page 48.

Adjusting Effects

After you apply an effect to a transition or segment in your sequence, you can adjust its appearance 
and operation. To make most effect adjustments, you enter Effect mode and work with the Effect 
Editor and the Effect Preview monitor.

This section explains how to enter Effect mode and provides basic information on how to use the 
Effect Editor and the Effect Preview monitor.
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Adjusting Effects
For more advanced information, see “Applying and Customizing Effects” on page 48.

Entering Effect Mode

After you add an effect to a sequence, you must enter Effect mode to change the parameters of the 
effect.

To enter Effect mode, do the following:

t Click the Effect Mode button.

Media Composer opens the Effect Editor and the Record monitor becomes the Effect Preview 
monitor. If the position indicator in the Timeline is on an effect, the controls for adjusting that 
effect display in the Effect Editor.

Understanding Effect Mode

The following illustration shows the main components of Effect mode, the Effect Editor (left) and the 
Effect Preview monitor (right).

Each property of an effect that you can control is known as an effect parameter. For example, a 
Picture-in-Picture effect has a Position parameter that controls where the picture-in-picture is located 
on the screen. The Effect Editor displays controls that let you adjust each of an effect’s parameters, as 
well as other buttons that help you adjust effects. As different effects have different sets of 
parameters, the Effect Editor display changes depending on the effect you select.

For more detailed information on the Effect Editor, see “Using the Effect Editor” on page 68.

The Effect Preview monitor displays the selected effect in the sequence where the position indicator 
is located in the Timeline. The position bar below the Effect Preview monitor represents the length of 
the selected effect, not of the entire sequence.
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Adjusting Effects
For some effects, the Effect Preview monitor displays tools that let you adjust the effect directly in 
the monitor. For example, a Picture-in-Picture effect normally displays with a wireframe outline and 
adjustment handles that you can use to reposition or resize the picture-in-picture. A direct adjustment 
like this is equivalent to adjusting the effect with parameter controls in the Effect Editor, but it is 
often easier and more intuitive to make the adjustment directly in the monitor.

For more detailed information on the Effect Preview monitor, see “Using the Effect Preview 
Monitor” on page 60.

Making Basic Effect Adjustments

This topic describes a general procedure for selecting and adjusting effects, including some simple 
examples of types of adjustments.

You can find more detailed information elsewhere in this guide. For example, for full details of how 
to use effect adjustment controls, see “Applying and Customizing Effects” on page 48. For details of 
the parameters available for a specific effect, see the reference information for that effect in “Effects 
Reference” on page 451.

To make basic effects adjustments:

1. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

2. In the Timeline, click the effect you want to adjust.

3. In the Effect Editor or the Effect Preview monitor, adjust the effect’s parameters until you 
achieve the look you want.

For example, depending on the effect, you might want to do one or more of the following:

t Adjust a parameter by dragging its slider control in the Effect Editor.

t Reposition an effect such as a Picture-in-Picture by dragging the effect in the 
Effect Preview monitor.

t Resize an effect such as a Picture-in-Picture by dragging one of the adjustment handles that 
display around the edge of the picture-in-picture in the Effect Preview monitor.

t Select an option for a parameter by clicking its Fast menu in the Effect Editor and selecting 
an item from the menu.

t Select a color for a parameter that uses color by clicking the parameter’s Color Preview 
window, dragging the eyedropper to the Effect Preview monitor, and releasing the mouse 
button over the color you want to use.

t Select a color for a parameter that uses color by clicking the Other Options button for the 
parameter and selecting the color from the Windows Color dialog box or the Macintosh 
Colors panel.

t Select an alignment option for a transition effect by clicking the Transition Effect Alignment 
button in the Effect Editor and selecting an option from the menu.

t Define a custom duration for a transition effect by clicking in the Transition Effect Duration 
box in the Effect Editor, typing a duration, and pressing Enter.
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Updating and Reverting Existing Effects in Sequences
Moving Through an Effect

The position bar in the Effect Preview monitor represents only the length of the currently selected 
effect. You can use the Effect Preview monitor’s position bar to move through an effect in the same 
way that you use the position bars in Source/Record mode to move through a clip or a sequence.

To move to a different point in an effect, do one of the following:

t Click a location in the position bar to move the position indicator to that location.

t Drag the position indicator to a location in the position bar.

Updating and Reverting Existing Effects in Sequences
If you are working with a sequence that already contains effects, you might need to update some of 
those effects.

If you apply color corrections to a sequence in the current version of Media Composer, you might 
need to save a duplicate version of the sequence with a reverted color corrections format that you can 
open in older versions of Avid editing applications.

The following table summarizes the types of effects that you can update or revert to their original 
format:

Effect Type Description

Standard 
keyframe effects

In the current version of Media Composer, many effects use advanced 
keyframes only. You can no longer apply or use standard keyframe versions of 
those effects.

If an existing sequence contains standard keyframe versions of any effects that 
now use advanced keyframes, you must update those effects to their advanced 
keyframe versions.

n This also applies to Title Effect clips in a sequence that still use 
standard keyframes. When you update these, you change the clip in the 
bin as well as the Title Effect segment in the sequence itself.

You can update the standard keyframe effects in a sequence by loading the 
sequence or by using the Update Effects command.

Color Correction You must update color corrections in sequences created in older versions of 
Avid editing applications that did not support keyframeable color correction 
before you can work with them in the current version. Color corrections in 
recent versions store parameter information differently to support keyframing.

If you apply color corrections to a sequence in the current version of Media 
Composer and want to open that sequence in a version of an Avid editing 
application that does not support keyframeable color correction, you must 
revert the color corrections to the earlier format. This creates a duplicate 
sequence that stores color correction parameter information in an appropriate 
format for use in the older version.

You can update color corrections in a sequence by loading the sequence or by 
using the Update Effects command.
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Updating and Reverting Existing Effects in Sequences
To update standard keyframe effects or color corrections by loading a sequence:

1. Load the sequence, for example, by dragging it to a monitor.

The Update Sequence dialog box opens.

If the sequence contains standard keyframe versions of effects that are now available in advanced 
keyframe versions, a message informs you that you must update the effects.

If the sequence contains incompatible color corrections from an older version of you Avid 
editing application (e.g., Media Composer), a message informs you that you must update the 
color corrections.

2. (Option) If you want Media Composer to update sequences that you open in the future without 
displaying the Update Sequence dialog box, select “Do not ask again when loading a sequence.”

3. Click OK.

Media Composer creates a copy of the sequence, updates the effects and color corrections in the 
copy that require updating, and opens the copy.

The name of the new sequence uses a suffix indicating that it is an updated sequence. If the 
original sequence is named MySequence, the updated copy is named, for example, 
MySequence.updated.01. Both the original sequence and the updated copy are available in the 
bin.

To update effects and color corrections in a sequence using the Update Effects command:

1. Select the sequence in a bin.

2. Right-click the sequence, and select Update Effects.

The Update Sequence dialog box opens.

Messages inform you if the sequence contains standard keyframe effects or color corrections that 
require updating.

If the sequence contains motion effects or AVX effects that you can choose to update, check 
boxes appear for those effect types.

3. (Option) Select the optional effect types that you want to update.

4. Click OK to update the effects, or Cancel to take no action.

If you click OK, Media Composer creates a copy of the sequence and updates the effects and 
color corrections in the copy that require updating or that you chose to update.

The name of the new sequence uses a suffix indicating that it is an updated sequence. If the 
original sequence is named MySequence, the updated copy is named, for example, 
MySequence.updated.01. Both the original sequence and the updated copy are available in the 
bin.

Traditional 
motion effects

You can update traditional motion effects in a sequence to Timewarp effects 
by using the Update Effects command. This provides you with superior tools 
for adjusting the effects.

Promotable, 
missing AVX1 
plug-ins

You can update these effects to AVX2 effects by using the Update Effects 
command. For more information on AVX effects, including other options for 
promoting AVX1 effects, see “Working with Plug-In Effects” on page 145.

Effect Type Description
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Working with Effect Templates
To save a sequence with reverted color corrections that you can open in older versions of Avid 
editing applications:

1. Select the sequence in a bin.

2. Right-click the sequence, and select Revert Effects.

A message box appears.

3. Do one of the following:

t If the message box indicates that the sequence includes color corrections that you must 
modify for use in versions of Avid editing applications that do not support keyframeable 
color correction, click OK to save a new version of the sequence, or Cancel to take no action.

If you click OK, Media Composer saves a new version of the sequence. The name of the new 
sequence uses a suffix indicating that it is a compatible copy, for example, 
MySequence.reverted.01.

t If the message box indicates that you do not need to revert any effects, click OK.

Working with Effect Templates
If you apply an effect and make a set of adjustments to it, you might want to be able to quickly 
recreate the same look elsewhere in your sequence or project. Media Composer lets you save an 
effect with its parameter settings as a template. You can then apply the template to other effects or 
video clips at any time.

You can save any effect to a bin as an effect template. You can also save a segment effect with its 
source media. This is useful when you want to save an imported PICT file or Matte Key clip for 
future editing into a sequence.

When you save a title effect template, Media Composer includes the source media by default. You 
can also save a keyframe-only template, which retains the movement of the title without the source 
media.

You can apply an effect template with all its parameters directly to segments or transitions as you 
would any other effect. You can also apply specific parameters from the template.
36



Working with Effect Templates
In this example, a 3D Picture-in-Picture effect template is applied repeatedly to a series of segments to achieve the same 
cropping and positioning of foreground footage

To save an effect template:

t Drag the effect icon from the Effect Editor to a bin.

A new effect template appears in the bin, containing the parameter setting information for the 
effect. The new effect template is identified in the bin by its effect icon.

n Effect icons for open bins also display in the Effect Palette.

To save a segment effect with its source media, or save a title effect as a keyframe-only 
template:

t Press and hold the Alt key (Windows) or Option key (Macintosh) while you drag the effect icon 
from the Effect Editor to a bin.

To rename an effect template:

t In the bin, click the template name below the icon and type a new name.

To apply a specific parameter from an effect template:

1. In the Timeline, select an effect transition or segment.

2. Select Tools > Effect Editor.

3. Open the parameter group you want to change.

For example, the following illustration shows the Position parameter group.

4. Click the effect template icon in the bin or in the Effect Palette, and drag it to the specific 
parameter group in the Effect Editor.
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Promoting Existing Effect Templates
c Do not drag the effect template through the Timeline because this deselects the effect.

Media Composer applies the effect template only to the effect parameter group you selected.

Promoting Existing Effect Templates

In the current version of Media Composer, many effects use advanced keyframes only. You can no 
longer apply or use standard keyframe versions of those effects.

You might have effect templates that you created in an older version of an Avid editing application. If 
you created these templates from standard keyframe versions of effects that now use advanced 
keyframes only, you can still apply them in the standard ways described in “Working with Effect 
Templates” on page 36. You can apply the template to create a new effect in the Timeline, in which 
case the new effect uses advanced keyframes, or you can apply the template to a specific parameter in 
an effect. You can also choose to promote the template itself to advanced keyframes.

To promote a standard keyframe effect template:

t Right-click the template in the bin, select Promote Effects, and then click OK in the Promote 
Effects dialog box.

Media Composer creates a copy of the template in the bin and promotes the effect information in 
the copy to advanced keyframes.

The name of the new template uses a suffix indicating that it is a promoted template. If the 
original template is named MyColorEffect, the promoted copy is named, for example, 
MyColorEffect.Promoted.01. Both the original template and the promoted copy are available in 
the bin.
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Playing Effects
There are several situations where you need to play effects:

• While you are adjusting effects in Effect mode, you might want to play an individual effect to 
check its look. Depending on your needs, you might want to see the effect playing in real time 
and at high quality, or you might be able to accept playback at lower quality or in less than real 
time. Alternatively, you might only need to play an outline preview of the effect’s movement.

• At any point in your project workflow, you might want effects in a sequence to play when you 
play all or part of the sequence. Depending on your needs, you might want to see the effects 
playing in real time and at high quality, or you might be able to accept playback at lower quality 
or in less than real time.

• When you are ready to output your project, you need all the effects in the sequence to play in real 
time and at full quality.

Depending on the capabilities of Media Composer and the complexity of your sequences, you might 
need to render some effects before you can play them back in real time.

For more information, see “Real-Time Playback of Video Effects” on page 122 and “Basics of 
Effects Rendering” on page 41.

Playing an Effect in Effect Mode

While you are in Effect mode, you can:

• Play all or part of an individual effect once.

• Play an individual effect in a continuous loop.

• Play an outline preview of an effect (a wire-frame representation of the effect’s position, scale, 
and path of motion).

To play an effect in Effect mode:

1. In the Timeline, select the effect.

2. In the position bar of the Effect Preview monitor, move the position indicator to the location 
where you want play to begin.

3. Click the Play button or press the space bar.

Play continues until the end of the effect, or until you click the Play button or press the space bar 
again.

To play an effect in a continuous loop in Effect mode:

1. Move the position indicator in the Timeline to the effect you want to play.

2. Click the Play Loop button.

Play begins at the start of the effect and continues until you press the space bar.
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To play an outline preview of an effect in Effect mode:

1. In the Timeline, select the effect.

2. In the position bar of the Effect Preview monitor, move the position indicator to the location 
where you want play to begin.

3. Click the Play button.

Play continues until the end of the effect, or until you click the Play Preview button again or 
press the space bar.

Playing Real-Time Effects

A real-time effect is an effect that you can typically apply to a sequence and play without having to 
render it first (rendering takes time and disk space).

Real-time effects have a small green dot within the effect icon in the Timeline. Effects that you must 
render have a small blue dot within the effect icon in the Timeline. For more information, see “Color 
Coding on Effect Icons” on page 18.

You can create a sequence that has any number of real-time and non-real-time effects. While any 
individual real-time effect plays in real time without rendering, multiple real-time effects in complex 
sequences might not all play in real time. The maximum real-time playback capabilities of Media 
Composer vary depending on system capabilities and the complexity of the sequence.

If your sequence contains a combination of effects that exceeds the real-time playback capabilities of 
Media Composer, you can still achieve successful playback in many cases. See “Options for 
Controlling Real-Time Effects Playback” on page 124.

Real-time effects might cause dropped frames during a digital cut. You can have Media Composer 
select and render real-time effects that might cause dropped frames. For more information, see 
“ExpertRender” on page 127.

n If you do not have Avid input/output hardware connected to your system, you must render all effects 
before performing a digital cut. Software-only systems ignore unrendered effects during a digital cut. 
For example, unrendered transition effects play as cuts.

Using Render On-the-Fly for Effect Preview

When you preview effects in a sequence, you can use Render On-the-Fly to control how Media 
Composer displays frames with effects.

When Render On-the-Fly is selected, you can step through your sequence and preview any frame to 
check the look of the effects that apply to it, regardless of the type or number of those effects. 
Whenever you change the frame you are monitoring, Media Composer updates to show the image 
that results from any effects applied to that frame. Depending on the number and complexity of 
effects, there might be a perceptible delay before the image updates in the Composer monitor.

When Render On-the-Fly is deselected, Media Composer shows the monitored frame as if no effects 
are applied to it. You can deselect Render On-the-Fly to avoid delays in image updating when you are 
not concerned about the look of effects.
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Using Render On-the-Fly can slow down your editing of a sequence. If you are compositing in a very 
complex, effects-intensive sequence, you might need to wait a noticeable period of time for a single 
frame to render when you change the frame you are monitoring. Instead of waiting for rendering to 
finish, you can interrupt Render On-the-Fly. Interrupting Render On-the-Fly interrupts only the 
rendering of non-real-time effects.

Render On-the-Fly only controls how Media Composer displays a frame when the position indicator 
is stationary at that frame. During playback (that is, while the position indicator is in motion), Media 
Composer’s ability to display effects depends on whether real-time effects are enabled and on other 
associated factors. For more information, see “Real-Time Playback of Video Effects” on page 122.

To display effects immediately during effects editing:

t Select Composer > Render On-the-Fly.

To interrupt Render On-the-Fly, do one of the following:

t Drag the position indicator in the Timeline.

While you are dragging, the sequence appears in the Composer monitor as it would if Render 
On-the-Fly were not selected from the Composer menu.

t If you click in the Timeline and rendering begins, quickly move to another location in the 
Timeline.

This interrupts the rendering process until you release the mouse button.

Basics of Effects Rendering

The topics in this section provide basic information about rendering effects in Media Composer, 
along with instructions for rendering effects manually.

You can also render effects with the help of the ExpertRender feature. ExpertRender determines 
which effects you need to render for successful playback of a sequence. For more information, see 
“ExpertRender” on page 127.

Understanding Effects Rendering

In Media Composer, rendering is the process of calculating and storing video information for the 
finished look of an effect so that the effect always plays in real time at full quality. Media Composer 
stores a rendered effect and its media file as a precomputed master clip (often referred to as a 
precompute).

There are two main situations in which you render effects:

• Before you output a sequence, you must render any effects in the sequence that cannot play in 
real time during output. Media Composer can use the ExpertRender feature to identify and 
render these effects for you, so that you do not spend time and storage rendering effects that do 
not need rendering.

• At any time in your workflow, you must render any effects in a sequence that cannot play in real 
time if you need to view those effects in real time and at full quality. (If you can accept effects 
playback that is less than real time or less than full quality for preview purposes, you do not need 
to render.) Information in the Timeline can help you to see which parts of a sequence cannot play 
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in real time, and you can use the ExpertRender feature to identify and render those effects that 
cannot play in real time. The ExpertRender feature can operate across a whole sequence, a 
marked part of a sequence, or a single location in a sequence.

You can render a single effect after you create it, or you can render multiple effects at the same time.

You can also interrupt a render in progress and choose to save or discard the completed portion. You 
can finish the render later by resubmitting the effect for rendering. 

The key to rendering quickly is to render only those effects that require it. With vertical and nested 
effects, for example, you do not have to render every layer to play the effect in real time. If the top 
track covers the entire duration of the tracks below, Media Composer renders the composite result of 
all tracks into the top track.

One useful way to minimize rendering time is to use the Submaster effect by applying it to a track 
above layered effects and rendering only the Submaster effect. For more information, see “Submaster 
Editing” on page 215.

n When you render an audio effect on a linked media clip, all audio media files are written as PCM 
(MXF), regardless of what you set for the audio file format.

Rendering Effects

You have the following options for rendering effects:

• Render a single effect.

• Render multiple effects at a particular point in the Timeline (for example, effects on several 
stacked video tracks).

• Render multiple effects for a whole sequence or a portion of a sequence, by marking IN and 
OUT points.

You can configure Media Composer to send an email notification when a render operation completes. 
This lets you leave Media Composer unattended when a long render operation is taking place, yet 
still know when the render completes.For more information, see “Email Settings” in the Help.

n Save your sequence before you render by marking IN and OUT points. Depending on the number, 
type, and complexity of the effects, the rendering process can take a long time.

To render a single effect:

1. Move the position indicator to the effect in the Timeline.

Make sure the track containing the effect is selected.

2. Do one of the following:

t Click the Render Effect button.

t Select Timeline > Render > Render at Position.

The Render Effect dialog box opens.
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n To prevent the Render Effects dialog box from opening, press and hold the Alt key (Windows) or 
Option key (Macintosh) when you click the Render Effect button. Media Composer uses the last drive 
selected, and you do not need to follow the remaining steps in this procedure.

3. Click the Drive button, and select a drive for the rendered media.

4. In the Processing field, select the processing method you want to use for the render operation.

n Greyed-out options are not available.

5. Click OK.

If there is not enough room on the drive, Media Composer displays a message box that gives you 
the following choices:

Media Composer renders the effect and stores a precompute master clip on the drive you select.

To render multiple effects at position:

1. Move the position indicator to the effects in the Timeline.

2. Select all tracks that contain effects you want to render.

3. Select Timeline > Render > Render at Position.

The Render Effects dialog box opens.

4. Click the Drive button, and select a drive on which to store the rendered effects.

5. Click OK.

Option Description

Stop Stop the rendering process and return to the Render Effect 
dialog box, and then select another drive before continuing.

Continue Attempt to render the effect anyway, in case there might be 
enough room on the drive.
43



Basics of Effects Rendering
To render multiple effects using IN and OUT points:

1. Select all tracks that contain effects you want to render.

2. Mark an IN point before the start of the first effect you want to render, and then mark an OUT 
point after the last effect you want to render.

3. Select Timeline > Render > Render In/Out.

The Render Effects dialog box opens.

4. Click the Drive button, and select a drive on which to store the rendered effect.

To render effects in the background:

1. Enable render for the effect or effects in the Timeline. 

The Render Effects dialog opens.

2. Select Background Process.

3. Click OK.

The render operation is performed in the background. You can continue working without having 
to wait for the background operation to complete. When the effects are rendered, the sequence 
will link to the new pre-computes and the effect icons in the Timeline will reflect the rendered 
state. 

4. (Optional) Select Tools > Background Queue or click the Show Background Queue button on the 
Timeline to open the Background Queue window to monitor the progress of the background 
render.

With Background Render, a new directory is created where the background media is located. The 
location for MXF and OMF media:

- Local Storage

- drive:AvidMediaFiles/MXF/__bg.1

- drive:OMFIMediaFiles/__bg.1

- Shared Storage

- (workspace):AvidMediaFiles/MXF/computername__bg.1

- (workspace):OMFIMediaFiles/computername__bg.1

Clearing Rendered Effects

When you have one or more effects in a sequence that you want to return to unrendered status, you 
can clear the rendered effects within a range marked by IN and OUT points.

Clearing rendered effects does not delete the effects or their precomputes, but it disassociates the 
precomputes from the sequence so that the effects appear unrendered. If you want to restore the 
renders after clearing them, you can use the Undo feature.

If you want to clear one or more effects at a particular point in the Timeline (for example, effects on 
several stacked video tracks), you can clear just the rendered effects at that position.

You can also choose to clear all rendered effects except motion effects and any effects that Media 
Composer does not recognize (third-party plug-in effects that are not installed on your system).
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n  If you clear an unknown effect — that is, one marked by a blank effect icon — you cannot rerender it 
on your system because the necessary AVX plug-in is not installed. For more information on blank 
effect icons, see “Troubleshooting AVX Plug-Ins” on page 151.

You can store effect precomputes on a drive separate from your media. If this drive is offline, 
rendered effects in the Timeline appear to be unrendered. Clearing these rendered effects does not 
change their appearance in the Timeline, but you cannot restore the rendered effect by bringing the 
effect drive online as the sequence has lost the information stored in the precompute. For more 
information on setting the effects drive, see “Media Creation Settings” in the Help.

To clear rendered effects using IN and OUT points:

1. Select all tracks that contain rendered effects you want to clear.

2. Mark an IN point before the start of the first effect you want to clear, and then mark an OUT 
point after the last effect you want to clear.

3. Select Timeline > Render > Clear Renders In/Out.

The Clear Renders dialog box opens.

4. Select the appropriate options:

5. Click OK.

Media Composer clears all rendered effects between the IN and OUT points. The effect icons in 
the Timeline change from rendered to unrendered (the render dot appears in all cleared renders).

To clear rendered effects at position:

1. Move the position indicator to the effects in the Timeline.

2. Select all tracks that contain effects you want to clear.

3. Select Timeline > Render > Clear Renders at Position.

The Clear Renders dialog box opens.

Option Description

Skip Motion Effects Retains all motion effects in the marked range.

Skip Unknown Effects Retains all effects with blank effect icons in the 
marked range.
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4. Select the appropriate options:

5. Click OK.

Media Composer clears all rendered effects at the position indicator. The effect icons in the 
Timeline change from rendered to unrendered (the render dot appears in all cleared renders).

To restore cleared effects, do one of the following:

t Select Edit > Undo Clear Renders.

The cleared effects are restored only if Clear Renders was the previous action.

t Select Edit > Undo/Redo List, and then select Undo Clear Renders.

All the previous commands, including the Clear Renders command selected from the submenu, 
are undone or redone as appropriate.

Rerendering Effects

In some situations you need to rerender an effect that you have already rendered. For example, you 
might have rendered a series of effects at a low resolution, and now need to rerender them at a higher 
resolution. This situation might occur if you are working with multiple resolutions. For more 
information, see “Using MultiRez and Dynamic Relink” in the Help.

n You cannot use ExpertRender to rerender effects.

To rerender a single effect:

1. Move the position indicator to a single effect in the Timeline.

2. Shift-click the Render Effect button.

3. Click OK.

For more information, see “Rendering Effects” on page 42.

To rerender multiple effects at one position:

1. Move the position indicator to the effects in the Timeline.

2. Select all tracks that contain effects you want to render.

3. Hold down the Shift key and select Timeline > Render > Render at Position.

For more information, see “Rendering Effects” on page 42.

To rerender multiple effects using IN and OUT points:

1. Select all tracks that contain effects you want to render.

2. Mark an IN point before the start of the first effect you want to render in your sequence, and then 
mark an OUT point after the last effect you want to render.

3. Hold down the Shift key and select Timeline > Render > Render In/Out.

For more information, see “Rendering Effects” on page 42.

Option Description

Skip Motion Effects Retains all motion effects at the position indicator.

Skip Unknown Effects Retains all effects with blank effect icons at the 
position indicator.
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n You can also rerender effects using the shortcut menu Render commands. On the Macintosh, 
Shift+Ctrl-click in the Timeline to display the shortcut menu, and then press and hold the Shift key 
while you select Render at Position or Render In/Out. On Windows, Shift+right-click in the Timeline, 
and then select Render at Position or Render In/Out.
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3 Applying and Customizing Effects

This chapter contains further information on applying and customizing effects that builds on the 
information presented in “Basics of Effects Editing” on page 27.

• Applying Dissolve Effects

• Working with the Quick Transition Dialog Box

• Adjusting Transitions in the Timeline

• Modifying Transition Effects in the Timeline

• Preserving Effect Transitions in the Timeline

• Replacing an Effect in Effect Mode

• Using the Effect Preview Monitor

• Stepping Through Field-Based Media

• Using the Effect Editor

• Manipulating Effects Directly in the Effect Preview Monitor

Applying Dissolve Effects
You can apply a Dissolve effect using any of the following methods:

• Select the Dissolve effect from the Effect Palette.

For more information, see “Applying Effects From the Effect Palette” on page 27.

• Click the Quick Transition button. 

For more information, see “Using the Quick Transition Button” on page 53.

• Type a duration in the Transition parameters in Trim mode or in the Effect Editor.

For more information, see “Applying a Dissolve Effect Using the Transition Parameters” on 
page 48.

• Use the Head Fade button or the Tail Fade button.

For more information, see “Adding Dissolves with the Head Fade and Tail Fade Buttons” on 
page 49.

Applying a Dissolve Effect Using the Transition Parameters

You can create a Dissolve effect by using the Transition parameters that display in Trim mode and in 
the Effect Editor. Enter the duration for the effect, and Media Composer adds the Dissolve effect to 
the sequence.



Applying Dissolve Effects
Transition Effect Alignment button (left, with menu below) and Transition Effect Duration text box (right) in the Effect 
Editor

To create a Dissolve effect by using the Transition parameters:

1. Click a transition in the Timeline while in Trim mode or Effect mode.

2. In the Transition Effect Duration text box in the Effect Editor, type the dissolve’s duration. 

n The Duration setting above the Record monitor determines the duration format — for example, 
seconds:frames.

Media Composer adds the Dissolve effect at the transition, and the Dissolve Effect icon appears 
in the Timeline.

3. Click the Transition Effect Alignment button, and select the effect’s position relative to the cut 
point.

For an explanation of the Transition Effect Alignment menu selections, see “Transition 
Parameters” on page 500.

Adding Dissolves with the Head Fade and Tail Fade Buttons

You can use the Head Fade button and Tail Fade button to add a dissolve for selected audio and video 
tracks.

When you use the Head Fade button and Tail Fade button, all selected tracks, including layered 
tracks, receive the effect.

n When you use the Head Fade button and Tail Fade button with filler, Media Composer treats the filler 
like another video clip. You can use the Tail Fade button, for example, to fade from filler at the 
beginning of a sequence into the opening video clip.

To add a fade (dissolve):

1. Move the position indicator to a clip where you want the dissolve to end or begin.

Media Composer uses the location of the position indicator to begin or end the dissolve. For 
example, if you move the position indicator ten frames after the beginning of the clip and then 
use the Head Fade button, Media Composer creates a ten-frame dissolve that lasts from the 
beginning of the clip to the location of the position indicator.

2. Select the tracks on which you want to create dissolves.

If you select more than one track, Media Composer creates dissolves of appropriate lengths for 
each track, as shown in the following illustration.
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Tail Fade example — Media Composer creates two dissolves of different lengths on the two tracks

3. Select Tools > Command Palette.

4. Click the FX tab, and then click Active Palette.

5. Click the Head Fade button or the Tail Fade button.

Head Fade button (left) and Tail Fade button (right)

The dissolves appear in the Timeline. If a dissolve begins or ends at the edit point between two 
clips, the dissolve crosses between the two clips. Otherwise the dissolve is a fade from or to 
black.

6. (Option) If, for any selected track, there is insufficient source media to create a dissolve of the 
length you specified with the position indicator, the Insufficient Source dialog box opens. Do one 
of the following:

t Click Size to Fit. 

Media Composer creates the longest dissolve possible. For more information on sizing 
effects to fit available media, see “Sizing Effects to Fit the Media” on page 31.

t Click Skip Track.

Media Composer does not create a dissolve on the track with insufficient source material but 
does create dissolves on any other selected tracks with sufficient source material.

t Click Cancel.

Media Composer does not create any dissolves.

Working with the Quick Transition Dialog Box
The following topics provide instructions and information for using the Quick Transition button and 
the Quick Transition dialog box to apply basic transition effects without using the Effect Palette or 
entering Effect mode.

• Detailed information about the graphical controls in the Quick Transition dialog box.

• Procedures for applying a single transition effect.

• Procedures for applying effects to multiple transitions at one time.
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The Quick Transition Dialog Box

The graphical display of the transition effect in the Quick Transition dialog box lets you control the 
length and position of the effect with frame accuracy simply by dragging. You can select specific 
tracks to apply the effect to, and you can quickly reset the position of the effect by using the three 
alignment buttons.

Element Description

1 Track Selection 
buttons

Let you specify the tracks to which you apply the effect. When you open 
the Quick Dissolve dialog box, all tracks selected in the Timeline are also 
selected in the dialog box by default. However, selecting tracks in the 
Quick Dissolve dialog box does not affect track selection in the Timeline 
itself.

Add effect menu Lets you select a specific transition effect:

• Dissolve

• Film Dissolve

• Film Fade

• Fade to Color

• Fade from Color

• Dip to Color

n When you select a color transition with Quick Transition, the default 
color is black. You must enter Effect mode to select another color. 
For more information, see “Using the Effect Editor” on page 68.
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Position menu Lets you specify where to position the effect:

• Ending at Cut

• Centered on Cut

• Starting at Cut

• Custom

Duration Lets you set the duration of the transition effect (in frames). The duration 
depends on the amount of available footage.

Start n frames 
before cut

Lets you specify how far before the cut (in frames) the transition effect 
begins. The number of frames depends on the amount of available footage.

2 Outgoing media Provides a graphical representation of the outgoing (A) media for the 
transition to which you apply the effect.

3 Transition effect 
icon

Shows the effect icon and indicates the length and position of the effect in 
relation to the media. You can adjust the effect by dragging this part of the 
display. For more information, see “Adjusting a Transition Effect by 
Dragging in the Quick Transition Dialog Box” on page 56.

4 Handle on 
outgoing media

The amount of handle available for each piece of media is indicated as a 
darker area on the graphic. If you have multiple transitions between an In 
point and an Out point, the handle refers to the transition closest to the 
position indicator (see “Using the Quick Transition Button to Apply Effects 
to Multiple Transitions” on page 55).

5 Frames of 
outgoing media

Lists the amount of handle available for each piece of media as a number of 
frames.

6 Handle on 
incoming media

The amount of handle available for each piece of media is indicated as a 
darker area on the graphic. If you have multiple transitions between an In 
point and an Out points, the handle refers to the transition closest to the 
position indicator (see “Using the Quick Transition Button to Apply Effects 
to Multiple Transitions” on page 55).

7 Alignment buttons Allow you to quickly reposition the effect so that it either ends at the cut 
point, is centered on the cut point, or starts at the cut point. These buttons 
appear when you select Custom from the Position menu or click in the 
graphical display. For more information, see “Repositioning the Dissolve 
Effect with the Quick Transition Alignment Buttons” on page 57.

8 Incoming media Provides a graphical representation of the incoming (B) media for the 
transition to which you apply the effect.

9 Frames of 
incoming media

Lists the amount of handle available for each piece of media as a number of 
frames.

Target drive Lets you select the drive where you store the effect if you choose to render 
it. The default Effect Source Drive is the drive where the media on the 
outgoing shot of a transition resides.

Apply to All 
Transitions

Applies the transition effect to all transitions between the In point and the 
Out point.

Skip Existing 
Transition Effect

Applies the transition effect only to transitions that do not have an effect 
already applied.

Element Description
52



Working with the Quick Transition Dialog Box
Using the Quick Transition Button

You can use the Quick Transition button to apply the following transition effects without using the 
Effect Palette and to adjust them for position and duration without entering Effect mode:

• Dissolve and Film Dissolve

• Fade to Color, Fade from Color, and Film Fade

• Dip to Color

The Quick Transition button appears on the Tool palette, in the Timeline top toolbar, and in the FX 
tab of the Command palette.  For more information, see “Using the Tool Palette,” “Displaying the 
Timeline Top Toolbar,” and “The Command Palette” in the Help.

You can add the same transition effect to multiple transitions by marking In and Out points in your 
sequence that select all the transitions to which you want to apply the effect. When you click the 
Quick Transition button, the Quick Transition dialog box contains a check box for Apply to All 
Transitions (In -> Out). For more information, see “Applying Effects From the Effect Palette” on 
page 27.

You can select which tracks to apply the effect to from within the Quick Transition dialog box. The 
Track Selection buttons in the Quick Transition dialog box match the Track Selection panel in the 
Timeline. However, selecting tracks in the dialog box only determines which tracks the effect applies 
to, not which Timeline tracks are active. You can apply the effect to active or inactive tracks, 
depending on your selection. Timeline shortcuts for selecting tracks — for example, lassoing a track 
selector to reverse the current track selection — also work in the Quick Transition dialog box, with 
the exception of Ctrl+A and Shift+Ctrl+A to select and deselect all tracks.

Creating a Transition with the Quick Transition Dialog Box

To create an effect by using the Quick Transition button:

1. Move the position indicator to the transition in the Timeline.

2. Click the Quick Transition button.

The Quick Transition dialog box opens.

Add button Adds the effect to the sequence without rendering it.

Add and Render 
button

Adds the effect to the sequence and renders all applied transition effects.

Cancel Closes the Quick Transition dialog box without applying any transition 
effects.

Element Description
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The dialog box shows a graphical display of the outgoing media (A) and incoming media (B), 
with the Dissolve Effect icon applied to the transition. Media Composer scales the graphical 
display to show the relative size of the Dissolve effect and the media available for the effect. For 
more information on Quick Transition options, see “The Quick Transition Dialog Box” on 
page 51.

3. Click the Track Selection buttons to select the tracks to which you want to apply the effect.

4. Click the Add menu and select a transition effect.

For reference information on individual effects shown in the menu, see “Blend Effects” on 
page 452.

n When you save a Dissolve effect template into a bin named Quick Transitions, the effect template 
appears in the Add menu. For more information, see “Working with Effect Templates” on page 36.

5. Set the transition duration by doing one of the following:

t Type the duration in frames in the Duration text box. You cannot type a number greater than 
the number of frames available for the effect.

t Click either the left or right edge of the Dissolve Effect icon and drag it to change the 
duration.

The graphical display changes to reflect the new duration. The size of the effect icon increases or 
decreases, and the numbers in the Duration and Start text boxes change.

6. Adjust the position of the effect relative to the cut point by doing one of the following:

t Click the Position menu, and select a command to have the effect end at the cut point, center 
on the cut point, or start at the cut point.

t Click the Position menu, select Custom, and then type a number in the Start text box to 
specify how many frames before the cut point you want the effect to begin. You cannot type 
a number greater than the number of frames available for the effect.

t Click the effect icon and drag it to position the effect with respect to the cut point.

t Click one of the alignment buttons below the graphical display.

These buttons appear when you select Custom from the Position menu or click in the 
graphical display.
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Media Composer positions the effect, and updates both the graphical display and the value in the 
Start text box.

If you select an alignment for which there is not enough media, Media Composer comes as close 
as possible to the alignment you request.

7. If you click the Dissolve Effect icon and drag it, the Position menu changes to Custom. Indicate 
where you want the effect to start — that is, how many frames before the cut you want to include 
in the effect — by doing one of the following:

t Click near the middle of the effect icon and drag it to change the number of frames 
dynamically.

t Click one of the alignment buttons below the graphical display to specify the effect as 
ending at cut, centered on cut, or starting at cut.

t Type the number of frames in the Start text box. You cannot type a number greater than the 
number of frames available for the effect.

The graphical display changes to show the relative amount of media available and the relative 
position of the effect, and the new value appears in the Start text box.

8. Click the Target Drive menu, and select a drive on which to store the effect if you choose to 
render it.

The Effect Source Drive is the default drive where the media on the outgoing shot of a transition 
resides.

9. (Option) If you have In and Out points marked in your sequence, do one of the following:

t Select Apply to All Transitions (In -> Out) to overwrite all existing transition effects 
between the In and Out points.

t Select both options to avoid overwriting any existing transition effects.

n The Skip Existing Transition Effects option is useful when you want to add a number of dissolves to a 
sequence that already has transition effects.

10. Do one of the following:

t To add the effect without rendering it, click Add.

t To add the effect and render it, click Add and Render.

Media Composer adds the effect to the selected transition and the selected tracks in the sequence, 
or, if you select Apply to All Transitions (In -> Out), to all transitions between the In and Out 
points on the selected tracks.

n If there is not enough incoming or outgoing media material to apply the effect to a transition, a 
dialog box opens. For more information, see “Sizing Effects to Fit the Media” on page 31.

Using the Quick Transition Button to Apply Effects to Multiple Transitions

You can select multiple transitions by marking In and Out points. Then you can apply an effect from 
the Quick Transition dialog box in one of the following ways:

• Apply the effect to all transitions between the In and Out points.

• Apply the effect to only those transitions that do not already have an effect applied.
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Working with the Quick Transition Dialog Box
The graphical display in the Quick Transition dialog box always shows the transition closest to the 
position indicator. When you define an effect to apply to multiple transitions, the positioning details 
of any one transition might not be useful since you need to create an effect that will fit all the 
transitions. However, you might want to select one transition as a model. For example, you might use 
the transition with the least amount of handle as a model. If your effect fits that transition, it should fit 
all the others you have selected.

To apply an effect to multiple transitions by using the Quick Transition button:

1. Mark In and Out points around the transitions to which you want to add the effect.

2. (Option) If you want to see a particular transition in the graphical display of the Quick Transition 
dialog box, move the position indicator to that transition.

3. Follow the procedure for applying an effect with the Quick Transition button described in 
“Creating a Transition with the Quick Transition Dialog Box” on page 53.

Adjusting a Transition Effect by Dragging in the Quick Transition Dialog Box

You can control the length or position of the transition effect by dragging in the graphical display.

To adjust the length of the effect:

1. Do one of the following:

t To adjust the length of the effect without changing its start point, move the pointer over the 
right edge of the effect.

t To adjust the length of the effect without changing its end point, move the pointer over the 
left edge of the effect.

The pointer changes to a resizing arrow.

2. Do one of the following:

t To lengthen the effect, drag away from the effect icon in the center.

t To shorten the effect, drag toward the effect icon in the center.

The graphical display and the Duration text box update to reflect your adjustment. If you are 
dragging the left edge of the effect, the Start text box also updates to reflect the changed start 
point.

To adjust the position of the effect:

1. Move the pointer inside the effect.

The pointer changes to a hand.
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Adjusting Transitions in the Timeline
2. Drag the effect to adjust its position with respect to the cut point.

The graphical display updates to show the new effect position, and the Start text box updates to 
show the new number of frames before the cut point.

n You cannot drag an effect beyond the ends of the handles on the media because you cannot create a 
transition unless both incoming and outgoing media are available for every frame of the transition. 
You also cannot drag an effect beyond the cut point.

For information about preserving transition effects, see “Preserving Effect Transitions in the 
Timeline” on page 59.

Repositioning the Dissolve Effect with the Quick Transition 
Alignment Buttons

You can use the alignment buttons below the graphical display in the Quick Transition dialog box to 
quickly reposition an effect so that it either ends at the cut, is centered on the cut, or starts at the cut. 
The buttons have the same effect as the Ending at Cut, Centered on Cut, and Starting at Cut 
commands in the Position menu.

To reposition the effect with an alignment button:

t Click one of the following buttons:

Adjusting Transitions in the Timeline
You can adjust transitions directly in the Timeline using the Transition Manipulation tool and 
dragging either the transition handles or the transition effect icon in the Timeline. For more 
information, see “Modifying Transition Effects in the Timeline” on page 58.

You can adjust transitions while you are performing Trim edits.

You can trim a transition effect by using the standard transition trim procedures. For more 
information, see “Working with Trim Edits” in the Help

You can also change the duration of transition effects by using the Transition Corner Display. For 
more information, see “Using the Transition Corner Display” in the Help .

n The Transition Corner Display feature is only available when you are in Big Trim mode. To ensure 
that you enter Big Trim mode, select “Never use Small Trim mode” in the Features tab of the Trim 
Settings dialog box. For more information, see “Trim Settings” in the Help.

Button Description

Ending at Cut Aligns the effect so it ends at the cut point.

Centered on Cut Aligns the effect so it is centered on the cut point.

Starting at Cut Aligns the effect so it starts at the cut point.
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Modifying Transition Effects in the Timeline
To customize transition effect parameters, see the procedures in “Transition Parameters” on 
page 500.

Modifying Transition Effects in the Timeline

If you use the Transition Manipulation button in the Timeline toolbar, you can edit transition effects 
by dragging the transition handles or by moving the transition effect icon. When you position your 
mouse pointer over a transition effect, the pointer changes to either a resizing arrow or a hand icon, 
which allows you to lengthen or shorten the transition by dragging to the left or right, or to move the 
transition by dragging the effect icon to another position in the Timeline.

Modifying a transition effect by dragging in the Timeline allows you to do the following, depending 
on the position of the transition effect:

• Dragging a transition handle away from or towards the cut point increases or decreases the 
duration of the transition in that direction. 

• If you want to modify the duration of the transition equally in both directions (on the incoming 
and outgoing sides of the transition), you can press the Alt key (Windows) or the Option key 
(Macintosh) before dragging a transition handle. Similarly, dragging toward the transition 
decreases the duration of the effect in both directions.

• You cannot move a transition effect or drag a transition handle beyond the cut point itself.

• If you enable link selection or if you select more than one transition, you can modify transitions 
on multiple clips at the same time. If the transitions on the clips differ in the length of the effect 
or the duration of the available handles, you cannot lengthen the transitions beyond the limit of 
the shortest handle or beyond a cut point on any of the selected tracks. (For more information on 
editing with linked clips, see “Linked Clips” in the Help.)

To lengthen or shorten the duration of a transition effect in the Timeline:

1. Click the Transition Manipulation button in the Timeline toolbar.

2. Position the mouse pointer over the transition handle on either the outgoing or incoming side of 
the transition.

The pointer changes to a resizing arrow.

3. Do one of the following:

t To lengthen the duration of a transition, drag the transition handle away from the effect icon 
in the center. You can press the Alt key (Windows) or the Option key (Macintosh) before you 
drag a transition handle to lengthen the duration of a transition equally in both directions.

t To shorten the duration of a transition, drag the transition handle toward the effect icon in the 
center. You can press the Alt key (Windows) or the Option key (Macintosh) before you drag 
a transition handle to shorten the duration of a transition equally in both directions.
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Preserving Effect Transitions in the Timeline
The duration of the transition changes as you drag the transition handle. If you enable link 
selection, the duration of the transition in the Timeline changes for all linked clips.

The monitor display changes to a Transition Corner display, showing you six frames that you can 
use as reference points when trimming a transition effect.

To adjust the position of the effect in the Timeline:

1. Click the Transition Manipulation button in the Timeline toolbar.

2. Position the mouse pointer over the effect icon for the transition you want to move.

The pointer changes to a hand.

3. Drag the effect to adjust its position with respect to the cut point.

The Timeline updates to show the new effect position. If you enable link selection, the transition 
moves on all tracks in the Timeline with linked clips.

The monitor display changes to a Transition Corner display, showing you six frames that you can 
use as reference points when trimming a transition effect.

n You cannot drag an effect beyond the ends of the handles on the media because you cannot create a 
transition unless both incoming and outgoing media are available for every frame of the transition. 
You also cannot drag an effect beyond the cut point.

Preserving Effect Transitions in the Timeline

This topic describes the behavior of clips with transition effects when you trim and move them in the 
Timeline. 

Segment Editing

When you move a segment with a transition effect into filler, the effect remains with the segment. 
Media Composer does not remove the effect.

When you move a segment with a transition effect into another segment, the effect remains with the 
stationary segment.

 For information about Segment editing, see “Working with Segments” in the Help.

Splicing and Overwriting

When you splice or overwrite a sequence onto another sequence, Media Composer preserves the 
transition effects at the marks in the source, depending on the position of the mark. For example:
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Replacing an Effect in Effect Mode
Trim Mode

You can trim past the edge of the transition effect up to the cut.

 For information about Trim mode, see “Working with Trim Edits” in the Help.

Cutting or Extracting

When you cut or extract a clip with a transition effect, the effect remains in the Timeline. Media 
Composer does not remove the effect.

 For information about extracting, see “Lifting, Extracting, and Copying Material” in the Help.

Replacing an Effect in Effect Mode
You can replace an existing effect in Effect mode. However, some effects cannot replace other 
effects. For example, some segment effects, such as the Mask effect, cannot replace transition effects. 
In addition, two-track effects, such as wipes, cannot replace three-track effects, such as matte keys.

To replace an effect:

1. If Media Composer is not in Effect mode, enter Effect mode, for example, by clicking the Effect 
Mode button.

For more information, see “Entering Effect Mode” on page 32.

2. In the Effect Palette, select an effect category.

3. Do one of the following to replace the effect:

t Drag the new effect’s icon to the Timeline. To replace an existing effect, move the new 
effect’s icon on top of the existing effect’s icon.

t Drag the new effect’s icon to the Effect Preview monitor.

t Select the effect in the Timeline, and double-click the new effect’s icon in the Effect Palette.

4. Set the applicable effect parameters in the Effect Editor.

Using the Effect Preview Monitor
The Effect Preview monitor displays the selected effect in the sequence where the position indicator 
is located in the Timeline. The effect’s position bar, located directly below the Effect Preview 
monitor, represents only the selected effect, not the entire sequence.

For information on entering Effect mode and displaying the Effect Preview monitor, see “Entering 
Effect Mode” on page 32.

If you: The result is:

Place the Mark In at the cut Media Composer leaves the transition effect as is.

Place a Mark In before the cut Media Composer leaves the transition effect, but shortens 
the transition.

Place a Mark In after the cut Media Composer removes the transition effect.
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Using the Effect Preview Monitor
The Effect Preview monitor. Top, left to right: tracking information, length of effect, and current position in effect. Bottom, 
left to right: scale bar (for expanding position bar), and position bar with position indicator (blue bar) and keyframe 
indicators (pink triangle).

n If the effect you expect does not appear in the Effect Preview monitor, make sure that you have 
selected the Record Track Monitor button in the Track Selector panel. If a black frame appears in the 
Effect Preview monitor, the position indicator might be at a location in the Timeline where an effect 
has not been applied to the sequence. The following illustration shows the Record Track Monitor 
buttons.

Toolbar Buttons in the Effect Preview Monitor

You can use toolbar buttons in the Effect Preview Monitor to control effect position and adjustment. 
The following table describes these buttons.

The Effect Editor also contains controls that you use to adjust and preview effects. For more 
information, see “Effect Editor Controls” on page 69.
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Using the Effect Preview Monitor
Mapping User-Selectable Buttons in Effect Mode

You can customize the buttons that are available in Effect mode by mapping user-selectable buttons 
directly from the Command palette to the Tool palette or to the area below the Effect Preview 
monitor.

To remap user-selectable buttons, enter Effect mode and use the procedure in “Mapping User-
Selectable Buttons” in the Help.

Button Description

Reduce Reduces the size of the image in the Effect Preview monitor.

Enlarge Enlarges the size of the image in the Effect Preview monitor.

n You can also Ctrl+click (Windows) or Command+click (Macintosh) in 
the Effect Preview monitor to enlarge the image.

Add Keyframe Creates a keyframe at the current position of the position indicator in the effect’s 
position bar. Alt+click (Windows) or Option+click (Macintosh) to delete the 
selected keyframe.

Step Backward
One Frame

Moves the position indicator one frame backward.

Step Forward
One Frame

Moves the position indicator one frame forward.

Play Plays the effect from the current position in the effect’s position bar. Click again 
or press the space bar to stop play.

Rendered effects play at full speed, and real-time unrendered effects play at full 
speed in most circumstances. For information on effect playback, see “Real-
Time Playback of Video Effects” on page 122.

Play Preview Plays back a wire-frame preview of an unrendered effect.

Play Loop Plays back the current effect repeatedly in a loop. Click again or press the space 
bar to stop play.

Rendered effects play at full speed, and real-time unrendered effects play at full 
speed in most circumstances. For information on effect playback, see “Real-
Time Playback of Video Effects” on page 122.

Dual Split Click to divide the Effect Preview monitor in half, showing the image with and 
without the effect applied. Click again to remove.

Go to Previous 
Event

Places the position indicator at the first frame or field of the sequence.

Go to Next Event Places the position indicator at the last frame or field of the sequence.
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Using the Effect Preview Monitor
n When you customize the display of buttons in Effect mode, the new configuration appears in Effect 
mode only. The default editing mode buttons reappear when you exit Effect mode.

Understanding Tracking Information in the Effect Preview Monitor

The two boxes above the Effect Preview monitor display the length of the effect in seconds and 
frames and the current position in the effect’s position bar. 

If you are working with two-field media, the current position display indicates the field that appears 
in the monitor. The current position display ends with .1 for the first field of a frame and with .2 for 
the second field. These boxes replace the name of the sequence that normally appears in this position. 

n If the position information boxes do not appear above the Effect Preview monitor, increase the size of 
the window.

Displaying Safe Title and Safe Action Guidelines in Monitors

Many effects can utilize the outer edges of the viewing screen area. If you are editing material that 
will be viewed on screens with more limited viewing areas, such as standard televisions, you can use 
the Safe Title and Safe Action options to provide visual guidelines in the Effect Preview monitor that 
replicate the actual viewable area on a standard television screen.

For example, you can use the Safe Title option as a template for the area in which you want the effect 
to operate. In this way, you can avoid the appearance of the effect floating off into a nonviewable area 
of a standard television screen.

To display the Safe Title and Safe Action guidelines in the Effect Preview monitor:

t Select Tools > Effect Editor, and click the Grid button in the Effect Editor.

n You can customize the type of grid displayed by the Grid button. For more information, see 
“Understanding the Effect Grid” on page 64.

Two outlined boxes appear in the Effect Preview monitor. The inner box is the safe title area. All 
text and objects should remain within the inner box. The outer box is the safe action area for 
video display
63



Using the Effect Preview Monitor
Understanding the Effect Grid

The Effect Grid helps you to position effects with accuracy and previsualize them in the Effect 
Preview monitor. The grid coordinates can be expressed in traditional fields or X–Y pixels in any 
resolution.

The following illustration shows a 12-field grid displayed in a video project.

You can use the Effect Grid to:

• Display the aspect ratios for film categories such as standard film, Academy, Super 35 mm, and 
Anamorphic, as well as the 4:3 safety area for the 16:9 aspect ratio.

• Show coordinate information to track the exact location of an effect in the frame.

• Use the snap-to-grid feature to easily position effects.

In film projects, you can also use the Effect Grid to:

• Create position information for the following effects: Paint, AniMatte™, Blowup.

You can include this information in an optical list created using the List Tool.

• Create position information for an effect you previsualize using the Previsualization Marker tool. 

You can include this information in an optical list created using the List Tool. For more 
information, see “Using the Previsualization Marker Tool for Film Projects” on page 404.

The Grid parameter category in the Effect Editor lets you customize the grid display for an individual 
effect. Grid parameters set in the Effect Editor apply only to that effect and temporarily override the 
current settings in the Grid Settings dialog box. For more information on the parameters available 
with the Grid parameter category, see “Grid” on page 497.

Displaying the Effect Grid in Effect Mode

To display the Effect Grid rather than the Safe Title/Safe Action guidelines:

t Press the Alt key (Windows) or Option key (Macintosh), and click the Grid button.
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Using the Effect Preview Monitor
To switch between the Effect Grid and the Safe Title/Safe Action guidelines:

t Press the Alt key (Windows) or Option key (Macintosh), and click the Grid button until the 
appropriate grid is displayed.

To remove the display of either the Effect Grid or the Safe Title/Safe Action guidelines:

t Click the Grid button without pressing the Alt key (Windows) or Option key (Macintosh).

Displaying Position Coordinates for Effects

Media Composer uses compass coordinates and X, Y coordinates to describe the position of an 
effect.

For compass coordinates, the point (0, 0) is the center of the axes. For X, Y coordinates, the point (0, 
0) is the upper left corner of the monitor. X values increase to the right, and Y values increase as you 
move down.

The compass coordinates describe the effect’s position in terms of film optical house standards. Each 
compass coordinate begins with a direction (N, S, E, or W, the abbreviations for North, South, East, 
or West) followed by a numerical value. This numerical component reflects the Fields and Sub Fields 
parameters you select in the Grid Settings dialog box or the Grid parameter group. 

The X, Y coordinates describe position in terms of the Source Scan Size parameters you select in the 
Grid Settings dialog box or the Grid parameter group.

To enable display of position coordinates:

1. Select File > Settings and click the User tab.

2. Double-click Grid.

The Grid Settings dialog box opens.

3. Select Show Position Info, and then click OK.

4. Enable the Effect Grid as described in “Displaying the Effect Grid in Effect Mode” on page 64.

To display position coordinates in Effect mode:

1. Deselect all tools in the Effect Editor (including the Outline/Path button and the Selection tool 
for Intraframe effects).

Outline/Path button (left) and Selection Tool button (right)

2. Press and hold the mouse button, and drag the pointer in the Effect Preview monitor.

To display position coordinates in Source/Record mode:

t Move the pointer to the Record monitor, press and hold the mouse button, and move the mouse.
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Using the Effect Preview Monitor
Obtaining Position Information in a Film Project

Media Composer enables you to use the Effect Grid to include position information in a cut list for 
the Paint and AniMatte effects on a keyframe-by-keyframe basis. You can include both compass 
coordinate and X, Y coordinate information in a cut list for each corner of a Paint or AniMatte effect. 
For example, a rectangle you create with the Paint Effect shows four compass and four X, Y 
coordinates for each keyframe.

The following illustration shows the presentation of Paint Effect information for a rectangular object 
in a cut list.

Example of Paint Effect information in a cut list. Top to bottom: Grid information, keyframe number and reference 
numbers, Shape type and color information, Compass and (X,Y) coordinate information for each corner of the rectangle.

You can also display the position information for the first keyframe of a Blowup effect in a cut list. 
The event section of the cut list displays the compass coordinates of the effect at the first keyframe in 
the segment and the Fields parameter you have selected for the effect. You must enable the Effect 
Grid before you generate the cut list to display this information in the list.

The following illustration shows sample Blowup effect information in a cut list.

Example of Blowup Effect information in a cut list. Top: Grid information. Bottom, left to right: Keyframe number, Field 
parameter value, and Compass coordinates.
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Using the Effect Preview Monitor
n You generate film cut lists and change lists with the List Tool. For general information See “Using the 
List Tool” on page 915.

You can also generate effect information in a cut list by using the Previsualization Marker Tool in the 
Paint Effect. For more information, see “Using the Previsualization Marker Tool for Film Projects” 
on page 404.

Moving an Enlarged Image in the Effect Preview Monitor

You can use the Enlarge and Reduce buttons in the Effect Editor or the Effect Preview Monitor 
toolbar to zoom in or out on an image in the Effect Preview monitor.

This lets you view parts of an image in detail or to view parts of effects and effect controls that extend 
beyond the limits of the standard-size image. For more information, see “Effect Editor Controls” on 
page 69 and “Toolbar Buttons in the Effect Preview Monitor” on page 61.

When you use the Enlarge button to increase the size of the image in the Effect Preview monitor, you 
cannot view the entire frame all at once. When you are creating an effect that requires great detail, 
you can reposition the enlarged frame in the monitor to view the areas that need your attention.

n This feature applies only to an enlarged image in the Effect Preview monitor, not to a standard-size or 
reduced image.

To move an enlarged image within the Effect Preview monitor:

1. Click within the boundaries of the Effect Preview monitor.

2. Press and hold Ctrl+Alt (Windows) or Command+Option (Macintosh).

The pointer changes to a hand.

3. Drag the hand in any direction to reposition the image within the Effect Preview monitor.

n You can also enlarge the frame in the Source monitor and move the frame around by pressing and 
holding Ctrl+Alt (Windows) or Command+Option (Macintosh). To access the Enlarge and Reduce 
buttons when you are not in Effect mode, use the Command palette, or map the buttons to your 
keyboard or to the user-selectable palettes. You can also use Ctrl+L (Windows) or Command+L 
(Macintosh) to enlarge the frame and Ctrl+K (Windows) or Command+K (Macintosh) to reduce the 
frame.
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Stepping Through Field-Based Media
Stepping Through Field-Based Media
Media Composer behaves differently when stepping through two-field media depending on the mode 
you are in.

In Effect mode, Media Composer displays each field in the media as you step forward or back using 
the standard controls, for example, the Step Forward and Step Backward buttons below the Effect 
Preview monitor. 

In Source/Record and Color Correction modes, Media Composer displays only field 1 of each frame 
by default. If you need to view both field 1 and field 2 of each frame of video while in these modes, 
you can use the Step Forward One Field and Step Backward One Field buttons.

To step through footage one field at a time in Source/Record or Color Correction mode:

t Click the Step Forward One Field button or the Step Backward One Field button.

Step Forward One Field button (left) and Step Backward One Field button (right)

As you step, the number “2” appears in the upper right corner of the image display in the Record 
monitor whenever field 2 of the media is displayed. The number disappears during the display of 
field 1 (the default display).

Using the Effect Editor
You use the Effect Editor to adjust the parameters for an effect and to control other aspects of effects 
such as how they display and how you preview them.

Parameter controls are grouped in parameter categories in the main area of the Effect Editor. For 
example, the Border parameter category includes all the controls that you can use to define the color 
and appearance of an effect border.

Other controls and buttons are grouped on the right and at the bottom of the Effect Editor.

Displaying an Effect’s Parameters in the Effect Editor

You display the Effect Editor by entering Effect Mode. The Effect Editor shows effect parameters for 
the effect currently selected in the Timeline.

To display an effect’s parameters in the Effect Editor:

1. Move the position indicator to the effect’s icon in the Timeline.

2. Make sure that the Record Track button for the track that contains the effect is selected in the 
Track Selector panel.

3. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens. The name of the effect and its icon appear at the top of the Effect Editor 
and the parameters that pertain to the effect appear in the Effect Editor.
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Using the Effect Editor
n If the Effect Editor is already open and active, select the segment or transition effect to display the 
effect’s parameters in the Effect Editor.

Understanding Parameters in the Effect Editor

Effect parameters are values that define the appearance of an effect. For example, you can set 
parameters that control the size and position of a Picture-in-Picture effect.

A number of parameters are common to many effects, such as parameters affecting size, position, or 
foreground level (transparency). You can adjust these parameters once for the entire effect, or you 
can use the Effect Editor along with keyframes to change the effect parameter over time. Other 
parameters can be adjusted only once for the entire effect, regardless of keyframe selection.

Not all effect parameters apply to all effects. Parameters that do not apply to an effect do not appear 
in the Effect Editor for that effect.

n If the position indicator is not on an effect’s icon in the Timeline, or if the track that contains the 
effect is not selected, the Effect Editor is blank.

For reference information on all of the available effect parameters (including which effect parameters 
apply to each effect), see “Effects Reference” on page 451 and “Effects Parameter Reference” on 
page 491.

Effect Editor Controls

This topic describes the controls in the Effect Editor. Not all controls apply to each effect. If a control 
is not applicable, it does not appear in the Effect Editor for that effect.

The following illustration is an example of the location of controls and buttons within a typical 
Effect Editor display. The exact number of controls and their appearance might vary for Media 
Composer. 
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Using the Effect Editor
The following table describes the buttons that all effects have in common. Additional buttons appear 
in the Effect Editor, depending on the effect used. For example, if you are working with a 3D effect, 
a set of 3D-specific buttons appears along the right side of the Effect Editor. For more information on 
3D-specific Effect Editor buttons, see “Working with 3D Effects” on page 282.

When you are working with advanced keyframes, additional buttons appear in the bottom toolbar of 
the Effect Editor. For more information, see “Effect Editor Controls for Advanced Keyframes” on 
page 114.

The Effect Preview Monitor toolbar also contains buttons that you use to adjust and preview effects. 
For more information, see “Using the Effect Preview Monitor” on page 60.

1 Triangular opener 5 Parameter name 9 Transition Effect Duration box

2 Effect name and icon 6 Render Effect button 10 3D Promote button

3 Parameter group (parameter 
category)

7 Outline/Path button 11 Show/Hide Keyframe Graph 
button

4 Parameter adjustment slider 8 Transition Effect 
Alignment button

12 Additional buttons (exact set 
depends on the effect
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Using the Effect Editor
Button or Control
Location in 
Effect Editor Description

Triangular 
opener

Left side Opens or closes the parameter group. A downward-pointing 
triangle displays the parameter group; a right-pointing 
triangle displays the parameter name.

n Triangular openers also appear to the left of keyframe 
graphs when you use advanced keyframes. For more 
information, see “Opening Keyframe Graphs” on 
page 82.

Other Options Inside some 
parameter 
categories

Opens additional parameters for some effects, including the 
Macintosh Colors panel or the Windows Color dialog box for 
color selection. For more information, see “Accessing 
Additional Parameters for an Effect” on page 74.

Reduce Right side Reduces the image in the Effect Preview monitor.

Enlarge Right side Enlarges the image in the Effect Preview monitor.

Dual Split Right side Splits the Effect Preview monitor in half to show the image 
with and without effects applied to it.

Play Loop Right side Plays back a transition or segment effect in a loop.

Play Right side Plays the effect from the current position in the effect’s 
position bar for most 2D and 3D effects.

HQ Right side Appears when a 3D effect has the HQ (Highest Quality) 
rendering option. Click to select the HQ implementation or 
the standard implementation with which to render the effect. 
The button is green when the HQ implementation is selected. 
For more information, see “Rendering 3D Effects Using the 
HQ (Highest Quality) Option” on page 141.

Tracking Tool Right side Appears when the effect can use motion tracking data. Click 
to open the Tracking window. For more information, see 
“Motion Tracking and Stabilization” on page 240.

Grid Right side Displays Safe Action/Safe Title guidelines or the Effect Grid. 
For more information, see “Displaying the Effect Grid in 
Effect Mode” on page 64.
You can also right-click the Grid button to access the Grid 
Settings.

Render Effect Bottom Renders the current effect.

Outline/Path Bottom Displays a wire-frame path to illustrate the movement of an 
effect from the first keyframe through the last keyframe.
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Using the Effect Editor
Selecting a Parameter from a Menu in the Effect Editor

Some effects have parameters that you select from a menu (advanced keyframes) or from a Fast 
menu (standard keyframes). For example, border types for 3D effects are in the same menu.

To select a parameter from a menu:

t Click the menu or the Fast Menu button, and then select a parameter.

Example of a menu in an advanced keyframe effect (left), and of a Fast Menu button and its menu in a standard 
keyframe effect (right)

Transition 
Effect 
Alignment

Bottom Opens a menu from which you select the alignment of a 
transition effect relative to the cut point. The appearance of 
the button changes depending on which alignment option you 
have selected from the menu. For a detailed explanation of the 
Transition Effect Alignment menu and the Transition Effect 
Duration box, see “Applying a Dissolve Effect Using the 
Transition Parameters” on page 48.

n The Transition Effect Alignment button shows the alignment of the transition effect applied at the cut 
point. If the cut point does not have a transition effect, the Transition Effect Alignment button appears as 
a vertical bar. If the cut point has an existing transition effect, the button indicates the alignment of the 
transition effect.

Transition 
Effect 
Duration box

Bottom Sets a duration for the transition effect other than the duration 
displayed.

Promote to 
Advanced 
Keyframes

Bottom Promotes an AVX 1.x effect to an AVX 2 effect. This button 
only appears for an AVX 1.x plug-in that is promotable to 
AVX 2. For more information, see “Updating and Promoting 
AVX Plug-ins” on page 148.

3D Promote Bottom right 
corner

Promotes the effect to a 3D effect. Available for some effects, 
including titles, Picture-in-Picture, and imported matte keys.

Button or Control
Location in 
Effect Editor Description
72



Using the Effect Editor
Changing a Parameter with a Slider in the Effect Editor

Many parameters have sliders for controlling parameters with a range of possible values.

n When you edit an effect that uses advanced keyframes, parameters are displayed with sliders. See 
“Effect Editor Controls for Advanced Keyframes” on page 114.

The parameter’s numeric value appears to the right of the slider.

Examples of a parameter slider

Some parameters display a blank slider track until you click an Effect Editor tool that activates the 
control.

To activate a parameter that has a slider:

t Click the slider. 

The slider highlights.

To change the value of a parameter that has a slider, use any of the following methods:

t Move the slider with the mouse.

t Use the Left Arrow or Right Arrow key to change the value by –1 or +1.

t Use the mouse scroll wheel to change the value by increments of –1 or +1.

t Press the Shift key, and use the Left Arrow key or Right Arrow key to change the value by –10 or 
+10.

t Press the Shift key and use the mouse scroll wheel to change the value by increments of -10 or 
+10.

t Use the numeric keypad to type a new value, and, if you entered fewer than three digits, press 
Enter (Windows) or Return (Macintosh).

The parameter’s numeric value (to the right of the slider) changes as you move the slider.

t Use the Trim keys to change the value:

- Click the Trim Left 1 Frame key to decrease the value by 1 unit. Shift+click the Trim Left 1 
Frame key to decrease the value by 10 units.

- Click the Trim Right 1 Frame key to increase the value by 1 unit. Shift+click the Trim Right 
1 Frame key to increase the value by 10 units.

- Click the Trim Left 10 Frames key to decrease the value by 10 units. Shift+click the Trim 
Left 1 Frame key to decrease the value by 100 units.

- Click the Trim Right 10 Frames key to increase the value by 10 units. Shift+click the Trim 
Right 10 Frames key to increase the value by 100 units.

To move from one slider to the next slider:

t Press the Tab key.
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To move from one slider to the previous slider:

t Press Shift+Tab.

Using Parameter Enable Buttons in the Effect Editor

You control some parameters using parameter Enable buttons. These parameters can either be active 
or inactive but cannot be adjusted over a range of values. For example, the Fixed Aspect parameter 
Enable button controls whether the aspect ratio of an image is maintained when you adjust one of its 
dimensions.

To turn a parameter on or off using a parameter Enable button:

t Click the Enable button.

Parameter Enable buttons, when the parameter is active (left) and when the parameter is inactive (right)

Accessing Additional Parameters for an Effect

Some effects have additional parameters that control their operation. For example, the Grid effect has 
additional parameters in which you set the number of columns and rows in the wipe. 

When an effect has additional parameters, the Other Options button appears next to the effect name 
or in a parameter group.

To access an effect’s additional parameters:

t Next to the effect name or in a parameter group, click the Other Options button.

A dialog box opens in which you set the additional parameters.

n You also use the Other Options button to access the parameters for third-party plug-in effects and for 
the Windows Color dialog box or Macintosh Colors panel in effects that lets you change color 
parameters.

Adjusting a Color Parameter for an Effect

In addition to using the Hue, Sat (saturation), and Lum (luminance) sliders, you can change a color 
parameter or select a key color with the following methods:

• Select a color with the eyedropper.

• Specify a color in the Windows Color dialog box or Macintosh Colors panel.

The Windows Color dialog box is part of the Windows operating system and the Macintosh 
Colors panel is part of the Macintosh operating system.
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To select a color using the eyedropper:

1. Position the pointer over the Color Preview window to activate the eyedropper.

Example of Color Preview window with eyedropper active

2. Click the mouse button, then drag the eyedropper to the Effect Preview monitor, and click on the 
color you want to select from the video image.

Media Composer updates the parameter’s numeric values, and the selected color appears in the 
Color Info window.

To open the Select Color dialog box:

t Double-click the swatch next to a color parameter.

The Select Color dialog box opens.
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To use the Select Color dialog box:

1. To select a color from the Basic colors palette, click the color you want.

2. To specify a custom color, do one of the following:

t Click in the color matrix to select a color, and then drag the color slider to adjust the amount 
of white and black in the color.

t Type numeric values for each color component in the color selection text boxes.

The new color appears in the left side of the Color|Solid box.

3. When you are satisfied with the color, click Add to Custom Colors to add it to the Custom Colors 
palette.

4. To select a custom color from the Select Color dialog box, click the color you want.

5. Click OK.

The Select Color dialog box closes, and Media Composer applies the color to the parameter in 
the Effect Editor.

To open the Macintosh Colors panel:

t Double-click the swatch next to a color parameter.

The Macintosh Colors panel opens.

1 Default color choices 4 Current color 7 Color Selection text boxes

2 Custom colors palette 5  Color slider

3 Color matrix 6 Color|Solid box
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Select the appropriate icon at the top of the Colors panel to display the method you want to use 
for selecting the color. Options include RGB sliders, a crayon box, an HSV (hue, saturation, 
luminance) color wheel, a Web-safe color picker (Name), and CMYK (cyan, magenta, yellow, 
and black) sliders. For a complete description of how to use the Macintosh Colors panel, see the 
documentation that ships with your Macintosh.

Disabling the Color Info Tool

An Effect Editor setting allows you to disable the Color Info Tool from automatically launching 
when you access a color picker. 

To disable the color info tool from automatically opening when you access a color picker:

1. Select File > Settings.

The Settings dialog box opens.

2. Click the User tab, and double-click Effect Editor. 

The Effect Editor settings opens. 

3. Deselect the Open the color info tool when picking color option.

4. Click OK. 

The Color Info tool will no longer automatically open when you are choosing a color.
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Manipulating Effects Directly in the 
Effect Preview Monitor

You can make some adjustments to effects by manipulating them directly in the Effect Preview 
monitor. These adjustments use handles and wire-frame outlines that you can display in the monitor.

You can create a motion path that defines how the foreground image moves across the background 
video. You can also resize a foreground image, as in a picture-in-picture effect.

You can define how the foreground image of a multilayer effect moves across the background video 
by building a motion path, or string of keyframes. You can define a motion path on multilayer video 
effects such as Picture-in-Picture effects. Use the wire-frame preview feature when you want to see 
the path an image takes on the screen. You can also use the resize handles to set the size of the effect 
image at each keyframe location.

Create keyframes where you need them, make sure that the appropriate keyframe is selected, and 
then manipulate the wire frame and handles in the Effect Preview monitor. Drag the wire frame to 
reposition the effect. Drag the resize handles to resize the image — the top handle adjusts the height 
of the effect image, the side handle adjusts the width, and the corner handle adjusts width and height 
together, maintaining the aspect ratio. For more information on keyframing, see “Working with 
Keyframes” on page 80.

When you are creating a motion path that moves beyond the viewing screen, you can use the Reduce 
button to view an outline of the image at a reduced scale. The reduced scale view shows the area 
outside the background image and lets you extend the motion path into that area. The Enlarge button 
returns the screen to full view.

Example of wireframe display in the Effect Preview monitor. The image area shows a background image on track V1 and 
a wire frame outlining the foreground image on track V2.
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Example of a motion path in the Effect Preview monitor. Each dot on the path represents the location of the center of the 
PIP at a keyframe. The center handle and the resize handles are highlighted.
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4 Working with Keyframes

This chapter describes how to use keyframes to change the behavior of an effect over time.

• Understanding Keyframes

• Track Types for Advanced Keyframes

• Viewing Advanced Keyframe Graphs

• Manipulating Advanced Keyframes

• Controls and Settings for Advanced Keyframes

• Working with Standard Keyframes

Understanding Keyframes
A keyframe is a point in an effect at which you can set parameters.

When you set parameters to different values in different keyframes, Media Composer animates your 
effect by calculating intermediate values for parameters between the keyframes. For example, if a 
Picture-in-Picture is set to be on the left of the screen at one keyframe and on the right of the screen 
at the next keyframe, the Picture-in-Picture moves from left to right across the screen over the period 
of time between the two keyframes.

Media Composer uses two different kinds of keyframes, advanced and standard. Most effects use 
advanced keyframes only, while a small number of effects use standard keyframes only.

n In previous versions of Avid editing applications, you could apply some effects as standard keyframe 
effects and subsequently choose to promote them to advanced keyframes. This workflow is no longer 
necessary or available. Effects either use advanced keyframes only or use standard keyframes only. 
For information on promoting existing effects in sequences, or existing effect templates, see 
“Updating and Reverting Existing Effects in Sequences” on page 34 and “Promoting Existing Effect 
Templates” on page 38.

Advanced Keyframes

Advanced keyframes let you establish independent keyframes for each keyframeable parameter in an 
effect, which provides flexibility and control for sophisticated effects adjustments. Most effects use 
advanced keyframes.

When an effect uses advanced keyframes, each keyframeable effect parameter has a separate 
keyframe track that opens to display a keyframe graph where you can set and customize keyframes. 
Keyframe tracks are also available for each parameter group, and for the entire effect. For more 
information on the three keyframe track types, see “Track Types for Advanced Keyframes” on 
page 82.

You can modify the keyframes for any single parameter independently from the keyframes for any 
other parameters. You can also modify the keyframes for various groups or combinations of 
parameters independently from the keyframes for any other parameters.
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Alternatively, you can create and modify keyframes that affect all parameters at once, in which case 
you are using advanced keyframes as if they were standard keyframes. This approach limits your 
flexibility, but it might provide all the control you need for simple effect adjustments. You might also 
prefer this approach if you have done most of your keyframing work in the past using standard 
keyframes, at least until you become more familiar with the capabilities of advanced keyframes.

The following illustration shows part of the Effect Editor display for a Center Box effect, one of the 
many effects that uses advanced keyframes. The illustration shows the three types of keyframe tracks 
and an open keyframe graph.

Top to bottom: effect track (gray), parameter group tracks (darker blue), parameter tracks (lighter blue), and an open 
keyframe graph

Standard Keyframes

Some effects use standard keyframes, which apply to every parameter in an effect. The Effect Editor 
does not include keyframe graphs or any other mechanism for manipulating keyframes, so you need 
to use the position bar of the Effect Preview monitor for such operations as adding, selecting, and 
moving keyframes. You still use the Effect Editor to make parameter adjustments that affect selected 
keyframes.

Media Composer always provides starting and ending keyframes when you create an effect that uses 
standard keyframes, and selects them by default. Any parameter changes are constant throughout the 
effect. Using techniques for adding, deleting, moving, selecting, and deselecting keyframes, you can 
begin to change the appearance and operation of the effect over time by applying parameter changes 
to specific keyframes.

Standard keyframe indicators appear as triangles in the position bar of the Effect Preview monitor 
when you select an effect and the Effect Editor is active. Before you make any keyframe changes to 
an effect, you see the default starting and ending keyframes at the ends of the position bar (both are 
pink, indicating that they are both selected).

Left to right: starting keyframe, Add Keyframe button, selected keyframe, and ending keyframe
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For more information, see “Working with Standard Keyframes” on page 119.

Track Types for Advanced Keyframes

Viewing Advanced Keyframe Graphs

You can open a keyframe graph for any effect parameter that is keyframeable. Once a keyframe graph 
is open, you can customize your view of the graph in a variety of ways.

n Parameters that are not keyframeable, such as the Fixed Aspect parameter, have tracks that do not 
show the parameter’s name, default keyframes, or time marks. You can drag the effect’s position 
indicator in these tracks, but you cannot add keyframes to them.

Showing and Hiding the Keyframe Graph Display

You can choose to either show or hide the keyframe graph display area in the Effect Editor. Keyframe 
graphs are hidden when the Effect Editor first opens, so you need to show the display area to view or 
adjust the graphs. You might find it helpful to hide the graphs again to simplify your view of the 
Effect Editor when you do not need to make graph adjustments. 

To show or hide the keyframe graph display:

t Click the Show/Hide Keyframe Graphs button in the bottom right corner of the Effect Editor.

The Show/Hide Keyframe Graphs button is highlighted when the keyframe graphs are visible.

Opening Keyframe Graphs

You open a keyframe graph by using the triangular opener to the left of the parameter track. 

Track Type Description

Effect track The keyframes in this track correspond to the keyframes in the Effect Preview monitor. 
When you select a keyframe in the effect track, the system automatically selects all of the 
keyframes at that point in time in the effect (all the keyframes directly under that 
keyframe in the Effect Editor). This makes it easy to move, delete, or perform other 
operations on many keyframes at the same time.

Parameter group track This track shows all the keyframes in the specific parameter group. When you select a 
keyframe in the parameter group track, the system automatically selects all the 
corresponding parameter keyframes in the group. Parameter groups can have subgroups. 
For example, the Border parameter for many effects has Color and Blend Color 
subgroups.

n Effect tracks and parameter group tracks provide similar functionality to the meta curve region available 
in Avid DS systems.

Parameter track This track shows the keyframes for the individual parameter. Parameter tracks are lighter 
in color than parameter group tracks. You can open individual parameter tracks to fine-
tune the parameter values in a keyframe graph.

n Advanced keyframe functions are available even when a keyframe graph is closed 
to show only the keyframe parameter track.
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n You do not have to open a keyframe graph to set and manipulate advanced keyframes. You can add 
and delete keyframes, customize keyframe interpolation options, and use the standard controls for 
each parameter to set the values for its keyframes while a keyframe graph is closed.

To open a keyframe graph:

t Click the triangular opener.

The keyframe parameter track opens to display a keyframe graph.

Triangular openers and keyframe graphs in the Effect Editor. When the triangular opener points down, the 
associated keyframe graph is open.

Understanding Keyframe Graphs

In keyframe graphs, the horizontal axis represents the length of the effect and the vertical axis 
represents the range of parameter values. The graph area itself is very dark grey.

In the default view, a keyframe graph shows the full length of the effect on the horizontal axis and the 
full range of parameter values on the vertical axis.

Example of a keyframe graph. The horizontal axis represents the length of the effect. The vertical axis represents the 
range of values for the parameter.

You can scale and scroll a keyframe graph both horizontally and vertically, for example to 
concentrate on one part of the effect’s length or one part of its parameter value range. When you do 
this, the boundaries of the keyframe graph might not be visible. For more information, see “Zooming 
Keyframe Graphs” on page 84 and “Scrolling Keyframe Graphs” on page 87.

The active keyframe graph is highlighted using a darker background. This lets you see which 
keyframe graph is active when multiple keyframe graphs are open. When you make another graph 
active, for example, by clicking a keyframe indicator in that graph, the background for that graph 
changes to the darker grey color.

In the following illustration, the Hue keyframe graph is active and is highlighted with a darker grey 
background.
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Resizing Keyframe Graphs

You can widen a keyframe graph or create space for expanding a keyframe graph vertically by 
resizing the Effect Editor window. You can expand or contract a keyframe graph vertically by 
dragging on the keyframe graph’s bottom border.

t Click a corner of the Effect Editor, and drag it to resize the window.

If you make the Effect Editor window wider, the keyframe track area and any open keyframe 
graphs also become wider. If you make the Effect Editor window taller, you create extra space 
within which you can expand keyframe graphs vertically.

To change the height of a keyframe graph:

1. Position the pointer over the bottom border of the keyframe graph that you want to change.

The pointer changes to a vertical resizing pointer.

2. Click the edge of the graph, and drag it up or down.

The height of the keyframe graph gets smaller or larger.

Before (left) and after (right) vertical resizing

Zooming Keyframe Graphs

You can zoom (or scale) advanced keyframe graphs in several ways:

• You can zoom keyframe graphs horizontally using the horizontal scale bar at the bottom of the 
Effect Editor.

The horizontal scale bar expands or contracts the view in the keyframe graphs centered around 
the position indicator. This lets you either zoom in to focus on a specific area of your keyframe 
graph or zoom out to display the entire keyframe graph.
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• You can zoom (or scale) any individual keyframe graph vertically using the graph’s vertical scale 
bar, located to the left of the graph.

The vertical scale bar expands or contracts the view in a keyframe graph. This lets you either 
zoom in to focus on a specific area of your keyframe graph or zoom out to display the entire 
keyframe graph. You can zoom out beyond the limits of the parameter value range.

• You can use the Zoom to Curve Height feature to quickly scale a graph so that its keyframe curve 
fills the available viewing area for the graph.

For more information, see “Using Zoom to Curve Height with Keyframe Graphs” on page 86.

Top to bottom: horizontal scale bar, vertical scale bar, and Zoom to Curve Height button in the Effect Editor

To zoom in or out horizontally on a keyframe graph:

t Drag the horizontal scale bar to the right (to zoom in) or to the left (to zoom out).

The view in the keyframe graph expands or contracts horizontally to show more or less detail.

Keyframe graph zoomed out (left) and zoomed in horizontally. In the zoomed in view, the graph shows detail of the 
middle of the effect’s length, and start and end keyframes are not visible.

To zoom in or out vertically on a keyframe graph:

t Drag the vertical scale bar down (to zoom in) or up (to zoom out).

The view in the keyframe graph expands or contracts to show a smaller or larger range of 
parameter values.

Keyframe graph at default vertical zoom (the graph shows the full range of parameter values)
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Keyframe graph zoomed in (left) and zoomed out vertically. The zoomed in view shows a reduced range of 
parameter values, and the zoomed out view shows an extended range of parameter values.

Using Zoom to Curve Height with Keyframe Graphs

The Zoom to Curve Height feature provides a quick way to focus on part of the keyframe graph.

Zoom to Curve Height centers the keyframe graph and scales the graph vertically so that the 
keyframe curve fills the available viewing area. This often makes it easier to read and manipulate 
graphs.

Keyframe graph before (left) and after (right) using Zoom to Curve Height

n If the curve passing through a selected keyframe uses the Bézier interpolation option, the scaling 
ensures that the Bézier handles for the keyframe are also visible in the viewing area.

Zoom to Curve Height also takes account of the horizontal zoom setting of the graph. If a graph is 
zoomed in horizontally on a small time range in an effect, for example, Zoom to Curve Height scales 
the curve vertically while maintaining the horizontal zoom. By combining horizontal zooming and 
the Zoom to Curve feature, you can quickly make a keyframe graph easier to work with, even when 
keyframes are very close together and their parameter values are similar.

Zoomed out keyframe graph before (keyframes are very hard to see or manipulate)

The same keyframe graph after horizontal zooming and scrolling (left) and after using Zoom to Curve Height. After 
horizontal zooming alone, the curve remains flat and hard to read. After using Zoom to Curve Height, the zoomed in part 
of the graph is easy to see and interpret, and keyframes are easy to adjust.
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To zoom on a keyframe graph so the keyframe curve fills the available viewing area, do one of 
the following:

t Click the Zoom to Curve Height button.

t Right-click the keyframe graph and select Zoom to Curve Height.

Scrolling Keyframe Graphs

You can scroll the view in a keyframe graph horizontally by using the scroll thumbwheel at the 
bottom of the Effect Editor.

You can scroll the view in a keyframe graph both horizontally and vertically by dragging directly in 
the keyframe graph.

To scroll the view in a keyframe graph horizontally:

t Drag the scroll thumbwheel to the left or to the right.

The view in the keyframe graph scrolls so that part of the view disappears on one side and more 
comes into view on the other side.

To scroll the view in a keyframe graph horizontally or vertically:

1. Alt+click (Windows) or Option+click (Macintosh) the keyframe graph.

The pointer changes to a hand.

2. Drag the hand to reposition the view within the keyframe graph.

Resetting Keyframe Graph Views

If you move the view in a keyframe graph so that you can no longer see the keyframes, you can use 
the shortcut menu to recenter the keyframes in the keyframe graph.

To reset the view in a keyframe graph:

t Right-click the keyframe graph, and select Reset All Graph Views.

The keyframes appear centered in the keyframe graph.

Manipulating Advanced Keyframes

You can manipulate advanced keyframes in a wide variety of ways. You can:

• Add or delete keyframes

• Add keyframes to the start and end frames of an effect

• Select or deselect keyframes

• Move keyframes

• Determine whether or not multiple keyframes move relative to one another

• Copy and paste keyframe parameters

• Control how effect parameters change at keyframes
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• Reverse the order in which keyframes are applied over time in an effect

• Control how keyframes adjust when you trim effects

• Control how effect parameters change at bracketing (start and end) keyframes

You can also determine whether your keyframe manipulations apply to a single effect parameter or to 
multiple parameters.

Understanding Advanced Keyframe Display

When you add a keyframe to a parameter, corresponding keyframe indicators appear in the effect 
track, in the parameter group track, and in the Effect Preview monitor. The following illustration 
shows the result after keyframes are added to the Position parameters H Pos and V Pos.

Top to bottom: keyframe in the effect track, keyframe in the parameter group track, new keyframes added to parameters 
in the Position group, new keyframe in the Effect Preview monitor’s position bar

You should be aware of the following aspects of advanced keyframe display:

• Keyframe indicators in the Effect Editor’s effect track or parameter group tracks are darker than 
those in individual parameter tracks, making it easier for you to distinguish between them.

• Keyframe indicators in parameter group tracks and in the effect track are linked to any keyframes 
that are beneath them in the parameter hierarchy. You can think of the keyframe indicators that 
appear in parameter group tracks and in the effect track as parent indicators, and the individual 
parameter keyframes beneath them as their children.

When you select a keyframe indicator in a parameter group track, any keyframes at that point in 
time for any individual parameters in that group are also selected and you can manipulate them 
together. When you select a keyframe indicator in the effect track, all keyframes at that point in 
time throughout the effect are also selected and you can manipulate them together.

Remember that a keyframe indicator in a parameter group track or in the effect track does not 
necessarily indicate that a keyframe exists at that point in time for every parameter in the group 
or in the effect. The keyframe indicator in the parameter group track or in the effect track might 
be the parent of one keyframe, or of several, or of a keyframe for every keyframeable parameter 
in the group or in the effect.
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• Keyframe indicators in the Effect Preview monitor’s position bar behave in the same way as 
keyframe indicators in the effect track of the Effect Editor. When you select a keyframe indicator 
in the Effect Preview monitor, the corresponding keyframe indicator in the effect track and all 
keyframes at that point in time in the effect are also selected.

• The Effect Editor displays controls for each parameter group even if you have not added 
keyframes for each parameter.

• You can adjust parameter values using the up arrow and the down arrow on your keyboard or by 
typing numerical values when a keyframe group is active.

• If you use the Deselect All Keyframes menu option, you can use the right arrow and left arrow to 
move the position indicator in the Effect Preview monitor. you can also use the default keyboard 
shortcuts for moving the position indicator (by pressing the 1, 2, 3, or 4 keys).

n Effect tracks and parameter group tracks provide similar functionality to the meta curve region 
available in Avid DS systems.

In some earlier versions of Avid editing applications, the system highlighted the keyframe in the 
Effect Preview monitor if you selected any keyframe in the associated column. Now the system 
highlights the keyframe in the Effect Preview monitor only if all the keyframes in the column are 
highlighted.

Adding Advanced Keyframes

You can add keyframes to any keyframeable parameters by using the following commands and 
buttons:

• The Add Keyframe command in the shortcut menu for the keyframe track.

• The Add Start and End Keyframes command in the shortcut menu for the keyframe track. This 
option is not available in the effect track for color correction effects, but you can apply it to the 
parameter group tracks and the parameter tracks for this effect.

• The Add Keyframe button in the Effect Editor.

• The Add Keyframe button in the Effect Preview monitor.

You can also add keyframes automatically by adjusting a parameter when you place the position 
indicator in a part of the keyframe graph that has no keyframe.

Depending on which method you use and how the Effect Editor is configured, you can add a 
keyframe to a single parameter, all the parameters in a group, every parameter in an effect, or any 
other custom combination of parameters.

You can use the Effect Editor shortcut menu to set a default Add Keyframe command that controls 
where keyframes are added when you use the Add Keyframe button in the Effect Editor or in the 
Effect Preview monitor. For more information, see “Shortcut Menu and Settings for the Effect 
Editor” on page 117.

n You cannot add keyframes to parameters that are not keyframeable (for example, the Fixed Aspect 
parameter). The graph area for these parameters does not display time marks, default keyframes, or 
the parameter name.
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To add a keyframe by using the shortcut menu for the keyframe track:

1. Move the position indicator to the point in the effect’s duration where you want to add a 
keyframe.

2. Right-click one of the following:

t The keyframe graph or the parameter track for an individual parameter, to add a keyframe to 
that parameter only.

t A parameter group track, to add a keyframe to every keyframeable parameter in that group.

The track displays the text “Apply to Group.”

t The effect track, to add a keyframe to every keyframeable parameter in the effect.

The track displays the text “Apply to All.”

3. Select Add Keyframe.

Active keyframe indicators appear at the position indicator in all appropriate tracks. For more 
information on where keyframe indicators appear, see “Understanding Advanced Keyframe 
Display” on page 88.

To add keyframes at the start and end of an effect:

1. Right-click one of the following:

t The keyframe graph or the parameter track for an individual parameter, to add start and end 
keyframes to that parameter only.

t A parameter group track, to add start and end keyframes to every keyframeable parameter in 
that group.

The track displays the text “Apply to Group.”

t The effect track, to add start and end keyframes to every keyframeable parameter in the 
effect.

The track displays the text “Apply to All.”

2. Select Add Start and End Keyframes.

Active keyframe indicators appear at the beginning and the end of the effect in all appropriate 
tracks. For more information on where keyframe indicators appear, see “Understanding 
Advanced Keyframe Display” on page 88.

To add a keyframe by using the Add Keyframe button in the Effect Editor:

1. Move the position indicator to the point where you want to add a keyframe.

2. In the Effect Editor, click the Add Keyframe button.

The Add Keyframe Mode menu opens.
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n If the Add Keyframe Mode menu does not appear, you need to select Show Add Keyframe Mode Menu 
in the Effect Editor shortcut menu or in the Effect Editor settings. For more information, see 
“Shortcut Menu and Settings for the Effect Editor” on page 117.

3. Do one of the following:

t Click the Add Keyframe button a second time to select the command that has a check mark 
next to it.

This is the default command for adding keyframes that you can set by using the Effect Editor 
settings or the Effect Editor shortcut menu. For more information, see “Shortcut Menu and 
Settings for the Effect Editor” on page 117.

t Select another command from the Add Keyframe Mode menu.

For more information on the command selections, see “Keyframe Mode Menu Commands” 
on page 93.

Active keyframe indicators appear at the position indicator in all appropriate tracks. For more 
information on where keyframe indicators appear, see “Understanding Advanced Keyframe 
Display” on page 88.

The command you select becomes the default command for adding keyframes and its Delete 
Keyframe equivalent becomes the default command for deleting keyframes. For more 
information, see “Shortcut Menu and Settings for the Effect Editor” on page 117.

To add a keyframe by using the Add Keyframe button in the Effect Preview monitor:

1. Move the position indicator to the point where you want to add a keyframe.

2. In the Effect Preview monitor, click the Add Keyframe button.

Media Composer adds one or more keyframes as determined by the current default command for 
adding keyframes in the Effect Editor shortcut menu. For more information on this default and 
how to change it, see “Shortcut Menu and Settings for the Effect Editor” on page 117.

Active keyframe indicators appear at the position indicator in all appropriate tracks. For more 
information on where keyframe indicators appear, see “Understanding Advanced Keyframe 
Display” on page 88.

To add a keyframe automatically:

1. With one or more keyframes displaying in the keyframe graph and all keyframes deselected, 
move the position indicator to the point where you want to add a keyframe.

2. In the Effect Editor, adjust the parameter you want to change.

Deleting Advanced Keyframes

You can delete advanced keyframes by selecting the keyframes you want to delete and then using one 
of the following:

• The Delete key.

• The Delete Keyframe command in the shortcut menu for the keyframe track.

• The Add Keyframe button in the Effect Editor.

• The Add Keyframe button in the Effect Preview monitor.
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To delete advanced keyframes by using the Delete key or the Delete Keyframe command in the 
shortcut menu for the keyframe track:

1. Click a keyframe indicator to activate it.

2. (Option) Ctrl+click additional keyframes in the same graph or in other graphs.

3. Do one of the following:

t Press the Delete key.

t Right-click the keyframe graph or keyframe track, and select Delete Keyframe.

Media Composer deletes the selected keyframes.

To delete advanced keyframes by using the Add Keyframe buttons:

1. Click a keyframe indicator to activate it.

2. (Option) Ctrl+click additional keyframes in the same graph or in other graphs.

3. Do one of the following:

t In the Effect Editor or in the Effect Preview monitor, press and hold the Alt key (Windows) 
or the Option key (Macintosh), and then click the Add Keyframe button.

Media Composer deletes any selected keyframes that are affected by the current default 
Delete Keyframe Mode menu command. For example, if Delete From Open Graphs is the 
current default, Media Composer deletes any selected keyframes in open keyframe graphs.

t In the Effect Editor, press and hold the Alt key (Windows) or the Option key (Macintosh), 
click the Add Keyframe button while still holding the Alt or Option key and pressing the 
mouse button, and then select a command from the Delete Keyframe Mode menu.

For more information on the Delete Keyframe Mode menu commands, see “Keyframe Mode 
Menu Commands” on page 93.

The command you select becomes the default command for deleting keyframes and its Add 
Keyframe equivalent becomes the default command for adding keyframes. For more 
information, see “Shortcut Menu and Settings for the Effect Editor” on page 117.

n If the Delete Keyframe Mode menu does not appear, you need to select Show Add Keyframe Mode 
Menu in the Effect Editor shortcut menu or in the Effect Editor settings.

Removing Redundant Keyframes

When you work with advanced keyframes, you sometimes accumulate redundant keyframes in your 
keyframe graphs. For example, if three or more keyframes lie on a straight line segment in the graph 
for a single parameter, only the first and last keyframes are necessary to define the parameter change, 
and the other keyframes are redundant.

You can remove redundant keyframes from either a single parameter graph, or from all the graphs in 
a parameter group, or from all the graphs in an effect.

You can also remove redundant keyframes for all effects in a sequence at one time. This is one good 
way to reduce the amount of memory required when working with a complex sequence.

To remove redundant keyframes:

1. Right-click one of the following:

t The effect track.

The track displays the text “Apply to All.”
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t A parameter group track.

The track displays the text “Apply to Group.”

t A parameter track.

t A keyframe graph.

2. Select Remove Redundant Keyframes.

Media Composer removes redundant keyframes from the range of keyframe graphs you 
specified in step 1.

To remove all redundant keyframes in a sequence:

1. (Option) If you want to keep a safe copy of your sequence with all of the existing keyframe data, 
duplicate the sequence.

For more information, see “Duplicating, Copying, and Moving Clips and Sequences” in the Help 
for Media Composer.

2. Select the sequence in a bin.

3. Right-click the sequence, and select Remove Redundant Keyframes.

A message box warns you that the sequence will be modified.

4. Click OK to remove all redundant keyframes in the sequence, or Cancel to take no action.

n When keyframes use the Bézier interpolation option, Media Composer might leave some keyframes 
that could be removed. This conservative behavior ensures that the Remove Redundant Keyframes 
command never removes needed keyframes.

Keyframe Mode Menu Commands

The Add Keyframe Mode and Delete Keyframe Mode menus provide commands that control how 
parameters are added or deleted when you use the Add Keyframe buttons in the Effect Editor or in 
the Effect Preview monitor. The same set of commands also appears in the Effect Editor shortcut 
menu.

When you select a command in one of these menus it becomes the default command when you add or 
delete keyframes using the Add Keyframe buttons. For more information, see “Shortcut Menu and 
Settings for the Effect Editor” on page 117.

The Add Keyframe Mode and Delete Keyframe Mode menus mirror one another. When you change 
one, a corresponding change happens in the other.

n Several of the menu command names include the word “group.” In these names, “group” refers to a 
parameter category.

The default command for adding and deleting keyframes applies to the keyframes in the Effect 
Preview monitor’s position bar just as it does to keyframes in the Effect Editor. For example, if “Add 
Keyframes to Open Groups” is the default command but no groups are open in the Effect Editor, you 
cannot add any keyframes to the Effect Preview monitor’s position bar. In this case, open a group in 
the Effect Editor before you add keyframes or change the command for adding and deleting 
keyframes.
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Add Keyframe Mode and Delete Keyframe Mode Menu Commands

Command Description

Add to Active Parameter
(Add Keyframe Mode menu)

Delete From Active Parameter
(Delete Keyframe Mode menu)

Add Keyframes to Active Parameter
(Effect Editor shortcut menu)

Adds a keyframe to or removes selected keyframes from the 
parameter track or keyframe graph for the active parameter 
only.

The active parameter is the parameter that is currently 
selected, for example, a slider that you clicked is 
highlighted.

Corresponding keyframes appear in or are removed from the 
relevant parameter group track and the effect track.

Active parameter (left) and keyframes added when you use the Add to Active Parameter command (right)

Add to Active Group
(Add Keyframe Mode menu)

Delete From Active Group
(Delete Keyframe Mode menu)

Add Keyframes to Active Group
(Effect Editor shortcut menu)

Adds keyframes to or removes selected keyframes from the 
parameter tracks or keyframe graphs of all parameters that 
are in the same parameter category as the active parameter. If 
the category containing the active parameter is a subcategory 
of a larger category (for example, Color is a subcategory of 
Border), keyframes appear only in the subcategory and not 
in the larger category.

The active parameter is the parameter that is currently 
selected, for example, a slider that you clicked is 
highlighted.

Corresponding keyframes appear in or are removed from the 
parameter group track and the effect track.

Active group (left, containing the active parameter) and keyframes added when you use the Add to Active Group 
command (right). In this case, the Hue, Sat, and Lum parameters each have a new keyframe.
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Add to Open Groups
(Add Keyframe Mode menu)

Delete From Open Groups
(Delete Keyframe Mode menu)

Add Keyframes to Open Groups
(Effect Editor shortcut menu)

Adds keyframes to or removes selected keyframes from the 
parameter tracks or keyframe graphs of all parameters in 
groups that are currently open, whether or not the group is 
enabled.

Corresponding keyframes appear in or are removed from the 
relevant parameter group tracks and the effect track.

Keyframes added when you use the Add to Open Groups command. Media Composer adds new keyframes to all 
parameters in open groups, even if the keyframe tracks are closed.

Add to Enabled Groups
(Add Keyframe Mode menu)

Delete From Enabled Groups
(Delete Keyframe Mode menu)

Add Keyframes to Enabled Groups
(Effect Editor shortcut menu)

Adds keyframes to or removes selected keyframes from the 
parameter tracks or keyframe graphs of all parameters in 
groups that are currently enabled, whether or not the group is 
open.

Corresponding keyframes appear in all parameter group 
tracks and the effect track.

Add Keyframe Mode and Delete Keyframe Mode Menu Commands(Continued)

Command Description
95



Manipulating Advanced Keyframes
Selecting and Deselecting Advanced Keyframes

You can select one or more keyframes at any level of the keyframe track hierarchy — open keyframe 
graphs, parameter tracks, parameter group tracks, or the effect track. When you select keyframes in 
parameter group tracks or in the effect track, you also select all the keyframes in the group or in the 
effect at that point in time.

Add to Open Graphs
(Add Keyframe Mode menu)

Delete From Open Graphs
(Delete Keyframe Mode menu)

Add Keyframes to Open Graphs
(Effect Editor shortcut menu)

Adds keyframes to or removes selected keyframes from all 
open keyframe graphs, whether or not the group is enabled.

This command lets you add or delete keyframes from any 
custom grouping of parameters. Open the keyframe graph 
for each parameter, and then use the command.

Corresponding keyframes appear in or are removed from the 
relevant parameter group tracks and the effect track.

Keyframes added when you use the Add to Open Graphs command. Media Composer adds new keyframes to any 
parameters whose keyframe graphs are open, to the group tracks that contain these parameters, and to the effect track.

Add to All Parameters
(Add Keyframe Mode menu)

Delete From All Parameters
(Delete Keyframe Mode menu)

Add Keyframes to All Parameters
(Effect Editor shortcut menu)

Adds keyframes to or deletes selected keyframes from the 
keyframe tracks or keyframe graphs for every keyframeable 
parameter in the effect.

Corresponding keyframes appear in all parameter group 
tracks and the effect track.

Choose this option if you want advanced keyframes to 
behave in the same way as standard keyframes.

Add Keyframe Mode and Delete Keyframe Mode Menu Commands(Continued)

Command Description
96



Manipulating Advanced Keyframes
To select a keyframe:

t Click the keyframe.

The keyframe changes to pink.

To select more than one keyframe:

1. Click the first keyframe that you want to select.

The keyframe changes to pink.

2. Ctrl+click each additional keyframe.

Each keyframe changes to pink.

n In some earlier versions of Avid editing applications, you could single-click a keyframe in a different 
parameter group to select it. Now you must Ctrl+click the keyframe in a different group if you want to 
add it to a multiple-keyframe selection.

When you select more than one keyframe in a single keyframe track, Media Composer uses the most 
recently selected one as the reference keyframe for aligning and slipping keyframes. In addition, 
there are special considerations when you align keyframes in a track with both selected keyframes 
and deselected keyframes. See “Aligning Advanced Keyframes” on page 101.

To select all keyframes in a track:

t Right-click a parameter track, parameter group track, or effect track, and select Select All 
Keyframes.

To deselect a keyframe:

t Ctrl+click the keyframe.

To deselect all keyframes but one in a track:

t Click the keyframe you want to remain selected.

The keyframe indicator you click changes to pink. All other keyframes in the track appear gray 
and are deselected.

To deselect all keyframes in a track, do one of the following:

t With a parameter enabled (for example, the slider for the parameter is highlighted), select Edit > 
Deselect All Keyframes.

All keyframes in the enabled parameter’s parameter track are deselected.

t Right-click a parameter track, a parameter group track, or the effect track, and select Deselect 
All Keyframes.

When you right-click a parameter group track, Media Composer displays the text “Apply to 
Group” in the parameter group track, as shown in the following illustration.

All keyframes for the parameter, group, or entire effect are deselected and the top parameter 
group in the Effect Editor becomes active. This allows you to navigate your footage in the Effect 
Preview monitor using the standard keyboard shortcuts for moving through footage.
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Moving Advanced Keyframes

You can move an advanced keyframe to another location in the keyframe graph.

This topic describes methods for moving keyframes by dragging in the Effect Editor or in the Effect 
Preview monitor. You can also move keyframes to the location of the position indicator by using 
commands on the shortcut menu for the keyframe track. For more information, see “Understanding 
the Align Keyframes and Slip Keyframes Commands” on page 100.

For additional information, see “Considerations When Moving Advanced Keyframes” on page 99.

To move a single keyframe, do one of the following:

t Drag the keyframe up or down in the keyframe graph to change its parameter value without 
changing its position in time.

t Alt+Shift+drag (Windows) or Option+Shift+drag (Macintosh) the keyframe horizontally to 
change its position in time without changing its parameter value.

t Alt+drag (Windows) or Option+drag (Macintosh) the keyframe to move it freely both vertically 
and horizontally and so change both its parameter value and its position in time.

To move multiple keyframes:

1. Click one of the keyframes to select it.

2. Ctrl+click additional keyframes to add them to the selection.

3. Do one of the following:

t Drag one of the keyframes up or down in the keyframe graph to change the parameter value 
of all the keyframes by the same relative amount without changing their positions in time.

With two keyframes selected in a parameter, drag one of the keyframes to move both vertically

t Press the Alt key (Windows) or the Option key (Macintosh) and then drag one of the 
keyframes.

When you Alt+drag (Windows) or Option+drag (Macintosh) multiple keyframes in an open 
keyframe graph, you can move the keyframe you are dragging both vertically and 
horizontally. The rest of the keyframes move horizontally (in time) but do not 
move vertically.
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With two keyframes selected in a parameter, Alt-drag (or Option-drag) the top keyframe. The keyframe you 
drag moves in both time and value. The second keyframe moves in time only.

Considerations When Moving Advanced Keyframes

You should be aware of the following when you are moving advanced keyframes:

• You can move keyframes by dragging at all levels of the keyframe track hierarchy — open 
keyframe graphs, parameter tracks, parameter group tracks, and the effect track. However, only 
open keyframe graphs let you move keyframes vertically and so change their parameter values.

• When you move keyframe indicators in a parameter group track or the effect track, you move all 
keyframes at that point in time in the parameter group or in the entire effect.

• You can move a keyframe outside the time boundaries of the keyframe graph, so that the effect 
behaves as if parameter values are changing before the beginning or after the end of the effect. 
This works only for the time at which a keyframe occurs; you cannot move a keyframe to a 
parameter value outside the maximum or minimum value for the parameter.

Before (left) and after (right) moving a keyframe outside of the effect’s time boundaries — in this case, to a position 
before the beginning of the effect

You can also move keyframes outside the time boundaries by using the Align Keyframes and 
Slip Keyframes commands. For more information, see “Understanding the Align Keyframes and 
Slip Keyframes Commands” on page 100.

• If you drag a keyframe for a parameter out of a column containing many keyframes, the system 
creates new keyframes on the effect track, on the corresponding parameter group track, and in 
the Effect Preview monitor.

The following illustration shows an example of what happens when one of the keyframes is 
dragged out of the column. In this example, the keyframe in the Sat parameter has been dragged 
to the left out of the column of keyframes at the location of the position indicator. New keyframe 
indicators appear in the effect track, in the Effect Preview monitor’s position bar, in the 
parameter group track, and in the group track for the Color parameter subcategory.
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• You cannot move a keyframe past another keyframe. Keyframe movement is bounded by 
neighboring keyframes.

• If two or more effects are shown in the Effect Editor, only the top effect is editable. This means 
that if you have nested effects, you can move the keyframes in only one effect at a time.

Understanding the Align Keyframes and Slip Keyframes Commands

The Align Keyframes and Slip Keyframes commands in the shortcut menu for the keyframe track lets 
you move keyframes to the location of the position indicator.

• Align Keyframes moves the selected keyframe to the position indicator. The other keyframes in 
the keyframe track do not move.

• Slip Keyframes moves all the keyframes of the parameter so the selected keyframe aligns with 
the position indicator, and the rest of the keyframes maintain their relative location.

You do not have to select a keyframe from an open keyframe graph to use Align Keyframes and Slip 
Keyframes. You can select keyframes in any keyframe track.

n Disabling Set Position To Keyframe can make it easier for you to use Align Keyframes and Slip 
Keyframes. See “Shortcut Menu and Settings for the Effect Editor” on page 117.

You can use Align Keyframes and Slip Keyframes within a single keyframe track by selecting a 
single active keyframe. You can also use Align Keyframes and Slip Keyframes to bring several 
parameters into alignment, by selecting an active keyframe in more than one parameter and then 
choosing where you invoke the shortcut menu. See “Selecting and Deselecting Advanced 
Keyframes” on page 96.

When you select more than one keyframe in a single keyframe track, Media Composer uses the most 
recently selected one as the reference keyframe for aligning and slipping keyframes. In addition, 
there are special considerations when you align keyframes in a track with both selected keyframes 
and deselected keyframes. See “Aligning Advanced Keyframes” on page 101.
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Both Align Keyframes and Slip Keyframes can move keyframes outside the time boundaries of the 
keyframe graph. This lets you make the effect behave as if parameter values are changing before the 
beginning or after the end of the effect.

Aligning Advanced Keyframes

In the procedure below, the reference keyframe of any keyframe graph is the keyframe you activated 
most recently in that keyframe graph.

To align the reference keyframe to the position indicator:

t Right-click an open keyframe graph, a parameter track, a parameter group track, or the effect 
track, and select Align Keyframes.

The reference keyframe moves to the position indicator. If the reference keyframe is in a 
parameter group track or in the effect track, all the keyframes at that point in time in the 
parameter group or in the entire effect move to the position indicator.

n Align Keyframes does not move the reference keyframe beyond an intervening keyframe (a keyframe 
between the reference keyframe and the position indicator). If there is an intervening keyframe, the 
reference keyframe moves to within one frame or field of it.

Before (left) and after (right) aligning a keyframe to the position indicator (no intervening keyframes)

Before (left) and after (right) aligning a keyframe to the position indicator. In this example, an intervening keyframe 
limits the movement of the selected keyframe.

Align Keyframes exhibits more complex behavior when you have multiple keyframes selected in 
one keyframe graph.

If you select all keyframes in one keyframe graph, Align Keyframes is equivalent to Slip 
Keyframes. The reference keyframe moves to the position indicator, and all other keyframes 
maintain their position relative to the reference keyframe.

Deselected (gray) keyframes do not move. All selected keyframes move as close to the target 
position as possible unless a deselected keyframe intervenes.

The following illustrations shows several examples (the second keyframe is the reference 
keyframe in all cases).
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Before (left) and after (right) aligning keyframes with all keyframes selected. The reference keyframe moves to the 
position indicator and all other keyframes move to maintain their positions relative to the reference keyframe.

Before (left) and after (right) aligning keyframes with one deselected keyframe. The reference keyframe moves to 
the position indicator, other selected keyframes move to maintain their position relative to the reference keyframe, 
but the deselected keyframe does not move.

Before (left) and after (right) aligning keyframes with two deselected keyframes. The reference keyframe moves to 
the position indicator, the other selected keyframe moves to maintain its position relative to the reference keyframe, 
but the deselected keyframes do not move.

Slipping Advanced Keyframes

In the following procedure, the reference keyframe of any keyframe track is the keyframe you 
activated most recently in that keyframe track.

To slip keyframes to the position indicator, in one keyframe track:

t Right-click an open keyframe graph, a parameter track, a parameter group track, or the effect 
track, and select Slip Keyframes.

All the keyframes move so that the reference keyframe aligns with the position indicator, and the 
other keyframes maintain their position relative to the reference keyframe. If the reference 
keyframe is in a parameter group track or in the effect track, all the keyframes at that point in 
time in the parameter group or in the entire effect move to the position indicator, and the other 
keyframes in the same parameters maintain their position relative to the reference keyframe.

Before (left) and after (right) slipping keyframes. The reference keyframe moves to the position indicator and other 
keyframes move relative to the reference keyframe.
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Copying and Pasting Advanced Keyframe Parameters

You have several options for copying and pasting advanced keyframe parameters. You can:

• Copy and paste selected keyframes in a single parameter.

• Copy and paste selected keyframes in more than one parameter.

The selected keyframes can be in graphs or on tracks (that is, the graphs that contain the selected 
keyframes can be open or closed). If the selected keyframes are offset from one another, the 
pasted keyframes preserve the offset.

• Copy and paste all graph values at a specific position.

This option is available both in the position bar of the Effect Preview monitor and in the 
keyframe graphs in the Effect Editor.

This option does not require a keyframe in any parameter at the location you are copying from. 
Media Composer takes all the parameter values at the copying location and uses them to create 
new keyframes (or replace existing ones) at the pasting location.

For illustrated examples of these options, see “Examples of Copy and Paste Operations on Advanced 
Keyframe Parameters” on page 104.

To copy and paste an advanced keyframe in a single keyframe graph or track:

1. Click the keyframe you want to copy.

2. Select Edit > Copy, or press Ctrl+C (Windows) or Command+C (Macintosh).

3. Do one of the following:

t Move the position indicator to the location where you want to paste.

t Click a keyframe to select it.

t Ctrl+click (Windows) or Command+click (Macintosh) multiple keyframes to select them.

4. Select Edit > Paste, or press Ctrl+V (Windows) or Command+V (Macintosh).

Media Composer pastes the parameters from the keyframe that you copy to the keyframes that 
you select, or creates a new keyframe using the parameters that you copy at the location of the 
position indicator.

To copy and paste multiple selected advanced keyframes:

1. Ctrl+click (Windows) or Command+click (Macintosh) multiple keyframes to select them.

You can select multiple keyframes within a single parameter or across several parameters.

2. Select Edit > Copy, or press Ctrl+C (Windows) or Command+C (Macintosh).

3. Do one of the following:

t Move the position indicator to the location where you want to paste.

t Click a keyframe to select it and move the position indicator to that location.

4. Select Edit > Paste, or press Ctrl+V (Windows) or Command+V (Macintosh).

Media Composer pastes the keyframes that you copy to the location that you select. When the 
keyframes you copy are offset from one another, Media Composer pastes the leftmost keyframe 
at the location that you select and pastes the other keyframes in locations that preserve the 
original offset.
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To copy and paste all parameter values at a position:

1. Do one of the following, either in the position bar below the Effect Preview monitor, or in the 
keyframe graphs in the Effect Editor:

t Move the position indicator to the location from which you want to copy values.

t Click a keyframe at the location from which you want to copy values.

2. Do one of the following:

t If you are working in the position bar of the Effect Preview monitor, select Edit > Copy, or 
press Ctrl+C (Windows) or Command+C (Macintosh).

t If you are working in the keyframe graphs in the Effect Editor, right-click in the graph area 
and select Copy All Values at Position, or press Ctrl+Alt+C (Windows) or 
Command+Option+C (Macintosh).

3. Do one of the following:

t Move the position indicator to the location where you want to paste values.

t Click a keyframe to select it and move the position indicator to the location where you want 
to paste values.

4. Select Edit > Paste, or press Ctrl+V (Windows) or Command+V (Macintosh).

Media Composer creates new keyframes at the pasting location, or modifies existing keyframes. 
As a result of this procedure, every keyframe graph in the effect has a keyframe at the pasting 
location with its parameter value set to the value for that parameter at the copying location.

Examples of Copy and Paste Operations on Advanced Keyframe Parameters

The following illustrations show the effects of the various copy and paste operations that you can 
perform on advanced keyframe parameters. For more information and step-by-step instructions for 
copying and pasting advanced keyframe parameters, see “Copying and Pasting Advanced Keyframe 
Parameters” on page 103.

Copying and Pasting Keyframes in a Single Parameter

Before (left) and after (right) copying and pasting a keyframe in a single parameter. Notice the difference in behavior 
between the top and bottom graphs in the example. The top graph is not active and the keyframe is not selected, so the 
keyframe is not copied even though it is at the same point in time as the selected keyframe in the bottom graph. The 
bottom graph is active and its keyframe is selected, so it is copied to the new location of the position indicator on the 
right.
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Before (left) and after (right) copying and pasting multiple keyframes in a single parameter. Their offset from one another 
is preserved in the new copies.

Copying and Pasting Keyframes in Multiple Parameters

Before (left) and after (right) copying and pasting keyframes that you select in multiple keyframe graphs. Media 
Composer pastes the leftmost selected keyframe at the new location of the position indicator, and preserves the offset of 
other keyframes from the leftmost one.

Copying and Pasting All Parameter Values at a Position

Before (left) and after (right) copying and pasting all parameter values at a position. In this example, a keyframe exists for 
one parameter at the copying location, but no keyframes exist for the other parameters. Media Composer uses the 
parameter values for each parameter at the copying location, regardless of whether a keyframe already exists, and 
creates new keyframes with those values at the pasting location. Any other parameters for the effect also get a new 
keyframe at the pasting location, even if (as in the top Level graph here) the new keyframe uses default values. If 
necessary, you can delete any redundant keyframes that this process creates using the Remove Redundant Keyframes 
command.
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Before (left) and after (right) copying and pasting all parameter values at a position.  In this example there are no existing 
keyframes at the copying location. Media Composer uses the parameter values at the copying location to create new 
keyframes with those values at the pasting location.

Controlling Parameter Changes at Keyframes

The keyframe interpolation options control how an effect parameter changes at a keyframe. 
Interpolation refers to the method Media Composer uses to calculate the rate of change and the 
relative smoothness of change. Keyframes use linear interpolation by default, but you can change this 
by selecting a different option.

To select an interpolation option:

t Right-click the keyframe graph or keyframe track for the parameter with which you are working, 
and select one of the following:

- Shelf

- Linear

- Spline

- Bézier

For information on these options, see “Advanced Keyframe Interpolation Options” on page 106.

Advanced Keyframe Interpolation Options

The following table describes the interpolation options available for advanced keyframes.
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Advanced Keyframe Interpolation Options

Interpolation 
Option Description

Shelf The parameter value does not change between keyframes and then changes abruptly to the new 
value. Some applications call this Hold.

Use Shelf to hold a parameter value for a fixed length of time. For example, you can use Shelf 
with the Position parameters to create a Picture-in-Picture that appears to “pop” to a new 
location at each keyframe.

Linear The parameter value ramps smoothly between keyframes but then changes abruptly at each 
keyframe. The change in parameter value at a keyframe happens with no ease-in or ease-out.

New keyframes use the linear interpolation option by default. You can change this by selecting 
a different option.

n Effects with standard keyframes always make linear parameter changes (with the 
exception of Spline for motion paths and Acceleration for other parameters). With 
advanced keyframes, you can use the Linear interpolation option for some parameters 
and not for others, depending on the effect you want to achieve.

Spline The parameter value changes smoothly at each keyframe, creating a simple ease-in or ease-out 
effect. Spline is sometimes called Natural Spline or Cardinal Spline because the line 
representing the parameter value always goes precisely through each keyframe.

With two keyframes, the parameter value changes slowly at the beginning of the effect, speeds 
up the rate of change, and then slows down to come to rest gently at the end of the effect. Use 
three keyframes to create an arc.

Use the Spline interpolation option (or the Bézier interpolation option) for any parameter for 
which you want to avoid abrupt changes, such as Scaling or Border width.
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Adjusting Parameter Values in the Effect Editor

Adjusting parameter values when using advanced keyframes works as it does with other effects. You 
can modify parameter values using the parameter sliders or you can enter numeric information using 
the keyboard to modify the active parameter. You can also change the values for the active parameter 
using one of the keyboard shortcuts. For more information, see “Changing a Parameter with a Slider 
in the Effect Editor” on page 73.

If you use the Deselect All Keyframes menu option, you cannot modify parameter values using 
keyboard shortcuts. With no active parameters, the keyboard shortcuts move the position indicator in 
the Effect Preview monitor.

n If you right-click on a parameter group that is not the active group and select Deselect All 
Keyframes, keyframes are deselected but the active parameter group remains active. In this instance, 
you cannot use the shortcut keys to navigate footage in the Effect Preview monitor because the 
shortcut keys modify the parameter values for the active parameter group.

Bézier The Bézier interpolation option is similar to the Spline interpolation option because the 
parameter value changes smoothly at each keyframe. The Bézier interpolation option also 
provides direction handles at each keyframe. You adjust the rate at which the parameter value 
changes by manipulating the direction handles.

When you click a direction handle and drag it, you change the height and angle of the curve. 
The curve responds as if you were gently tugging it like a piece of string. The curve remains 
anchored to the keyframes on either side of the active keyframe.

You have several options for how you manipulate Bézier direction handles. For more 
information, see “Adjusting Parameter Values with the Bézier Interpolation Option” on 
page 109.

Use the Bézier interpolation option (or the Spline interpolation option) for any parameter for 
which you want to avoid abrupt changes.

Advanced Keyframe Interpolation Options(Continued)

Interpolation 
Option Description
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Adjusting Parameter Values with the Bézier Interpolation Option

You can adjust Bézier curves in the following ways:

• Symmetrically: Dragging a direction handle changes the length and rotation of both direction 
handles symmetrically.

Before (left) and after (right) dragging symmetrically. Dragging the left handle up and to the left causes both sides to 
rotate and increase in length.

• Asymmetrically: Dragging a direction handle changes the length of the selected handle, but not 
the opposite handle. The rotation of both handles changes as you drag the selected handle.

Before (left) and after (right) dragging asymmetrically. Dragging the left handle up and to the left causes the left side 
to rotate and increase in length. The right side rotates but does not change in length.

• Independently: Dragging a direction handle changes both the length and rotation of the selected 
handle. The opposite handle does not change. You do this by “breaking” the handle.

Before (left) and after (right) dragging independently. The image in the center shows dragging with no rotation — 
dragging the left handle to the left causes only the left side to increase in length. The image on the right shows 
dragging and rotating — dragging the left handle up and to the left causes only the left side to rotate and increase in 
length. In both cases, the right side of the curve does not change.

The default adjustment method is symmetrical. You change the adjustment method using the Alt key 
(Windows) or Option key (Macintosh). 

To use the Bézier interpolation option for adjusting a parameter value:

1. Select the Bézier interpolation option. 

For more information, see “Controlling Parameter Changes at Keyframes” on page 106.

2. Click a keyframe indicator to activate it.

The keyframe indicator changes to pink, and a direction bar with direction handles appears.

3. Position the pointer over one of the direction handles.

The pointer changes to a hand pointer.

4. Do one of the following:

t Drag the mouse to move the direction handle.
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Media Composer uses the currently active adjustment option. The direction bar and the 
curve change to show the new interpolation motion.

t Alt+click (Windows) or Option+click (Macintosh) the direction handle, and then drag the 
mouse to move the direction handle.

The use of the modifier key instructs Media Composer to use the next adjustment method in 
the sequence of adjustment options: symmetrical, asymmetrical, or independent. 

For example, suppose you make an adjustment using independent direction handles, and 
then move the cursor away from the keyframe. To continue using independent direction 
handles, click the direction handle and make further adjustments. To change the adjustment 
method from independent to symmetrical, Alt+click (Windows) or Option+click 
(Macintosh) the direction handle.

5. Continue adjusting the direction handles to achieve the effect you want.

Reversing Advanced Keyframes

You can use the Reverse Keyframes command in the shortcut menu for the keyframe track to reverse 
the keyframes in time for an individual parameter, a parameter group, or an entire effect.

The Reverse Keyframes command is an enhanced version of the Reverse Animation command in the 
standard keyframe interface.

You should be aware of the following when working with the Reverse Keyframes command:

• Reverse Keyframes does not affect keyframe parameter values. It changes only the position of 
keyframes in time.

• Reverse Keyframes always applies to the entire effect duration. You cannot reverse the 
keyframes for a portion of the effect duration. 

• If the effect is a transition effect that contains a Swap Sources button, Media Composer 
automatically enables the Swap Sources button when you reverse the keyframes on the entire 
effect. This maintains the shot continuity while reversing the movement.

To reverse keyframes in time:

t Right-click an open keyframe graph, a parameter track, a parameter group track, or the effect 
track, and select Reverse Keyframes.

Media Composer reverses the appropriate keyframes in time:

- For an open keyframe graph or a single parameter track, the keyframes are reversed for that 
parameter.

- For a parameter group track, keyframes are reversed for all parameters in the group. The 
parameter group track displays the text “Apply to Group” when you right-click the track.

- For the effect track, keyframes are reversed for all parameters in the entire effect. The 
parameter group track displays the text “Apply to All” when you right-click the track.

Controlling Advanced Keyframe Behavior with Trimmed Effects

You can use the Elastic and Fixed commands in the shortcut menu for the keyframe track to control 
how advanced keyframes adjust when you change the length of an effect by trimming.
110



Manipulating Advanced Keyframes
When you use the Elastic option, Media Composer scales the keyframes to fit the new duration. For 
example, if you trim out the start of a keyframed 2-second effect segment so that its length increases 
to 3 seconds, the gap between each of the keyframes increases by 50% and the original animation 
takes place over 3 seconds. Elastic is the default behavior for a parameter, and is also the behavior for 
standard keyframes.

The keyframe indicator for an elastic keyframe is a simple triangle, as shown in the following 
illustration.

When you use the Fixed option, Media Composer leaves the existing duration of your keyframe 
animation intact. For example, if you trim out the start of a keyframed 2-second effect segment so 
that its length increases to 3 seconds, the original animation still takes places over 2 seconds at the 
end of the segment. The one second of material you have added uses the parameter values of the first 
keyframe, so no movement or other change takes place until the first keyframe is reached. Fixed 
keyframes let you “pin” a parameter change to a particular timecode.

The keyframe indicator for a fixed keyframe has a mark or tail on its bottom edge, as shown in the 
following illustration.

n You can select elastic keyframes or fixed keyframes for each parameter of an effect, so some 
parameters can have elastic keyframes while other parameters have fixed keyframes.

All keyframes for a parameter are either elastic or fixed. You cannot mix elastic keyframes and fixed 
keyframes within a single parameter.

The following illustrations show an example of the difference between elastic and fixed keyframes.

Two-second clip with four keyframes

The same clip, trimmed out to add 1 second at the head (shaded area) and using elastic keyframes. The time between 
keyframes stretches.

The same clip, trimmed out to add 1 second at the head (shaded area) and using fixed keyframes. The timing of events 
does not change.

02:00 02:18 03:04 03:29

01:00 01:27 02:21 03:2901:00

01:00 02:00 02:18 03:04 03:29
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Selecting Elastic Keyframes or Fixed Keyframes

To select elastic keyframes or fixed keyframes:

t Right-click the keyframe graph, parameter track, or parameter group track whose keyframes you 
want to affect, and select Fixed or Elastic.

The keyframes for the parameter or parameter group change to the selected keyframe type and 
the keyframe indicators for the parameter display the selected keyframe type. All subsequent 
keyframes you add to this parameter appear as the selected keyframe type.

Controlling Parameter Changes Outside First and Last Keyframes

Effects that use standard keyframes always have a starting keyframe and an ending keyframe that are 
fixed at the start of the effect and the end of the effect. You cannot move or delete the starting 
keyframe and the ending keyframe.

Effects that use advanced keyframes do not require a starting keyframe or an ending keyframe, so 
you can move or delete them.

In a keyframe graph, the first keyframe and the last keyframe are the bracketing keyframes for the 
parameter. Media Composer determines parameter values beyond the bracketing keyframes using 
either Extrapolate or Hold. 

When Extrapolate is enabled, Media Composer extrapolates — that is, estimates more values for — 
the parameter values at the start and end of an effect using the values at the bracketing keyframes. 
Parameter values continue to change over time. Media Composer calculates new values using the 
interpolation option in effect for that parameter.

Parameter values change before and after the bracketing (start and end) keyframes

In the previous illustration, the blue lines represent the parameter value before and after the 
bracketing keyframes and show the extrapolation of the parameter value.

For example, if the parameter value between the last two keyframes increases as the end of the effect 
approaches, the parameter value continues to increase until the end of the effect. Similarly, if the first 
keyframe is not at the very beginning of the clip, Media Composer extrapolates the parameter value 
from the start of the effect up to the first keyframe.

When Hold is enabled, Media Composer uses only the parameter values at the bracketing keyframes 
to set values at the start and end of the effect. The parameter values stay the same from the start of the 
effect to the first keyframe, and again from the last keyframe to the end of the effect.
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Parameter values hold steady before and after the bracketing (start and end) keyframes

In the previous illustration, the horizontal lines indicate the parameter value before the first keyframe 
and after the last keyframe.

Extrapolate and Hold are useful any time you slip keyframes or align keyframes in such a way that a 
bracketing keyframe falls within the effect, or if you are using fixed keyframes for a parameter and 
you trim the effect in or out so that a bracketing keyframe falls within the effect.

n The Extrapolate or Hold setting remains in effect if you trim the effect in or out.

In either case, you do not have an explicitly defined value outside the bracketing keyframes. 
Extrapolate and Hold can save you the trouble of individually setting new values for each parameter 
whenever you make changes to the position of keyframes or the length of the effect.

Keyframe graph before Slip Keyframes — bracketing keyframes included

When you select Extrapolate, Media Composer estimates more values for the parameter before and 
after the bracketing keyframes using the values at the bracketing keyframes. Parameter values 
continue to change over time. Media Composer calculates new values using the interpolation option 
in effect for that parameter.

Keyframe graph after Slip Keyframes with Extrapolate enabled, The parameter value changes before the bracketing 
keyframe.

When you select Hold, Media Composer uses only the parameter values at the bracketing keyframes 
to set values before and after the bracketing keyframes. The parameter values are the same from the 
start of the effect to the first keyframe, and again from the last keyframe to the end of the effect.

Keyframe graph after Slip Keyframes with Hold enabled, The parameter value does not change before the bracketing 
keyframe.
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n As a result of slipping the keyframes in the previous examples, the last keyframe indicator moves out 
of the keyframe graph view but is still present and is still the bracketing keyframe. The keyframe 
indicator visible at the right edge of the keyframe graph (the third keyframe indicator) is not a 
bracketing keyframe. Therefore, the parameter values in effect from the third keyframe to the end of 
the effect are calculated along the curve between the third keyframe and the last (bracketing) 
keyframe.

You set Extrapolate and Hold independently for each parameter in an effect. The default condition is 
Hold.

Setting Extrapolate or Hold for an Effect Parameter

To set Extrapolate or Hold for a parameter:

t Right-click the keyframe track, and select Extrapolate or Hold.

The display changes to reflect the new setting.

Controls and Settings for Advanced Keyframes

This topic provides reference information for the following parts of the advanced keyframes user 
interface:

• Effect Editor controls that are specific to advanced keyframes.

• The shortcut menu for the keyframe track.

• The Effect Editor shortcut menu and the Effect Editor Settings dialog box.

You use commands in the Effect Editor shortcut menu or settings in the Effect Editor Settings 
dialog box to control certain aspects of advanced keyframe behavior, such as whether start and 
end keyframes are automatically added to parameters.

Effect Editor Controls for Advanced Keyframes

The toolbar at the bottom of the Effect Editor includes specific controls for advanced keyframes.

The following table describes the Effect Editor toolbar controls for advanced keyframes. For 
information on the buttons on the left side of the toolbar, see “Effect Editor Controls” on page 69.

Control Description

Go to Previous 
Event

Moves the position indicator one keyframe to the left and 
activates the keyframe. If there is no keyframe to the left, the 
position indicator does not move.

Go to Next 
Event

Moves the position indicator one keyframe to the right and 
activates the keyframe. If there is no keyframe to the right, 
the position indicator does not move.

Add Keyframe Creates a keyframe at the current position. Alt+click 
(Windows) or Option+click (Macintosh) this button to delete 
a keyframe. When you add or delete a keyframe, a menu 
gives you additional selections. For more information, see 
“Adding Advanced Keyframes” on page 89 and “Deleting 
Advanced Keyframes” on page 91.
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Accessing Settings for Advanced Keyframes

You access settings for advanced keyframes by displaying one of the shortcut menus available in the 
Effect Editor, or by opening the Effect Editor settings dialog box.

For more information on the settings themselves, see “Shortcut Menus for Keyframe Tracks and the 
Motion Effect Editor” on page 116 and “Shortcut Menu and Settings for the Effect Editor” on 
page 117.

To display the shortcut menu for a keyframe track:

t Right-click a keyframe graph, a parameter graph, a parameter group title track, or the effect 
title track.

To display the shortcut menu for the Motion Effect Editor:

t Right-click the active control graph.

To display the Effect Editor shortcut menu:

t Right-click the Effect Editor outside the keyframe track area.

The Effect Editor shortcut menu opens.

To display the Effect Editor settings dialog box:

t Select File > Settings, click the User tab and double-click Effect Editor.

Horizontal 
scale bar

Zooms (or scales) the view of keyframe graphs horizontally 
so that you can focus in on a particular part of a graph. For 
more information, see “Zooming Keyframe Graphs” on 
page 84.

Scroll 
thumbwheel

Scrolls the view of keyframe graphs horizontally so that part 
of the view disappears on one side and more comes into view 
on the other side. For more information, see “Scrolling 
Keyframe Graphs” on page 87.

Control Description
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Shortcut Menus for Keyframe Tracks and the Motion Effect Editor

Advanced keyframes use two shortcut menus. The shortcut menu for the keyframe track is available 
from the area of the Effect Editor that displays keyframe tracks and keyframe graphs. The Effect 
Editor shortcut menu is available from the part of the Effect Editor that does not display the keyframe 
tracks. For more information about the Effect Editor shortcut menu, see “Shortcut Menu and Settings 
for the Effect Editor” on page 117.

Because the Motion Effect Editor uses advanced keyframes, the shortcut menu for the Motion Effect 
Editor and the shortcut menu for keyframe tracks are nearly identical. The differences stem from the 
multiple tracks available in the Effect Editor. In the following table, the listed commands appear in 
both menus unless otherwise stated.

Control Description

Add Keyframe Adds a keyframe at the position indicator. See “Adding Advanced Keyframes” on 
page 89.

Delete Keyframe Deletes the selected keyframe. See “Deleting Advanced Keyframes” on page 91.

Add Start and End 
Keyframes

Adds keyframes at the first and last frames of your effect. See “Adding Advanced 
Keyframes” on page 89.

This option does not apply to the Motion Effect Editor.

Remove Redundant 
Keyframes

Removes extra keyframes that you do not need to define parameter changes. See 
“Removing Redundant Keyframes” on page 92.

Copy All Values at 
Position

Copies parameter values at the current position for all keyframe graphs in an effect. 
You can then paste these values at another location to create new keyframes or replace 
existing ones. For more information, see “Copying and Pasting Advanced Keyframe 
Parameters” on page 103.

Select All Keyframes For the Effect Editor, selects all keyframes in the section of the editor where you click 
to display the shortcut menu. See “Selecting and Deselecting Advanced Keyframes” 
on page 96.

For the Motion Effect Editor, selects all keyframes in the active graph.

Deselect All Keyframes Deselects all the keyframes in the currently active track, parameter group, or effect. 
See “Selecting and Deselecting Advanced Keyframes” on page 96.
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Shortcut Menu and Settings for the Effect Editor

The Effect Editor shortcut menu and the Effect Editor Settings dialog box give you options for 
adjusting the Effect Editor display, for controlling the playback of effects with advanced keyframes, 
and for setting a default command for the Add Keyframe button. The shortcut menu and the settings 
dialog box have some options in common, but others appear only in the menu or only in the settings 
dialog box. The table below indicates where options appear only in one of the locations.

n The Effect Editor shortcut menu is available only for effects with advanced keyframes.

The following table describes the options for the Effect Editor shortcut menu and the Effect Editor 
settings dialog box.

Align Keyframes Moves the selected keyframe to the position indicator. See “Understanding the Align 
Keyframes and Slip Keyframes Commands” on page 100.

(Motion Effect Editor shortcut menu only) Moves the selected keyframe in one or 
more keyframe graphs to the position indicator, depending on which keyframes you 
select and on where you click to display the shortcut menu. See “Understanding the 
Align Keyframes and Slip Keyframes Commands” on page 100.

Slip Keyframes Moves all the keyframes of the parameter so the active keyframe aligns with the 
position indicator, and the rest of the keyframes maintain their relative location. See 
“Understanding the Align Keyframes and Slip Keyframes Commands” on page 100.

Reverse Keyframes Lets you reverse the keyframes in time for a parameter, a parameter group, or an entire 
effect. See “Reversing Advanced Keyframes” on page 110.

Shelf, Linear, Spline, 
Bézier

Defines how parameter changes occur at keyframes. See “Controlling Parameter 
Changes at Keyframes” on page 106.

Fixed
Elastic

Defines how Media Composer moves keyframes when you trim an effect. Elastic 
keyframes change the time at which they occur when you trim an effect, in proportion 
to the new effect length. Fixed keyframes do not change. See “Controlling Advanced 
Keyframe Behavior with Trimmed Effects” on page 110.

Extrapolate
Hold (Shortcut menu for 
the keyframe track only)

Determines how Media Composer sets parameter values before the first keyframe and 
after the last keyframe. See “Controlling Parameter Changes Outside First and Last 
Keyframes” on page 112.

Zoom to Curve Height Scales the keyframe graph so that its keyframe curve fills the available viewing area 
for the graph. For more information, see “Zooming Keyframe Graphs” on page 84.

Reset All Graph Views Resets all graph views. This includes removing any changes to the views made using 
the zoom sliders or the Zoom to Curve Height feature. See “Resetting Keyframe 
Graph Views” on page 87.

Control Description
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Option Description

Indent Rows When this option is selected, parameter rows are indented from the parameter 
category row, and any parameter subgroups are indented again. When this option is 
deselected, the left edges of parameter rows line up with the parameter category row.

Indented (left) and non-indented (right) parameter rows

Large Text When this option is selected, text in the Effect Editor appears in 12-point size. When 
this option is deselected, text in the Effect Editor appears in the default size, 10 
points (Windows) or 9 points (Macintosh).

Normal (left) and Large (right) text size

Thumbwheels When this option is deselected, variable controls in the Effect Editor appear as the 
default slider control. When this option is selected, variable controls appear as 
thumbwheels. For information on using thumbwheels, see “Changing a Parameter 
with a Slider in the Effect Editor” on page 73.

Slider controls (left) and thumbwheel controls (right)

Real-Time Update When this option is selected, Media Composer updates the rendered effect image in 
real time. Because the update can be slow for complex effects, you have the option to 
deselect updating in real time.

Set Position To Keyframe When this option is selected, when you click a keyframe, Media Composer moves 
the position indicator to the keyframe. When this option is deselected, when you 
click a keyframe, the position indicator does not move. Deselecting this option lets 
you align a keyframe to the position indicator. See “Understanding the Align 
Keyframes and Slip Keyframes Commands” on page 100.

Update Position While 
Playing

When this option is selected, the position indicator in the Effect Editor moves while 
you play the effect. This option is deselected by default because using this option can 
cause video underrun problems in complex real-time effects.
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Working with Standard Keyframes
You can manipulate standard keyframes in the following ways:

• You can add standard keyframes at any point in the effect’s position bar.

• You can delete any standard keyframe that you create, but you cannot delete the starting and 
ending keyframes Media Composer creates.

• You can select one or more standard keyframes.

A keyframe indicator changes to pink when selected. For a quick way to jump to the next or 
previous keyframe indicator, use the Go to Next Event and Go to Previous Event buttons on the 
Effect Preview Monitor toolbar.

• You can move a standard keyframe that you create to another position in the position bar below 
the Effect Preview monitor. You cannot move the starting and ending keyframes.

• You can adjust most effect parameters to a different value for each keyframe, allowing you to 
animate an attribute such as the position of the effect.

Some parameter categories, however, are not keyframeable, and you can only adjust these 
parameters globally for the entire effect. The reference topics for each parameter in “Effects 
Parameter Reference” on page 491 indicate when a parameter is not keyframeable.

• You can copy and paste parameters from one standard keyframe and apply them to another 
standard keyframe. You can also copy keyframe parameters from one effect to another effect.

Show Add Keyframe Mode 
Menu

When this option is selected, the Add Keyframe Mode menu (or the Delete 
Keyframe Mode menu) appears when you use the Add Keyframe button to add (or 
delete) keyframes. See “Keyframe Mode Menu Commands” on page 93.

When this option is deselected, the Add Keyframe button performs the default 
command from the Add Keyframe button options list below, without displaying the 
Add Keyframe Mode menu or the Delete Keyframe Mode menu.

Add Keyframe button options 
(Effect Editor shortcut menu 
only):

• Add Keyframes To 
Active Parameter

• Add Keyframes To 
Active Group

• Add Keyframes To 
Open Groups

• Add Keyframes To 
Enabled Groups

• Add Keyframes To 
Open Graphs

• Add Keyframes To 
All Parameters

Select one as the default command for the Add Keyframe button.

• When you deselect Show Add Keyframe Mode Menu, clicking the Add 
Keyframe button once performs the default command.

• When you select Show Add Keyframe Mode Menu, clicking the Add Keyframe 
button twice performs the default command. (The first click displays the Add 
Keyframe Mode menu so you can select another command.)

n The selection you make for the Add Keyframe mode is mirrored in the Delete 
Keyframe Mode menu, and vice versa. For example, when you change your 
selection to Add Keyframe To Open Groups, the Delete Keyframe mode 
changes to Delete Keyframe From Open Groups.

For a description of each command, see “Keyframe Mode Menu Commands” on 
page 93.

These options are available only in the Effect Editor shortcut menu.

Option Description
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To create a standard keyframe:

1. Click in the position bar below the Effect Preview monitor at the point in the effect where you 
want to add the keyframe. 

The position indicator moves to that frame.

2. Do one of the following to add a keyframe:

t In the Effect Preview Monitor toolbar, click the Add Keyframe button.

t Manually adjust a parameter in the Effect Preview monitor (segment effects only).

For example, when you click a handle on an effect outline and drag to resize or reposition it, 
Media Composer automatically creates a new keyframe.

To delete a standard keyframe:

1. In the position bar below the Effect Preview monitor, click the keyframe indicator.

The keyframe indicator changes to pink when selected.

2. Do one of the following:

t Press the Delete key.

t Alt+click (Windows) or Option+click (Macintosh) the Add Keyframe button.

To select one keyframe:

t In the position bar below the Effect Preview monitor, click the keyframe indicator.

To select multiple keyframes:

t In the position bar below the Effect Preview monitor, Shift+click the keyframe indicators that 
you want to select.

To select all keyframes in the effect’s position bar, do one of the following:

t Press Ctrl+A (Windows) or Command+A (Macintosh).

t Press and hold Ctrl+Alt (Windows) or the Command key (Macintosh), and click one keyframe 
indicator.

To move a standard keyframe, do one of the following:

t Alt+click (Windows) or Option+click (Macintosh) the keyframe indicator, and drag it to its new 
position.

t Select a keyframe indicator, and click the Trim Left 1 Frame or Trim Right 1 Frame button or the 
Trim Left 10 Frames or Trim Right 10 Frames button. 

Left to right: Trim Left 1 Frame button, Trim Right 1 Frame button, Trim Left 10 Frames button, Trim Right 10 Frames 
button

n The Trim buttons are located in the Trim tab of the Command palette. You can map them to other 
locations. For more information, see “Mapping User-Selectable Buttons” in the Help.

To change a standard keyframe’s parameters:

1. In the position bar below the Effect Preview monitor, click the keyframe indicator. 

The keyframe indicator changes to pink when selected.

2. Adjust any of the applicable parameters in the Effect Editor.
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To copy and paste standard keyframe parameters:

1. In the position bar below the Effect Preview monitor, click one keyframe indicator whose 
parameters you want to copy.

2. Select Edit > Copy.

3. Select one or more standard keyframes: 

t To copy the parameters to one keyframe, click the keyframe indicator.

t To copy the parameters to multiple keyframes, Ctrl+click (Windows) or Command+click 
(Macintosh) multiple keyframe indicators.

t To copy the parameters to all keyframes, select Edit > Select All.

4. Select Edit > Paste.

Media Composer pastes the parameters that you copy to the keyframes that you select.
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5 Playing Effects, Rendering Effects, and 
Managing Effect Media Files

This chapter provides information on playing and rendering effects that extends the basic information 
provided in “Playing Effects” on page 39 and “Basics of Effects Rendering” on page 41. It also 
provides information on managing your effect media files.

• Real-Time Playback of Video Effects

• ExpertRender

• Creating and Using Render Settings

• Render Settings Options

• Using Partial Render

• Using 16-Bit Processing Support for Rendered Effects

• Rendering 3D Effects Using the HQ (Highest Quality) Option

• Managing Effect Media Files

Real-Time Playback of Video Effects
You can play back most video effects available in Media Composer in real time. This lets you play 
back sequences that contain effects and to review the appearance of those effects.

Real-time effects playback has no effect on the methods you use when you apply and modify the 
effects themselves.

For more information on playing effects, see “Playing Effects” on page 39.

Understanding Real-Time Effects Processing

To display a frame from a sequence that has a video effect applied, Media Composer must calculate 
the result of the effect at that frame. For example, to display the midpoint frame from a dissolve, 
Media Composer must calculate, for each pixel in the frame, a 50 percent blend between the color 
and luminance values in the outgoing clip and those in the incoming clip. To display frames in real 
time, Media Composer must be able to perform enough of these effect calculations per second to 
maintain the appropriate display rate for your project, for example 30 frames per second (fps) for 
NTSC video.

Because your computer’s processor and memory capabilities are finite, Media Composer’s ability to 
play back effects in real time is limited. Effect calculations are more complex for some effects than 
for others, and still more complex when you adjust many effect options or when multiple effects 
apply to the same frame in a sequence. Even the fastest and most powerful system might eventually 
reach a point where it can no longer maintain real-time playback.



Real-Time Playback of Video Effects
For most real-time effects, Media Composer automatically selects the most efficient and highest 
performance processing resources available. Depending on the particular effect and the graphics 
hardware available on your system, processing might be done by your graphics card’s GPU or your 
computer’s CPU (including all CPU cores for multicore processors).

A small number of effects, when certain parameters are enabled, use OpenGL processing. For these 
effects, you might want to select a processing method that emphasizes either image quality or 
playback performance. For more information, see “Select a Different OpenGL Mode” in “Options 
for Controlling Real-Time Effects Playback” on page 124.

When Media Composer is unable to maintain real-time playback, it continues to play at the correct 
rate but does not display frames that it cannot process quickly enough. If Media Composer is having 
only a small amount of difficulty with the complexity of the sequence, you might perceive a short 
stutter in the video playback, but you might still be able to get a useful sense of how your effects will 
look once they are rendered. If Media Composer is having more difficulty, it is less likely that you 
can judge the look of the effects.

Understanding Real-Time Playback Information in the Timeline

When Media Composer is unable to maintain real-time playback of an effects sequence, colored bars 
appear in the timecode track of the Timeline when playback ends. The following illustration shows a 
typical set of colored bars.

Colored bars in the Timecode track of the Timeline

These bars provide you with information about the difficulties Media Composer had during 
playback. You can use this information to help you render only those parts of the sequence necessary 
to achieve real-time playback.

Bar Color Description

Red Marks the ranges where Media Composer was unable to display frames.

The ranges marked by red bars are ranges that Media Composer recommends for 
rendering to achieve successful real-time playback. If you mark IN and OUT points 
around these ranges, use the ExpertRender In/Out command, and then render the 
recommended ranges, Media Composer can preview your material successfully in 
real time. For more information, see “ExpertRender” on page 127.

Yellow Marks the ranges that caused difficulty for Media Composer during playback 
because of processing power.

No frames were dropped during play. This is only a warning.

Blue Marks the location of frames that caused difficulty for Media Composer because of 
disk speed limitations.

No frames were dropped during play. This is only a warning.
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Turning Playback Performance Indicators On or Off

To turn playback performance indicators on or off:

1. Select File > Settings and click the User tab.

2. Double-click Timeline.

3. In the Display tab, select or deselect Highlight Suggested Render Areas After Playback.

Playback performance indicators appear in the Timeline when you select this option. This option 
is selected by default.

Options for Controlling Real-Time Effects Playback

When Media Composer is unable to maintain real-time playback of an effects sequence, there are a 
number of ways you can attempt to ensure that the sequence plays back successfully in real time.

Start Playback Earlier in the Sequence

If possible, start playback earlier in the sequence, before the effects that are causing difficulties 
begin. This lets Media Composer begin processing some of the effects frames before it must display 
them, decreasing the chance of difficulties with playback.

Change the Bit Depth for Effects Processing

In some circumstances, you have the option to process effects during playback at either of two bit 
depths, 8-bit or 10-bit. 10-bit processing using the Full Quality 10-bit option in the Video Quality 
menu provides higher quality for some effects in a manner similar to that provided by using the 16-
bit processing option when rendering effects (see “Using 16-Bit Processing Support for 
Rendered Effects” on page 138). However, 10-bit processing during playback uses additional system 
resources and might limit real-time playback capabilities.

If you are using 10-bit processing for playback and find that Media Composer cannot play your 
sequence in real time, you might be able to improve performance by switching to one of the other 
Video Quality Menu options, all of which use 8-bit processing.

The circumstances in which the Full Quality 10-bit option is available depend on several factors, 
such as your Avid input/output hardware, your project type (SD or HD), and the editing mode in 
which you are working. For more information, see “Controlling Real-Time Effects Processing” on 
page 126 and “Playing Effects Back at Different Video Qualities” on page 126).

Select a Different OpenGL Mode

A small number of effects use OpenGL processing when certain parameters are enabled. For 
example, a 3D Warp effect with the Trail parameter enabled, or a Stabilize effect with the Tracking 
parameter enabled, uses OpenGL processing.

OpenGL processing can occur in two ways:

• Using the OpenGL capabilities of the graphics card that is installed on your system.

This method allows effects to display in real time, but image quality is limited.

• Using a software implementation of the OpenGL application programming interface (API).

This method allows effects to display at the highest possible quality, but not in real time.
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If you need both the highest effect quality and real time performance (for example, for final output), 
you must render the effects.

You can use a setting in the Video Display Settings dialog box to switch between the OpenGL 
processing provided by your graphics card and software OpenGL processing. This might be useful if 
you notice either unacceptable image quality or poor playback performance with 3D Warp or 
Stabilize effects. For more information, see “Controlling Real-Time Effects Processing” on 
page 126.

n Processing of 3D Warp effects is also affected by the Highest Quality option. For more information, 
see “Rendering 3D Effects Using the HQ (Highest Quality) Option” on page 141.

Render using the Expert Render Command

Render those parts of the sequence where Media Composer had difficulties during playback. Media 
Composer marks these parts of the sequence in the Timeline. For more information, see 
“Understanding Real-Time Playback Information in the Timeline” on page 123 and “ExpertRender” 
on page 127.

n Consider rendering transition effects such as the Dissolve effect or wipe effects first because they take 
less time to render than titles or segment effects.

Select a Lower Playback Quality from the Video Quality Menu

This increases Media Composer’s ability to process effects at the expense of reducing image quality. 
For more information, see “Playing Effects Back at Different Video Qualities” on page 126.

Use the Submaster Effect or Perform a Video Mixdown

For more information, see “Submaster Editing” on page 215 and “Performing a Video Mixdown” on 
page 218.

Reduce the Number of Real-Time Streams

Each Avid editing application supports a specific number of real-time streams. If your system does 
not have the capacity to run that many real-time streams, you can experience a degradation of system 
performance. Processor speed, system memory, and disk speed all affect system performance.

You can also experience performance degradation in an Avid shared storage environment when the 
demands on the system exceed the capacity of the Avid shared storage network to respond.

In either case, you can improve system performance by decreasing the number of real-time streams 
that Media Composer uses during playback. Use the Video Display Settings dialog box to change the 
number of real-time streams, as described in “Controlling Real-Time Effects Processing” on 
page 126.

Optimize your Drive Striping

Proper drive striping increases the speed at which Media Composer retrieves media. For more 
information, see the Media Composer ReadMe for and the online Knowledge Base.
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Real-Time Playback of Video Effects
If your sequence contains multiple short clips with multiple real-time effects or images with a high 
level of complexity, you might exceed the capacity of your hardware to play these in real time, even 
if these effects do not normally exceed the real-time playback capabilities of Media Composer. This 
results in Video Underrun error messages. In this case, render some of the intermediate effects before 
playing the sequence. For more information, see “ExpertRender” on page 127.

Controlling Real-Time Effects Processing

To choose 10-bit effects processing, do one of the following:

t Click the Video Quality Menu button until it displays a green background and the number 10 
(Full Quality 10-bit option).

t Right-click the Video Quality Menu button and select Full Quality 10-bit.

The Full Quality 10-bit option is only available with some system configurations. For more 
information, see “Options for Controlling Real-Time Effects Playback” on page 124.

To select the OpenGL mode:

1. Select File > Settings and click the Project tab.

2. Double-click Video Display.

The Video Display Settings dialog box opens.

3. In the OpenGL Hardware section, select one of the following:

- Software OpenGL

- The OpenGL video board installed on your system (listed by model number)

4. Click OK.

To set the number of real-time streams:

1. Select File > Settings and click the Project tab.

2. Double-click Video Display.

The Video Display Settings dialog box opens.

3. In the Stream Limit text box, type the number of real-time streams you want Media Composer to 
use for playback.

By default, this dialog box displays the maximum number of streams supported by Media 
Composer.

4. Click OK.

Playing Effects Back at Different Video Qualities

The Video Quality Menu button in the Timeline bottom toolbar lets you control the quality (display 
resolution) of the video playback. This feature lets you trade off video quality with smooth playback 
of real-time effects. If you notice missing frames or choppy video during real-time playback, switch 
to a lower quality setting. For more information about selecting a video quality, see “Video Quality 
Options for Playback” in the Help and “Setting the Video Quality for Playback” in the Help.

Some input/output hardware configurations also let you play back at Full Quality using a bit depth of 
10-bits, which provides even higher quality processing for some effects (see “Change the Bit Depth 
for Effects Processing” in “Options for Controlling Real-Time Effects Playback” on page 124).
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Media Composer also provides an option that improves image quality during playback of mixed-
format sequences where material requires resizing. You might need to deselect this option to avoid 
missing frames or choppy video during real-time playback.

n If you switch from one video quality level to another during the course of your workflow, you might 
create precomputed clips that have not rendered with the quality that you need for your final output. 
You might need to manually purge the precomputed clips and re-render effects. For more information, 
see “Ensuring the Quality Level of Precomputed Clips” on page 140.

n On systems with an Avid input/output hardware device attached and selected for playback, real-time 
effects are always enabled. 

To switch the video playback quality:

t Do one of the following:

- In the Timeline bottom toolbar, click the Video Quality Menu button and cycle through the 
video quality settings to the one you want.

- In the Timeline bottom toolbar, right-click the Video Quality Menu button and select the 
video quality setting you want from the menu.

When you change video qualities, immediate changes appear in the quality and the sharpness of 
the media displayed in the Source/Record monitor.

To prepare a sequence for output to a digital cut, switch to Full Quality mode and use 
ExpertRender. For more information, see “ExpertRender” on page 127.

ExpertRender
ExpertRender determines which effects need to be rendered to achieve successful playback of a 
sequence.

You can use the ExpertRender feature in the same way that you use the standard Render commands. 
You can use the ExpertRender at Position command or you can mark IN and OUT points and then 
use the ExpertRender In/Out command. For more information, see “Using the ExpertRender 
Command” on page 129.

If Media Composer has difficulty previewing effects in real time and displays playback information 
indicators in the timecode track of the Timeline, the steps you take when you use the ExpertRender 
In/Out command are somewhat different from the steps you take when you use one of the 
ExpertRender commands in other circumstances. For more information, see “Using the 
ExpertRender Command After a Real-Time Playback Attempt” on page 130.

For more information on rendering, start with “Basics of Effects Rendering” on page 41.

Understanding ExpertRender

When you render effects by using the Render at Position or Render In/Out command, Media 
Composer renders all effects in the selected material — all effects on the enabled tracks at the 
position or all effects on the enabled tracks between the marked IN and OUT points. In most cases, 
Media Composer renders some effects that do not require rendering for successful playback, 
increasing the time to render and creating more precomputes than necessary.
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For example, the following sequence includes four effects on four different tracks. You could render 
all four effects, however if you use the ExpertRender In/Out command on the material, the 
ExpertRender analysis recommends rendering only three of the effects.

A sequence with four effects (top) and the results of an ExpertRender analysis of this sequence. Only three of the effects 
needs to be rendered for successful output.

ExpertRender helps to solve the problem of unnecessary rendering by analyzing all the effects in 
selected material and determining which effects you need to render to achieve successful playback. 
You can choose to render the effects identified by ExpertRender or to modify the selections before 
submitting them for rendering.

ExpertRender attempts to generate a minimum set of effects to render for successful playback. If you 
render the effects recommended by ExpertRender, your material usually plays successfully in real 
time.

ExpertRender is particularly useful in the following circumstances:

• If you attempt to preview a sequence with effects and Media Composer is not been able to 
maintain real-time playback, you can use ExpertRender to help you render the minimum amount 
of material necessary to achieve successful playback for previewing. ExpertRender includes an 
option that lets you render effects only in the regions recommended by Media Composer for 
rendering after a playback attempt. These are the regions marked by red indicators in the 
timecode track of the Timeline. For more information, see “Understanding Real-Time Playback 
Information in the Timeline” on page 123.

• If you are ready to output a sequence, for example, by performing a digital cut to tape, you can 
use the ExpertRender In/Out command and select the Prepare for Digital Cut option to determine 
which effects you need to render for successful output. In particular, when there are overlapping 
effects on multiple tracks, ExpertRender can calculate when the rendering of an effect on an 
upper track will incorporate picture information from lower tracks. In this situation, you do not 
need to render effects on the lower tracks separately. Depending on the complexity of your 
sequence, ExpertRender might save you both time and storage space by eliminating unnecessary 
rendering and precomputes.
128



ExpertRender
n On systems without Avid input/output hardware, you must render all effects before performing a 
digital cut.

• In most circumstances, ExpertRender enables you to render material quickly, easily, and with a 
high degree of storage efficiency. However, experienced Avid users might achieve an even 
quicker render of a complex sequence than that offered by ExpertRender — for example, using 
Submaster editing. For more information, see “Considerations When Using ExpertRender” on 
page 134 and “Submaster Editing” on page 215.

You can configure Media Composer to send an email notification when a render operation completes. 
This lets you leave Media Composer unattended when a long render operation is taking place, yet 
still know when the render completes. For more information, see “Email Settings” in the Help.

Using the ExpertRender Command

Use the following procedure when there are no colored real-time playback information bars in the 
timecode track of the Timeline. You generally use this method to render a sequence so that it plays 
back successfully for output.

For information on using the ExpertRender command when colored real-time playback information 
indicators appear in the Timeline following a real-time playback attempt, see “Using the 
ExpertRender Command After a Real-Time Playback Attempt” on page 130.

To render effects by using the ExpertRender command: 

1. Select all tracks in the Timeline that contain effects you want ExpertRender to analyze.

2. Do one of the following:

t To render at position, move the position indicator to the effects in the Timeline.

t To render between IN and OUT points, mark IN and OUT points around the effects.

3. Select one of the following:

t Timeline > Render > ExpertRender at Position

t Timeline > Render > ExpertRender In/Out

ExpertRender analyzes the selected effects and highlights the effects that require rendering in the 
Timeline. The Expert Render dialog box opens and indicates how many of the effects require 
rendering.
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4. Click the Drive button, and select a drive on which to store the rendered effects.

The Effect Source Drive selection refers to the drive where the media for the outgoing shot of the 
first transition resides.

5. In the Processing field, select one of the available processing methods based on where you want 
the effects to be rendered:

t Application - The effect(s) will be rendered within Media Composer.

t Background Process - The effect(s) will be rendered by Media Composer via background 
processing.

t Distributed Processing - The effects will be rendered on another computer so as not to use 
your system’s resources. For details, see the Avid Media Composer / Distributed Processing 
Administration Guide.

6. Do one of the following:

t Click Cancel.

Media Composer removes all ExpertRender highlighting and cancels the ExpertRender 
process without rendering any effects.

t Click Modify Selection.

The effects identified for rendering remain highlighted, and you can modify the set of effects 
to render. For more information, see “Modifying ExpertRender Results” on page 132.

t Click OK.

Media Composer renders the highlighted effects.

If there is not enough room on the drive, Media Composer displays a message box that gives you 
the following choices:

Using the ExpertRender Command After a Real-Time 
Playback Attempt

Use the following steps when Media Composer has difficulty with real-time preview of effects and 
displays information indicators in the timecode track of the Timeline.

n When you render recommended ranges in material by following this procedure, you can usually 
achieve analog output of the same material without further rendering. For DV output, however, you 
should use the ExpertRender command again for the duration of the material since you usually need 
to render additional effects.

For information on using the ExpertRender command under other circumstances, see 
“Understanding ExpertRender” on page 127.

Option Description

Continue Attempt to render the effect anyway, in case there might be enough room on the 
drive.

Stop Stop the rendering process and return to the Render Effect dialog box, and then 
select another drive before continuing.
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To render effects using ExpertRender after a real-time playback attempt:

1. Select all tracks in the Timeline that contain effects you want ExpertRender to analyze.

2. Mark IN and OUT points around the material you want ExpertRender to analyze.

If your sequence contains complicated effects and multiple layers, the IN and OUT points you 
mark might include parts of the Timeline marked by red indicators in the timecode track. For 
more information, see “Understanding Real-Time Playback Information in the Timeline” on 
page 123.

3. Select Timeline > Render > ExpertRender In/Out.

The Expert Render dialog box opens and indicates the number of red indicator ranges that 
require rendering to achieve real-time preview of effects.

4. In the Processing field, select one of the available processing methods based on where you want 
the effects to be rendered:

t Application - The effect(s) will be rendered within Media Composer.

t Background Process - The effect(s) will be rendered by Media Composer via background 
processing.

t Distributed Processing - The effects will be rendered on another computer so as not to use 
your system’s resources. For details, see the Avid Media Composer / Distributed Processing 
Administration Guide.

5. Do one of the following:

t To render only the effects necessary to achieve successful real-time effects preview, select 
“Render recommended ranges,” and then click OK.

t To render all the effects that ExpertRender identifies for rendering within your marked 
selection, select “Render entire selection.”

The message in the Expert Render dialog box changes to indicate the number of effects that 
ExpertRender has identified for rendering across the entire selection. Using this option 
renders all the effects necessary for successful real-time playback of the marked region of 
the Timeline.

t If you are preparing for a digital cut, select Prepare effects for Digital Cut.

The message in the Expert Render dialog box changes to indicate the number of effects that 
ExpertRender has identified for rendering in order to create a digital cut. Using this option 
renders all the effects necessary for successful output of the marked region of the Timeline.

n If you do not have Avid input/output hardware connected to your system, you must render all effects 
before performing a digital cut. Software-only systems ignore unrendered effects during a digital cut. 
For example, unrendered transition effects play as cuts.

6. Click the Drive button, and select a drive on which to store the rendered effects.

The Effect Source Drive selection refers to the drive where the media for the outgoing shot of the 
first transition resides.

7. Do one of the following:

t Click Cancel.

Media Composer removes all ExpertRender highlighting and cancels the ExpertRender 
process without rendering any effects.

t Click Modify Selection.
131



ExpertRender
The effects identified for rendering remain highlighted, and you can modify the set of effects 
to render. For more information, see “Modifying ExpertRender Results” on page 132.

t Click OK.

Media Composer renders the highlighted effects.

If there is not enough room on the drive, Media Composer displays a message box that gives you 
the following choices:

Modifying ExpertRender Results

You can modify the results of an ExpertRender analysis, removing effects that you do not want to 
render and adding others that you do want to render.

In most cases, the results of an ExpertRender analysis offers the fastest rendering necessary for 
successful playback. You should only modify the results of an ExpertRender analysis if you are 
confident that your modifications are useful. For examples of situations where you might want to 
modify the results of an ExpertRender analysis, see “Considerations When Using ExpertRender” on 
page 134.

If you render the results of an ExpertRender analysis without making any modifications, the material 
you submitted to ExpertRender usually plays back successfully in real time. If you render 
recommended ranges, the material plays back successfully for preview purposes. If you render the 
entire selection, the material plays back successfully for output.

To modify the results of an ExpertRender analysis:

1. Perform an ExpertRender by following steps 1 through 3 in “Using the ExpertRender 
Command” on page 129 or in “Using the ExpertRender Command After a Real-Time Playback 
Attempt” on page 130.

2. In the Expert Render dialog box, click Modify Selection.

3. Shift+click effects in the Timeline to add them or remove them from the set of effects to render.

Effects currently selected are highlighted.

4. When you are satisfied with your selections, click the Render Effect button in the Effect Editor 
or in the Tool palette.

The Render Effect dialog box opens.

Option Description

Continue Attempt to render the effect anyway, in case there might be enough room on the 
drive.

Stop Stop the rendering process and return to the Render Effect dialog box, and then 
select another drive before continuing.
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n To prevent the Render Effects dialog box from opening, press and hold the Alt key (Windows) or 
Option key (Macintosh) when you click the Render Effect button. Media Composer will use the last 
drive selected, and you do not need to follow the remaining steps in this procedure.

5. Click the Drive button, and select a drive for the rendered media.

The Effect Source Drive selection refers to the drive where the media on the outgoing shot of a 
transition resides.

6. In the Processing field, select one of the available processing methods based on where you want 
the effects to be rendered:

t Application - The effect(s) will be rendered within Media Composer.

t Background Process - The effect(s) will be rendered by Media Composer via background 
processing.

t Distributed Processing - The effects will be rendered on another computer so as not to use 
your system’s resources. For details, see the Avid Media Composer / Distributed Processing 
Administration Guide.

7. Click OK.

If there is not enough room on the drive, Media Composer displays a message box that gives you 
the following choices:

Media Composer renders the highlighted effects.

To cancel ExpertRender during the modification process, do one of the following:

t Click in the timecode track to move the position indicator.

t Double-click one of the segment tools on the Timeline toolbar.

Option Description

Continue Attempt to render the effect anyway, in case there might be enough room on the 
drive.

Stop Stop the rendering process and return to the Render Effect dialog box, and then 
select another drive before continuing.
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Segment tools in the Timeline toolbar

t From the Clip menu, select an ExpertRender command, and then click Cancel in the Expert 
Render dialog box.

ExpertRender removes all its highlighting and cancels the ExpertRender process without 
rendering any effects.

Considerations When Using ExpertRender

When you work with ExpertRender, you should be aware of the following aspects of its operation:

• ExpertRender operates on all selected tracks in the Timeline, including any enabled tracks that 
might be above the currently monitored track. To view the material that you are submitting to 
ExpertRender accurately in the monitor window, make sure that you are monitoring the topmost 
selected track in the sequence.

• ExpertRender takes account of all tracks at or below the topmost selected track when 
determining what to render on the selected tracks to achieve successful playback. For example, if 
you have a sequence with tracks V1 to V4, and select tracks V3 and V4 when using 
ExpertRender, Media Composer considers tracks V1 and V2 when determining playback 
possibilities but highlights effects to render only from tracks V3 and V4.

• If the material you submit to ExpertRender includes an effect in a segment that also contains 
nested effects, ExpertRender always renders the effect on the top (outside) track rather than the 
effect inside the nest. In certain circumstances, this might limit your workflow flexibility. For 
example, you might anticipate the need to readjust the parameters of the effect outside the nest 
and the effect would then require rerendering. You can use the procedure described in 
“Modifying ExpertRender Results” on page 132 to select the effect within the nest for rendering 
and deselect the effect outside the nest.

• In some circumstances where segment effects and transition effects are adjacent in a sequence, 
ExpertRender might recommend the segment effects for rendering when rendering the transition 
effects might be quicker or more convenient and still allow for successful playback. You can use 
the procedure described in “Modifying ExpertRender Results” on page 132 to modify the 
combination of effects for rendering.

Creating and Using Render Settings
You can create one or more sets of render parameters and save them as a custom Render setting. For 
example, you can create one setting especially for rendering single-field motion effects and another 
for rendering two-field motion effects. You can then activate the setting that you need at each stage of 
your project.

To create a new Render setting:

1. Select File > Settings and click the User tab.

2. Right-click Render and select Duplicate.

3. Name the setting by doing the following:

a. Click the custom name column (in between the setting name and the setting type identifier).

b. Type a name.
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c. Press Enter (Windows) or Return (Macintosh).

4. Select options for the new Render setting as described in the table “Render Settings Options” on 
page 135.

To activate a Render setting:

t Click in the box of the desired Render setting.

A check mark appears beside the setting that is currently active.

To adjust the options for a Render setting:

1. Select File > Settings, and click the User tab.

2. Double-click a Render setting.

The Render Settings dialog box opens.

3. Select the appropriate options, based on the descriptions in Media Composer in “Render Settings 
Options” on page 135, and then click OK.

Render Settings Options
The following table describes the options available in the Render Setting dialog box.

Option Suboption Description

Image 
Interpolation

This option allows you to choose filtering quality vs. speed.
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Timewarps 
Render Using / 
Motion Effects 
Render Using

These two menus determine the processing method when you render 
or rerender existing motion effects and Timewarp effects.

Original Preference Causes effects to render using the type they were when originally 
created.

Duplicated Field Displays a single field in the effect. For two-field media, this reduces 
the information stored by half because it drops one field of the image, 
resulting in a lower quality image. For single-field media, this is 
usually the best choice because of its speed (the other options do not 
improve effect quality for single-field media). 

With JFIF resolutions, selecting this option causes the effect to render 
in the shortest amount of time. With DV and MPEG resolutions, the 
effect renders approximately as quickly as it would if you select 
Both Fields as the rendering option.

Both Fields Displays both fields in the effect. For example, the first two frames of 
a half-speed (50%) slow-motion effect repeat the original Frame 1 
(both fields) twice. This option is good for shots without inter-field 
motion, NTSC or PAL film-to-tape transfers, and still shots. With 
footage that includes inter-field motion, this method might result in 
minor shifting or bumping of the image because it disturbs the 
original order of fields: a Field 1 will appear both before and after the 
corresponding Field 2. 

The effect renders relatively quickly. For best results, you should use 
evenly divisible frame rates with this option.

Interpolated Field Creates a second field for the effect by combining scan line pairs from 
the first field in the original media. This option calculates the motion 
effect at the field level rather than the frame level. Because Media 
Composer considers all fields and does not disturb the original order 
of fields, the smoothest effect results. 

Effects you create using this option take the longest amount of time to 
render.

VTR-Style Creates a second field for the effect by shifting selected video fields 
of the original media by a full scan line. This technique is similar to 
that used by high-quality professional video decks when playing 
footage at less than normal speed. This option also creates the motion 
effect at the field level rather than the frame level. However, because 
pixels are not filtered, the final image is sharper than that created by 
the Interpolated Field option. The image might display some slight 
jitter at certain speeds. 

The time needed to render effects you create with this option is longer 
than the time for effects you create using either Duplicated Field or 
Both Fields but similar to the time needed for Interpolated Field.

Option Suboption Description
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Using Partial Render
If you interrupt a render that is not complete, Media Composer lets you save the completed portion of 
the render. You can finish the render later by resubmitting the effect for rendering. Media Composer 
then renders only the part of the effect that has not rendered previously and saves that part as a 
separate precompute. 

This feature is especially useful if you have to interrupt a long render of a single effect, such as a 
Submaster effect.

You can also use the Render Ranges command in the Timeline Fast menu to customize the Timeline 
so that it indicates which parts of an effect Media Composer has rendered.

Blended Interpolated (Timewarp only) Blends (averages) pixels from the original frames or 
fields to create intermediate frames or fields. For example, at 25% 
speed, Media Composer creates three blended images between 
outgoing Image A and incoming Image B. The first blended image 
weights the pixels from Image A at 75% and Image B at 25%. The 
second blended image weights the pixels from Image A at 50% and 
Image B at 50%. The third blended image weights the pixels from 
Image A at 25% and Image B at 75%. Objects in motion from 
Image A to Image B appear to fade out of Image A and fade in to 
Image B.

Timewarp effects you create using Blended Interpolated or Blended 
VTR render less quickly than Interpolated Field or VTR-Style.

Blended VTR (Timewarp only) Creates a second field for the effect by shifting 
selected video fields of the original media by a full scan line, then 
blending (averaging) pixels from the original frames or fields to 
create intermediate frames or fields. For example, at 25% speed, 
Media Composer creates three blended images between outgoing 
Image A and incoming Image B. The first blended image weights the 
pixels from Image A at 75% and Image B at 25%. The second 
blended image weights the pixels from Image A at 50% and Image B 
at 50%. The third blended image weights the pixels from Image A at 
25% and Image B at 75%. Objects in motion from Image A to 
Image B appear to fade out of Image A and fade in to Image B.

Timewarp effects you create using Blended Interpolated or Blended 
VTR render less quickly than Interpolated Field or VTR-Style.

n Another Timewarp rendering option, FluidMotion™, is available only through the 
Motion Effect Editor. See “Creating Timewarp Effects” on page 165.

Render 
Completion 
Sound

Defines a sound that Media Composer plays once the rendering 
process is complete. This is useful when you are rendering multiple 
effects.

None Disables the rendering completion sound. This is the default.

System Beep The rendering completion sound matches the sound set for your 
operating system.

Render Sound The rendering completion sound is a customized sound.

Option Suboption Description
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The playback behavior of a partially rendered effect depends on the frame at which playback begins. 
If playback begins at a rendered frame, Media Composer attempts to play the entire effect in real 
time. You see the rendered portion in real time but cannot see the unrendered portion. If playback 
begins at a non-rendered frame, Media Composer plays the entire effect using Render On-the-Fly.

To interrupt a render:

1. Press Ctrl+period (Windows) or Command+period (Macintosh) to interrupt the render.

A message box opens.

2. Do one of the following:

t Click Keep to save the material already rendered.

t Click Discard to end the render without saving the material already rendered.

To customize the display of render ranges in the Timeline:

1. Click the Timeline Fast Menu button, and select Render Ranges.

2. Select one of the following from the submenu:

Using 16-Bit Processing Support for Rendered Effects
You can choose to render most effects using a bit depth of 16 or a bit depth of 8. 16-bit rendering 
provides greater precision and better color quality when working with 10-bit resolutions. For 
example, if you apply a color effect to a clip that contains a gradient (such as a wide, soft border), 
you notice a difference if you zoom in on the rendered effect. An effect rendered at 8-bit would show 
banding between colors at higher zoom ratios than an effect rendered at 16-bit. Also, if you use 
nested effects with many levels of nesting, using 16-bit precision can help preserve the overall image 
quality of the rendered effect.

The results of 16-bit precision rendering are more obvious with 10-bit resolutions than with 8-bit 
resolutions. However, 16-bit precision can be useful with 8-bit resolutions if you use color effects or 
use nested effects with many levels of nesting. Because it takes longer to render effects with 16-bit 
precision, you need to determine when the additional time is useful.

Some effects do not support 16-bit processing. The reference information for each individual effect 
in “Effects Reference” on page 451 indicates which effects do not support 16-bit processing.

Option Description

None Turns off the display of render ranges.

Partial Only Displays a red line on the portion of any partially rendered effect 
that is currently unrendered (but does not mark completely 
unrendered effects). This is the default option.

All Displays a red line on the portion of any partially rendered effect 
that is currently unrendered and on all completely unrendered 
effects. This is a simple visual indication of which effects are 
unrendered. It is not an indication of which effects you might need 
to render to achieve successful playback.
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Using 16-Bit Processing Support for Rendered Effects
n If you switch from one processing bit depth to another during the course of your workflow, you might 
create precomputed clips that have not rendered with the quality that you need for your final output. 
You might need to manually purge the precomputed clips and re-render effects. For more information, 
see “Ensuring the Quality Level of Precomputed Clips” on page 140.

n Rendering times are slower when using 16-bit processing. Turning on HQ (highest quality render 
mode) for a 3D effect can also add additional rendering time. For more information on HQ, see 
“Rendering 3D Effects Using the HQ (Highest Quality) Option” on page 141.

To set the bit depth for rendered effects:

1. Select File > Media > Media Creation Settings.

The Media Creation dialog box opens.

2. Click the Render tab.

3. Set the Effects Processing bit depth option to one of the following:

Option Description

8-bit Use this option when rendering time is more important than image 
quality, or if you are mainly working with effects that do not support 
16-bit precision.

16-bit Use this option if you want the best overall image quality. Use this 
option if you use 10-bit resolutions, use many levels of nested 
effects, or want the best color fidelity for rendered effects.

Automatic Use this option if you want the media source to determine the effects 
resolution. Effects render at 16-bit for 10-bit media and at 8-bit for 
8-bit media. This is the default.
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Ensuring the Quality Level of Precomputed Clips
Ensuring the Quality Level of Precomputed Clips

Before you export or output your sequence, you must ensure that all your precomputed clips have 
been rendered using the desired quality settings. Media Composer cannot always recognize that it 
needs to re-render effects when you change a quality setting. You must manually purge and re-render 
precomputed clips to ensure that all effects render with the desired quality.

In general, you need to purge and re-render if you have rendered effects while working in a lower 
quality setting and have then switched to a higher quality setting.

In contrast, if you render in a higher quality and switch to a lower quality, you do not always need to 
re-render. The quality of the precomputed clips is higher than that of the sequence and they are 
downconverted in real-time during playback. In this case, you should re-render only if you want to 
improve playback performance or maintain a consistent rendering quality across all clips.

You need to consider re-rendering your precomputes if you change any of the settings listed in the 
following table.

You can either purge precomputes from an individual sequence, or you can purge precomputes from 
all sequences in the project.

To purge precomputes from an individual sequence:

1. Open the sequence in Source/Record mode.

2. Select all audio and video tracks that contain prerendered effects.

3. Mark an IN point at the start of the sequence, and then mark an OUT point at the very end.

4. Select Timeline > Renders > Clear Renders In/Out.

The Clear Renders dialog box opens.

5. Deselect Skip Motion Effects and Skip Unknown Effects.

6. Click OK.

To purge precomputes from all sequences:

1. Select Tools > Media Tool.

The Media Tool Display window opens.

2. Select All Drives to select all media drives.

3. Select Current Project to select the current project.

Location Setting

File > Settings- Format Tab Project type

Aspect ratio

Color space

Raster dimension

Media Creation Settings - Render Tab Effects processing bit-depth

Video Quality Menu Button Video playback quality
140



Rendering 3D Effects Using the HQ (Highest Quality) Option
n You can select multiple projects if you also want to clear pre-computes in other projects.

4. Deselect Master Clips and Media Files.

5. Select Precompute Clips.

6. Click OK.

The Media Tool window opens.

7. With the Media Tool window selected, select Edit > Select-All (or press Ctrl+A).

8. Select Edit > Delete (or press the Delete key).

9. In the Delete Media dialog, select all tracks and click OK.

10. Click Delete in the confirmation dialog.

After you purge all effects, render effects with the new settings where necessary. Avid recommends 
that you purge and re-render only as the last step before output. You should not need to purge pre-
computed clips more than once.

Rendering 3D Effects Using the HQ (Highest Quality) 
Option

A small number of 3D effects have two rendering options, the standard hardware-assisted render and 
the HQ (Highest Quality) software-based render. HQ rendering produces a superior image but takes 
longer than standard rendering.

The HQ button appears in the Effect Editor for 3D effects that have an HQ rendering option. Use the 
HQ button to select HQ rendering for an individual effect in your sequence.

The additional quality that you achieve using the HQ rendering option depends on the effect and the 
footage you use to create the effect. For example, HQ rendering can often improve the quality of an 
effect that dynamically resizes an image or an effect on a clip with a lot of motion.

n If an effect supports 16-bit processing, you can achieve additional quality by turning on HQ 
rendering along with 16-bit processing. See “Using 16-Bit Processing Support for Rendered Effects” 
on page 138.

To select HQ rendering for an individual effect:

1. In Effect mode, move the position indicator to the effect you want to select.

If HQ rendering exists for the effect, the HQ button is available in the Effect Editor.

2. Click the HQ button.

The button turns green.

To select standard rendering for an individual effect:

t Click the HQ button again.

The button is greyed out.

The HQ button has a global setting in the Render Setting dialog box. The Effects Quality Render 
Using menu lets you override the selection you made in the Effect Editor for individual effects. 
141



Managing Effect Media Files
You can easily change from standard rendering to HQ rendering for your entire sequence, once 
you are satisfied with your draft version, by using the Render Setting selection. You can also 
choose to set all effect rendering to standard if you want to reduce rendering time. For more 
information, see “Creating and Using Render Settings” on page 134.

n Once Media Composer begins rendering, it changes all affected HQ settings to the Effects Quality 
Render Using value in the active Render setting. If you cancel the render, HQ settings for individual 
effects do not revert to their previous values.

For example, suppose you apply several effects to a sequence and use the HQ button in the Effect 
Editor to select HQ rendering for some but not all the effects. In the active Render setting, you 
set Effects Quality Render Using to Highest Quality. You set an IN point and an OUT point, and 
select Timeline > Render In/Out.

When you start the render, Media Composer immediately changes all the effects between the IN 
point and the OUT point to HQ rendering, if the HQ render is available for a given effect. If you 
cancel the render, the HQ settings that changed do not change back. You must reset the HQ 
settings individually.

Managing Effect Media Files
Media Composer lets you view effect media files and select them for deletion. You can quickly find 
or delete an effect media file from a bin, or you can use the Media tool to view all the files that relate 
to your project and select those you want to delete.

Understanding Effect Media Files Management

When you render an effect, Media Composer creates two elements: a rendered effect clip (also 
known as a precompute clip) and an associated media file. When you create a title or an imported 
matte key clip, Media Composer creates several elements: an effect clip, a precompute clip, and 
associated media files.

Media Composer overwrites or automatically deletes a media file from your drive only if you:

• Render an effect two or more times with the Render Effect button.

• Close the project before either an Auto-save or a manual save occurs.
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Managing Effect Media Files
In this case, Media Composer automatically saves the last-rendered effect and deletes the earlier, 
unreferenced versions. This autodeletion applies only to effects rendered since the last save or project 
close.

This prevents you from deleting media that might be necessary to play other versions of the 
sequence. If you want to remove media files from your drive to save space, you must manually delete 
the files.

 For complete information on the media management features and on the use of the Media tool, see 
“Managing Media Files” in the Help.

n If you are using Media Composer in an Avid Interplay™ workgroup environment, you can use the 
asset manager to manage your media. For more information, see “Working with Media Files in an 
Avid Interplay Environment” in the Help.

Revealing Effect Media Files

You can reveal the media files associated with effect clips (titles and matte keys), rendered effect 
clips (precompute clips), and motion effects so that they are visible in their folders on the desktop. 
You can then verify information about the media files, delete them directly from the folder, or 
perform other standard file management operations.

To reveal effect clip, rendered effect clip, or motion effect media:

1. (Option) If you want to reveal effect media for rendered effect clips (precompute clips), display 
those clips in the bin by doing the following:

a. Select a bin.

b. Select Bin > Set Bin Display.

The Set Bin Display dialog box opens.

c. Select Effects and Show reference clips, and click OK.

Any rendered effect clips appear in the bin. The clips are named with the sequence name and 
effect type.

2. Select an effect item in the bin.

In the following illustration, a rendered effect clip is selected.

n You can reveal media files for only one item in a bin at a time.

3. Select File > Reveal File.

(Windows) Media Composer searches all available drives, opens the folder in Windows 
Explorer, and highlights a related media file.
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Managing Effect Media Files
(Macintosh) Media Composer searches all available drives, opens the folder, and highlights 
related media files.

4. (Option — Windows only) If more than one media file is associated with the clip, Media 
Composer displays a message box prompting you to reveal the next file. Do one of the following:

t Click OK to reveal the next file.

If the Explorer window disappears from view, bring it forward by pressing and holding the 
Alt key and pressing the Tab key until you select the Explorer window containing the OMFI 
MediaFiles folder or Avid MediaFiles folder information.

t Click Cancel to end the Reveal File operation.

Deleting Effect Media Files from a Bin

You can delete effect media files (for titles, matte key clips, and rendered effects) and motion effect 
media from a bin using the Delete dialog box.

To delete effect media files and motion effect media:

1. (Option) If you want to delete effect media for rendered effect clips (precompute clips), display 
those clips in the bin by doing the following:

a. Select Bin > Set Bin Display.

The Set Bin Display dialog box opens.

b. Select Effects and Show reference clips, and click OK.

Any rendered effect clips appear in the bin.

2. In the bin, select the clip or clips whose media you want to delete.

In this example, two items are selected: a title and a motion effect.

3. Press the Delete key.

The Delete dialog box opens.

4. Select the appropriate check boxes for the material you want to delete, and then click OK.

For more information, see “Deleting Items from a Bin” in the Help.
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6 Working with Plug-In Effects

You can use AVX plug-in effects to add new effects or to update existing effects. This chapter 
describes how to work with these plug-in effects.

• Understanding AVX Plug-Ins

• Freeing Memory Used by AVX 1.x Plug-ins

• Installing AVX Plug-ins

• Locating the AVX 1.x Plug-Ins Folder (Windows Only)

• Updating and Promoting AVX Plug-ins

• Assigning Multiple Tracks in Plug-in Effects

• Using AVX Plug-In Controls

• Using the Client Monitor to Preview a Plug-In Effect

• Troubleshooting AVX Plug-Ins

Understanding AVX Plug-Ins
Third-party plug-in effects use the Avid Visual Extensions (AVX) standard. AVX is a cross-platform 
software architecture that allows software effect modules to work with a host application such as 
Media Composer.

Avid also develops some AVX plug-in effects and supplies them with Media Composer. For example, 
the Illusion FX category of effects are AVX plug-in effects.

Third-party plug-in effects appear in the Effect Palette in their own category (usually the name of the 
plug-in vendor). Individual effects each have a plug-in icon. Plug-in effects behave in Media 
Composer in much the same way as standard Avid-supplied effects. For example, when you apply a 
plug-in effect to a sequence, the plug-in effect icon appears in the Timeline. You can also save and 
apply effect templates based on plug-in effects.

Media Composer supports both 1.x and 2.0 versions of the AVX standard. AVX 2.0 supports 
advanced keyframes and allows plug-in vendors to take advantage of 16-bit effects processing, while 
AVX 1.x does not. AVX 2.0 plug-ins automatically use advanced keyframes, so you do not need to 
promote them. A particular AVX 2.0 effect might or might not support 16-bit processing. For more 
information on 16-bit effects processing, see “Using 16-Bit Processing Support for 
Rendered Effects” on page 138.

Some vendors let you promote AVX 1.x plug-ins to an AVX 2.0 version. For more information, see 
“Updating and Promoting AVX Plug-ins” on page 148.

In general, AVX plug-ins are resolution-independent and automatically scale to the resolution of the 
clip. If an older AVX plug-in does not scale correctly with HD resolutions, please contact the plug-in 
vendor.



Freeing Memory Used by AVX 1.x Plug-ins
n Media Composer also supports AudioSuite™ plug-ins. These plug-ins apply only to audio clips and 
do not appear in the Effect Palette.  For more information, see “Working with Audio” in the Help.

n If you are transferring a project that includes sequences with AVX plug-in effects from another 
system, you must install matching AVX plug-ins to see the effects.

For more information on AVX, visit the Avid AVX Developer Program page at www.avid.com. For a 
complete list of third-party AVX plug-in vendors, see the Partner Product Search page at 
www.avid.com.

Freeing Memory Used by AVX 1.x Plug-ins
Each time you apply an AVX plug-in effect to a sequence, Media Composer keeps the effect resident 
in memory. When you close the bin containing the sequence, Media Composer closes the AVX plug-
ins, which frees the memory. If you apply many plug-ins and find Media Composer running out of 
memory, you can close all AVX 1.x plug-ins and free the memory they use with a console command.

To close all AVX 1.x plug-ins:

1. Select Tools > Console.

2. Type closeallavxplugins and press Enter (Windows) or Return (Macintosh).

Media Composer closes all open AVX 1.x plug-ins. The AVX plug-ins automatically open again 
as needed.

Installing AVX Plug-ins
Most AVX plug-ins have an installation program that installs the plug-ins automatically in the correct 
AVX Plug-In folder when you follow the installation instructions.

c If an AVX plug-in has an installation program, always use the program to install the plug-ins. 
For more information, see the documentation for the plug-in.

Some AVX plug-ins do not have an installation program and you must install them manually.

To install AVX plug-ins manually:

1. Quit Media Composer.

c Do not add or remove plug-ins while Media Composer is running.

2. Copy the plug-in files from the software vendor’s folder to the corresponding AVX Plug-Ins 
folder located on your Avid system.

t (Windows) You must install AVX 2.0 plug-ins in the following folder:

C:\Program Files\Avid\Avid Media Composer\AVX2_Plug-Ins

t (Windows) The default location for AVX 1.x plug-ins is:

C:\Program Files\Avid\AVX_Plug-Ins

The AVX 1.x Plug-Ins folder might be in a different location on your system.

t (Macintosh) The AVX_Plug-Ins folder is located within the Avid file structure:
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Locating the AVX 1.x Plug-Ins Folder (Windows Only)
Macintosh HD:Applications:Avid Media Composer:SupportingFiles:
AVX_Plug-Ins

(AVX 1.x plug-ins only) You must place AVX 1.x plug-ins directly in the corresponding 
AVX_Plug-Ins folder for Media Composer to recognize them. They cannot be inside another 
folder within this folder or elsewhere on your system.

(Windows only) If the AVX 1.x AVX_Plug-Ins folder does not appear in the default location and 
you do not know where the folder is located, you can use the Registry Editor to locate the folder. 
For more information, see “Locating the AVX 1.x Plug-Ins Folder (Windows Only)” on 
page 147.

3. Restart Media Composer.

4. Select Tools > Effect Palette.

For more information, see “Understanding the Effect Palette” on page 19.

The AVX plug-in effects appear in the Effect Palette, usually in their own category under the 
name of the vendor.

(Windows only) If the plug-in effects do not appear in the Effect Palette after installation, see 
“Troubleshooting AVX Plug-Ins” on page 151.

Locating the AVX 1.x Plug-Ins Folder (Windows Only)
This topic applies only to AVX 1.x plug-ins. The AVX2_Plug-Ins folder is always in the same 
location. For more information, see “Installing AVX Plug-ins” on page 146.

When your first install Media Composer, you can select a location for the AVX_Plug-Ins folder. The 
default path is:

C:\Program Files\Avid\AVX_Plug-Ins

If you accept this location for the AVX_Plug-Ins folder, you install AVX 1.x plug-ins here.

If the AVX_Plug-Ins folder is not in the default location, or if the effects do not appear in the Effect 
Palette after you install them, you can use the Windows Registry Editor (Regedit) to locate the 
AVX_Plug-Ins folder.

c Use the following procedure only to locate the AVX_Plug-Ins folder. Do not change any of the 
information in the Windows Registry. Changing values in the Windows Registry might affect 
the performance of your system.

To locate the AVX_Plug-Ins folder by using Regedit:

1. Click the Start button, and then click Run.

The Run dialog box opens.

2. Type regedit in the command line, and click OK.

The Registry Editor window opens.

3. In the left pane of the window, navigate to the following path:

HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\AVX Plug-Ins

4. Click the AVX Plug-Ins folder in the left pane, and then check the entry for “Directory” in the 
right pane.
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Updating and Promoting AVX Plug-ins
The value of this entry is the path that contains the AVX_Plug-Ins folder. For example, if the 
AVX_Plug-Ins folder is in its default location, the Directory entry is “C:\Program Files\Avid.” If 
you navigate to C:\Program Files\Avid using My Computer or Windows Explorer, you will find 
the AVX_Plug-Ins folder in that location.

The Directory entry for HKEY_LOCAL_MACHINE\SOFTWARE\Avid Technology\AVX Plug-ins in the Registry 
Editor

Updating and Promoting AVX Plug-ins
You can upgrade an AVX 1.x plug-in to a newer AVX 1.x plugin, or upgrade an AVX 2.0 plug-in to a 
newer AVX 2.0 plug-in.

You can promote some AVX 1.x plug-ins to an AVX 2.0 version if you have both versions of the 
plug-in installed on your system.

You can also promote all promotable AVX 1.x plug-ins in a sequence to AVX 2.0 in a single 
operation if the AVX 1.x plug-ins are missing (not installed on your system). For more information, 
see “Updating and Reverting Existing Effects in Sequences” on page 34.

n You might be able to downgrade an AVX 2.0 plug-in, depending on the vendor’s implementation. See 
your plug-in documentation for details.

To upgrade an AVX 1.x plug-in to a newer AVX 1.x plug-in or an AVX 2.0 plug-in to a newer AVX 
2.0 plug-in:

1. Uninstall the old version of the plug-in.

2. Install the new version in your AVX2_Plug-Ins or AVX_Plug-Ins folder.

Media Composer upgrades existing effects in sequences to be compatible with the new version. 
When you select one of the effects, the existing parameter values for the effect appear in the 
Effect Editor or in the plug-in’s own user interface.
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Assigning Multiple Tracks in Plug-in Effects
If the new version of the plug-in has new or redesigned parameter controls, Media Composer sets 
these controls to their default settings for existing effects. Controls that are unchanged from the 
older version of the plug-in retain the values you previously set.

c (AVX 1.x plug-ins only) Once you upgrade a plug-in effect, do not reinstall the older version of 
the plug-in. Media Composer cannot use an older version of a plug-in to process effects that 
you create with a newer version. Similarly, if you transfer projects between systems, an effect 
you create with a newer version of a plug-in does not work on a system that has an older 
version installed.

To promote an AVX 1.x plug-in effect to AVX 2.0:

1. Ensure that both the 1.x and the 2.0 versions of the plug-in are installed on your system.

2. Open the sequence containing the 1.x plug-in that you want to promote.

3. Open the AVX 1.x plug-in in the Effect Editor.

If the plug-in is promotable, the Promote to Advanced Keyframes button appears in the Effect 
Editor.

4. Click the Promote to Advanced Keyframes button.

The Effect Editor changes to display the advanced keyframe interface.

n New parameters might not exactly match the old parameters, depending on how the vendor 
implements the new version of the plug-in.

n Once you promote an effect to AVX 2.0 and save the effect in a bin, you cannot demote it back to AVX 
1.x. This is important if you are moving sequences and effects between different Avid editing systems. 
If you will be moving sequences and effects between newer and older Avid editing systems, you might 
want to keep the plug-in effect at the 1.x version.

Assigning Multiple Tracks in Plug-in Effects
Some plug-in effects take an arbitrary number of tracks as input. Media Composer lets you select the 
number of video inputs from the AVX Optional Inputs dialog box.

n For more information on the multiple track capabilities of a plug-in, see the documentation for that 
plug-in.

To assign multiple tracks to a plug-in effect by using the AVX Optional Inputs dialog box:

1. Drag the plug-in icon to the Timeline.

If the plug-in supports a variable number of input tracks, the AVX Optional Inputs dialog box 
opens.

2. Click the Number of Tracks menu, select the number of video inputs, and then click OK.

For more information on nested effects, see “Nesting Effects” on page 209.
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Using AVX Plug-In Controls
AVX plug-ins use a variety of interfaces that give you control over the effects. Plug-in vendors have 
the following styles for controls:

• Standard buttons and parameter controls.

For AVX 2.0 plug-ins, this includes advanced keyframe buttons and parameter controls.

The Effect Editor for a specific plug-in might include only Avid standard buttons and parameter 
controls, or it might include additional custom controls that use an Avid-like interface.

• Custom dialog box only.

You typically access this dialog box by clicking the Other Options button or another custom 
button in the Effect Editor.

• Direct manipulation controls in the Effect Preview monitor.

In this case, when you click the Outline/Path button in the Effect Editor, custom controls appear 
over the image in the monitor.

For more information on how the plug-in vendor implements their interface, see the plug-in vendor’s 
documentation.

Some plug-in effects let you adjust an image by using controls that appear as overlays, such as 
handles and wire frames, in the Effect Preview monitor. You access these overlays by clicking the 
Outline/Path button at the bottom of the Effect Editor. In some cases, you can then access further 
controls by clicking buttons on the right side of the Effect Editor that are similar to the buttons 
available in standard Avid 3D effects.

The Angle control is not available in standard Avid effects but appears in some AVX plug-in effects. 
The Angle control lets you alter an effect’s angle or direction value by dragging within a graphic 
representation of a circle. Values can be positive or negative and are not limited to a single 
360º rotation.
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Using the Client Monitor to Preview a Plug-In Effect
Using the Client Monitor to Preview a Plug-In Effect

Some plug-in vendors let you preview the effect in the client monitor. This lets you see how the effect 
will look in Media Composer while you are working on the effect in the plug-in interface. The effect 
does not play smoothly but you can view the results frame by frame.

Depending on the vendor’s implementation this might apply to HD as well as SD projects. See your 
plug-in documentation for information on whether the option is supported and any additional 
information on configuring the plug-in to work with the client monitor.

n The AVX Plug-ins custom interface cannot display frames on the client monitor if the Capture tool is 
open.

Troubleshooting AVX Plug-Ins
This topic describes problems that you might encounter with AVX plug-ins and suggests possible 
solutions or sources for more information. 

If a plug-in does not work as expected and these suggestions do not solve the problem, contact the 
plug-in vendor.

Plug-In Does Not Appear in the Effect Palette

AVX plug-ins have a plug-in icon in the Effect Palette and in the Timeline. If the plug-in icon does 
not appear in the Effect Palette after installation, the plug-in might be in the wrong folder. For more 
information, see “Locating the AVX 1.x Plug-Ins Folder (Windows Only)” on page 147 and 
“Installing AVX Plug-ins” on page 146.

Plug-In Does Not Load

AVX plug-ins might not load correctly for a variety of reasons. In particular, even though a plug-in is 
located correctly in the AVX2_Plug-Ins or AVX_Plug-Ins folder, it might require supporting files 
such as .dll files that are missing from your system or are installed in the wrong location.

The Console window might display messages about why a plug-in did not load correctly.

If a correctly located plug-in does not load, check the plug-in documentation for information on 
required supporting files.

Media Composer Cannot Render the Plug-In

If Media Composer cannot render the plug-in, the plug-in might have expired.

If you have problems rendering a plug-in effect, check the Console window. Some plug-ins write 
information about the failure to the Console window. Also, some plug-ins might report the problem 
as a message in the Bin or in the Edit monitor. 

Blank Effect Icons in the Timeline

AVX plug-ins have a plug-in icon in the Effect Palette and in the Timeline. If the effect icon in the 
Timeline is blank, Media Composer could not find the plug-in.
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Troubleshooting AVX Plug-Ins
To identify the plug-in that is missing or misplaced, open the Console window (select Tools > 
Console), and look for the message “Can’t find effect.” The message identifies the plug-in. You can 
then reinstall the plug-in in your AVX2_Plug-Ins or AVX_Plug-Ins folder and restart Media 
Composer.

Missing Effect Categories in the Effect Palette

If plug-in effect categories are not visible in the Effect Palette, either they are not installed correctly 
or you might have an incorrect version of the AVX Library. Check the Console window for a message 
that states that AVX was disabled.

• If AVX was not disabled, quit Media Composer, reinstall the plug-ins, and restart Media 
Composer.

• If AVX was disabled, contact Avid Technical Support to determine whether you need a new 
version of the AVXLibrary.

To obtain Technical Support, visit the online Knowledge Base at www.avid.com.

The Avid System Is Running Out of Free Memory

Each time you apply an AVX plug-in to a sequence, Media Composer keeps the effect resident in 
memory. When you close the bin containing the sequence, Media Composer also closes the AVX 
plug-ins and frees the memory. To close the AVX plug-ins manually, see “Freeing Memory Used by 
AVX 1.x Plug-ins” on page 146.
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7 Creating and Customizing Motion Effects

This chapter describes how to create and customize effects that alter motion in a clip either by 
changing a clip’s speed or by creating a strobe (stuttering) effect.

• Understanding Motion Effects

• Creating Traditional Motion Effects

• Playing and Rendering Motion Effects

• Understanding Timewarp Effects

• Creating Timewarp Effects

• Promoting a Traditional Motion Effect to Timewarp

• Using the Motion Effect Editor

• Scaling a Graph Display in the Motion Effect Editor

• Using the Source Anchor Frame

• Using Adaptive Deinterlacing

• Motion Effect Editor Reference

• Rendering Options for Timewarp Effects

• Timewarp Speed Graph Reference

• Timewarp Position Graph Reference

• Timewarp Effect Examples

• Understanding FluidMotion Timewarp Effects

• FluidMotion Workflow

• Using FluidMotion Edit

• Example of Correcting FluidMotion Artifacts

• Timewarp Preset Effects

• FluidFilm Preset Effects

• Setting Source and Output Options for Format Conversion with Timewarp Effects

Understanding Motion Effects
Motion effects divide into two main categories, traditional motion effects (sometimes known as 
source-side motion effects) and Timewarp effects.

Traditional Motion Effects

You create a traditional Freeze Frame, Variable Speed, or Strobe Motion effect by generating a new 
clip with specific motion characteristics from an original clip that you open in the Source monitor. 
You then edit the motion effect clip into your sequence.



Creating Traditional Motion Effects
For example, if you begin with a 3-second clip and create a Variable Speed motion effect from that 
clip with the speed set to 50%, the result is a new 6-second clip in which movement takes place at 
half the speed of the original clip.

The advantage of traditional motion effects is that they are simple to create. The disadvantage of 
traditional motion effects is that they limit flexibility when you are editing and they allow only one 
speed for the duration of the clip. You cannot change the speed of a Variable Speed effect without 
creating a new motion effect clip, and you cannot achieve an effect where a clip moves slowly for 
part of its duration and then suddenly speeds up.

For more information, see “Creating Traditional Motion Effects” on page 154.

Timewarp Effects

You create Timewarp effects by applying the Timewarp effect from the Effect Palette to a clip in a 
sequence. You modify the effect by using the Motion Effect Editor. You can also promote a 
traditional motion effect to a Timewarp effect once you edit it into a sequence.

You can use keyframes with the Timewarp effect to make multiple changes to the speed and position 
of any image in the effect. You can employ several different rates of speed, including reverse speed, 
in the same clip. You can also freely edit the effect, changing your speed settings as often as you need 
until you achieve the look you want.

In a Timewarp effect, the variations in speed are independent of the length of the clip in the sequence, 
so you can trim the clip without affecting your speed adjustments.

For more detailed information on Timewarp effects and how they differ from traditional motion 
effects, see “Understanding Timewarp Effects” on page 163.

Creating Traditional Motion Effects
You can create the following kinds of traditional motion effects:

• Freeze Frame

For more information, see “Creating a Traditional Freeze Frame Effect” on page 155 and 
“Creating a Rolling Clip That Freezes” on page 156.

• Variable Speed

For more information, see “Creating a Traditional Variable Speed Effect” on page 156 and 
“Using the Fit to Fill Button to Create a Variable Speed Effect” on page 158.

• Strobe Motion

For more information, see “Creating a Traditional Strobe Motion Effect” on page 159.

You can also combine a variable speed effect with a strobe motion effect. For more information, see 
“Creating a Traditional Variable Speed Effect” on page 156.

Some of the options you can choose from when you create traditional motion effects, for example the 
rendering options, affect the quality of the finished effect or its playback capabilities. It is important 
to understand these choices fully. For more information, see “Playing and Rendering Motion Effects” 
on page 160.
154



Creating Traditional Motion Effects
Creating a Traditional Freeze Frame Effect

A Freeze Frame effect is a still image, based on a selected frame from a clip, that continues to display 
for the duration that you select. When combined with the original clip, the footage plays and then 
“freezes” and holds on the frame that you specified.

As an alternative to creating a traditional freeze frame, you can use the Timewarp effect to freeze a 
single frame or create a rolling clip that freezes. See “Speed Graph Example: Creating a Rolling Clip 
That Freezes” on page 179.

To create a traditional Freeze Frame effect:

1. Load a clip into the Source monitor.

For more information, see “Creating and Editing Sequences” in the Help.

2. Cue the clip to the frame that you want to freeze.

3. Select Composer > Freeze Frame.

A submenu appears.

4. (Option) If you are using two-field or uncompressed media, select Two Field Freeze Frames, and 
then select one of the following:

n For more information on these options, see “Motion Effect: Freeze Frame” on page 474.

The selected option becomes the default until you select another option.

5. (Option) If you made a Two Field Freeze Frames choice in step 4, select Composer > Freeze 
Frame again.

6. Select a duration:

t Select a preconfigured duration from the list.

t Select Other, type a custom duration in the dialog box, and then click OK to enter the new 
duration.

A dialog box opens and prompts you to select a target drive for the freeze frame media.

7. Click the Drive menu, select a drive, and then click OK.

A new clip appears in the Source monitor and in the current bin preceded by a Motion Effect 
icon. The new clip has the original clip name followed by the letters FF.

Option Description

Using Duplicated Field Media Composer uses a single field to create the effect. This reduces 
the vertical resolution of the image by one-half, but is often the best 
option if the source footage contains rapid motion.

Using Both Fields Media Composer uses both fields to create the effect. This option is 
especially useful when there is little or no motion in the footage 
because it preserves all vertical resolution.

Using Interpolated Field Media Composer creates a second field for the effect by combining 
scan line pairs from the first field in the original media. This might 
result in a slightly softer look to the freeze frame.
155



Creating Traditional Motion Effects
Motion Effect icon and FF (Freeze Frame) clip name suffix on a Freeze Frame clip in the bin

Creating a Rolling Clip That Freezes

One common use for freeze frames is to create a segment that plays normally and then freezes, either 
to superimpose text information or to add emphasis to the end of a sequence before fading.

For an example that uses the Timewarp effect instead of a traditional freeze frame, see “Speed Graph 
Example: Creating a Rolling Clip That Freezes” on page 179.

To create a rolling clip that freezes:

1. Edit the clip into the sequence.

2. Mark an IN point in the sequence at the frame where you want the freeze frame to occur.

3. Click the Match Frame button to load and cue the source clip to the matching frame.

For more information on matchframing, see “Using Match Frame” in the Help.

4. Create the Freeze Frame effect from the source footage as described in “Creating a Traditional 
Freeze Frame Effect” on page 155.

5. Click the Extract/Splice-in button or the Lift/Overwrite button to edit the freeze frame into the 
sequence at the previously marked IN point.

Extract/Splice-in button (left) and Lift/Overwrite button (right)

When you play the sequence, the footage plays full-motion and then freezes at the 
selected frame.

Creating a Traditional Variable Speed Effect

Variable Speed effects involve changing the rate of playback to achieve fast-motion or slow-motion 
effects. Media Composer creates slow-motion effects by duplicating frames in the original media. It 
creates fast-motion effects by eliminating frames from the original media.

For information on using the Timewarp effect to create a Variable Speed effect, see “Timewarp Speed 
Graph Reference” on page 176 and “Position Graph Example: Reverse Motion” on page 184.

To create a Variable Speed effect:

1. (Option) If you require a fixed duration for the clip based on a segment in the sequence, mark the 
segment in the Timeline with IN and OUT points.

n You can use the Fit to Fill button to create a motion effect of fixed duration. See “Using the Fit to Fill 
Button to Create a Variable Speed Effect” on page 158.

2. (Option) If you want to use only part of the source clip for the motion effect, mark IN and OUT 
points in the Source monitor.
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3. Click in the Source monitor to activate it.

n If you do not activate the Source monitor, clicking the Motion Effect button does not open the Motion 
Effect dialog box. If the Record monitor is active, clicking the Motion Effect button opens the Motion 
Effect Editor for Timewarp effects.

4. Do the following:

a. Select Tools > Command Palette.

b. Click the FX tab.

c. Select Active Palette.

d. Click the Motion Effect button.

The Motion Effect dialog box opens.

n If you map the Motion Effect button from the Command palette to the button palettes on the interface 
or to the keyboard, it opens the Motion Effect Editor for Timewarp effects. You must use the Motion 
Effect button in the Command palette (with Active Palette selected) to create traditional Variable 
Speed or Strobe Motion effects. For information on using the Command palette, see “The Command 
Palette” in the Help.

5. Select the Variable Speed option.

6. Specify the play speed for the Variable Speed motion effect by doing one of the following: 

t Type a number of frames in the Frames text box.

t Type a frame rate in the FPS text box. To indicate reverse motion, enter a negative number 
for the play rate.

t Type a percentage of the current play rate in the % Speed text box. To indicate reverse 
motion, enter a negative number for the percentage.

t Select the Fit To Fill option to automatically set the variable speed parameters so that the 
duration of the motion effect will match the IN to OUT duration marked in the sequence.

All of the values change to reflect the rate you specify.

7. (Option) If you are using two-field or uncompressed media, select Two Field Freeze Frames, and 
then select one of the following:

n For more information on these options, see “Motion Effect: Variable Speed and Strobe Motion” on 
page 474.

Option Description

Duplicated Field Media Composer creates the effect using one field.

Both Fields Media Composer creates the effect using both fields.

Interpolated Field Media Composer creates a second field for the effect by combining 
scan line pairs from the first field in the original media.

VTR-Style Media Composer creates a second field for the effect by shifting 
selected video fields of the original media by a full scan line. This 
technique is similar to that used by high-quality professional video 
decks when playing footage at less than normal speed.
157



Creating Traditional Motion Effects
8. (Option) If you are using two-field media, and a specific motion effect type is set as the Motion 
Effects Render Using option in the active Render setting (in the Settings list), Media Composer 
automatically selects that type in the Motion Effect dialog box, makes all other types 
unavailable, and displays the Ignore Render Setting check box. If you want to override the 
Render setting, select the Ignore Render Setting check box, and then select one of the four 
options described in step 7.

9. Do one of the following:

t Click Create to create the new clip and close the dialog box.

Another dialog box asks you to select the target bin for the effect.

t Click Create and Render to render the clip (creating new media files) and close the dialog 
box.

Another dialog box asks you to select the target bin for the effect.

n You must render a reverse motion Variable Speed effect in order to play it back in real time. If you do 
not render the effect at the time you create it, the effect plays back as filler (black image) until it is 
rendered.

A new clip appears in the Source monitor and in the current bin. The clip has the original clip 
name followed by the frame rate in parentheses. You can then edit this clip into your sequence as 
you would any other clip.

Motion Effect icon and Variable Speed clip name suffix on a Variable Speed clip in the bin

Using the Fit to Fill Button to Create a Variable Speed Effect

You can create a Variable Speed effect that is automatically sized to fit a marked IN to OUT duration 
in a sequence by clicking the Fit to Fill button.

The Fit to Fill button, in the Edit tab of the Command palette, performs an overwrite edit and uses a 
Variable Speed motion effect to fill the marked duration. When you click the Fit to Fill button, Media 
Composer automatically selects variable speed parameters so that the duration of the motion effect 
matches the IN to OUT duration marked in the Timeline. Media Composer then overwrites the 
motion effect into the sequence.

The motion effect you create with the Fit to Fill button uses the parameters you set in the Render 
Setting and Media Creation dialog boxes. If the Render preference is set to Original Preference, the 
new motion effect is rendered with duplicated fields.

n To create an unrendered motion effect, press the Alt key (Windows) or the Option key (Macintosh) 
when you click the Fit to Fill button.

For more information, see “The Command Palette,” “Performing an Overwrite Edit,” and “Media 
Creation Settings” in the Help.

For information about Render settings, see “Creating and Using Render Settings” on page 134.
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Creating a Traditional Strobe Motion Effect

Strobe motion results in a stuttering effect during playback of a clip. You determine the degree of the 
stutter or strobe when you create the effect.

You can also combine the Strobe Motion effect with the Variable Speed effect. For more information 
on the Variable Speed effect, see “Creating a Traditional Variable Speed Effect” on page 156.

For a procedure using the Timewarp effect, see “Strobe Motion Using the Timewarp Effect” on 
page 182.

To create a Strobe Motion effect:

1. (Option) If you want to use only part of the source clip for the effect, mark IN and OUT points in 
the Source monitor.

2. Click in the Source monitor to activate it.

n If you do not activate the Source monitor, clicking the Motion Effect button does not open the Motion 
Effect dialog box. If the Record monitor is active, clicking the Motion Effect button opens the Motion 
Effect Editor for Timewarp effects.

3. Do the following:

a. Select Tools > Command Palette.

b. Click the FX tab.

c. Select Active Palette.

d. Click the Motion Effect button.

The Motion Effect dialog box opens.

n The Motion Effect button on the Tool palette and in the Timeline top toolbar opens the Motion Effect 
Editor for Timewarp effects. If you map the Motion Effect button from the Command palette to 
another button, it opens the Motion Effect Editor. You must use the Motion Effect button in the 
Command palette to create traditional Variable Speed or Strobe Motion effects.

4. Select the Strobe Motion option.

5. Specify the update rate in frames for the Strobe Motion effect.

For example, a rate of 5 causes every fifth frame to be held for five frames before updating in the 
Strobe Motion effect. 

6. (Option) If you are using two-field or uncompressed media, select Two Field Freeze Frames, and 
then select one of the following:

Option Description

Duplicated Field Media Composer creates the effect using one field.

Both Fields Media Composer creates the effect using both fields.

Interpolated Field Media Composer creates a second field for the effect by combining 
scan line pairs from the first field in the original media.
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n For more information on these options, see “Motion Effect: Variable Speed and Strobe Motion” on 
page 474.

7. (Option) If you are using two-field media, and a specific motion effect type is set as the Motion 
Effects Render Using option in the active Render setting (in the Settings list), Media Composer 
automatically selects that type in the Motion Effect dialog box, makes all other types 
unavailable, and displays the Ignore Render Setting check box.

8. Do one of the following:

t Click Create to create the new clip and close the dialog box.

Another dialog box asks you to select the target bin for the effect.

t Click Create and Render to render the clip (creating new media files) and close the dialog 
box.

Another dialog box asks you to select the target bin for the effect.

n You must render a Strobe Motion effect in order to play it back in real time. If you do not render the 
effect at the time you create it, the effect plays back as filler (black image) until it is rendered.

A new clip appears in the Source monitor and in the current bin preceded by a Motion Effect 
icon. The new clip has the original clip name followed by the word Strobe and the number of 
update frames in parentheses.

Motion Effect icon and Strobe Motion clip name suffix on a Strobe Motion clip in the bin

Playing and Rendering Motion Effects
This section provides information on playback capabilities for traditional motion effects, and on your 
options for rendering and rerendering motion effects.

Playback Capabilities for Traditional Motion Effects

Some motion effect clips play in real time when edited into a sequence. You must render others 
before they can play. The following table describes the normal playback capabilities for traditional 
motion effects:

VTR-Style Media Composer creates a second field for the effect by shifting 
selected video fields of the original media by a full scan line. This 
technique is similar to that used by high-quality professional video 
decks when playing footage at less than normal speed.

Option Description
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Understanding When to Render or Rerender Motion Effects

You sometimes need to render or rerender existing traditional motion effects. To do this, follow one 
of the procedures described in “Basics of Effects Rendering” on page 41.

You might need to render or rerender motion effects in the following circumstances:

• You need to render any motion effect that requires rendering for successful playback if you did 
not render the effect when you created it.

This kind of effect appears with a blue dot in the Timeline until you render it.

• You might need to render a motion effect so that it plays successfully in a complex sequence 
even if that effect does not normally require rendering.

This kind of effect appears with a green dot in the Timeline, but might not play back in real time 
under some circumstances. 

For more information on overall real-time playback capabilities, see “Real-Time Playback of 
Video Effects” on page 122.

• You might need to render or rerender motion effects when you edit them into a sequence and 
perform trims or apply transition effects.

This kind of effect appears with a blue dot in the Timeline after the changes that cause it to 
require rendering. (Previously, it appeared with no colored dot in the Timeline (if it had been 
rendered) or with a green dot in the Timeline (if it previously played in real time).

The Partial Render feature lets you render only those parts of the Motion Effect clip that have 
been changed by your editing. The Render Ranges command in the Timeline Fast menu lets you 
see which parts of the motion effect require rendering. For more information, see “Using Partial 
Render” on page 137.

• You need to rerender motion effects when you recapture media at a different resolution.

For example, if you offline a sequence using a single-field resolution and then recapture at a two-
field resolution, you need to rerender all motion effects before they can play back correctly. In 
this circumstance, it is important to manage the quality of the finished effects using the most 
appropriate Render settings. For more information, see “Controlling Motion Effect Type When 
Rendering or Rerendering Motion Effects” on page 162 and “Creating and Using Render 
Settings” on page 134.

Effect Type Description

Freeze Frame Clips play in real time regardless of their type or duration. No icon appears on a 
Freeze Frame clip in the Timeline.

Variable Speed, 
forward motion

Clips play in real time and appear with a motion effect icon and a green dot in the 
Timeline. The motion effect icon indicates the type of the effect.

Variable Speed, 
reverse motion

Clips cannot play in real time and play as filler (black image) until you render 
them. Clips of this type appear with a motion effect icon and a blue dot in the 
Timeline.

Strobe Motion or 
Strobe Motion 
combined with 
Variable Speed

Clips cannot play in real time and play as filler (black image) until you render 
them. Clips of this type appear with a motion effect icon and a blue dot in the 
Timeline.
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Controlling Motion Effect Type When Rendering or Rerendering Motion Effects

Each motion effect type has a distinct effect icon in the Timeline:

Color-coded dots appear on Motion Effect icons to indicate whether they require rendering. For more 
information, see “Color Coding on Effect Icons” on page 18.

The following illustration shows several examples of Motion Effect icons in the Timeline.

Left to right, examples of Motion Effect icons in the Timeline: rendered VTR-style motion effect (no dot); unrendered 
Interpolated Field motion effect (green dot — plays in real time); unrendered Interpolated Field motion effect (blue dot — 
plays as black until rendered)

ExpertRender correctly identifies motion effects that require rendering.

The motion effect type that Media Composer uses when it renders a motion effect depends on the 
setting for the Motion Effects Render Using option or the Timewarp Effects Render Using option in 
the active Render setting. If the option is set to Original Preference (the default setting), Media 
Composer makes no change to the type of motion effects when it renders them. If the option is set to 
a specific motion effect type, Media Composer changes all motion effects to that type when it renders 
them.

If you render motion effects after recapturing at a new resolution, or if you have another reason for 
wanting to change the type of all motion effects, ensure you have set the type you want in the active 
Render setting. Changes to motion effect types are permanent changes to both the Motion Effect clip 
and its associated media. You can return to the old motion effect type only by rerendering.

Using the same type for all motion effects is particularly important for controlling the look of motion 
effects when you are working with two-field media. For example, you might offline a project using 
single-field media and the Duplicated Field type for motion effects. Later, you might recapture the 
media at a two-field resolution, set the Motion Effects Render Using option in the active Render 
setting to VTR-Style, and submit the whole sequence for rendering. This creates new motion effects 
that are higher quality and that can play with the two-field media.

If you want to ignore the motion effect type set in the active Render setting for an individual motion 
effect or for a group of motion effects selected for rendering, you can do so using the Ignore Render 
Setting check box in the Motion Effect Editor. For more information, see “Motion Effect Editor 
Reference” on page 171.

Icon Description Icon Description

Duplicated Field Motion Effect Interpolated Field Motion Effect

Both Fields Motion Effect VTR-Style Motion Effect
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Considerations for Motion Effects in Progressive Projects

Motion effects in progressive projects behave somewhat differently from the same effects in 
interlaced projects. You should be aware of the following issues when you are working with motion 
effects in progressive projects.

• Media Composer always uses complete progressive frames to create motion effects since there 
are no fields in progressive material. There are no two-field rendering options available in the 
Motion Effect dialog box in a progressive project.

• Media Composer creates motion effects by duplicating or eliminating frames to speed up or slow 
down the motion. Because progressive motion effects use a relatively small number of full 
frames per second (for example, 24 or 25), if you use speed ratios that are not integer values, you 
might notice minor stuttering due to unusual patterns of duplication. Select simple ratios such as 
2:1 (50%), 3:1 (33%), or 4:1 (25%).

• Progressive motion effects might look slightly different from interlaced motion effects because 
of the way Media Composer handles progressive material. For more information, see “Working 
with Effects in HD and in Progressive Frame Projects” on page 21.

Understanding Timewarp Effects
Timewarp effects provides a powerful and flexible alternative to traditional motion effects. You apply 
Timewarp effects to segments in a sequence, and then use keyframes and other controls in the Motion 
Effect Editor to control the speed and the position of any image in the effect. For example, you can 
create a sequence that begins and ends with specific images, and in which the speed of motion 
changes an arbitrary number of times between the first image and the last.

For information on creating and modifying Timewarp effects, see “Creating Timewarp Effects” on 
page 165, “Promoting a Traditional Motion Effect to Timewarp” on page 166, and “Using the Motion 
Effect Editor” on page 167.

FluidMotion is a method of interpolating motion in a Timewarp effect that results in extremely 
smooth motion. The tools available in FluidMotion Edit lets you refine the results of rendering 
effects with FluidMotion. For more information, see “Understanding FluidMotion Timewarp 
Effects” on page 186.

Differences Between Timewarp Effects and Traditional Motion Effects

Timewarp effects differ from traditional motion effects in the following ways:

Difference Description

Method of 
application

You apply a Timewarp effect to a segment in a sequence, in just the same way that 
you apply any other effect from the Effect Palette. To switch to a different 
Timewarp effect, just replace the effect.

With traditional effects, you must load a source clip, create a motion effect clip 
from that source clip, and then edit the motion effect into the sequence. If you want 
to change the speed, you must go back to the original clip, make a new motion 
effect clip, and then cut the new effect clip into the sequence.
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Understanding Speed and Position Controls for Timewarp Effects

The Timewarp effect provides two ways to control motion: speed and position. You display the Speed 
graph and the Position graph in the Motion Effect Editor.

The Speed control resembles traditional motion effects because you determine how fast you want the 
clip to play and change the speed accordingly. The Motion Effect Editor displays the speed of the 
source (input speed) at output time in the Speed graph. You customize the effect by using the Speed 
graph to add keyframes at specific times and then setting the speed of the effect at that time. For more 
information, see “Timewarp Speed Graph Reference” on page 176.

Position maps input (source) time to output (effect) time. The Motion Effect Editor displays input 
time (vertical axis) over output time (horizontal axis) in the Position graph. You use the Position 
graph if you need a specific frame in the source to be at a specific frame in the effect. For example, 
you might want the clip to begin with a soccer player kicking the ball and end with the goalie 
catching the ball. You can position everything in between for effect, but you keep these two 
keyframes fixed. For more information, see “Timewarp Position Graph Reference” on page 177.

You can work with either the Speed graph or the Position graph but not both at once. The adjustments 
you make with one control graph do not alter adjustments made on the other control graph. You 
activate the graph with which you want to work by selecting it from the Edit Graph menu. See “Using 
the Motion Effect Editor” on page 167.

n When you render a Timewarp effect, Media Composer applies only the information from the active 
graph.

Media Composer stores keyframe information for both control graphs and maintains the two sets of 
keyframe information separately. For example, you might make adjustments using the Speed graph, 
switch to working with the Position graph, and then change back to the Speed graph. Media 
Composer displays and applies all the keyframe information you initially created using the Speed 
graph. It does not show your adjustments with the Position graph, but does save the Position graph 
information so you can return to it if you choose.

While you adjust the active graph, the Motion Effect Editor represents changes in the inactive graph 
as well. This gives you a visual check in the inactive graph of your modifications to the active graph. 
You might find this useful, especially when working with the Position graph, to give you an idea of 
how your position alterations affect the speed of the effect.

Clip duration With traditional motion effects, if you create an effect at 50-percent speed, the clip 
becomes twice as long.

With the Timewarp effect, the duration of the segment in the sequence does not 
change. You can enter Trim mode directly from the Motion Effect Editor to make 
the segment longer or shorter.

Speed display 
in the Timeline

Traditional motion effects display the effect speed in parentheses beside the effect 
icon in the Timeline.

Because the speed in a Timewarp effect is not fixed, a clip with a Timewarp effect 
does not display the speed.

Difference Description
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Understanding Keyframe Interpolation Options for Timewarp Effects

You select a keyframe interpolation option to define the way the Timewarp effect changes speed or 
position in a clip. This selection determines the rate of change and the relative smoothness of change 
at keyframes. For example, you can create an effect in which all changes occur abruptly, or you can 
choose to smooth out all changes. For a full explanation of interpolation options, see “Controlling 
Parameter Changes at Keyframes” on page 106.

You select an interpolation option from the Motion Effect Editor Fast menu.

Rendering Timewarp Effects

In addition to the rendering options familiar from other Avid effects (Duplicated Field, Both Fields, 
Interpolated Field, and VTR-Style), the Timewarp effect offers the following rendering options:

• Blended Interpolated takes the quality of the Interpolated Field option and combines it with 
frame blending.

• Blended VTR first applies the VTR-Style rendering option and then applies frame blending

• FluidMotion .uses an interpolation algorithm that creates intermediate images by morphing the 
motion across the bracketing images

This results in extremely smooth motion. However, it can also cause artifacts (distorted areas) to 
appear when objects move in front of or behind other objects, move significantly from one frame 
to the next, or move into the image from outside the frame. FluidMotion Edit provides tools for 
correcting artifacts. See “Understanding FluidMotion Timewarp Effects” on page 186.

For more information, see “Rendering Options for Timewarp Effects” on page 174.

Rendering time for a Timewarp effect varies considerably. The following list ranks the rendering 
options by length of rendering time, from shortest to longest:

• Duplicated Field

• Both Fields

• Interpolated Field and VTR-Style (approximately the same)

• Blended Interpolated and Blended VTR (approximately the same)

• FluidMotion Draft

• FluidMotion

n To save time while rendering the Timewarp effect, select a faster rendering option to rough out your 
sequence, and use FluidMotion only when you are satisfied with the overall sequence.

Creating Timewarp Effects
You create a Timewarp effect by dragging the Timewarp effect icon from the Effect Palette.

You can also promote a traditional motion effect to a Timewarp effect. For more information, see 
“Promoting a Traditional Motion Effect to Timewarp” on page 166.

To apply a Timewarp effect from the Effect Palette:

1. Create a sequence in the Record monitor.

For information about creating a sequence, see “Creating and Editing Sequences” in the Help.
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2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. In the Effect Palette, click the Timewarp Effect category.

4. Click the Timewarp Effect icon, and drag it to the clip in the Timeline.

The Timewarp Effect icon appears in the Timeline.

n If you apply the Timewarp effect as part of a nested effect, it must be the innermost effect.

Promoting a Traditional Motion Effect to Timewarp
You can promote a traditional motion effect to the Timewarp effect by using the Promote button in 
the Motion Effect Editor. The Promote button appears in the Motion Effect Editor only when you 
have the position indicator on a traditional motion effect in the Timeline.

You can also promote all traditional motion effects in a sequence to Timewarp effects with a single 
operation. For more information, see “Updating and Reverting Existing Effects in Sequences” on 
page 34.

n Once you promote the effect, you might not be able to load or use the sequence in an older version of 
an Avid editing application. Before promoting any effect, create a copy of the original sequence.

To promote a traditional motion effect to a Timewarp effect:

1. Move the position indicator to the traditional motion effect in the Timeline.

2. Click the Effect Mode button or the Motion Effect button.

Effect Mode button (left) and Motion Effect button (right)

For more information, see “Using the Motion Effect Editor” on page 167.

The Motion Effect Editor opens.

The Promote button appears in the Motion Effect Editor. The Speed, Strobe and Duration values 
for the motion effect appear in the appropriate text boxes in the Motion Effect Editor.
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Promote button, Speed value text box, and Strobe and Duration value text boxes in the Motion Effect Editor

3. In the Motion Effect Editor, click the Promote button.

The Timewarp icon appears in the Timeline. The Motion Effect Editor uses the duration and 
speed information from the traditional motion effect to create a Timewarp effect.

n Strobe motion information does not carry over to the Timewarp effect.

The name of the clip in the Timeline does not change. Media Composer creates traditional 
motion effect clips with speed and strobe information in parentheses following the name. For 
example, a traditional motion effect clip named Turbocharge (15FPS) (Strobe: 5) is a half-speed 
effect with a strobe every five frames. After you promote the effect to a Timewarp effect, the 
name remains the same. This can be confusing if you rely on the information in parentheses to 
accurately reflect the effect’s parameters.

Using the Motion Effect Editor
You customize Timewarp effects by using the Motion Effect Editor.

You do not have to be in Effect mode to use the Motion Effect Editor, and you do not have to close 
the Motion Effect Editor to use other modes. You can, for example, use the Motion Effect Editor 
while in Trim mode.

n You cannot create a traditional motion effect with the Motion Effect Editor open. To create a 
traditional motion effect, close the Motion Effect Editor and follow the procedure in “Creating 
Traditional Motion Effects” on page 154.

You can expand the Motion Effect Editor to display the Speed graph, the Position graph, or both. 
Displaying a graph does not activate the graph.

You use the Edit Graph menu to activate a graph. Although both graphs might be visible, only one 
graph can be active at a time. However, you can switch between the Speed graph and the Position 
graph while you are working.
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The following illustration shows the fully expanded Motion Effect Editor.

To set up the Motion Effect Editor for customizing a Timewarp effect:

1. Do one of the following:

t Click the Timewarp Effect icon in the Effect Palette and drag it to the segment in the 
Timeline where you want to create a Timewarp effect.

t Move the position indicator to an existing Timewarp effect in the sequence.

2. If the Motion Effect Editor is not already open, click the Motion Effect button.

For more information, see “Using the Motion Effect Editor” on page 167.

The Motion Effect Editor opens.

n The Motion Effect button appears in the Tool palette and in the Timeline top toolbar. You can also 
map the Motion Effect button from the Command palette to another button or to the keyboard. For 
more information, see the following topics in the Help: “Using the Tool Palette,” “Displaying the 
Timeline Top Toolbar,” and “The Command Palette.”

3. Click either the Speed Graph Display button or the Position Graph Display button.

Speed Graph Display button (left) and Position Graph Display button (right)

The appropriate graph opens, and the button you clicked changes it appearance.

4. Click the Edit Graph menu, and select one of the following: 

t Speed to activate the Speed graph

t Position to activate the Position graph

The graph you selected becomes the active graph. The Fast Menu, Go to Previous Event, Go to 
Next Event, and Add Keyframe buttons appear under the active graph. For more information, see 
“Motion Effect Editor Reference” on page 171.

5. Make input and output format selections appropriate for your project in the Formats dialog box.

For more information, see “Motion Effect Editor Reference” on page 171.

6. Click the Motion Effect Editor Fast Menu button, and select an interpolation option.

 For more information, see “Controlling Parameter Changes at Keyframes” on page 106.
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7. (Option) If you are using two-field media, and a specific motion effect type is set as the 
Timewarp Effects Render Using option in the active Render setting, Media Composer 
automatically selects that type in the Type menu, makes all other types unavailable, and displays 
the Ignore Render Setting option.

If you want to override the Render setting, select the Ignore Render Setting option, and then 
select a new rendering option. For a complete description of rendering options, see “Rendering 
Options for Timewarp Effects” on page 174.

8. Customize your effect.

For more information, see “Timewarp Speed Graph Reference” on page 176 and “Timewarp 
Position Graph Reference” on page 177.

For examples using the Speed graph and the Position graph to create various effects, see 
“Timewarp Effect Examples” on page 179.

Scaling a Graph Display in the Motion Effect Editor
Each graph in the Motion Effect Editor has a Value scale slider and a Position scale slider. You use 
these sliders to scale the graph view up or down to see more or less detail.

For the Speed graph, the Value scale slider controls the Percent Speed (vertical) axis, and the Position 
scale slider controls the Output Position (horizontal) axis.

For the Position graph, the Value scale slider controls the Input Position (vertical) axis, and the 
Position scale slider controls the Output Position (horizontal) axis.

Speed graph (left) and Position graph (right) in the Motion Effect Editor. Below each graph are the Value scale slider (on 
the left), which controls the scaling of the vertical axis, and the Position scale slider (on the right), which controls the 
scaling of the horizontal axis.

To change the amount of detail in the Percent Speed axis (Speed graph) or the Input Position 
axis (Position graph):

t Drag the Value scale slider for either the Speed graph or the Position graph to the right (to show 
more detail) or to the left (to show less detail.

To change the amount of detail in the Output Position axis for either graph:

t Drag the Position scale slider for either the Speed graph or the Position graph to the right (to 
show more detail) or to the left (to show less detail).
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n The darker gray area of a graph represents the valid working area (the amount of source material 
you have available). The lighter gray area represents handles before and after the source material.

To move the view in the graph display without scaling:

1. Click within the boundaries of the graph display you want to move.

2. Press and hold Ctrl+Alt (Windows) or Command+Option (Macintosh).

The pointer changes to a hand.

3. Drag the hand in any direction to reposition the view within the graph display.

Using the Source Anchor Frame
Media Composer needs to know the Source Anchor Frame to completely determine the results of 
Speed graph settings. One point in the source material — the input material for the effect — must 
map to one point in the effect — the output material. This allows Media Composer to use your Speed 
graph keyframe information to create the Timewarp effect.

The default Source Anchor Frame is the first frame or field of the source, and the default point for 
anchoring the Source Anchor Frame is timecode 0 — the first frame or field of the effect’s output. 

When you select elastic keyframes, the Source Anchor Frame determines which frame remains 
anchored (stays the same) while the other keyframes stretch or compress. See “Controlling Advanced 
Keyframe Behavior with Trimmed Effects” on page 110.

To change the Source Anchor Frame:

t Enter the source timecode of the frame or field you selected in the Anchor text box.

To anchor the Source Anchor Frame at the active keyframe:

t Click the Source Anchor Frame button.

The Source Anchor Frame indicator moves to the active keyframe. The output timecode shows 
above the Record monitor.

To anchor the Source Anchor Frame manually:

t Click the Source Anchor Frame indicator, and drag it in the Output Position axis of the Speed 
graph.

The output timecode shows above the Record monitor.

Using Adaptive Deinterlacing
Adaptive deinterlacing is an additional processing option for Timewarp and Motion Adapter effects. 
The Adaptive Deinterlace Source check box is available in the Motion Effect Editor when all of the 
following are true:

• The Source parameter value is Interlaced.

• The Output parameter value is Progressive.

• The Type parameter value is one of the following: Both Fields, Blended Interpolated, Blended 
VTR.
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Adaptive deinterlacing uses an algorithm for producing progressive frames from interlaced fields that 
analyzes adjacent frames as well as the currrent frame. Adaptive deinterlacing results in higher image 
quality for some kinds of clips, particularly where there is fast motion in the clip and when the clip is 
being slowed down significantly. For example, it can help to eliminate interlacing line artifacts, or 
jagged edges between a moving object and a background, without losing information from an entire 
field.

However, the complex calculations required by adaptive deinterlacing reduce processing 
performance, so you need to balance this against any improvement in image quality. You can 
experiment with the option to see whether it provides a valuable gain in image quality with your 
footage at an acceptable performance cost.

Motion Effect Editor Reference
The initial appearance of the Motion Effect Editor depends on whether there is no motion effect, a 
Timewarp effect, or a traditional motion effect in the segment at the position indicator. The following 
illustration shows the three possibilities.

Initial appearance of the Motion Effect Editor when no effect (left), a Timewarp effect (center), or a traditional motion 
effect (right) is in the segment at the location of the position indicator.

Motion Effect Editor Components  

Component Description

Timewarp Effect icon Drag the icon to a bin to create a Timewarp Effect template from the current 
settings in the Speed graph and Position graph.

Speed Graph display button

Graph closed (left) and open (right)

Click to open or close the Speed graph. See “Using the Motion Effect Editor” 
on page 167.
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Position Graph display button

Graph closed (left) and open (right)

Click to open the Position graph. Click again to close the Position graph. See 
“Using the Motion Effect Editor” on page 167.

n Clicking a graph display button does not activate the graph. Use the Edit Graph menu (described below) 
to select the Speed graph or Position graph.

Promote to Timewarp button Click to promote a traditional motion effect to a Timewarp effect. See 
“Creating Timewarp Effects” on page 165.

Edit Graph menu

• Speed

• Position

Click to activate a control graph with which to customize the Timewarp effect. 
You can work with either the Speed graph or the Position graph but not both at 
once.

n The Motion Effect Editor applies information only from the active 
control graph.

For more information, see “Timewarp Speed Graph Reference” on page 176 
and “Timewarp Position Graph Reference” on page 177.

Type menu Click to select a rendering option. For more information, see “Playing and 
Rendering Motion Effects” on page 160 and “Rendering Options for 
Timewarp Effects” on page 174.

Ignore Render Setting check box The Ignore Render Setting check box appears below the Type menu when you 
have made a rendering selection other than Original Preference in either the 
Motion Effects Render Using or the Timewarp Effects Render Using menu in 
the Render Setting dialog box. In this situation, the Type menu is dimmed.

If you want to override the motion effect render settings in the Render Setting 
dialog box, click the Ignore Render Setting check box, and then select an 
option from the Type menu. For information about the Render Setting dialog 
box, see “Creating and Using Render Settings” on page 134.

Speed display Displays the percent speed of the traditional motion effect.

Anchor text box Displays the source timecode of the Source Anchor Frame. Use the Anchor 
text box to set the timecode of the Source Anchor Frame for the Timewarp 
effect. For more information, see “Using the Source Anchor Frame” on 
page 170.

Source Anchor Frame button Click to set the Source Anchor Frame at the active keyframe. The default 
Source Anchor Frame is the first frame of the source clip. For more 
information, see “Using the Source Anchor Frame” on page 170.

Source menu Click to select the Source format for a rendered Timewarp effect. Your 
selection should match the format of the original source material. For 
example, if you shot the material on a 30i camera, select Interlaced.

Motion Effect Editor Components(Continued)  

Component Description
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The following table describes the buttons that always appear in the Motion Effect Editor toolbar.

The following table describes the buttons that appear in the Motion Effect Editor toolbar below the 
active control graph.

Output menu Click to select the Output format for a rendered Timewarp effect. If you are 
creating a regular motion effect, you can use the same value as for the Source 
format. You also have the option of performing a format conversion on the 
effect. This lets you create a film look from interlaced video sources. For 
more information, see “FluidFilm Preset Effects” on page 193.

You might also use a Timewarp effect to help in the processing of an effect on 
an interlaced clip within a progressive project. In this situation, you set the 
Source menu to Interlaced and the Output menu to Progressive.

n The Source and Output menus are not available in Film projects.

Adaptive Deinterlace Source 
option

Adaptive Deinterlacing is an additional processing option that might improve 
output image quality in some circumstances. This option is only available 
when certain combinations of options are set in the Type, Source, and Output 
menus. For more information, see “Using Adaptive Deinterlacing” on 
page 170.

Strobe n frames text box Displays the number of frames the Strobe Motion effect holds the image 
before updating. To change the strobe rate of the effect, type a new strobe rate 
in the text box and then press Enter (Windows) or Return (Macintosh).

Duration display Displays the duration of the effect. If you change the output duration by 
manipulating the Speed graph or Position graph, or by trimming the clip in the 
Timeline, Media Composer reflects the new duration in this display.

Motion Effect Editor Components(Continued)  

Component Description

Motion Effect Editor Toolbar Buttons  

Button Description

Render Effect Renders the Timewarp effect with the selected rendering option.

Remove Effect Removes the Timewarp effect.

Match Frame Finds and displays the frame in the source material that matches the frame in the 
Timewarp effect. In the case of an intermediate (interpolated) frame, the frame that 
displays is the frame closest to the intermediate frame.

Play Loop Plays the Timewarp effect in a loop.

Play Plays the Timewarp effect from the current position in the effect’s position bar.

Trim Mode You can trim out or trim in material while the Motion Effect Editor is active. For 
more information, see “Working in Trim Mode” in the Help.
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Rendering Options for Timewarp Effects
For information on selecting a rendering option, see “Using the Motion Effect Editor” on page 167.

Active Control Graph Buttons  

Button Description

Fast Menu Displays the Fast menu.

The same menu appears as the shortcut menu when you right-click the active control 
graph.

Because the Motion Effect Editor uses advanced keyframes, its Fast menu is similar to 
the Effect Editor shortcut menu for keyframe graphs. The components of these menus 
are described in “Shortcut Menus for Keyframe Tracks and the Motion Effect Editor” on 
page 116.

Go to Previous 
Event

Moves the position indicator one keyframe to the left and activates the keyframe. If 
there is no keyframe to the left, nothing happens.

Go to Next 
Event

Moves the position indicator one keyframe to the right and activates the keyframe. If 
there is no keyframe to the right, nothing happens.

Add Keyframe Creates a keyframe at the current position. Alt+click (Windows) or Option+click 
(Macintosh) this button to delete a keyframe.

Option Description

Duplicated Field Displays a single field in the effect. For two-field media, this reduces the information 
stored by half because it drops one field of the image, resulting in a lower quality image. 
For single-field media, this is usually the best choice because of its speed. (The other 
options do not improve effect quality for single-field media.)

Timewarp effects that you create using Duplicated Field render in the shortest amount of 
time.

You can use this option to remove unwanted field motion in interlaced material brought 
into a progressive project.

Both Fields Displays both fields in the effect. For example, the first two frames of a half-speed (50%) 
slow-motion effect repeat the original Frame 1 (both fields) twice. This option is good 
for clips without inter-field motion, for NTSC or PAL film-to-tape transfers, and for 
stills. With footage that includes inter-field motion, this method might result in minor 
shifting or bumping of the image because it disturbs the original order of fields: a Field 1 
appears both before and after the corresponding Field 2. 

Timewarp effects that you create using Both Fields render relatively quickly. For best 
results, use evenly divisible frame rates with this option.

n In some circumstances, Adaptive Deinterlace Source is available as a further 
processing option. For more information, see “Using Adaptive Deinterlacing” on 
page 170.
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VTR-Style Creates a second field for the effect by shifting selected video fields of the original media 
by a full scan line. This option also creates the motion effect at the field level rather than 
the frame level, but because pixels are not filtered, the final image is sharper than that 
created by the Interpolated Field option. The image might display slight jittering at 
certain speeds. This technique is similar to that used by high-quality professional video 
decks when playing footage at less than normal speed.

Timewarp effects that you create using Interpolated Field or VTR-Style render less 
quickly than Both Fields but more quickly than Blended Interpolated, Blended VTR, or 
FluidMotion.

Interpolated Field Creates a second field for the effect by combining scan line pairs from the first field in 
the original media. This option calculates the motion effect at the field level rather than 
the frame level. Because Media Composer considers all fields and does not disturb the 
original order of fields, the smoothness of the rendered effect is second only to 
FluidMotion. This method is best for video-originated material or film-originated 
material transferred at 24 fps. 

Timewarp effects that you create using Interpolated Field or VTR-Style render less 
quickly than Both Fields but more quickly than Blended Interpolated, Blended VTR, or 
FluidMotion.

Blended Interpolated Blends, or averages, pixels from the original frames or fields to create intermediate 
frames or fields. For example, at 25% speed, Media Composer creates three blended 
images between outgoing Image A and incoming Image B. The first blended image 
weights the pixels from Image A at 75% and Image B at 25%. The second blended 
image weights the pixels from Image A at 50% and Image B at 50%. The third blended 
image weights the pixels from Image A at 25% and Image B at 75%. Objects in motion 
from Image A to Image B appear to fade out of Image A and fade in to Image B.

Timewarp effects that you create using Blended Interpolated or Blended VTR render less 
quickly than Interpolated Field or VTR-Style but more quickly than FluidMotion.

n In some circumstances, Adaptive Deinterlace Source is available as a further 
processing option. For more information, see “Using Adaptive Deinterlacing” on 
page 170.

Blended VTR First creates a second field for the effect by shifting selected video fields of the original 
media by a full scan line, then blends, or averages, pixels from the original frames or 
fields to create intermediate frames or fields. For example, at 25% speed, Media 
Composer creates three blended images between outgoing Image A and incoming 
Image B. The first blended image weights the pixels from Image A at 75% and Image B 
at 25%. The second blended image weights the pixels from Image A at 50% and 
Image B at 50%. The third blended image weights the pixels from Image A at 25% and 
Image B at 75%. Objects in motion from Image A to Image B appear to fade out of 
Image A and fade in to Image B.

Timewarp effects that you create using Blended Interpolated or Blended VTR render less 
quickly than Interpolated Field or VTR-Style but more quickly than FluidMotion.

n In some circumstances, Adaptive Deinterlace Source is available as a further 
processing option. For more information, see “Using Adaptive Deinterlacing” on 
page 170.

FluidMotion Draft Lets you view the motion that would be created by the FluidMotion setting, but at a 
lower quality. Use this setting if you are working in vector edit mode and performance is 
too slow. Use the FluidMotion setting for final output.

Option Description
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Timewarp Speed Graph Reference
The following illustration shows the activated Speed graph.

FluidMotion Analyzes the motion between outgoing Image A and incoming Image B, and interpolates 
intermediate frames pixel-by-pixel. The motion generated by FluidMotion is the 
smoothest of all the rendering options.

Timewarp effects that you create using FluidMotion are the slowest to render.

n When you step through a sequence with a Timewarp effect, Media Composer can 
take a noticeable amount of time to update the Effect Preview monitor. For better 
performance, use FluidMotion Draft while you work on your sequence.

To save time, select one of the other rendering options to rough out your sequence and 
use FluidMotion only when you are satisfied with the overall sequence.

n This option is not available in the Render Setting dialog box in the Settings list 
because it is best used while you are working with a Timewarp effect.

c You must render FluidMotion effects before combining with any other effects, especially any other 
time-based effects such as FluidColorMap.

Option Description

1 2 3 4 5
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 Motion Effect Editor Speed Graph Components  

Component Description

1 Anchor text box Displays the timecode of the Source Anchor Frame. For more information, see 
“Using the Source Anchor Frame” on page 170.
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n The Fast menu that appears when you click the Fast Menu button in the Speed graph toolbar is the 
same as the shortcut menu that appears when you right-click the Speed graph. The menu is described 
in “Shortcut Menus for Keyframe Tracks and the Motion Effect Editor” on page 116.

Timewarp Position Graph Reference
The following illustration shows the activated Position graph.

2 Source Anchor Frame 
button

Click to anchor the Source Anchor Frame at the current keyframe. For more 
information, see “Using the Source Anchor Frame” on page 170.

3 Active keyframes The keyframes to which Media Composer applies any changes you specify. Active 
keyframes are pink.

4,
11

Percent Speed axis
Output Position axis

The Percent Speed (vertical) axis represents the speed of the resulting effect as a 
percentage of the speed of the source material. The Output Position (horizontal) 
axis represents the timecode for the resulting effect. For example, if Percent Speed 
is 200 at an Output Position of 00:00:02:15, then at 2:15 after the start of the effect, 
the speed of the effect is twice the speed (200%) of the source material.

5 Position indicator 
(blue)

The image that appears in the monitor is the image at this position in the effect. You 
move the Speed graph position indicator as you would any other position indicator.

When you add a keyframe, it appears at the position indicator.

6 Source Anchor Frame 
indicator

Indicates the point (timecode) in the effect where you have anchored the source. 
The default Source Anchor Frame is the first frame or field of the source, and the 
default point for anchoring the Source Anchor Frame is timecode 0 — the first 
frame or field of the effect. For more information, see “Using the Source Anchor 
Frame” on page 170.

7 Percent Speed text box Displays the percent speed at the active keyframe. You change the percent speed by 
moving keyframes vertically or by typing a number in the Percent Speed text box.

8 Output Position 
text box

Displays the timecode for the resulting effect at the active keyframe. You can 
change the output position by Alt+dragging (Windows) or Option+dragging 
(Macintosh) keyframes horizontally or by typing a timecode in the Output Position 
text box.

9 Value scale slider and 
Position scale slider

Scale sliders scale the Speed graph view up or down so you can see more or less 
detail. The Value scale slider controls the Percent Speed axis. The Position scale 
slider controls the Output Position axis. For more information, see “Scaling a 
Graph Display in the Motion Effect Editor” on page 169.

10 Green line Indicates output speed in the effect as a percentage of input speed. The slope of the 
line tells you how fast and in which direction the speed changes over the course of 
the effect. You add keyframes to further refine the effect.

12 Active control graph 
toolbar

Appears under the active control graph. See “Motion Effect Editor Reference” on 
page 171.

 Motion Effect Editor Speed Graph Components(Continued)  

Component Description
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1 2
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 Motion Effect Editor Position Graph Components  

Components Description

1, 
8

Input Position axis
Output Position axis

The Input Position (vertical) axis represents the timecode for the source clip. The 
Output Position (horizontal) axis represents the relative timecode for the 
resulting effect. The exact timecode displays above the Record monitor.

2 Position indicator (blue) The image that appears in the monitor is the image at this position in the effect. 
You move the Position graph position indicator as you would any other position 
indicator.

When you add a keyframe, it appears at the position indicator.

3 Active keyframes The keyframes to which Media Composer applies any changes you specify. 
Active keyframes are pink.

4 Input Position text box Indicates the input position (timecode in the source clip) at the active keyframe. 
You can change the input position by moving keyframes vertically or by typing a 
number in the Input Position text box.

5 Output Position text box Indicates the relative timecode for the resulting effect at the active keyframe. You 
can change the output position by Alt+dragging (Windows) or Option+dragging 
(Macintosh) keyframes horizontally or by typing a timecode in the Output 
Position text box.

6 Value scale slider
Position scale slider

Use the scale sliders to scale the Position graph view up or down to see more or 
less detail. The Value scale slider controls the Input Position axis. The Position 
scale slider controls the Output Position axis. For more information, see “Scaling 
a Graph Display in the Motion Effect Editor” on page 169.

7 Green line A point on the green line indicates the timecode in the source clip relative to the 
timecode in the resulting effect. The line shows the mapping of source material to 
the effect. You add keyframes to further refine the effect.
178



Timewarp Effect Examples
n The Fast menu that appears when you click the Fast Menu button in the Position graph toolbar is the 
same as the shortcut menu that appears when you right-click the Position graph. The menu is 
described in “Shortcut Menus for Keyframe Tracks and the Motion Effect Editor” on page 116.

Timewarp Effect Examples

The examples in this section demonstrate several basic effects you can achieve with the Timewarp 
effect. You can also use the Timewarp templates that appear in the Motion Effect category as a 
starting place for familiarizing yourself with the capabilities of the Timewarp effect. For more 
information, see “Timewarp Effects” on page 483.

Speed Graph Example: Creating a Rolling Clip That Freezes

When you create a traditional Freeze Frame effect, you create a clip of a single frozen image in the 
Source monitor and edit it into your sequence at the right place. To change the location of the frozen 
image, you must create a new Freeze Frame clip.

You create a freeze frame with a Timewarp effect by cueing to the image in your sequence that you 
want to freeze and adding a keyframe to set the speed of the clip to 0% at that point. When you want 
motion to resume, add a keyframe at that timecode and set the speed of the clip to 100%.

You can easily add multiple freeze frames to a single clip by creating additional pairs of keyframes: 
one at the beginning of each freeze frame to set the speed to 0%, and one at the end of each freeze 
frame to return the speed to 100%.

To create a rolling clip that freezes by using the Timewarp effect Speed graph:

1. Apply a Timewarp effect, and set up the Motion Effect Editor as described in “Using the Motion 
Effect Editor” on page 167, with the following specifics:

a. Click the Edit Graph menu, select Speed, and click the Speed Graph Display button to open 
the Speed graph.

b. Click the Motion Effect Editor Fast Menu button, and select Shelf as the interpolation 
option. See “Controlling Parameter Changes at Keyframes” on page 106.

2. (Option) Click the Position Graph Display button to open the Position graph.

Changes you make to the Speed graph are reflected in the Position graph. Having the Position 
graph open lets you see how you could achieve the same changes by using the Position graph.

The Position graph opens, and the Position Graph Display button changes.

3. Cue to the image in your sequence where you want the image to freeze.

4. In the toolbar below the Speed graph, click the Add Keyframe button.

A keyframe indicator appears at the position indicator in the Speed graph.

9 Active control graph 
toolbar

Appears under the active control graph. See “Motion Effect Editor Reference” on 
page 171.

 Motion Effect Editor Position Graph Components(Continued)  

Components Description
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5. Move the position indicator to the timecode at which you want action to resume.

As you drag the position indicator in the Position graph, the output timecode shows in the upper 
left corner of the Position graph.

6. In the toolbar below the Speed graph, click the Add Keyframe button.

A keyframe indicator appears at the position indicator in the Speed graph.

7. Click the middle keyframe indicator to activate it, and set the speed at 0% for this keyframe by 
doing one of the following:

t Type 0 in the Percent Speed text box, and press Enter (Windows) or Return (Macintosh).

t Click the keyframe indicator, and drag it down until it reaches the zero (0) marking on the 
Percent Speed axis.
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n You move Timewarp keyframes directly in the same way you move keyframes in keyframe graphs. See 
“Moving Advanced Keyframes” on page 98.

Notice the line in the Position graph. At the beginning of the effect, the line shows that input 
position (timecode in the source) and output position (timecode in the effect) are changing at the 
same rate. 

The effect plays at 100% speed until the freeze frame. At that point, the line becomes flat. It 
remains flat for the length of the freeze frame because the timecode in the source does not 
change. 

From the end of the freeze frame to the end of the effect, the line again slopes upwards at 45 
degrees, showing that input position and output position are changing at the same rate.

You can become familiar with using the Position graph by experimenting with duplicating the 
Speed graph freeze frame results with the Position graph as the active control graph.

8. In the Motion Effect Editor toolbar, click the Render Effect button.

9. (Option) In the Motion Effect Editor toolbar, click the Trim Mode button, and trim the effect to 
achieve the duration you want.

For more information, see “Working with Trim Edits” in the Help.

10. (Option) Click the Timewarp Effect icon in the Motion Effect Editor, and drag it to a bin to create 
an effect template with the current parameters.

Speed Graph Variations: Moving Keyframes

You can change the time in the clip at which a freeze frame starts or ends, or change the length of the 
freeze, by moving the keyframes that control the starting and ending times of the freeze frame.

n You move Timewarp keyframes directly in the same way you move keyframes in keyframe graphs. See 
“Moving Advanced Keyframes” on page 98.

To change the time at which the freeze frame starts:

1. Click the keyframe indicator at which the freeze frame ends.

2. Shift+click the keyframe indicator at which the freeze frame starts.
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3. Do one of the following:

t Alt+Shift+click (Windows) or Option+Shift+click (Macintosh) the first keyframe indicator, 
and drag it to its new position.

t Type a new start timecode in the Output Position text box.

The keyframes move together to the new position.

The freeze frame now starts and ends at the new keyframe positions.

To change the length of the freeze frame, without changing the starting time, do one of the 
following:

t Alt+Shift+click (Windows) or Option+Shift+click (Macintosh) the second keyframe indicator, 
and drag it to its new position.

Dragging to the left shortens the freeze frame, while dragging to the right lengthens it.

t Type a new ending timecode in the Output Position text box.

Strobe Motion Using the Timewarp Effect

Strobe motion is essentially the same for the Timewarp effect as for a traditional motion effect.
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To create a Strobe Motion effect by using the Timewarp effect:

1. Apply a Timewarp effect, and set up the Motion Effect Editor as described in “Using the Motion 
Effect Editor” on page 167.

2. Type the strobe motion rate in frames in the Strobe text box.

For example, a rate of 5 causes every fifth frame to be held for five frames before updating.

3. In the Motion Effect Editor toolbar, click the Render Effect button.

4. View the result. If you want to change the strobe motion rate, repeat steps 3 and 4

5. (Option) You can combine strobe motion and variable speed in the same Timewarp effect. Set 
and customize keyframes in either the Speed graph or the Position graph to achieve the result 
you want.

6. (Option) In the Motion Effect Editor toolbar, click the Trim Mode button, and then trim the effect 
to achieve the duration you want.

For more information, see “Working with Trim Edits” in the Help.

7. (Option) In the Motion Effect Editor, click the Timewarp Effect icon, and drag it to a bin to 
create an effect template with the current parameters.

Customizing an Effect with the Position Graph

When you use the Position graph to customize a Timewarp effect, you map source material position 
to output position. Any timecode of the source material is mapped to any timecode of the result, 
within the constraints of the Position graph. The results of the Position graph are reflected in the 
Speed graph.

To customize an effect with the Position graph:

1. Apply a Timewarp effect, and set up the Motion Effect Editor as described in “Using the Motion 
Effect Editor” on page 167, with the following specifics:

a. Click the Edit Graph menu, select Position, and then click the Position Graph Display button 
to open the Position graph. 

b. Click the Motion Effect Editor Fast Menu button, and select an interpolation option.

For more information, see “Controlling Parameter Changes at Keyframes” on page 106.

2. (Option) Click the Speed Graph Display button to open the Speed graph.

Changes you make to the Position graph are reflected in the Speed graph. Having the Speed 
graph open gives you a visual check on how your changes affect the speed of the result.

The Speed graph opens, and the Speed Graph Display button changes.

3. Where you want to have a particular part of the source appear at a fixed time in the effect, move 
the position indicator to that timecode in the Output Position axis, and add a keyframe. For more 
information, see “Adding Advanced Keyframes” on page 89.

A keyframe indicator appears on the green line at the position indicator.

4. Map the source timecode to the output by doing one of the following:

t Move the keyframe indicator to the point where the input timecode (shown in the Input 
Position text box) maps to the output timecode (shown in the Record monitor) to achieve the 
effect you want.

n You move Timewarp keyframes directly in the same way you move keyframes in keyframe graphs. See 
“Moving Advanced Keyframes” on page 98.
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As you drag the keyframe over major position markings, you will notice a resistance. This 
helps you place keyframes more accurately.

t Type the input timecode in the Input Position text box.

5. Add and customize more keyframes to achieve the effect you want.

For more detailed information, see “Position Graph Example: Reverse Motion” on page 184.

6. Render and review the effect.

7. (Option) Click the Timewarp Effect icon in the Motion Effect Editor, and drag it to a bin to create 
an effect template with the current parameters.

Position Graph Example: Reverse Motion

While the Motion Effect category contains a Reverse Motion template for the Timewarp effect, 
setting up reverse motion directly in a clip demonstrates how the Position graph works in this basic 
effect. You can use the same technique to create reverse motion in part of a clip instead of across the 
entire clip.

To create reverse motion, you map the end of the source to the beginning of the effect, and the 
beginning of the source to the end of the effect. You do this by setting new input positions for the first 
and last keyframes, either by dragging the keyframe indicators to their new locations or by typing the 
input position timecodes for each keyframe. 

n You move Timewarp keyframes directly in the same way you move keyframes in keyframe graphs. See 
“Moving Advanced Keyframes” on page 98.

To create reverse motion in a clip:

1. Apply a Timewarp effect, and set up the Motion Effect Editor as described in “Using the Motion 
Effect Editor” on page 167 with the following specifics:

a. Click the Motion Effect Editor Fast Menu button, and select Linear or Bézier as the 
interpolation option.

The Bézier interpolation option eases the parameter change in and out at each keyframe. By 
manipulating the Bézier direction handles, you control the characteristics of the speed 
change. For more information, see “Controlling Parameter Changes at Keyframes” on 
page 106.

b. Click the Edit Graph menu, and select Position to make the Position graph the active control 
graph.

The Motion Effect Editor displays the graphs for the unaltered clip. In the Position graph, a 
straight diagonal line stretches from the first keyframe to the last keyframe. Each frame of 
the input is the same as each output frame, with no variations in speed. The Input Position 
timecode is the same as the Output Position timecode at each keyframe. 

In the Speed graph, a straight line crosses the graph at 100% speed.
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2. Click the first keyframe indicator, and note the starting timecode in the Input Position text box.

3. Click the last keyframe indicator, and note the ending timecode in the Input Position text box.

4. Reverse the starting timecode and ending timecode by doing the following:

a. Click the first keyframe indicator, and either drag the indicator up the Input Position axis 
until it is even with the last keyframe indicator, or type the original ending timecode in the 
Input Position text box.

If you drag, the Input Position text box changes until it reaches the timecode for the last 
frame of the source. In the Speed graph, the Percent Speed at the left changes until it reaches 
0% — with starting and ending timecodes the same, if you played the effect it would be a 
freeze frame of the last frame.

b. Click the last keyframe indicator, and either drag it vertically down the graph until the line in 
the Speed graph reaches -100%, or type the original starting timecode in the Input Position 
text box.

If you drag, the value in the Input Position text box changes until it reaches the timecode for 
the first frame of the source.

In the Position graph, a straight line descends across the graph, mapping the effect’s starting time 
to the clip’s ending time, and the effect’s ending time to the clip’s starting time, effectively 
reversing the clip.

The effect plays back in reverse motion.
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5. (Option) Click the Timewarp Effect icon in the Motion Effect Editor, and drag it to a bin to create 
an effect template with the current parameters.

Understanding FluidMotion Timewarp Effects
The FluidMotion rendering option for Timewarp effect creates very smooth rendered effects. 
FluidMotion uses an interpolation algorithm that creates intermediate images by morphing the 
motion across the bracketing images. FluidMotion examines each pixel in the outgoing image, finds 
the corresponding pixel in the incoming image, and creates a motion path between the two that it uses 
to build the intermediate images necessary to fill out the effect.

n On a Macintosh system, FluidMotion requires significant system resources and rendering times can 
be very long. In addition, when you step through a sequence with a Timewarp effect, Media 
Composer can take a noticeable amount of time to update the Effect Preview monitor.

FluidMotion can introduce artifacts into the effect, particularly when objects move in front of or 
behind other objects, move significantly between one frame and the next, or move into the image 
from outside the frame. FluidMotion Edit provides tools to correct artifacts in a Timewarp effect.

By definition, artifacts appear only in intermediate images that FluidMotion creates. The bracketing 
images, whether frames or fields of original material, do not have artifacts. You use FluidMotion Edit 
to make corrections either by incorporating motion information from other parts of the image or clip 
or by directly manipulating the artifact’s motion vectors.

FluidMotion performs motion estimation based on the original source frames. When you use the 
Effect Editor to edit the motion vectors in a FluidMotion effect, the Timeline changes to a source-
frame Timeline. The position indicator under the Record monitor appears green when you are 
working in a source-frame Timeline.

FluidMotion Workflow

The typical workflow for using FluidMotion effects is as follows:

1. Use the Blended Interpolated rendering option to set up the initial motion effect.

This lets you quickly set up the ramp rates and time curves you want. Blended Interpolated is the 
closest in quality to FluidMotion but takes less time to render.

For more information, see “Understanding Timewarp Effects” on page 163.

2. Render and play the effect.

For more information, see “Basics of Effects Rendering” on page 41.

3. If you want smoother motion, use the Motion Effect Editor to change the effect to FluidMotion.

4. Render the effect, and look for artifacts in the rendered media.

5. Use the Effect Editor and the Effect Preview monitor to step through the effect to the first frame 
that contains artifacts.

6. Fix the artifacts on that frame, and render the effect again.

Media Composer renders only the part of the effect that has changed.
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7. Determine whether you need to continue to work on the current frame or move on to the next 
frame.

8. Each time you fix an artifact, render the effect again.

This is often the fastest way to remove all the artifacts.

n By fixing the intermediate frame represented by Warp 50% or Color Warp 50%, you are fixing all the 
intermediate frames in the final result between Image A and Image B.

Using FluidMotion Edit
An artifact occurs when Media Composer makes an incorrect estimation about the motion for a 
region of pixels. FluidMotion Edit provides a variety of methods for dealing with artifacts. In 
general, you define a region around an artifact and then modify the way FluidMotion creates new 
material from the source material within that region. FluidMotion does not alter the way it creates 
new material outside defined regions.

FluidMotion Edit uses motion vectors to show the relative speed and direction of a pixel from the 
outgoing Image A to the incoming Image B. FluidMotion Edit represents motion vectors as arrows 
and as colors.

Correcting an artifact involves changing the motion vectors that FluidMotion calculates to motion 
vectors that produce little or no distortion. You can use the following approaches to make corrections:

• Copy the motion vectors from an area of the image that behaves correctly to the defined region, 
replacing the original motion vectors with the copied motion vectors.

• Copy a correction from one image, and paste it into another to correct multiple artifacts.

• Clear the motion vectors that FluidMotion creates inside a defined region. You can do this by 
drawing a region and setting the vectors within the region to zero with the Vector X and Vector Y 
sliders. 

• Use the Mask parameter to prevent black borders around the image from affecting the result. 
Mask defines a border around the edge of the image, shown by a blue wire frame on the Effect 
Preview monitor. 

To open FluidMotion Edit:

1. In the Motion Effect Editor, click the Type menu, and then select FluidMotion.

The Edit FluidMotion Vectors button appears in the Motion Effect Editor next to the Type menu.

2. Click the Edit FluidMotion Vectors button.

If Media Composer was not in Effect mode, it enters Effect mode and the Effect Editor opens.

FluidMotion Edit appears in the Effect Editor.
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For general information on working with the Effect Editor, see “Using the Effect Editor” on 
page 68.

To view vectors as arrows:

t In the Display parameter category, select Show Vectors.

Notice the motion vectors around the rope and the child’s hand. The length of a vector arrow 
represents the speed at which a pixel moves between Image A and Image B, and the arrow’s 
orientation shows the direction of motion.

To view vectors as colors:

1. In the Display parameter category, click the Fast Menu button, and select Color Warp 50%.

2. (Option) Deselect Show Vectors to see the color vectors and the underlying image more clearly.
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The saturation of a vector color corresponds to speed, and hue corresponds to direction.

To define a region for FluidMotion Edit:

1. In the Display parameter category, click the Fast Menu button, and then select Warp 50% or 
Color Warp 50%.

Warp 50% shows the image generated by FluidMotion that is halfway between source material 
Image A and Image B. Color Warp 50% shows the same image, with an overlay of motion vector 
colors. 

2. (Option) Select Show Vectors to display the motion vector arrows.

3. Step through your clip until you reach an image in which you want to make a correction.

4. Select a shape from the drawing tools in the Effect Editor, and draw around the region that has 
the artifact.

You use the drawing tools in the same way as you would for Intraframe editing. You can copy, 
move, and modify any shape. For more information, see “Intraframe Editing” on page 382.

n Use the Feathering and Brush parameters at any point during the correction process to help define 
and modify the selected area.

Example of Correcting FluidMotion Artifacts

In this example, a table tennis ball crosses a net. FluidMotion creates one artifact where the ball 
crosses the net and a second artifact directly above the first at the edge of the table.

Example of FluidMotion artifacts: details of the bracketing images (left and right) and the intermediate image (center) 
with artifacts created by FluidMotion.

The following illustrations show the vector information in the image as vector arrows and vector 
colors. The vector displays indicate that there is motion across a large portion of the image. 

This example uses vector colors to fix the artifacts.
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The artifacts in this example: without vector display (left), with vector arrow display (center), and with vector color display 
(right).

You can view artifacts by stepping through the effect while keeping the Display Fast menu in the 
Effect editor set to Warp 50% or Color Warp 50%. This shows the images created at the halfway 
point between the source images. To view the corresponding source images, change the Display Fast 
menu to Image A or Image B.

In this example, we fix the artifacts by reducing the amount of motion within the areas where the 
artifacts occur.

To fix the artifacts:

1. In the Effect Editor, click the Fast Menu button in the Mode parameter category, and select Set 
Vector.

2. Select the Oval tool, and draw ovals around the areas containing the artifacts.

Media Composer automatically sets the Vector X and Vector Y values to 0 within the new 
objects. This removes all motion information from within the regions. The artifacts disappear but 
the image is now a blend of the two bracketing images, so the ball appears extended and dimmer 
than before. 

Bracketing images (left and right) with blended intermediate frame (center) after use of the Oval tool.

If you play the effect now, the image of the ball over the net fades out as the image of the ball 
under the net fades in. We need to add motion information back into the image so we can view 
the moving ball.

3. Turn on color vector information in the image by doing the following:

t Click the Fast Menu button in the Display parameter category, and select Color Warp 50%.
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Color Warp 50% shows movement as chroma (color) and direction and hue (color intensity). The 
image shows that there is no motion information within the oval.

Some motion along the top of the net shows as yellow in the image. We can use the eyedropper 
in the Mode parameter category to copy this motion information into the oval.

4. Do the following:

a. Select the oval shape that you created to make it active.

b. Press and hold the mouse pointer over the Color Preview window of the Mode parameter 
category in the Effect Editor. 

The pointer changes to an eyedropper.

c. Drag the eyedropper over the top of the net, and view the changes in the Vector X and Vector 
Y parameter values. The values change as you drag over an area that contains motion 
information.

Color Preview window and Vector thumbwheels in the Effect Editor

n You can use the eyedropper to view Vector X and Vector Y information in the image even if Color 
Warp 50% is not enabled.

d. Release the mouse button over the yellow portion of the top of the net (to the left of the 
oval).

Media Composer applies the motion information to the oval and the yellow vector color 
display appears inside the oval.

5. Render the effect, and click the Play Loop button to review the rendered effect.
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We need to put some of the motion information back into the image of the ball. One way to do 
this is to draw an object around the ball that cuts a hole through the oval that we just created and 
reveals the original motion of the ball.

6. Select the Polygon tool, and draw an object around the blurred image of the ball.

The following illustrations show the result displayed with Color Warp 50% and Warp 50%.

7. In the Mode parameter category, click the Fast Menu button, and select Erase.

8. Add some feathering to create a smooth transition between the motion within the polygon and 
the motion in the oval.

The illustration below shows the result of setting Bias to 92, and both Feathering X and 
Feathering Y to 5.

For more information, see “Intraframe Editing” on page 382.

9. Render the effect, and play the result.

After you remove the artifact at the Warp 50% position, all intermediate frames between Image 
A and Image B reflect the change.

Timewarp Preset Effects
The Timewarp effect category contains several preset effects that you apply directly to clips in a 
sequence. The effects are set up as templates but you can modify them using the Motion Effect editor. 
The following table describes these effects.

For information on using the FluidFilm templates, see “FluidFilm Preset Effects” on page 193. For 
details on using the other templates, see “Timewarp Effects” on page 483.

Effect Description

0% To 100% Ramps motion in a sequence from 0% (freeze frame) to 100% 
(full speed).
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FluidFilm Preset Effects
Film footage has specific timing characteristics that you might want to duplicate with video footage. 
Film timing is different because a film camera records images as full frames while a video camera 
records individual fields, a fraction of a second apart. The resulting video playback has a very 
different look from film.

The FluidFilm templates (FluidFilm 2:3 Cadence and FluidFilm Progressive) use the FluidMotion 
rendering option to create intermediate progressive frames. The result is a motion effect that plays as 
though it were shot on film. The default speed is 100%.

n You can also use the templates as a starting point to create a video look from sources originally shot 
on film by switching the input and output format values.

Applying a Film Look to a Video Clip

A common scenario involves a show that is shot on film and edited at 30i where you want to 
incorporate some video clips into the Timeline. You can process the video clips with the FluidFilm 
template to generate a look similar to the film footage.

Applying a Film Look to an Entire Sequence

You can use the FluidFilm templates to apply a film look to an entire interlaced sequence by doing 
one of the following:

• Mix down the entire sequence and apply a FluidMotion effect to the resulting master clip.

Media Composer might produce artifacts between the original cuts. If this happens, you can use 
FluidMotion Edit to set the motion vectors for the entire frame to zero at the cut points. For more 
information, see “Understanding FluidMotion Timewarp Effects” on page 186.

• Apply the FluidMotion effect to each clip in the sequence.

The 2:3 cadence might be off between adjacent clips depending on whether the clip starts on an 
A, B, C. or D frame. If this is a problem, use the mixdown method instead.

100% To 0% Ramps motion in a sequence from 100% (full speed) down to 0% 
(freeze frame). The last frame of the clip is the last frame of the 
motion effect.

FluidFilm 2:3 Cadence and 
FluidFilm Progressive

Let you create a film look from interlaced video sources or a video 
look from sources originally shot on film.

Pulldown Insertion and 
Pulldown Removal

Inserts or removes pulldown in a sequence.

Reverse Motion Creates a reverse motion effect at 100% speed.

Speed Boost Creates an effect that starts out at half speed, reaches approximately 
double speed at the midpoint, and returns to half speed at the end.

Speed Bump Creates an effect that starts out at full speed, slows to approximately 
half speed at the midpoint, and returns to full speed at the end.

Trim to Fill Plays at a constant speed. You can adjust the speed by entering 
Trim mode and trimming the effect.

Effect Description
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n The FluidMotion rendering option can take a long time to process an entire sequence.

Default Values for the FluidFilm Preset Effects

The FluidFilm Timewarp effect options use the following default values:

By default, these templates create 100% Timewarp effects (the effect plays at the same speed as the 
original clip). You can use the Speed and Position controls to change the speed.

Setting Source and Output Options for Format 
Conversion with Timewarp Effects

You can use the Motion Effect editor to convert formats when creating a Timewarp effect.

You need to match the Source format option to the format of the original source material. For 
example, if the material was shot on a 30i camera, select Interlaced as the Source format.

If your source material includes repeated progressive frames, such as animation or video from a 
consumer digital photo camera, select Progressive Repeated as the Source format

In some circumstances, adaptive deinterlacing might improve the image quality of the output.

To set source format and output format options:

1. In the Motion Effect Editor, click the Source menu, and select your source format.

The following table lists the source format and the output format options to use for format 
conversions. Progressive projects do not allow format conversions.

Option Default Value

Source format Interlaced

Output format Film with 2:3 Pulldown (for FluidFilm 2:3 Cadence effect)

Progressive (for FluidFilm Progressive effect)

Rendering option FluidMotion

Project Type Source media type
Corresponding
Source Option Possible Output Options

30 fps interlaced 30 fps interlaced Interlaced Progressive, Film with pulldown

30 fps progressive Progressive Interlaced, Film with pulldown

30 fps interlaced with 
2:3 pulldown

Film with pulldown Interlaced, Progressive

Repeated progressive 
frames

Progressive 
Repeated

Interlaced, Progressive, Film 
with pulldown

25 fps interlaced 25 fps interlaced Interlaced Progressive

25 fps progressive Progressive Interlaced
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If you select Film with Pulldown as the source format, additional options display that lets you 
either manually or automatically set the pulldown pattern.

If you select Progressive Repeated as the source format, additional options display that lets you 
either manually or automatically set the repeated frame count.

2. Click the Output menu, and select an output format.

See the table in step 1 above.

3. (Option) Select Adaptive Deinterlace Source.

For more information, see “Using Adaptive Deinterlacing” on page 170.

4. Click OK.

n For best results when performing a format conversion, use the FluidMotion render option and view 
the resulting footage on a client monitor.

Repeated progressive 
frames

Progressive 
Repeated

Interlaced, Progressive

Project Type Source media type
Corresponding
Source Option Possible Output Options
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8 Layered and Nested Effects

This chapter describes how to apply multilayer effects to your sequence. Layered effects consist of 
two or more layers of video that play back simultaneously with effects such as Picture-in-Picture, 
Superimpose, or Submaster applied to the tracks. Nested effects consist of one or more effect layers 
that are contained within another effect on the same video layer.

The methods for creating multilayer effects that this chapter describes build on the procedures for 
creating single-layer effects in “Applying Effects” on page 27.

• Key Effects

• Working with Imported Graphics and Animation

• Nesting Effects

• Submaster Editing

• Collapsing Layers into a Submaster Effect

• Performing a Video Mixdown

Key Effects
Media Composer supports the following key effects:

For reference information on all key effects, see “Key Effects” on page 469.

Key Effect Type Description

Chroma Replaces one part of the video image with another video image based on color. 
You have the following options for chroma key effects:

The SpectraMatte™ chroma key effect creates a superior quality key and makes 
it easy to correct common keying problems such as controlling shadows and 
removing color spill.

The Chroma Key and RGB Keyer effects are more basic effects that are 
supported for backwards compatibility with older versions of 
Avid editing applications.

Luma Replaces one part of the video image with another video image based on 
luminance (brightness). You create a luma key using the Luma Key effect.

Matte Replaces one part of the video image with another video image or graphic based 
on the location of a high-contrast image known as a matte. You create a matte 
key using the Matte Key effect or an imported Matte Key clip.
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Understanding the SpectraMatte Chroma Key Effect

The SpectraMatte effect provides superior quality keying and makes it easy to fine-tune your keys to 
solve problems such as controlling shadows and removing color spill. The SpectraMatte effect is 
available in the Key category of the Effect Palette.

The SpectraMatte effect includes the following main features:

• Analysis displays that provide visual feedback and aid in fine-tuning the key.

• Chrominance controls for precise adjustment of the range of hue and saturation values that the 
effect keys out.

• Additional luminance-based controls that let you fine-tune alpha values in the key and remove 
unwanted shadows.

• Matte processing controls that let you blur, erode, or dilate the edges of the alpha matte 
generated by the effect.

• Spill suppression controls that let you remove reflected key color from a foreground subject.

• Scale, position, and crop controls.

• Advanced keyframes that let you keyframe each effect parameter individually, enabling you to 
adjust for changes over the duration of a clip.

You apply the SpectraMatte effect to the foreground track of a multilayer segment in the Timeline in 
the same way that you apply other chroma key effects. For more information, see “Creating a 
SpectraMatte Effect” on page 200.

n The keying capabilities of SpectraMatte are also available in the 3D Warp effect. A SpectraMatte Key 
option in the Foreground parameter category provides access to the full set of SpectraMatte 
parameter controls. You might prefer to use SpectraMatte from the 3D Warp effect because 3D Warp 
uses Hue, Saturation, and Luminance controls to define the key color rather than Red, Green, and 
Blue controls. For more information, see “Foreground (3D)” on page 579.

Understanding SpectraMatte Analysis Displays

The SpectraGraph™ display for the SpectraMatte effect shows how the effect operates on the entire 
CbCr color space. This helps you see how the effect is working and what further adjustments you 
might need to make.

You can also display the alpha matte that the effect is generating. This lets you see clearly which 
pixels from the foreground image are being keyed in or out, and how pixels on the edge of the matte 
are being blended.

You can display these analysis views in either the Effect Preview monitor or in the Source monitor. If 
you display them in the Effect Preview monitor, they replace your view of the composite image 
created by the effect itself until you turn the analysis display off. If you display them in the Source 
monitor, you can see the analysis and the composite image at the same time.

The SpectraGraph Display

The SpectraGraph display shows a color swatch that represents the entire CbCr color space with 
which the SpectraMatte effect works. You activate the SpectraGraph display using controls in the 
Matte Analysis category in the Effect Editor. For more information, see “Key: SpectraMatte Effect” 
on page 472.
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The center point of the swatch is neutral gray while the outer areas show highly saturated color. This 
representation of color is similar to that in the ChromaWheel color wheels in the Color Correction 
tool. Hue changes as you move around the swatch and saturation increases as you move away from 
the center. The following illustration shows this swatch.

The range of colors that the SpectraMatte effect is currently keying out from your foreground image 
is also keyed out from this swatch, revealing a black background in its place. The range of colors that 
the effect is currently retaining from the foreground image appears as fully opaque color. The range 
of colors that the effect is currently blending between foreground and background appears as 
partially transparent color. For more information on how the effect calculates these color ranges 
based on your input, see “How the SpectraMatte Effect Calculates Key Color Values” on page 199.

Superimposed on the color swatch is a vectorscope-style display that shows the distribution of color 
values in the foreground image. This typically shows a concentration of either green or blue color 
values that represent the background screen colors you want to key out, along with the distribution of 
other color values from the foreground subject that you want to retain.

Example of a SpectraGraph display for an image where the key color is green. The area outlined in white shows the 
range of colors that are currently keyed out and replaced by background pixels. The area outlined in black shows the 
range of colors that are being retained from the foreground image. The gradient between the two outlined areas shows 
the range of values that are currently a blend of foreground and background pixels. The superimposed color data shows 
the distribution of color in the foreground image (a subject shot in front of a green screen).

The SpectraGraph display lets you clearly see the relationship between the current result of the key 
and the color values in your image. In the preceding illustration, you can see that many of the green 
color values in the superimposed color display are still at least partially included in the key. Knowing 
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this, you can make further parameter adjustments that remove these values more completely from the 
key. By viewing both the SpectraGraph display and the standard view of the composited images, you 
get all the information you need to produce a high-quality key.

The Alpha Matte Display

The alpha matte display shows the alpha matte that the SpectraMatte effect is currently generating. 
This matte is used to create the final composite of foreground and background images. You activate 
the alpha matte display using controls in the Matte Analysis category in the Effect Editor. For more 
information, see “Key: SpectraMatte Effect” on page 472.

The alpha matte display is particularly useful for checking and adjusting how foreground and 
background pixels are being blended at the edges of the matte. Refining this blend is often important 
to create a natural-looking composite of foreground and background.

As you adjust parameter controls that affect the position and extent of the blend, the alpha matte 
display updates to show the result of your adjustments.

The following illustration shows a typical alpha matte display.

How the SpectraMatte Effect Calculates Key Color Values

The SpectraMatte effect calculates a range of color values that are either completely or partially 
keyed out from the foreground image. In the SpectraGraph display, this range of color appears as a 
wedge with blended edges in the CbCr color swatch. The effect generates an alpha matte based on 
these values, then uses this matte to create the final composite.

The shape and design of the wedge is a good model for calculating key color values because it 
automatically keys out a relatively wide range of high-saturation color values in the region of the key 
color. These are the kinds of color values that should always require keying out of well-shot key 
footage and that you should not normally need to blend or adjust. The wedge also provides very 
precise control over lower saturation color values and hue color values that fall on the borderline 
between those you want to key out and those you want to retain. These are the kinds of color values 
that you often need to blend or fine-tune, for example, to improve the edges of the foreground subject 
in a key shot.

This topic explains how the SpectraMatte effect calculates the key color wedge from some of the 
main parameter values you set. For detailed information about all of the SpectraMatte effect’s 
parameters, see “Key: SpectraMatte Effect” on page 472.
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The basic size and position of the wedge is defined by the following parameters:

• The hue set by the Key Color parameters defines the position of the wedge around the swatch. In 
the following illustration, the key color is green, so the wedge falls in the green part of the 
swatch.

• The saturation value set by the Chroma Control Key Saturation parameter defines the location of 
the center point of the wedge. The illustration shows the effect of the default Key Saturation 
value (0), so the point of the wedge is at the exact center of the swatch. You can move the wedge 
out from the center of the swatch by increasing the Key Saturation value.

• The angle set by the Chroma Control Tolerance parameter defines the width or spread of the 
wedge. The illustration shows the effect of the default Tolerance value (90 degrees), so the 
wedge is 90 degrees wide, 45 degrees on either side of the line between the Key Saturation value 
and the Key Color value.

The Key Color wedge in the SpectraGraph display. The white point at the center is the point defined by the Key 
Saturation parameter. The white point within the wedge is the point defined by the Key Color parameter. The marked 
angle is the angle defined by the Tolerance parameter.

Many of the other parameters modify how this basic key color wedge is calculated. For example, the 
Key Saturation Line parameter reshapes the wedge near the center of the swatch so that it retains a 
wider range of low-saturation color values from the foreground image. Several parameters affect how 
the blend gradient is calculated (its position and its width on the wedge), which results in changes to 
how foreground and background pixels blend in the final composite.

Creating a SpectraMatte Effect

To create a SpectraMatte Key effect:

1. Create a sequence with two video layers.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Edit the background image onto track V1 and the foreground image onto track V2.

3. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

4. In the Effect Palette, click the Key category.

5. Drag the SpectraMatte icon from the Effect Palette to the clip on track V2.

Media Composer adds the SpectraMatte Key effect.

6. Move the position indicator to the segment containing the effect in the Timeline.
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The Effect Editor displays parameters for adjusting the SpectraMatte effect. The effect uses 
advanced keyframes.

7. Click the Color Preview window in the Key Color parameter category to display the Eyedropper 
icon, and then drag the eyedropper to a representative region of the blue or green background 
screen in the Record monitor.

Media Composer selects the primary key color, and the key takes effect.
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8. Fine-tune the key by enabling and adjusting additional parameter categories as necessary.

 This example uses the following adjustments to improve the edges of the key:

- Increase the Spill Angle Offset value

- In the Matte Processing parameter category, use the Erode matte Blur type and add a small 
amount of Matte Blur

- In the Chroma Control parameter category, increase the Inner Softness value

You can achieve similar results using different parameter combinations. For more information, 
see “Understanding the SpectraMatte Chroma Key Effect” on page 197.

While adjusting the colors and matte, use the analysis displays as described in “Understanding 
SpectraMatte Analysis Displays” on page 197. For more information on specific parameters, see 
“Key: SpectraMatte Effect” on page 472.

Understanding the Chroma Key Effect and the RGB Keyer Effect

The Chroma Key and RGB Keyer effects do not create as high a quality key as the SpectraMatte 
effect. However, they provide backwards compatibility with older Avid editing applications.

If you are moving sequences between different versions of Avid editing applications, use the Chroma 
Key or RGB Keyer effect. Otherwise, try the higher quality SpectraMatte effect.

n You can promote a Chroma Key effect to the SpectraMatte effect. For more information, see 
“Promoting a Chroma Key Effect to the SpectraMatte Effect” on page 205.

The Chroma Key effect and the RGB Keyer effect are typically used with a foreground image shot in 
front of a highly saturated color screen that is keyed against a background image.

This topic explains the basic differences between these color-based key effect options. For 
information on creating color-based key effects, see “Creating a Chroma Key Effect or RGB Keyer 
Effect” on page 203.

Chroma Key Effect

The Chroma Key effect includes several standard effect parameters such as scaling, position, and 
crop in addition to key control parameters. You can also promote the Chroma Key effect to 3D for 
additional adjustments to various 3D parameters such as skew, perspective, and spline-based motion.

Use the Chroma Key effect when you want to work in real time, or when you need to adjust various 
parameters of the foreground chroma key footage.
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Chroma Key effect example: the original key (left), and the key after promoting to 3D, repositioning, and applying defocus 
to enhance the effect of perspective between foreground and background

RGB Keyer Effect

The RGB Keyer effect is a non-real-time plug-in effect that includes additional parameters for fine-
tuning the edges of the key and for applying post-key color correction (correction applied to the 
foreground image without affecting the key itself). You cannot promote the RGB Keyer effect to 3D.

Because the foreground and background elements of a chroma key are often shot at different times 
and locations, post-key color correction is especially useful for maintaining the key while matching 
the visual characteristics of the foreground elements to the background footage.

Use the RGB Keyer when working with full-screen chroma key footage that does not require 
parameter adjustments such as repositioning or scaling, or when you need the RGB Keyer’s post-key 
color correction capabilities to better match the foreground to the background.

Creating a Chroma Key Effect or RGB Keyer Effect

To create a Chroma Key effect:

1. Create a sequence with two video layers.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Edit the background image onto track V1 and the foreground image onto track V2.

3. In the Effect Palette, click the Key category.

4. Drag either the Chroma Key Effect icon or the RGB Keyer icon from the Effect Palette to the clip 
on track V2.

The following example shows the Chroma Key effect applied to V2.

Media Composer adds the Chroma Key effect. Ultimatte® blue is the default key color. 

5. Move the position indicator to the segment containing the effect in the Timeline.

6. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor displays parameters for adjusting the effect.
203



Key Effects
7. Open the Key parameter category (Chroma Key effect) or the Key Color parameter category 
(RGB Keyer). 

Ultimatte blue is selected by default. To match the key color more closely to the color of the 
background screen used in the footage, proceed with the following step.

8. (Option) Click the Color Preview window in the Key or Key Color parameter category to display 
the Eyedropper icon, and then drag the eyedropper to a representative region of the blue or green 
background screen in the Record monitor.

Media Composer selects the primary key color, and the key takes effect.

9. Fine-tune the key by enabling additional parameter categories and then adjusting parameters as 
necessary.

For more information on specific parameters, see the reference information in “Key Effects” on 
page 469.

10. (Option) Perform post-key color correction by adjusting the hue, saturation, and value of the 
foreground elements using the Color Correction parameters in the Effect Editor.

For more information on the specific parameters, see the reference information in “Key: RGB 
Keyer” on page 471.
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Promoting a Chroma Key Effect to the SpectraMatte Effect

You can promote a Chroma Key effect to the SpectraMatte effect. Because of the differences in the 
way the two effects work, existing parameter adjustments in the Chroma Key effect might not all 
move forward to the SpectraMatte effect. The primary key color does always move forward correctly 
to the SpectraMatte effect.

To promote a Chroma Key effect to the SpectraMatte effect:

t Click the Promote to SpectraMatte button in the bottom right of the Effect Editor for the Chroma 
Key effect.

Creating a Luma Key Effect

Use a Luma Key effect to replace portions of the foreground video with the background video based 
on brightness or luminance. 

To create a Luma Key effect:

1. Create a sequence with two video layers.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Edit the background image onto track V1 and the foreground image onto track V2.

3. In the Effect Palette, click the Key category.

4. Drag the Luma Key Effect icon from the Effect Palette to the segment on track V2.

5. In the Timeline, move the position indicator to the segment with the Luma Key effect.

6. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

The Luma Key parameters appear in the Effect Editor.

7. Use the eyedropper or the Luma Key sliders to select a brightness value in the foreground video. 

Media Composer replaces the corresponding portions of the foreground video with background 
video.

For information on all Luma Key parameters, see “Key: Luma Key” on page 470.

Creating a Matte Key Effect

A Matte Key effect replaces one part of the video image with another video image or graphic based 
on the location of a high-contrast image known as a matte.

The Matte Key effect uses three layers of video to create the effect. The bottom layer is the 
background image, the middle layer is the foreground image, and the top layer contains the matte or 
alpha channel.

To create a Matte Key effect:

1. Create a sequence with three video layers.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Edit the background image onto track V1 and the foreground image onto track V3.

3. Load a high-contrast image into the Source monitor, and edit it onto track V3.
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The high-contrast image can be an imported graphic or a clip that you adjust within Media 
Composer.

n If the image is not high enough in contrast, you can adjust the contrast by applying the Color Effect, 
and then adjusting its parameters in Effect mode. For more information, see “Using the Color Effect 
to Prepare a High-Contrast Image” on page 207.

4. In the Effect Palette, click the Key category.

5. Apply the Matte Key effect as follows:

t If your high-contrast image was created with the Color Effect, press and hold the Alt key 
(Windows) or Option key (Macintosh) and drag the Matte Key Effect icon from the Effect 
Palette onto the segment on track V3 to nest the Color Effect within the Matte Key effect.

t If your high-contrast image on track V3 does not include a Color Effect, drag the Matte Key 
Effect icon from the Effect Palette onto the segment on track V3.

6. Click the Record Track Monitor button for track V3 in the Track Selector panel.

Tracks V2 and V1 become visible through the high-contrast image on track V3.

7. Move the position indicator to the Matte Key effect, and render the effect.

For more information, see “Basics of Effects Rendering” on page 41.

n For information on Matte keys and Matte Key parameters, see “Using Matte Keys with 3D Effects” 
on page 284 and “Key: Matte Key” on page 471.

Working with Real-Time Moving Mattes

If you import a moving matte as a 32-bit QuickTime file or a graphic sequence, Media Composer 
handles the effect in real time. Media Composer treats a QuickTime file with embedded alpha as a 
moving matte if it has more than one frame.

The basic procedure for importing a moving matte is described in “Importing Files” in the Help.

You should be aware of the following when editing with real-time moving mattes:

• You can promote a real-time Matte Key effect to a 3D Warp effect, and use the 3D manipulation 
parameters.

• If the Matte Key effect is not on the top video track of a multilayered composite, you must render 
it before it can play in real time.

• If you add a motion effect to the matte and foreground, the effect does not play in real time until 
you render the motion effect.

• Real-time moving mattes cannot be combined with real-time titles without rendering the effect.

• Moving mattes in a 24p or 25p project play in real time in their native format only. You must 
render moving mattes in order to output the sequence in alternate formats when using the Digital 
Cut tool. For example, a moving matte imported into a 24p NTSC project does not play back to 
the PAL format on output unless you render it first.
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To import a QuickTime file as a moving matte:

1. Click the Image tab of the Import Settings dialog box.

2. In the Alpha parameter category, select either Use Existing or Invert Existing.

To import a graphics sequence as a moving matte:

1. Select the first file in the sequence as the file to import.

2. In the Image tab of the Import Settings dialog box, select Autodetect Sequential Files.

Media Composer uses all the files in the sequence to make the moving matte. If you import only 
one graphic file with alpha, it becomes a static matte.

Media Composer creates a real-time Matte Key effect with nested alpha and video fill. To 
preserve real-time performance, Media Composer locks the alpha track so that you cannot 
replace it.

Using the Color Effect to Prepare a High-Contrast Image

This topic describes how to enhance high-contrast images for use in creating Matte Key effects. You 
can also import a graphic image with an alpha channel and use it as a Matte Key effect. For more 
information, see “Working with Imported Graphics and Animation” on page 207.

To create a high-contrast image from available footage:

1. Apply the Color Effect to the clip.

For more information, see “Applying Effects” on page 27.

2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. Change the Luma Range to 0 to 255.

4. Drag the Sat (saturation) slider under Chroma Adjust all the way down to remove all color 
saturation from the image.

5. Adjust the Gamma to change the color of the midtones.

You can now use the high-contrast image as a matte for the key effect, as described in “Creating 
a Matte Key Effect” on page 205.

6. (Option) Black portions of the high-contrast image are transparent and white portions are 
opaque. To switch the order, use the Reverse option in the Foreground parameter category of the 
Matte Key effect.

Working with Imported Graphics and Animation
This topic describes two different methods for editing with imported graphic images, depending 
upon whether:

• The image was imported as a master clip with no alpha channel (an opaque graphic element).

• The image was imported as a Matte Key clip with an alpha channel (a keyable graphic element 
for video overlay).

Both single-frame graphic images (such as a single JPEG file) and multiple-frame animation 
sequences (such as a JPEG file sequence) appear in the bin in the same form after import, and 
you use the same editing techniques for both. You can edit this type of clip into a sequence as a 
standard matte key overlay.
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n Only single-frame files can be used as real-time keyed graphics. PICT sequences, QuickTime files, 
PICS animation files, and ERIMovie files cannot be used as real-time keyed graphics.

These alternatives apply to both single-frame graphic images and animation. You can also edit 
imported images into sequences by using standard Avid editing application effects.

n (Windows only) AVI files cannot be imported with an alpha channel. To import animation with an 
alpha channel, you must use another supported format. For more information on importing graphic 
and animation clips, see “Importing Files” in the Help.

To edit an imported master clip into the sequence:

1. Create the sequence, and then load a graphic clip into the Source monitor.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. In the Source monitor, mark an IN point at the start of the clip and an OUT point to specify the 
duration of the graphic.

3. In the sequence, mark an IN point where you want the graphic clip to begin.

4. Click the Source Track and Record Track buttons.

5. Click the Splice-in button or the Overwrite button to add the opaque graphic to the sequence.

Splice-in button (left) and Overwrite button (right)

The opaque image appears in the sequence. In the Timeline, the graphic looks like a standard 
video clip edited into the sequence.

6. Play the clip by using the standard playback procedures.

To edit a Matte Key clip into the sequence:

1. Edit the main video sequence.

2. Add a new track above the tracks in the sequence by selecting Clip > New Video Track.

n You must edit Matte Key clips onto an upper track to achieve the keying effect. If you edit a Matte Key 
clip onto track V1, for example, the image is keyed over black unless track V1 contains nested tracks.

3. Play the sequence, and mark an IN point and an OUT point where you want to overlay the 
graphic.

4. Load a Matte Key clip into the Source monitor. Mark an IN point toward the center of the clip if 
it is a still.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

5. In the Track Selector panel, click the V1 Source Track button and drag it to the Record Track 
button for the new track to patch the video from track V1 of the Source monitor to the track in 
the sequence that will receive the Matte Key clip.

Track Selector panel before (left) and after (right) patching Source V1 to Record V2

6. Click the Overwrite button to edit the matte key into the sequence.
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Media Composer keys the graphic over the video on the lower tracks.

7. Adjust effect parameters in the Effect Editor, if necessary, using procedures described in “Using 
the Effect Editor” on page 68.

8. (Option) If the keyed portions of the images are the reverse of the intended effect, open the 
Foreground parameter category and click the Invert Key button.

For more information, see the reference information in “Foreground” on page 496.

9. Use standard effect editing procedures to preview, render, or play the Matte Key clip.

To see the complete effect, make sure the Record Track Monitor button for the topmost track is 
selected in the Track Selector panel.

Nesting Effects
You can place effect tracks inside one another to better combine multiple images and effects. This 
involves a process known as nesting, which lets you use the Timeline to step into a track, perform a 
series of editing operations, and then step out to view and render the effect as one segment on the 
track.

Example of nested layers in a Timeline. Tracks 1.1, 1.2, and 1.3 hold effects nested inside the Submaster effect on track 
V1. Tracks 2.1 and 2.2 are additional nested layers inside the first nest.

Depending on the model of Media Composer, you can edit up to 24 video track layers, and you can 
additionally nest (stack inside) up to 24 more video tracks within each layer. You can also nest 
AudioSuite effects. You can step into each video track indefinitely, constrained only by your Avid 
system’s memory.

You can use nesting when you want to create layered effects. The nested layers are treated as one 
element during the transition.

Transition effects themselves, such as dissolves, fades, and wipes, are not multilayered, so nesting is 
not applicable to transition effects. 

Nested effects have the same playback capabilities and constraints as any other effects that you apply 
to a sequence. However, because of the complexity you create when you layer effects in nests, nested 
effects are a good example of a situation where you might need to render or change video display 
settings to achieve acceptable playback.

n Some effects do not work well together when nested. For example, you cannot use the Box Wipe effect 
and Edge Wipe effect together in a nested segment because the two effects are competing to establish 
the shape of the wipe.

Another use of nesting is to constrain one effect using another effect. For example, you can use the 
Circle Shape Wipe effect to constrain an image posterization inside a region.
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All nested effects on a segment are fully available when they use advanced keyframes. You can open 
and manipulate the available parameter and keyframe graphs for any nested effect at any time.

n Nested effects do not appear in edit decision lists (EDLs) because they are not supported by linear 
tape-based edit controllers.

Stepping Into and Out of Nested Effects

You can step into an existing nested effect for editing. When you step into the effect, Media 
Composer replaces the full sequence in the Timeline with just the tracks that make up the nested 
effect. You can then add new tracks, monitor individual tracks, edit source material into the tracks, 
and apply and adjust effects on the nested tracks. You can step into any segment effect in this way.

n You can also expand nested effects while leaving the rest of the sequence visible in the Timeline. See 
“Expanding Nested Effects in the Timeline” on page 210.

When you step into a nested effect, a number appears with the letter N in the Timecode button. This 
number represents the level of nesting that you are currently in. For example, N2 indicates that you 
are two levels in from the outermost track level.

To step into a nested effect:

t Click the Step In button.

To step out of a nested effect:

t Click the Step Out button.

n The Step In and Step Out buttons appear by default in the Timeline top toolbar, and are also 
available in the Command palette.

Expanding Nested Effects in the Timeline

You can expand an existing nested effect for editing within the Timeline. You can then add new 
tracks, edit source material into the tracks, and apply and adjust effects on the nested tracks. You can 
expand any segment effect in this way.

n You cannot monitor individual tracks when you expand nested tracks in the Timeline. To monitor 
individual tracks within a nested effect, see “Stepping Into and Out of Nested Effects” on page 210.

To expand a nested effect, do one of the following:

t In Effect mode, double-click the nested effect.

t In Source/Record mode, click one of the segment tools on the Timeline palette, and then double-
click the nested effect.

Segment tools in the Timeline palette
210



Nesting Effects
The nested tracks appear in the Timeline above the track you double-clicked. Editing and 
patching features are available for changing the content of the track’s effect.

To step out of the nested effect

t Double-click the effect’s icon in the Timeline.

Creating a Simple Nested Effect

This example involves nesting a sequence of clips with dissolves inside another segment effect.

To create the nest:

1. Create a sequence and add a segment effect.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

p

2. Click one of the segment tools on the Timeline palette, and then double-click the segment.

Segment tools in the Timeline palette

The segment opens to reveal the nested tracks.

3. Edit new footage into the nested tracks, and apply additional effects as necessary.

In this example, a series of clips is edited onto nested track 1.2, with dissolves applied between 
the shots. The 3D Picture-in-Picture effect applies to the entire nested dissolve sequence.
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4. Double-click the main track for the nested effect (V2 in this example) to close the nested tracks 
again.

Nested Effects in the Effect Editor

Nested effects on a segment are fully available in the Effect Editor if the effects use advanced 
keyframes. You can open and manipulate the available parameters and keyframe graphs for any 
nested effect at any time. For example, if you have a Picture-in-Picture effect with a Color Correction 
effect nested inside it, you can see both effects and their parameters in the Effect Editor, as shown in 
the following illustration.

Foreground and nested effect in the Timeline (top) and in the Effect Editor (bottom)

If you have nested standard keyframe effects in a sequence, the Effect Editor shows only one effect at 
a time. If you have a mix of standard keyframe and advanced keyframe effects in a nest, effects below 
the standard keyframe do not show in the Effect Editor unless you step into the nest.

Changing the Order of Nested Effects

You can change the order of most nested effects in the Effect Editor.

To change the order of nested effects:

t Drag the effect icon for the effect you want to move to the position you want it to occupy in the 
nest.
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Before (left), during (center), and after changing the order of nested effects. In this example, the SubCap effect is 
moved above the Color Effect and Flop effects.

If you attempt a change in order that is not possible, a message box opens that explains why you 
cannot make the change. For example, you cannot change the order of nested effects if the result 
would not provide enough video inputs for the effect.

(Symphony Option) Also, color corrections that use relationships must be the lowest effect in a 
nest.

When you release the mouse button, the order of the effects changes in the Effect Editor and in 
the Timeline. Changes to the appearance of the image appear in the Effect Preview monitor. For 
example, the following illustration shows the results of changing the order of a Flip effect and a 
Subcap effect.

A simple example of changing the order of nested effects. In the original order, the SubCap effect is nested inside 
the Flop, so the text in the image is reversed. Changing the order of the two effects in the Effect Editor corrects the 
problem.

Nesting a Matte Key Effect

A Matte Key effect uses three layers of video to create the effect.
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To nest a Matte Key effect:

1. Create a sequence with the background video on track V1.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Load a high-contrast image into the Source monitor, and edit it onto track V2.

For an example of a high-contrast image, see “Key: Matte Key” on page 471.

3. In the Effect Palette, click the Key category.

4. Drag the Matte Key Effect icon from the Effect Palette to the segment on track V2.

5. Click one of the segment tools on the Timeline palette.

Segment tools in the Timeline palette

6. Double-click the Matte Key Effect icon in the segment.

The Timeline expands to display three nested tracks (1.1, 1.2, and 1.3). 

By default, nested track 1.3 contains the same image segment as track V2. Nested track 1.2 is 
empty (foreground filler track). Nested track 1.1 (background video) is also empty.

7. Click one of the segment tools again to stop segment editing so you can edit the tracks.

8. Edit the foreground image onto nested track 1.1.
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9. Click one of the segment tools on the Timeline palette, and double-click track V2 to collapse the 
nested tracks.

10. Click the Record Track Monitor button for track V2 in the Track Selector panel.

Tracks V1 and nested track 1.1 become visible through the high-contrast image on track 1.3.

For information on Matte Key parameters, see “Key: Matte Key” on page 471.

Submaster Editing
The Submaster effect is a single-track segment effect, available in the Image category of the Effect 
Palette. You can apply the Submaster effect to a track above layered or nested effects and then render 
only the Submaster. Media Composer renders the composite result of all tracks into the top track. 
Rendering a Submaster effect saves the new Submaster clip to the drive as a single media file. 
However, Media Composer leaves each element that makes up the composite untouched, so you can 
still manipulate any element. 

The Submaster effect is useful when you want to play back bandwidth-limited sequences, such as 
sequences composed of several seconds of single-frame clips. It is much faster to use the Submaster 
effect than to use methods such as applying a graphic, or using a Picture-in-Picture, Mask, or Resize 
effect. Normally, Submaster effects render at about the same rate as motion effects.

The Submaster effect maintains links to the original media files, so you should not delete the original 
media files. If you want to combine tracks to create a sequence that is independent from the original 
media files, perform a video mixdown. For more information, see “Performing a Video Mixdown” on 
page 218.

The Submaster effect does not render each track separately, so you cannot play each track 
individually, and the blue dot remains in the effect icon. If you delete or modify a track below a 
Submaster effect, the Submaster effect becomes unrendered.

n You can nest up to 24 tracks inside a Submaster effect depending on the model of Media Composer.

An edit decision list (EDL) for a sequence that contains a Submaster effect represents the contents of 
the Submaster effect as a single cut. To work around this, you can create a new sequence with the 
contents of the Submaster effect and generate a separate EDL for that sequence.

To apply the Submaster effect to a multilayered sequence:

1. Select Timeline > New > Video Track.

2. On the new video track, create one add edit before and another after the group of clips to be 
submastered.
215



Collapsing Layers into a Submaster Effect
Add edits on track V5 bracket a group of clips on V4

For more information on add edits, see “Working with Add Edits (Match Frames)” in the Help.

3. In the Effect Palette, click the Image category.

4. Drag the Submaster Effect icon to the space between the add edits you created in step 2.

Media Composer applies the effect above the layers.

Submaster effect on track V5

5. Render the Submaster effect, as described in “Basics of Effects Rendering” on page 41.

To apply the Submaster effect to multiple short clips:

1. Select Timeline > New > Video Track.

2. On the new video track, create one add edit before and another after the group of clips.

For more information on add edits, see “Working with Add Edits (Match Frames)” in the Help.

3. In the Effect Palette, click the Image category.

4. Drag the Submaster Effect icon to the space between the add edits you created in step 2.

5. Render the Submaster effect, as described in “Basics of Effects Rendering” on page 41.

Collapsing Layers into a Submaster Effect
The Collapse feature lets you build your effect at the topmost level. When you are finished, you 
collapse the layers automatically into one Submaster effect. This is useful for simplifying a sequence 
with complex compositing. After you collapse a complex composite, you can easily add transition 
effects to the start and end of the resulting Submaster effect.
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n You can also use the Collapse feature to simplify the deletion of multilayer segment effects. After 
collapsing the effects, you can select the resulting segment and press the Delete key twice to delete 
the effect and all the layers.

After Media Composer collapses tracks into a Submaster effect, it recognizes a Submaster effect as a 
multilayer effect instead of a single-layer effect. This lets you add chroma keys and other multilayer 
effects to the nested tracks within a Submaster effect.

n You can drag “two-channel” effects (such as chroma keys) onto Submaster effects if the Submaster 
segment contains two or more nested tracks. This is useful after performing a Collapse operation to 
composite the new Submaster effect over another background.

To collapse layers into a submaster effect:

1. Select all the tracks you want to collapse.

The tracks must be adjacent.

2. Mark an IN point and an OUT point around the area you want to collapse.

3. Click the Collapse button.

Depending on the model of Media Composer, the Collapse button might appear by default in the 
Timeline top toolbar or in the Tool palette. It is also available from the Command palette.

Media Composer collapses the tracks into a Submaster effect on a single track.

To open the nested tracks again:

1. Click one of the segment tools on the Timeline palette.

Segment tools in the Timeline palette

2. Double-click the Submaster effect.

To collapse a sequence (alternative procedure):

1. Click one of the segment tools on the Timeline palette.

Segment tools in the Timeline palette

2. Select the segments you want to collapse.

3. Click the Collapse button.
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Performing a Video Mixdown
Video mixdown lets you combine several tracks into a new master clip. You can use video mixdown 
after you finish building your sequence and want to make it into one piece (for example, a standard 
opening to a program).

Video mixdown is useful when you want to:

• Create a complex sequence you need to use repeatedly.

• Add a motion effect to an entire sequence.

• Finalize a complex sequence before consolidating, exporting, or transferring.

n For information to prepare a RED clip for a video mixdown, see “Preparing your Red Clip for 
Transcode, Mixdown or Render” in the Help.

Video mixdown is similar to the Collapse feature, but the end result is different: 

• With the Collapse feature, you collapse the tracks into a Submaster effect. After you collapse the 
tracks, you are still able to step in to the Submaster effect and work on the individual elements. 

• With video mixdown, your end result is a new master clip made up of all the tracks you built on 
different layers. Those tracks become one clip. You cannot separate the tracks to work on them 
or step in to the sequence.

For more information on the Collapse feature, see “Collapsing Layers into a Submaster Effect” on 
page 216.

n You cannot generate an edit decision list (EDL) for a sequence that contains a video mixdown. To 
work around this, you can either remove the video mixdown or maintain a version of the sequence 
that does not contain a video mixdown.

To perform a video mixdown:

1. Select the Record Track Monitor button in the Track Selector panel for the highest track you 
want to include in the video mixdown.

n Video Mixdown collapses the selected track and all tracks under it. If you want to perform a video 
mixdown of only one track, select the track for solo monitoring by Ctrl+clicking (Windows) or 
Shift+clicking (Macintosh) the Record Track Monitor button. For more information, see “Patching 
Tracks” in the Help.

2. Mark an IN point and an OUT point around the area to mix down.

3. Select Timeline > Mixdown > Video.
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The Video Mixdown dialog box opens.

4. Select a target bin, target drive, and resolution for storing the new master clip, and then click OK.

A progress indicator appears. When the video mixdown finishes, a new clip appears in the bin 
along with the sequence, and a new media file is created on the target drive.

n If your sequence includes a data track, the data track will not mixdown with the video tracks. 
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9 Working with Camera Effects

This chapter describes effects that control aspect ratio, format, or apparent camera motion in a clip.

• Using the Reformat Effects

• Working with the Pan and Scan Effect

• Using Avid Pan & Zoom

n You can also use the Stabilize and Region Stabilize effects to alter the apparent camera motion in a 
clip in order to eliminate unwanted camera motion. For more information, see “Motion Tracking and 
Stabilization” on page 240.

Using the Reformat Effects
You use Reformat effects to reformat media to different aspect ratios, such as when you need to 
reformat a film aspect ratio for television programming or combine 4:3 legacy media into a 16:9 
master.

One of these effects, Pan and Scan, usually works as a vertical effect that you apply to a layer above 
the rest of your video material and that affects all the video material beneath it. For more information, 
see “Working with the Pan and Scan Effect” on page 221.

Reformat effect example: original footage (left) and image after applying the 16:9 Letterbox effect (right)

n A Reformat effect works on all tracks below the track to which you apply it. For example, if you apply 
the effect above a title track, the titles become reformatted as well. If you do not want to reformat the 
titles, apply the effect below the title track.

The following table describes the three Reformat effects, other than Pan and Scan, that reformat 
media to new aspect ratios. For reference information on these effects, see “Reformat Effects” on 
page 477.
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Working with the Pan and Scan Effect

Pan and Scan lets you select a portion of the media to reformat and provides other parameters.

Pan and Scan also supports conversion of 15:9 Anamorphic source media to 16:9 Anamorphic. For 
more information, see “Selecting the Source and Target Aspect Ratios for the Pan and Scan Effect” 
on page 223.

n If you use the Pan and Scan effect and another Reformat effect on the same sequence, you must 
render one of the effects before the sequence can play in real time. For more information on other 
Reformat effects, see “Using the Reformat Effects” on page 220.

Understanding the Pan and Scan Effect

Pan and Scan is a technique for reformatting media to different aspect ratios. The most widespread 
use of this technique is for reformatting television programming, for example, when you need to 
convert 16:9 Anamorphic material to the 4:3 aspect ratio. By selecting a portion of each frame in 
your media for output, you reformat without distorting the media. Traditionally, this selection 
process, known as Pan and Scan, is done in a telecine room during film-to-tape transfer.

The Pan and Scan effect lets you pan across your media and select what portion of the media you 
want to retain for output. If necessary, you can use keyframes to adjust the effect.

You can use Pan and Scan on any type of project.

Pan and Scan example: original media with the Pan and Scan wireframe in 16:9 mode (left), and results
of the Pan and Scan effect in 4:3 mode (right)

Effect Description

16:9 Letterbox Scales the image vertically to the 16:9 aspect ratio within a 4:3 frame. Works on 
16:9 Anamorphic media.

14:9 Letterbox Reformats media to the 14:9 Letterbox aspect ratio with a black band at the top 
and bottom. The effect expands the media horizontally by a fixed amount before 
scaling it down vertically, resulting in a slight horizontal cropping of the image. 
You control what part of the image is cropped with the Position slider.

4:3 Sidebar Reformats 4:3 source media to the 16:9 Anamorphic aspect ratio by scaling 
down the media horizontally and applying a black band to the left and right sides 
of the image.
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Outputting Media with the Pan and Scan Effect

You can output media with the Pan and Scan effect in two video formats: 4:3 or 16:9 Anamorphic. 
The Pan and Scan effect does not generate data for inclusion in cut lists. If your target is not video, or 
if your source requires excessive scaling, you can preview the reformatting operation, but the Pan and 
Scan effect does not automate a film-to-film or a film-to-tape transfer.

Positioning the Pan and Scan Track

When your sequence does not contain titles, the Pan and Scan track is typically the top track. When 
you have titles, you can place the Pan and Scan track above a title track to scale the title along with 
the video tracks beneath it. If you need to pan, however, the pan applies to the title as well as the 
other video tracks. Since this technique results in the title being panned, the results might not be what 
you want.

If you need to pan your footage and the title aspect ratio is not critical, you can move the titles above 
the Pan and Scan track. If the title aspect ratio is important, you might need to create a new title in 
your target aspect ratio.

If you use titles on a Symphony Option system, the most effective way to work with Pan and Scan 
and titles is to use multiformat titles. If you work with multiformat titles, you can place the Pan and 
Scan track below the titles. This placement ensures that both titles and the Pan and Scan effect play 
correctly in real time.

n When you place the Pan and Scan effect below multiformat titles, you might not see the titles with the 
correct Target aspect ratio as you work. For example, if you are reformatting from 4:3 to 16:9, titles 
appear distorted in the Client monitor. When you output the sequence at 16:9 by using the Digital 
Cut tool, select the 16:9 aspect ratio and the titles are sized correctly during the digital cut. 

Applying the Pan and Scan Effect

Because the Pan and Scan effect controls the aspect ratio of your final output, you must apply the 
effect to your entire sequence. Apply the Pan and Scan effect to its own video track after you finish 
editing the sequence.

n You might want to place a Pan and Scan effect directly on a video segment. For more information, see 
“Combining the Pan and Scan Effect with Transition Effects” on page 229.

n If you apply the Pan and Scan effect and then add a segment to or remove a segment from your 
sequence, the Pan and Scan effect does not automatically adjust to cover the entire segment. You can 
either trim the Pan and Scan effect manually, or remove the Pan and Scan effect and insert a fresh 
effect.

To apply the Pan and Scan effect:

1. After you finish editing your sequence, press Ctrl+Y (Windows) or Command+Y (Macintosh) to 
create a new video track on the topmost track.

2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. In the Effect Palette, click the Reformat category.
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4. Drag the Pan and Scan Effect icon from the Effect Palette to the new track.

Selecting the Source and Target Aspect Ratios for the Pan and Scan Effect

In Effect mode, the Pan and Scan effect displays a white wire frame in the Effect Preview monitor. 
This wire frame lets you select the portion of the media that appears in your output. The Pan and 
Scan aspect ratios determine the size and shape of the wire frame. Setting these ratios correctly is the 
most important part of using Pan and Scan.

Whenever you change aspect ratios, you must decide which part of an image to retain for the final 
output and which part to discard. The Pan and Scan aspect ratios specify the size of the incoming 
image and determine how much of that image you retain for your final output.

You must set two ratios:

• Source ratio specifies the aspect ratio of your incoming media.

• Target ratio specifies the aspect ratio of the final output.

To set the Source and Target aspect ratios for a Pan and Scan effect:

1. Apply the Pan and Scan effect to the new video track, as described in “Applying the Pan and 
Scan Effect” on page 222.

2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.
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3. Move the position indicator to the Pan and Scan effect.

4. In the Effect Editor, click the triangular opener for the Aspect Ratios parameter category.

5. Set the Source aspect ratio to the ratio of your source material.

6. Set the Target aspect ratio to the ratio of the final output. 

Viewing Pan and Scan Media

In Effect mode, the Effect Preview monitor displays your original media and the Pan and Scan wire 
frame. The Client monitor displays the original media.
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In Source/Record mode, the Client monitor displays the media inside the Pan and Scan wire frame. 
The portion of the image inside the wire frame expands to fill the entire monitor. The Record monitor 
also shows the media inside the wire frame. The media is distorted if either the Source or Target 
aspect ratio is 16:9 Anamorphic.

In Effect mode (left) the original media displays in the Effect Preview monitor with the Pan and Scan wire frame. In 
Source/Record mode (right) the Record monitor shows a distorted view of the results of the Pan and Scan effect (the 
Client monitor shows an accurate view of the results).

Other effects let you view results on a frame-by-frame basis in Effect mode but the Pan and Scan 
effect does not. You see the entire source image so that you can select a portion of it. To see the 
results of the Pan and Scan effect while in Effect mode, click the Play button. In Source/Record 
mode, you can see the results of the Pan and Scan effect on a frame-by-frame basis or by playing the 
media.

Using the Effect Grid

The Effect Grid displays positioning guides that help you move and position the Pan and Scan wire 
frame. Displaying the Safe Action grid and Thirds grid can be particularly useful when adjusting Pan 
and Scan compositions. 

The following illustration shows the Effect Grid with Show Safe Action, Show Thirds, and Show 
Axes selected.

n Safe Title/Safe Action and Thirds grid marks are based on the Target aspect ratio and are displayed 
inside the wire frame. Other grid markings are displayed as normal across the entire monitor.
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You can open the Grid Settings dialog box by clicking the Other Options button in the Grid 
parameter category of the Effect Editor. The Grid Settings dialog box controls the size, position, and 
display of a variety of grids. For more information on Grid settings, see “Understanding the Effect 
Grid” on page 64.

In addition to using the options in the Grid Settings dialog box, you can use the controls in the Grid 
parameter category of the Effect Editor to change some Grid settings. For more information on these 
parameters, see “Grid” on page 497.

Setting an Origin in the Pan and Scan Effect

Each Target aspect ratio has default position and scaling settings. You can return to these default 
settings at any time by selecting the aspect ratio again. 

You can also use the Establish Origin parameter to create customized default values for each instance 
of the Pan and Scan effect. 

n Establish an origin before subdividing or adjusting individual keyframes in your Pan and Scan effect.

After you insert the Pan and Scan effect, you might want to adjust the size and position of the wire 
frame and save the wire frame’s new settings as base settings for the effect.

To save wire-frame settings for the Pan and Scan effect:

t In the Effect Editor, open the Actions parameter category and click Establish Origin.

To reset the wire frame for the Pan and Scan effect:

t In the Effect Editor, open the Actions parameter category and click Reset to Origin.

Reset to Origin is useful for quickly centering the wire frame after you move it.

n If you have not set a custom origin, clicking Reset to Origin returns to the default values for the 
Target aspect ratio.

Subdividing the Pan and Scan Effect

When your sequence contains a variety of segments with different panning requirements, you might 
need to adjust the position of the Pan and Scan effect on a segment-by-segment basis. The Subdivide 
Effect parameter makes it easier to adjust Pan and Scan for individual segments. Subdivide Effect 
splits the Pan and Scan effect based on the segment boundaries of the selected video tracks 
underneath the Pan and Scan track.

n You can also use add edits to subdivide a Pan and Scan effect manually.

The following illustrations show the Timeline before and after using the Subdivide Effect command.
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Subdividing minimizes the number of keyframes you need to add and manipulate because, by 
default, each effect has a keyframe at the start and end of the effect. If you want to reposition Pan and 
Scan for an entire segment, you can select the segment and drag the Pan and Scan wire frame to a 
new position. If you need to adjust Pan and Scan within the segment, add keyframes to the effect.

n Subdivide the Pan and Scan effect only after you have finished editing your sequence and have 
selected your Pan and Scan aspect ratios and origin. For more information, see “Selecting the 
Source and Target Aspect Ratios for the Pan and Scan Effect” on page 223 and “Setting an Origin in 
the Pan and Scan Effect” on page 226.

To subdivide a Pan and Scan effect:

1. If Media Composer is not in Effect mode, enter Effect mode, for example, by clicking the Effect 
Mode button.

For more information, see “Entering Effect Mode” on page 32.

2. Move the position indicator to the Pan and Scan effect.

3. Click the Record Track buttons in the Track Selector panel for the video tracks to use as the 
subdivision guide.

Subdivide Effect divides Pan and Scan based on the segment boundaries of the selected tracks 
underneath the Pan and Scan track.

4. In the Actions parameter category, click Subdivide Effect.

Media Composer divides the Pan and Scan effect into multiple effects.

n Subdivide Effect works on the selected Pan and Scan effect, not on the entire track.

n Subdivide Effect does not subdivide segments connected by transition effects. For information on 
using Pan and Scan with transition effects, see “Combining the Pan and Scan Effect with Transition 
Effects” on page 229. 

Using the Wire Frame in the Pan and Scan Effect

The Pan and Scan wire frame in the Record monitor outlines the portion of media selected for output.

The wire frame functions similarly to the Picture-in-Picture wire frame. You can move the wire 
frame and define a motion path, and you can manipulate the wire frame in the following ways:

• Resize (scale) the wire frame by dragging its handles or by using the Scaling sliders.

Scaling lets you zoom in on your media. When you make the wire frame smaller, the image 
inside the wire frame is enlarged to fit the output monitor. Because making the wire frame very 
small results in a pixelated (grainy) image, you might not want to zoom in closely on an image 
that you plan to output directly to video.

• Reposition the wire frame by dragging it or by using the Position sliders.

You cannot drag the wire frame off the screen because in most circumstances you do not need to 
select empty space outside the boundaries of the source image. If you do need to position the 
edges of the wire frame beyond the screen’s limits, use the Position sliders in the Effect Editor.

You cannot change the shape of the wire frame, which is determined by the Target aspect ratio. 
Media Composer maintains the shape during scaling.

To scale the wire frame, do one of the following:

t Click one of the wire frame’s handles, and drag it to the position you want.
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t Click the triangular opener for the Scaling parameter category in the Effect Editor, and use the 
slider controls to adjust the wire frame’s height and width.

To position the wire frame, do one of the following:

t Click inside the wire frame, and drag it to a new position.

Movement is restricted to the most important axis. For example, if you go from a wide aspect 
ratio (16:9) to a narrow aspect ratio (4:3), you can drag the wire frame from side to side. If you 
go from 4:3 to 16:9, you can drag the wire frame up and down.

t Shift-click inside the wire frame, and drag it to a new position.

You can move the wireframe in all directions.

t In the Position parameter category, adjust the wire frame’s horizontal and vertical Position 
sliders.

Adjusting the Pan and Scan Effect

You might need to adjust Pan and Scan at different points throughout your sequence. The following 
are some suggestions for adjusting Pan and Scan.

If your sequence needs few adjustments:

1. Click the Play button or the Play Loop button.

Play (left) and Play Loop (right) buttons

2. If you see a problem with the panning, stop playback by doing one of the following:

t Click the Play button or the Play Loop button.

t Press the space bar.

3. Enter Effect mode, for example, by clicking the Effect Mode button. 

For more information, see “Entering Effect Mode” on page 32.

4. Adjust the Pan and Scan effect.

If your sequence needs many adjustments:

1. Enter Effect mode, for example, by clicking the Effect Mode button. 

For more information, see “Entering Effect Mode” on page 32.
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2. Use the Go To Next Edit and Go To Previous Edit buttons to step from one Pan and Scan effect to 
the next. 

Go To Next Edit (left) and Go To Previous Edit (right) buttons

The Go To Next Edit and Go To Previous Edit buttons appear on the Command palette. You can 
map the buttons from the Command palette to the keyboard or to another button. For more 
information, see “The Command Palette” in the Help.

3. Adjust the Pan and Scan effect.

Combining the Pan and Scan Effect with Transition Effects

When you subdivide the Pan and Scan effect, the subdivisions are based on the segment boundaries 
of the selected track. However, if some segments are connected by a transition effect, Pan and Scan 
treats these segments as one continuous segment and does not place a subdivision between them.

The following illustrations show this behavior for a typical sequence with transition effects. After 
subdividing, the three segments that are connected by transition effects have a single Pan and Scan 
effect above them.

You can set Pan and Scan parameters for the starting and ending keyframes of the entire segment 
string and insert additional keyframes wherever you need to fine-tune the panning. However, this 
approach works only if the panning does not vary among the segments in the string.

If panning needs to vary greatly from segment to segment, you might need to handle Pan and Scan on 
a segment-by-segment basis. To work on a segment-by-segment basis, you need to combine the Pan 
and Scan effect with the transition effects by placing the Pan and Scan effect on your video track.

To place Pan and Scan effects in the segments:

1. After subdividing the Pan and Scan effect, select the Pan and Scan effect above the segment 
string.

For more information, see “Subdividing the Pan and Scan Effect” on page 226.

2. Press the Delete key to remove the Pan and Scan effect.

3. Enter Effect mode, for example, by clicking the Effect Mode button. 

For more information, see “Entering Effect Mode” on page 32.

4. In the Effect Palette, click the Reformat category.

5. Drag the Pan and Scan Effect icon from the Effect Palette to the first segment in the segment 
string in the Timeline.

6. Repeat step 5 for each segment in the segment string.
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7. Adjust each Pan and Scan effect as needed.

Using Avid Pan & Zoom
The Avid Pan & Zoom effect provides capabilities similar to a motion control camera using high-
quality digital processing. You can move around a still image, with extensive keyframe control over 
the location and magnification of the field of view.

The Avid Pan & Zoom effect uses a downsized proxy image as its source while you are manipulating 
and previewing the effect, which provides excellent speed and response to your parameter and 
keyframe changes. When you render the effect, you can choose from a range of filtering options that 
provide exceptional finished image quality.

The Avid Pan & Zoom effect parameters let you control many aspects of your effect, such as how you 
view the image while you are working on it, what parts of the image the camera views, and how the 
camera moves over time.

The Avid Pan & Zoom effect supports any image file format for which your system has the 
appropriate QuickTime codec. You can download the latest version of QuickTime from the Apple® 
Web site.

Most images you use with Avid Pan & Zoom come from digital cameras, scanners, or third-party 
graphics applications such as Adobe Photoshop®. If the image comes from a video source, you might 
need to set parameters in the Advanced parameter category to enable the effect to compensate 
appropriately. For more information, see “Adjusting for Source Image Pixel Aspect Ratio and Color 
Levels in an Avid Pan & Zoom Effect” on page 238.

If you move an image file after you associate it with the effect, the image is no longer accessible to 
the effect. The next time you open the effect a dialog box opens asking you to locate the file.

Applying the Avid Pan & Zoom Effect

To apply the Avid Pan & Zoom effect:

1. Load a sequence and create a placeholder segment of the duration you want for your image.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

The footage you use in the placeholder segment is the footage the effect uses if you set the 
Background parameter to Video. For more information, see “Selecting the Background for an 
Avid Pan & Zoom Effect” on page 237.

n You cannot use filler in the placeholder segment.

2. Enter Effect mode, for example, by clicking the Effect Mode button. 

For more information, see “Entering Effect Mode” on page 32.

3. In the Effect Palette, click the Image category.

4. Click the Avid Pan & Zoom icon, and drag it to the placeholder segment you created in step 1.

The Avid Pan & Zoom parameters appear in the Effect Editor.
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Using Avid Pan & Zoom
5. In the Effect Editor, click the Other Options button.

A file selection dialog box opens.

6. Navigate to the file containing your image, and click OK.

Media Composer associates the image file with the effect, and superimposes the image on the 
placeholder segment. The image appears in the Effect Preview monitor.

n If you select a file that Media Composer does not recognize as an image file, Media Composer takes 
no action and no error message appears. For more information, see “Using Avid Pan & Zoom” on 
page 230.

The placeholder segment name does not change (the name of the image file does not appear in the 
segment).

7. Customize the Avid Pan & Zoom effect using the procedures described in the following topics.

Controlling Your View of an Avid Pan & Zoom Image

The Display parameter lets you select how you view the image while you work. You can view a 
scaled representation of the entire Source image while you draft the effect, or the result (Target) of 
your pan and zoom settings to preview the final look of the effect.

You can use the Show Action Safe option in the Display Options parameter category to provide a 
visual guideline for the viewable area on a standard television screen.
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To set the Display parameter:

t Click the Display Fast Menu button, and select Source or Target.

To set the Safe Action display in the Display Options parameter:

t Click the Show Action Safe button to turn the Safe Action area display on or off.

When Show Action Safe is on, the Safe Action area displays. When Show Action Safe is off, the 
Safe Action area does not display.

Adjusting the Field of View for an Avid Pan & Zoom Image

The field of view is the part of the source image that you select to create the final image. It is 
represented in the Effect Preview monitor by a gray rectangle superimposed on the source image. 
You can zoom in or out on the source image, and pan over it.

Field of view display for Avid Pan & Zoom effect: field of view rectangle (outer rectangle), Safe Action area (inner 
rectangle), and crosshair (center)

n If your final image will display on screens with limited viewing areas, you should turn on the Safe 
Action area display as a guideline while you work. For information on the Safe Action area, see 
“Controlling Your View of an Avid Pan & Zoom Image” on page 231.

Option Description

Source Shows you the entire image scaled to fit inside the Effect Preview monitor. Use 
this mode as you draft the effect. The pan and zoom settings appear as a 
rectangle superimposed over the image. The closer in you zoom, the smaller the 
rectangle appears.

Target Shows you the results of your pan and zoom settings. Use this mode for 
previewing your moves. A crosshair appears at the center of the image. If you 
use Target Display mode and one of the real-time filtering options, the image 
appears pixelated in the Effect Preview monitor. This does not affect the quality 
of the rendered image. For more information, see “Setting a Rendering Option 
for an Avid Pan & Zoom Effect” on page 236.
232



Using Avid Pan & Zoom
To zoom in or out on the Source image:

t Use the Zoom Factor slider in the Size parameter category.

Zoom Factor ranges from 0.1 to 20. At 0.1, the effect scales the image down to one-tenth the 
original. At 1, the effect applies no magnification to the image. At 20, the effect scales the image 
up 20 times the original size. The larger the Zoom Factor, the smaller the field of view rectangle 
appears when you use Source Display mode.

Example of zooming and panning in the Avid Pan & Zoom effect. In Source Display Mode (left) the field of view 
rectangle is reduced in size and isolates one part of the image. In Target Display Mode (right) you see the resulting 
magnified image.

n The Avid Pan & Zoom effect automatically preserves the clip’s aspect ratio. The Avid Pan & Zoom 
effect also uses any aspect ratio you select from the Clip menu.

To pan over the source image, do one of the following:

t Using either Source Display mode or Target Display mode, click the crosshair, and drag it to a 
new location.

t Use the X and Y Position parameters.

The Position parameters refer to the center of the field of view. A Position of 0, 0 centers the 
field of view over the center of the image.

You can use the click-and-drag method to easily create a rough path, and then refine it with the X 
and Y Position parameters.

Modifying Apparent Camera Speed for an Avid Pan & Zoom Effect

The Avid Pan & Zoom effect uses Velocity In and Velocity Out at each keyframe to modify apparent 
camera speed as it pans across the image between keyframes. It modifies changes in the Zoom Factor 
setting in the same way.

The Velocity parameters divide the time between keyframes in half. Velocity In controls the rate of 
movement in the first half. Velocity Out controls the rate of movement in the second half.

How the Velocity parameters control the rate of movement between keyframes. The first half of the time between the two 
middle keyframes is controlled by the Velocity In parameter, and the second half of the time is controlled by the Velocity 
Out parameter.
233



Using Avid Pan & Zoom
The following procedures describe:

•  The general method for setting the Velocity parameter.

•  A method for setting a simple ease in and ease out.

Ease in is the gradual acceleration at the beginning of movement. Ease out is the gradual 
deceleration at the end of movement. With the Avid Pan & Zoom effect, you typically want to 
create a simple ease in only on the first keyframe and an ease out only on the last keyframe. If 
you use Ease In and Ease Out for each keyframe, the pan and zoom movements bounce at each 
keyframe like a car repeatedly speeding up and slowing down.

• A method for setting a constant speed for an effect.

When you change the position of a keyframe, the time it takes the effect to move from that 
position to the position of the next keyframe also changes. This is usually the result you want, 
but if you want a constant speed across a number of key frames you can use this method. 
Alternatively, you can make the calculations manually and place the keyframes accordingly.

To set the Velocity parameter:

1. Click the keyframe indicator for the keyframe you want to adjust.

2. Click the In Fast Menu button, and then select a Velocity In option from the Fast menu.

For a description of all the Velocity options, see “Image: Avid Pan & Zoom” on page 465.

3. Click the Out Fast Menu button, and then select a Velocity Out option from the Fast menu.

4. Repeat steps 1 to 3 for any other keyframes you want to adjust.

To set up a simple ease in and ease out for an effect with multiple keyframes:

1. Click the first keyframe indicator to select it.

2. Set Velocity In to Ease In.

3. Set Velocity Out to Linear.

4. Click the next keyframe indicator to select it.

n For a quick way to jump to the next or previous keyframe indicator, use the Go to Next Event and Go 
to Previous Event buttons in the Effect Preview Monitor toolbar.

5. Set Velocity In and Velocity Out to Linear.

6. Repeat steps 4 and 5 for all keyframes except the last keyframe.

7. Click the last keyframe indicator to select it.

8. Set Velocity In to Linear.

9. Set Velocity Out to Ease Out.

To create a path with constant velocity:

1. Create an Avid Pan & Zoom effect. 

For more information, see “Applying the Avid Pan & Zoom Effect” on page 230.

2. Add keyframes to define the path you want the effect to take.

3. At each keyframe, set the Velocity In and Velocity Out parameters to Constant.
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When you use Constant for Velocity In and Velocity Out, the position at which you placed a 
keyframe in the Timeline is not necessarily the time at which the Avid Pan & Zoom effect 
applies the keyframe’s parameters. The effect applies the parameters at the time calculated by the 
effect to achieve a constant velocity for the path you created.

When you use the Constant option, your Path parameter selection can affect the result of changes 
you might make to the effect.

- If you select Linear for the Path parameter, moving keyframes or changing the Position 
parameters does not affect the velocity of the effect’s path.

- If you select Spline for the Path parameter, moving keyframes or changing the Position 
parameters might affect the velocity of the effect’s path.

For more information, see “Controlling Path Changes at Keyframes for an Avid Pan & Zoom 
Effect” on page 235.

4. Press the Play button or the Play Loop button to preview the effect.

Play (left) and Play Loop (right) buttons

The velocity of the path is constant.

Controlling Path Changes at Keyframes for an Avid Pan & Zoom Effect

The Path parameter controls how the Avid Pan & Zoom effect interpolates Position parameter 
changes at keyframes.

To set the Path parameter:

t Click the Path Fast Menu button, and select one of the following options from the Fast menu.

- Linear interpolation creates straight-line changes from one keyframe to the next.

Linear interpolation (abrupt changes of direction at each keyframe). The line represents the path of the effect 
over time while the numbers represent keyframes and indicate where the direction of the path changes.

- Spline interpolation smooths out changes at keyframes to create a more natural movement.
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Spline interpolation (gradual changes of direction at each keyframe). The line represents the path of the effect 
over time while the numbers represent keyframes and indicate where the direction of the path changes.

The Avid Pan & Zoom effect calculates a Spline path so that it is smooth through all points. 
If you move a point, the effect recalculates the entire path.

n If you combine a Spline path with Constant velocity, when you move a keyframe, the path 
recalculation might result in a change to the velocity of the effect.

Setting a Rendering Option for an Avid Pan & Zoom Effect

The rendering option you select for the Avid Pan & Zoom effect determines the quality of the 
rendered result. The various filtering options let you trade off the clarity or sharpness of the resized 
image and the speed at which the effect renders.

n The image quality of the effect in the final output depends in part on the output resolution for the 
sequence. You might lose some sharpness due to compression during the final output.

To select a rendering method:

t Click the Filtering Fast Menu button, and select a rendering option from the Fast menu.

For information on the available options, see “Rendering (Filtering) Options for Avid Pan & 
Zoom” on page 236.

To adjust animation smoothness in progressive projects:

t Click the Progressive button in the Render Mode parameter category.

When Progressive is on, progressive frames render more smoothly. When Progressive is off, 
progressive frames render less smoothly.

Rendering (Filtering) Options for Avid Pan & Zoom

The following table describes the options available in the Filtering parameter category for the Avid 
Pan & Zoom effect. The options are ranked from fastest render and lowest quality image to slowest 
render and highest quality image.

You might not always want the sharpest possible result. Images with many sharp edges might look 
better with a softer rendering. Many users find that B-Spline Catmull is the best compromise between 
image quality and rendering time.
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Selecting the Background for an Avid Pan & Zoom Effect

You can select a field of view from the original image that does not fill the entire screen. The 
Background parameter determines what appears outside the field of view.

n The Background parameter is not keyframeable.

To select the background:

1. Click the Background Fast Menu button, and select Color or Video.

2. (Option) If you select Color, use one of the following methods to set the background color:

t Manipulate the RGB sliders directly, or use the numeric keypad to enter values.

t Click the Other Options button to use the Windows Color dialog box or the Macintosh 
Colors panel.

t Click the Color Preview window, and use the eyedropper.

For more information, see “Adjusting a Color Parameter for an Effect” on page 74.

Option Description

Real Time Renders most quickly but results in a draft-quality image.

n Media Composer uses Real Time filtering during uncompressed play.

Triangle Results in fairly soft images.

Quadratic Results in slightly sharper images than Triangle filtering.

Cubic Results in sharper images than Quadratic filtering although they are still fairly 
soft.

B-Spline Catmull Lets you shrink an image (zoom out) by a large amount.

B-Spline Catmull produces a sharper image than Cubic filtering when you stay 
close to the original size of the image (very little zooming in or zooming out) or 
when you enlarge the image (zoom in) past the source image resolution.

Gaussian Results in an image that is relatively soft but sharper than B-Spline Catmull.

Avid Hi Qual Creates sharp images when you shrink the original (zoom out).

Avid Ultra Qual Creates extremely sharp images when you shrink the original (zoom out).

Option Description

Color Lets you select a background color.

Video Uses the video from the segment upon which you placed the 
Avid Pan & Zoom effect.
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Adjusting for Source Image Pixel Aspect Ratio and Color Levels in an 
Avid Pan & Zoom Effect

The Advanced parameter category provides controls to compensate for differences in pixel aspect 
ratio and in color levels between the source image and the video output.

Digital cameras and scanners, common sources for the Avid Pan & Zoom effect, use square pixels. 
Computer monitors and HD video formats also use square pixels. SD video formats, however, use 
non-square pixels.

Most images you use with the Avid Pan & Zoom effect use RGB color levels that range from 0 to 
255. In rare cases, you might use images from a video source with 601 color levels.

To compensate for pixel aspect ratio differences:

t Click the Source Has Square Pixels button in the Advanced parameter category.

When Source Has Square Pixels is on, the Avid Pan & Zoom effect makes the calculations 
necessary to produce results compatible with rectangular pixels. This is the default setting.

When Source Has Square Pixels is off, the Avid Pan & Zoom effect does not change the pixel 
shape but does apply the aspect ratio in effect for the project. This might be a good setting if your 
source image does not have square pixels, for example, if it comes from an SD video source.

To adjust for source image color levels:

t Click the Level Fast Menu button, and select an option from the Fast menu.

Managing Memory with the Avid Pan & Zoom Effect

The images you work with in Avid Pan & Zoom are often extremely large. The amount of memory 
used to store a large image can impact the performance of Media Composer. The Cache parameter 
gives you control over the amount of memory used to store your images for playback. A full 
resolution image is always used for rendering.

To control the amount of memory used to store images:

t Click the Cache Fast Menu button, and select an option from the Fast menu.

Option Description

Source has RGB Level For images with a black level of 0 and a white level of 255. The 
effect maps colors to video black and white levels, which are 16 
and 235 respectively. This is the default setting.

Source has 601 Levels Refers to the ITU-R-601 standard for video black and white levels. 
Select 601 if you use images from an SD video source. When you 
select 601 for the Level setting, the effect makes no adjustment to 
color levels.

Option Description

Video Resolution The effect stores a source image at a reduced pixel resolution that 
uses about 1 MB per image. Use Video Resolution if you have 
many images in your sequence and you need to limit how much 
memory they occupy.
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Image Resolution The effect stores a source image at its original resolution. The 
amount of memory used varies with the size of the image.

Multi-Resolution The effect stores several versions of the image: original image 
resolution, half resolution, quarter resolution, and so on, for eight 
versions of the image. The result is higher quality real-time preview 
and faster rendering. Multi-Resolution uses about twice the 
memory of Image Resolution.

Free Current Cache The effect frees all memory used for image storage and then reverts 
to Image Resolution. Use this setting to free up memory after you 
have rendered the clip.

Cache All Media Composer sets the same Cache parameter for all instances of 
the effect in a sequence.

Free All Caches Media Composer frees the caches for all instances of the plug-in in 
that sequence.

Option Description
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10 Motion Tracking and Stabilization

You can track the motion of a selected area in an image over time. You can then use the tracking data 
to control the motion of an effect such as a Picture-in-Picture or to stabilize an image to compensate 
for camera motion.

• Understanding Motion Tracking

• Workflow for Motion Tracking

• Effects and Effect Parameters That Use Tracking Data

• Understanding the Tracking Interface

• Opening The Tracking Window

• Tracking Window Components

• Setting Up an Effect for Tracking

• Preparing to Generate Tracking Data

• Generating Tracking Data

• Offset Tracking

• Understanding Tracking Data

• Customizing the Display of Tracking Data

• Setting the Reference Frame for a Tracker

• Understanding the SteadyGlide and Smoothing Options for Tracking

• Using SteadyGlide or Smoothing to Process Tracking Data

• Selecting, Deleting, and Moving Tracking Data Points

• Moving Tracker Data Points Outside the Frame Boundary

• Stretching a Range of Tracker Data Points

• Limiting the Effect of Position Tracking Data to a Single Axis

• Playing Effects That Use Tracking Data

• Understanding Stabilizing

• Stabilizing an Image

• Reviewing and Adjusting a Stabilized Image

• Guidelines for Using Multiple Trackers When Stabilizing

• Using the Region Stabilize Effect

• Making Adjustments to the Region Stabilize Region of Interest

• Editing Segments That Use Tracking Data

• Reusing Existing Tracking Data

• Copying and Pasting Tracking Data

• Examples of Effects Using Motion Tracking



Understanding Motion Tracking
Understanding Motion Tracking
This topic includes conceptual information that helps you to understand how tracking works and 
when you might want to use it.

Understanding the Tracking Process

Motion tracking searches for a distinctive pattern of pixels in each frame of a video segment. As the 
pattern moves over time, Media Composer records the movement as a series of points, one for each 
frame or field in the segment. For example, if a car is moving across a segment, you can track a 
distinctive pattern on the side of the car, such as the shape of its side mirror. The result is a set of 
tracking data points that represent the movement of the car over time.

Once you have a set of data points, you can associate them with an effect parameter to control how an 
effect moves. For example, if you need to hide the identity of the person driving the car in your 
segment, you can associate the tracking data with the Position parameter of a Blur effect. The 
tracking data then controls the movement of the Blur effect so that the blurred area remains over the 
person’s head throughout the segment.

Each set of data points is contained within a structure called a tracker. Depending on the kind of 
motion you need to track, you might need one, two, or more trackers. For simple two-dimensional 
movement, a single tracker is sufficient. If you need to track rotational movement or scaling 
information, you need two trackers so that Media Composer can calculate the position of one point in 
the image relative to a second point. For even more complex motion, such as that involved in corner 
pinning an image, you might need three or four distinct points to correctly track perspective or the 
angle at which the image is tilted.

Uses of Motion Tracking

One common use for motion tracking is to replace a moving area in one image with new material. 
For example, you can track the motion of a distinctive area on a vehicle and then use that data to 
replace an advertising sign on the vehicle or to replace or blur the license plate. In many cases, 
especially when the motion of the vehicle is complex, using tracking data to control the movement of 
the foreground replacement is much quicker than using keyframes to define the movement by hand. 
For an example of this use of motion tracking, see “Examples of Effects Using Motion Tracking” on 
page 279.

Sometimes a shot is designed from the outset with motion tracking in mind. A director might attach a 
target to the moving vehicle so that you can track it easily. You can create a replacement sign as a 
graphic and import it or shoot a replacement sign against a keying background. During editing, you 
use tracking data to control the movement of the replacement material in a Picture-in-Picture or a 
chroma key effect promoted to 3D Warp.

Another use for motion tracking is to create an effect in which a foreground object follows a 
background object but remains offset from it. For example, you might track the movement of a hand 
in a background clip and then use that tracking data to control the movement of a foreground object 
so that the object’s movement appears to be controlled by the moving hand.

When you stabilize an image, you use tracking information somewhat differently. By tracking an 
object that should be motionless — for example, part of a building — you collect information about 
the movement of the camera from one frame to the next. The Stabilize effect then applies the inverse 
of that movement to each frame in order to eliminate the camera motion. 
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Motion Tracking and Footage Characteristics

The motion tracking tools in Media Composer let you track movement in many kinds of footage 
successfully.

However, some footage will always be difficult or even impossible to track successfully. There might 
be no consistent pattern to track across multiple frames, or insufficient distinction between the 
pattern you want to track and the surrounding material. Typically, tracking requires a distinct edge in 
the target area, for example the edge of a moving vehicle against a background, or the edge of an 
advertising sign against the body of a vehicle.

n In some cases, you can temporarily apply a color correction or a Color Effect that you can use to 
make a pattern more distinct. For example, if a blue vehicle does not track well against a sky 
background that is a similar shade of blue, you could use a secondary color correction on the vehicle 
to change its color temporarily.

Workflow for Motion Tracking
The following workflow outlines the main stages of the motion tracking process and indicates where 
to find more detailed information and procedures for each stage.

Motion tracking provides considerable workflow flexibility. As you become a more experienced user 
of motion tracking, you can modify the order of these stages or merge them together to suit your 
editing style and the requirements of a particular project.

1. (Option) Before you begin working with the motion tracking tools, develop a general concept 
and design for the effect you want to create.

In some cases, you can design your shoot itself with tracking in mind, for example, by attaching 
a distinctive target to a moving object that you can later track and replace with an effect.

2. Set up the effect that you want to control using tracking information.

You access motion tracking from within an effect parameter for a specific effect, so you must set 
up the effect first. For more information, see “Setting Up an Effect for Tracking” on page 248.

3. Prepare to generate tracking data by creating trackers and customizing how Media Composer 
will conduct the tracking operation.

For more information, see “Preparing to Generate Tracking Data” on page 249.

4. Generate tracking data.

Depending on the complexity of the movement you want to track, you might need to track one, 
two, or more distinct points in the image. If you are not able to track one target area successfully 
throughout your segment, you might need to add and track one or more additional tracker 
regions.

For more information, see “Generating Tracking Data” on page 257 and “Performing Offset 
Tracking” on page 260.

5. If necessary, process or modify the tracking data.

For example, you might want to smooth the path of the tracking points, or adjust some of the 
points by hand. For more information, see “Using SteadyGlide or Smoothing to Process 
Tracking Data” on page 264 and “Selecting, Deleting, and Moving Tracking Data Points” on 
page 264.

6. Play back the effect.
242



Effects and Effect Parameters That Use Tracking Data
Media Composer calculates the motion of the effect by incorporating the tracking data and 
displays the result. For more information, see “Playing Effects That Use Tracking Data” on 
page 269.

7. If necessary, continue to adjust the tracking information or other effect parameters until you are 
satisfied with the look of the effect.

Effects and Effect Parameters That Use Tracking Data
You can enable tracking and use tracking data for most segment effects that can move over time, 
including Picture-in-Picture, keys, Intraframe™ effects, titles, and all 3D effects. In some cases, you 
must promote an effect to 3D to access tracking for the effect or to access the full range of tracking 
options.

Effect parameters that can use tracking data divide into two groups:

• The Position, Scaling, and Rotation parameters let you use tracking data to control the specific 
kinds of motion associated with each parameter. You can work with tracking enabled in any 
combination of these parameters at the same time. For example, you can work with tracking 
enabled in both the Position and the Scaling parameters to control both the position of an effect 
on the X and Y axes and the size of the effect.

• The Tracking parameter category provides a more flexible way to define and use tracking data by 
allowing you to enable up to four trackers. The Tracking parameter is the only parameter that lets 
you work with more than two trackers at one time and is therefore the only option for controlling 
complex motions that involve perspective changes or tilting of the effect.

You can also use the Tracking parameter with only one or two trackers enabled to control simpler 
motions such as position and scaling. This is the only option for such control in effects that do 
not have Position, Scaling, and Rotation parameters, such as Intraframe effects. This is also an 
alternative method for controlling simpler motions in effects that do have Position, Scaling, and 
Rotation parameters.

The two groups of parameters that use tracking data are mutually exclusive. When you enable the 
Tracking parameter, tracking is automatically disabled in the Position, Scaling, and Rotation 
parameters. When you enable tracking in the Position, Scaling, or Rotation parameters, the Tracking 
parameter is automatically disabled.

The following table provides a complete list of the effects and effect parameters that can use tracking 
data. For reference information on these effects and their parameters, see “Effects Reference” on 
page 451 and “Effects Parameter Reference” on page 491.

Effect Available Parameters

Picture-in-Picture (2D) Position, Scaling

Paint

AniMatte

Blur Effect

Mosaic Effect

Scratch Removal

Spot Color Correction 
(Media Composer | Symphony only)

Tracking
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Understanding the Tracking Interface
Tracking controls appear in three locations: the Effect Editor, the Effect Preview monitor, and the 
Tracking window.

Tracking Controls in the Effect Editor

The Effect Editor includes tracking controls within those effect parameter categories that can use 
tracking information. These controls let you enable tracking for the parameter and to define which 
trackers apply to that parameter.

The appearance of tracking controls in the Effect Editor varies depending on whether or not the effect 
uses advanced keyframes.

The following illustration shows the tracking controls for the Position parameter category in both 
standard keyframes and advanced keyframes.

Examples of tracker controls in an effect with standard keyframes (left), and in an effect with advanced keyframes (right)

For more information, see:

• “Effects and Effect Parameters That Use Tracking Data” on page 243

• “Enabling Tracking in the Effect Editor” on page 249

• “Creating and Mapping Trackers” on page 252

Tracking Controls in the Effect Preview Monitor

The Effect Preview monitor displays tracking controls that you can manipulate directly. The monitor 
displays the tracking boxes that you use to define the target area and the search area on the first frame 
or field of the region that you want to track. As tracking takes place, the monitor displays the 
generated data points for each frame or field. Once tracking data has been generated, you can display 
tracking data points and manipulate them in the monitor.

Stabilize Position, Scaling, Tracking

Matte Key effect (applied from Key category in the 
Effect Palette)

Position, Scaling

Imported Matte Key clip (2D) Position, Scaling

Titles (2D) Position, Scaling

3D Warp (including promoted Picture-in-Picture 
effects, keys, 3D Xpress shape effects, and titles)

Position, Rotation, Scaling, Tracking

Effect Available Parameters
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For more information, see:

• “Setting Up Tracking in the Effect Preview Monitor” on page 253

• “Understanding Tracking Data” on page 260

• “Customizing the Display of Tracking Data” on page 261

• “Selecting, Deleting, and Moving Tracking Data Points” on page 264

The following illustration shows a typical display of tracking boxes and data points.

Tracking Controls in the Tracking Window

The Tracking window has the following main features:

• An area containing controls for setting up and performing tracking, controlling the display of 
tracking data, and modifying tracking data

• A timeline representation of each tracker for the current effect

For more information, see:

• “Opening The Tracking Window” on page 246

• “Tracking Window Components” on page 246

The following illustration shows the Tracking window.
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Opening The Tracking Window
For more information on the features of the Tracking window, see “Tracking Window Components” 
on page 246.

To open the Tracking window, do one of the following in the Effect Editor:

t Enable tracking in an effect parameter for a tracker that is not currently mapped.

For more information, see “Creating and Mapping Trackers” on page 252.

t Click the Tracking Tool button.

You might need to resize the Effect Editor to see the Tracking Tool button in the column of 
buttons on the right side.

Tracking Window Components
The following table describes the components of the Tracking window and indicates where to find 
more detailed information.

Tracking Window Components

Control Description

Start Tracking Starts a tracking operation from the current location 
of the position indicator. For more information, see 
“Generating Tracking Data” on page 257.

New Tracker Creates a new tracker. For more information, see 
“Creating and Mapping Trackers” on page 252.

Go to Previous Region 
and Go to Next Region

Click one of these buttons to move to the previous or 
next region boundary in the tracker timelines. For 
more information, see “Using Tracker Regions” on 
page 259.

Tracking Engine Lets you choose the tracking engine that calculates 
the tracking data. For more information, see 
“Understanding Tracking Engines” on page 256.

Track Background/
Foreground

Lets you choose between tracking the background 
shot and tracking the foreground shot, (In the great 
majority of cases, you track the background shot.) 
For more information, see “Setting Up Tracking in 
the Tracking Window” on page 256.

Point Range Controls how many of the tracking data points 
appear in the Effect Preview monitor. For more 
information, see “Customizing the Display of 
Tracking Data” on page 261.

Display Controls the display in the Effect Preview monitor, 
allowing you to view either the tracking data or the 
results of the effect. For more information, see 
“Customizing the Display of Tracking Data” on 
page 261.
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Stretch Points Mode Lets you stretch data points. For more information, 
see “Stretching a Range of Tracker Data Points” on 
page 267.

Enable Tracker button 
(Tracker timeline 
displays)

When this button is active for a tracker, tracking 
boxes and tracking data points display in the Effect 
Preview monitor, and Media Composer generates 
tracking data for that tracker during a tracking 
operation. The button is purple when active and gray 
when inactive. For more information, see “Enabling, 
Disabling, and Deleting Trackers” on page 253.

Offset Tracking (Tracker 
timeline displays)

When this option is selected, the tracker uses offset 
tracking to calculate a continuous motion for the 
effect from multiple regions of tracking data. For 
more information, see “Offset Tracking” on 
page 258.

SteadyGlide (Tracker 
timeline displays)

When this option is selected, Media Composer 
processes the tracking data for the tracker to remove 
unwanted jittery motion while preserving underlying 
smooth movement such as a camera pan or zoom. 
The value in the Smoothing Value text box controls 
the extent of the processing. For more information, 
see “Using SteadyGlide or Smoothing to Process 
Tracking Data” on page 264.

Smoothing (Tracker 
timeline displays)

When this option is selected, Media Composer 
processes the tracking data for the tracker to smooth 
the path between selected points. The value in the 
Smoothing Value text box controls the amount of 
smoothing. For more information, see “Using 
SteadyGlide or Smoothing to Process Tracking 
Data” on page 264.

Smoothing Value 
(Tracker timeline 
displays)

Enter a value between 1 and 100 to control the 
amount of smoothing the SteadyGlide or Smoothing 
processes provide. The larger the value, the more 
smoothing occurs. For more information, see “Using 
SteadyGlide or Smoothing to Process Tracking 
Data” on page 264.

Tracker Color box 
(Tracker timeline 
displays, Effect Editor)

Shows the color the Effect Preview monitor uses to 
display information for this tracker and lets you 
change the tracker’s display color. For more 
information, see “Customizing the Display of 
Tracking Data” on page 261. 

Tracker Name text box 
(Tracker timeline 
displays, Effect Editor)

Shows the name of the tracker and lets you change 
the name. For more information, see “Creating and 
Mapping Trackers” on page 252.

Tracking Window Components(Continued)

Control Description
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Setting Up an Effect for Tracking
The first stage of the motion tracking workflow is to set up the effect to which you want to apply 
tracking data. To do this, you edit the necessary footage into a sequence, apply the effect, and, in 
most cases, make initial parameter adjustments to the effect.

Understanding Video Layers and Motion Tracking

Because motion tracking either controls an effect in relation to a moving area in a clip or controls the 
stabilization of a clip, you need one of the following situations for motion tracking to be useful:

• Two (or more) layers in the Timeline, where one contains the video you track and another 
contains the material to which you apply the effect (that material might be video, an imported 
graphic, or a title clip).

• A single video layer on which you draw one or more Intraframe objects. When you track 
movement in the video, you can use that tracking data to control the movement of the Intraframe 
objects.

• For stabilizing only, a single video layer that you intend to stabilize.

When you are working with two video layers, the material you intend to track typically is on the 
background layer and the effect is on the foreground layer. However, Media Composer can track 
either the foreground or the background layer, so you can place the material you want to track on top 
of the material that receives the effect if necessary.

Applying an Effect for Motion Tracking

You apply an effect for motion tracking in the same way that you apply any effect that either operates 
on a multilayer sequence or lets you draw a foreground object on top of a video layer. For more 
information, see “Applying Effects” on page 27.

Making Non-Tracking Parameter Adjustments to an Effect 

The final look of an effect that uses tracking is typically the result of combining the tracking data 
with standard effect parameter adjustments. You usually need to define the appearance of the effect in 
the first frame or field of the segment, and you might also need keyframe adjustments at other points 
in the segment.

Tracker timeline 
(Tracker timeline 
displays)

Shows information about the tracking data in the 
tracker. Color coding indicates the status of the data. 
For more information, see “Setting Up Tracking in 
the Effect Preview Monitor” on page 253 and 
“Understanding Tracking Data” on page 260.

Tracker Close button 
(Tracker timeline 
displays)

Closes the tracker and permanently deletes any 
information within it. For more information, see 
“Enabling, Disabling, and Deleting Trackers” on 
page 253.

Tracking Window Components(Continued)

Control Description
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Preparing to Generate Tracking Data
In most cases, you can choose whether to make these adjustments before or after you generate the 
tracking data. As long as the standard adjustments as well as the tracking data are in place when you 
play the effect, you see the final result of all the adjustment data.

For example, if you are replacing a sign on a moving vehicle, you use standard effect parameter 
adjustments to set the initial size, shape, and position of the sign. Depending on the complexity of the 
material, you might make these adjustments using basic parameters such as Position and Scaling, or 
you might place each corner independently using the Corner Pin parameter.

If you want the effect to be offset from the moving area that you plan to track, you establish the offset 
by adjusting the Position parameters. The final motion of the effect maintains that offset from the 
tracking data points as it moves. If you want the size of the effect to change in a manner that is not 
dependent on changes in the moving area, you can set up that change in size by using keyframes and 
the Scaling parameters.

When you work with Intraframe effects, you must draw the foreground object that you want to 
control with tracking information and select it with the Selection tool before you can generate 
tracking data. As with other effects, however, you can establish the precise size, shape, and position 
of the object either before or after generating tracking data.

n You can choose which frame in a tracked segment is the reference frame (the frame at which the 
tracking data makes no change to the look of the effect). For more information, see “Setting the 
Reference Frame for a Tracker” on page 262.

Preparing to Generate Tracking Data
The topics in this section cover procedures that you need to follow before you can generate tracking 
data. These procedures control how the system operates as it creates the tracking data.

Enabling Tracking in the Effect Editor

The first step in creating tracking data is to enable tracking for an effect parameter in the Effect 
Editor. Once you do this, other tracking controls become available.

The basic procedure for enabling tracking in an effect parameter is simple, but there are slight 
variations depending on:

• The parameter type

• Whether the effect is 2D or 3D

• Whether the effect uses standard keyframes or advanced keyframes

n For Intraframe effects, you can only enable trackers when an Intraframe object is selected.

To enable tracking for the Position, Rotation, or Scaling parameters in effects that use 
standard keyframes:

t Click the Use Tracking button.
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Preparing to Generate Tracking Data
Media Composer creates an appropriate number of trackers (one for Position, two for Rotation or 
Scaling) and maps them to the parameter.

To enable tracking for the Position or Scaling parameters in 2D effects that use advanced 
keyframes:

t Open the Position or Scaling category, and then click the enable button for the Tracking 
subcategory.

Media Composer creates an appropriate number of trackers (one for Position, two for Scaling) 
and maps them to the parameter. You must open the Tracking subcategory to see the list of 
mapped trackers and any additional controls.

To enable tracking for the Position, Rotation, or Scaling parameters in 3D Warp effects:

t Open the Position, Rotation, or Scaling category, and then click the enable button for the Position 
Tracking, Rotation Tracking, or Scale Tracking subcategory.

Media Composer creates an appropriate number of trackers (one for Position, two for Rotation or 
Scaling) and maps them to the parameter. You must open the Position Tracking, Rotation 
Tracking, or Scale Tracking subcategory to see the list of mapped trackers and any additional 
controls.

To enable tracking for the Tracking parameter in effects that use standard keyframes:

t Click one or more of the individual tracker enable buttons.

Media Composer creates and maps a tracker for each tracker enable button you click, and also 
enables the Tracking parameter category.

To enable tracking for the Tracking parameter in 2D effects that use advanced keyframes:

t Open the Tracking parameter category, and then click one or more of the individual tracker 
enable buttons.
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Preparing to Generate Tracking Data
Media Composer creates and maps a tracker for each tracker enable button you click, and also 
enables the Tracking category.

To enable tracking for the Tracking parameter in 3D Warp effects:

t Open the Corner Tracking parameter category, and then click one or more of the individual 
tracker enable buttons.

Media Composer creates and maps a tracker for each tracker enable button you click, and also 
enables the Corner Tracking category.

Once you enable tracking for a parameter, the Tracking window opens. For more information on the 
Tracking window, see “Tracking Window Components” on page 246.

When you first enable tracking for a parameter, Media Composer creates appropriate default trackers 
and maps them to the parameter, as described in the table. For more information, see “Creating and 
Mapping Trackers” on page 252.

Understanding Tracker Selectors and Tracker Function

Each parameter includes a number of tracker selectors appropriate to its function in controlling 
movement. When you enable tracking in a parameter, Media Composer looks for existing trackers 
and maps them to the parameter’s tracker selectors. If trackers do not yet exist, Media Composer 
creates them and then maps them to the parameter’s tracker selectors. In the Tracking parameter 
category, new trackers are created and mapped as you enable individual tracker selectors.

When you work in the Position, Scaling, and Rotation parameters, the number of trackers you can 
use is limited by the type of movement controlled by the parameter. For example, the Position 
parameter includes a single tracker selector since you need only one point to define movement in X 
and Y.

When you work in the Tracking parameter, you can use any number of trackers up to a total of four. 
The following table describes the kinds of motion that you can control with a given number of 
trackers.

Number of 
Trackers Description

One Controls position on the X and Y axes only. Use one tracker if you want your effect to move in 
only two dimensions on the plane of the screen.
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Preparing to Generate Tracking Data
Creating and Mapping Trackers

Media Composer automatically creates and maps trackers when you first enable tracking for an effect 
parameter. For most tracking work, you do not need to create additional trackers beyond those Media 
Composer creates automatically.

In some situations, you might want to create extra trackers. For example, you might want to track 
more than the minimum number of points necessary for a parameter so that you can experiment with 
different combinations of tracking points. You also might want to change the mapping of trackers so 
that an effect parameter uses a different tracker or combination of trackers from that originally 
created by Media Composer. For more information about the uses of different tracker combinations, 
see “Understanding Tracker Selectors and Tracker Function” on page 251.

You can use up to eight trackers for each effect.

To create a new tracker manually:

1. In the Tracking window, click the New Tracker button.

For more information, see “Opening The Tracking Window” on page 246.

A new tracker timeline display appears in the bottom area of the Tracking window. The tracker 
name uses the next letter of the alphabet that is not already in use, up to the letter D. If all of the 
letters A through D are in use, the name of any subsequent new trackers is “Untitled Tracker.”

2. (Option) If you want to rename the new tracker, click the Tracker Name text box, and type a new 
name.

The new tracker appears as an option in all the tracker selector Fast menus in the Effect Editor.

To map a tracker manually, do one of the following, depending on the interface style in the 
Effect Editor:

t Click the Fast Menu button for the appropriate tracker selector in the parameter, and then select 
the tracker you want.

t Click the tracker selector in the parameter, and then select the tracker you want.

Two Controls position, scaling, and rotation. Use two trackers if you want your effect to change size or 
rotate.

Three Controls position, scaling, rotation, and skew. Skew refers to a transformation that tilts or 
squashes an object along one axis while retaining its orientation along the other axis. This has the 
effect, for example, of transforming a rectangle into a parallelogram. Use three trackers if you 
want your effect to skew in this manner.

Four Controls position, scaling, rotation, skew, and perspective. Perspective refers to the way parallel 
lines appear to converge and changes depending on the angle from which an object is viewed. Use 
four trackers if you want to control perspective for your effect.

Number of 
Trackers Description
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Preparing to Generate Tracking Data
Enabling, Disabling, and Deleting Trackers

You can enable and disable trackers as necessary. Enabling and disabling a tracker has a different 
effect depending on whether you do it in the Tracking window or in the Effect Editor.

• When you enable or disable a tracker in the Tracking window, you control whether or not the 
tracker displays in the Effect Preview monitor and whether or not Media Composer generates 
tracking data for that tracker.

• When you enable or disable a tracker in the Effect Editor, you control which sets of tracking data 
Media Composer uses to control the effect. This lets you compare the look of an effect under the 
control of different tracker combinations.

You can also delete existing trackers. When you do so, you permanently erase that tracker and any 
tracking data associated with it.

To enable or disable a tracker in the Tracking window:

t Click the Enable Tracker button for the tracker in the tracker’s timeline.

To enable or disable all trackers at once:

t Alt+click (Windows) or Option+click (Macintosh) the Enable Tracker button for any tracker.

To enable or disable a tracker in the Effect Editor:

t Click the Enable button for the appropriate tracker selector.

n In the Tracking (or Corner Tracking) parameter category, clicking the Enable button that controls the 
whole parameter disables all the trackers at the same time but does not change the enable status or 
the mappings of the individual trackers. When you click the Enable button for the whole parameter 
again, the system reenables all the individual trackers.

To delete a tracker:

t In the Tracking window, click the Close button in the top right corner of the tracker’s timeline.

Setting Up Tracking in the Effect Preview Monitor

You define the region of interest (the area of an image that each tracker tracks) and the larger area it 
searches within by making direct adjustments to the tracking box display in the Effect Preview 
monitor.

Each tracking box display includes three elements: 

• An inner rectangle used to define the target area

• An outer rectangle used to define the search area

• A data point locator, which appears at the center of the rectangles

Each rectangle has a corner adjustment handle.

The following illustration shows the tracking box display.
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Preparing to Generate Tracking Data
n You can change the color of the tracking boxes display for a tracker. This might make it easier to see 
the display against the background image. For more information, see “Customizing the Display of 
Tracking Data” on page 261.

To display tracking boxes in the Effect Preview monitor:

1. If you have not already done so, enable, create, and map the trackers with which you want to 
work.

2. In the Display Tracking Data area of the Tracking window, ensure that Tracking Data is selected 
in the Display menu.

3. Make sure that the Enable Tracker button is active (purple) in the tracker timeline display of the 
Tracking window for each tracker that you want to display.

4. Make sure that you are monitoring the track in the Timeline that contains the material you want 
to track.

5. Move the position indicator to the first frame or field of the segment, or to the first frame or field 
of the tracker region.

A tracking box display appears in the Effect Preview monitor for each tracker. For more 
information on tracking regions, see “Performing Offset Tracking” on page 260.

To move a tracking box display in the monitor:

t Click anywhere within the boxes except the adjustment handles, and drag the boxes to a new 
position.

To resize a box in a tracking box display:

t Drag the adjustment handle for the box.

For more information on what to consider when making these adjustments, see “Guidelines for 
Positioning and Resizing Tracking Boxes” on page 255.

n If you enable multiple trackers, you might find it difficult to select one. You can disable some of the 
trackers temporarily in the Tracking window to simplify the display in the Effect Preview monitor and 
make it easier to select and manipulate a particular tracker.
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Preparing to Generate Tracking Data
Guidelines for Positioning and Resizing Tracking Boxes

Positioning

When you position tracking boxes, consider the following:

• Locate the boxes over material that Media Composer can track successfully.

• Locate the boxes so that the tracking data you generate accurately represents the movement you 
want to track.

Tracking works most successfully on an area of the image that is easily distinguishable from its 
surroundings. For example, a bright dot tracks extremely well if darker material surrounds it. You 
often need to scrub through the entire clip to determine which areas are good candidates for tracking.

To represent the movement you want to track accurately, you must consider the geometry of the 
motion that you want to achieve. For complex movement, such as controlling a replacement sign for 
a bus that is receding into the distance as well as moving across the screen, you must track enough 
points to represent the change in shape and size of the sign over time. Tracking two corners lets you 
control changes in scale and rotation (the corners should be diagonally opposite if scaling on the X 
axis differs from scaling on the Y axis). Adding third and fourth trackers fills in the other two corners 
as needed for more complex transformations.

You do not have to track points at the exact location where you want the finished effect to appear. 
You can track any set of points that represent the right movement. For example, you might want to 
add a small sign to the door of a moving car. Since the door panel is a uniform surface you cannot 
track areas on it. However, you can gather tracking data to control the positioning and scaling you 
need for the sign, for example, by tracking two or more of the corners of the car window.

Resizing

When you resize either of the tracking boxes, consider the following:

• Define material that Media Composer can track successfully

• Ensure that tracking proceeds successfully from frame to frame or from field to field throughout 
the range of frames or fields you are tracking

• Minimize the length of time Media Composer spends generating tracking data

The smaller you can make the boxes, the less image information the tracking engine has to search 
and the faster it can work. However, if you set the boxes too small, you increase the possibility that 
Media Composer will lose the search pattern between one frame or field and the next.

n You can also refine how Media Composer follows a target area by setting controls in the Tracking 
window. For more information, see “Setting Up Tracking in the Tracking Window” on page 256.

Size the Target Area box so that it is as small as possible while still enclosing a distinct area to track. 
The pattern needs to remain distinct throughout the range you are tracking.

Size the Search Area box so that it is as small as possible while remaining large enough to encompass 
the movement of the target area from one frame or field to the next. You often need to scrub through 
the clip you are tracking to check how much a prospective target area moves from one frame or field 
to another.
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Preparing to Generate Tracking Data
Setting Up Tracking in the Tracking Window

In addition to defining the search criteria for a tracker in the Effect Preview monitor, you can also set 
up the following aspects of tracking behavior in the Tracking window.

• Choose which tracking engine to use.

For more information on available tracking engines, see “Understanding Tracking Engines” on 
page 256.

• Choose whether the region to track is in the background or the foreground clip.

You can track either the background or foreground for a multilayer effect. You almost always 
want to track the background to define the movement of an effect or painted object layered above 
the background shot.

One situation in which you must choose Track Foreground is when you are stabilizing an image 
using a 3D Warp effect. For more information, see “Stabilizing an Image” on page 270.

The following illustration shows the area of the Tracking window that contains these controls.

To switch the tracking engine:

t In the Setup Tracking area of the Tracking window, select the tracking engine you want to use 
from the Tracking Engine menu.

To switch between background and foreground tracking:

t In the Setup Tracking area of the Tracking window, select the option you want to use from the 
Track Background/Foreground menu.

Understanding Tracking Engines

The term tracking engine refers to the calculation methods that Media Composer uses to recognize a 
moving pattern and generate data for it.

The following table describes the tracking engines available in Media Composer.

Tracking Engine Description

Correlation Tracker This tracking engine is often the best first choice for tracking motion in an image. It 
usually produces accurate tracking data when the target area is distinctive, and usually 
generates tracking data faster than the FluidTracker when the area being searched is 
small. If you need to search a larger area, the Correlation Tracker might become too 
slow to be useful, in which case you should switch to the FluidTracker.

This is the tracking engine that Avid DS uses.
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Generating Tracking Data
Generating Tracking Data
You can generate tracking data for any number of the available trackers in a single operation.

You can generate tracking data for the entire length of the segment, or for any part of the segment 
starting from the location of the position indicator. This lets you stop tracking at any point in the 
segment and resume later, or retrack over any part of the segment whenever you need to do so.

You can also create separate tracking regions for different parts of your segment, and define a 
different target area for each region. This is primarily useful for performing offset tracking. Once you 
create a region, you can move the position indicator to the start of that region and generate tracking 
data for the region. For more information, see “Offset Tracking” on page 258.

As Media Composer generates tracking data, it updates the tracker timeline displays to show the 
status of tracking data over time. For more information on the tracker timeline display, see 
“Understanding Tracking Data” on page 260.

To generate tracking data:

1. In the Tracking window, click the Enable Tracker button for each tracker you want Media 
Composer to track.

To enable all trackers at once, Alt+click (Windows) or Option+click (Macintosh) the Enable 
Tracker button for any tracker.

2. Move the position indicator to the location where you want to start generating tracking data.

This location can be at any point in the segment, but in most cases is either:

FluidTracker If you need to search a large part of your image, FluidTracker might produce good 
tracking data faster than the Correlation Tracker.

In the following two specific situations, FluidTracker usually produces more accurate 
data than the Correlation Tracker:

• When the points you want to track start outside the visible area of the frame.

• When you are using four trackers to control the corner-pinning of an image.

This tracking engine uses the same motion analysis methods that FluidMotion Timewarp 
uses.

FluidStabilizer This tracking engine is designed to track camera motion and is recommended for use 
with the Stabilize effect. It is often particularly effective for removing camera motion 
when used in combination with the SteadyGlide feature. For more information on 
SteadyGlide, see “Understanding the SteadyGlide and Smoothing Options for Tracking” 
on page 263.

FluidStabilizer divides the image into a grid, automatically selects a point of interest in 
each grid area, and then tracks each point using the same motion analysis methods that 
FluidMotion Timewarp uses. These points appear as highlighted green pixels in the 
image display.

FluidStabilizer then uses further calculations to combine the motion of these points, de-
emphasizing any values that are not consistent with the general pattern of motion. The 
result is a series of data points (displayed with the standard tracking data cross and dots) 
that, for many images, accurately represents the motion of the camera and is not 
distorted by other motion or noise in the image.

Tracking Engine Description
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Offset Tracking
- At the beginning of the segment.

- At the beginning of a region.

- At the location where you stopped generating tracking data and from where you want to 
resume tracking.

For information about moving to the beginning of a tracking region, see “Using Tracker 
Regions” on page 259.

3. Click the Tracking button.

Media Composer begins to generate tracking data.

As the tracking operation proceeds:

- The Effect Preview monitor displays each frame or field on which tracking is being 
performed, and shows the tracking data point for that frame or field as a cross.

- Media Composer updates the timeline for each tracker to indicate the status of the tracking 
data over time. If you are tracking where there is no existing tracking data, Media Composer 
replaces the red bar at the bottom of the line with a black bar at the top as data is generated, 
as shown in the following illustration. If you are retracking where tracking data already 
exists, you see no change in the tracker timeline, but the old tracking data is being replaced 
with new data.

n When you start tracking from the beginning of a tracking region, Media Composer steps back one 
frame from the region boundary before it starts tracking. This is normal behavior to ensure that 
motion at the region boundary is tracked correctly.

To stop a tracking operation, do one of the following:

t Press the space bar.

t Press Ctrl+period (Windows) or Command+period (Macintosh).

t Click any element of Media Composer’s interface.

The tracking operation stops.

Offset Tracking

You can use Media Composer’s offset tracking capabilities to create smooth effect motion from 
tracking data that you generate using more than one target area. This lets you track motion 
successfully when a single target area is not available for the full duration of a segment.

Understanding Offset Tracking

Motion tracking is simplest when you can track a single distinct area for the full length of a segment. 
For example, if the side of a moving bus is visible throughout the segment, you can select any area or 
set of areas on the side of the bus and track them throughout the segment.

Other situations are more complex. For example, if the bus is moving slowly and is also relatively 
close to the camera, you might find that an area you choose to track at the beginning of the segment 
moves out of the frame later in the segment. Or, the bus passes behind a foreground sign, again with 
the result that an area you choose to track at the beginning becomes hidden later in the segment.
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In these situations, you can use offset tracking to generate useful tracking data. Offset tracking lets 
you track one target area until it becomes unavailable because it leaves the frame or is hidden by 
another object, then track another target area that shows the same kind of motion as the first. Media 
Composer calculates the offset from the first set of tracking points to the second, and takes account of 
this offset when animating the final effect. The result is an effect that follows a continuous path.

If necessary, you can track more than just two targets. You can also track one target, switch to a 
second (for example, when the first becomes temporarily hidden), and then return to the first when it 
becomes visible again.

To track more than one target area in a segment, you add a new tracker region to a tracker timeline. 
You can then set a new target area in the first frame or field of the new region and track that target 
area.

Using Tracker Regions

You can add one or more new tracker regions to the tracker timeline and track a new target area for 
each of the regions.

In most cases, you use tracker regions with the offset tracking feature, so that your finished effect 
combines the tracking data from more than one target area into one continuous motion. For more 
information, see “Understanding Offset Tracking” on page 258.

When you have multiple regions in the tracker timelines, you can move between them by using the 
Go to Previous Region and Go to Next Region buttons.

To add a new tracker region for a tracker:

1. In the tracker’s timeline, move the position indicator to the location where you want the new 
region to start.

2. Right click in the tracker’s timeline, and select Add New Tracker Region.

Media Composer creates a new region that extends from the location of the position indicator to 
either the start of the next tracker region or the end of the timeline. The start of the new region 
appears as a vertical bar in the tracker timeline.

Tracker Region boundaries in a tracker timeline

To delete a tracker region for a tracker:

1. In the tracker’s timeline, move the position indicator to any location within the region.

2. Right-click in the tracker’s timeline, and select Delete Tracker Region.

Media Composer deletes the tracker region and any tracking data for it. The vertical boundary 
bar for the region disappears from the timeline. A red bar appears at the bottom of the tracker’s 
timeline for the duration of the old region, indicating that you must retrack these frames to get 
new tracking data, as shown in the following illustration.
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Understanding Tracking Data
To go to the beginning of the previous or next tracking region:

t Click the Go to Previous Region or Go to Next Region button.

Go To Previous Region (left) and Go To Next Region (right) buttons

Performing Offset Tracking

When you start tracking from the beginning of a tracking region, Media Composer steps backward 
one frame from the region boundary before it starts tracking. This is normal behavior to ensure that 
motion at the region boundary is tracked correctly.

To perform offset tracking:

1. Make sure that offset tracking is enabled for each tracker you plan to use.

Offset tracking is enabled by default. The Offset Tracking button is purple when offset tracking 
is enabled.

2. In the first frame or field of your segment, set up a tracker for your first target area, as described 
in “Preparing to Generate Tracking Data” on page 249.

3. Begin generating tracking data, as described in “Generating Tracking Data” on page 257.

4. When the target area disappears, stop tracking by pressing the space bar.

5. (Option) If necessary, step back a few frames or fields in the segment until the position indicator 
is on the last frame or field with a good tracking data point.

6. Right-click in the tracker timeline and select Add New Tracker Region.

A vertical bar appears in the tracker timeline to show the beginning of the new region, and the 
tracking boxes for the tracker appear in the Effect Preview monitor.

7. Drag the tracking boxes to the location of your second target area and size them as necessary.

8. Begin tracking from the start of the new region by clicking the Tracking button.

9. (Option) If necessary, repeat steps 3 through 7 for additional target areas (or to return to tracking 
the original target area when it becomes visible again).

Understanding Tracking Data
After you create tracking data, a set of tracking data points exists for each tracker enabled during the 
tracking operation. You can display these points in the Effect Preview monitor. You can also view 
information about the status of the tracking data in the tracker timeline display.

Tracking Data in the Effect Preview Monitor

Tracking data points display in the Effect Preview monitor.

While tracking is taking place, Media Composer shows the location of the current tracking data point 
as a cross.

Once tracking stops, Media Composer displays, by default, every point created during the tracking 
operation. The data point for the current frame or field displays as a flashing cross. All other data 
points display as solid dots.
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Customizing the Display of Tracking Data
You can control which sets of data points display and how many of the points display. You can also 
manipulate the points directly in the monitor in a variety of ways. For more information, see 
“Selecting, Deleting, and Moving Tracking Data Points” on page 264.

Tracking Data in the Tracker Timelines

The tracker timeline display shows you the status of tracking data over the length of the effect.

Example of the tracker timeline display. Left to right: Reference Frame Marker, starting Display Marker, vertical bar 
marking start of new region, and ending Display Marker.

The following table describes the display options.

Customizing the Display of Tracking Data
You can customize how Media Composer displays tracking data in the following ways:

• You can enable or disable display for each tracker.

• You can customize the color used to display each tracker.

• You can control how many of the tracking data points display.

• You can control whether the Effect Preview monitor shows tracking data or shows the results of 
applying the tracking data to the effect.

Color Description

Black Line at top 
of timeline

Tracking data exists for this part of the segment, and the data points for this part of the 
segment are not currently selected in the Effect Preview monitor. For more information, see 
“Generating Tracking Data” on page 257.

White Line at top 
of timeline

Tracking data exists for this part of the segment, and the data points for this part of the 
segment are currently selected in the Effect Preview monitor. For more information, see 
“Selecting, Deleting, and Moving Tracking Data Points” on page 264.

Red Line at bottom 
of timeline

Tracking data does not exist for this part of the segment.

Vertical Bar Marks the start of a new tracking region. For more information, see “Offset Tracking” on 
page 258.

Display Markers Define the beginning and end of a range of frames. When In to Out is selected in the Point 
Range menu, the Effect Preview monitor only shows tracking data points for this range of 
frames. For more information, see “Customizing the Display of Tracking Data” on 
page 261.

Reference Frame 
Marker

Marks the location of the reference frame — the frame at which the tracking data does not 
modify the effect. For more information, see “Setting the Reference Frame for a Tracker” 
on page 262.
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Setting the Reference Frame for a Tracker
To turn the tracking display on or off for a tracker:

t In the Tracking window, click the Enable Tracker button for the appropriate tracker.

The Enable Tracker button is purple when the display is on.

n Alt+click (Windows) or Option+click (Macintosh) the Tracking Box Display button for any tracker to 
turn the display on or off for all trackers at once.

To customize the display color for a tracker:

t Click the Tracker Color box, and then click the color you want to use.

To define the range of data points in the display:

1. (Option) If you want to define a range of frames for which you want data points to display, do 
one of the following:

t Drag the Display Markers in any one of the tracker timelines to define the beginning and end 
of the range you want.

t Use the position indicator in the tracker timelines along with the Mark IN and Mark OUT 
buttons to define the beginning and end of the range you want.

The Display Markers move to the beginning and end points you establish.

2. In the Display Tracking Data area of the Tracking window, click the Point Range menu, and then 
select an option.

To choose Tracking Data or Effect Results display:

t In the Display Tracking Data area of the Tracking window, select the option you want to use 
from the Display menu.

n The Display menu affects what you see in the Effect Preview monitor once tracking data is available 
and while you are parked on a frame or are stepping through the effect. The Display menu does not 
affect what you see in the Effect Preview monitor while tracking is taking place (when the current 
data point always shows as a cross). When you play an effect with tracking data, for example, by 
clicking the Play button in the Effect Preview monitor, you always see the results of the effect.

Setting the Reference Frame for a Tracker
The reference frame for a tracked segment is the frame at which the tracking data makes no change to 
the appearance of the effect. For example, for a Stabilize effect, the reference frame is the frame at 
which the tracking data causes no change in the position of the image. The location of the reference 
frame is marked on the tracker timeline by a red diamond.

Option Description

Current Displays the data point at the current location of the position indicator for each 
enabled tracker.

In to Out Displays the data points for the range currently defined by the Display 
Markers in the Tracking window for each enabled tracker. Shows the points 
for the current frame or field as flashing crosses.

All Displays every data point for each enabled tracker. This is the default option. 
Shows the points for the current frame or field as flashing crosses.
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Understanding the SteadyGlide and Smoothing Options for Tracking
By default, Media Composer considers the first frame of a tracked segment to be the reference frame. 
In every frame after the first, the effect is modified by the tracking data for that frame.

You can choose to set the reference frame to any other frame in the segment. This might be useful 
when trimming changes the location of the head frame for the segment, or in other circumstances 
where the position of the reference frame influences the final look of the effect. For example, if you 
set the reference frame for a Stabilize effect to the frame at the midpoint of the segment, the tracking 
data at that frame causes no change in the position of the image. In all earlier and all later frames, the 
effect is modified by the tracking data for that frame.

To set the reference frame for a tracker:

1. In the tracker timeline, move the position indicator to the frame you want to set as the reference 
frame.

2. Right-click the tracker timeline, and select Set Reference Frame.

The red diamond reference frame marker moves to the location of the position indicator.

Understanding the SteadyGlide and Smoothing 
Options for Tracking

Media Composer provides two options for processing tracking data to smooth the motion it 
represents. You can turn these options on or off at any time, and you can control the amount of 
smoothing they provide. The original set of tracking data points is not changed in any way by the 
processing. For information on using these options, see “Using SteadyGlide or Smoothing to Process 
Tracking Data” on page 264.

SteadyGlide

SteadyGlide™ processes tracking data to reduce abrupt, jittery movements without affecting 
underlying motion. SteadyGlide is particularly useful for stabilizing unwanted camera motion 
without eliminating desirable motion. You typically use SteadyGlide with the Stabilize effect, or with 
Stabilize Tracking turned on for an effect parameter in the 3D Warp effect. For example, you can use 
SteadyGlide to reduce any jittery motion in a pan shot with a hand-held camera while retaining the 
underlying motion of the pan itself. For more information on stabilizing, see “Stabilizing an Image” 
on page 270.

When you are using SteadyGlide, the display shows a graph of the jittery motions that Media 
Composer is removing. It is not easy to assess the final look of the effect from this information, so 
you should view the effect results to determine whether you need to adjust the smoothing value 
further.

Smoothing

Smoothing processes tracking data to smooth out the path between the tracking data points. The 
higher the Smoothing value you define, the smoother the path becomes. You typically use Smoothing 
when compositing an image or a paint object over a tracked region of a moving background, for 
example, when the motion of the tracked region is not completely smooth but you want the motion of 
the image or paint object to be smooth.
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Using SteadyGlide or Smoothing to Process Tracking Data
When you are using Smoothing, the display shows the smoothed curve that results from the 
processing, which gives a useful visual indication of the amount of smoothing Media Composer is 
applying. The following illustrations show typical results for Smoothing using different smoothing 
values.

Smoothing examples with the Smoothing Value set to 10 (left), 50 (center), and 90 (right)

Using SteadyGlide or Smoothing to Process Tracking 
Data

To use SteadyGlide or Smoothing:

1. In the tracker timeline, click the SteadyGlide button or the Smoothing button.

SteadyGlide (left) and Smoothing (right) buttons

The button is purple when the processing option is turned on.

n SteadyGlide and Smoothing are mutually exclusive processing operations. You cannot perform both 
SteadyGlide and Smoothing at the same time. If you turn on one, the other is automatically turned off 
if it was on previously.

2. In the Smoothing Value text box, type a smoothing value between 1 and 100.

The smoothing value controls the extent of the smoothing performed by both the SteadyGlide 
and the Smoothing options. The larger the value, the more smoothing is performed.

If you are displaying tracking data in the Effect Preview monitor, the display updates to show the 
results from the processing.

3. (Option) If necessary, check the effect results and adjust the smoothing value until you are 
satisfied with the results, or click the SteadyGlide or Smoothing button again to turn off the 
processing if you decide you do not want it.

Selecting, Deleting, and Moving Tracking Data Points
You can manipulate tracking data points in the Effect Preview monitor in the following ways that are 
described in this topic:

• You can find a specific data point

• You can select individual data points or ranges of data points.
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Selecting, Deleting, and Moving Tracking Data Points
• You can delete points.

• You can move one or more points.

You can also move points outside the limits of the frame to extend the movement of an effect 
smoothly out of the frame, or stretch a range of points. For more information, see “Moving Tracker 
Data Points Outside the Frame Boundary” on page 267 and “Stretching a Range of Tracker Data 
Points” on page 267.

Unlike SteadyGlide or Smoothing processing, these adjustments change the tracking data itself. You 
can only reverse them by using Media Composer’s Undo feature, or by retracking to generate a new 
set of tracking data points.

n If your tracking data points are very close together at normal magnification, you can use Media 
Composer’s standard methods to zoom in on your tracking data in the Effect Preview monitor and 
view it more clearly. For more information, see “Using the Effect Preview Monitor” on page 60.

To find a specific data point when multiple data points are displaying for a tracker:

t Move the position indicator to the frame or field for which you want to find the data point.

The data point for that frame or field flashes in the Effect Preview monitor.

To isolate the point further, you can select Current in the Point Range menu in the Tracking 
window, so that the point for the current frame or field is the only point that appears in the Effect 
Preview monitor.

To select a single data point:

t Click the point in the Effect Preview monitor.

The point is highlighted with a circle in the monitor and the corresponding part of the tracker 
timeline display changes to white.

To select a single data point and move to the frame or field for that point:

t Double-click the point in the Effect Preview monitor.

The point is highlighted with a circle in the monitor and with a flashing cross, the corresponding 
part of the tracker timeline display changes to white, and Media Composer automatically moves 
to the frame or field for that point.

To select a contiguous range of data points, do one of the following:

t Click the first data point in the range you want to select, and then Shift+click the last data point 
in the range.

t Drag the pointer across the range of data points that you want to select to lasso them.

The points in the range are highlighted with a circle and the corresponding part of the tracker 
timeline display changes to white.

The following illustration shows a range of selected data points.
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Selecting, Deleting, and Moving Tracking Data Points
To delete one or more selected data points:

t Press the Delete key.

Media Composer repositions the selected data points along a straight line between the two 
unselected points that bound the selected points. The data points remain fully functional. They 
display in the Effect Preview monitor at their newly calculated locations, and they remain 
available for you to modify further.

Selected points before deleting (left) and the result of deleting — points are repositioned in a straight line between 
the unselected bounding points

To move a single selected data point:

t Drag the point to a new location.

To move a range of selected data points:

t Drag any one of the points in the range to a new location.

All the data points move along with the one you drag and maintain their positions relative to one 
another, as shown in the following illustrations.

Before (left), during (center), and after (right) moving a selected range of data points. The points move as a group 
and maintain their positions with respect to one another.
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Moving Tracker Data Points Outside the Frame Boundary
Moving Tracker Data Points Outside the 
Frame Boundary

If you track a target area that moves out of the frame, the tracking engine can no longer track the 
target area and generates invalid data points. You have two options to ensure consistent motion if you 
want your effect to move smoothly out of the frame.

• You can use offset tracking to track a second target area that does not leave the frame until the 
end of the segment. For more information, see “Offset Tracking” on page 258.

• You can move the very last data point outside the boundary of the frame so that it extends the line 
of motion that has been successfully tracked earlier in the segment. (You need to reduce the 
magnification in the Effect Preview monitor to less than 100% to view the area outside the 
frame.) You can then delete all of the invalid points between that final point and the last valid 
data point.

Media Composer repositions the points you delete on a straight line. When the effect plays back, 
the repositioned data points ensure that the effect moves smoothly out of the frame. If the motion 
you are tracking is, for example, simple straight line movement, this might be quicker than 
setting up an extra tracking region.

Stretching a Range of Tracker Data Points
You can select a range of data points and then stretch them into a new position. In contrast to simply 
moving a range of points, the stretching process uses one moving point and one or two anchor points. 
As you move the moving point, all the other points in the selected range stretch to new relative 
positions.

This feature is useful for tracking data points that are slightly offset from the area you are tracking 
but otherwise represent the motion you are tracking accurately. For example, if you are tracking an 
area on a moving vehicle, changes in the image from frame to frame and in Media Composer’s 
updating of the target area might yield tracking data points that lag behind the area you are tracking.

The following illustration shows this behavior.

This illustration represents data points (dots) created by tracking an area (the rectangle containing the triangle) across a 
series of frames. For the first half of the process, the object is tracked accurately. During the second half of the process, 
a small amount of error is introduced, and by the end the data point lags behind the object somewhat. Stretching the 
points in the second half of the series so that the last point is positioned over the last triangle quickly creates a complete 
set of usable points.
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Limiting the Effect of Position Tracking Data to a Single Axis
You can select a range of points that are slightly out of the ideal position in this way and stretch them 
so that they more exactly represent the path of the object you want to follow. This provides the 
motion you need for your effect without retracking or moving many data points individually.

To stretch a range of data points:

1. Select the range of points as described in “Selecting, Deleting, and Moving Tracking 
Data Points” on page 264.

2. In the Modify Tracking Data area of the Tracking window, click Stretch Points Mode.

The button is purple when Stretch Points mode is turned on.

3. Drag one of the selected points to a new location.

Media Composer relocates the points proportionally along the path between the point you have 
moved and the anchor point or points. If you move a point at either end of the selected range, the 
point at the opposite end becomes the anchor. If you move a point in the middle of the range, the 
two end points become anchors.

The following illustrations show these two behaviors.

Stretching a range of points by moving one end. The point at the other end of the range becomes the anchor while 
you drag the moving point. After the stretching process, all the selected points are relocated proportionally between 
the point you have dragged and the anchor point.

Stretching a range of points by moving a point in the middle of the range. Both end points become anchors while 
you drag the moving point. After the stretching process, all the selected points are relocated proportionally between 
the point you have dragged and the two anchor points.

Limiting the Effect of Position Tracking Data to a Single 
Axis

You might want to track an area to generate data on its X, Y position but then control the movement 
of the effect on only one axis. You can limit the effect of Position tracking data to one axis to achieve 
this effect.
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Playing Effects That Use Tracking Data
n You can limit Position motion to a single axis when you want to stabilize a shot without eliminating 
camera motion in one direction, such as a pan. However, a more flexible approach to this problem for 
most shots is to use data from both axes and then use SteadyGlide to process the data. For more 
information, see “Stabilizing an Image” on page 270 and “Using SteadyGlide or Smoothing to 
Process Tracking Data” on page 264.

To limit the effect of Position tracking data to a single axis:

1. In the Effect Editor, open the Position parameter category and the Tracking subcategory.

2. Select either X Tracking Only or Y Tracking Only from the menu.

Playing Effects That Use Tracking Data
Once you have generated tracking data and have modified it to create acceptable sets of data points, 
you can play the effect to check its movement over time.

n Tracking data does not alter the real-time status of an effect. If an effect is normally real time, it 
remains real time when it uses tracking data. If an effect normally requires rendering, it continues to 
require rendering when it uses tracking data. Playback of an effect while still in Effect mode also 
follows the normal behavior of the effect.

To play an effect that uses tracking data:

1. Move the position indicator to the beginning of the effect.

2. Click the Play button.

3. (Option) If you are not satisfied with the appearance of the effect, you can do one or more of the 
following to further modify its movement:

t Adjust the effect’s keyframe parameters.

For more information, see “Working with Standard Keyframes” on page 119.

t Modify the existing tracking data.

For more information, see “Selecting, Deleting, and Moving Tracking Data Points” on 
page 264.

t Retrack all or part of the segment to generate new tracking data.

For more information, see “Generating Tracking Data” on page 257.
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Understanding Stabilizing
If you need to eliminate unwanted motion in a video clip, such as motion from an unstable camera, or 
even more subtle motion such as gate weave introduced during the telecine process, you can stabilize 
the clip.

Stabilizing lets you track an object in a shot that should not be in motion and then use the tracking 
data to keep that object stationary and remove the unwanted motion. Objects such as buildings, 
telephone or light poles, and fixed objects in nature such as rocks or trees, are good candidates for 
tracking when you are stabilizing and you need to select a target manually.

Unlike other effects that use motion tracking, stabilizing works with only one layer of video, using 
the tracking data to move each frame of the video enough to keep the tracked object stationary. 

You can also use stabilizing to create unusual special effects. For example, if you stabilize an object 
that is actually moving in a clip, you force other parts of the clip to move from frame to frame. You 
can take a clip of a person running down a street, stabilize on that person, and force the buildings in 
the shot into motion.

Media Composer provides three effects that have stabilizing capabilities:

• The Stabilize effect

The Stabilize effect is the most versatile option for stabilizing. Its AutoStabilize feature handles 
all aspects of tracking and stabilizing a single clip automatically when you apply the effect. If 
you don’t like the results of the automated process, you can adjust the effect’s parameters 
manually, or even generate new tracking data. For more information, see “Stabilizing an Image” 
on page 270.

• The Region Stabilize effect

The Region Stabilize effect does not work automatically, and has fewer controls than Stabilize. 
However, it provides the Progressive Source option, which lets you specify that the footage you 
are tracking is progressive material so that it is tracked correctly in an interlaced project.

• The 3D Warp effect

The 3D Warp effect does not work automatically, but it lets you have access to stabilizing and to 
all of the 3D Warp parameters in a single effect.

The tracking process exposes black around the edges of the frames, so a stabilized image typically 
requires resizing or repositioning to remove the exposed edges. Both the Stabilize effect and the 
Region Stabilize effect have options that can automatically remove exposed edges so that the 
stabilized image fills the frame.

n Clips that contain extreme camera motion might be hard to stabilize successfully because they must 
be resized substantially to remove exposed edges. As a result, you might lose so much of the image 
information that the clip is no longer useful.

Stabilizing an Image
This topic describes how to use the Stabilize effect or the 3D Warp effect to stabilize an image.
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Stabilizing an Image
The Stabilize effect uses AutoStabilize to track and stabilize an image automatically when you apply 
it to a single segment in the Timeline. AutoStabilize uses the tracking and effect parameter options 
that are most likely to result in a stable image. In many cases, you do not need either to interrupt the 
automatic process or to adjust effect parameters after it finishes. If you need to, you can adjust 
parameters after the automatic process, or even retrack.

AutoStabilize does not function when you apply the Stabilize effect to multiple selected segments in 
the Timeline. If you want to AutoStabilize multiple segments, apply the Stabilize effect to each 
segment individually.

AutoStabilize does not function when you use the Alt key modifier (Windows) or the Option key 
modifier (Macintosh) to nest an effect inside another effect, for example, by Alt-double-clicking in 
the Effect Palette or by Alt-dragging to the Timeline. If you want to AutoStabilize in a nest, step into 
the nest in the Timeline and apply the Stabilize effect directly to the nested layer. For more 
information, see “Nesting Effects” on page 209.

n The Region Stabilize effect is an alternative option for stabilizing a clip. For more information, see 
“Using the Region Stabilize Effect” on page 274.

To stabilize a segment automatically:

1. Apply the Stabilize effect from the Image category in the Effect Palette.

The AutoStabilize process begins and does the following:

- Opens the Effect Editor (if necessary) and the Tracking window.

- Creates a tracker and enables the tracker in the Position parameter for the effect.

- Tracks the image using the FluidStabilizer tracking engine.

- Processes the tracking data using the SteadyGlide option and applies the data to the image.

- Uses the Auto-Zoom option to adjust the Scaling and Position parameters, which removes 
black edges from around the frame.

When the AutoStabilize process ends, the image in the Effect Preview monitor shows the results 
of the effect.

You can stop the tracking process at any time by pressing the space bar or by clicking anywhere 
in Media Composer’s interface. This lets you set different tracking options, and then track and 
stabilize manually.

2. Review the stabilized effect and, if necessary, make parameter adjustments.

For more information, see “Reviewing and Adjusting a Stabilized Image” on page 273.

To stabilize a segment manually:

1. Do one of the following:

t Apply the Stabilize effect from the Image category in the Effect Palette, then stop the 
tracking process that starts automatically by pressing the space bar or by clicking anywhere 
in Media Composer’s interface.

t Apply the 3D Warp effect from the Blend category in the Effect Palette, or promote an effect 
that uses tracking data to 3D.

n You can promote the Stabilize effect to 3D, so you can stabilize an image using the Stabilize effect 
and then promote it to access additional effect functionality. When you promote the Stabilize effect to 
3D, Stabilize Tracking is automatically activated for all effect parameters that use tracking data. The 
Run Auto-Zoom option is not available after you promote the Stabilize effect to 3D.
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Stabilizing an Image
2. Enable one or more trackers.

If you plan to use the FluidStabilizer tracking engine, do one of the following:

t For the Stabilize effect, open the Position parameter category and click the Enable button for 
one tracker.

t For the 3D Warp effect, open the Position parameter category, then the Position Tracking 
subcategory, and then click the Stabilize Tracking button.

If you plan to use either the Correlation Tracker or the FluidTracker tracking engine, do one of 
the following:

t For the Stabilize effect, open the Position, Scaling, or Tracking parameter category and click 
the Enable button for one or more trackers.

t For the 3D Warp effect, open the Position Tracking, Rotation Tracking, Scaling Tracking, or 
Corner Tracking parameter categories, then click the Stabilize Tracking button, and then 
enable one or more trackers.

For specific information on the number of trackers to use when stabilizing, see “Understanding 
Tracker Selectors and Tracker Function” on page 251 and “Guidelines for Using Multiple 
Trackers When Stabilizing” on page 274.

The Tracking window opens.

3. In the Tracking window, choose a tracking engine from the Tracking Engine menu.

The easiest way to stabilize an image is to use the FluidStabilizer tracking engine, which does 
not require you to set up regions of interest. If FluidStabilizer does not provide you with good 
results, you can track using one of the other tracking engines. For more information on the 
tracking engines and how they work, see “Understanding Tracking Engines” on page 256.

4. If you are using the Correlation Tracker or the FluidTracker, set up each tracker for tracking by 
selecting the region of interest.

For more information, see “Preparing to Generate Tracking Data” on page 249.

5. (Option) If you are using the 3D Warp effect, in the Tracking window, choose Track Foreground 
from the Track Background/Foreground menu.

6. Click Start Tracking to generate the tracking data.

For information on how tracking information displays in the Tracking window and in the Effect 
Preview monitor, see “Understanding Tracking Engines” on page 256, “Generating Tracking 
Data” on page 257, and “Understanding Tracking Data” on page 260.

7. Review and adjust the effect, as described in “Reviewing and Adjusting a Stabilized Image” on 
page 273.
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Reviewing and Adjusting a Stabilized Image
After you stabilize an image, you typically need to review the results to determine whether the 
stabilized image looks good. You can also adjust the effect using one or more of the following 
options:

• SteadyGlide

This option often provides good results when you use it with FluidStabilizer tracking data, and is 
particularly useful if you want to remove jittery motion, such as that in a hand-held camera shot, 
while retaining underlying motion such as a pan. The AutoStabilize process uses SteadyGlide 
automatically. For more information, see “Understanding the SteadyGlide and Smoothing 
Options for Tracking” on page 263.

• Auto-Zoom

This option automatically adjusts the Position and Scaling parameters for the effect so that 
exposed black edges are removed and the stabilized image fills the frame. The AutoStabilize 
process uses Auto-Zoom automatically.

• Position and Scaling parameters

Although in most cases Auto-Zoom provides good positioning and scaling results, you might 
want to make manual adjustments to the Position and Scaling parameters.

For information on how to stabilize an image, see “Stabilizing an Image” on page 270.

To review the look of a stabilized effect:

t In the Effect Editor, click the Play Loop button.

The effect plays repeatedly to let you see how Media Composer repositions each frame or field in 
accordance with the tracking data.

To turn SteadyGlide processing on or off for the tracking data:

t In the Tracking window, click the SteadyGlide button for the tracker, and then type a smoothing 
value in the Smoothing Value text box.

For complete details on using SteadyGlide, see “Using SteadyGlide or Smoothing to Process 
Tracking Data” on page 264.

To use Auto-Zoom to remove exposed black edges on a stabilized effect:

t In the Tracking subcategory of the Position parameter category, click Auto-Zoom.

Media Composer processes the tracking information and generates values for the Position and 
Scaling parameters that reposition and enlarge the image enough to remove black edges. Any 
existing keyframes on the Position and Scaling parameters are removed.

If you retrack, turn SteadyGlide or Smoothing on or off, or change the smoothing values for 
SteadyGlide or Smoothing, Auto-Zoom recalculates Position and Scaling values so that black 
edges continue to be removed.

A warning message appears if no tracking data exists. A warning message also appears if the 
stabilized image moves too far offscreen to allow Auto-Zoom to calculate usable values.

To manually remove exposed black edges on a stabilized effect:

t In the Effect Editor, adjust the Position and Scaling parameter sliders until black edges are no 
longer visible in the effect.
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Guidelines for Using Multiple Trackers When Stabilizing
A message box appears, informing you that Auto-Zoom will be turned off. If you want to use the 
Auto-Zoom option again later, you must click Auto-Zoom.

Guidelines for Using Multiple Trackers When 
Stabilizing

The number of trackers that you need when stabilizing depends on the complexity of the motion you 
want to stabilize. However, multiple trackers might introduce unnecessary additional motion that is 
detrimental to the final look of the clip, so you should use them only when they are absolutely 
necessary.

When the motion of an unstable camera is limited to movement on the X and Y axes only, you need 
only one tracker (typically enabled in the Position parameter category). Even when you see a small 
amount of rotational movement or change in scale in an image you want to stabilize, a single point 
usually stabilizes the image well enough to give an acceptable result without introducing unwanted 
motion.

If you are stabilizing a clip that shows significant changes in scaling, rotational, or other movement, 
or if you are using the Stabilize effect to create a special effect, you might need to use two or even 
more tracking points.

Using the Region Stabilize Effect
The Region Stabilize effect provides an alternative option for stabilizing an image. The Region 
Stabilize effect provides fewer controls than the Stabilize effect or the Stabilize Tracking option in 
3D Warp, but its options might be all you need in some circumstances. Region Stabilize also provides 
the Progressive Source option, which lets you specify that the footage you are tracking is progressive 
material so that it is tracked correctly in an interlaced project.

To stabilize a clip with the Region Stabilize effect:

1. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

2. In the Effect Palette, click the Image category.

3. Drag the Region Stabilize Effect icon to the segment you want to stabilize.

4. Move the effect position bar to the segment with the Region Stabilize effect.

A wire frame appears in the Effect Preview monitor to indicate the region of interest. This is the 
area you want to use in stabilizing the image.
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Using the Region Stabilize Effect
5. Reposition and resize the wire frame by doing one of the following:

t Use the sliders in the Region of Interest parameter category.

t Click the wire frame, and drag it in the Effect Preview monitor.

Select a region that contains one or more features that do not change much from frame to frame, 
for example, objects such as buildings or rocks. Another approach is to shoot the scene with 
stabilization in mind: include an object, such as a reflective sticker, that you intend to use as your 
region of interest.

6. Click the Model Fast Menu button, and select the type of stabilization:

7. (Option) Turn on Auto Zoom:

a. Click the triangular opener for the Options parameter category.

b. Select Auto Zoom.

Stabilization exposes black around the edges of the repositioned frames. Auto Zoom 
compensates by resizing and, if necessary, repositioning the clip to remove the exposed edges.

8. (Option) Select Progressive Source:

a. Click the triangular opener for the Options parameter category.

b. Select Progressive Source.

Select Progressive Source if your footage was captured or converted to progressive footage (not 
interlaced). If your sources are progressive, selecting Progressive Source produces smoother 
results.

Option Description

Translational Keeps the region of interest steady along both the horizontal and the 
vertical axes.

Horizontal Constrains horizontal motion in the region of interest. Features in the 
region of interest can move vertically but not horizontally.

Vertical Constrains vertical motion in the region of interest. Features in the 
region of interest can move horizontally but not vertically.
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Making Adjustments to the Region Stabilize Region of Interest
n Progressive Source has no effect in 24p projects because Media Composer assumes that you are 
using progressive footage.

If you click the Progressive Source button and your underlying source is not progressive, you may see 
motion artifacts between fields in the rendered effect.

9. Render and review the effect.

If the rendered clip does not perform as expected, see “Making Adjustments to the Region 
Stabilize Region of Interest” on page 276.

10. (Option) Add keyframes to further refine the motion of the stabilized clip.

11. Continue to review and refine the effect until you achieve the results you want.

12. (Option) Resize and, if necessary, reposition the clip to eliminate black edges.

Making Adjustments to the Region Stabilize Region of 
Interest

If the Region Stabilize effect does not perform as expected, it might be due to one of the following:

• If an object in your region of interest moves too far away from the region from one frame to the 
next, the rendered clip might display unexpected results.

You can increase the size of the region of interest, or reposition it, to cover large movement.

• An object in your region of interest might move over the course of the clip in a way that 
unpredictably affects the stabilization.

You can decrease the size of the region of interest to eliminate extraneous motion that is affecting 
the stabilization.

• The region of interest might not have enough features to allow Region Stabilize to track it 
effectively.

You can select a new region of interest.

You can also add keyframes to reestablish or refine the region of interest over the course of the clip.

Editing Segments That Use Tracking Data
Once tracking data exists for a segment, you can edit that segment in a number of standard ways 
without losing the tracking data and having to retrack.

Segment Editing with Segments That Use Tracking Data

Tracking data persists during Segment editing. For example, if you shift the position of a segment 
that contains tracking data, or copy a segment to another point in your sequence, the data is still 
available. If you lift a portion of the segment out of your sequence, tracking data is preserved on all 
parts of the segment for the range of frames in each part.

However, if you move only the foreground layer of a multilayer effect, the tracking data remains 
useful only to the extent that it corresponds, or can be made to correspond, to the background layer at 
its new location. For example, if you shift an effect segment with tracking data a few frames with 
respect to the background material beneath it, you might be able to continue to use the tracking data 
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Reusing Existing Tracking Data
to follow the background area (perhaps by selecting all the points and moving them a little). If you 
shift the effect segment substantially, or even place it over a different background clip, the tracking 
data remains available but has no practical use.

n Sometimes it might be useful to create a multilayer effect with motion tracking as a nested effect. If 
you do this, you can move or divide the nested effect during segment editing and be sure that the 
effect will stay in sync with the tracked material. For more information, see “Nesting Effects” on 
page 209.

Trimming Segments That Use Tracking Data

If you trim in from the edges of a segment, tracking data is preserved for both the new length of the 
segment and for the material you have trimmed. If you later trim the edges of the segment back out, 
the tracking data is still available to control the motion of your effect.

If you trim out beyond the tracked data for an effect, you must track over the range of these new 
frames to generate data for them.

If you edit a segment into a sequence by marking it to be longer than you will finally need, you can 
track the whole segment, trim it in, and know that you can adjust the trims back out when fine-tuning 
your sequence without having to retrack. This might be a useful approach if you know that a clip is 
likely to be trimmed.

Adding Transition Effects to Tracked Segments

If you add a transition effect to a tracked segment, you usually need to track the additional frames 
that the transition requires. For example, if you add a standard one-second, centered-on-cut dissolve 
at the beginning of a tracked segment, the dissolve uses one-half-second of new material from the 
tracked segment’s master clip.

It might be difficult to track these additional frames after you apply the transition effect because the 
Effect Preview monitor displays the combination of outgoing and incoming media created by the 
transition effect. In the case of a dissolve, for example, the monitor shows the blend of outgoing and 
incoming frames, which often obscures the pattern you need to track.

You can avoid this problem by doing the following:

1. Trim the tracked segment out by the number of frames that the transition requires.

2. Track the frames added by this trim.

3. Trim the tracked segment back in to the original edit point.

4. Add the transition effect.

Reusing Existing Tracking Data
You can reuse tracking data within the same effect. You can also copy and paste tracking data to 
another effect, as described in “Copying and Pasting Tracking Data” on page 278.

Trackers that you initially create and map to one effect parameter are available for use in any other 
parameter in the effect that can use tracking data. For example, you might create a single tracker with 
the default Point A name in the Position parameter category. This tracker is available for use in other 
parameters such as Scaling.
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Copying and Pasting Tracking Data
n The Tracking parameter and the Position, Scaling, and Rotation parameter categories form two 
mutually exclusive groups. You cannot have tracking enabled in both groups at the same time. For 
more information, see “Effects and Effect Parameters That Use Tracking Data” on page 243.

You are less likely to find tracking information useful outside the effect for which you created it since 
the information refers specifically to the motion in one particular background clip. No other 
background clip is likely to contain exactly the same movement. However, there are some 
circumstances in which you might want to move tracking data to a new effect, such as the following 
two examples:

• You might want to move tracking data to an additional effect applied over the same background 
clip in the sequence. This might be a duplicate use of the background at another point in the 
sequence or an extra effect layered above the first (such as a second Picture-in-Picture effect tied 
to the same background movement).

• You might want to destabilize a stable shot so that it has a handheld look. To do this, you can 
track a segment that does have unsteady camera motion, and then copy the resulting tracking 
data to an effect on the segment you want to destabilize.

Copying and Pasting Tracking Data
You can copy one or more trackers and their associated tracking data and then paste those trackers 
into another effect. You can also copy one or more trackers and paste them within the same effect to 
create two versions of a tracker. This might be useful if you want to make two different sets of 
modifications to tracking data and then compare how each set changes the effect.

To copy and paste tracking data into another effect:

1. Enable the trackers you want to copy in the Tracking window.

2. Do one of the following:

t Select Edit > Copy.

t Press Ctrl+C (Windows) or Command+C (Macintosh).

3. Move the position indicator to the effect to which you want to copy the trackers.

4. Make sure that the Tracking window is active.

5. Do one of the following:

t Select Edit > Paste.

t Press Ctrl+V (Windows) or Command+V (Macintosh).

The trackers appear in the Tracking window below any existing trackers. For example, if you are 
pasting into an effect that has trackers T1 and T2, the pasted trackers are numbered T3 and T4.

6. (Option) If existing trackers in the effect have the same name or color as the trackers you paste, 
you might want to rename the trackers that have duplicate names or change their assigned colors 
to avoid confusion.

To copy and paste tracking data within the same effect:

1. Enable the trackers you want to copy in the Tracking window.

2. Do one of the following:

t Select Edit > Copy.

t Press Ctrl+C (Windows) or Command+C (Macintosh).
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3. Do one of the following:

t Select Edit > Paste.

t Press Ctrl+V (Windows) or Command+V (Macintosh).

Duplicate copies of the enabled trackers appear in the Tracking window with new tracker 
numbers.

4. Rename the duplicate copies and change their assigned colors so that you can continue to 
distinguish between the different versions.

Examples of Effects Using Motion Tracking
This topic includes two illustrated examples of typical uses of motion tracking to control effects. 
Studying these examples helps you to understand how you can use motion tracking in your own 
work.

n If you find it difficult to distinguish details in the printed versions of the following illustrations, you 
can view them in full color in the online (PDF) version of this guide.

Example 1: Replacing the License Plate on a Moving Vehicle

This example uses motion tracking to track the license plate on a truck and then replace the plate with 
an imported graphic.

The license plate in the footage is white and the surrounding areas of the truck are generally dark, so 
the exact corners of the license plate are good targets for the tracking operation. However, if tracking 
the exact corners of the plate is difficult, you can track other points on the back of the truck to achieve 
the same control over the changing size and shape of the replacement plate. For more information, 
see “Guidelines for Positioning and Resizing Tracking Boxes” on page 255.

All four corners of the license plate are tracked for this example to ensure that any skew and 
perspective changes are recorded by the tracking data. In fact, changes in perspective are relatively 
small in this clip because the plane of the back of the truck remains at almost exactly the same angle 
with respect to the plane of the screen. You might be able to achieve an acceptable finished look for 
this clip by using three trackers or even just two trackers on opposite corners of the license plate, 
especially since the replacement object is small.

The original materials for the example. On the left is the first frame of the video clip. The effect will replace the white 
license plate. On the right is the graphic for the replacement license plate. The graphic is blurred so that it will blend in 
with the clip. (You could do this in a graphics application or use Blur mode in the Paint Effect.) In the finished effect, a 
softened border is also applied to disguise the sharp edge of the graphic.
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Examples of Effects Using Motion Tracking
The location of the four tracking boxes at the four corners of the license plate (left), and the tracking data points 
generated for the four trackers. As the truck moves into the distance and the plate gets smaller, the points move closer 
together.

Images from the beginning, middle, and end of the original clip (top) and the finished effect. The replacement plate is 
positioned and sized manually in the first frame of the clip. The size and shape of the replacement changes under the 
control of the tracking data in the remaining frames of the clip.

Example 2: Special Effects Using Targets for Motion Tracking

This example uses special effects footage that has been specifically created to make use of motion 
tracking. White targets for tracking are part of the shot. After tracking these targets, you can use the 
tracking data to control the movement of an effect layer, for example, a keyed video image or an 
object created with the Paint Effect. In this example, the tracking data controls the movement of an 
object created with the Paint Effect.

The first frame of the clip. The original video (left) shows the target white dots on the wand. The finished effect (right) 
shows the image with the Paint object added.
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The tracking boxes located over the targets (left), and the generated tracking data points for the entire clip (right).

Images from the beginning, middle, and end of the original clip (top) and the finished effect (bottom) with the Paint object.
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11 Working with 3D Effects

This chapter describes procedures for creating and manipulating 3D effects.

• Understanding 3D Effects

• Applying the 3D Warp Effect

• Using Xpress 3D Effects

• Promoting 2D Effects to 3D Effects

• Using Matte Keys with 3D Effects

• Real-Time Playback of 3D Effects

• Understanding 3D Geometry and Degrees of Rotation

• Working with 3D Effects Parameters

• Manipulating 3D Effects Directly

• Applying 3D Effects: Examples

For reference information on 3D effects and their parameters, see “Effects Reference” on page 451 
and “Effects Parameter Reference” on page 491.

Understanding 3D Effects
Avid 3D effects feature a wide range of digital video effects, including the following:

• Image effects such as blur (defocus), corner pin, and resize with rotation and perspective

• Two-channel segment effects including smooth-motion picture-in-picture 

• Shapes, including page folds, balls, and slats

• Positioning, scaling, skewing, and rotation, with perspective

• Source cropping

• Internal borders including beveled and rounded edges

• Soft borders

• Trails and drop shadows with varying opacity

• Highlights and wipe generator

• Luma key and chroma key effects

You can create 3D effects in the following three ways:

• Apply the 3D Warp effect from the Blend category in the Effect Palette.

This option lets you create a 3D effect from scratch and have access to the full range of 3D effect 
parameters. For more information, see “Applying the 3D Warp Effect” on page 283.

• Apply one of the effects from the Xpress 3D Effect category in the Effect Palette.



Applying the 3D Warp Effect
For more information, see “Using Xpress 3D Effects” on page 283.

• Promote an existing 2D effect to 3D.

You can promote a wide variety of 2D effects to 3D, including titles and matte key effects. The 
reference information in “Effects Reference” on page 451 indicates which effects you can 
promote to 3D. For more information, see “Promoting 2D Effects to 3D Effects” on page 284 
and “Using Matte Keys with 3D Effects” on page 284.

Applying the 3D Warp Effect
All the 3D effects features are accessible through the 3D Warp effect in the Blend category.

For general information on adding effects to a sequence, see “Applying Effects” on page 27.

To apply the 3D Warp effect:

1. Create a sequence by using standard Avid editing procedures.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. Click the Blend category.

4. Drag the 3D Warp Effect icon to a transition or a segment in the Timeline. 

The 3D Warp Effect icon appears in the Timeline as shown in the following illustration.

5. In the Timeline, move the position indicator to the 3D Warp effect.

Using Xpress 3D Effects
The Effect Palette contains an Xpress 3D Effect category with four effects (3D Ball, 3D PIP, 3D Page 
Fold, and 3D Slats).

Xpress 3D effects provide a fast way to apply basic 3D effects to your sequence, without using the 
3D Warp effect to make custom adjustments. For example, the 3D Page Curl effect automatically 
creates a page curl effect when you apply it.
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Promoting 2D Effects to 3D Effects
n You can use the Shape menu in the Effect Editor to switch between the 3D shapes, but the name of the 
effect in the Effect Editor does not change when you change the shape. For example, when you are 
editing a 3D Ball effect, you can change the shape to 3D Slats. All of the 3D Slats parameters apply 
to the effect but the name of the effect in the Effect Editor continues to be 3D Ball. This limitation 
applies to all the effects in the Xpress 3D Effect category.

Promoting 2D Effects to 3D Effects
You can promote many 2D effects to 3D. For example, if you have a 2D Picture-in-Picture effect, you 
can promote the effect to 3D and add 3D features like 3D borders, drop shadow, page curls, smooth 
curve movement, and rotation.

n For information on creating a 2D Title effect, see “Creating Titles” on page 296.

For reference information on which 2D effects you can promote to 3D, see “Effects Reference” on 
page 451.

The following rules and restrictions apply to promoting effects to 3D:

• You cannot demote a 3D effect to a 2D effect (although you can immediately undo the promotion 
of a 2D effect to 3D if you decide that you do not want the 3D version).

• All effects that were real time in 2D are still real-time when you upgrade to 3D.

To promote a 2D effect or title to a 3D effect:

1. Enter Effect mode , for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

2. Click the effect icon in the sequence to select it.

3. In the Effect Editor, click the 3D Promote button.

Using Matte Keys with 3D Effects
A matte key is an effect made up of three components: 

• High-contrast image or matte (also called the key)

• Background image (the image that shows through the lightest part of the matte)

• Foreground image (the image that shows through the darkest part of the matte)

For more information on Matte Key clips, see “Creating a Matte Key Effect” on page 205.

You can promote real-time 2D Matte Key effects (graphics imported with alpha channel) to 3D Warp, 
and apply additional parameters, such as Shape Wipe effects, or X, Y, and Z positioning. You cannot 
promote matte keys created using the Matte Key effect from the 2D Effect Palette to a 3D matte key.

To create a matte key for use with 3D effects:

1. Import a graphic file containing an alpha channel. 

Media Composer creates a Matte Key clip when you import the file. In this example, the 
imported graphic is a title created in Adobe Photoshop.
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Real-Time Playback of 3D Effects
Graphic master clip with no alpha channel (top) and Matte Key Effect clip with alpha channel (bottom) in a bin

2. Edit the Matte Key clip into your sequence as an overlay.

2D imported Matte Key title edited into a sequence

Ensure Render On-the-Fly is enabled so you can see the matte key as you are working with it. 
When Render-On-the-Fly is enabled, it displays a check mark in the Composer menu.

3. Promote the Matte Key clip to a 3D Warp effect as explained in “Promoting 2D Effects to 3D 
Effects” on page 284.

4. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

5. Apply changes to additional parameters to achieve the effect you want.

Real-Time Playback of 3D Effects
In most circumstances, 3D effects play in real time, subject to the normal limitations on real-time 
playback described in “Real-Time Playback of Video Effects” on page 122.

However, in the following case, 3D effects cannot play in real time and appear in the Timeline with a 
blue dot:

• If you are working with HD media, the following 3D effects cannot play in real time:

- 3D Shape effects (Ball, Page Fold, Slats), whether applied from the Xpress 3D effect 
category or by selecting from the Shape parameter category in the 3D Warp effect.

- Titles promoted to 3D.

- Imported moving Matte Key effects promoted to 3D.

In addition, some parameter adjustments to a 3D effect prevent the effect from being processed using 
hardware acceleration. As a result, the effect cannot play in real time.

Understanding 3D Geometry and Degrees of Rotation
This topic provides basic information about 3D coordinate geometry and degrees of motion.

n Moving objects in 3D space requires an understanding of each of the 3D effects parameters and its 
correct order in the effects parameters hierarchy. For more information, see “Effects Parameter 
Reference” on page 491 and “Understanding 3D Parameter Hierarchy” on page 574.
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Understanding 3D Geometry and Degrees of Rotation
In the discussions of 3D effects in this document, the terms X, Y, and Z refer to the three axes or 
dimensions of the image that you can manipulate in the 3D effect’s coordinate space:

• X refers to the image’s left/right direction (values increase from left to right).

• Y refers to the image’s up/down direction (values increase from bottom to top).

• Z refers to the image’s front/back dimension (values increase from back to front).

The Shape and Rotation parameters let you rotate the image around the X, Y, and Z axes. Note that 
you can rotate more than 360 degrees (from –720 to 720 degrees) between keyframes. 

The following illustration shows how angles of rotation (in degrees) are distributed around a circle.

A positive number of degrees refers to a clockwise rotation; a negative number of degrees refers to a 
counterclockwise rotation. A rotation of +45o rotates the image clockwise by one-eighth of a full 
circle. Arotation of –45o rotates the image counterclockwise by one-eighth of a full circle.

The following illustration shows several rotation examples.
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Working with 3D Effects Parameters
Working with 3D Effects Parameters
You work with 3D effect parameters in much the same way that you work with 2D effect parameters. 
You access, manipulate, and reset 3D effect parameters in the Effect Editor in just the same way as 
2D effect parameters. You can save 3D effect adjustments as templates just as you can 2D effect 
adjustments. You can use the Enlarge and Reduce buttons to zoom in and out on the Effect Preview 
monitor just as you can with 2D effects. For more information, see “Entering Effect Mode” on 
page 32, “Using the Effect Editor” on page 68, and “Working with Effect Templates” on page 36.

You can also manipulate 3D effects directly in the Effect Preview monitor. For more information, see 
“Manipulating 3D Effects Directly” on page 287.

For specific information on each of the 3D parameters available in the Effect Editor, as well as 
important information on the hierarchy of 3D effects parameters, see “Effects Parameter Reference” 
on page 491 and “Understanding 3D Parameter Hierarchy” on page 574.

Manipulating 3D Effects Directly
You can perform a number of operations on an image by clicking buttons in the Effect Editor and 
dragging handles attached to the image in the Effect Preview monitor. This is similar to the 
procedures you use to directly manipulate 2D effects; some additional manipulations are possible, 
however, when working with 3D effects.

For more information on direct manipulation of 2D effects, see “Manipulating Effects Directly in the 
Effect Preview Monitor” on page 78.

Various 3D effect handle buttons appear along the right side of the Effect Editor. You determine the 
direction and type of manipulation performed in the Effect Preview monitor by selecting one of the 
image manipulation buttons in the Effect Editor.
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Applying 3D Effects: Examples
Use the Outline/Path button when you want to see the path a moving effect takes on the screen.

To manipulate a 3D effect handle in the Effect Preview monitor:

1. If Media Composer is not in Effect mode, enter Effect mode, for example, by clicking the Effect 
Mode button.

For more information, see “Entering Effect Mode” on page 32.

2. In the Effect Editor, click one of the image manipulation buttons to activate the specific handles.

3. Click the handles, and drag them to manipulate the image.

4. Click the image manipulation button a second time to turn off the handles.

The following illustrations show the handles for several image manipulation buttons.

Image manipulation handles. Top, left to right: Scale, Position, and Axis. Bottom, left to right: X, Y, and Z Rotation. 
When scaling, use the side handle to scale in X only, the top handle to scale in Y only, and the corner handle to 
scale in X and Y at the same time.

To see the path an image takes on the screen:

t Click the Outline/Path button.

Applying 3D Effects: Examples
The topics in this section provides examples of some basic 3D transition and segment effects, 
including the steps and values used to create them. You can use them to practice creating 3D effects, 
or to get ideas for building your own effects.

If you need more information while you are trying to complete the examples shown here, see the 
following sources:

• For basic information on effects editing, see “Basics of Effects Editing” on page 27.

• For information on the 3D interface and moving in 3D space, see “Understanding 3D Geometry 
and Degrees of Rotation” on page 285 and “Working with 3D Effects Parameters” on page 287.

• For reference information on all 3D effects parameters and controls, see “Effects Parameter 
Reference” on page 491.

• For basic information about editing a sequence, see “Creating and Editing Sequences” in the 
Help.

Crop Z Rotation XY Position

Scale X Rotation XZ Position
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In addition to re-creating the examples in this section, you can experiment with the default shape 
effects. For more information, see “Shape” on page 586.

n When you apply a shape effect, what you see in the Effect Preview monitor depends on where in the 
clip the position indicator is located. If the position indicator is at the start or end of the clip it might 
look as if the effect is missing.

Tips for Creating 3D Effects

The following tips apply to the examples in this section:

• Creating the sequence: Transition effects require only a two-clip sequence. Some of the segment 
effects require at least two tracks.

• Avoiding Insufficient Source errors: Several of these examples assume that you are creating a 
transition effect centered on the cut between the incoming and outgoing video. Leave enough 
material for the overlapping portions of the transition when you mark the source material.

If you receive an Insufficient Source message when you apply an effect to the transition, you did 
not leave enough source material behind for Media Composer to create the transition. For more 
information, see “Sizing Effects to Fit the Media” on page 31.

• Using the Swap Sources button: When you use the 3D Warp effect as a transition and click the 
effect for the first time, Media Composer applies the effect to the incoming video. To apply the 
effect to the outgoing video, click the Swap Sources button in the Foreground parameter 
category. Click anywhere in the effect’s Timeline to view the results.

Creating a Page Fold Transition

This example uses the Page Fold effect, which treats the foreground video channel as though it were 
a sheet of paper being folded over to reveal another page beneath. Page Fold supports one highlight 
along the top edge the fold and a second lowlight under the fold.
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Applying 3D Effects: Examples
Example of a Page Fold effect with highlight and lowlight: outgoing and incoming video sources (top) and stages of the 
effect (bottom)

To create the Page Fold effect:

1. Create a sequence, and apply the 3D Warp effect as described in “Applying the 3D Warp Effect” 
on page 283.

2. Open and enable the Shape parameter category, and select Page Fold from the menu.

The default Page Fold effect appears on the incoming video. To apply the effect to the outgoing 
video, swap the video sources by doing the following:

a. Open the Foreground parameter category, and click the Swap Sources button.

b. Click anywhere in the Effect Preview monitor’s position bar to see the effect on the outgoing 
video.

3. Open and enable the Highlight parameter category.

4. Use keyframes to animate the Curl parameter in the Shape parameter category.

Set a value of 0 (no curl) on a keyframe at the start of the effect and a value of 100 on a keyframe 
at the end of the effect. For more information, see “Working with Keyframes” on page 80. 

5. Click the Play button or the Play Loop button to preview the effect.
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Applying 3D Effects: Examples
Play (left) and Play Loop (right) buttons

6. (Option) Use the Transition parameters to adjust the length of the effect.

For more information, see “Applying a Dissolve Effect Using the Transition Parameters” on 
page 48.

Creating a Cropped Foreground Effect

This example shows how to adjust 3D Warp parameters and apply them repeatedly as a template to 
create a consistent band of foreground segments — scaled and cropped with a soft border shadow — 
across a background.

Example of a cropped foreground effect: top and bottom video tracks (top left), finished look of the effect (top right) and 
use of the effect when saved as a template and applied to several segments in the Timeline (bottom)

To create a foreground band of footage:

1. Build the sequence with the background footage on the bottom track and the foreground footage 
on the top track.

In this example, dissolves are added between a series of foreground segments.

2. Apply the 3D Warp effect to one segment of the top video track.

3. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

4. Click the segment to display the parameters in the Effect Editor.

5. Adjust the effect parameters as shown in the following table.

Parameter Category Parameter Settings

Crop T (top): 600, L (left): -999, B (bottom): -600, R (right): 999

Scaling Wid:110, Hgt: 100
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Applying 3D Effects: Examples
6. Save the parameters as a template by dragging the effect icon from the Effect Editor to a bin.

7. Apply the template from the bin to the remaining segments on the top track.

8. Click the Play button or the Play Loop button to preview the effect.

Play (left) and Play Loop (right) buttons

The foreground segments play through smoothly with the same scale, border, and cropping effect 
against the background.

Corner Pinning an Image

Corner pinning is a way of precisely positioning a foreground image over an image in the 
background video track, with matching perspective. You “pin” the foreground image onto the 
background image and adjust the corners to give the desired perspective.

This example shows the background and foreground videos used to create a segment transition using 
corner pinning. The segment starts with the foreground image “pinned” onto the video monitor in the 
scene. The image then moves off the TV and eventually fills the screen.

Example of a Corner Pin effect: background and foreground video (top), and stages of the effect (bottom). The 
foreground video starts pinned to the monitor screen in the background image, and moves off it until it fills the frame, 
completing the transition.

Position Enable (leave parameter defaults)

Border Select a dark color. For more information on color selection, see 
“Adjusting a Color Parameter for an Effect” on page 74.

Width: 40, Soft: 100, H (hue): 0, S (saturation): 0, L (luminance): 255

Parameter Category Parameter Settings
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To corner pin an image:

1. Create a segment with two video tracks, placing the foreground video on the top track.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Apply the 3D Warp effect to the top track.

3. If Media Composer is not in Effect mode, enter Effect mode, for example, by clicking the Effect 
Mode button.

For more information, see “Entering Effect Mode” on page 32.

4. Position, scale, and rotate your image if necessary.

For best results, adjust the Position, Scale, and Rotate parameters before you use Corner Pin. The 
center of the image for Corner Pin scale and rotation adjustments will be closer to the apparent 
center of the image, and you can get the results you want more easily.

5. Position the corners using one of the following methods:

t Use the Corner Pin button:

a. In the Effect Editor, click the Corner Pin button to activate the handles.

b. Click the handles, and drag to manipulate the image.

c. Click the Corner Pin button a second time to turn off the handles.

t Use the Quick Pin feature:

a. In the Effect Editor, click the Corner Pin button to activate the handles.

b. Press and hold the Ctrl and Alt keys (Windows), or the Command and Option keys 
(Macintosh), then position the pointer where you want the highlighted corner to be corner 
pinned, and click.

The next corner is highlighted.

c. Continue using the Ctrl and Alt keys (Windows), or the Command and Option keys 
(Macintosh), while clicking until the image is positioned where you want it.

The next corners continue to be highlighted in a clockwise rotation each time you click.

d. Click the Corner Pin button a second time to turn off the handles.

t Use the Corner Pin parameter category:

a. In the Effect Editor, click the Corner Pin button to activate the handles.

b. Use the X and Y sliders in the Corner Pin parameter category to position the image.

The Corner Pin parameter category has a button for each corner, letting you pin one corner at 
a time.

6. Click the Play button or the Play Loop button to review your edit.
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Play (left) and Play Loop (right) buttons

To return a corner to the default position:

1. In the Corner Pin parameter category, click the button for the corner you want to reset.

2. Alt+click (Windows) or Option+click (Macintosh) the Corner Pin Enable button.

Creating a Stamp

The Stamp category of the 3D Warp effect lets you make certain effects — such as titles and Matte 
Key effects — remain on screen while other effects come and go, even though the effect segment 
itself has ended. For example, you can stamp a product or channel logo onto the lower corner to act 
as a type of watermark effect without adding additional layers onto the sequence.

In the following example, two effects are applied sequentially on the top track. Each one has Stamp 
enabled on the last keyframe, which lets each element remain in place as the next element appears on 
the screen.

Both elements remain in place, and you could add additional stamps until you enable Clear to clear 
the Stamp buffer.

Example of a Stamp effect: the stamp element zooms into position from full screen (top left), is “stamped” in place at the 
end of the first segment (top center), and remains in place for the second segment (top right)

To create a stamp:

1. Create the image you want to use as a stamp.

For example, you can use the Title tool to create a title or you could import a PICT image.

2. Create a segment with at least two video tracks.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

If you want the stamp to be in the foreground, it must be on the top track.

3. Add the track with your stamp image to the segment.

4. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

5. Click the 3D Promote button to turn on the 3D parameters.

6. Create a keyframe at the point where you want the stamp to occur, and make sure the keyframe is 
selected.
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7. Open and enable the Stamp parameter category, and select Stamp Image.

8. (Option) Repeat steps 6 and 7 to enable Stamp on more than one keyframe.

9. Click the Play button or the Play Loop button to review your edit.

Play (left) and Play Loop (right) buttons

To clear a stamp:

1. Create a keyframe at the point where you want the stamp to be cleared, and ensure the keyframe 
is selected.

2. In the Stamp parameter category, click the Clear Image button.

Everything in the Stamp buffer is cleared.

Applying a Chroma Key Effect

You can use the options in the Foreground category of 3D Warp to apply a chroma key effect. You 
also have the option of using the SpectraMatte option for a chroma key that has higher quality and 
gives you greater control over the final look of the effect. For more information, see “Key: 
SpectraMatte Effect” on page 472.

To apply a Chroma Key effect:

1. Edit the foreground image onto track V2 and the background image onto track V1 in the 
Timeline.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

2. Apply the 3D Warp effect to track V2.

For more information, see “Applying the 3D Warp Effect” on page 283.

3. Open the Foregnd (foreground) parameter category, click the Fast Menu button, and select 
Chroma Key.

4. Click the Color Preview window, and press and hold the mouse.

5. When the eyedropper appears, drag it to the most representative area of color to be keyed and 
release the mouse.

n When selecting a color, stay away from corners of the frame or the area immediately around the 
foreground because these areas might contain subtle shades of gray.

When you are finished, Media Composer replaces the color with the video on track V1.

6. (Option) If Media Composer includes the 3D Spill Suppression parameter category, use Spill 
Suppression if necessary to remove spill in the foreground image.

7. (Option) Use the sliders in the Foregnd parameter category to make refining adjustments to 
improve the look of the key. 
295



12 Creating Titles

You can create titles in Media Composer using multiple title tools; the classic Avid Title tool, the 
Marquee® Title tool, Avid Titler+, or NewBlue® Titler Pro. Titles can incorporate text, graphic 
objects, imported graphics, and video. This chapter provides information on using the Title tools to 
create titles.

• Titler +- Title Tool that works within Media Composer that allows you to quickly create titles in 
all project types and rasters. 

• Title Tool Application - Title Tool Application. You cannot create titles in greater than HD 
projects using the Title Tool Application.

• Marquee - Separate Title Tool application. You cannot create titles in greater than HD projects 
using Marquee.

• NewBlue Titler Pro - Third party application that can be used for greater than HD projects. 
NewBlue Titler does not work from the clip menu. Either drop the NewBlue effect onto a clip or 
select the clip in the Timeline and right click to select Add/Edit Title.

• Opening the Title Tools

• Using Marquee

• Avid Titler+

• Overview of Title Creation in the Title Tool

• Installing Fonts for Use in the Title Tool

• Understanding the Title Tool

• Toolbar Reference for the Title Tool

• Using the Selection and Text Tools

• Understanding the Drawing Environment

• Setting Up the Drawing Environment

• Creating Text

• Sizing and Positioning Text Objects

• Editing a Text String

• Formatting Text

• Creating Graphic Objects

• Creating Rolling and Crawling Titles

• Modifying and Manipulating Title Objects

• Modifying Box Corners, Lines, and Borders on Title Objects

• Understanding Color and Transparency Controls in the Title Tool

• Selecting Colors and Setting Transparency

• Adding Shadows to Title Objects



Opening the Title Tools
• Adjusting Shadows on Title Objects

• Manipulating Title Objects

• Saving Titles

• Revising a Title in a Bin

• Creating and Using Title Templates

• Saving and Recalling Title Styles

• Exporting a Title as a Graphics File

Throughout this chapter:

• “Titler” refers to the Avid Titler tool that works within Media Composer as an effect.

•  “Title” refers to both text and graphics.

• “Title tool” refers to the classic Avid Title tool. 

• “Marquee” refers to the Marquee Title tool. 

Opening the Title Tools
You can open either the Title tool or Marquee, and you can bring the Title tool to the foreground if it 
is covered by another window, using standard menu commands.

To open one of the Title tools:

1. (Option) In the monitor window, move the position indicator to the video frame you want to use 
as a background.

If you are not using video as the background, you can ignore this step. For more information, see 
“Setting Up the Drawing Environment” on page 323.

2. Select Clip > New Title or Tools > Title Tool Application.

The New Title dialog box opens.

3. Do one of the following:

t To use Marquee, click Marquee.

Marquee opens. For information on Marquee, see “Using Marquee” on page 298.

t To use the Title tool, click Title Tool.

The Title tool opens. The Text tool is automatically selected, and the pointer becomes an I-
beam, ready for entering text.

If you know you want to create only Marquee titles or only standard titles for the current session, 
select Persist before you click Marquee or Title Tool. For the rest of your editing session, Media 
Composer automatically opens the title tool you selected.
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Using Marquee
You turn off automatic selection from the Settings list — open the Marquee Title Setting dialog 
box and click Ask Me.

To bring the Title tool to the foreground:

t Select Windows > Title Tool.

Using Marquee
Marquee is both an alternative tool for creating basic titles and a tool for creating much more 
sophisticated titles such as 3D and animated titles. Marquee opens from within Media Composer but 
has its own self-contained user interface, including its own Help system.

For information on opening Marquee, see “Opening the Title Tools” on page 297.

For information on creating titles with Marquee and on using Marquee in conjunction with Media 
Composer, see the Avid Marquee Title Tool User’s Guide or the Avid Marquee Title Tool Help. The 
“Creating Basic Titles for Media Composer” chapter provides a good starting point for basic work in 
Marquee.

n You can promote titles created using the classic Avid Title tool to Marquee titles. You cannot use the 
classic Avid title tool to edit titles that you promote to or create in Marquee.

Avid Titler+ 

Avid Titler+ is a Title Tool that works within Media Composer that allows you to quickly create titles 
in all project types and rasters. (In previous releases, if you were working with greater than HD 
projects, you had to use the NewBlue Titler Pro tool.) Avid Titler+ creates a Title effect in your 
sequence. You can create titles and then easily edit them in the Effect Editor. Just like an effect, titles 
can be saved back to the bin and re-used.

Creating a Title

You can easily create a title using Avid Titler+.

To create a Title:

1. Load your sequence in the Timeline.

2. Select the clip where you want to add a Title.

3. Click the Avid Titler+ icon in the Timeline.

The Avid Titler+ tool opens.
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Avid Titler+
4. Click in the monitor where you want to create the title and drag to create the Title box. Text (and 
objects) can be repositioned by simply dragging the outer frame. You can also double-click to 
select the word or triple click to select the entire line of text.

Type the text. When you resize the text box, the text will wrap appropriately.
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Avid Titler+
Changing the size of the text box wraps the text appropriately. 

5. Use the Avid Titler tool to format your title.

Avid Titler+ All-In-One Text Box

You can start typing with a standard title text box and turn it into a defined paragraph text box by 
simply resizing its bounding box while in Text mode. 

Note: The text bounding box changes visually depending upon which mode you are in.

• If you are in Text Mode and you begin typing, the text box is dotted white and keeps growing as 
you type. If needed, you can drag the handles of the text box and define an area in which the text 
will be wrapped (text box turns dotted red)

• If you are in Move Mode, the text box is solid white. When you drag the handles of the solid 
white box, the text scales accordingly.
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Avid Titler+
Text Mode

When in Text mode, you can type anywhere and create a text layer at that location. You can also 
return to an existing text layer to directly edit the text. Enter text mode by simply double-clicking in 
an empty area or by pressing T.

You can exit Text mode by simply:

• Pressing ESC key

• Clicking in an empty area

• Turning off text

• Selecting another mode

If you click in an empty area but you do not type anything, that empty layer gets deleted once exit 
text mode.

Move Mode

Move Mode allows you to change the position and attributes of your text without changing the text 
itself. Enter Move Mode by simply clicking anywhere on the title text. The bounding box appears 
around the text. Changing the properties (text color, shadow, etc.) when the bounding box is selected 
affects the entire text in the box.

n Double-clicking the title text allows you to enter Text Mode for quick text editing,

Formatting Text

The Font formatting tools in the Avid Titler+ tool control the appearance of text. Using the Font 
formatting tools allow you to select the font, the font size, leading, kerning, rotation, skew, bold, or 
italics options.

To change the font:

t Select the font pulldown menu and select a font.

To change the point size:

1. Select the text you want to change.

2. Click the size and enter a number to increase or decrease the point size.

To make text bold or italic or to underline the text:

1. Select the text you want to change.

2. Click to enable the (B) Bold, (I) Italics or (U) Underline button.
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Avid Titler+
To remove bold, italic or underline formatting:

t Click to deselect the applicable button.

To justify the text:

t Click the left text justification button to align text with the left side of the text object. 

t Click the center button to center the text. 

t Click the right button to align text with the right side of the text object. 

Justification buttons in the Avid Titler tool - below the font selection menu

To vertically justify the text:

t Click the top button to justify the text vertically to the top

t Click the center button to center the text between the top and bottom

t Click bottom button to justify the text vertically to the bottom 

Justification buttons in the Avid Titler+ tool - below the font selection menu

To write text vertically:

t In the Avid Titler+ Effect editor, set the Font to write from Top to Bottom.

To change the color of the text:

1. Click to select the text you want to change. 

2. Click the color text box.
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Avid Titler+
The Select Color dialog opens.

3. Choose a color and click OK.

The text will be updated to the selected color.

To adjust kerning:

1. Click to select the text where you want to adjust kerning. 

You can kern the text for an entire text object, or you can kern individual character pairs or 
character strings. Kerning improves the appearance of titles by controlling the amount of space 
between characters. You can expand or condense the character spacing to make text more 
readable or to create special effects, such as dramatically expanded spacing in a title.

2. Click the Kerning number and move the mouse to the left or right to increase or decrease the 
kerning value. Or double click the Kerning number and type the desired kerning value. 

To skew the text:

1. Click to select the text where you want to adjust skew.

Skew moves or tilts an image in the X or the Y direction. 

2. Click the Skew number and move the mouse to the left or right to increase or decrease the value. 
Or double click the Skew number and type the desired value.

To rotate the text:

1. Click to select the text you want to rotate. 

Rotation moves the text clockwise or counterclockwise.

2. Click the Rotation number and move the mouse to the left or right to increase or decrease the 
value. Or double click the Rotation number and type the desired value.

To preview the font in real-time:

1. Click to select the text you want to change. 

2. Move the mouse over the font list names to update the selected text with that font, making it 
easier to browse for a font selection.

3. Click to select the font, or click away to return to the original font.
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Avid Titler+
Opacity Control for Gradient Color

You can select the exact value for the Alpha Channel. Double-click the Face color option in the 
Titler+ toolbar.

The Select Color window opens.
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Avid Titler+
Color Picker (Windows)

Color Picker (macOS)

Here you can set the opacity value of the Alpha channel. 
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Avid Titler+
Scroll Bar for Rolls and Crawls 

A scroll bar for Rolls and Crawls allows for easier editing, viewing and manipulation of the title 
when in edit mode for Rolls and Crawls. 

Once the title effect is selected choose either Roll or Crawl in the drop down menu. Then select Edit 
Mode. Then you will see a scroll bar in the viewer (seen as an overlay). The scroll bar will be vertical 
or to the right of the viewer for Rolls. The scroll bar will be at the top of the viewer for the various 
crawls. This makes it much easier to edit rolling and crawling title effects.

Creating Graphic Objects

You use the drawing tools to create graphic objects such as squares, rectangles, circles, and ovals. 
After creating graphic objects, you can modify or manipulate them in a variety of ways. 

Graphics tools in the Avid Titler Tool

To draw a square or a rectangle:

1. Click the Square tool in the toolbar.

A square appears.

2. Drag a handle of the square to create the desired object. Dragging constrains the aspect ratio. 

Shift-drag to freely resize the object.

You can use the Shift + arrow keys to move the object in larger increments.
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To draw a circle or an oval:

1. Click the Oval tool in the toolbar.

A circle appears.

2. Drag a handle of the circle to create the desired object. Dragging constrains the aspect ratio. 

Shift-drag allows you to freely resize the object. 

You can use the Shift + arrow keys to move the object in larger increments.

Moving an Object or Text Forward or Backward

Once you create text and or graphics, you might want to bring one forward or send to the 
background.

For example, you might create text and then create a solid circle or rectangle object for the 
background of the text.

Bring Forward and Send to Back buttons

Example of Text brought Forward using the Bring Forward button

Select Previous and Select Next Layers

Once you create multiple layers of text and shapes, you can scroll through them by selecting the 
Select Previous Layer or Select Next Layer buttons. 

n When no layer is selected (by clicking in an empty area) pressing the spacebar will playback to allow 
you to preview the title over the shot.
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Choosing a Background for your Title

You can choose whether to display a color background or a frame of video from your sequence.

With a sequence in the Record monitor, the Avid Titler+ tool opens with a video background. The 
location of the position indicator in the Timeline at the time you open the Avid Titler+ determines the 
initial video frame that displays. If you want to select a solid background, simply click Background 
button and choose a color from the Color button.

Adding Shadows to Title Objects

You can add a shadow to any text or graphic object. 

To apply shadows to text or objects:

1. Select text or an object.

2. Click the Shadow button to add a shadow to the text or object.

3. With the object selected, adjust the shadow by doing one or more of the following:
308



Avid Titler+
t Click the Angle button, and use the mouse to move the shadow position.

t Click the Color button to open the Select Color dialog and choose a color for the shadow.

t Click the Dist number and move the mouse to the left or right to increase or decrease the 
value to move the depth of the shadow from the text or object. Or double click the Dist 
number and type the desired value. 

t To set a degree of softening, click the Softness number and move the mouse to the left or 
right to increase or decrease the softness. Or double click the Softness number and type in 
the desired value.

You can continue to make adjustments to the shadow until you achieve the effect you want.

Adding Outlines to Title Objects

You can add an edge or outline to any text or graphic object. 

To apply an edge to text or objects:

1. Select text or an object.

2. Click the Edge button to add an outline to the text or object.

3. With the object selected, adjust the outline by doing one or more of the following:

t Click the Color button to open the Select Color dialog and choose a color for the outline.

t Click the Size number and move the mouse to the left or right to increase or decrease the 
value to increase or decrease the size of the outline. Or double click the Size number and 
type the desired value. 

t To set a degree of softening, click the Softness number and move the mouse to the left or 
right to increase or decrease the softness. Or double click the Softness number and type in 
the desired value.

You can continue to make adjustments to the edges until you achieve the effect you want.

Rotating Text Boxes and Shapes

After creating a text box or a shape, you can use the Rotation Icon to rotate the box or shape. Simply 
hover over one of the bounding box corners and select the Rotation Icon to rotate the image. You can 
also hold down the Shift key while dragging to rotate the shape in increments of 15 degrees.
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Avid Titler+
Safe Title Shortcut in Avid Titler+ Toolbar 

You can access the Safe Title button in the Titler+ toolbar. 

Right-click this button to quickly access the Grid properties.

Load and Save Default Parameters

You can save and load default parameters. This allows you to save current properties (font, size, color 
etc.) as default for Avid Titler+. Creating a new title will use those properties.

Click on the Load Default Properties button to reload the properties.
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Avid Titler+
Displaying Avid Titler+ Titles in Frame Views

When your bin is in Script View or Frame View, Avid Titler+ title presets display a still of the first 
frame in the bin. The title is displayed over black.

n If you have a fade-in in the preset, no title is present to show. You will only see black.

Avid Titler+ Text in Clip Notes and EDLs 

An Avid Titler+ setting allows you to automatically populate the clip note on the Avid Titler+ 
segment in the Timeline with the Titler+ text. 

This provide an easy way to view, search and export Titler+ text in the Timeline. 

Avid Titler+ Presets

You can override T+ attributes while preserving text.
When a text layer is selected (in the viewer), you can ALT-Drag and drop an already saved T+ effect 
from a bin onto the effect icon in the effect editor. This will replace all the properties of the layer 
(colors, font, shadow etc) while preserving the text.
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Editing the Title in the Effect Editor

You can perform additional edits to your titles using the Effect Editor.

Place the cursor over the Title effect in your sequence and select Tools > Effect Editor to edit your 
title effect. 
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Parameter Description

Font Allows you to edit the title text.

• Font: Select the Font from the font pulldown menu. You can also select to set the text 
to write from Left to Right, Right to Left, Top to Bottom or Tom to Bottom Rotated.

• Size: Use the slide to increase or decrease the title text size.

• Leading: Leading controls the line spacing between lines of text in a title. Use the 
slider to increase or decrease the leading.

• Kerning: Kerning improves the appearance of titles by controlling the amount of space 
between characters. Use the slider to increase or decrease the text kerning.

• Rotation: Use the slider to move the text clockwise or counterclockwise.

• Skew: Use the slider to move or tilt the text in the X or the Y direction.

• Bold: Select to set the text bold.

• Italics: Select to italicize the text.

Face • Visible: When selected, allows you to see the color properties of the text or shape.

• Color Gradient: Allows you to set a color gradient for the selected text or shape.

• Hilite: Adds highlight to the gradient.

• Top Left Color (RGB), Top Right Color (RGB), Bottom Left Color (RGB), Bottom 
Right Color (RGB): Use the sliders to set the color for the applicable areas of the 
selected text or shape.

• Softness: Use the slider to increase or decrease the softness.

• Opacity: Use the slider to increase or decrease the opacity.

Underline Allows you to underline the selected text.

• Visible: When selected, displays the underline.

• Color Gradient: Allows you to set a color gradient for the underline.

• Hilite: Adds highlight to the gradient.

• Spaces: When selected, if the title includes multiple words, the underline appears for 
the space between words.

• Square/Round: Sets the underline square or rounded.

• (If Color Gradient is selected) Top Left Color (RGB), Top Right Color (RGB), Bottom 
Left Color (RGB), Bottom Right Color (RGB): Use the sliders to set the color gradient 
for the applicable areas of the underline.

• (If Color Gradient is not selected) Solid Color (RGB): Use the Red, Green, and Blue 
sliders to set the solid color of the underline.

• Softness: Use the slider to increase or decrease the softness of the underline.

• Opacity: Use the slider to increase or decrease the opacity of the underline.

• Width: Use the slider to increase or decrease the width of the underline.

• Height: Use the slider to increase or decrease the height of the underline.

• Horizontal Offset: Use the slider to move the underline left or right.

• Vertical Offset: Use the slider to move the underline up or down.
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Edge Allows you to add an edge to the text or shape.

• Visible: When selected, displays an edge around the text or shape.

• Color Gradient: Allows you to set a color gradient for the edge.

• Hilite: Adds highlight to the gradient.

• Filled, Outer, Inner, Border: Sets the properties of the edge.

• (If Color Gradient is selected) Top Left Color (RGB), Top Right Color (RGB), Bottom 
Left Color (RGB), Bottom Right Color (RGB): Use the sliders to set the color gradient 
for the applicable areas of the edge.

• (If Color Gradient is not selected) Solid Color (RGB): Use the Red, Green, and Blue 
sliders to set the solid color of the edge.

• Softness: Use the slider to increase or decrease the softness of the edge.

• Opacity: Use the slider to increase or decrease the opacity of the edge.

• Size: Use the slider to increase or decrease the size of the edge.

Shadow Allows you to add a shadow to the text or shape.

• Visible: When selected, displays a shadow to the text or shape.

• Color Gradient: Allows you to set a color gradient for the shadow.

• Hilite: Adds highlight to the gradient.

• Drop, Deep: Sets the style of the shadow. A deep shadow extends from the edges of 
the object, as though the object were three-dimensional. A drop shadow is offset from 
the object itself, as though cast by a light source. 

• (If Color Gradient is selected) Top Left Color (RGB), Top Right Color (RGB), Bottom 
Left Color (RGB), Bottom Right Color (RGB): Use the sliders to set the color gradient 
for the applicable areas of the shadow.

• (If Color Gradient is not selected) Solid Color (RGB): Use the Red, Green, and Blue 
sliders to set the solid color of the shadow.

• Softness: Use the slider to increase or decrease the softness of the shadow.

• Opacity: Use the slider to increase or decrease the opacity of the shadow.

• Angle: Use the slider to move the angle of the shadow.

• Distance: Used the slider to increase or decrease the distance between the shadow and 
the text or shape.

Parameter Description
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Frame Allows you to add a frame around the text or shape.

• Visible: When selected, displays a frame around the text or shape.

• Color Gradient: Allows you to set a color gradient for the frame.

• Hilite: Adds highlight to the gradient.

• Include Spaces: If selected, spaces between words will be framed. If deselected, 
spaces will not contain a frame.

• Square, Round: Sets the style of the corners of the frame. 

• (If Color Gradient is selected) Top Left Color (RGB), Top Right Color (RGB), Bottom 
Left Color (RGB), Bottom Right Color (RGB): Use the sliders to set the color gradient 
for the applicable areas of the frame.

• (If Color Gradient is not selected) Solid Color (RGB): Use the Red, Green, and Blue 
sliders to set the solid color of the frame.

• Softness: Use the slider to increase or decrease the softness of the frame.

• Opacity: Use the slider to increase or decrease the opacity of the frame.

• Height: Use the slider to increase or decrease the height of the frame.

• Horizontal Offset: Use the slider to move the frame left or right relative to the text.

• Vertical Offset: Use the slider to move the frame up or down relative to the text.

Background Allows you to switch between a video background and a color background.

• Visible: When selected, displays a background rather than the sequence video.

• Color Gradient: Allows you to set a color gradient for the background.

• Hilite: Adds highlight to the gradient.

• (If Color Gradient is selected) Top Left Color (RGB), Top Right Color (RGB), Bottom 
Left Color (RGB), Bottom Right Color (RGB): Use the sliders to set the color gradient 
for the applicable areas of the background.

• (If Color Gradient is not selected) Solid Color (RGB): Use the Red, Green, and Blue 
sliders to set the solid color of the background.

• Opacity: Use the slider to increase or decrease the opacity of the background.

Layer Allows you to add a text or shape layer.

• Add Text: Allows you to add a text layer.

• Add Rectangle: Adds a rectangle shape to the title.

• Add Ellipse: Adds an ellipse shape to the title.

• Order: Allows you to set the order of the layers. Choose from:

- Bring to Front, Send to Back, Bring Forward One Layer, Send Back One Layer

• Translate: Use the sliders to. change the position of the entire composition (text and 
shapes).

• Scale: Use the sliders to change the size of the entire composition (text and shapes).

• Rotation: Use the slider to rotate the layer clockwise or counterclockwise.

• Skew: Use the slider to move or tilt the layer in the X or the Y direction.

• Origin: Use the sliders to define the point of rotation for the entire composition.

Parameter Description
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Overview of Title Creation in the Title Tool
Overview of Title Creation in the Title Tool 

n The Title Tool application is not supported with greater than HD projects. For greater than HD 
projects, use Avid Titler+.

The following is an overview of the tasks you perform to create a title with the Title tool:

• Set up the drawing environment.

For example, you can choose whether to display a color background or a frame of video from 
your sequence. You can also use safe colors or safe title and action guidelines, or apply a grid for 
the placement of objects. For more information, see “Understanding the Drawing Environment” 
on page 321.

• Create a new title with the Title tool.

You create text and graphic objects, and then apply and adjust borders, colors, transparency, and 
shadows as necessary. For more information, start with “Creating Text” on page 324 and 
“Creating Graphic Objects” on page 329.

• Save the title and exit the Title tool.

When you save a new title, you select a resolution that is compatible with your project and a 
target drive for the title media. You can also save just the styles for the title for future use. When 
you close the Title tool, the new title appears in the bin and in the Source monitor, ready for 
editing. For more information, see “Saving Titles” on page 347 and “Editing with Titles” on 
page 355.

Edit Allows you to edit the title text:

• Select Layers: Allows you to select the next or previous layer.

• Select Text: Selects title text.

• Select Word: Selects an individual word in the text.

• Select Row: Selects the entire row of text.

• Clear All: Clears all text and shapes.

• Left Justify: Moves text left.

• Center Justify: Moves text to the center.

• Right Justify: Moves text to the right

Global Allows you to make change the opacity and crop the entire composition.

• Foreground Level: Use the slider to change the opacity of the entire composition.

• Crop: Use the top, bottom, left, right sliders to crop the entire composition.

Effect Allows you to set the title to either Crawl, CrawlPg Left, CrawlPg Right, or Roll

Parameter Description
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Installing Fonts for Use in the Title Tool
You can use any font that is installed on your system when you create titles in the Title tool. When 
installing and using fonts, consider the following:

• If you want to apply a special font that is not currently on the system, you must install the font 
first before creating titles. 

• If you are bringing a project from another system, ensure that you have installed any fonts used 
in titles contained in the project. The fonts must match exactly (you cannot use variations of the 
font in the same font family). If the Title tool does not recognize a font contained in a title, the 
Font Replacement dialog box opens to let you substitute an alternative font. 

• If you are bringing a project from the Macintosh platform to the Windows platform, or from the 
Windows platform to the Macintosh platform, you might need to substitute a font from the new 
platform for an existing font in the project. Windows and Macintosh fonts sometimes differ even 
when they have the same name. If the Title tool does not recognize a font contained in a title, the 
Font Replacement dialog box opens to let you substitute an alternative font.

• If you intend to create titles with font sizes of 128 points or larger, use TrueType® fonts. Some 
fonts cannot display consistently at sizes of 128 points or higher, but TrueType fonts can 
accommodate larger font sizes.2

n For more information on installing fonts, see your Windows or Macintosh system documentation.

Understanding the Title Tool
The following illustration shows a title over a video background.
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Understanding the Title Tool
Example of a title over a video background in the Title tool. The two dotted-line rectangles are the safe action area 
(outside) and safe title area (inside) guidelines.

The Title tool has the following major components:

• A video background based on a sequence or a color background that you create.

When your project uses the 16:9 aspect ratio, the Title tool uses the 16:9 aspect ratio also, and 
saved titles appear correctly in the monitors.

For more information, see “Understanding the Drawing Environment” on page 321 and “Setting 
Up the Drawing Environment” on page 323.

• The title or graphic in the foreground that you create.

• The safe title and safe action area guidelines.

For more information, see “Understanding the Drawing Environment” on page 321 and “Setting 
Up the Drawing Environment” on page 323.

• The toolbar at the bottom of the screen.

Topics throughout this chapter describe the use of these tools. For information on the two most 
widely-used tools, the Selection tool and the Text tool, see “Using the Selection and Text Tools” 
on page 320. For detailed reference information on all the tools in the toolbar, see “Toolbar 
Reference for the Title Tool” on page 319.

• In addition, title-related menu commands appear in the File, Edit, Object, and Alignment menus.

Topics throughout this chapter describe the use of these menu commands.
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Toolbar Reference for the Title Tool
The toolbar at the bottom of the Title tool contains tools and menus you can use to create and edit text 
and objects. They work much like similar tools in other drawing and paint programs.

For a general introduction to the layout of the whole Title tool, see “Understanding the Title Tool” on 
page 317.

Component Description

1 Selection tool Changes the pointer to an arrow and lets you select text or 
objects for operations. For more information, see “Using the 
Selection and Text Tools” on page 320.

2 Text tool Changes the pointer to an I-beam and lets you enter text. For 
more information, see “Using the Selection and Text Tools” 
on page 320 and “Creating Text” on page 324.

3 Video Placement tool Changes the pointer to a hand and lets you pan around the 
entire video clip within the Title tool. 

4 Drawing tools Let you draw boxes, circles, ovals, and lines. For more 
information, see “Creating Graphic Objects” on page 329.

5 Text formatting tools Let you set various text attributes such as font, font size, 
kerning, and leading. For more information, see “Formatting 
Text” on page 325.

6 Color Selection 
boxes

Let you change the color of text and objects. For more 
information, see “Selecting Colors and Setting Transparency” 
on page 340.

7 Transparency Level 
boxes

Let you change the transparency levels of text and objects. 
For more information, see “Selecting Colors and Setting 
Transparency” on page 340.

8 Color and 
Transparency Blend 
tools

Let you create a blend between two colors or two 
transparency values. For more information, see “Selecting 
Colors and Setting Transparency” on page 340.

9 Shadow tools Let you create drop shadows and depth shadows for text and 
objects and to preview the degree of softness set for shadows. 
For more information, see “Adding Shadows to Title Objects” 
on page 342.

1 2 3 4 5 6 7 8 9

10

11 12 13

14
15
319



Using the Selection and Text Tools
Using the Selection and Text Tools
The Selection tool and the Text tool are the tools you use most frequently in the Title tool. You use 
the Selection tool when selecting and adjusting whole objects in a title (whole pieces of text or 
graphic objects). You use the Text tool when you create or edit text content.

Selection tool (left) and Text tool (right) in the Title Tool toolbar

To select a single object:

t Click the Selection tool, and then click an object.

Selection handles appear around the object.

10 Styles button Displays examples of the styles you defined and lets you 
select one. For more information, see “Recalling a Title 
Style” on page 353.

10 Save Style Parameter 
button

Displays the Title Style sheet and lets you modify it and save 
the changes. For more information, see “Saving a Title Style” 
on page 351.

11 Line attribute tools Let you change the corners of boxes, line and border 
thickness, and arrowhead styles. For more information, see 
“Modifying Box Corners, Lines, and Borders on Title 
Objects” on page 336.

12 Templates button Lets you create a standard format for text and graphics that 
you use regularly. The template prevents you from changing 
the position, colors, shadows, or graphics, which ensures 
consistency. For more information, see “Creating and Using 
Title Templates” on page 350.

13 Background 
Selection tools

Let you switch between a video and an opaque background 
and change the color of opaque backgrounds. For more 
information, see “Setting Up the Drawing Environment” on 
page 323.

14 Crawling Title button Lets you create crawling titles. For more information, see 
“Creating Rolling and Crawling Titles” on page 330.

15 Rolling Title button Lets you create rolling titles. For more information, see 
“Creating Rolling and Crawling Titles” on page 330.

Component Description
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Understanding the Drawing Environment
To select multiple objects, do one of the following:

t Shift+click with the Selection tool.

t Click outside the objects, and drag to surround the objects with a lasso.

To use the Text tool:

t Click the Text tool, click anywhere within the text object, and begin typing.

An I-beam pointer indicates your position within the text. The Text tool remains selected until 
you select another tool.

n By default, the Text tool is active when you open the Title tool, and you can begin entering text as 
soon as you click in the Title tool.

To switch between the Selection tool and the Text tool:

t Press the Alt key (Windows) or Option key (Macintosh), and click anywhere in the Title tool.

To use the Selection tool temporarily when another tool is active:

t Press and hold the Ctrl and Alt keys (Windows), or the Ctrl and Option keys (Macintosh).

n After you use a tool in the toolbar, the Title tool reverts to the Selection tool, and the pointer becomes 
an arrow. To prevent a tool from automatically reverting to the Selection tool, double-click the tool’s 
icon.

Understanding the Drawing Environment
This topic describes aspects of the display of titles and their backgrounds in the Title tool, as well as 
the display of visual guides that can help you as you create titles. For information on how to control 
these display features, see “Setting Up the Drawing Environment” on page 323.

You can set or change these features at any time during your work on a title. These preferences are 
User settings, so they appear each time a particular user opens the Title tool.

Anti-Aliased Preview

Media Composer creates text and objects in titles anti-aliased with an 8-bit alpha channel. Anti-
aliasing ensures that text, lines, and object edges appear smooth, regardless of size. You can preview 
a title to see the title drawn with anti-aliasing, just as it will be saved. Media Composer always saves 
titles in anti-aliased format.

The display behavior for title objects when anti-aliased preview is on is as follows:

• You can alter the graphics characteristics of title objects (including colors, shadows, borders, and 
transparency) without losing the anti-aliased preview.

• You can select text objects and apply text styles from the Styles menu without losing the anti-
aliased preview.

• When you click a text object for editing, the Title tool displays the text without anti-aliasing. 
When you finish editing the text and click outside the object to deselect it, the Title tool restores 
the anti-aliased preview.
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Understanding the Drawing Environment
Safe Colors

If you plan to use your title for television broadcast, you can select the Safe Colors command from 
the Object menu. This command displays only low saturation colors for use in text, objects, and 
background. Colors with low saturation look best when combined with video. By default, Safe 
Colors is turned on.

Safe Title and Safe Action Guidelines

By default, the Title tool displays two outlined boxes to use as guidelines. The inner box is the safe 
title area. All text for television broadcast should remain within this inner box. The outer box is the 
safe action area for video display. These guidelines are self-adjusting for PAL and NTSC projects and 
for 4 x 3 or 16 x 9 display.

n You can customize the Effect Grid display. For more information, see “Understanding the Effect 
Grid” on page 64.

Alignment Grid

You can display an alignment grid to help you position text and objects. The visible grid is not part of 
the title, and Media Composer does not store it when you save the title.

The snap grid is an invisible grid that helps position and connect objects. The snap grid has four lines 
for each line in the visible grid. Each square in the grid is subdivided by four invisible vertical and 
horizontal grid lines. Text and objects can snap to these lines.

Title Backgrounds

You use the Video Background button to switch between a video background and an opaque color 
background, or to update the video background with the currently selected frame in the Timeline.

Background Color window (left) and Video Background button (right) in the Title Tool toolbar

If there is a sequence in the Record monitor, the Title tool opens with a video background. The 
location of the position indicator in the Timeline at the time you open the Title tool determines the 
initial video frame that displays. If there is no sequence in the Record monitor, the Title tool opens 
with no video showing (the background appears black).

The Video Background button is green when you are creating a title for display over a video 
background.

The background video frame is a reference that helps you position title objects relative to the video 
you plan to edit the title over. It does not become part of the title you create. You can edit the title 
anywhere else in the current sequence or in another sequence.

n When you create a title with a color background, it is opaque and you cannot key it over video. 

You cannot create rolling or crawling titles with a color background. You can create a separate color 
background as a title and then edit the rolling or crawling title over it in the sequence.
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Setting Up the Drawing Environment
Use the following procedures to set up the display of titles and their backgrounds in the Title tool, as 
well as the display of visual guides that can help you as you create titles. For more information, see 
“Understanding the Drawing Environment” on page 321.

To switch the display of anti-aliased titles on or off:

t Select Object > Preview. 

A check mark indicates that Preview mode is enabled.

To display only safe (low saturation) colors:

t Select Object > Safe Colors.

To turn the safe title area or safe action area guidelines on or off:

t Select Object > Safe Title Area/Global Grid.

To display a grid:

t Select Alignment > Show Alignment Grid.

To snap to a grid:

t Select Alignment > Align to Grid.

When you create or drag an object in the Title tool, the object snaps to the nearest grid line.

To update the video background:

1. Click the Video Background button in the toolbar to activate video background if you have not 
already done so.

2. Load the sequence into the Record monitor.

For information about editing a sequence, see “Creating and Editing Sequences” in the Help.

3. Move the position bar in the Timeline or in the monitor to display the new frame.

4. Click again in the Title tool to activate its window.

The background updates to reflect the current contents of the Record monitor.

To create a title that appears over an opaque color background:

1. (Option) Click the Video Background button to switch off the video background if it was 
previously turned on.

2. Click and hold on the Background Color (Bg) window.

The Title Tool Color Picker dialog box opens.

3. Use the Title Tool Color Picker dialog box, eyedropper, Windows Color dialog box, or 
Macintosh Colors panel to select a color.

 For a description of how to use these tools, see “Selecting Colors and Setting Transparency” on 
page 340.

The default background color is black.
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Creating Text
You create new text by using the Text tool. You can also copy and paste text into the Title tool 
directly from a word processing or text editing application.

In addition to static text objects, you can also create text objects in the Title tool that scroll vertically 
on the screen (rolling titles) or that crawl horizontally across the screen (crawling titles). For more 
information, see “Creating Rolling and Crawling Titles” on page 330.

c Media Composer limits the size of text objects you can create in the Title tool. Avoid pasting 
large blocks of text (numerous pages in a word processor) into the Title tool. Instead, consider 
pasting smaller blocks of text into separate text objects. For more information, see “Page Count 
Limits for Rolling and Crawling Titles” on page 331.

To create text:

1. Click the Text tool in the toolbar.

The pointer becomes an I-beam.

2. Click the position in the frame where you want to add text.

An insertion point appears.

3. Type the text. 

To insert a line return, press Enter (Windows) or Return (Macintosh).

n Text is word-wrapped automatically as you type. You can adjust the wrapping by changing the width 
of the text object. For more information, see “Sizing and Positioning Text Objects” on page 324.

4. When you finish typing, click the Selection tool in the toolbar to deselect the text object.

To copy and paste text into the Title tool:

1. In a word processor or text editor, open the text file and select the text.

2. Select Edit > Copy.

3. In the Title tool in Media Composer, click the Text tool in the toolbar.

The pointer becomes an I-beam.

4. Click the position in the frame where you want to add text.

An insertion point appears.

5. Select Edit > Paste.

The pasted text takes on the attributes currently set in the Title Tool toolbar.

Sizing and Positioning Text Objects
You can resize and reposition text objects by dragging directly in the Title tool. When you resize a 
text object, the text remains the same size but rewraps to fill the reshaped area.

When you create text that is aligned on the left side using left justification (the default), you can 
eliminate the unused space on the right side of the newly created text object, especially if you want to 
use the Alignment menu commands.
324



Editing a Text String
To resize a text object:

1. Click the Selection tool, and click the text object.

2. Click one of the object selection handles for width, and drag to resize.

n You can resize only the width of a text object. The height of a text object is automatically determined 
by the number of words and the size of text.

To eliminate unused space on the right side of a left-aligned text object:

t Click the middle selection handle on the right side of the text box, and drag it to the left until it is 
closer to the text.

To reposition a text object:

1. Click the Selection tool, and click the text object.

2. Move the text by doing one of the following:

t Click in the middle of the object, and drag it to a new position.

t Use the arrow keys to move the object one pixel at a time.

t Use commands in the Alignment menu to position the text.

For more information, see “Manipulating Title Objects” on page 344.

Editing a Text String
To edit an existing text string;

1. Click the Text tool, and click anywhere in the text. 

2. Perform any of the following tasks:

t Use the arrow keys to move around within the text string.

t Type additional characters.

t Press Enter (Windows) or Return (Macintosh) to insert a line return.

t Drag to select characters.

t Use the Cut, Copy, and Paste commands from the Edit menu.

t Use the Delete key.

t Change the formatting of the selected text, as described in “Formatting Text” on page 325.

Formatting Text
The text formatting tools control the appearance of text. You can click a text object with the Selection 
tool to format all the text within it, or you can use the Text tool to select a string of text within a text 
object to format individual characters or words. The following illustration shows the text formatting 
controls in the Title Tool toolbar.
325



Formatting Text
In addition to the text-specific formatting described in this section, you can modify or manipulate text 
objects in a variety of other ways. For more information, see “Modifying and Manipulating Title 
Objects” on page 335.

While you type text, only the text color is apparent. Shadows, outlines, and other color attributes 
appear when you finish typing the text and click the Selection tool.

n If you want to create text elements in the title with different appearances, create a separate text object 
for each set of attributes.

Setting Default Text Attributes

When you start Media Composer and open the Title tool, it uses default text attributes. You can 
change the defaults at any time. Changes you make to the default text attributes apply until you quit 
Media Composer.

To change the default text attributes:

1. Click the Selection tool.

2. Click in the Title tool but do not select any text.

3. Change any of the text attributes.

Whenever you start typing a new text string, the Title tool uses your new defaults.

Selecting a Font

The Font Selection button displays the name of the current font for a text selection and lets you 
change the font. When you first open the Title tool, the font listed is the preferred system font. 

Font Selection button in the Title Tool toolbar

To display all the fonts currently installed on the system:

t Click the Font Selection button.

To change the font:

t Click the Font Selection button, and select a font.

The Title tool displays the name in the Font Selection button and uses this font for text until you 
change it during the editing session.

n When you select a text object, the Font Selection button displays the name of the font in the text 
object.

Changing Point Size

The point size controls the size of the selected text. A point is a typographical unit of measure. There 
are 12 points to the pica and 72 points to the inch.

You can enter a point size either before or after you type text.
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Formatting Text
Point Size text box (left) and Point Size button (right) in Title Tool toolbar

To change the point size, do one of the following:

t Click the Point Size button, and select a standard point size from the menu.

t Double-click in the text box, type a point size between 5 and 999, and then press Enter 
(Windows) or Return (Macintosh).

t Click in the text box, and use the Up Arrow and Down Arrow keys to change the value 
incrementally.

Making Text Bold or Italic

The Bold and Italic buttons are located under the Point Size text box. The Object menu also contains 
commands for bold and italic.

Bold button (left) and Italic button (right) in Title Tool toolbar

To make text bold or italic:

1. Select the text you want to change.

2. Do one of the following:

t Click the Bold button or the Italic button.

t Select Object > Bold or Object > Italic.

To remove bold or italic formatting:

t Repeat the procedure.

Justifying Text

Justification controls the alignment of text in an existing text object and also when you type text in a 
new text object. The text justification buttons appear below the Font Selection button in the Title Tool 
toolbar.

Text justification buttons in the Title Tool toolbar

To justify the text, do one of the following:

t Click the left text justification button to align text with the left side of the text object. 

t Click the center button to center the text. 
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Formatting Text
t Click the right button to align text with the right side of the text object. 

Kerning Text

Kerning improves the appearance of titles by controlling the amount of space between characters. 
You can expand or condense the character spacing to make text more readable or to create special 
effects, such as dramatically expanded spacing in a title.

You can kern the text for an entire text object, or you can manually kern individual character pairs or 
character strings. For example, if you mix italic and plain versions of a font in a title, you might want 
to adjust the spacing between characters.

You use the Kerning button to select predefined kerning options or the Kerning text box to specify 
your own custom kerning value. Positive numbers increase the spacing; negative numbers decrease 
the spacing. You can also use the arrow keys to make incremental adjustments.

Kerning text box (left) and Kerning button (right) in the Title Tool toolbar

n For individual characters or selected groups of characters, the arrow keys provide the only way to 
adjust kerning.

You can select the kerning value before you type text.

To adjust kerning manually with the arrow keys:

1. Click the Text tool in the toolbar.

2. Click between a character pair, or select a group of characters to be kerned.

3. Press the Alt key (Windows) or Option key (Macintosh), and use the Left Arrow key or the Right 
Arrow key to increase or decrease the kerning.

To adjust kerning with predefined sizes:

1. Select the text.

2. (Option) Click the Kerning button, and select Pair Kerning to eliminate excessive space between 
some character pairs. 

Pair kerning works only on fonts that support kerning tables (for example, Palatino).

3. Click the Kerning button, and select a kerning option:

Option Description

Loose Adds space between letters

Normal Leaves spacing unchanged

Tight Closes up the spacing between the letters
328



Creating Graphic Objects
Top to bottom: loose, normal, and tight kerning

To adjust kerning with the text box:

t Click in the Kerning text box, and type a positive or negative numerical value. 

Values are a percentage of the point size.

t Click in the Kerning text box, and use the Up Arrow and Down Arrow keys to change the value 
incrementally.

The kerning for the entire text object changes.

Adjusting Leading

Leading controls the line spacing between lines in a title. Leading is measured in points, from 
baseline to baseline of the lines of text. The Title tool uses the leading that is built into the font as the 
default. Positive leading values add space and negative values decrease space. You might want to add 
leading for sans serif, tall, or boldface fonts, and for fonts with a strong vertical emphasis.

Leading text box in the Title Tool toolbar

To set leading:

t Click in the Leading text box, and type a number to indicate the leading value you want.

The Title tool adjusts leading immediately.

Creating Graphic Objects
You use the drawing tools to create graphic objects such as squares, rectangles, circles, ovals, and 
lines. After creating graphic objects, you can modify or manipulate them in a variety of ways. For 
more information, see “Modifying and Manipulating Title Objects” on page 335.

Drawing tools in the Title Tool toolbar
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Creating Rolling and Crawling Titles
n By default, when you use a drawing tool and deselect the created object, the pointer reverts to the 
Selection tool. To avoid this, double-click the drawing tool when you select it in the Title tool toolbar.

To draw a square or a rectangle:

1. Click the Square and Rectangle tool in the toolbar.

The pointer becomes a crosshair pointer.

2. Click in the Title tool, and drag to create an object.

Shift-drag to constrain the object to a square.

Example of a rectangle drawn over a video background

To draw a circle or an oval:

1. Click the Oval tool in the toolbar.

The pointer becomes a crosshair pointer.

2. Click in the Title tool, and drag to create an object.

Shift-drag to constrain the object to a circle.

To draw a line:

1. Click the Line tool (slanted line) in the toolbar.

The pointer becomes a crosshair pointer.

2. Click in the Title tool, and drag to create a line.

Shift-drag to constrain the line to a horizontal or vertical line.

Creating Rolling and Crawling Titles
You can create title text and graphics that roll up the screen or crawl across the screen. You can refine 
the motion after you edit the title into your sequence.

n Rolling and crawling titles are non-real-time effects. You can step through the effect in a Source 
monitor, the Composer monitor, or the Effect Preview monitor, but you must render the effect to play 
it.

Rolling titles scroll vertically, moving from top to bottom or from bottom to top.

 : example of start, middle, and end of a bottom-to-top roll.

Crawling titles scroll horizontally, moving from right to left or from left to right.

The Long Road HomeThe Long Road Home

The Long Road HomeThe Long Road Home

The Long Road HomeThe Long Road Home
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Creating Rolling and Crawling Titles
Left to right: example of start, middle, and end of a right-to-left crawl.

n You cannot save a rolling or crawling title with a color background even though you can set the Title 
tool to display a color background while you create the title. To place your rolling or crawling title 
over a color background, you must export the background as a PICT file, reimport it (with Ignore 
Existing Alpha selected in the Import dialog box), edit it into your sequence, and then edit your title 
onto a new layer above the background graphic.

Page Count Limits for Rolling and Crawling Titles

Rolling and crawling titles form pages in the Title tool that are similar to the pages you create with a 
word processor. A page in a rolling or crawling title is a unit the size of a PAL, NTSC, or HD frame. 
The following table lists the page limits for different projects.

Typing more text, increasing the size of the font, or adjusting kerning and leading all affect the 
number of pages in the title. If you reach the page count limit while you are typing text, the title stops 
getting bigger and text entry stops.

If you attempt to change the text formatting in a way that would make the title exceed the page count 
limit, a message box opens. To cancel the operation and keep the title within the page count limit, 
click OK.

HD Resolution Type Page limit SD Resolution Type Page limit

1080i and 1080p Rolling 29 NTSC Rolling 67

Crawling 4 Crawling 11

720p Rolling 44 PAL Rolling 56

Crawling 6 Crawling 11
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Workflow Options for Creating Crawling Titles

Rolling titles scroll in the direction of the roll as you type the text, but crawling titles do not scroll 
horizontally in the direction of the crawl during typing. When you create crawling text, consider the 
following workflow options:

• Type the text first as a rolling title. This lets you view the text as it scrolls down during typing, 
and provides you with a scroll bar on the right side of the screen for moving quickly through the 
text. You can then click the Crawl button in the toolbar to convert the text to a crawling title 
before resizing, reformatting, and saving the title.

• Use a small font size, such as 12 point, to view as much of the text in the window as possible 
before changing the font size and resizing the text box in a horizontal direction.

• Use other options to control the text in the Title tool. For example, you can create objects and 
move or copy them to specific pages, insert pages, and delete pages. For more information, see 
“Working with Pages in Rolling or Crawling Titles” on page 334.

Using Auto Size Mode for Rolling and Crawling Titles

Auto Size mode adds or removes pages automatically as you add, delete, or reformat the text. Auto 
Size mode is on by default when you click the Rolling Title button or the Crawling Title button.

You can turn off Auto Size mode if you want to add extra pages before or after the text (for example, 
to make room for additional title elements). For more information, see “Working with Pages in 
Rolling or Crawling Titles” on page 334.

To switch Auto Size mode off or on:

t Select Object > Auto Size Mode.

A check mark indicates that Auto Size mode is on.

Creating Text in a Rolling Title or a Crawling Title

Before you create a rolling or crawling title, set the text formatting defaults for attributes such as font, 
point size, leading, and kerning. For more information, see “Setting Default Text Attributes” on 
page 326.

When you type the text for a rolling or crawling title, lines of text wrap within the safe title area, and 
the title scrolls down as you type. For rolling titles, this provides you with a sense of positioning, 
word wrap, and page count limitations.

To type rolling or crawling title text:

1. Do one of the following:

t Select Timeline > New > Title.

t Select Tools > Title Tool Application.

The Title tool opens.

2. Click the Text tool in the toolbar.

3. Do one of the following:

t Click the Rolling Title button to enter Rolling Title mode.

t Click the Crawling Title button to enter Crawling Title mode.
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Creating Rolling and Crawling Titles
Top to bottom: Crawling Title button, Rolling Title button, and Page Number text box in the Title Tool toolbar

The button changes to green, and a Page Number text box appears in the lower right corner of the 
Title tool.

n You cannot create rolling and crawling titles over a color background, although you can preview 
them with a color background. For rolling and crawling titles, the Background Selection tools are set 
to Video Background and the Video Background button changes to green.

4. Type the title text.

The text wraps automatically as you type.

5. When you are finished, click the Selection tool in the toolbar to select the new text object.

Resizing the Width of a Rolling Title or a Crawling Title

You resize titles by manipulating their object selection handles.

n You can resize only the width of a rolling or crawling title. The Title tool determines the height of 
your title by the amount of text it contains.

If you resize a crawling title, save it before rendering to ensure the correct rendering result.

To resize a rolling title or a crawling title:

1. Click the Selection tool, and click the title object.

2. Click the object selection handle, and drag to resize the title until it appears as you want.

Using the Make Crawl Command to Position a Crawling Title

After you enter and edit your crawling title text, you can transform the title into a single-line text 
object and position it on the lower third of the screen.

To position a crawling title:

t Select Object > Make Crawl.

Scrolling Through a Rolling Title or a Crawling Title

When you create a rolling or crawling title, a scroll bar appears along the right side of the Title tool 
video background for moving vertically through the rolling title, and at the bottom for moving 
horizontally through a crawling title.

To scroll through a rolling or crawling title, do one of the following:

t Use standard techniques for scrolling, such as clicking the arrow icons, dragging the scroll box, 
or clicking in the scroll bar.

t Press the Home or the End key to go to the beginning or end of the title.

t Press the Page Up or the Page Down key on the keyboard to move through a rolling title one 
page at a time.
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t (Rolling titles only) Press the Up Arrow or the Down Arrow key to move the pointer through a 
rolling title one line at a time.

Working with Pages in Rolling or Crawling Titles

When you first create a rolling title or a crawling title, a Page Number text box appears in the lower 
right corner of the Title tool. The Page Number text box reflects your current position in the title.

You can go to a specific page, add and delete pages, insert blank pages, and copy or move material to 
a page.

Page Number text box in the Title Tool toolbar

To go to a different page:

1. Click the Page Number text box.

2. Do one of the following:

t Type a page number for a specific page.

t Use the Up Arrow and Down Arrow keys to cycle through the page numbers.

3. Press Enter (Windows) or Return (Macintosh).

The selected page appears.

To add pages:

1. If Auto Size mode is on (a check mark appears next to Auto Size Mode in the Object menu), turn 
it off by choosing Object > Auto Size Mode.

The Add Page command is not available when Auto Size mode is on.

2. Select Object > Add Page.

The Title tool adds a page to the end of the title. You can select Add Page repeatedly to continue 
adding pages up to the maximum page count.

For more information on maximum page counts, see “Creating Rolling and Crawling Titles” on 
page 330.

3. Select text or graphic objects in the title and position them within the range of available pages, or 
create new elements.

To insert a blank page into a rolling or crawling title:

1. Select Object > Insert Page.

The Insert Page dialog box opens.

2. Type a page number, and then click OK.

The Title tool inserts a blank page at that page number, and moves all objects after it by one 
page.

The Title tool inserts a page only if the left boundary of an object appears on the page whose 
number you typed. For example, you cannot insert a page in the middle of a long crawling title.

You cannot use the Insert Page command to add a blank page to the end of a roll or crawl.
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To delete empty pages from a rolling or crawling title:

1. Select Object > Remove Page.

The Remove Page dialog box opens.

2. Type the page number of the page you want to remove, and then click OK.

If the page is empty, the page is removed and all pages after the removed page are moved by one 
page.

To remove excess pages at the end of a rolling or crawling title:

t Select Object > Auto Size Mode.

For more information on Auto Size mode, see “Using Auto Size Mode for Rolling and Crawling 
Titles” on page 332.

To copy or move an object to a title page:

1. Create a text block or any other title object.

2. Select the object.

3. Do one of the following:

t Select Object > Copy to Page.

The Copy to Page dialog box opens.

t Select Object > Move to Page.

The Move to Page dialog box opens.

4. Type a page number, and then click OK.

The Title tool copies or moves the object, and automatically adds pages if necessary.

Formatting Rolling and Crawling Titles

You can modify the text attributes of a rolling or crawling title with the same methods used to format 
still text elements:

• To adjust font, point size, style, justification, kerning, and leading, see “Formatting Text” on 
page 325.

• To create outlines surrounding the text, see “Modifying Box Corners, Lines, and Borders on Title 
Objects” on page 336.

• To adjust color and transparency, see “Selecting Colors and Setting Transparency” on page 340.

• To add a drop or depth shadow, see “Adding Shadows to Title Objects” on page 342.

Modifying and Manipulating Title Objects

You can modify or manipulate title objects in a variety of ways:

• You can round the corners of a box, adjust the width of lines and text borders, or add arrowheads 
to lines.

For more information, see “Modifying Box Corners, Lines, and Borders on Title Objects” on 
page 336.

• You can change or blend colors in any title object.
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For more information, see “Understanding Color and Transparency Controls in the Title Tool” 
on page 338 and “Selecting Colors and Setting Transparency” on page 340.

• You can add and adjust drop or depth shadows for any title object.

For more information, see “Adding Shadows to Title Objects” on page 342 and “Adjusting 
Shadows on Title Objects” on page 343.

• You can modify the transparency level of any title object or of its shadow.

For more information, see “Selecting Colors and Setting Transparency” on page 340.

• You can manipulate title objects by changing their layer order, grouping them, locking them to 
prevent accidental editing, aligning them with respect to one another, and distributing them 
evenly across the viewing area.

For more information, see “Manipulating Title Objects” on page 344.

Modifying Box Corners, Lines, and Borders on Title 
Objects

You can use the line attribute tools to round the corners of a box, adjust the width of lines and text 
borders, or add arrowheads to lines. The following illustration shows the line attribute tools.

Left to right: Box Corner button, Border Width button, and Arrowhead button in the Title Tool toolbar

n If you do not select an object and you select a line attribute, the Title tool makes that attribute the 
default for any new objects that you create.

You can use the Border Width button to change the width of lines created with the drawing tools or to 
apply a border outline to text or graphic objects.

Example of text with borders

To round box corners:

1. Select a box.

2. Click the Box Corner button, and do one of the following:

t Select a standard rounding option.

t Specify a custom corner radius by doing the following:

a. Select the Custom Radius option (the last item on the list).

The Enter New Corner Radius dialog box opens.

b. Type a whole number (in pixels) into the dialog box.

The maximum custom radius is 200.

c. Click OK.
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Box Corner button and options, with Custom Radius option at bottom

To select a line or border width:

1. Select an object (such as a line, shape, or text object).

2. Click the Border Width button, and do one of the following:

t Select from the standard widths.

t Specify a custom width by doing the following:

a. Select the Custom Width option (the last item on the list).

The Enter New Line Width dialog box opens.

b. Type a whole number (in pixels) into the dialog box.

c. Click OK.

If you selected a line for modification, the width of the line changes. If you selected an object for 
modification, the width of the border changes.

Border Width button and options, including Remove Border option (top) and Custom Width option (bottom)

To remove a border:

t Click the Border Width button, and select the Remove Border option (the first item on the list).

To add arrowheads to a line:

1. Select a line.

2. Click the Arrowhead button, and do one of the following:

t Select a standard arrowhead style.
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t Select the Edit Arrowhead option (the last item on the list), and specify a custom arrowhead 
as described in the following procedure.

Arrowhead button and options, including Remove Arrowhead option (top) and Edit Arrowhead option (bottom)

To change the arrowhead size:

1. Select a line.

2. Click the Arrowhead button.

3. Select the Edit Arrowhead option (the last item on the list).

The Arrowhead Size dialog box opens. 

Arrowhead handle in the Arrowhead Size dialog box

4. Click the handle on the arrowhead, and drag it vertically or horizontally to resize and reshape it.

The shape of the arrowhead is in proportion to the line width.

5. Click OK. 

The line changes to show the new arrowhead shape.

To remove an arrowhead:

1. Select a line.

2. Click the Arrowhead button

3. Select the Remove Arrowhead option (the first item on the list).

Understanding Color and Transparency Controls in the 
Title Tool

You can select the color and transparency for text and graphic objects, for their shadows, and for their 
borders. This topic describes the options available. For information on how to make color, 
transparency, and blend changes, see “Selecting Colors and Setting Transparency” on page 340.
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 The following illustration shows the boxes associated with color and transparency.

Left to right: Color Selection boxes, Transparency Level boxes, and Color and Transparency Blend tools in the Title Tool 
toolbar

• The Color Selection boxes control fill (Fill), shadow (Shad), and border (Bord) color, 
respectively.

These boxes provide access to the Title Tool Color Picker dialog box, which enables you to do 
the following:

- Select a color from the Title Tool Color Picker.

- Use an eyedropper to select a color from any open application on your computer.

- Use the Windows Color dialog box or the Macintosh Colors panel to select a color.

• The Transparency Level boxes control fill, shadow, and border transparency, respectively. 

• The Color and Transparency Blend tools appear when you select a Fill or Border Color Selection 
box or Transparency Level box. You can use these tools to blend two colors in a text or graphic 
object or in a border to create a color gradient, and to specify the direction of the blend. You 
cannot blend the shadow for a title object.

- If you select a Color Selection box, the top boxes show the two colors that create the blend. 
The bottom box shows the blended color and lets you control the direction of the blend or 
transparency.

Example of a gradient blend (left) created with the Color Blend tools (right)

- If you select a Transparency Level box, the top boxes show the two transparency values that 
are used to create the blend. The bottom box lets you control the direction of the 
transparency blend.
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Example of a transparency blend (left) created with the Transparency Blend tools (right)

Selecting Colors and Setting Transparency
To select a color for a title object:

1. Select a text or graphic object.

If you do not select an object, the color is applied to the next object you create.

2. Press and hold the mouse button with the pointer over one of the Color Selection boxes in the 
toolbar: 

The Title Tool Color Picker opens.

n You can drag the Color Picker from the toolbar to create a floating palette.

3. Select a color:

Box Description

Fill Applies the color to the selected object.

Shadow (Shad) Applies the color to the selected object’s shadow.

Border (Bord) Applies the color to the selected object’s outline or border.

1
2

3 4

5

6

7

1 Grayscale selection bar 4 Shade selection palette 7 Original Color window

2 Eyedropper 5 Color selection bar

3 Open the Windows Color 
dialog box or the 
Macintosh Colors panel

6 New Color window
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t To select from the Title Tool Color Picker, drag the pointer along the color selection bar to 
the color you want, and then move the pointer down into the shade selection palette to select 
a shade. Media Composer applies the color when you release the mouse button.

t To use the eyedropper, drag the pointer to the Eyedropper icon and release the mouse button. 
The pointer changes to the eyedropper. Click the color you want from anywhere in the 
window to apply the color to the selected object.

t To use the Windows Color dialog box or the Macintosh Colors panel, drag the pointer to the 
Round Button icon under the eyedropper, and release the mouse button. The Windows Color 
dialog box or the Macintosh Colors panel opens. For more information, see “Adjusting a 
Color Parameter for an Effect” on page 74.

t To select a grayscale value, click in the grayscale selection bar.

To create a blend between two colors for a title object:

1. Select text or another object.

2. Click the Color Selection box for either fill or border.

The Color Blend tools appear.

Color Selection boxes (left), Color Blend Selection boxes (top right), and Blend Direction box (bottom right) in the 
Title Tool toolbar

3. Click one of the Color Blend Selection boxes, and select a color by using either the Title Tool 
Color Picker, the eyedropper, the Windows Color dialog box, or the Macintosh Colors panel.

4. Click the other Color Blend Selection box, and select the second color for your blend.

The Blend Direction box appears below the two Color Blend Selection boxes. This box displays 
the blend and lets you specify the direction of the blend (for example, left to right).

Example of a gradient blend (left) created with the Color Blend tools (right)

5. Click the Blend Direction box, and drag clockwise or counterclockwise to achieve the effect you 
want. 

As you rotate the pointer, the position of the two colors rotates. The change takes effect as soon 
as you release the mouse button.
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To control transparency level:

1. Click the appropriate Transparency Level box, depending on whether the transparency will apply 
to an object or will adjust a shadow or border around the selected object.

The Transparency Level box displays the text “Hi” with a background that changes from black to 
white. A completely white background represents a fully transparent object or portion of an 
object. A transparency control with a slider opens. The following illustration shows an example.

Transparency Level boxes (left), Transparency Blend Selection boxes (center top), Blend Direction box (center 
bottom), and transparency control with slider (right) in the Title Tool toolbar

2. In the transparency control that appears, drag the slider until you attain the transparency you 
want, and then release the mouse button.

The Title tool immediately applies the transparency to your selection.

n You might find it useful to turn off the shadow and shadow softness for an object while experimenting 
with transparency. Set the shadow value to zero in the Shadow Depth text box and the softness value 
to zero in the Soft Shadow dialog box, as described in “Adding Shadows to Title Objects” on 
page 342 and “Adjusting Shadows on Title Objects” on page 343.

Adding Shadows to Title Objects
You can add a depth shadow or drop shadow to any text or graphic object. A depth shadow extends 
from the edges of the object, as though the object were three-dimensional. A drop shadow is offset 
from the object itself, as though cast by a light source. You can place the shadow anywhere within the 
title without restriction. The following illustration shows an example of depth and drop shadows.

You can adjust the color or transparency of a shadow. You can also soften (blur) shadows or create a 
glow effect behind a title object. For more information, see “Adjusting Shadows on Title Objects” on 
page 343.

Shadow Depth and Direction button (top), Shadow Depth text box (bottom left), and Drop and Depth Shadow button 
(bottom right) in the Title Tool toolbar
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To apply shadows to text or objects:

1. Select text or an object.

2. Click the Drop and Depth Shadow button to switch between a drop or depth shadow.

3. Adjust the depth or direction of the shadow by doing one or more of the following:

t Click the Shadow Depth and Direction button, and drag the shadow sample to any position.

t Shift-click the shadow in the Shadow Depth and Direction button, and drag to restrict 
shadow placement to 45-degree angles around the title.

t Press the Shift key, and use the arrow keys to move the shadow to any position around the 
title.

t Type a value in the Shadow Depth text box to change the shadow depth by increments.

The Title tool automatically orients the shadow to the selected object. You can continue to follow 
these procedures to adjust the shadow until you achieve the effect you want.

Adjusting Shadows on Title Objects
You can adjust the color and transparency for a shadow using the same procedures you use to adjust 
color and transparency for title objects themselves. For more information, see “Selecting Colors and 
Setting Transparency” on page 340.

You can also control the amount of softening or blurring on shadows you create in the Title tool. The 
value that you set applies immediately to any selected title. The value also becomes the new default 
setting and applies to any new title objects you create in current and future Title tool sessions. To 
change the degree of softening that applies to objects in the Title tool, you must set a new value. The 
following illustration shows a typical soft shadow.

The current degree of softness is always represented visually on the shadow display of the Shadow 
Depth and Direction button. The following illustration shows this representation for a Shadow 
Softness setting of 10.

You can use specific softness values to create a glow or halo around a title object.

For information on applying shadows to title objects, see “Adding Shadows to Title Objects” on 
page 342.

To set a degree of softening or blurring for shadows:

1. Select Object > Soften Shadow.

The Soft Shadow dialog box opens.

2. Type a number in the Shadow Softness text box to represent the degree of softening you want.
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Shadow softness values must be integer values between 4 and 40. The higher the value, the more 
blurred the shadows are. If you set the value to zero, shadows on title objects have no softening 
(hard edges).

3. Click OK to close the Soft Shadow dialog box.

To adjust shadow softness on-the-fly, using the Soft Shadow text box:

1. Select one or more objects in the Title tool.

2. Select Object > Soften Shadow.

3. Type a number in the Shadow Softness text box to represent a degree of softening.

4. Click Apply.

The Title tool applies the softness value to the selected title objects.

5. Repeat steps 3 and 4 until you are satisfied with the effect.

6. Click OK.

To adjust shadow softness on-the-fly, using the Up Arrow and Down Arrow keys:

1. Select one or more objects in the Title tool.

2. While pressing and holding the Shift and Alt keys (Windows) or the Shift and Option keys 
(Macintosh), press the Up Arrow and Down Arrow keys to adjust the softness value 
incrementally until you are satisfied with the effect.

Each press of the Up Arrow key adds 1 to the shadow softness value. Each press of the Down 
Arrow key subtracts 1 from the shadow softness value.

To confirm the current numerical value for shadow softness:

t Select Object > Soften Shadow, and check the number in the Shadow Softness text box.

To create a glow or halo around a title object:

1. In the Title tool, set Shadow Depth for the object to zero.

2. Set Shadow Softness for the object to a non-zero value.

The higher the Shadow Softness value, the softer the glow effect. In the following illustration, 
Shadow Softness is set to 10.

n To create titles that do not have either softened shadows or glows, you must set the Shadow Softness 
to zero.

Manipulating Title Objects
You can manipulate title objects in the following ways using commands in the Edit, Object, and 
Alignment menus:

• You can cut, copy, and paste title objects.

• You can select all objects at once, and deselect any selected objects.

• You can change the layering order of title objects.
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The last object created occupies the top layer, but you can move objects forward or backward 
within the screen area.

• You can group and ungroup title objects.

Combining objects into a group means that actions, such as moving or applying color, affect all 
objects in the group.

• You can lock and unlock title objects.

You lock objects to make sure that changes to default settings, such as the font setting or object 
position, do not affect the locked objects. You might also want to lock objects so that you do not 
inadvertently change them while working on other objects.

• You can align title objects to each other and to the frame, or distribute them evenly.

Aligning to the frame and distributing refers to the safe title area. For more information, see 
“Understanding the Drawing Environment” on page 321.

For more information on how to select objects, see “Using the Selection and Text Tools” on 
page 320.

To manipulate objects using the Edit menu (cut, copy, paste, select all, and deselect):

1. Click the Selection tool, and click an object.

2. Do one of the following:

t To cut an object and move it to the Clipboard, select Edit > Cut.

t To copy an object to the Clipboard, select Edit > Copy.

t To paste an object from the Clipboard, select Edit > Paste.

t To select all objects, select Edit > Select All.

t To delete selected objects, select Edit > Delete.

n You cannot delete locked objects. Unlock objects you want to delete. For more information, see the 
procedures for locking and unlocking objects below.

t To duplicate an object, select Edit > Duplicate.

To adjust the layering of objects in a title:

1. Click the Selection tool, and click an object.

2. Do one of the following:

t To bring an object to the top layer, select Object > Bring To Front.

t To send an object to the bottom layer, select Object > Send To Back.

t To move an object forward one layer, select Object > Bring Forward.

t To move an object back one layer, select Object > Send Backward.

To group objects:

1. Click the Selection tool, and Shift+click multiple objects.

2. Select Object > Group.

The Title tool creates a grouped object from the individual objects. Changes to any individual 
object in the group affect all objects in the group.
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To ungroup objects:

1. Click the Selection tool, and click a grouped object.

2. Select Object > UnGroup.

Everything in the group becomes an individual object that you can move or change 
independently.

To lock objects:

1. Click the Selection tool, and click an object.

2. Select Object > Lock.

The Title tool locks the object. You cannot change the object until you unlock it.

A locked object displays hollow selection handles, as shown in the following illustration.

To unlock objects:

1. Click the Selection tool, and click a locked object.

2. Select Object > Unlock.

The Title tool unlocks the object. You can now change it.

To align objects to the frame:

1. Click the Selection tool, and click an object or Shift+click multiple objects.

2. Do one of the following:

t Select Alignment > Align To Frame Left.

t Select Alignment > Align To Frame Right.

t Select Alignment > Align To Frame Top.

t Select Alignment > Align To Frame Bottom (Shift+Ctrl+Z).

t Select Alignment > Center in Frame Horiz. (Shift+Ctrl+C).

t Select Alignment > Center in Frame Vert.

The Title tool aligns the objects within the safe title area.

To align objects to each other:

1. Click the Selection tool, and Shift+click or lasso multiple objects.

2. Do one of the following:

t Select Alignment > Align Objects Left.

t Select Alignment > Align Objects Right.

t Select Alignment > Align Objects Top.

t Select Alignment > Align Objects Bottom.

The Title tool uses the last object you selected as the reference object to which it aligns the 
others.
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n For information on aligning objects to a grid, see “Understanding the Drawing Environment” on 
page 321.

To distribute objects:

1. Click the Selection tool, and Shift+click at least three objects.

2. Do one of the following:

t Select Alignment > Distribute Left to Right.

The Title tool distributes the objects evenly from left to right.

t Select Alignment > Distribute Top to Bottom.

The Title tool distributes the objects evenly from top to bottom.

t Select Alignment > Distribute First to Last.

The Title tool distributes the objects evenly between the position of the first object you select 
and the position of the last object you select.

This command is especially useful for aligning objects diagonally or for roughly positioning 
a group of objects and then lining them up without spreading them out to the edges of the 
safe title area.

Saving Titles
You can save a title and then exit the Title tool immediately. Alternatively, you can save a title and 
then continue creating titles, using the Save As command to save each additional title separately. You 
can also save a title and automatically place it between an In and Out mark in the Timeline.

The Save As command is also useful for saving the latest version of a title without replacing the 
original. A keyboard shortcut makes this even quicker.

The Fast Save option also lets you work more quickly when creating and saving multiple titles in a 
Title tool session. Fast Save skips the steps that create anti-aliased images from title objects. Instead, 
just the raw title objects (text and graphics) are saved in the bin, with the prefix “unrendered.”

Fast-saved titles appear as black in the monitors and are labeled as “media offline” during editing. 
You can edit with the titles and then batch render them at a more convenient time. Fast Save is ideal 
for working with multipage rolling titles with complex styles and shading. For information on 
rendering fast-saved titles, see “Creating Media for Unrendered Titles in a Bin” on page 365.

You can also save the attributes of a particular title as a title style or as a title template that you can 
apply repeatedly to other titles or title objects, in much the same way that you can save effect 
templates. For more information, see “Saving and Recalling Title Styles” on page 351 and “Creating 
and Using Title Templates” on page 350.

n After you edit a title into a sequence and adjust effect parameters, you can also save a Title Effect 
template that contains only the effect information (without title media) for applying to other 
previously created titles. For more information, see “Working with Effect Templates” on page 36.

c Before you export a sequence using OMF® or creating an EDL from a sequence, always render 
fast-saved titles. Before you export a sequence using OMF, render all rolling or crawling titles.
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To save the title and exit the Title tool:

1. Select File > Close.

If the contents of the title have changed since the last time it was saved, a dialog box opens, 
asking if you want to save the existing title.

2. Click Save. 

The Save Title dialog box opens.

3. Type a name to identify the title in the bin, and then select a bin, drive, and resolution from the 
menus.

If you are saving a new title, the resolution you select becomes the default for future new title 
saves.

You can also use the Media Creation dialog box to set the resolution and drives for titles. For 
more information, see “Media Creation Settings” in the Help.

4. Select or deselect Fast Save (Unrendered), depending on your needs.

Fast Save remains in effect until you deselect it, load a title that was saved without Fast Save 
selected, or exit the Title tool.

5. Click Save.

The Title tool closes, and Media Composer loads the new title into the Source monitor. A 2-
minute Title Effect clip that corresponds to the new title appears in the bin.

To save multiple titles in a continuing Title tool work session:

1. Select File > Save Title.

The Save Title dialog box opens.

2. Type a name to identify the title in the bin, and then select a bin, drive, and resolution from the 
menus. 

You must select a resolution that is compatible with the sequence. Titles do not play with 
incompatible media. For detailed information on mixing media resolutions in a project, see 
“Resolutions and Storage Requirements” in the Help.

You can also use the Media Creation dialog box to set the resolution and drives for titles. For 
more information, see “Media Creation Settings” in the Help.

3. Select or deselect Fast Save (Unrendered), depending on your needs. 

Fast Save remains in effect until you deselect it, load a title that was saved without Fast Save 
selected, or exit the Title tool.

4. Click Save.

The new Title Effect clip appears in the bin.

5. Create another title.

6. Select File > Save Title as, and repeat steps 2 to 5 for each subsequent title that you create.

Media Composer loads titles into the Source monitor as they are saved, so the most recently 
saved title always appears in the Source monitor.

To save a title and place it between In and Out marks in the Timeline:

1. Make sure you have an In and Out mark in your Timeline.

2. Select File > Save Title.

The Save Title dialog box opens.
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3. Enter a name for the title.

4. Select the Place in Timeline (In -> Out) option.

5. Select the track where you want to place the title. The tracks listed are based on the tracks 
available for the current sequence.

6. Click Save.

The title is placed in the Timeline between the In and Out marks.

To save a version of a title using the keyboard shortcut:

1. Press Shift+Ctrl+S (Windows) or Shift+Command+S (Macintosh).

The Save Title dialog box opens.

2. Type a name for the title.

3. Select a bin, a drive, and a resolution from the menus. 

4. Click Save.

To quickly locate unrendered fast-saved titles in a bin:

1. Open the bin containing the unrendered fast-saved titles.

2. Select Bin > Select > Unrendered Titles.

The fast-saved titles are highlighted in the bin.

Revising a Title in a Bin
If you want to revise a title that has not been edited into a sequence, you can reopen the title in the 
Title tool directly from the bin.

For information on revising a title that has been edited into a sequence, see “Revising a Title in a 
Sequence” on page 362.

To revise a title in a bin:

1. Ctrl+double-click the Title Effect icon in the bin.

The title opens in the Title tool.

n If the Title tool is already open, you can drag a Title Effect clip from the bin directly into the Title 
tool.

2. Edit the title, using the techniques described in “Editing with Titles” on page 355.

3. Save the title with the same name and media parameters (bin, drive, and resolution) by choosing 
File > Save Title.

The revised Title Effect clip replaces the previous clip in the bin. The clip also appears in the 
Source monitor.

The Title tool remains open. You can continue creating additional titles, or select File > Close.

4. Save the title with a new name or change any of the media parameters (bin, drive, and resolution) 
by doing the following:

a. Select File > Save Title as.

The Save Title dialog box opens.
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b. Rename the title, or select other options from the Bin, Drive, and Resolution menus.

If you keep the same name for the title, Media Composer retains the original Title Effect clip 
in the bin and creates a new clip with the same name plus a two-digit extension that adds 
incremental numbering for each revision.

c. Select or deselect Fast Save, depending on your needs.

For more information, see “Saving Titles” on page 347.

d. Click Save to save the title and exit the Title tool.

Creating and Using Title Templates
Title templates let you create a standard format for text and graphics that you use regularly. After you 
set up your template, open the template, edit the text, and save the new title. The template prevents 
you from changing the position, colors, shadows, or graphics, which ensures consistency.

You can use the Moveable Templates option in the Templates menu to change the position of a 
template.

You can also use title styles to save and recall only the parameters that control the appearance of title 
objects. For more information, see “Saving and Recalling Title Styles” on page 351.

To create a title template:

1. Open the Title tool by doing one of the following:

t Select Timeline > New > Title.

t Select Tools > Title Tool Application.

2. In the Title tool, create the text and graphic elements to include in the template.

3. Click the Templates menu, and select Save Template.

The Save Template dialog box opens.

4. Type a name for the template.

5. Click Save.

By default, the Title tool saves the template in a Title_Templates folder within the Settings folder 
for Media Composer, but you can save it elsewhere.

6. Close the Title tool, and click Don’t Save in the dialog box. 

To use a title template:

1. Open the Title tool by doing one of the following:

t Select Timeline > New > Title.

t Select Tools > Title Tool Application.

2. Click the Templates menu, and select Include Template.

The Open dialog box opens.

3. Select the template you want to use, and click Open. 

The Title template opens.

4. Make any edits you want to the text.
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5. (Option) If you want to change the position of a template, click the Templates menu, and select 
Moveable Templates. Then click the Arrow buttons to move the template within the Title Tool.

6. Close the Title tool, and click Save in the dialog box.

The Save Title dialog box opens.

7. Type a name for your title, and click Save. 

The named title appears in the bin you specify. Now you can edit the title into the sequence. For 
more information, see “Editing with Titles” on page 355.

Saving and Recalling Title Styles
As you begin to work with a title, you might set up some basic title parameters you can use again for 
other titles. You can save the following style parameters in the form of a title style:

• Font, style, size, justification, kerning, and leading.

• Fill color and transparency.

• Shadow color, transparency, depth, direction, softness, and type.

• Border color, transparency, and width.

You can also assign a title style to one of the function keys on your keyboard. You can then recall that 
style by pressing the appropriate function key.

Title styles save only the parameters that control the appearance of text or graphic objects in the Title 
tool. If you want to save the entire contents and layout of a title, including specific title objects 
themselves, use a title template. For more information, see “Creating and Using Title Templates” on 
page 350.

The following illustration shows the location of the two buttons that let you select and define title 
styles.

Styles button (left) and Save Style Parameter button (right) in the Title Tool toolbar

See “Title Style Sheet Options” on page 352 for information on Style sheet components.

Saving a Title Style

To save title parameters to a Style sheet:

1. Click the Selection tool, and click the object that you want to use as a basis for the title style.

2. Click the Save Style Parameter button.

A menu opens that lets you select either an existing title style name or Save As.

3. Select Save As.

The Title Style Sheet dialog box opens. The following illustration shows an example.
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Saving and Recalling Title Styles
Top to bottom: Sample window, Function Key text box, and Style Name text box in the Title Style Sheet dialog box

4. Select the parameters that you want to include in the style using the information in “Title Style 
Sheet Options” on page 352.

The Title tool uses the values from the currently selected object or from the current defaults if no 
object is selected.

5. (Option) Type a function key number in the Function Key text box to assign the style to a 
function key.

For example, typing 5 assigns the style to the F5 function key.

6. Type a name in the Style Name text box, and click Done when you are ready to exit the dialog 
box and save the values.

Title Style Sheet Options

The Title Style Sheet dialog box lets you create templates for the Title tool. Style sheets let you 
define and select basic text and drawing parameters that you can use with the Title tool. The 
following table describes the components of the Title Style Sheet dialog box.

Component Description

Check boxes Select the current attributes of the object that you want to include in the style. You can 
modify the attributes that are associated with a saved title. Use the check boxes to 
specify the attributes to save.

Function Key text box (Option) Lets you designate a function key that you can use to apply the title style.

Style Name text box This name appears in the Style list in the Title tool and in the Settings list.

Refresh button Appears after you change an item in the dialog box. Click to display the change in the 
sample window.

Select All button
Select None button

Let you select all or none of the check boxes.
352



Saving and Recalling Title Styles
Recalling a Title Style

You can recall a title style and use its attributes as the defaults in subsequent Title tool sessions.

To recall title style attributes using the Title Styles tear-off menu:

1. In the Title tool, click the Styles button to display the Title Styles tear-off menu.

The menu contains a scaled visual representation of each style. Arrows on the right and left let 
you scroll back and forth.

2. Drag the pointer to the style you want to recall, and release the mouse button.

The style attributes appear in the Title tool toolbar.

To recall a title style attribute using the Save Style Parameter button:

t Click the Save Style Parameter button, and select a style from the menu.

To recall a title style attribute using a function key:

t Press the appropriate function key.

The style attributes appear in the Title Tool toolbar.

Confirming Function Key Mapping of Title Styles

To verify which function key is assigned to a particular title style:

t Open the Title Style Sheet dialog box for the style from the Settings list, and then check the 
function key number in the Function Key text box.

Applying Title Styles to Text Objects

To apply a title style directly to text objects:

1. Select one or more text objects.

2. Do one of the following:

t Click the Styles button to display the Title Styles tear-off menu, and then select a title style.

Revert button Returns the settings to those used when the style was last saved.

Done button Closes the dialog box and saves your changes.

Convert to Marquee 
button

Converts your title style to Marquee format. For more information, see the Avid 
Marquee Title Tool User’s Guide or the Avid Marquee Title Tool Help.

Close button Acts as a Cancel button. A message box opens, asking whether you want to cancel or 
save your changes. If you created a new style from within the Title tool, clicking 
Cancel means that the Title tool does not create the new style.

Component Description
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Exporting a Title as a Graphics File
t If the style is assigned to a function key, press the appropriate function key.

Managing Title Styles

Select File > Settings and click the User tab to see the available title styles.

To delete a style:

1. Select the style in the list.

2. Do one of the following:

t Press the Delete key.

t Select Edit > Delete.

To copy a style:

t Right-click the style in the list, and select Duplicate.

To rename a style, do the following:

t Click the Name column and rename.

Exporting a Title as a Graphics File
To export a title as a PICT graphics file:

1. With the Title tool open, select File > Export Title.

The Export Pict As dialog box opens.

2. Select the location where you want to export the file, type a file name, and click Save.

The Title tool saves the title.
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13 Editing with Titles

This chapter provides information on editing titles created in the Title tool or in Marquee into 
sequences.

• Displaying Title Clips and Frames in Bins

• Editing a Title into a Sequence

• Removing a Title

• Fading a Title

• Adjusting Title Effect Parameters

• Revising a Title in a Sequence

• Replacing Fill Tracks in a Title

• Rendering Titles

• Guidelines for Handling Playback Issues with Rolling Titles

• Re-creating Title Media

• Troubleshooting Titles

Throughout this chapter:

•  “Title” refers to both text and graphics.

• “Title tool” refers to the classic Avid Title tool. 

• “Marquee” refers to the Marquee Title tool. 

Displaying Title Clips and Frames in Bins
When the Title tool or Marquee saves a title, it creates a Title Effect clip and saves it in the bin you 
select. One media object, referred to as a precompute, has references to the RGB and alpha channel 
information. Every time you make a change, Media Composer creates two additional media files. 
The original media files are not changed.

Rendered effect or precompute (left) and Title Effect clip (right) in Frame view in a bin

n Bins do not display rendered effects by default. To view rendered effects in the bin, select Bin > Set 
Bin Display, then select Rendered Effects and “Show reference clips” in the dialog box.



Editing a Title into a Sequence
For more information, see “Managing Effect Media Files” on page 142.

When you have a bin in Frame view, you can display a frame from the title itself rather than display 
the Title Effect Clip icon for the clip. This is especially useful if you have many titles in the bin and 
want a quick visual reference.

To display a frame from the title:

1. Select one or more Title Effect clips.

2. Press the Home key on the keyboard.

Editing a Title into a Sequence
There are three basic methods for editing a title into a sequence:

• Mark edit points and then splice or overwrite the title into the sequence.

For more information, see “Splicing or Overwriting a Title into a Sequence” on page 356.

• Mark edit points, and then drag the title directly into the sequence.

For more information, see “Dragging a Marked Title into a Sequence” on page 357.

• Place the position indicator, and then drag an unmarked title clip directly into the sequence at the 
location of the position indicator.

For more information, see “Dragging an Unmarked Title into a Sequence” on page 358.

Splicing or Overwriting a Title into a Sequence

To splice or overwrite a title into a sequence:

1. Load the sequence into the monitor window.

n You must place titles on a track above the video that forms the background. If an upper track already 
exists with an open region for the title, you can go to step 3.

2. (Option) Select Timeline > New > Video Track.

Media Composer adds the next video track for the sequence to the Timeline. For example, if the 
sequence includes only V1, Media Composer adds V2.

3. Double-click the Title Effect Clip icon in the bin to load the title clip in the monitor window.

4. Patch the title source to the video track in the sequence by clicking the Source Track button for 
track V1 in the Track Selector panel and dragging it to the Record Track button for track V2.
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Editing a Title into a Sequence
Example of patching from a Source Track button (left) to a Record Track button (right)

n You can use any three-point editing method to edit a title into a sequence. The following steps are just 
one editing method. For other methods, see “Creating and Editing Sequences” in the Help.

5. Mark an IN point in the title clip.

Mark the IN point toward the middle of a static title clip so you can trim the title, if necessary. 
For rolling and crawling titles, set no marks and move the position indicator to the beginning of 
the clip if you want to use the full roll.

6. Mark IN and OUT points in the sequence.

7. Ensure all other Record Track buttons are deselected in the Track Selector panel.

8. Click one of the segment tools in the Timeline palette to edit the title into the sequence.

Segment tools in the Timeline palette

The Title Effect segment appears in the top video track.

Dragging a Marked Title into a Sequence

To mark a portion of a title clip and then drag the marked clip directly into the Timeline:

1. Load the sequence into the monitor window.

For more information, see “Creating and Editing Sequences” in the Help.

n You must place titles on a track above the video that forms the background. If an upper track already 
exists with an open region for the title, you can go to step 3.
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Editing a Title into a Sequence
2. (Option) Select Timeline > New > Video Track.

Media Composer adds the next video track for the sequence to the Timeline. For example, if the 
sequence includes only V1, Media Composer adds V2.

3. Double-click the Title Effect Clip icon in the bin to load the title clip into the monitor window.

4. Mark an IN point and an OUT point in the title clip to establish the duration that you want for the 
title.

Mark the IN point toward the middle of a static title clip so you can trim the title, if necessary. 
For rolling and crawling titles, set no marks and move the position indicator to the beginning of 
the clip if you want to use the full roll. Media Composer uses the position indicator to determine 
the IN point on rolling titles.

5. Clear the title clip from the monitor window by choosing Clip Name > Clear Monitor.

6. Click either the Extract/Splice-in button or the Lift/Overwrite button, depending upon how you 
want to insert the Title effect.

Extract/Splice-in button (left) and Lift/Overwrite button (right)

7. Click the Title Effect Clip icon in the bin, and drag it to the Timeline.

As you drag the Title effect in the Timeline, a white outline of the title clip indicates location in 
the sequence.

8. Release the mouse button when you have the title positioned where you want it.

The Title effect appears in place in the sequence.

Dragging an Unmarked Title into a Sequence

If you are not concerned about the OUT point for your title, or if you plan on trimming the Title 
effect later, you can quickly drag the unmarked Title effect directly into the Timeline.

To apply a Title effect to a sequence without adding marks:

1. Load the sequence into the monitor window.

For more information, see “Creating and Editing Sequences” in the Help.

n You must place titles on a track above the video that forms the background. If an upper track already 
exists with an open region for the title, you can go to step 3.
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Removing a Title
2. (Option) Select Timeline > New > Video Track.

Media Composer adds the next video track for the sequence to the Timeline. For example, if the 
sequence includes only V1, Media Composer adds V2.

3. Move the position indicator to the location where you want the Title effect to begin.

4. Click either the Extract/Splice-in button or the Lift/Overwrite button, depending upon how you 
want to insert the Title effect.

Extract/Splice-in button (left) and Lift/Overwrite button (right)

5. Click the Title Effect Clip icon in the bin, and drag it to the Timeline.

As you drag the Title effect in the Timeline, a white outline of the title clip indicates location in 
the sequence.

6. Release the mouse button when you have the title positioned where you want it.

The Title effect appears in place in the sequence.

Removing a Title
To remove a title segment:

1. Move the position indicator to the segment containing the Title effect.

2. Use the Track Selector panel to select the track containing the Title effect and to deselect all 
other tracks.

3. Click the Mark Clip button under the monitor.

IN and OUT points appear surrounding the Title effect.

4. Click one of the segment tools in the Timeline palette to remove the segment.

Segment tools in the Timeline palette

n The Title effect remains in the bin. To remove the Title effect from the bin, select the effect in the bin 
and press the Delete key.
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Replacing a Title
Replacing a Title
To replace a title in a sequence:

1. Click the Segment Overwrite tool in the Timeline palette.

2. Click the title segment currently in the sequence to select it.

3. Click the Mark Clip button to mark an IN point at the beginning of the title segment and an OUT 
point at the end of the segment.

4. Drag the new Title Effect clip from the bin to the marked segment.

The new title replaces the old title.

Fading a Title
You can use the Fade Effect button to fade a title. A dialog box opens that lets you enter the number 
of frames to fade up and fade down without opening the Effect Editor.

Rather than adding Dissolve effects that require rendering, you can use the Fade Effect button to 
quickly create keyframes in the title with the proper level settings for playback in real time. You can 
access the keyframes in the Effect Editor. For more information, see “Using the Fade Effect Button” 
on page 29.

Setting Marks in a Rolling or Crawling Title
By default, a rolling or crawling title clip begins with the visible title just off screen and ends after the 
last element disappears off screen.

You can mark IN and OUT points of rolling or crawling titles in the Source monitor to change the 
start and finish points. For example, you might want the title to start with the screen full of text rather 
than start off screen.

You can play and mark a rolling or crawling title clip in the Source monitor by using standard 
procedures. For more information, see “Controlling Playback” in the Help.

If you want to use the complete roll or crawl in the sequence, do not set marks. For information about 
adjusting the duration of the roll, see “Trimming the Duration of Rolling and Crawling Titles” on 
page 360.

n You can view a crawling title frame by frame if you select Composer > Render On-the-Fly.

Trimming the Duration of Rolling and Crawling Titles
When you edit a title clip into a marked segment of a sequence, the clip plays back from beginning to 
end regardless of the duration of the segment. That is, the entire roll shrinks to fit within the duration 
of the marked segment in the sequence.

After you edit the clip into the sequence, you can trim the duration of the segment at any time, and 
the title adjusts to fit. 
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Adjusting Title Effect Parameters
Unlike trimming other segments, trimming a rolling or crawling title does not remove any part of the 
title contents. As a result, the duration of the title determines how fast it plays. For example, the 
shorter you trim the title, the faster it rolls.

n Rolling titles might jitter at certain speeds. You can trim the duration slightly to fix the problem.

c If you trim your rolling title very short, it scrolls very fast and cannot display in real time, so 
you must render it. The maximum speed for an unrendered rolling title is one screen per 
second.

To trim the duration of a rolling title or a crawling title:

1. Use the Track Selector panel to select the track containing the Title effect and to deselect all 
other tracks.

2. Trim the title segment to the duration you want by using standard trim procedures.

For more information, see “Working with Trim Edits” in the Help.

The entire roll or crawl plays back within the new duration.

Adjusting Title Effect Parameters
After you edit a title into a sequence, you can open the Effect Editor and refine the title with 
keyframe control over effect parameters.

You can also promote a 2D title to 3D in the same way that you promote other effects from 2D to 3D. 
For more information, see “Promoting 2D Effects to 3D Effects” on page 284.

n Adjusting parameters might affect the real-time playback capabilities of your titles in various ways, 
depending on the particular options available with Media Composer.

To access the effect parameters for a Title effect:

1. If you are not in Effect mode, enter Effect mode, for example, by clicking the Effect Mode 
button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

2. Click the Title Effect segment in the sequence to select it.

The Effect Editor displays the parameter controls.
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Revising a Title in a Sequence
3. Do one or more of the following to work with the Title effect parameters:

t Adjust Title effect parameters by using basic techniques described in “Using the Effect 
Editor” on page 68.

n For information on specific Title effect parameters, see “Title Effects” on page 488.

t Use multiple keyframes to gradually change keyframeable parameters over time.

For more information, see “Working with Keyframes” on page 80.

t Save effect templates of Title effect parameter adjustments to a bin for use in other 
sequences or projects as described in “Working with Effect Templates” on page 36.

Revising a Title in a Sequence
If you want to revise a title after you edit it into a sequence, you must reopen the title in the Title tool 
directly from the sequence rather than revise the Title Effect clip in the bin. Or you can edit the title 
directly from the Timeline.

To change a title in a sequence:

1. Click the Title Effect segment in the sequence to select it.

2. If you are not in Effect mode, enter Effect mode, for example, by clicking the Effect Mode 
button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

3. Click the Edit Title button.
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Revising a Title in a Sequence
A dialog box opens, asking if you want to promote the title to Marquee.

n You cannot use the Title Tool to edit titles that you promoted to or created in Marquee. For 
information on Marquee titles and the Marquee Title tool, see the Avid Marquee Title Tool 
User’s Guide or the Avid Marquee Title Tool Help.

4. Click No.

The Title tool opens.

5. Revise the title by using techniques described elsewhere in this chapter.

6. Save the title by using one of the following procedures.

To change a title directly in the Timeline:

1. Place your cursor over the Title in the sequence that you want to edit.

2. Right-click and select Edit Title.

If the title is a Title Tool title, a dialog box opens, asking if you want to promote the title to 
Marquee. If you do not want to promote to Marquee, click no.

n You cannot edit titles that you promote to or create in Marquee with the Title tool. For information on 
Marquee titles and the Marquee Title tool, see the Avid Marquee Title Tool User’s Guide or the Avid 
Marquee Title Tool Help.

The Title tool or Marquee application will open and display the title.

3. Revise the title.

4. Save the title.

To save the title with the same name and media parameters:

1. Select File > Save Title.

A message box opens, asking if you want to save the title and exit the Title tool.

2. Click Save.

The Title tool closes. The revised Title Effect clip replaces the previous clip in the sequence and 
the Source monitor and saves the new title to the bin.

To save the title with a new name or parameters:

1. Select File > Save Title as.

A message box opens, asking if you want to save the title and exit the Title tool.

2. Click Save.

The Save Title dialog box opens.

3. Rename the title, or select other options from the Bin, Drive, and Resolution menus.
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Replacing Fill Tracks in a Title
n You cannot select Fast Save when revising a title in a sequence.

4. Click Save to save the title and exit the Title tool.

The Title tool closes, and the revised Title Effect clip replaces the previous clip in the sequence. 
The new clip with its new name also appears in the Source monitor and in the bin. The previous 
Title Effect clip is preserved in the bin.

Replacing Fill Tracks in a Title
You can replace the fill track of Title effects with video or graphics. The moving video or graphic 
effect then appears inside the title itself, keyed over the background.

To replace the fill track:

1. In the Timeline toolbar, click the Step In button to step into the effect.

2. Load the video you would like to use as replacement filler into the Source monitor.

3. Drag the Source Track button in the Track Selector panel to the Record Track button for the fill 
track to patch the new source video to the title fill track.

4. Using standard editing methods, edit the video from the Source monitor onto the fill track.

Rendering Titles
Rolling and crawling titles are non-real-time effects. You must render them before they will play 
back in real time. You might also need to render static titles in some circumstances, particularly when 
they are layered with other titles or other effects, or when the overall complexity of the sequence 
limits real-time playback for your system.

For more information on rendering Title effects, see “Basics of Effects Rendering” on page 41.

Re-creating Title Media
You can use the Re-create Title Media command to:

• Regenerate title media that is offline.

• Generate title media for unrendered (Fast Saved) titles in a bin.

• Change the resolution of a title.

If you batch capture a sequence at a resolution different from the resolution at which the sequence 
was originally created, for example, you can use this command to re-create the titles at the new 
resolution. You need to do this when conforming an offline sequence with titles for online editing and 
output at uncompressed resolution.

You can re-create title media that is edited into a sequence in the Timeline, or you can create media 
for unrendered (Fast Saved) titles in a bin. For more information on Fast Save for titles, see “Saving 
Titles” on page 347.

c The Re-create Title Media command removes any nested edits inside a title, and replaces them 
with the new title’s graphic and alpha tracks.
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Troubleshooting Titles
Re-creating Title Media from the Timeline

To re-create title media from the Timeline:

1. Load the sequence containing the titles into the Record monitor.

2. Mark IN and OUT points in the sequence surrounding all the titles that you want to re-create.

3. In the Track Selector panel, select the Record Track button for each track that contains titles you 
want to re-create.

4. Select Clip > Re-create Title Media.

The Re-create Title Media dialog box opens.

5. Select a drive on which to store the re-created titles.

6. Select a resolution for the re-created titles.

n The default drive and resolution are defined in the Titles tab of the Media Creation dialog box. For 
more information, see “Media Creation Settings” in the Help.

7. Click OK.

Media Composer re-creates the title media file.

Creating Media for Unrendered Titles in a Bin

To create media for unrendered titles in a bin:

1. In the bin, select the titles for which you want to generate media.

To quickly select all the unrendered titles in the active bin, select Bin > Select > Unrendered 
Titles.

2. Select Timeline > Create Unrendered Title Media.

The Create Unrendered Title Media dialog box opens.

3. Select a drive on which to store the title media.

4. Select a resolution for the title media that is compatible with the sequence, such as a two-field 
resolution for a sequence containing two-field media.

n The default resolution is the resolution specified at the time you originally saved the titles with the 
Fast Save option.

5. Click OK.

Media Composer generates the title media file, and the title clip appears in the bin without the 
(unrendered) label in the name field.

Troubleshooting Titles
The following topics describe errors that might occur when working with Title effects and includes 
recommendations for resolving the problems.
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Troubleshooting Titles
Guidelines for Handling Playback Issues with Rolling Titles

The following limitations apply to rolling titles:

• Rolling titles might jitter slightly at certain speeds. You can adjust the duration by a few frames 
to fix the problem.

• Rolling titles cannot play back at a rate greater than one page per second. This situation occurs 
when you edit a lengthy title roll into a short segment in the sequence.

If you experience a playback problem with a title, do one or more of the following:

• Render the title or underlying effects.

For more information, see “Basics of Effects Rendering” on page 41.

• For a rolling title, slow the roll by extending the duration of the clip. For more information, see 
“Trimming the Duration of Rolling and Crawling Titles” on page 360.

• Separate title clips in the sequence.

• Store title and video media on separate drives, or use faster drives.

Guidelines for Handling Underrun Error Messages for Titles

When you edit with titles or graphics, you might experience an underrun error message because 
Media Composer could not load the graphic key in time. 

Possible causes include the following:

• Insufficient drive speed

• Title rolling too fast

• Several graphics too close together

Possible solutions include the following:

• Render the clip and underlying video.

• Slow down the rolling title.

• Store the clip media on a drive other than the drive containing the underlying media.

• Add filler between sequential clips.

• Use faster drives.

Handling a Wrong Format Message for a Title

If you see an image in a monitor that says Wrong Format, the resolution of the Title effect is not 
compatible with the resolution of the video clips in the sequence. You can determine the resolution of 
the video clip, and then regenerate the title at the same resolution as the video clip.

To determine the resolution of the current video clip:

1. Open the bin containing the sequence.

2. Select Bin > Set Bin Display.

3. Select “Show reference clips.”

The master clips used in the sequence appear in the bin.

4. Check the resolution for any master clips in the Video column in Text view in the bin.
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Troubleshooting Titles
To correct a title’s resolution to match the resolution used in the video clips in the sequence, use 
the procedure described in “Re-creating Title Media” on page 364.

Using Filtering for HD Titles

Titles created with the Title Tool or Marquee in an HD project might display undershoots and 
overshoots in the SD signal after you downconvert and output a sequence. This problem might also 
occur with imported animated graphics that contain an alpha channel (except for QuickTime 
imports). You can avoid this problem by using a console command to filter HD titles and imported 
graphics.

The HD title filter is disabled by default, and entering this command enables it. Note the following:

• Enter the command before creating titles or importing animated graphics. The command does 
not affect media already created.

• Using the title filter might result in a slight softening of sharp transitions between dark colors and 
light colors.

To turn on HD title filtering:

1. Select Tools > Console.

2. Enter HDTitleFilter.

This command works as a toggle, so the filter remains on until you type the command again.

Controlling Character Mapping for Title Text

Recent versions of Avid editing applications use different default character mappings from older 
versions. Some text objects might not display correctly when you open or edit them in the current 
version of Media Composer. In particular:

• Greek text objects created in older versions do not display correctly in recent versions.

• Certain characters, such as superscripts or other characters you enter using Alt key sequences, 
might not display correctly.

If you experience these problems, you can switch to the older, “classic” character mappings.

To turn classic character mapping on or off:

1. Ensure that the Title Tool is closed.

2. Select File > Settings, click the User tab and double-click Interface.

The Interface Settings dialog box opens.

3. Click the General tab.

4. Select or deselect “Use Classic Character Mapping.”

5. Open the Title Tool, switch to a different font, and then switch back to the font you need.

This action clears any cached font information and ensures that the character mapping change 
takes effect. For more information, see “Selecting a Font” on page 326.
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14 Working with the SubCap Effect

This chapter provides information on the SubCap™ captioning and subtitling effect.

• Understanding the SubCap Effect

• How the SubCap Effect Handles Caption Files

• Applying the SubCap Effect

• Entering Caption Text Directly in the Effect Editor

• Importing a Caption File

• Adding Information to a SubCap Effect

• Editing Text in the Master Caption List

• Adjusting SubCap Effect Parameters

• Synchronizing SubCap Effect Parameters and Information

• Exporting SubCap Effect Data to Caption Files

• Working with Unicode Text in the SubCap Effect

• Working with SubCap Effect Stylesheets

• Examples of SubCap Effect Parameter Adjustments

Understanding the SubCap Effect
You use the SubCap effect to add text to the video in your sequences, either by entering text directly 
or by importing text from files formatted in standard captioning formats.

The SubCap effect composites text and any background effects such as drop shadows or background 
boxes into the video material. The text becomes a permanent part of the finished video material and 
is always visible. The text in a SubCap effect is therefore a form of open captioning, a common 
industry term that refers to captioning that is always visible to the viewer.



How the SubCap Effect Handles Caption Files
n The SubCap effect does not provide closed captioning capabilities. Closed captioning encodes text 
information into the video signal instead of compositing it into the video frames themselves. A viewer 
can choose whether or not their television or other decoding equipment decodes this text information 
and displays it on screen.

The SubCap effect is typically used for two different types of text information:

• Text that provides a translation of the spoken dialogue in a program.

This case assumes a viewer who can hear the audio for the program but cannot understand the 
language in which it is spoken. Text items of this kind are usually known as subtitles in North 
America.

• Text that provides a full description of all the audio content in a program.

This case assumes a viewer who cannot hear the audio for the program and so needs a 
description not only of the spoken dialog but also of sound effects and the character of the music. 
Text items of this kind are usually known as captions in North America.

You might use the SubCap effect to create text that becomes part of the finished program. 
Alternatively, you might use the SubCap effect to create text that provides a preview during your 
production process but that is replaced in the finished program by closed caption text that is encoded 
into the video signal.

The SubCap effect has the following main features:

• Support for the EBU N19 (.stl) and the Avid DS caption file formats, including the storage of 
metadata such as contact and program information.

• Support for Unicode text entry.

• Parameter control over many aspects of text appearance, including fonts, colors, line length, and 
line spacing.

• Ability to apply parameter changes made on one caption effect clip to all other caption effect 
clips on the current track or throughout the sequence.

• Ability to save sets of parameter values for any caption effect clip as a stylesheet file that you can 
then apply to other caption effect clips in the same or other sequences.

How the SubCap Effect Handles Caption Files
Caption files contain a series of caption text items associated with starting and ending timecode 
values. They might also contain additional information about the project or about the formatting of 
the text. For example, the following sample shows two text items and their associated timecode in an 
Avid DS caption file:

00:00:02:00 00:00:03:00
Bob, are you there?

00:00:04:18 00:00:06:13
Yes, Sam.
Just behind the car.

When you import a caption file into a SubCap effect, Media Composer subdivides the effect at the 
timecode points specified by the file. This creates a series of separate effects, one for each caption. 
The following illustration shows this process for the file sample above:
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Applying the SubCap Effect
Before (above) and after (below) importing a caption file. Before the import, the SubCap effect occupies the
full length of its own caption track (white), above all the video tracks (gray). After the import, the
caption track is automatically subdivided, creating separate effects for each caption. For the first effect,
the text reads “Bob, are you there?” For the second effect, the text begins “Yes, Sam.”

The importing and subdividing process depends on a correspondence between the timecode values in 
the caption file and the timecode values for the effect clip. In the preceding example, importing the 
caption file successfully subdivides the caption track because the timecode range of the original 
effect (00:00:00:00 to 00:08:00:00) includes all of the specific timecode values in the caption 
file. If the timecode range of the original effect were different (for example, if the sequence timecode 
began at 00:30:00:00), the import could not take place.

The dialog box you use to import a caption file provides you with information about the timecode 
ranges of the file and the effect, and reports what the result of the import will be. This information 
lets you see in advance whether an import will be successful. For more information on importing a 
caption file, see “Importing a Caption File” on page 372.

The following illustrations show two examples of this information in the “Select a file that contains 
caption data” dialog box. In the first case, timecode values correspond and the import will be 
successful; in the second case, timecode values are inconsistent and no import will occur.

Applying the SubCap Effect
The SubCap effect is available from the Caption category in the Effect Palette. You can apply the 
effect in any of the standard ways, for example, by dragging the effect icon from the Effect Palette 
onto the Timeline. For more information, see “Applying Effects” on page 27.

0 1 2 3 4 5 6 7 8

02:00 03:00 04:18 06:13
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Applying the SubCap Effect
You apply the SubCap effect to a video track above all the other video material in your sequence. In 
some circumstances (for example, for translations into more than one language) you might apply 
different instances of the effect to different tracks, and then turn the tracks on or off as necessary to 
create different language outputs.

Depending on how you plan to add text to the effect, you might need to divide the video track into 
segments using Add Edits:

• If you are adding text by typing it in directly, you must divide the video track at the points where 
you want the text to appear and disappear. To add captions to an entire sequence in this way, you 
must divide the video track into a series of segments that correspond to the points in the video 
material where you want each caption to begin and end.

• If you are adding text by importing a caption file, you only need to divide the video track at the 
points where you want the captions as a whole to begin and end. If you want captions to appear 
for the entire length of the sequence, you do not need to divide the track. When you import the 
caption file, Media Composer further subdivides the segment to which you apply the effect, 
based on the timecode information for each text item in the caption file.

To apply a SubCap effect for direct text entry:

1. (Option) If necessary, create a new video track in the Timeline.

For example, right-click in the Timeline and select New Video Track.

2. Ensure that the video track to which you want to apply the effect is the only selected track.

3. Move the position indicator to the point in the sequence where you want the caption text to 
appear.

4. Click the Add Edit button to add an edit point.

5. Move the position indicator to the point in the sequence where you want the caption text to 
disappear.

6. Click the Add Edit button to add an edit point.

7. Select Tools > Effect Palette and then select the Generator category.

8. Drag the SubCap effect to the segment in the Timeline created by the two Add Edits.

To apply a SubCap effect for import of a subtitles file:

1. (Option) If necessary, create a new video track in the Timeline.

For example, right-click in the Timeline and select New Video Track.

2. Ensure that the video track to which you want to apply the effect is the only selected track.

3. (Option) If you want captions from the imported file to apply to only part of the sequence, do the 
following:

a. Move the position indicator to the point in the sequence where you want captions defined in 
the caption file to start.

b. Click the Add Edit button to add an edit point.

c. Move the position indicator to the point in the sequence where you want captions defined in 
the caption file to end.

d. Click the Add Edit button to add an edit point.

4. Select Tools > Effect Palette and then select the Generator category.
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Entering Caption Text Directly in the Effect Editor
5. Do one of the following:

a. Drag the SubCap effect to the video track to which you want to apply the effect.

b. Drag the SubCap effect to the segment in the Timeline that you created in step 3.

Entering Caption Text Directly in the Effect Editor
You can enter caption text directly in the Effect Editor.

Direct text entry in the Effect Editor has the following limitations:

• You cannot enter line breaks (carriage returns) in the Effect Editor text box. (You can insert line 
breaks directly in the Edit Master Caption List dialog box.)

• You can enter Unicode characters only as references. (You can enter Unicode characters directly 
in the Edit Master Caption List dialog box.)

• On the Macintosh, you might need to change the default system font to a font that supports all 
the characters you want to enter.

For more information, see “Editing Text in the Master Caption List” on page 374 and “Working with 
Unicode Text in the SubCap Effect” on page 377.

To enter caption text directly in the Effect Editor:

1. Move the position indicator to the SubCap effect to which you want to add text, and ensure that 
the track containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. In the Caption Text parameter category, enter the text in the text box.

Importing a Caption File
To import a caption file:

1. Follow the second procedure in “Applying the SubCap Effect” on page 370 to create a SubCap 
effect that covers the part of the sequence you want to caption.

2. Move the position indicator to the effect you created in step 1, and ensure that the track 
containing the effect is selected.

3. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

4. In the Caption Files parameter category, click Import Caption Data.

The “Select a file that contains caption data” dialog box opens.
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Adding Information to a SubCap Effect
5. Navigate to the location of the caption file you want to import.

6. From the Files of type menu (Windows) or the Enable menu (Macintosh), select the file type of 
the caption file you want to import:

- EBU N19

- Avid DS

7. In the list of files, select the caption file you want to import.

At the bottom of the dialog box, the Selected File Start and End boxes display the timecode 
range for the captions in the file — the starting timecode for the first caption in the file and the 
ending timecode for the last caption in the file. A message below these boxes indicates how 
many captions will be spliced into the sequence, or explains why importing the selected file into 
the effect will not be successful.

For more information on how the SubCap effect handles timecode ranges in caption files, see 
“How the SubCap Effect Handles Caption Files” on page 369.

8. Do one of the following:

t If you want to proceed with the import, click Open.

t If you do not want to proceed with the import, select another file to import, or click Cancel.

If you click Open, Media Composer creates edit points and adds a new instance of the SubCap 
effect for each caption in the caption file. For each of these effects, Media Composer imports the 
appropriate caption text from the caption file.

Adding Information to a SubCap Effect
You can add information to a SubCap effect, including standard information categories such as 
program title and editor’s name, as well as custom data that you define.
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Editing Text in the Master Caption List
You can use settings in the Synchronize tab of the Global Properties dialog box to propagate the 
information changes you make in one instance of the SubCap effect in a sequence, either to all 
instances of the SubCap effect on the current track, or to all instances anywhere in the sequence. For 
more information, see “Synchronizing SubCap Effect Parameters and Information” on page 375.

If you export the caption data from your sequence to the EBU N19 (.stl) format, any information that 
you add to SubCap effects is included in the file along with the caption text and timecode data. For 
more information, see “Exporting SubCap Effect Data to Caption Files” on page 376.

To add information to a caption effect:

1. Move the position indicator to the SubCap effect to which you want to add information, and 
ensure that the track containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. In the Effect Editor, click Edit Global Properties.

The Global Properties dialog box opens.

4. In the Contacts, Custom, and Program tabs, enter information in the appropriate categories.

For information on the categories and limitations on the length of text that you can enter, see 
“SubCap Effect Global Properties” on page 505.

5. Click OK.

Editing Text in the Master Caption List
You can view a list of all the captions in a sequence in the Master Captions List, and edit any of the 
captions from the list.

The Master Captions List also lets you modify text in the following ways that are not available in the 
Caption Text text box in the Effect Editor:

• Enter line breaks (carriage returns) in the text.

• Type Unicode characters directly.

For more information, see “Working with Unicode Text in the SubCap Effect” on page 377.

To edit text in the Master Caption List:

1. Move the position indicator to any instance of the SubCap effect in the sequence, and ensure that 
the track containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. In the Caption Text parameter category, click Edit Master Caption List.

The Edit Master Captions List dialog box opens. The dialog box lists the video track, timecode 
range, and caption text for each caption in the sequence.

4. For each caption you want to edit, modify the text in the caption text box.

Press Enter (Windows) or Return (Macintosh) to enter a line break.

5. When you have finished editing all the captions you need to modify, click OK.
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Adjusting SubCap Effect Parameters
Adjusting SubCap Effect Parameters
The SubCap effect has a full range of parameter controls for adjusting the appearance of the caption 
text and its background box.

You can also change the position of the caption text and its background box on the screen by 
manipulating an anchor point directly in the Effect Preview monitor.

When you make adjustments to the parameter controls for a single SubCap effect in a sequence, you 
might want to have your changes apply to other instances of the SubCap effect in the same sequence. 
For more information on how to do this, see “Synchronizing SubCap Effect Parameters and 
Information” on page 375.

To adjust a SubCap effect’s parameters in the Effect Editor:

1. Move the position indicator to the SubCap effect in the sequence, and ensure that the track 
containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. Adjust one or more of the parameter controls in the Effect Editor.

For general information on working with parameter controls in the Effect Editor, see “Effect 
Editor Controls” on page 69.

For reference information on the parameter controls for the SubCap effect, see “SubCap Effect 
Parameters” on page 502.

Synchronizing SubCap Effect Parameters and 
Information

In most circumstances, you probably want the formatting and the additional information stored in all 
the SubCap effect clips in a sequence to be the same. When you change parameter values or global 
properties in one SubCap effect clip, you want all the other instances on that caption track, or all the 
other instances anywhere in the sequence, to update automatically.

The SubCap effect refers to such updating as synchronizing. You can customize how synchronizing 
operates for each effect parameter in the Effect Editor and for each information item in the Contacts, 
Custom, and Program tabs of the Global Properties dialog box.

To control how SubCap effect parameters and information items synchronize:

1. Move the position indicator to any instance of the SubCap effect in the sequence, and ensure that 
the track containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. Click Edit Global Properties.

The Global Properties dialog box opens.

4. Click the Synchronize tab.
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Exporting SubCap Effect Data to Caption Files
5. For each effect parameter or information type in the list, select one of the following:

6. Click OK.

Exporting SubCap Effect Data to Caption Files
You can export caption data to a caption file. The caption data is then available for use outside the 
current sequence. For example, you might import it into another version of the sequence, or use it 
with captioning software other than Media Composer. You can export to either of the file formats 
supported by the SubCap effect.

If you export to an EBU N19 (.stl) caption file, any additional information that you have entered in 
the Contacts, Custom, or Program tabs of the Global Properties dialog box is exported along with the 
caption text and timecode information. For more information on entering additional information, see 
“Adding Information to a SubCap Effect” on page 373.

If you export to an Avid DS caption file, only the caption text and timecode information is exported.

When you export caption data to a caption file, all of the caption data in the sequence is available for 
export. However, you can select which caption tracks to include in the export, and you can determine 
how the export resolves conflicts between captions on different tracks that overlap in time (a caption 
file can have only one caption for any given timecode range).

Option Description

Clip Changes to this item remain unique to the current effect clip and are not copied 
to any other SubCap effect clips in the sequence.

Track Changes to this item are copied to any other SubCap effect clips on the track 
containing the current clip, but not to those on any other tracks in the sequence.

Sequence Changes to this item are copied to all other SubCap effect clips in the sequence.
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Working with Unicode Text in the SubCap Effect
To export caption data to a caption file:

1. Move the position indicator to any instance of the SubCap effect in the sequence, and ensure that 
the track containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. In the Caption Files parameter category, click Export Caption Data.

The “Export caption data to the specified file” dialog box opens.

4. Navigate to the location where you want to store the exported file.

5. In the File name text box, enter a name for the caption file.

6. From the Files of type menu (Windows) or the Enable menu (Macintosh), select the caption file 
format you need, either EBU N19 or Avid DS.

7. Click Save.

Media Composer exports the caption data to the caption file.

Working with Unicode Text in the SubCap Effect
You can type Unicode text in the SubCap effect, for example, to create text that uses non-Western 
characters. To type Unicode text, you must use a font that includes the Unicode characters you need.

You cannot type Unicode text directly into the Caption Text text box in the Effect Editor. Instead, you 
type Unicode text in the Master Captions List, as described in “Editing Text in the Master Caption 
List” on page 374.

Unicode text that you type in a caption in the Master Captions List displays in the Effect Editor’s 
Caption Text text box as references — sequences of hexadecimal characters preceded by an 
ampersand. For example, the Japanese Katakana character that transliterates as Na displays in the 
Caption Text text box as &30ca. Unless you are very familiar with these character codes, it is always 
better to view and edit Unicode text in the Master Captions List.
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Working with SubCap Effect Stylesheets
Working with SubCap Effect Stylesheets
You can save the current parameter values and information items for any SubCap effect clip as a 
stylesheet. You can then apply the values from a stylesheet to any SubCap effect clip. You can also 
set a stylesheet as the default to use when you create a new SubCap effect clip — all of the parameter 
values and information items from the default stylesheet are used as the initial values for the new 
effect clip, taking the place of the Avid-defined defaults.

Stylesheets let you maintain consistent formatting and metadata across many different sequences and 
projects. For example, they ensure that the caption style is the same for every episode of a television 
program or that every caption effect you create starts with the same look.

n Caption stylesheets are XML files and are stored in a folder called Caption Effect Stylesheets inside 
the AVX2_Plug-Ins folder in the application folder for Media Composer. If you are comfortable 
editing XML files, you can edit caption stylesheets directly in any text editor.

You manage SubCap effect stylesheets in the Stylesheets tab of the Global Properties dialog box.

To create a new SubCap effect stylesheet:

1. Move the position indicator to the SubCap effect clip in the sequence that contains the parameter 
values and information items you want to save, and ensure that the track containing the effect is 
selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. Click Edit Global Properties.

4. Click the Stylesheets tab.

5. Click Create.

The Add New Stylesheet dialog box opens.

6. Type a name for the stylesheet in the Stylesheet Name text box, and click OK.

The new stylesheet appears in the list of stylesheets.

7. Click OK.
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Examples of SubCap Effect Parameter Adjustments
To delete a SubCap effect stylesheet:

1. Move the position indicator to any SubCap effect clip in a sequence, and ensure that the track 
containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. Click Edit Global Properties.

4. Click the Stylesheets tab.

5. Select the stylesheet you want to delete in the stylesheet list.

6. Click Delete.

The stylesheet is removed from the list.

7. Click OK.

To apply a SubCap effect stylesheet:

1. Move the position indicator to the SubCap effect clip in the sequence to which you want to apply 
the stylesheet values, and ensure that the track containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. Click Edit Global Properties.

4. Click the Stylesheets tab.

5. Select the stylesheet you want to apply in the stylesheet list.

6. Click Apply.

7. Click OK.

The values from the stylesheet are applied to the effect clip and are reflected on the Effect 
Editor’s parameter controls and in the Contacts, Custom, and Program tabs in the Global 
Properties dialog box.

To set a SubCap effect stylesheet as the default for new SubCap effect clips:

1. Move the position indicator to any SubCap effect clip in a sequence, and ensure that the track 
containing the effect is selected.

2. If it is not already open, open the Effect Editor, for example, by clicking the Effect Mode button.

3. Click Edit Global Properties.

4. Click the Stylesheets tab.

5. Select the stylesheet you want to use as the default in the stylesheet list.

6. Click Set Default.

7. Click OK.

8. Restart Media Composer.

After the restart, the stylesheet you selected becomes the default. Its values become the default 
settings for any new SubCap effect clip.

Examples of SubCap Effect Parameter Adjustments
This topic provides two examples of caption text formatting. The examples illustrate and compare the 
effect of certain parameter changes on the appearance of caption text. They are not intended to 
represent an ideal finished look.
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Examples of SubCap Effect Parameter Adjustments
For more information on SubCap effect parameters, see “Adjusting SubCap Effect Parameters” on 
page 375 and “Generator Effect Parameters” on page 501.

Example 1

This example uses a single box as background for the entire text, a custom shadow, and keeps the 
Avid default settings for padding and row spacing. The following are the important parameter values 
that contribute to the look of the example:

Parameter Value

Font Face Arial Black

Font Size 20

Text Shadow Custom (Radius 0.5, Angle 5.5)

Text Alignment Center

Box Color and Opacity R, G, and B all 95, Opacity 0.8

Box Style One Box

Anchor Box to Anchor to Bottom of Text

Box Width Fixed Width (Wrap), Width 590

Padding Vertical 2, Horizontal 3

Row Spacing 0
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Examples of SubCap Effect Parameter Adjustments
Example 2

This example uses a separate box for each row of the text, does not use a shadow, and uses custom 
values for padding and row spacing that allow the boxes to frame the text more elegantly than 
Example 1. The following are the important parameter values that contribute to the look of the 
example:

Parameter Value

Font Face Georgia

Font Size 20

Text Shadow No Shadow

Text Alignment Left

Box Style Separate Boxes for Each Row

Anchor Box to Anchor to Top of Text

Box Width Each Row as Wide as Needed

Padding Vertical 10, Horizontal 20

Row Spacing 15
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15 Intraframe Editing

This chapter provides information on the intraframe editing features of Media Composer. 

• Understanding the Intraframe Effects

• Rendering Intraframe Effects

• Applying the Paint or AniMatte Effect to a Sequence

• Effect Editor Reference for the Paint and AniMatte Effects

• Using the Intraframe Drawing Tools

• Working with Vector-Based Objects

• Using the Previsualization Marker Tool for Film Projects

• Manipulating Intraframe Objects

• Layering, Grouping, and Locking Intraframe Objects

• Exporting a Matte Key Created With the AniMatte Effect

• Scratch Removal

• Intraframe Editing Examples

• Working with the Blur Effect and Mosaic Effect

Understanding the Intraframe Effects
You can use the Paint Effect and the AniMatte effect to perform paint or animated matte effect 
operations within an individual frame or series of frames in a clip. You can also use the Scratch 
Removal effect to remove scratches and flaws from your video material, and the Blur and Mosaic 
effects to obscure part of an image by distorting the pixels within a defined area.

While many of the tools and parameters are the same for all the Intraframe effects, the result of 
applying each effect is different.

Media Composer draws vector-based objects on the screen when you use Intraframe effects. Vector-
based objects are composed of mathematically described lines and Bézier curves. You can edit 
vector-based graphics with greater control and efficiency than you can bitmapped objects, which are 
drawn on the screen as a pattern of pixels. For more information, see “Working with Vector-Based 
Objects” on page 396.

Changes you make to an Intraframe effect are not limited to an individual frame. Any object you 
paint and any changes you make to it appear for the duration of the segment or clip. In most cases, 
you can change the parameters of the effect between keyframes, for example, to change the shape of 
the object or reposition it over time.

You can create multiple paint or matte shapes within a single effect. You can also add keyframes and 
apply effects separately to each of the shapes.



Rendering Intraframe Effects
Paint Effect

The Paint Effect includes the following features:

• Creation of vector-based objects that you can animate and edit.

• Customizable paint brushes with preset templates and parameters for adjustable softness and 
rotation.

• A variety of paint modes including Blur, Clone, Colorize, Darken, Emboss, Erase, Lighten, 
Mosaic, Scratch Removal, and Unsharp Mask.

• Object selection with rescale, lock/unlock, and group/ungroup capabilities.

• Z-rotation of painted objects.

• Outline feathering with bias control.

• Magic Mask™ for quick and easy colorization.

AniMatte Effect

The AniMatte effect includes the following features:

• Keyframeable animation of matte effects.

• Modes for keying in and keying out images.

• Creation of mattes as vector-based objects that let you move, rescale, and reshape the mattes 
during a segment or transition.

• Freehand painting ability to create organic matte wipes.

• Magic Mask, brush shapes, Z-rotation, and feathering.

• Export of mattes to create keys in third-party applications.

Scratch Removal Effect

The Scratch Removal effect lets you remove scratches or other flaws by replacing them with clean 
material from elsewhere in the same frame or from another nearby frame. The Scratch Removal 
effect includes the same tools for drawing objects and painting brush strokes found in the Paint 
Effect, together with specific controls for selecting clean replacement material. For more 
information, see “Understanding Scratch Removal” on page 411.

Blur Effect and Mosaic Effect

The Blur effect and Mosaic effect let you obscure parts of an image by distorting pixels. The Blur 
parameter category for the Blur effect is the same as the one that appears for the Blur mode of the 
Paint Effect. The Mosaic parameter category for the Mosaic effect is the same as the one that appears 
for the Mosaic mode of the Paint Effect. For more information, see “Working with the Blur Effect 
and Mosaic Effect” on page 432.

Rendering Intraframe Effects
Intraframe effects are non-real-time effects. After you paint or draw a matte on a segment, you must 
render the effect to play it in real time. Regardless of how many objects you add to an individual 
segment, the effect plays back as a single stream of video. For more information, see “Basics of 
Effects Rendering” on page 41.
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Applying the Paint or AniMatte Effect to a Sequence
In Effect mode, you can see the object as you step through each frame in the segment if Render On-
the-Fly is selected in the Composer menu.

You can also use the Play Preview function to preview a Paint Effect while you are working in Effect 
mode. For more information, see “Effect Editor Controls” on page 69.

Media Composer renders painted objects to the screen starting with the bottom layer (closest to the 
video background).

Media Composer renders a multitrack AniMatte effect to the screen starting with the top video track 
(farthest from the video background and appearing closest to you in three-dimensional space). For 
example, if the video background is on track V1, and you apply the AniMatte effect to track V2, the 
effect renders starting with the image on track V2.

However, if you draw multiple mattes in the same segment, these mattes are all objects that appear in 
the same foreground space, and they interact with each other much like multiple painted objects do in 
the same segment. For more information, see “Layering, Grouping, and Locking Intraframe Objects” 
on page 408.

Remember these concepts as you use multiple objects and key modes in combination and layer them 
to generate new effects in a sequence. You can also combine the AniMatte effect with the Paint Effect 
to create custom effects.

Applying the Paint or AniMatte Effect to a Sequence
To apply the Paint Effect or AniMatte effect to a sequence:

1. Load a sequence into the Record monitor.

For information, see “Creating and Editing Sequences” in the Help.

2. Enter Effect mode by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. Do one of the following:

t To apply the Paint Effect, drag the Paint Effect icon from the Image category in the Effect 
Palette to a segment in the sequence.

The Paint Effect is a segment effect only. You cannot apply a Paint Effect to a transition.

t To apply the AniMatte Effect, drag the AniMatte effect icon from the Key category in the 
Effect Palette to a transition or a segment in the sequence.

You can apply an AniMatte effect to segments for multilayered effects or to transitions to 
create matte key wipes with your own custom shapes. (For information on creating keys, see 
“Key Effects” on page 196.) 

The Effect Editor displays the default settings for the effect. Parameter sliders do not appear until 
you select one of the corresponding tools from the right side of the Effect Editor.
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Effect Editor Reference for the Paint and AniMatte Effects
Effect Editor Reference for the Paint and AniMatte 
Effects

The following illustration identifies the different components of the Effect Editor that appear when 
you apply a Paint Effect to a segment in a video project and enter Effect mode.

The following table briefly describes the components of the Effect Editor for the Paint Effect.

For basic information on working with the Effect Editor, see “Using the Effect Editor” on page 68.
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Effect Editor Reference for the Paint and AniMatte Effects
Component Description

1 Effect parameter 
categories

Enable you to change the parameters of an effect.

The same categories are available for both the Paint Effect and the AniMatte 
effect, with the following exceptions:

• The AniMatte effect includes a Swap Src (swap sources) button in the 
Foreground parameter category that enables you to swap the foreground 
and background video images for matte keys composed of multiple video 
tracks. When you are building a single-track wipe, the Swap Src button 
enables you to swap the incoming and outgoing segments in the sequence.

• The Magic Mask parameter category functions differently in the two 
effects. In the Paint Effect, you use the Magic Mask parameter category or 
the Color parameter category to make color selections. In the AniMatte 
effect, you use the Magic Mask parameter category to select a key color 
when you create a matte.

2 Brush Shape 
buttons

Change the shape of the brush.

3 Render Effect 
button

Renders effects on selected tracks at the location of the position indicator in 
the effect’s Timeline.

4 Outline/Path 
button

Displays wire-frame representations of the painted object. Illustrates the 
movement of an object from the first keyframe through the last keyframe.

5 Transition Effect 
Alignment button

You can use the alignment button to quickly reposition an effect so that it 
either ends at the cut, is centered on the cut, or starts at the cut.

6 Brush Preview 
window

Displays the brush head with the parameters you select, such as color and 
shape. You also can use the window to reshape the brush head by dragging its 
control points.

7 Selection tool Selects an object so that you can change its parameters, move it, or delete it. 
With the Shift key pressed, selects multiple objects. 

8 Z-Rotation button Rotates an object around the Z axis.

9 Reshape button Reshapes objects by manipulating anchor points at locations where new 
curves begin or straight lines intersect. Inserts additional control points.

10 Bring Forward 
button and 
Send Backward 
button

Bring a painted object one layer forward on the screen or send an object one 
layer backward on the screen. With the Alt key (Windows) or Option key 
(Macintosh) pressed, bring a painted object to the front or send an object to 
the back.

11 Painting tool and 
Editing tool 
buttons

Enable you to paint shapes or draw mattes on frames in a sequence with 
freehand capability or with preset shapes.

12 HQ Button Controls rendering quality for a small number of 3D effects.
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Using the Intraframe Drawing Tools
You can use the Intraframe drawing tools for creating preset shapes or for creating freehand, vector-
based objects and mattes with editable lines and Bézier curves. Additionally, the Selection tool 
enables you to select painted objects and mattes to move them, rescale them, and change their 
parameters.

Top to bottom: Rectangle, Oval, Polygon, Curve, and Brush tools in the Effect Editor

n The parameter sliders do not appear until you select the corresponding drawing tool.

Media Composer supports the use of a pen tool and graphics tablet with Intraframe drawing tools. 
For installation and configuration instructions, see the documentation that ships with your pen tool 
and tablet.

When you work with a Paint or AniMatte effect in Effect mode, the pointer is the normal arrow when 
you select tools and options from the Effect Editor. However, once you select a paint or editing tool 
and position the pointer over the Effect Preview monitor, the pointer changes to a crosshair. This 
indicates that you can begin to paint or draw a matte on the frame.

n After you use the Rectangle, Oval, Polygon, and Curve tools, Media Composer reverts to the 
Selection tool, and the pointer changes to an arrow. After you use the Brush tool, it remains the active 
tool, and the pointer remains a crosshair.

Understanding Intraframe Modes

The Paint Effect includes a wide variety of modes that offer many creative and corrective 
possibilities. Modes control the nature and appearance of the objects that you create with the drawing 
tools.

For example, if you create an oval shape with the Solid mode selected, a solid color oval appears in 
the frame. If you create the same oval shape and select the Lighten mode, the oval is not a solid color 
that masks part of the image beneath. Instead, it defines an area of the image that is lightened by an 
amount you specify.

13 Tracking Tool 
button

Opens the Tracking Window, allowing you to generate and modify motion 
tracking data. For more information, see “Motion Tracking and Stabilization” 
on page 240.

Previsualization 
Marker tool

Available only in film projects. See “Using the Previsualization Marker Tool 
for Film Projects” on page 404.

14 Grid button Displays the Effect Grid. See “Understanding the Effect Grid” on page 64.

Component Description
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The AniMatte effect provides two modes, Key In and Key Out. These modes enable you to key in or 
key out an image in a sequence.

n For a complete listing of the characteristics of each Paint Effect mode as well as the Key In and Key 
Out modes in the AniMatte effect, see “Paint Effect Modes” on page 540 and “AniMatte Effect Mode 
Parameters” on page 550.

Understanding the Brush Tool

The Brush tool lets you use the mouse or a pen tool with a tablet to paint objects or mattes with 
precision directly on the images in a sequence. You also can change and customize the brush shape, 
determine the opacity of the paint or matte, adjust the outline feathering and softness values, and, for 
the Paint Effect, define the color.

You paint an object on the frame that displays in the Effect Preview monitor. The painted object is 
superimposed over the video background, appearing closer to you in three-dimensional space. Each 
object you paint is on its own foreground layer that you can work with individually or that you can 
group with other painted objects in the segment.

Example of a painted line over a gray background.

Selecting a Color for the Brush Tool

You can select the color that the Brush Tool uses by using the eyedropper, the parameter sliders, the 
Windows Color dialog box, or the Macintosh Colors panel. You can select the color before you begin 
painting or after you have painted an object. For more information, see “Adjusting a Color Parameter 
for an Effect” on page 74.

When you use the Brush tool to paint an object, you can select a color quickly from a video segment.

To select a color from a video segment when using the Brush tool:

1. In the Effect Editor, click the Brush tool to make it the active paint tool.

2. In the Mode category, click the Fast Menu button, and then select Solid.

3. Press and hold the Alt key (Windows) or Option key (Macintosh), and drag the pointer to the 
Effect Preview monitor.

The pointer becomes an eyedropper.

4. Position the eyedropper over the color you want to select, and click it.

The color you pick becomes the new default color shown in the Color Preview window.

Painting with the Brush Tool

To begin painting with the Brush tool:

1. Apply the Paint Effect to a segment in the sequence as described in “Applying the Paint or 
AniMatte Effect to a Sequence” on page 384.

2. Click the Brush tool in the Effect Editor.

3. Select a paint mode or key mode and parameters in the Effect Editor.
388



Using the Intraframe Drawing Tools
4. In the Brush parameter category of the Effect Editor, click one of the Brush Shape buttons.

Brush Shape tools in the Effect Editor

The default shape of the brush head changes to your selection. 

5. Position the pointer over the image in the Effect Preview monitor. 

The pointer becomes a crosshair.

6. Press and hold the mouse button, and drag to paint freehand style on the video background.

7. Release the mouse button when you have finished painting the object.

Creating a Custom Brush Head

You can change the brush head to a custom shape by modifying the brush head in the Brush Preview 
window.

To create a custom brush head:

1. Click the Brush tool in the Effect Editor.

2. Click a Brush Shape button to use as the basis for your custom brush head.

The shape appears as the brush head in the Brush Preview window.

3. In the Brush Preview window, click the brush head.

Control points appear on the brush head where curves merge or straight lines intersect.

n You might need to increase the Size value for the brush head, for example to a value over 20, in order 
to see the control points. You can reduce the size of your custom brush head once you have adjusted 
its shape.
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4. Click a control point, and drag it to change the shape of the brush head.

5. Repeat step 4 with other anchor points until you have the shape you need.

n For brush shapes with rounded edges and curves, such as the oval, the ellipse, and the circle, clicking 
an anchor point creates direction bars and handles that enable you to edit the Bézier curve. For 
information on working with Bézier curves, see “Working with Vector-Based Objects” on page 396. 
You can use the direction bars and handles, and you can drag the object’s control points, but you 
cannot use the modifier key variations.

To rotate the brush head:

1. Click the Brush tool if the brush is not already active.

2. Click the Brush Shape button for the brush head you want to rotate.

The shape appears in the Brush Preview window.

3. Do one of the following:

t Drag the Spin slider to the right (clockwise rotation) or to the left (counterclockwise 
rotation) to rotate the brush head to the position you want.

t Click the Spin slider, and use the numeric keypad to type a value from –360 to 360.

Saving and Applying Brush Templates

You can save a template of a custom brush to a bin so that you can reuse the parameters of the brush 
with an Intraframe effect.

To save a brush template:

1. In the Brush category, click the Brush Template icon, and then drag it to a bin.

A brush template appears in the bin, and the name of the template defaults to Brush.

2. Click the name of the template in the bin, type a unique name for the template, and press Enter 
(Windows) or Return (Macintosh).

To use a brush template:

t Click the template in the bin, drag it to the Brush Preview window, and release the mouse button.
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The brush in the Brush Preview window assumes the same parameters as the brush template you 
saved to the bin.

Using the Brush Tool and the Path Parameter to Create a Signature Effect

The Path parameter slider is useful for creating a “signature” effect with the Paint Effect, in which a 
signature gradually appears on the screen as if written with an invisible pen.

To create the signature effect:

1. Apply the Paint Effect to a segment.

2. In the Effect Editor, click the Brush tool.

3. In the Mode category, click the Fast Menu button, and select Solid.

4. Drag the pointer in the Effect Preview monitor to paint a signature or other string of text.

5. Release the mouse button when you are satisfied with the text.

6. Use keyframes with the Path parameter to gradually reveal the text over time.

For example, in the simplest case, set the Path parameter to 0 on a keyframe at the beginning of 
the effect and to 100 on a keyframe at the end of the effect.

7. Render the Paint Effect to play it back in real time.

For more information, see “Basics of Effects Rendering” on page 41.

Creating Rectangular and Oval Shapes

To paint with the Rectangle or Oval tool:

1. In the Effect Editor, click the Rectangle or Oval tool.

2. In the Effect Editor, select a paint mode or key mode and parameters.

3. Position the pointer where you want to begin painting in the frame.

4. Press and hold the mouse button, and drag to create the rectangle or oval.

As you drag, you describe the diagonal of the rectangle or oval. The rectangle or oval’s anchor 
point is the point at which you start to drag. For example, if you drag to the right and down, the 
rectangle or oval is anchored to its upper left corner.

5. Release the mouse button to complete the shape.

6. (Option) Adjust the object’s parameters.
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Creating Shapes with the Polygon Tool

You can use the Polygon tool to paint a variety of create objects and mattes composed of straight-line 
segments, curved segments, or a combination of both.

To take full advantage of the Polygon tool, you should be familiar with the concepts behind vector-
based graphics. For more information, see “Working with Vector-Based Objects” on page 396. 

The general workflow for working with the Polygon tool is:

1. Visualize the shape and position of the object you want to create.

2. Determine a location in the frame to begin painting, and click that location to create the initial 
control point.

3. Click additional control points as you continue to define the shape of the object.

Try to create the object with as few control points as possible. Fewer control points simplify your 
work if you need to modify the object later.

4. Double-click to create the final control point, or click the initial control point to create the closed 
polygon.

To create a polygon with straight-line segments:

1. In the Effect Editor, click the Polygon tool.

2. Select a paint mode or key mode and parameters in the Effect Editor.

3. Click in the frame where you want to place the initial control point.

n The control points do not appear as tiny rectangles while you are painting the object.

4. Click in the frame where you want to place the next control point.

Media Composer draws a straight-line segment between the initial control point and the control 
point you just created.

n Segments appear as wire frames until you finish painting the object.

5. Click in the frame to create additional control points that further define the shape of the object.

A straight-line segment appears between each pair of adjacent control points.

6. When you are satisfied with the shape of the object, double-click in the frame to create the final 
control point or click the initial control point.

The object becomes a closed polygon.

7. (Option) Adjust the parameters of the polygon.

To create an object with curved segments:

1. In the Effect Editor, click the Polygon tool.

2. Select a paint mode or key mode and parameters in the Effect Editor.
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3. Click in the frame where you want to place the initial control point, and release the mouse 
button.

4. Move the pointer to the location where you want to place the next control point.

5. Click and hold the mouse button to begin creating the first curved segment.

Direction bars with handles appear as a tangent to the curved segment. The pointer “leads” the 
direction handle that you use to determine the direction and height of the curve.

6. Drag the pointer, which is attached to the direction handle, to adjust the direction and height of 
the curved segment.

7. Release the mouse button when you are satisfied with the height and angle of the curved 
segment.

8. Move the pointer to the next location where you want to create a curved segment.

9. Repeat steps 3 to 8 to create additional curves if needed.

10. When you are satisfied with the shape of the object, double-click in the frame to create the final 
control point or click the initial control point.

The object becomes closed.

11. (Option) Adjust the parameters of the object.

To create a straight line following a curved segment:

1. Create one or more curved segments as described in the previous procedure.

2. Move the pointer to the location where you want to begin painting the straight line.

3. Click and then release the mouse button to create the control point.

4. Move the pointer to the location where you want the straight-line segment to end.

5. Click and then release the mouse button to create the control point.
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6. Continue to create additional lines and curves.

7. When you are satisfied with the shape of the object, double-click in the frame to create the final 
control point or click the initial control point. 

The object becomes closed.

8. (Option) Adjust the parameters of the object.

Creating Freehand Curved Objects

With the Curve tool, you can trace curved objects with freehand capability.

To paint with the Curve tool:

1. In the Effect Editor, click the Curve tool.

2. Select a paint mode or key mode and parameters in the Effect Editor.

3. Position the pointer where you want to begin painting in the frame.

4. Press and hold the mouse button, and drag the pointer as you paint a freehand curved shape on 
the frame.

5. When you are satisfied with the shape of the object, release the mouse button to complete the 
curved object.

6. Adjust the object’s parameters if needed.

Selecting and Deselecting Intraframe Objects

You can select one or more Intraframe objects, for example to move them in the frame, rescale them, 
or change their parameters. When a segment contains multiple objects, you can use buttons to change 
your selection from one object to another.

To select an object:

t Click the Selection tool, and click an object.

Selection handles appear around the object.
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To select multiple objects, do one of the following:

t Shift+click additional objects with the Selection tool.

t Drag a lasso around the objects you want to select.

When you select multiple objects, one set of selection handles appears around all the objects, 
which enables you to move, rescale, or otherwise change the parameters of all the selected 
objects simultaneously.

To change the selection from one object to another:

t Click one of the following buttons: Go to Next Event, Go to Previous Event

The Go to Next Event and Go to Previous Event buttons are in the Effect Preview Monitor 
toolbar. You can also map them to the keyboard. For more information, see “The Command 
Palette” in the Help.

To delete an object:

1. Click the Selection tool. 

2. Click the object you want to delete.

3. Do one of the following: 

t Press the Delete key.

t Select Edit > Delete.

To undelete an object:

t Select Edit > Undo.

Changing the Parameters of Intraframe Objects

You can change the parameters of an object you have already painted. Select the object (see 
“Selecting and Deselecting Intraframe Objects” on page 394), and perform any of the following 
procedures.

To move an object:

t Click anywhere within the object’s outline, and drag the object to a new location.

To rescale an object, do one of the following:

t Click one of the selection handles and drag.

t Press and hold the Alt key (Windows) or Option key (Macintosh) while you click one of the 
selection handles, and drag to rescale the object from its center.

Selection handles on a rectangular object
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To change the color of an object:

1. Click the triangular opener for the Color parameter category.

2. Adjust the Hue, Sat (saturation), and Lum (luminance) sliders.

To add feathering to an object’s edges:

1. Click the triangular opener for the Feathering parameter category.

2. Adjust the Bias, Hor (horizontal), and Vert (vertical) sliders.

Working with Vector-Based Objects
Intraframe effects are vector-based objects. Vector-based objects have several advantages over 
bitmapped objects. For example, you can create and edit vector-based objects with much greater 
precision than you can bitmapped objects. Also, vector-based objects are not subject to problems 
such as artifacting when you rescale them.

Before you begin working with the paint and editing tools included in the Intraframe effects, you 
must understand the basics of working with vector-based objects and Bézier curves.

The Elements of Vector-Based Objects

The objects you paint, the matte keys you draw, and the brush templates that appear in the Brush 
Preview window include a control point at the midpoint of each line or curve, also known as a join. 
The portion of the line or curve on each side of the control point is called a segment. The control 
point controls the direction of each segment as it passes through the join.

Control points for a painted object are visible when you select an object with the Selection tool and 
then click the Reshape tool. Also, when you click a brush template in the Effect Editor, the brush 
head displays visible control points in the Brush Preview window.
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A control point at the midpoint of a curve

The following illustration shows the three types of joins: 

Left to right: straight-edge join, smooth join, and corner join

A control point associated with a smooth join or a corner join describes a Bézier curve. Clicking a 
control point makes it the active join. Tangents called direction bars appear on each side of the 
control point associated with a Bézier curve. At the end of each direction bar is a direction handle. 

Direction bar with direction handles

Dragging a direction handle changes the way the segments pass through the control point to define 
the curve. When you drag a direction handle, you change the height and angle of the curve. The curve 
responds as if you are gently tugging it like a piece of string. The segments remain anchored to the 
control points on either side of the active join.

Straight-edge joins do not display direction bars and handles when you click them. 

Reshaping an Intraframe Object with Straight Edges

To reshape an object composed of one or more straight edges, do one or more of the 
following:

t Click the Selection tool, click the object to select it, click the Reshape tool, and then drag one or 
more control points.

Selection tool (left) and Reshape tool (right)

For information on control points, see “Moving Control Points” on page 403.

t Convert straight-edge joins to Bézier curves, and then manipulate the curves.

For more information, see the following topics:

- “Experimenting with Bézier Curves and Direction Handles” on page 398

- “Creating a Corner Join on an Intraframe Object” on page 400

- “Reference for Modifying Lines and Curves in Intraframe Objects” on page 401
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Experimenting with Bézier Curves and Direction Handles

This topic provides two procedures that you can use to practice using Bézier curves and their 
direction handles. In the first procedure, you create a rectangle using the Rectangle tool, and then 
transform the rectangle into a circle by converting the straight-edge joins at the corners of the 
rectangle to smooth joins. In the second procedure, you alter the curve segments that comprise the 
circle by manipulating the Bézier direction handles.

To create a rectangle and transform it into a circle with Bézier curves:

1. Apply the Paint Effect to a segment in a sequence.

2. If Media Composer is not in Effect mode, enter Effect mode, for example, by clicking the Effect 
Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. In the Effect Editor, click the Rectangle tool.

4. In the Mode parameter category, click the Fast Menu button, and then select Solid.

5. Press and hold the mouse button, and drag in the Effect Preview monitor to paint a rectangular 
object.

Do not worry about picking a color or other parameters for this exercise.

6. Click the Selection tool, and click the object you just painted.

7. Click the Reshape tool, or double-click the object.

Each corner of the rectangle displays a control point.

8. Alt+click (Windows) or Option+click (Macintosh) the control point at the top left corner of the 
rectangle.

The straight-edge join becomes a smooth join with direction bars and handles.

9. Working in a counterclockwise direction, Alt+click (Windows) or Option+click (Macintosh) 
each control point until they have all been transformed into smooth joins.

The resulting shape is a circle. The control point at the top right of the circle is the active join and 
displays direction bars and handles.
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To experiment with the direction handles:

1. Click the bottom direction handle, and drag away from the control point to increase the length of 
the direction bar.

Notice how the curve changes. Also, the direction bar and segment on the opposite side of the 
control point move in unison with the direction bar you are dragging. The control points adjacent 
to the active join serve as anchor points for the segments that compose the curve.

Example of dragging a direction handle.

2. Drag the direction handle toward the control point to shorten the direction bar.

Notice how the curve changes as you shorten the direction bar.

3. Shift+click the direction handle, and then drag it away from the control point.

Notice that the length of the direction bar on the opposite side of the control point does not 
change. This prevents the height of its associated segment from changing. However, the opposite 
direction bar does move in unison with the direction handle you are dragging, thereby changing 
the angle of the segment in unison.

Example of Shift+dragging a direction handle.

4. Shift+click the direction handle to revert the direction bars to their previous functionality.

5. Click the bottom direction handle, and drag it in a counterclockwise direction.

Notice how the curve changes as you drag the direction bar.
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Example of rotating a direction handle without changing its length.

6. When you have finished experimenting, adjust the direction bar so that the object again 
resembles a circle.

Creating a Corner Join on an Intraframe Object

The painting tools do not create corner joins by default, but you can change an existing smooth join 
into a corner join. The procedure in this topic assumes you are starting with an object like the one 
created by following the procedure in “Experimenting with Bézier Curves and Direction Handles” on 
page 398.

To transform a straight-edge join into a corner join, first transform the straight-edge join into a 
smooth join and then transform the smooth join as described here. For more information, see 
“Reference for Modifying Lines and Curves in Intraframe Objects” on page 401.

To transform a smooth join into a corner join:

1. Alt+click (Windows) or Option+click (Macintosh) the bottom direction handle.

Although you might not notice it immediately, the smooth join is transformed into a corner join.

2. Drag the direction handle away from the control point.

The direction bar and the segment on the opposite side of the control point do not move in unison 
with this direction handle, and the active segment remains anchored to the adjacent control point.

3. Drag the direction handle in a counterclockwise direction.

Notice how the segment changes as you drag the direction bar.
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4. When you are finished experimenting, Alt+click (Windows) or Option+click (Macintosh) the 
direction handle.

The control point reverts to a smooth join.

Reference for Modifying Lines and Curves in Intraframe Objects

The following table summarizes how you can use the mouse and the modifier keys on the keyboard 
to modify lines and Bézier curves (smooth joins or corner joins).

Methods of Modifying Intraframe Lines and Curves

Illustration Description Action

Smooth join: Drag one direction 
handle so that the direction bar on the 
opposite side of the control point 
moves and changes length in unison.

You do not have to press any 
of the modifier keys. Click one 
of the direction handles, and 
drag it.

Smooth join: Drag one direction 
handle so that the direction bar on the 
opposite side of the control point 
moves in unison but does not change 
in length.

Shift+click a direction handle.

To change it back, Shift+click 
the direction handle.

Transform a straight-edge join (left) 
into a smooth join (right).

Alt+click (Windows) or 
Option+click (Macintosh) the 
control point.

To change it back to a 
straight-edge join, 
Alt+click (Windows) or 
Option+click (Macintosh) the 
smooth join.

Transform a smooth join (left) into a 
corner join (right).

Alt+click (Windows) or 
Option+click (Macintosh) one 
of the direction handles.

To change it back to a smooth 
join, Alt+click (Windows) or 
Option+click (Macintosh) the 
direction handle.
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Adding and Removing Control Points

Placing more control points on an object enables the object to trace more detailed images. For 
example, if a segment of an object does not follow a curved section on a frame as well as you would 
like, and adjusting the control points and direction bars does not help, you can add a new control 
point.

Avid recommends that you remove a control point if the object does not need the control point to 
adequately define its shape. It is better to have fewer control points and to manipulate the direction 
bars to gain the same effect because fewer control points mean less work if you need to modify an 
object later.

Unnecessary number of control points (left) and minimum number of control points (right) for describing the curve

To add a control point:

1. Click the Selection tool, and click the object.

2. Do one of the following:

t Click the Reshape tool.

t Double-click the object.

3. Click the selected object where you want to add a new control point.

A new control point appears and is calculated so that the object does not change dramatically in 
shape. The new control point appears as part of the object for all keyframes in the segment. 

Any changes you make to a control point, such as moving it or changing the angle of the 
associated curve, affect the keyframes you have selected in the segment. If you change a control 
point at a selected keyframe or add a keyframe to make changes, the changes are interpolated 
between the selected keyframe and adjacent keyframes.

To remove a control point:

t Click the control point, and press the Delete key.

To remove multiple control points:

t Shift+click the control points, and then press the Delete key.

Corner join: Drag one direction 
handle so that the direction bar on the 
opposite side of the control point 
moves independently of the bar on the 
opposite side of the control point.

You do not have to press any 
of the modifier keys. Click one 
of the direction handles, and 
drag it.

Methods of Modifying Intraframe Lines and Curves(Continued)

Illustration Description Action
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Media Composer attempts to reconstruct the object so that it does not change. The results you 
see might vary because of the internal mechanics and geometry of Bézier curve technology. 
However, adding and then removing the same control point should not dramatically change the 
curve of that section of an object.

Moving to Adjacent Control Points

You can move from a control point to an adjacent control point without having to click the mouse.

To move to an adjacent control point:

1. Click a control point.

2. Do one of the following:

t Click the Go to Next Event button to move in a clockwise fashion to the next control point.

t Click the Go to Previous Event button to move in a counterclockwise fashion to the next 
control point.

Moving Control Points

Before you select control points for moving, first click the Selection tool, and click the object to 
display the control points.

To move a single control point manually:

t Drag the control point to its new location.

The control point’s direction bars do not change orientation.

To move multiple control points manually:

t Click one control point, Shift+click or lasso additional control points that you want to move, and 
then drag one of the selected control points.

All other selected control points move in unison. To deselect the group, click any unselected 
control point.

To move all control points manually:

t Press Ctrl+A (Windows) or Command+A (Macintosh) to select all control points, and then drag 
one of the selected control points.

All other control points move in unison. To deselect the group, click outside the object to 
deselect it. 

To move or “nudge” control points in 1-pixel increments:

1. Click a control point to select it, or Shift+click additional control points to move them as a 
group. 

2. Nudge the control point or points using one of the following techniques:

t To nudge selected control points to the left, press the Left Arrow key or the Trim Left key.

t To nudge selected control points to the right, press the Right Arrow key or the Trim Right 
key.

t To nudge selected control points up, press the Alt key (Windows) or the Option key 
(Macintosh) and the Left Arrow key, or press the Trim Left key.
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t To nudge selected control points down, press the Alt key (Windows) or the Option key 
(Macintosh) and the Right Arrow key, or press the Trim Right key.

c The Effect Preview monitor must be the active window for arrow key movement of control 
points to work. Additionally, if your arrow keys are mapped to another function, such as Step 
Back and Step Forward, this feature might not function properly.

Using the Previsualization Marker Tool for 
Film Projects

The Previsualization Marker tool lets you place a marker in a segment to represent an effect that will 
be processed at an optical facility. This tool is applicable to 24-fps film projects only and does not 
appear in the Effect Editor for the Paint Effect in any other project types.

When you create an optical list, each marker, along with its position in the segment on a keyframe-
by-keyframe basis, appears as an optical event. The editor at the optical facility can refer to the event 
as a cue for creating a visual effect, such as a rotoscoped object.

For example, the optical editor’s assignment is to create an airplane that flies through the scene. The 
optical editor can use keyframe information from the optical list to plot the exact path of the effect as 
it moves through the scene. The marker’s position at each keyframe is described with coordinates 
derived from the Effect Grid. Position is described in terms of compass coordinates and X, Y 
coordinates.

You can add multiple markers to a single scene to represent different effects, and use a unique color 
for each marker. The resulting optical list displays each marker and its unique color values to enable 
the optical editor to distinguish each marker.

To add a Previsualization Marker effect to a sequence:

1. Enable the Effect Grid and set the appropriate parameters for image scan size, aspect ratio, and 
film format.

For more information, see “Displaying the Effect Grid in Effect Mode” on page 64.

2. If Media Composer is not in Effect mode, enter Effect mode, for example, by clicking the Effect 
Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. In the Effect Editor, click the Previsualization Marker tool.

4. Adjust the sliders in the Color parameter category to determine the color of the marker.

5. Move the pointer to the location in the frame where you want to place the marker, and click the 
mouse.

A marker appears in the frame.

6. Use keyframes to move the marker throughout the segment.

To add more markers:

t Repeat steps 2 to 5 in the previous procedure.

To delete a marker:

t Click the marker to highlight it, and then press the Delete key. 
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Manipulating Intraframe Objects

Intraframe effects include editing tools and additional parameters that enable you to perform the 
following operations:

• Move objects individually or in groups.

For more information, see “Moving Intraframe Objects” on page 405.

• Reshape objects.

For more information, see “Reshaping Intraframe Objects” on page 405.

• Rotate objects.

For more information, see “Rotating Intraframe Objects” on page 406.

• Scale objects.

For more information, see “Scaling Intraframe Objects” on page 407.

• Apply keyframed changes over time.

For more information, see “Changing Intraframe Object Parameters over Time” on page 408.

Moving Intraframe Objects

The Selection tool also enables you to drag objects or mattes around the screen and in relation to the 
screen when you zoom out from a frame.

To move a painted object or matte:

1. In the Effect Editor, click the Selection tool.

2. Click the object you want to move.

The object outline becomes highlighted, and four selection points appear around the object.

3. Click the center of the object, and drag it to a new location.

4. Release the mouse button when the object is positioned in the location you want.

Reshaping Intraframe Objects

The Reshape tool lets you modify the shape of a painted object or matte on the screen using several 
different techniques. These procedures require some familiarity with vector-based graphics. For more 
information, see “Working with Vector-Based Objects” on page 396.

n You can use keyframes to change the shape of an intraframe object over time. For more information, 
see “Changing Intraframe Object Parameters over Time” on page 408.

n The default behavior of control points in an object or matte created with the Curve tool differs 
slightly from those created with the Polygon tool. When you drag one of the direction handles, the 
direction bar on the opposite side of the control point moves in unison but the length does not change 
in unison. The dimensions of the curved segments on each side of the control point are not equal 
because the Curve tool creates curves with freehand capability, not with a mathematical formula that 
describes a Bézier curve in the way that the Polygon tool does.

You can transform the direction bars at a control point so that their lengths change in unison when 
you drag one of the direction handles. To do so, Shift+click one of the direction handles. For more 
information, see “Reference for Modifying Lines and Curves in Intraframe Objects” on page 401.
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To reshape an object:

1. Click the Selection tool, and click an object or matte.

2. Do one of the following:

t Click the Reshape tool.

t Double-click the selected object.

The outline of the object becomes highlighted, and control points appear.

n To drag the control points only, Alt+click (Windows) or Option+click (Macintosh) the Reshape tool 
to hide the direction handles.

3. Edit the shape of the object or matte:

t Click one or more of the object’s control points and drag.

For information on moving control points, see “Moving Control Points” on page 403.

t Edit the object by manipulating the direction bars at one or more control points.

For information on editing straight-line segments and curved segments, see “Reference for 
Modifying Lines and Curves in Intraframe Objects” on page 401.

Rotating Intraframe Objects

You can select an object or matte and rotate it around the Z axis.

You can also change the rotation of an object over time by rotating the object on an individual 
keyframe basis. For more information, see “Changing Intraframe Object Parameters over Time” on 
page 408.

To rotate an object or matte around the Z axis:

1. In the Effect Editor, click the Z-Rotation tool.

2. Click the object you want to rotate.

The object outline becomes highlighted, and a rotation handle appears within the object.
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Center of rotation (+) and Z-Rotation handle

The + on the rotation handle marks the default center of the Z axis for the object. You can click 
the + and drag it anywhere on the screen to change the center of the object’s rotation.

3. Click the rotation handle and drag the mouse to rotate the object in either a clockwise or a 
counterclockwise direction.

Scaling Intraframe Objects

You can rescale any object or matte that you create. Rescaling increases or decreases all dimensions 
of the object proportionately.

You can also use keyframes to change the scale of an intraframe object over time. For more 
information, see “Changing Intraframe Object Parameters over Time” on page 408.

To rescale an object or matte:

1. In the Effect Editor, click the Selection tool.

2. Click the object you want to rescale.

The object outline becomes highlighted, and four selection points appear around the object.

3. Rescale the object using one of the following methods:

t Click any selection point and drag.

Drag toward the center of the object to decrease the overall size. Drag away from the center 
to increase the overall size. When you drag a selection point, the object is anchored by the 
selection point that is diagonal to the one you are dragging.

t Alt+click (Windows) or Option+click (Macintosh) any selection point, and drag to rescale 
the object, using the center of the object as the anchor.
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Changing Intraframe Object Parameters over Time

You can animate an intraframe object by changing parameters on an individual keyframe basis. The 
following parameters are keyframeable:

For more information on using keyframes with parameters, see “Working with Keyframes” on 
page 80.

Layering, Grouping, and Locking Intraframe Objects
Intraframe effects include tools for navigating and adjusting layers of intraframe objects, for 
grouping objects for performing operations on several objects at once, and for locking objects to 
prevent further changes.

When you paint on a frame, the paint appears as an object in the foreground, seeming closer to you in 
three-dimensional space than the video frame. You can change the parameters of each painted object 
independently, including the object’s orientation in relation to another object. For example, if you 
have three painted objects, you can stack or cascade them over each other to create three separate 
layers of objects in the foreground. 

All compositing of painted objects takes place in the foreground and is not destructive to the video 
background. When you composite various Paint Effects on a frame, remember that Media Composer 
renders the Paint Effects to the screen beginning with the bottom layer.

Parameter For more information:

Position of an object on screen See “Moving Intraframe Objects” on page 405.

Shape of an object See “Reshaping Intraframe Objects” on page 405

Z-axis rotation of an object See “Rotating Intraframe Objects” on page 406

Scale or relative size of an object See “Scaling Intraframe Objects” on page 407

Feathering See “Feathering” on page 495.

Foreground level See “Foreground” on page 496.

Magic Mask See “Magic Mask” on page 498.
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Layering with the AniMatte effect works much as it does with the Paint Effect, but the image that 
appears in the foreground of an AniMatte effect is the video that you have chosen to key in or key 
out. Even though Media Composer renders matte keys starting with the highest track in a multilayer 
matte key, compositing of multiple AniMatte effects in the same segment occurs in the foreground 
and is not destructive to the video background.

You can use the Outline/Path button to locate an object or matte that is hidden by others on the 
screen. The Outline/Path button creates a wire-frame representation of each object, which enables 
you to locate, select, and manipulate the object.

To locate objects or mattes with the Path function:

1. In the Effect Editor, click the Outline/Path button.

Each object painted on the frame appears as a wire frame.

2. Select an object, and change its location or parameters.

3. Click the Outline/Path button to return to default viewing mode.

To change the layer order of an object or matte:

1. Click the Selection tool, and click an object on the screen.

If the object is hidden by other objects, use the Outline/Path feature to locate it as described in 
the previous procedure.

2. Do one of the following:

t To move the object one layer forward, click the Bring Forward button in the Effect Editor or 
select Object > Bring Forward.

t To move the object one layer backward, click the Send Backward button in the Effect Editor 
or select Object > Send Backward.

t To move the object to the front of the layers (appearing closest to you in three-dimensional 
space), Alt+click (Windows) or Option+click (Macintosh) the Bring Forward button in the 
Effect Editor or select Object > Bring to Front.

t To move the object to the back of the layers (appearing farthest from you in three-
dimensional space), Alt+click (Windows) or Option+click (Macintosh) the Send Backward 
button in the Effect Editor or select Object > Send to Back.

To group painted objects or mattes:

1. Click the Selection tool, and click an object.

If the object or matte is hidden by other objects, use the Outline/Path feature to locate it as 
described in the first procedure in this topic.

2. Shift+click any additional objects you want to include in the group.

3. Select Object > Group.

The objects become grouped together, and you can manipulate the group as if it were a single 
object.

To ungroup painted objects or mattes:

1. Click the Selection tool, and click an object that is a member of the group.

2. Select Object > UnGroup.

The objects become ungrouped.
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n You can also group together groups of objects. If you then click the new group and select UnGroup, 
all objects become ungrouped completely.

To lock a painted object, matte, or group:

1. Click the Selection tool, and click an object or group.

If the object is hidden by other objects, use the Outline/Path feature to locate it as described in 
the first procedure in this topic.

2. Select Object > Lock.

To unlock a painted object, matte, or group:

1. Click the Selection tool, and click an object or group.

2. Select Object > Unlock.

Exporting a Matte Key Created With the 
AniMatte Effect

You can create a matte with the AniMatte effect and export it as a high-contrast matte without leaving 
Effect mode. The exported image is a high-contrast 32-bit PICT file that includes an alpha channel.

You can use the exported PICT file in the following ways:

• Import the file back into Media Composer to create a real-time Matte Key clip that you can edit 
into a sequence. You can use this clip as a garbage matte or promote the clip to 3D.

• Open the file in a third-party graphics application, edit the file, and import the file back into 
Media Composer.

• Use the file as a graphic in an application other than Media Composer.

When you import the PICT file back into Media Composer, Media Composer creates a Matte Key 
clip in the bin that you select. You can load the Matte Key clip into the Source monitor and edit it into 
a sequence as you can with any other imported matte key. The Matte Key clip appears as a high-
contrast matte with transparent (black) and opaque (white) components. 

When you open the high-contrast PICT file in a third-party application that supports alpha channels, 
select the file’s alpha channel to view the high-contrast components of the matte. When you open the 
PICT file in an application that does not support alpha channels, the image appears completely white.

To export a matte key created with the AniMatte effect:

1. Use the AniMatte effect to create a matte key.

For more information, see “Applying the Paint or AniMatte Effect to a Sequence” on page 384.

2. If Media Composer is not in Effect mode, enter Effect mode, for example, by clicking the Effect 
Mode button.

For more information, see “Entering Effect Mode” on page 32.

3. In the Timeline, move the position indicator to the frame you want to export.

4. Click the Effect Editor.

5. Select File > Export Matte PICT.
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n You must click the Effect Editor before you select File > Export Matte PICT. If you do not, Media 
Composer displays the default Export command in the File menu.

The Export PICT As dialog box opens.

6. Select the location where you want to save the PICT file, and then click Save.

Media Composer saves the PICT file to the location you selected.

7. If necessary, open the PICT file in a third-party application and make changes to the file.

To import the matte key into your project:

1. Select the bin into which you will import the PICT file, and select File > Import.

The Select files to Import dialog box opens.

2. Select Graphic Files from the Files of Type menu.

3. Click Options.

4. In the Alpha area, click one of the following to select an alpha channel option:

- Use Existing

- Invert Existing

- Ignore

Depending on your needs, you might have to select Invert Existing. In a high-contrast matte key 
with an alpha channel, the white regions are opaque, and the black regions are transparent.

For more information on importing a matte key, see “Importing Media Files” in the Help.

5. When you have finished selecting the options you need, click OK.

6. Select the resolution and video drive for storing the effect clip.

7. Select the files you want to import and click Open.

The PICT file appears as a Matte Key effect clip in the bin you selected.

8. Click the Source/Record Mode button below the Timeline.

9. Load the Matte Key effect clip into the Source monitor.

The clip appears in the Source monitor as a black-and-white, high-contrast image.

10. Edit the matte key into the sequence as described in “Working with Imported Graphics and 
Animation” on page 207.

Scratch Removal

Media Composer includes tools for fixing flaws such as dropout in video frames or defects in film-
originated footage. You can replace a flaw with clean material from the same frame or field or from 
other nearby frames or fields.

Understanding Scratch Removal

The workflow for removing a flaw involves the following main steps:

1. Isolate the flawed material in a new segment.

2. Apply an Intraframe effect.
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3. Use the Intraframe drawing tools and effect parameters to draw a shape that covers the flaw, and 
fill the shape with clean replacement material.

4. (Option) If the flaw persists over several frames or fields, use keyframes to adjust the covering 
shape so it continues to cover the flaw as the footage moves.

Frame and Field Processing

When you use Scratch Removal with two-field media, Media Composer can use either frame or field 
processing to determine the source of the replacement material that covers the flaw. For information 
on selecting the processing method, see “Selecting Frame or Field Processing When Using 
Scratch Removal” on page 414.

Frame processing copies replacement material from Field 1 of the clean frame to Field 1 of the 
flawed frame and from Field 2 of the clean frame to Field 2 of the flawed frame. Field processing 
copies replacement material from only one field to all subsequent fields.

The following illustrations show the frame and field processing methods for a typical two-frame 
correction created by clicking the Scratch Removal button and using default parameter settings 
(Frame: 0; Offset: From Start). In the frame processing example, material is copied from the first 
(clean) frame to the second (flawed) frame. In the field processing example, material is copied from 
the first field of the effect segment to all the subsequent fields.

n The Scratch Removal button appears by default on the Tool palette. You can also map the Scratch 
Removal button from the Command palette to the keyboard or to a button. For more information, see 
“Using the Tool Palette” and “The Command Palette” in the Help.

Example of frame-based processing. Frame A is the clean frame and frame B is the flawed frame. The arrows indicate 
how Media Composer copies material — from Field 1 of the clean frame to Field 1 of the flawed frame and from Field 2 
of the clean frame to Field 2 of the flawed frame.

Example of field-based processing. The arrows indicate how Media Composer copies material from the first field of the 
effect segment to all subsequent fields.

1 2 1 2

A B

1 2 1 2

A B
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Frame processing is the default processing method. It preserves full video resolution and provides the 
smoothest correction in most circumstances, particularly when the flaw you are correcting extends 
over both fields of a frame. Most flaws that originate in film source material (for example, a scratch 
on a single frame of the film) extend across both fields of the video frame.

Field processing results in a better-looking correction under certain circumstances because it lets you 
select your replacement material with field accuracy. For example, in the field-based processing 
illustration above, changing the Field parameter value to +1 causes Media Composer to copy material 
from Field 2 of Frame A to both of the fields in Frame B. A field-based correction might be a good 
solution when you want to correct a flaw such as video dropout, which does not necessarily occur on 
both fields of one or more frames. However, field processing always results in at least one instance 
where material from an odd field is copied to an even field, or vice versa. Depending on the nature of 
your video material, this might result in a slight jitter on playback.

Options for Removing Flaws

You can often remove a flaw by replacing it with a clean area from the same frame or field. For 
example, you can replaces a flaw on a uniform background such as sky by copying another portion of 
the sky over the flaw.

When you remove a flaw by using material from the same frame that contains the flaw, you can see 
both the flaw and all the available clean material as you work. This can be helpful for certain kinds of 
footage, making it easy to select the exact portion of the image that allows for the best replacement.

Replacing flaws with material from a nearby frame or field lets you correct flaws in more complex 
footage. For example, a flaw on an image such as a face might be very difficult to cover using 
material from the same frame or field — there might be no other area of the face in that image that 
shows similar tones, textures, and highlights. In this situation, it is better to replace the flaw by 
copying the same part of the face from an earlier or later frame that does not contain the flaw.

This method also provides an alternative for dealing with uniform areas such as sky since you can 
replace a flaw with the same area from a nearby clean frame.

When you use material from a nearby frame to replace a flaw, you cannot see the whole of the nearby 
frame as you work. Instead, you see the replacement area in the shape you draw to cover the flaw, and 
you use parameter sliders in the Effect Editor to adjust which portion of the nearby frame appears.

Selecting Material to Use When Correcting Flaws

When you isolate a flaw as a new segment to correct it, you must include enough clean material to 
make the correction. The Intraframe tools you use for removing flaws cannot reference frames 
outside the segment that you isolate. 

In some cases, you can take all the clean material you need from the same frames that contain the 
flaw. In other situations, you need to include one or more completely clean frames along with the 
flawed frames in the segment you isolate.

For example, if a flaw persists across several frames in footage that includes no motion, the simplest 
way to correct the flaw is to include one clean frame before or after the flawed frames and use 
replacement material from the clean frame to cover the flaw in all the other frames. For more 
information on using replacement material from different points in your footage, see “Examples of 
Scratch Removal Parameter Settings” on page 421.
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Detecting Video Dropout in 24p or 25p Material

Because of the way some Avid editing applications handle the display of 24p or 25p material, you 
might not be able to see video dropout when you use the default Fast Frame Display mode.

To ensure that you can see dropout when you are working with 24p or 25p material, turn off Fast 
Frame Display mode by selecting Special > Fast Frame Display. (When Fast Frame Display is 
deselected, there is no check mark beside it in the menu.) You can then see every line of the full 24p 
or 25p frame.

For more information on how Media Composer displays 24p or 25p material, see “Displaying 24p 
and 25p Media” in the Help.

c When you turn off Fast Frame Display, you slow down Media Composer’s display capabilities. 
If you turn off Fast Frame Display to check for flaws, you should turn it on again before you 
proceed with other editing operations.

Selecting Frame or Field Processing When Using Scratch Removal

To select frame or field processing when using Scratch Removal:

1. Move the position indicator to the effect’s icon in the Timeline.

2. If you are not in Effect mode, enter Effect mode, for example by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

3. Open the Mode parameter category of the Paint Effect or the Scratch parameter category of the 
Scratch Removal effect, and click the Frame Processing button.

Frame/Field parameter slider and Frame Processing button in the Effect Editor

If the Frame Processing button is selected, Media Composer uses frame processing. The Frame/
Field parameter slider is labeled Frame and is calibrated in one-frame increments from –5 to +5.

If the Frame Processing button is deselected, Media Composer uses field processing. The Frame/
Field parameter slider is labeled Field and is calibrated in one-field increments from –10 to +10.

For more information on frame and field processing, see “Frame and Field Processing” on 
page 412.

n When you are working with single-field material, the Frame Processing button does not appear in the 
Effect Editor.
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Isolating a Flaw

If you need to correct a flaw on a single frame, you can use the Scratch Removal button to quickly 
create a two-frame segment and apply the Scratch Removal effect. 

n The Scratch Removal button appears by default on the Tool palette. You can also map the Scratch 
Removal button from the Command palette to the keyboard or to a button. For more information, see 
“Using the Tool Palette” and “The Command Palette” in the Help.

If a flaw persists over several frames, do one of the following:

• Use the Scratch Removal button to create a two-frame segment, and then use standard Trim 
mode methods to extend the segment.

• Insert add edits, and apply a Scratch Removal effect manually.

n You cannot access frames outside the segment you mark when you are working with the Scratch 
Removal tools. When you isolate a flaw, you must include in the segment both the flawed frames and 
sufficient clean material to correct the flaws successfully. For more information on the relationship 
between flaws and clean material, see “Understanding Scratch Removal” on page 411 and 
“Examples of Scratch Removal Parameter Settings” on page 421.

For information on finding flaws in 24p or 25p material, see “Detecting Video Dropout in 24p or 25p 
Material” on page 414.

To isolate a flaw by using the Scratch Removal button:

1. Find the frame containing the flaw:

t Use the Step Forward button or the Step Backward button (in the toolbar under the monitor) 
to carefully cue the frame containing the flaw.

t (Option) Press and hold the Alt key (Windows) or Option key (Macintosh) while clicking the 
Step Forward or the Step Backward button to step through one field at a time.

2. Move the position indicator to the frame containing the flaw.

3. Ensure that the Record Track button for the track containing the flaw is the highest selected track 
button in the Track Selector panel.

4. Click the Scratch Removal button.

Media Composer creates a two-frame segment ending at the frame marked by the position 
indicator and applies the Scratch Removal effect to that segment. If an effect is already present at 
that point in the sequence, Media Composer auto-nests the Scratch Removal effect on top of the 
existing effect.

A Scratch Removal effect on a segment created by two add edits
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To isolate a flaw by using add edits:

1. Find the series of frames or fields containing the flaw:

t Use the Step Forward button or the Step Backward button (in the toolbar under the monitor) 
to carefully cue the frames containing the flaw.

t (Option) If you are working with two-field media, press and hold the Alt key (Windows) or 
Option key (Macintosh) while clicking the Step Forward button or the Step Backward button 
to step through one field at a time if necessary.

2. Isolate the flawed frames, together with sufficient clean material to make your correction, by 
placing add edits before and after the frames to create a new segment.

3. Apply either the Paint Effect or the Scratch Removal effect from the Image category to the 
segment:

The Scratch Removal effect provides only those effect parameters specific to fixing flaws, while 
the Paint Effect provides Scratch Removal as one of many available Paint modes.

Removing a Flaw By Drawing a Shape

Once you isolate a flaw and apply an Intraframe effect to it, you can remove the flaw by replacing it 
with a clean area of video. The best way to do this is usually to draw a shape that covers the flaw and 
fill the shape with replacement material.

An alternative method is to draw a shape over your selected replacement material and then drag the 
replacement over the flaw. This works well when you are taking replacement material from the same 
frame that contains the flaw. For more information, see “Removing a Flaw By Dragging 
Replacement Material” on page 417.

To remove a flaw by drawing a shape over it and filling the shape with replacement material:

1. Isolate the flaw, and apply the Paint Effect or the Scratch Removal effect by using the procedures 
described in “Isolating a Flaw” on page 415.

2. If you are not in Effect mode, enter Effect mode, for example, by clicking the Effect Mode 
button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

3. Select the segment if it is not already selected.

4. (Option) If you are working with the Paint Effect, do the following:

a. Click the triangular opener next to the Mode parameter category.

b. Click the Fast Menu button, and select Scratch Removal.

5. Click the triangular opener next to the Mode parameter category (Paint Effect) or the Scratch 
parameter category (Scratch Removal effect).

6. Select a shape tool or a brush in the Effect Editor.

7. Click the image, and drag to create an object that covers the flaw.

In most circumstances, you should make the object as small as possible while still covering the 
flaw completely.
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8. Make sure that the Object Visible button is selected in the Mode parameter category (Paint 
Effect) or the Scratch parameter category (Scratch Removal effect) of the Effect Editor.

9. (Option) Select frame or field processing.

For more information, see “Selecting Frame or Field Processing When Using Scratch Removal” 
on page 414.

10. Use the Horizontal, Vertical, and Frame/Field sliders in the Effect Editor to select an area of 
replacement material to fill the object in the image and replace the flaw.

The replacement material appears in the object, replacing the flaw. For more information on 
using the Horizontal, Vertical, and Frame or Field parameter sliders, see “Using the Scratch 
Removal Positioning Parameters” on page 420.

11. (Option) Use the Feathering parameters to help blend the replacement material into the 
surrounding area.

Original flaw (left) seen with a shape drawn around it, and the final effect (right) where clean material from a nearby 
frame appears within the shape

12. (Option) Animate the shape that contains the replacement material using keyframes to follow 
movement and changes in the frames of footage.

For example, you can resize, reshape, and reposition the shape over time, or you can use the 
Object Visible button to control when the shape is visible.

For more information, see “Intraframe Example: Animating a Matte Key Effect” on page 429, 
“Image: Paint Effect” on page 467, and “Key: AniMatte” on page 470.

13. Render the effect to play it back in real time.

For more information, see “Rendering Intraframe Effects” on page 383.

n A standard Intraframe geometric shape such as an oval or a rectangle renders considerably faster 
than a series of brush strokes. In most cases of a single small flaw, a brush might be the easiest 
correction tool. If you need to correct several flaws that are close together, however, you save 
rendering time if you can cover them with a single shape rather than use several different 
brush strokes.

Removing a Flaw By Dragging Replacement Material

This procedure is an alternative to the flaw removal method described in “Removing a Flaw By 
Drawing a Shape” on page 416. Consider this method when you are taking replacement material 
from the same frame that contains the flaw.
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To remove a flaw by selecting replacement material and then dragging it over the flaw:

1. Isolate the flaw, and apply the Paint Effect or Scratch Removal effect by using the procedures 
described in “Isolating a Flaw” on page 415.

2. If you are not in Effect mode, enter Effect mode, for example, by clicking the Effect Mode 
button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

3. Select the segment if it is not already selected.

4. (Option) If you are working with the Paint Effect, do the following:

a. Click the triangular opener next to the Mode parameter category.

b. Click the Fast Menu button, and select Scratch Removal.

5. Click the triangular opener next to the Mode parameter category (Paint Effect) or the Scratch 
parameter category (Scratch Removal effect).

6. (Option) Select frame or field processing.

For more information, see “Selecting Frame or Field Processing When Using Scratch Removal” 
on page 414.

7. Select a shape tool or a brush in the Effect Editor.

8. Click a clean area of the image, and drag to create a selection that is appropriately sized for 
covering the flaw.

In most circumstances, you should make the object as small as possible while still covering the 
flaw completely.

9. Drag the replacement selection over the flaw.

10. (Option) Use the Feathering parameters to help blend the replacement material into the 
surrounding area. 

Left to right: original flaw and selection, selection dragged over flaw, and the final effect

11. (Option) Animate the shape that contains the replacement material using keyframes to follow 
movement and changes in the frames of footage.

For example, you can resize, reshape, and reposition the shape over time, or you can use the 
Object Visible button to control when the shape is visible.

For more information, see “Intraframe Example: Animating a Matte Key Effect” on page 429, 
“Image: Paint Effect” on page 467, and “Key: AniMatte” on page 470.

12. Render the effect to play it back in real time.

For more information, see “Rendering Intraframe Effects” on page 383.
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Scratch Removal
Removing Flaws Covering More Than One Frame or Field

You can use IN and OUT points to define multiple frames or fields of video that contain a scratch and 
then use the Scratch Removal button to quickly create a Scratch Removal effect that covers the 
scratched frames or fields together with the clean frame or field immediately before them. When you 
draw a shape to cover the scratch, Media Composer fills that shape with clean material in every frame 
or field of the effect.

This is useful when a scratch is repeated across several frames or fields. In particular, it allows for 
quick correction of a scratched frame in film-originated material that has been duplicated by the 
pulldown process in telecine transfer to video.

To remove a scratch covering more than one frame or field:

1. Mark an IN point at the first scratched frame or field.

2. Mark an OUT point at the last scratched frame or field.

3. Move the position indicator to one of the following locations:

- Between the marked IN and OUT points

- On the frame or field immediately before the marked IN point

4. Click the Scratch Removal button.

n The Scratch Removal button appears by default on the Tool palette. You can also map the Scratch 
Removal button from the Command palette to the keyboard or to a button. For more information, see 
“Using the Tool Palette” and “The Command Palette” in the Help.

Media Composer applies a Scratch Removal effect that covers the scratched frames or fields and 
the clean frame or field immediately before them.

The position indicator must be between the marked IN and OUT points or on the frame or field 
immediately before the marked IN point. If the position indicator is at any other location, Media 
Composer creates the Scratch Removal effect at that location and ignores the marked IN and 
OUT points.

5. (Option) Select frame or field processing.

For more information, see “Selecting Frame or Field Processing When Using Scratch Removal” 
on page 414.

6. In the Effect Editor, select a shape tool or a brush.

7. Click the image, and drag to create a shape that covers the scratch.

Media Composer replaces the material in the shape with material from the clean frame or field. 
The same clean material covers the scratch on every scratched frame or field within the effect.

n The Scratch Removal positioning parameters reference the part of the clean frame that corresponds 
to the shape you draw by default. In most cases, you do not need to make any adjustments to these 
parameters to cover the scratch successfully.

8. (Option) Use the Feathering parameters to help blend the replacement material into the 
surrounding area.

9. Render the effect to play it back in real time.

For more information, see “Rendering Intraframe Effects” on page 383.
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Scratch Removal
In some unusual circumstances, you might need to animate the shape that contains the 
replacement material, using keyframes together with positioning adjustments to follow 
movement and changes. For example, if the image is changing rapidly from frame to frame and 
the scratch covers several frames, the clean material might not match the later scratched frames 
without repositioning. 

Using the Scratch Removal Positioning Parameters

The Hor (horizontal), Vert (vertical), and Frame/Field sliders in the Scratch Removal mode of the 
Paint Effect or in the Scratch parameter category of the Scratch Removal effect let you control 
exactly which material you use from elsewhere in the same frame or in nearby frames to replace 
flawed material.

The Hor (horizontal) and Vert (vertical) sliders define the position of the replacement material 
relative to the shape you have drawn on the horizontal and vertical axes of the frame. 

The Frame/Field slider defines which nearby frame or field is used as the source of the replacement 
material. Values represent an offset from the reference point defined in the Offset Fast menu.

Offset Fast Menu button in the Effect Editor

The following table shows the default settings.

These settings correctly reference the clean frame or field whenever you use the Scratch Removal 
button to apply the Scratch Removal effect. The settings reference the clean frame when you use the 
Scratch Removal button without marking IN and OUT points to remove a scratch on a single frame 
or field. They also reference the clean frame when you use the Scratch Removal button with IN and 
OUT points to remove a scratch or other flaw that repeats across more than one frame or field.

The Frame Processing button lets you select between frame and field processing. If the Frame 
Processing button is selected, Media Composer uses frame processing. The Frame/Field parameter 
slider is labeled Frame and is calibrated in one-frame increments from –5 to +5.

If the Frame Processing button is deselected, Media Composer uses field processing. The Frame/
Field parameter slider is labeled Field and is calibrated in one-field increments from –10 to +10.

For more information on field processing, see “Frame and Field Processing” on page 412. For more 
information on these parameters, see “Image: Scratch Removal” on page 468.

Parameter Default setting

Frame/Field 0

Offset From Start
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Scratch Removal
n You cannot access frames more than 5 frames (or fields more than 10 fields) from the zero point as 
defined by the Offset Fast menu, regardless of the length of the segment. 

You cannot access frames or fields outside the segment that contains the effect. If you are positioned 
six fields from the end of the segment, and you set the Field slider to 10 and the Offset to Relative, you 
reference the last field of the segment (six fields ahead of your position).

Examples of Scratch Removal Parameter Settings

The following examples illustrate several different settings for the Scratch Removal positioning 
parameters.

Example 1: Replacement Material in the Same Frame

In this example, the effect replaces the area of the rectangle covering the scratch (bottom left) with 
material from the area of the clean rectangle in the same frame or field (top right). Each frame or 
field in the segment uses replacement material from the same relative position in its own frame or 
field.

Example 2: Replacement Material from a Two-Frame Relative Offset

Parameter Setting

Vertical –250

Horizontal +250

Frame/Field 0

Offset Relative

250px

250px

Parameter Setting

Vertical 0

Horizontal 0
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Intraframe Editing Examples
In this example, the area of the rectangle covering the scratch (left) is replaced by the same 
coordinate area of the frame two frames (four fields) ahead (right). Each frame or field in the segment 
uses replacement material from two frames (four fields) ahead.

Example 3: Replacement Material from a Single Clean Frame

In this example, the area of the rectangle covering a scratch in several frames is replaced by the area 
of the clean rectangle in the first frame of the segment. If the same parameter settings are used 
throughout the segment, then every frame in the segment references the first frame of the segment.

You can select From Start or From End from the Offset Fast menu in this way to cover a flaw in 
several frames with clean material from a single frame. In this example, the flaw first appears in 
frame 2, and it is replaced in every frame in which it appears by clean material from frame 1.

Intraframe Editing Examples

The topics in this section provide examples of how to use Intraframe techniques.

Frame/Field +2/+4

Offset Relative

Parameter Setting

Parameter Setting

Vertical 0

Horizontal 0

Frame/Field 0

Offset From Start

1 2 3 4
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Intraframe Editing Examples
Intraframe Example: Colorizing with Magic Mask

You can use the Magic Mask effect to apply effects across a series of frames, using the chroma and 
luma values as the criteria for edge detection.

Magic Mask is primarily useful for localized colorization, which enables you to create garbage 
mattes and various chroma effects. For example, you can use Magic Mask to change the color of a 
white shirt to another color without having to create a detailed matte.

In this example, the goal is to colorize the window area through which we see the athletes walking to 
the pool. The odd shapes in the window area would normally make this task extremely time 
consuming, but because the region is high contrast with a consistent off-white color, Magic Mask 
makes the job simple.

To colorize the example image:

1. If you are not in Effect mode, enter Effect mode, for example, by clicking the Effect Mode 
button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

2. In the Effect Palette, click the Image category.

3. Drag the Paint Effect icon to the segment of footage in the sequence.

4. Select the segment if it is not already selected.

The Paint Effect parameters appear in the Effect Editor.

5. For this example, in the Mode parameter category, click the Fast Menu button, and select Solid.

In other applications of Magic Mask, you might select another mode such as Lighten, Darken, or 
Colorize.

6. Click the Rectangle tool (or another shape tool) in the Effect Editor, click in the Effect Preview 
monitor, and drag to draw a box surrounding the window region.
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Intraframe Editing Examples
7. Open the Color category, and, using standard methods, select a color to apply to the window 
region.

For more information on selecting a color, see “Adjusting a Color Parameter for an Effect” on 
page 74.

8. (Option) Click the Outline/Path button so you have an unobscured view of the object you want to 
colorize. Adjust the size and shape of the box as necessary.

9. In the Magic Mask category, click the Enable button.

Enable button for Magic Mask in the Effect Editor

Media Composer activates the Magic Mask.

The default key color for Magic Mask might not match the color in your selection, so the color is 
not yet applied to the white area of the window.

Effect applied before selecting Magic Mask key color. The color effect does not appear.

10. In the Magic Mask parameter category, click in the Color Preview window, drag the pointer to 
the colored area of the window in the image, and then release the mouse button.

Media Composer sets the Magic Mask key color to the color you selected, and applies the effect. 

11. Click the Outline/Path button to switch between viewing the image with or without the effect.
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Intraframe Editing Examples
Effect applied with key color selected from the image

12. Adjust the Magic Mask parameters, such as Gain and Soft (softness), to fine-tune the effect.

Media Composer applies the colorization effect to areas where the rectangle shape extends 
beyond the window area in the image. You can quickly convert the rectangle to a polygon and 
adjust its shape around the window.

To reshape the rectangle:

1. Double-click the rectangle to select it and display its control points.

2. Drag the control points at the corners of the rectangle one at a time to surround the window area.

New shape restricts the Magic Mask effect to the window area

Intraframe Example: Applying the Paint Effect to Regions of a Clip

The Paint Effect includes a number of modes for applying special effects to traced regions of an 
image. This example describes using keyframes with the Blur mode to gradually blur a region of the 
clip. The effect gives the impression that the background is losing focus while the rest of the image is 
unaffected.

The background behind the woman is traced with the Paint Effect, and the Blur mode is gradually 
applied during the clip.
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Intraframe Editing Examples
Before (left) and after (right) the blur effect

To apply the blur:

1. If you are not in Effect mode, enter Effect mode, for example, by clicking the Effect Mode 
button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

2. From the Image category, drag the Paint Effect icon to the segment of footage in the sequence.

3. Select the segment if it is not already selected.

The Paint Effect parameters appear in the Effect Editor.

n The next task is to trace the background region around the woman in the foreground to apply the 
effect. Because the woman moves during the clip, you must animate the traced shape by using 
keyframes.

4. Press the Home key to go to the beginning of the clip. Make sure both the first and last keyframes 
are selected.

5. In the Effect Editor, click the Reduce button to view the image in the Effect Preview monitor at 
75 percent. 

This makes it easier to include the outer edges of the footage in the traced area.

6. Click the Curve tool.

7. Click the image, and drag to draw a matte with freehand capability. Trace an outline around the 
woman and surrounding the background.

8. When you are satisfied with the shape of the matte, release the mouse button.

Complex polygon shape traced around woman and background
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Intraframe Editing Examples
9. In the Effect Preview monitor, click the last keyframe indicator to select the keyframe. Check the 
shape of the traced area around the woman, and adjust control points as necessary to make an 
accurate outline.

10. Before creating new keyframes to further animate the traced outline, apply the blur to the first 
and last keyframes to ensure a smooth effect across all keyframes:

a. In the Effect Preview monitor, click the first keyframe indicator to select it.

b. In the Mode parameter category, click the Fast Menu button, and select Blur.

c. Drag the Hor (horizontal) and Vert (vertical) sliders to 0.

d. Click the last keyframe indicator to select it.

e. Drag the Hor (horizontal) and Vert (vertical) sliders to 50.

Media Composer applies the Blur mode effect.

11. Click elsewhere in the Effect Preview monitor’s position bar to check the traced outline. Make 
adjustments as necessary.

n As you adjust control points, Media Composer automatically creates new keyframes.

12. (Option) To soften the edges of the blurred outline around the woman, adjust the Feathering 
parameters.

For more information, see “Feathering” on page 495.

13. Render the effect to play it back in real time.

For more information, see “Rendering Intraframe Effects” on page 383.

Intraframe Example: Creating a Matte Key Effect

When you apply the AniMatte effect and create a matte key, the shape and location of the matte 
remain fixed over the course of the segment. The parameters of the matte are the same at both the 
first and last keyframes in the segment.

To apply a two-layer matte key:

1. For this two-layer effect, edit the image you want to use as the background onto one track and the 
image you want to use as the foreground onto the track above.

For more information, see “Creating and Editing Sequences” in the Help.

2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.
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Intraframe Editing Examples
The Effect Editor opens.

3. In the Effect Palette, click the Key parameter category.

4. Drag the AniMatte Effect icon from the Effect Palette to the upper track in the Timeline.

5. Press the Home key to go to the beginning of the clip. Ensure both the first and last keyframes 
are selected.

6. In the Effect Editor, click the Reduce button to view the image in the Effect Preview monitor at 
75 percent.

This makes it easier to include the outer edges of the footage in the traced area.

7. Click the Curve tool.

8. In the Mode parameter category, click the Fast Menu button, and select Key In.

9. Click the image, and drag to draw a matte with freehand capability.

10. When you are satisfied with the shape of the matte, release the mouse button.

The area outside the border of the matte reveals the underlying image on the lower track (V1 in 
the example), and the area inside the border of the matte displays the image on the upper track 
(V2).

In this example, a series of shapes are drawn to key out all areas of the foreground image

11. In the Foreground parameter category, click the Swap Src (swap sources) button to check the 
traced outline.

The foreground and background footage are reversed in the key. This lets you easily spot areas 
where the outline encroaches on the foreground image.
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Intraframe Editing Examples
In this example, swapping sources on one of the shapes reveals edges from the foreground image

12. Click the Swap Src button to restore your effect to a matte that keys in your selection.

13. Animate the effect as described in “Intraframe Example: Animating a Matte Key Effect” on 
page 429.

Intraframe Example: Animating a Matte Key Effect

This topic is a continuation of the example that is created by following the procedure in “Intraframe 
Example: Creating a Matte Key Effect” on page 427.

When you have moving video, you must use animation to change the shape and location of the matte 
in order to follow the changes of the video over the course of the segment.

Foreground and background layers (left) and the composite image (right). In this example, the matte shape is animated 
to follow the movement of the men in the foreground footage.
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Intraframe Editing Examples
To animate a Matte Key effect:

1. Under the monitor, click the Step Forward button or the Step Backward button as many times as 
necessary to park on a frame in which the matte no longer provides a clean key due to the motion 
of the foreground or background image.

2. If you are not in Effect mode, enter Effect mode, for example, by clicking the Effect Mode 
button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

3. Adjust the matte outline as follows:

t Click the Reshape tool, and drag control points to change the shape.

You can also Shift+click multiple control points for repositioning as a group. For 
information, see “Adding and Removing Control Points” on page 402.

t Edit the object by manipulating the direction bars at one or more control points.

For information, see “Reference for Modifying Lines and Curves in Intraframe Objects” on 
page 401.

t Click the Swap Src button if necessary to swap the view of the foreground and background 
images to examine edges.

t Reposition the matte if necessary by selecting the shape and dragging it with the Selection 
tool.

As you adjust control points, Media Composer automatically creates new keyframes.

4. Repeat the procedure as needed to create a matte that keys the images cleanly over the course of 
the segment.

5. (Option) To soften the edges of the matte key, adjust the Feathering parameters.

For more information, see “Feathering” on page 495.

6. Render the effect to play it back in real time.

For more information, see “Rendering Intraframe Effects” on page 383.

Intraframe Example: Creating a Single-Layer Organic Matte Wipe

You can use the AniMatte effect to create a custom matte wipe. Additionally, you can create soft 
edges and other useful variations by adjusting the parameters of the AniMatte wipe. Multiple video 
tracks are not necessary. You apply the AniMatte effect to a transition on a single track of video and 
then draw the matte wipe as described in this section.

To create an organic matte wipe:

1. Create a sequence that contains a transition (an incoming and an outgoing segment).

For more information, see “Creating and Editing Sequences” in the Help.
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Outgoing segment (left) and incoming segment (right)

2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

3. Apply the AniMatte effect to a transition as described in “Applying the Paint or AniMatte Effect 
to a Sequence” on page 384.

4. In the Mode parameter category, click the Fast Menu button, and select Key In.

5. In the Effect Preview Monitor toolbar, click the Reduce button three times to reduce the image to 
25 percent of its normal viewing size.

6. Click the first keyframe indicator in the Effect Preview monitor’s position bar.

The first keyframe indicator is highlighted, and the last keyframe is deselected.

7. Click the Curve tool.

8. Press and hold the mouse button, and drag to draw a custom shape to the right of the image 
displayed in the Effect Preview monitor.

Draw a matte that is at least as wide as the frame in the Effect Preview monitor.

9. When you are satisfied with the shape of the object, release the mouse button to complete the 
matte wipe.

10. Click the last keyframe indicator in the Effect Preview monitor’s position bar.

Media Composer highlights the last keyframe indicator, and deselects the first keyframe.

11. Click the matte wipe within its borders and drag it so that it covers the frame in the Record 
monitor. Make sure to position the leading edge of the wipe so that it is beyond the left border of 
the frame.
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12. In the Effect Preview Monitor toolbar, click the Enlarge button three times to restore the video 
image to 100 percent.

13. Click in the middle of the Effect Preview monitor’s position bar to view the edge of the wipe.

14. (Option) To soften the edges of the wipe, adjust the Feathering parameters.

For more information, see “Feathering” on page 495.

15. Render the effect to play it back in real time.

For more information, see “Rendering Intraframe Effects” on page 383.

Working with the Blur Effect and Mosaic Effect

The Blur effect and Mosaic effect, found in the Image category, let you obscure part of an image by 
distorting the pixels within a defined area.

The Blur effect and Mosaic effect act as intraframe effects. The Blur parameter category for the Blur 
effect is the same as the one that appears for the Blur mode of the Paint Effect. The Mosaic parameter 
category for the Mosaic effect is the same as the one that appears for the Mosaic mode of the Paint 
Effect.

n The Blur and Mosaic effects are non-real-time effects. When you finish creating one of these effects, 
you must render the effect to play it in real time.

Effect Editor Reference for the Blur Effect and Mosaic Effect

You control the Blur and Mosaic effects by using the following parameters in the Effect Editor:

Parameter Description

Acceleration Adjusts the effect’s speed from one keyframe to the next when the Blur or 
Mosaic object moves within a segment.
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For basic information on working with the Effect Editor, see “Using the Effect Editor” on page 68.

The following buttons appear on the right side of the Effect Editor for the Blur and Mosaic effects.

Creating and Modifying Blur and Mosaic Effects

To create a Blur or a Mosaic effect:

1. Click the Effect Mode button.

2. In the Effect Palette, click the Image category.

3. Drag the Blur Effect icon or the Mosaic Effect icon to a segment in the sequence.

Blur Effect icon (left) and Mosaic Effect icon (right)

4. Click either the Rectangle tool or the Oval tool.

Rectangle tool (left) and Oval tool (right)

5. Click in the Effect Preview monitor and drag to create an object.

Feathering Adds soft edges to a Blur or Mosaic object. Modifying the outline can 
make an object stand out from or blend into the background.

Blur or Mosaic Controls the overall appearance of the object area, allowing for varying 
degrees of distortion.

Parameter Description

Button Description

Selection tool Selects an object so you can change its parameters, move it, or 
delete it. With the Shift key pressed, selects multiple objects. 

Z-rotation tool Rotates an object around the Z axis.

Reshape tool Lets you reshape objects by manipulating anchor points at 
locations where new curves begin or straight lines intersect. 
Inserts additional control points.

Bring Forward Brings an object one layer forward on the screen.

Send Backward Sends an object one layer backward on the screen.

Rectangle tool Creates a square or rectangle object. The pointer changes to a 
crosshair when clicked.

Oval tool Creates a circle or oval to create an object. The pointer changes 
to a crosshair when clicked.
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Working with the Blur Effect and Mosaic Effect
A wire-frame outline of the object appears, and the default Blur or Mosaic effect appears in the 
Effect Preview monitor.

The following illustration shows a Mosaic effect in an oval object.

To modify the attributes of blur and mosaic objects:

1. Click the Selection tool, and click the object you want to change.

2. Use the Feathering parameter category to adjust the appearance of the outline of the object:

3. Use the sliders in the Blur or Mosaic parameter category to adjust the appearance of the blur or 
mosaic distortion:

4. Use the Z-Rotation and Reshape tools to customize the shape of the blur or mosaic object:

Parameter Description

Hor (horizontal) Adjusts the range of pixels along the X axis to which the effect applies.

Vert (vertical) Adjusts the range of pixels along the Y axis to which the effect applies.

Fixed Aspect Locks the horizontal and vertical sliders so that they move in unison. This 
controls how smoothly the effect blends with the background image.

Anti-alias Reduces the jaggedness of the edges of the object.

Parameter Description

Opac (opacity) Controls how prominently the blur or mosaic appears against the 
background image. A value of 0 makes the blur or mosaic transparent, 
while a value of 100 makes it fully opaque.

Hor (horizontal) and 
Vert (vertical)

Change the size of each tile within the effect along the X or Y axis, 
respectively. This controls the coarseness of the blur or mosaic.

Fixed Aspect Allows you to lock X and Y to the same values.

Blur Visible or 
Mosaic Visible

Switches the effect on and off in the Effect Preview monitor.

Parameter Description

Z-rotation Lets you rotate the object around a Z axis by manipulating the resize 
handles.
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The following illustration shows the handles on an object in a Mosaic effect.

5. Drag the center handle of the object to match the movement of the image in the clip.

Media Composer automatically adds a keyframe each time you drag the object to a new position.

Reshape Lets you create an irregular object by moving the resize handles 
individually.

Bring Forward and 
Send Backward

Apply when objects overlap. You use the buttons to define which 
object appears closer to the viewer.

Parameter Description
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16 PlasmaWipe Effects

• Understanding PlasmaWipe Effects

• Folder Structure for PlasmaWipe Effects

• Using PlasmaWipe Effects

• Creating Gradient Images for PlasmaWipe Effects

• Understanding PlasmaWipe Frame and Border Effects

• Applying and Adjusting PlasmaWipe Frame and Border Effects

• Creating Custom PlasmaWipe Border and Frame Effects

Understanding PlasmaWipe Effects
PlasmaWipe effects are two-stream, real-time effects that use gradient image bitmaps to create wipes 
and segment effects. There are 64 preset effects, and you can create your own by creating new 
gradient images.

PlasmaWipe effects uses the Level parameter value to define a threshold point that changes gradually 
from black to white. Media Composer replaces gray tones in the gradient image that are lighter than 
the threshold point by outgoing video, and gray tones that are darker than the threshold point by 
incoming video. As the threshold point gets closer to white, more of the incoming video appears. The 
result is a smooth, custom wipe.

The following illustration shows the black and white gradient image used by the Horiz Twirl 
PlasmaWipe effect and the resulting effect, with softness applied. The effect gradually reveals the 
incoming image in a curling spiral pattern. 



Understanding PlasmaWipe Effects
Top, left to right: outgoing image, gradient bitmap image, and incoming image. Center: stages of the gradient image as 
the Level parameter value changes from near black to near white. Bottom: sample frames of the transition effect that 
result from the gradient image stages above them. 

You can use PlasmaWipe effects on transitions to create custom wipes. You can use PlasmaWipe 
effects on segments as static wipes. For example, you can design a PlasmaWipe effect that gives the 
impression of fog on the top and bottom of the video image, or to create a custom border for an effect 
similar to a picture-in-picture effect. For information on the effects in the Border category, see 
“Understanding PlasmaWipe Frame and Border Effects” on page 446.

n Although PlasmaWipe effects are real-time, they are processor-intensive effects. They might be more 
likely than most real-time effects to require rendering if you combine them with other effects or 
multiple video streams.
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Folder Structure for PlasmaWipe Effects
The installer for Media Composer automatically installs the PlasmaWipe effects. Several 
PlasmaWipe effect categories appear in the Effect Palette, and a PlasmaWipes folder is created in the 
SupportingFiles folder of Media Composer. The following shows the default locations for the folder:

• (Windows) drive:\Program Files\Avid\Avid Media Composer\
SupportingFiles\PlasmaWipes

• (Macintosh) Macintosh HD/Applications/Avid Media Composer/
Supporting Files/PlasmaWipes

c (Macintosh only) If you create additional folders for your custom PlasmaWipe effects, back 
them up before you run the PlasmaWipes installer to replace or update the PlasmaWipes 
folder. The installer deletes and replaces the entire PlasmaWipes folder.

There are parallel folders for NTSC (720x486) and PAL (720x576) resolutions. When you create 
your own PlasmaWipe effects for use in SD projects, you create two versions of each effect, one for 
each resolution.

The following illustration shows the default PlasmaWipes folder structure.

Using PlasmaWipe Effects
To use a PlasmaWipe effect:

1. Apply the PlasmaWipe effect to a transition or segment.

2. Enter Effect mode, for example, by clicking the Effect Mode button.

For more information, see “Entering Effect Mode” on page 32.

The Effect Editor opens.

3. Adjust parameters (and add keyframes if necessary) in the Effect Editor.
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Creating Gradient Images for PlasmaWipe Effects
You can use three different approaches to create an image for a PlasmaWipe effect:

• Create a black and white gradient image in a graphics tool such as Adobe Photoshop.

For more information, see “Creating a Custom Image for a PlasmaWipe Effect” on page 439.

• Modify an existing image to create a black and white gradient image.

For more information, see “Creating a PlasmaWipe Effect from an Existing Image” on page 440.

• Create a wipe by drawing a wide brush stroke that changes smoothly from black to white.

For example, you can use the Pencil tool in Photoshop to create this type of image. For more 
information, see “Creating a PlasmaWipe Image Using the Pencil Tool” on page 441.

This document describes how to create gradient images using Adobe Photoshop. However, you can 
use any graphics tool, such as Corel® Paint Shop Pro®, that lets you create black and white gradient 
images and save the image as a raw image file (with a .raw extension).

The images in the PlasmaWipes folders are raw Photoshop images. You can open and inspect the 
images in Photoshop to get ideas for new effects.

Because PAL and NTSC require different resolutions for graphic images you must create two 
versions of your image as follows:

• A 720x576 pixel image for PAL

• A 720x486 pixel image for NTSC

It is better to start with a 720x576 image because it is the highest resolution.

The following tips apply to working with gradient images:

• Keep the graphic smooth without too many hard edges. This increases the number of levels 
(gradients) and creates a smoother wipe.

• Do not use dithering or antialiasing because they might add artifacts to the wipe. For example, 
when a graphics application performs antialiasing, it smooths out the edge of a line by blending 
the colors along the edge. These blended colors might force small portions of the incoming or 
outgoing video to appear at inappropriate times.

• If you use Photoshop, use the histogram to view the gradient levels of the image. This lets you 
ensure that the image uses all the available gradient values and that the effect plays smoothly.

For more information, see “Using the Histogram to Analyze PlasmaWipe Images” on page 442.

For information on the effects in the Border category, see “Understanding PlasmaWipe Frame and 
Border Effects” on page 446.

Creating a Custom Image for a PlasmaWipe Effect

This sample procedure uses Adobe Photoshop, but you can use any graphics tool that creates black 
and white gradient images and lets you save an image as a raw image file.

To create a gradient image using Adobe Photoshop:

1. Create a new file with the following characteristics:

- Image size: 720 pixels (width) by 576 pixels (height)
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Creating Gradient Images for PlasmaWipe Effects
- Resolution: 72 pixels/inch (you can use any resolution)

- Mode: Grayscale

2. Create a black and white graphic.

For example, use the Gradient tool to create a basic pattern with the following settings:

- Foreground: black

- Background: white

- Opacity: 100%

3. (Option) Use distortion filters such as Spherize, Twirl, or Ripple to modify the image.

The following illustration shows a gradient image modified by two separate distortion 
operations.

Left to right: Gradient image, image with Swirl filter applied, and image with Ripple filter applied

4. (Option) Perform image operations to create different effects.

For example, you can copy different gradient images to separate layers and experiment with 
blending the layers. 

n For information on blending layers, see your Photoshop documentation.

5. Save the image as a raw image file as described in “Saving a PlasmaWipe Image for PAL and 
NTSC” on page 444. 

Creating a PlasmaWipe Effect from an Existing Image

This sample procedure describes how to create a gradient image from an existing image using Adobe 
Photoshop. You can use any graphic, but images with rich texture often give the best results.

Examples of PlasmaWipe images: image used by Falling Text effect (left) and image used by Lava Flow 3 effect (right)

To create a gradient image from an existing image using Adobe Photoshop:

1. Open an existing graphics file.

2. Select Image > Image Size.

The Image Size dialog box opens.
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3. Change the image size to 720 pixels x 576 pixels.

4. Deselect Constrain Proportions.

5. Click OK.

6. Select Image > Mode > Grayscale.

7. Open the Histogram palette and use the histogram to ensure that the image uses the full range of 
gradient values.

For more information on using histograms, see “Using the Histogram to Analyze PlasmaWipe 
Images” on page 442.

8. Click OK.

9. Save the image as a raw image file as described in “Saving a PlasmaWipe Image for PAL and 
NTSC” on page 444. 

Creating a PlasmaWipe Image Using the Pencil Tool

This sample procedure describes how to use Adobe Photoshop to create a gradient image similar to 
the images in the PlasmaWipes/Avid/Paint folder. The wipe effect simulates uncovering the incoming 
video by wiping away the outgoing video with a brush or cloth.

To create a gradient image using the Pencil tool in Adobe Photoshop:

1. Ensure that the background color selection is set to black and the foreground color selection box 
is set to white.

2. Create a new file with the following characteristics:

- Image size: 720 pixels (width) by 576 pixels (width)

- Resolution: 72 pixels/inch (you can use any resolution)

- Mode: Grayscale

- Background Contents: Background Color

3. Select the Pencil tool.

The pencil tool is useful for this method because it creates hard edges.

4. Click Other Dynamics in the Brushes palette.

5. In the Opacity Jitter parameter area, click the Control menu and select Fade.

6. Enter a high Step number in the Control text box (for example, 500).

This creates a pencil stroke that fades from white to black (foreground to background color) in 
small increments.

7. Click Brush Presets, and select a wide pencil shape, for example 100 pixels or higher.

You can also create a custom brush.

8. Close the Brushes palette.

9. Set Opacity to 100%.

10. Start anywhere in the image and draw back and forth across the image, covering the entire image 
from top to bottom.

This creates a wide pencil mark that changes the color from white to black.
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Draw the line as if you are painting the wipe backwards from white to black. When the wipe 
plays, the darkest parts of the image are replaced by incoming video first. For example, to create 
an effect similar to Paint Strokes 4, start drawing in the upper left corner and draw concentric 
rectangles until you reach the center. This wipe starts in the center and spreads out in concentric 
rectangles. Paint Strokes 2 creates a wipe effect with a crisscross pattern.

Examples of PlasmaWipe Paint images: image used by Paint Strokes 4 effect (left) and image used by Paint 
Strokes 2 effect (right)

11. (Option) Apply filters to the image to change the edges.

For example, select Filter > Distort > Ripple to apply a Ripple effect.

12. Save the image as a raw image file as described in “Saving a PlasmaWipe Image for PAL and 
NTSC” on page 444. 

n When you resize the image for NTSC, select Resample Image > Nearest Neighbor. This maintains the 
sharp edges in the image.

Using the Histogram to Analyze PlasmaWipe Images

The Histogram palette in Adobe Photoshop shows the distribution of grayscale value for your 
PlasmaWipe image. Other graphics tools also typically provide a histogram display.

The wider the range of gradient values (levels), the smoother the resulting animation. For example, 
the following illustrations show two histograms. The one with the wide range of gradient values 
creates a smoother animation.

Histogram examples: image that does not use all available gradient values (left) and image that does use all available 
values (right)

A horizontally smooth histogram results in an animation that does not have abrupt changes. If the 
histogram has a wide vertical range, the wipe might come in quickly and then slow down. The 
following illustrations show two histograms. The image with the peak creates an animation that starts 
quickly, slows down as it gets to the middle of the effect, and then speeds up again. The image with 
the smooth histogram creates an animation with a constant speed.
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Histogram examples: image that will not animate at a constant speed (left) and image that will animate at a constant 
speed (right)

Depending on the effect you want to create, the image associated with either type of histogram might 
create an acceptable animation as long as it uses the full range of gradients.

n If you want to change the speed of the wipe, you can use keyframes to control the Level parameter.

You can use Adobe Photoshop commands such as Equalize, Auto Levels, or Auto Contrast to 
increase the range of gradient values. For more information, see your Adobe Photoshop 
documentation.

Adjustments such as Equalize might result in a histogram that has a wide range of gradients but that 
has many gaps in the values. In a short wipe effect the gaps are not noticeable. In a long effect, the 
gaps might create doubled frames in the animation. You can use a blur filter such as Gaussian Blur to 
smooth out the range. For more information, see your Adobe Photoshop documentation.

Example of a histogram with gaps

Testing a PlasmaWipe Animation

You can use the following procedure in Adobe Photoshop to preview the animation for your gradient 
image. This example uses the Horiz Twirl image from the PlasmaWipes folder.

To test an animation:

1. Select Image > Adjustments > Brightness/Contrast.

The Brightness/Contrast dialog box appears. The following illustration shows the image and the 
Brightness/Contrast dialog box.

2. Move the Contrast slider all the way to the right to view the animation with hard edges. 
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3. To view the animation with some softness applied, move the Contrast slider to the left to select a 
lower Contrast number.

4. Move the Brightness slider from left (-100) to right (+100) to view the animation.

The following images show three stages of the animation.

Saving a PlasmaWipe Image for PAL and NTSC

This sample procedure is for use with Adobe Photoshop and assumes that you have created a PAL 
version of your image (720x576 pixels), for example, as described in “Creating a Custom Image for a 
PlasmaWipe Effect” on page 439.

To save a gradient image:

1. Make a backup copy of the image.

2. If the image has multiple layers, flatten the image.

3. Select File > Save As.

The Save As dialog box appears.

4. Name the file, and select Format > Photoshop Raw (*.RAW).

The system saves the file as a raw Photoshop image with a .raw extension. This is the 720x576 
(PAL) version of the image.
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5. Save an NTSC version of the image by doing the following:

a. Select Image > Image Size.

b. In the Height text box, change the image height to 486 pixels. Keep the image width at 720 
pixels.

c. Deselect Constrain Proportions.

d. Select Resample Image, and then select Resample Image > Bicubic, or, if the image has hard 
edges, select Resample Image > Nearest Neighbor.

e. Click OK.

f. Select File > Save As.

The Save As dialog box opens.

g. Name the file as described in step 4.

c The name you choose for the image becomes the name of the effect that appears in the Effect 
Palette. Ensure you use exactly the same name for the PAL and NTSC versions of the file.

6. Store the two images in the PlasmaWipes folder structure.

For more information, see “Storing Images in the PlasmaWipes Folder Structure” on page 445.

Storing Images in the PlasmaWipes Folder Structure

You must store your PlasmeWipe images in the correct folders so that Media Composer can 
recognize the files. For more information on the folder structure, see “Folder Structure for 
PlasmaWipe Effects” on page 438.

To store your Plasma Wipe image files:

1. Give your image files unique names so that you can recognize the files if you copy them to 
another system.

c The name you choose for the image becomes the name of the effect that appears in the Effect 
Palette. Ensure you use exactly the same name for the PAL and NTSC versions of the file.

2. Create new folders to organize your new effects. Create identical folders within the 720x486 
folder and the 720x576 folder in your PlasmaWipes folder.

Do not store your files in the Avid folders because the folders might be overwritten when you 
update your Avid software. Create folders within the 720x486 folder and the 720x576 folder at 
the same level as the Avid folder. You can use any number of nesting levels for your folders in 
order to organize your effects. Media Composer system displays the full path as part of the name 
in the effect category.

(Macintosh only) If you create additional folders for your own custom PlasmaWipe effects, back 
them up before you run the PlasmaWipes installer to replace or update the PlasmaWipes folder. 
On the Macintosh operating system, the installer deletes and replaces the entire PlasmaWipes 
folder.

3. Copy your images to the new folders.

4. Restart Media Composer.

Your new effects appear in the Effect Palette.
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Understanding PlasmaWipe Frame and Border Effects
n If you move sequences that use your new wipes to another system, you must copy the wipes to that 
other system. You must maintain the same folder structure on each system that uses your effects.

Adjusting an Existing PlasmaWipe Effect While Media Composer is Running

If you add new effects, you must restart Media Composer to see the effects in the Effect Palette. 
However, you can adjust a PlasmaWipe effect that you have previously created without having to 
restart. This helps when testing changes to one of your effects.

To adjust an existing effect while Media Composer is running:

1. Edit the older version of the effect into a sequence.

2. Locate the PlasmaWipes folder and replace the old effect with the new effect in the appropriate 
folder.

3. In the Timeline bottom toolbar, click the Video Quality menu button and select a lower video 
quality.

4. Click the effect icon in the Timeline and move the position indicator to update the effect in the 
Timeline.

5. Click the Video Quality menu button and select a higher video quality.

Media Composer replaces the effect with the new version.

Understanding PlasmaWipe Frame and Border Effects
PlasmaWipe frame and border effects let you add a variety of edge treatments to a clip. The following 
illustrations show several examples.

Top left: Stone Frame Medium effect. Top right: Stone Frame Large effect applied to a resized and repositioned Picture-
in-Picture effect. Bottom, left to right: Soft Sky effect, Soft Window effect used as a picture-in-picture, Soft Window effect 
used to darken edges.

Frame and border effects are in the PlasmaWipe Avid Borders category of the Effect Palette.
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Border effects let you darken the edges and corners of an image or give a tint or shadow to the sky as 
though the image were shot through a lens filter. Border effects include the following:

• Round Border

• Soft Sky

• Soft Window

• Square Border

Frame effects allow for textured, colored frames and have the word Frame in their name. There are 
three versions of each:

• Large places a frame around the entire image and is intended for use with DVE effects such as 
picture-in-picture (PIP) effects.

• Medium and Small remain centered in the image and cannot be resized or repositioned.

Frame effects are segment effects only. You can use Border effects like Soft Sky as either segment 
effects or transition effects, but they are intended primarily as segment effects. 

n You can achieve effects similar to frame effects if you import a Matte key created in an application 
such as Photoshop. Frame effects have the added benefit of allowing you to adjust the frame color 
within Media Composer.

Default Values for PlasmaWipe Frame Effects

Frame effects have different default values from other PlasmaWipes effects because frame effects 
usually have crisp edges between the video and the frame graphic. Other PlasmaWipe effects often 
blend video clips together and can benefit from some amount of softness.

In order to determine which default values to use, the PlasmaWipes software looks for the words 
border and frame in the pathname to the effect source graphic. If both words appear in the path, the 
software applies the frame effect defaults (and only allows the effect to be used as a segment effect). 
Otherwise the software applies the defaults used for all other PlasmaWipes. For example, the 
following two effects use the frame effect defaults:

• PlasmaWipes/720x486/Avid/Borders/Stone Frame Large

• PlasmaWipes/720x486/MyEffects/MyFrames/Large Stone Border

Applying and Adjusting PlasmaWipe Frame and 
Border Effects

To apply a PlasmaWipe frame effect or border effect:

t Drag the effect icon from the Effect Palette to the segment in the Timeline.

To apply a PlasmaWipe frame or border effect to an existing DVE such as a Picture-in-Picture 
effect:

1. Apply the Picture-in-Picture effect to a clip in the Timeline.

2. Double-click the effect’s icon in the Timeline.

Media Composer steps into the effect and displays the nested tracks.

3. Drag the frame or border effect icon from the Effect Palette to the upper track in the nested 
effect.
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4. Double-click the Picture-in-Picture effect icon again to step out of the nested effect.

5. Adjust the parameters for the Picture-in-Picture effect.

n The Frame Large effects are designed for use with DVEs such as the Picture-in-Picture effect.

To adjust a frame effect or border effect:

1. (Option) If the effect is part of a nested effect, step into the effect.

2. For Frame effects, adjust the Border and Blend color to change the color of the frame.

The color modifies the effect as follows:

- Border adjusts the base color of the frame.

- Blend Color adjusts the highlight color.

3. Adjust the Soft (softness) and Foreground Level parameters. 

If you want to adjust a border effect to darken the edges of an image, use the Foreground Level 
parameter to expand the border to the edges of the image. Then modify the border using the Soft, 
Border color, and Border Blend parameters. 

n You usually do not want to keyframe the Foreground Level parameter on a frame effect. The source 
graphics for PlasmaWipe frame effects have a sharp transition between black and white values and 
you might find that the change from foreground to background video happens too quickly.

Creating Custom PlasmaWipe Border and Frame 
Effects

For border effects such as Soft Sky or Square Window, you can use the technique described in 
“Creating Gradient Images for PlasmaWipe Effects” on page 439.

Frame effects have the following unique requirements:

• You must use an image with a 4:3 aspect ratio to create the frame graphic.

For example, start with a 720x540 pixel image. After you create the frame graphic, save it as the 
correct size for PAL or NTSC as described in “Saving a PlasmaWipe Image for PAL and NTSC” 
on page 444.

• For best results, keep distinct boundaries between the black, white, and gray portions of your 
image. Do not blend between black and gray or between white and gray areas.

For example, the following illustration shows the image for the Stone Frame Small effect.
448
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Foreground video displays through the black area and background video displays through the 
white area. If you allow the gray area to blend with the black, portions of the frame might appear 
within the background video area and portions of the foreground video might appear within the 
frame.

The histogram for a frame graphic does not need to contain a wide range of gradient values. In fact, 
there will be large portions of the image that are completely black or white.

To create a custom frame graphic:

1. Create a new file with the following characteristics:

- Image size: 720 pixels (width) by 540 pixels (height)

- Resolution: 72 pixels/inch (you can use any resolution)

- Mode: Grayscale

n The 720x540 size ensures that the original image has a 4:3 aspect ratio. This lets you create a frame 
that fits correctly within the video image.

2. Display the Photoshop grid to allow for precise placement of the frame and interior area.

Use a grid size of one gridline every 36 pixels.

3. Create a frame graphic using the grid lines as a guide.

4. Modify the grayscale image and apply filter effects as necessary.

5. Color the inside of the frame black. 

6. If you want background video to appear around the frame, color that area white.

7. Flatten the image to remove extra layers.

8. Make a copy of the image.

9. Save one copy as 720x576 (PAL) and another as 720x486 (NTSC) as described in “Saving a 
PlasmaWipe Image for PAL and NTSC” on page 444.

n Select the Nearest Neighbor resampling option to avoid blending between the black, white, and gray 
areas of the image.

To create a frame graphic from an existing image:

1. Open an existing image, such as a graphic of a stone slab, piece of wood, or wooden frame.

2. Select Image > Image Size.

The Image Size dialog box appears.

3. Change the image size to 720 pixels x 540 pixels.

4. Deselect Constrain Proportions.

5. Click OK.

6. Select Image > Mode > Grayscale.

7. Use the Photoshop grid with a grid size of one gridline every 36 pixels to allow for precise 
placement of the frame and interior area.

8. Modify the grayscale image and apply filter effects as necessary.

9. Color the inside of the frame black. 

10. If you want background video to appear around the frame, color that area white.
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11. Flatten the image to remove extra layers.

12. Make a copy of the image.

13. Save one copy as 720x486 (for NTSC) and another as 720x576 (for PAL) as described in 
“Saving a PlasmaWipe Image for PAL and NTSC” on page 444.

n Select the Nearest Neighbor resampling option to avoid blending between the black, white, and gray 
areas of the image.
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17 Effects Reference

This chapter provides reference information for all standard effects available for Media Composer.

For information on effects editing, begin with “Basics of Effects Editing” on page 27. For reference 
information on parameters for effect adjustment, see “Effects Parameter Reference” on page 491. For 
information on Audio Track effects, see “Using Audio Plug-Ins” in the Help.

Effects are listed within their effect categories, as follows:

Reference information includes:

• An illustration of the effect’s icon

• A description of the effect

• Information on where to apply the effect (to transitions, single-layer segments, or multilayer 
segments)

Effects that you can apply to transitions have active transition parameters available at the bottom 
of the Effect Editor. For more information, see “Transition Parameters” on page 500

• Indication of the real-time status of the effect, where appropriate.

All standard Avid effects are real-time effects unless otherwise noted in this chapter. For more 
information, see “Playing Real-Time Effects” on page 40.

• Information on whether you can promote the effect (to 3D or SpectraMatte)

For more information, see “Promoting 2D Effects to 3D Effects” on page 284 and “Promoting a 
Chroma Key Effect to the SpectraMatte Effect” on page 205.

• Information on the processing bit depth capabilities of the effect

Most effects support both 8-bit and 16-bit processing. For more information, see “Using 16-Bit 
Processing Support for Rendered Effects” on page 138.

• “Blend Effects” on page 452

• “Box Wipes” on page 454

• “Conceal Effects” on page 454

• “Edge Wipes” on page 455

• “Film Effects” on page 456

• “Generator Effects” on page 458

• “Illusion FX Effects” on page 459

• “Image Effects” on page 465

• “Key Effects” on page 469

• “L-Conceal Effects” on page 472

• “Matrix Wipes” on page 473

• “Motion Effects” on page 474

• “Peel Effects” on page 475

• “PlasmaWipe Effects” on page 476

• “Push Effects” on page 476

• “Reformat Effects” on page 477

• “Sawtooth Wipes” on page 478

• “Shape Wipes” on page 479

• “Spin Effects” on page 481

• “Squeeze Effects” on page 482

• “Timewarp Effects” on page 483

• “Title Effects” on page 488

• “Xpress 3D Effects” on page 489



Blend Effects
• Information on the RGB processing capabilities of the effect

Most effects support processing in the RGB color space, but a small number of effects do not.

• A cross-referenced list of effect parameter categories available for that effect

• Where useful, illustrations of the effect’s behavior

For illustrations that help you understand the differences between similar types of transition effects, 
see “Comparison of Similar Effects” on page 490.

Blend Effects
Blend effects are general two-channel 2D effects, except for 3D Warp. (Two specialized blend effects 
are also available for creating a film look. For more information, see “Film: Film Dissolve and Film 
Fade” on page 458.)

Blend: 3D Warp

Blend: Dip to Color, Dissolve, Fade from Color, and Fade to Color

Provides direct access to a full set of parameter categories for making 3D and other advanced adjustments 
to effects. For information on using the 3D Warp effect, see “Applying the 3D Warp Effect” on page 283.

Apply to Transitions, single-layer segments, or multilayer segments

Real-time status Real-time in most circumstances. For more information on real-time playback for 
3D effects, see “Real-Time Playback of 3D Effects” on page 285.

Bit depth processing 8-bit and 16-bit. 16-bit requires the use of the HQ (Highest Quality) button in the 
Effect Editor. For more information, see “Rendering 3D Effects Using the HQ 
(Highest Quality) Option” on page 141.

RGB processing Available for most parameter categories. For more information, see “3D Effect 
Parameters” on page 573.

Parameter categories Shape; Corner Pin; Corner Corner Tracking; Crop (3D); Scaling (3D); Axis; 
Skew; Rotation; Position (3D); Perspective; Target; Border (3D); Highlight; 
Highlight Color; Lowlight Color; Defocus; Shadow; Trail; Stamp; Foreground 
(3D); Spill Suppression; Erode/Expand; Background Color (3D)

Dip to Color fades from the outgoing video to any color and then fades up to the incoming video.

Dissolve blends images from the outgoing video with the incoming video over time.

Fade from Color fades from any color to incoming video.

Fade to Color fades from the outgoing video to any color.

Apply to Transitions

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Foreground; Background Color; Grid (not available for all project types)
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Blend Effects
Blend: Picture-in-Picture

Blend: Superimpose

Illustrations

Left to right: outgoing image, middle of Dissolve effect, incoming image

Creates a picture within a picture. Video on the top layer, where you apply the effect, appears inside the 
video on the bottom layer. On a transition, the incoming video appears inside the outgoing video.

Apply to Transitions, multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Foreground; Scaling; Position; Crop; Grid (not available for all project 
types)

Illustrations

Left to right: outgoing image, Picture-in-Picture effect, incoming image

Blends the image from the top video track (where you apply the effect) with the image from the bottom 
video track over time. The Foreground Level slider controls the blend percentage over time. When 
Level=100, only the top image is visible, and when Level=0, only the bottom image is visible.

Apply to Multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Foreground; Grid (not available for all project types)

Illustrations

Left to right: bottom track, Superimpose effect, top track
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Box Wipes
Box Wipes
Box Wipes use an expanding box shape to create transitions to the incoming video.

n For examples of similar effects, see “Comparison of Similar Effects” on page 490.

Conceal Effects
Conceal effects use a predefined path to overlap one video channel over the other.

n For examples of similar effects, see “Comparison of Similar Effects” on page 490.

Incoming video begins as a box and wipes out the outgoing video as the box expands to fill the screen. 
Eight Box Wipe effects, named for the direction in which the effect moves, are available:

• Bottom Box

• Bottom Left to Top Right

• Bottom Right to Top Left

• Left Box

• Right Box

• Top Box

• Top Left to Bottom Right

• Top Right to Bottom Left

The effect icons for the category indicate the starting position of the box.

Apply to Transitions, multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Foreground; Grid (not available for all project types)

Illustrations

Left to right: outgoing image, middle of Bottom Box effect, incoming image

Left to right: outgoing image, middle of Top Left to Bottom Right effect, incoming image
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Edge Wipes
Edge Wipes
Edge Wipes wipe an edge across the screen to reveal one video channel on top of the other.

Incoming video slides on top of the outgoing video. Eight Conceal effects, named for the direction in which 
the wipe moves, are available:

• Bottom Left to Top Right

• Bottom Right to Top Left

• Bottom to Top

• Left to Right

• Right to Left

• Top Left to Bottom Right

• Top Right to Bottom Left

• Top to Bottom

The effect icons for the category indicate the starting position of the box.

Apply to Transitions, single-layer segments, or multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Foreground; Grid (not available for all project types)

Illustrations

Left to right: outgoing image, middle of Bottom Left to Top Right effect, incoming image

Left to right: outgoing image, middle of Right to Left effect, incoming image
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Film Effects
Film Effects
Film effects emulate many of the effects an optical house can produce.

Incoming video begins at the edge or center of the screen and moves out to wipe away the outgoing video. 
Eight Edge Wipe effects, named for the direction in which the wipe moves, are available:

• Horizontal

• Horizontal Open

• Lower Left Diagonal

• Lower Right Diagonal

• Upper Left Diagonal

• Upper Right Diagonal

• Vertical Open

• Vertical

The effect icons for the category indicate the starting position of the box.

Apply to Transitions, multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All Edge Wipes: Foreground; Grid (not available for all project types)

Horizontal, Horizontal Open, Vertical Open, and Vertical effects: Border

Lower Left Diagonal, Lower Right Diagonal, Upper Left Diagonal, Upper Right 
Diagonal effects: Scaling

Illustrations

Left to right: outgoing image, middle of Horizontal Open effect, incoming image

Left to right: outgoing image, middle of Upper Right Diagonal effect, incoming image
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Film Effects
Film: Mask Effects — 1.66 Mask, 1.85 Mask, 16:9 Mask, Anamorphic Mask, Mask

Film: Blowup

Masks out with a black background any area of the image that is not inside a specified rectangle. Five Film 
Mask effects are available:

• 1.66 Mask — the rectangle is 1.66 times wider than it is tall.

• 1.85 Mask — the rectangle is 1.85 times wider than it is tall.

• 16:9 Mask — the rectangle is 16 units wide by 9 units high.

• Anamorphic Mask — the rectangle is 2.35 times wider than it is tall.

• Mask — you can define a custom rectangle by adjusting the effect’s Scaling and Position parameters.

Apply to Single-layer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Background Color; Scaling; Position; Grid (not available for all project types)

Illustrations

Original image (left) and 1.66 Mask effect

Modifies the size and portion of an image.

Apply to Single-layer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Background Color; Blowup; Crop; Grid (not available for all project types)

Illustrations

Original image (left) and Blowup effect
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Generator Effects
Film: Film Dissolve and Film Fade

Generator Effects
Generator effects let you add subtitle, captioning, timecode, or production comment text to your 
video.

Generator: SubCap

The Film Dissolve effect blends the outgoing frame to the incoming frame over time. It has preset 
parameters that emulate film’s response to light when dissolving to another (nonblack) picture.

The Film Fade effect blends to the incoming frame over time. It has preset parameters that emulate film’s 
response to black material. Use this effect for fade-ins and fade-outs.

For both effects, the Level parameter is preset to Kodak™ specifications. Avid does not recommend 
adjusting the Level parameter. The Level set at 0% shows all of the outgoing frame; the Level set at 100% 
shows all of the incoming frame.

Apply to Transitions

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Foreground; Grid (not available for all project types)

Illustrations

Left to right: outgoing image, middle of Film Dissolve effect, incoming image

Lets you add caption or subtitle text to the video in your sequences. For more information, see “Working 
with the SubCap Effect” on page 368.

You cannot keyframe SubCap parameters and you cannot promote the SubCap effect.

Apply to Segments on video tracks above all other video content

Bit depth processing 8-bit and 16-bit

RGB processing Not available

Parameter categories See “SubCap Effect Parameters” on page 502 and “SubCap Effect Global 
Properties” on page 505.
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Illusion FX Effects
Generator: Timecode Burn-In

Illusion FX Effects
The Illusion FX category contains a variety of transition and segment effects. Illusion FX effects use 
the AVX plug-in architecture.

Most Illusion FX effects have an Input Parameters parameter category containing controls that vary 
from one Illusion FX effect to another. For more information, see “Illusion FX Effect Parameters” on 
page 510.

Several Illusion FX effects share a Border effect parameter category that has different controls from 
the Border parameter category in other effect types. For more information, see “Border Parameter for 
Illusion FX Effects” on page 510.

This topic groups information for the Illusion FX effects in three tables as follows:

• Segment effects (except FluidBlur and FluidColorMap)

• Transition effects (except FluidMorph)

• FluidBlur, FluidColorMap, and FluidMorph

These three effects use high-quality blurring techniques and are non-real-time.

Lets you add timecode displays that update in real time, or text annotations, to the video in your sequences.

You cannot keyframe Timecode Burn-In parameters and you cannot promote the Timecode Burn-In effect.

Apply to Single-layer segments.

A typical use is to apply the effect to an empty video track above all other video 
content. You can then turn the track on or off as necessary to display timecode 
information or other annotations for some versions of the sequence but not others.

Bit depth processing 8-bit only

RGB processing Not available

Parameter categories See “Timecode Burn-In Effect Parameters” on page 506.
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Illusion FX Effects
Illusion FX: Segment Effects — Color Mix, Crystal, Film Grain, Flare, Kaleidoscope, 
Lightning, Motion Blur, Pattern Generator, Pinch, Radial Blur, Ripple, Sparkler, Sphere, 
Swirl, Twist, Wave

Eighteen Illusion FX effects are segment effects. FluidBlur and FluidColorMap are described separately in 
the final table in this topic. The following are the remaining segment effects:

• Color Mix lets you blend a solid color with the image.

• Crystal uses polygons to create a mosaic effect. You can control the size of the polygons and the 
randomness of their shape.

• Film Grain adds a grainy texture to a video clip to simulate the imperfections present in some film 
footage, such as 16mm stock.

• Flare creates a random ring flare. You can control the brightness, size, and center of the flare.

• Kaleidoscope creates an animation that resembles a kaleidoscope. You can control the number, angle, 
and position of the mirrors as well as the source area for the effect.

• Lightning creates a random lightning pattern

• Motion Blur lets you blur the edges of moving objects. FluidBlur and Motion Blur are similar effects. 
FluidBlur creates a higher quality effect because it blurs in the direction of travel, but FluidBlur is a 
non-real-time effect that always requires rendering.

• Pattern Generator creates a clip using a solid color, a variety of color bars, or a grid. The frames can be 
numbered automatically, and a circle can be animated. This effect is useful for testing purposes.

• Pinch pinches the image in toward, or pushes it out from a user-defined point. You can control the 
amount of distortion and the area affected.

• Radial Blur blurs the image inward or outward from a user-defined point, and around a user-defined 
rotation. You can control the zoom factor.

• Ripple creates ripples on the image, as if you dropped a stone into a pond. You can control the number 
of ripples; their size, speed, and spread; and the color and direction of the light.

• Sparkler creates random sparks or fireworks. You can control the number and nature of the sparks.

• Sphere creates a spherical distortion in the image. You can control the size and position of the sphere.

• Swirl distorts the image by swirling the pixels within a circular area. You can control the size and 
position of the circle and the amount of swirl.

• Twist distorts the image by twisting the two ends in opposite directions. You can control the position 
and the amount of the twist.

• Wave distorts the image by applying a user-defined number of waves to it. You can control the size of 
the waves.

Apply to Single-layer segments

Bit depth processing 8-bit only

RGB processing Available
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Illusion FX Effects
Parameter categories For all effects:  Input Parameters; Grid (not available for all project types)

For Crystal, Kaleidoscope, Pinch, Radial Blur, Ripple, Sphere, Swirl, Twist, and 
Wave effects:  Border

For Kaleidoscope effect: Center; Offset

For Lightning effect:  Generation; Core; Glow

For Pattern Generator effect: Background; Number; Circle

For Ripple effect:  Motion; Generation; Illumination

For Sparkler effect: Generation; Movement; Glow; Core
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Illusion FX Effects
Illustrations

Top, left to right: examples of Color Mix, Crystal, and Film Grain. Center, left to right: 
examples of Flare, Kaleidoscope, and Lightning. Bottom, left to right: examples of Motion 
Blur, Pattern Generator, and Pinch

Top, left to right: examples of Radial Blur, Ripple, and Sparkler. Center, left to right: 
examples of Sphere, Swirl, and Twist. Bottom: example of Wave
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Illusion FX Effects
Illusion FX: Transition Effects — Iris, Melt, Pagecurl, Particle Blast, Particle Orbit, Particle 
Wind, Random Blend, Rollup, Shear

Ten Illusion FX effects are transition effects. FluidMorph is described separately in the final table in this 
topic. The following are the remaining transition effects:

• Iris wipes the foreground clip away to reveal the background clip, using a circle that radiates out from 
the center. You can control the softness of the edge of the circle.

• Melt melts away the foreground clip to reveal the background clip. The foreground clip “melts” 
downward off the screen, while being distorted in a random “liquid” manner along the horizontal lines; 
the vertical lines are not distorted. You can control the strength of the distortion.

• Pagecurl treats the foreground video channel as though it were a sheet of paper being rolled over to 
reveal another page beneath. Pagecurl and Rollup are similar effects. Rollup has more flexibility, but 
Pagecurl adds a highlight along the curled edge.

• Particle Blast divides the foreground image into circular particles and then blows away the particles 
from the center outward.

• Particle Orbit divides the foreground image into circular particles, which then orbit around their 
original position. You can control the size and spacing of the particles.

• Particle Wind divides the foreground image into circular particles and then blows the particles away 
directionally.

• Random Blend uses a random pattern to blend the image of the incoming and outgoing video.

• Rollup rolls up the foreground clip to reveal the background clip. You can control the size and direction 
of the rollup. Rollup and Pagecurl are similar effects. Rollup has more flexibility, but Pagecurl adds a 
highlight along the curled edge.

• Shear divides the foreground clip into strips and moves alternate strips away in opposite directions to 
reveal the background clip.

Apply to Transitions

Bit depth processing 8-bit only

RGB processing Available

Parameter categories For all effects: Input Parameters; Grid (not available for all project types)

For Melt, Particle Blast, Particle Orbit, Particle Wind, Rollup, and Shear effects:  
Border
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Illusion FX Effects
Illusion FX: FluidBlur, FluidColorMap, and FluidMorph

Illustrations

Top, left to right: examples of Iris, Melt, and Pagecurl
Center, left to right: examples of Particle Blast, Particle Orbit, and Particle Wind
Bottom, left to right: examples of Random Blend, Rollup, and Shear

FluidBlur creates a motion blur. The amount of blur is based on the amount of motion in the clip. Only 
objects that are moving from one frame to the next are blurred. FluidBlur creates a higher quality effect 
than the Illusion FX Motion Blur effect because it blurs in the direction of travel. You must render this 
effect to see the result.

FluidColorMap creates animation based on the amount of motion in a scene. Motion maps to color values 
as follows:

• Direction of movement maps to unique chroma (color) values. A different color is used for each 
direction within a 360° circle. Media Composer uses the Vectorscope layout (used in the Video Input 
tool) as a compass of color values.

• Motion magnitude maps to luminance (brightness) and color saturation values. Motion magnitude is 
defined as the amount of pixels an object moves between frames (or fields).

FluidMorph lets you morph between two clips.

Apply to Single-layer segments (FluidBlur and FluidColorMap)

Transitions (FluidMorph)

Real-time status Non-real-time

Bit depth processing 8-bit only

RGB processing Available

Parameter categories For all effects:  Input Parameters; Border; Grid (not available for all 
project types)

For FluidMorph: Source 
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Image Effects
Image Effects
Image effects are general effects that apply to a single stream of video or (in the case of Scratch 
Removal and Submaster) that modify all the layers of video beneath them.

Image: Avid Pan & Zoom

Image: Blur Effect and Mosaic Effect

Lets you import a high-resolution still image, and then pan and zoom over it. You can preview the 
movement in real time with no filtering and render the effect with a wide range of filtering options that 
provide exceptional image quality. For more information, see “Using Avid Pan & Zoom” on page 230.

Apply to Single-layer segments

Bit depth processing 8-bit only

RGB processing Available

Parameter categories  Other Options button; Display; Display Options; Size; Position; Velocity; Path; 
Filtering; Background; Advanced; Cache; Render Mode; Grid (not available for 
all project types)

The Blur Effect applies a blur effect to a selected area that you can animate and edit on one frame or a 
series of frames. This is useful for distorting or disguising part of an image.

The Mosaic Effect applies a tile effect to a selected area that you can animate and edit on one frame or a 
series of frames. This is useful for distorting or disguising part of an image.

Apply to Single-layer or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories For both effects: Acceleration; Corner Tracking; Feathering; Grid (not available 
for all project types)

For Blur Effect:  Blur

For Mosaic Effect:  Mosaic

Illustrations

Blur Effect (left) and Mosaic Effect (right)
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Image Effects
Image: Color Correction

Image: Color Effect

Image: Field Swap

Image: Flip, Flip-Flop, and Flop

The Color Correction effect lets you access the tools available in Color Correction mode from the Effect 
Palette. Depending on Media Composer, you might use the Color Correction effect when you need to 
create a color correction that can be nested within other effects, when you want to apply automatic color 
corrections in a single step, or when you want to apply a color correction saved as an effect template. 

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Grid (not available for all project types)

Color Correction parameters (the set of parameters available depends on the 
Color Correction tools available on Media Composer)

Modifies the luminance, chroma, color style (posterized or solarized), and color gain of the segment. You 
can use the Color Effect to perform keyframeable color corrections.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories  Luma Adjust; Luma Range; Luma Clip; Chroma Adjust; Color Style; Color 
Gain; Grid (not available for all project types)

Inverts the fields of any interlaced media.

Bypass Allows you to bypass the effect.

Flip flips the video image vertically.

Flip-Flop flips the video image both horizontally and vertically.

Flop flips the video image horizontally, which reverses the camera angle.

Apply to Single-layer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Grid (not available for all project types)
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Image Effects
Image: Mask

Image: Paint Effect

Illustrations

Top: original image. Bottom, left to right: Flip effect, Flip-Flop effect, and Flop effect

Masks out any area of the image that is not inside a rectangle defined by the Scaling and Position 
parameters of the effect. The area surrounding the rectangle is masked by the effect’s background color.

Apply to Single-layer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Background Color; Scaling; Position; Grid (not available for all project types)

Enhances the creative and corrective powers of Media Composer by allowing you to create vector-based 
objects that you can animate and edit with customizable paint brushes on one frame or a series of frames. 
For examples of the Paint Effect, see “Intraframe Editing” on page 382.

Apply to Single-layer or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Acceleration; Corner Tracking; Mode; Feathering; Magic Mask; Color; Brush; 
Grid (not available for all project types)
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Image Effects
Image: Resize

Image: Safe Color Limiter

Image: Scratch Removal

Modifies the size and position of the video. The background color displays where no video is present. Use 
the H Pos, V Pos, and Size sliders to specify the size and position of the video. Use the Crop parameters to 
remove the edges of the picture.

Apply to Single-layer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Background Color; Scaling; Position; Crop; Grid (not available for all 
project types)

Illustration

Left to right: original image, Resize effect with reduced image, Resize effect with 
enlarged image 

Lets you limit the color values of video material to a specific range, for example, to meet safe color 
standards set by a broadcaster. For more information, see “Working with the Safe Color Limiter Effect” on 
page 745.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories  422 Safe; Source Monitor Analysis; Composite/Luma Levels; RGB Levels; Grid 
(not available for all project types)

Lets you remove scratches and other flaws by drawing an object to cover the scratch, and then filling the 
object with clean replacement material. For examples of the Scratch Removal effect, see “Examples of 
Scratch Removal Parameter Settings” on page 421.

Apply to Single-layer segments

Real-time status Non-real-time

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Acceleration; Corner Tracking; Scratch; Feathering; Brush; Grid (not available 
for all project types)
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Key Effects
Image: Spot Color Correction (Media Composer | Symphony Option Only)

Image: Stabilize

Image: Submaster

Key Effects
Key effects combine two or more video streams, using components from one of the streams.

The Chroma Key and Luma Key effects share a Key parameter category. For more information, see 
“Key Effects Key Parameters” on page 550.

Lets you apply color adjustments to selected parts of images as well as to whole images. For more 
information, see “(Media Composer | Symphony Option) Spot Color Correction” on page 748.

The Spot Color Correction effect includes all of the color adjustment parameter categories available in the 
Color Effect, as well as the Color Match control.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Acceleration; Corner Tracking; Luma Adjust; Luma Range; Luma Clip; Chroma 
Adjust; Color Style; Color Gain; Color Match; Feathering; Magic Mask; Brush; 
Grid (not available for all project types)

Lets you eliminate unwanted motion in a video clip, such as motion from an unstable camera or even more 
subtle motion such as that introduced during the telecine process as a result of gate weave. For more 
information, see “Stabilizing an Image” on page 270.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Background Color; Scaling; Position; Crop; Corner Tracking; Grid (not 
available for all project types)

The Submaster effect creates a single media file for all the video on the layers below the effect. This lets 
you group several effects that reside on different video layers and render them as one effect, which can 
sometimes be quicker than rendering each effect separately.

n The Submaster effect does not render each track separately, so you cannot play each track 
separately after you render the Submaster effect.

Apply to Video track above all the video tracks you want to include in the Submaster effect.

Bit depth processing 8-bit and 16-bit

RGB processing Not applicable

Parameter categories Grid (not available for all project types)
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Key Effects
Key: AniMatte

Key: Chroma Key

Key: Luma Key

Enables you to generate custom matte effects that you can apply to a segment or transition in a sequence. 
You can use a variety of brushes and painting tools to create matte effects that you can animate. For 
examples of the AniMatte Effect, see “Intraframe Editing” on page 382.

Apply to Transitions or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Acceleration; Corner Tracking;Foreground; Mode; Feathering; Magic Mask; 
Brush; Grid (not available for all project types)

Replaces one part of the video image with another video image based on color. The key color in the video 
on the higher track is replaced with the video from the lower track number. Chroma Key is used most 
frequently with a foreground image shot in front of a highly saturated color screen.

Apply to Transitions or multilayer segments

Promotes to SpectraMatte

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Key; Secondary Key; Spill Suppression;  Profile; Foreground; Acceleration; 
Scaling; Position; Crop; Grid (not available for all project types)

Illustration

Left to right: background image, key image, and Chroma Key effect

Replaces part of the video image with another video image based on luminance

Apply to Multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Key; Foreground; Scaling; Position; Crop; Grid (not available for all 
project types)
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Key Effects
Key: Matte Key

Key: RGB Keyer

Illustration

Left to right: key image, background image, and Luma Key effect

A three-layer track effect. The bottom layer is the background image, the middle layer is the foreground 
image, and the top layer contains the grayscale matte or alpha channel.

Apply to Multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Chroma Key Profile, Secondary Key, and Spill Suppression Parameters; 
Foreground; Acceleration; Scaling; Position; Crop; Grid (not available for all 
project types)

Illustration

Left to right: background image, foreground image, high-contrast matte image, and 
Matte Key effect

Replaces part of the video image with another video image based on color. The key color in the video on 
the higher track is replaced with the video from the lower track. You can also perform post-key color 
correction with the RGB Keyer.

Apply to Multilayer segments

Real-time status Non-real-time

Bit depth processing 8-bit only

RGB processing Available

Parameter categories Key Color; Chroma Key; Matte Control; Color Correction; Grid (not available for 
all project types)

Illustration

Left to right: background image, key image, and RGB Keyer effect
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L-Conceal Effects
Key: SpectraMatte Effect

L-Conceal Effects
L-Conceal effects overlap one video channel over another, using a predefined L-shaped path.

Replaces one part of the video image with another video image based on color. Provides advanced controls 
and analytical tools for adjusting the key. The key color in the video on the higher track is replaced with the 
video from the lower track number.

Each parameter is individually keyframeable, except Luma Curve, which uses the advanced keyframe 
display as a luminance adjustment curve. For more information, see “Luma Control Parameters” on 
page 560.

Apply to Multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories  Bypass; Key Color; Matte Analysis; Chroma Control; Luma Control; Matte 
Processing; Spill; Scaling; Position; Crop; Grid (not available for all 
project types)

Illustration

Left to right: background image, key image, and SpectraMatte effect

Incoming video slides vertically over one half of the screen and then slides horizontally to fill the 
remaining half of the screen. Four L-Conceal effects, named for the direction from which the effect begins, 
are available:

• Bottom Left

• Bottom Right

• Top Left

• Top Right

The effect icons for the category indicate the starting position of the incoming video.

Apply to Transitions or multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Foreground; Grid (not available for all project types)
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Matrix Wipes
Matrix Wipes
Matrix wipes reveal one video channel on top of another video channel, using blocks or bands that 
appear in a predefined position or path.

All Matrix Wipe effects share custom grid parameters, accessible from the More Options button. For 
more information, see “Custom Grid” on page 495.

Illustration

Left to right: outgoing image, example of middle of effect for the Bottom Right L-
Conceal, and incoming image

Incoming video begins as blocks or bands that follow a pattern while wiping out the outgoing video. You 
can customize the grid size by clicking the Other Options button.

Five Matrix Wipe effects are available:

• Grid

• One-WayRow

• Speckle

• Spiral

• Zig-Zag

Apply to Transitions or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Not available

Parameter categories Custom Grid (More Options button); Border; Foreground; Grid (not available for 
all project types)
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Motion Effects
Motion Effects
Freeze Frame, Variable Speed, and Strobe Motion effects are traditional (source-side) motion effects 
that you create as new clips. For more information, see “Creating Traditional Motion Effects” on 
page 154.

For other motion effects, see “Timewarp Effects” on page 483.

Motion Effect: Freeze Frame

Motion Effect: Variable Speed and Strobe Motion

Illustrations

Top: outgoing image (left) and incoming image (right). Center, left to right: middle of 
effect for Grid, One-Way Row, and Speckle. Bottom: middle of effect for Spiral (left) and 
Zig-Zag (right)

Creates a new clip that repeats the current frame in the Source monitor for the specified duration

Apply to Current frame in the Source monitor

Parameters Accessible from the Clip menu. For more information, see “Freeze Frame 
Parameters” on page 565.

Variable Speed creates a new clip with slow motion, fast motion, or reverse motion. Strobe Motion creates 
a new clip with stuttering effect. The Strobe Motion effect can be used in combination with the Variable 
Speed effect.

Apply to Clip marked with IN and OUT points in the Source monitor

Real-time status Real-time or non-real-time, dependent on the type of motion being represented. 
For more information, see “Playback Capabilities for Traditional Motion Effects” 
on page 160.

Parameters Available in the Motion Effect dialog box. For more information, see “Variable 
Speed and Strobe Motion Parameters” on page 566.
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Peel Effects
Peel Effects
Peel effects treat outgoing video like a sheet of paper being peeled from incoming video.

Outgoing video is peeled from incoming video starting from one corner or side of the screen. Eight Peel 
effects, named for the direction in which the effect moves, are available:

• Bottom Left Corner

• Bottom Right Corner

• Bottom to Top

• Left to Right

• Right to Left

• Top Left Corner

• Top Right Corner

• Top to Bottom

The effect icons for the category indicate the starting position of the effect.

Apply to Transitions, multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Foreground; Grid (not available for all project types)

Illustrations

Top: outgoing image (left) and incoming image (right)
Bottom, left to right: middle of effect for Bottom Left Corner, Right to Left, and 
Top Right Corner
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PlasmaWipe Effects
PlasmaWipe Effects

Push Effects
Push effects move one video channel to fill the screen while the other video channel is pushed out of 
the screen.

n For examples of similar effects, see “Comparison of Similar Effects” on page 490.

PlasmaWipe effects use gradient image bitmaps to create wipes and segment effects. There are 64 preset 
effects, and you can create your own by creating new gradient images. For more information on using 
PlasmaWipe effects, see “PlasmaWipe Effects” on page 436.

The preset PlasmaWipe effects are grouped into the following categories:

• Borders lets you apply a variety of edge treatments to effects. For more information, see 
“Understanding PlasmaWipe Frame and Border Effects” on page 446.

• Center creates a variety of center wipes.

• Horiz creates a variety of horizontal wipes.

• Lava creates several shape wipes based on images of lava. These effects are examples of effects that 
you can create using existing images. For more information, see “Creating a PlasmaWipe Effect from 
an Existing Image” on page 440.

• Paint creates several wipes that simulate uncovering the incoming video by wiping away the outgoing 
video with a brush or cloth. These effects are examples of how to create an effect using the Adobe 
Photoshop Pencil tool. For more information, see “Creating a PlasmaWipe Image Using the Pencil 
Tool” on page 441.

• Techno are free form shape wipes and segment effects that you can create using the techniques 
described in “Creating Gradient Images for PlasmaWipe Effects” on page 439.

When you experiment with PlasmaWipe effects, keyframe the Level parameter to see how the effect 
changes over time

Apply to Transitions, single-layer segments, or multilayer segments, depending on the 
specific effect

Bit depth processing 8-bit only

RGB processing Not available

Parameter categories Border; Chroma Key Profile, Secondary Key, and Spill Suppression Parameters; 
Foreground; Acceleration; Grid (not available for all project types)
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Reformat Effects
Reformat Effects
Reformat effects let you reformat media to different aspect ratios, for example, when you need to 
reformat a film aspect ratio for television programming. The 14:9 Letterbox, 16:9 Letterbox, and 4:3 
Sidebar effects resize the media to conform to the aspect ratio you select. Pan and Scan lets you 
select a portion of the media to reformat.

Incoming video pushes out outgoing video starting from a corner or side of the screen. The border is on the 
incoming video. Eight Push effects, named for the direction in which the effect moves, are available:

• Bottom Left to Top Right

• Bottom Right to Top Left

• Bottom to Top

• Left to Right

• Right to Left

• Top Left to Bottom Right

• Top Right to Bottom Left

• Top to Bottom

The effect icons for the category indicate the starting position of the effect.

Apply to Transitions or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Foreground; Grid (not available for all project types)

Illustrations

Top: outgoing image (left) and incoming image (right)
Bottom, left to right: middle of effect for Bottom Left to Top Right, Right to Left, and 
Top Right to Bottom Left
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Sawtooth Wipes
Reformat: 14:9 Letterbox, 16:9 Letterbox, 4:3 Sidebar

Reformat: Pan and Scan

Sawtooth Wipes
Sawtooth wipes create a transition between shots, using a jagged edge like the teeth of a saw.

All Sawtooth Wipe effects share custom grid parameters, accessible from the More Options button. 
For more information, see “Custom Grid” on page 495.

Reformats media to a different aspect ratio (14:9 letterbox, 16:9 letterbox, or 4:3 sidebar) by distorting the 
media. For more information, see “Using the Reformat Effects” on page 220.

Apply to Single-layer or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Background Color; Position H (14:9 Letterbox only); Grid (not available for all 
project types)

Illustration

Original image (left) and 16:9 Letterbox effect

Lets you reformat media to different aspect ratios, for example, when you need to reformat a film aspect 
ratio for television programming. For more information, see “Working with the Pan and Scan Effect” on 
page 221.

Apply to Multilayer segments, or single-layer segments in certain circumstances. For more 
information, see “Combining the Pan and Scan Effect with Transition Effects” on 
page 229.

Bit depth processing 8-bit only

RGB processing Available

Parameter categories  Aspect Ratios; Scaling; Position; Actions; Grid (not available for all 
project types)
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Shape Wipes
Shape Wipes
Shape Wipes reveal one video channel on top of another video channel, using a growing or moving 
geometric shape.

Some Shape Wipe effects have custom grid parameters, accessible from the More Options button. 
For more information, see “Custom Grid” on page 495.

Incoming video appears with a sawtooth edge and expands to fill the screen. . Four Sawtooth Wipe effects, 
named for the direction in which the effect moves, are available:

• Horizontal Sawtooth (moves left to right)

• Horizontal Open Sawtooth

• Vertical Open Sawtooth

• Vertical Sawtooth (moves top to bottom)

The effect icons for the category indicate the starting position of the effect.

Apply to Transitions or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Not available

Parameter categories Custom Grid (More Options button); Foreground; Grid (not available for all 
project types)

Illustrations

Left to right: outgoing image, middle of Horizontal Sawtooth (top) and Vertical Open 
Sawtooth (bottom), and incoming image
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Shape Wipes
Incoming video uses a geometric shape to fill the screen and wipe out the outgoing video. Nine Shape Wipe 
effects, named for the shape they use, are available:

• 4 Corners

• Center Box

• Circle

• Clock

• Diamond

• Ellipse

• Horizontal Bands

• Horizontal Blinds

• Vertical Blinds

The effect icons for the category indicate the shape of the effect.

Apply to Transitions or multilayer segments

Bit depth processing 8-bit and 16-bit

RGB processing Not available

Parameter categories All effects: Foreground; Grid (not available for all project types)

4 Corners, Center Box, Circle, Ellipse, Horizontal Bands, Horizontal Blinds, and 
Vertical Blinds effects: Border

Center Box, Circle, Diamond, and Ellipse effects: Scaling; Position

Horizontal Bands, Horizontal Blinds, and Vertical Blinds effects: Custom Grid 
(More Options button)
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Spin Effects
Spin Effects
Spin effects rotate one or more video channels.

Spin: X Spin and Y Spin

Illustrations

Outgoing image (left) and incoming image (right)

Top, left to right: middle of effect for 4 Corners, Center Box, and Circle. Center, left to 
right: middle of effect for Clock, Diamond, and Ellipse. Bottom: middle of effect for 
Horizontal Bands, Horizontal Blinds, and Vertical Blinds

Outgoing video is squeezed until it appears as a line (vertical for X Spin, horizontal for Y Spin). Incoming 
video then expands from that line until it fills the screen. Border appears only on the incoming video.

Apply to Transitions

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Border; Foreground; Grid (not available for all project types)

Illustration

Left to right: outgoing image, stages of the X Spin effect, incoming image
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Squeeze Effects
Spin: Z Spin

Squeeze Effects
Squeeze effects expand a video channel from a single point or line until it fills the screen, obscuring 
the second video channel.

n For examples of similar effects, see “Comparison of Similar Effects” on page 490.

Incoming video begins as a dot in the center of the screen and then enlarges to full screen while rotating 
counterclockwise one full revolution, covering the outgoing video

Apply to Transitions or multilayer segments

Promotes to 3D

Bit depth processing 8-bit only

RGB processing Available

Parameter categories Border; Foreground; Grid (not available for all project types)

Illustration

Left to right: outgoing image, stages of the Z Spin effect, incoming image

Incoming video squeezes over the outgoing video, beginning as a point or line at a specific location 
on the screen and expanding to fill the screen. Fifteen Squeeze effects, named for the starting location 
or the movement of the effect, are available:

Apply to Transitions or multilayer segments

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available
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Timewarp Effects
Timewarp Effects
Timewarp effects are motion effects that you apply directly to segments in a sequence and customize 
using the Motion Effect Editor. The Timewarp effect itself is described fully in “Understanding 
Timewarp Effects” on page 163. The other effects in the Timewarp effect category are templates with 
different preset parameters for the Timewarp effect.

You can use several specialized FluidMotion Edit parameters to correct artifacts in a Timewarp effect 
that uses the FluidMotion rendering option. For more information, see “FluidMotion Edit Parameters 
for Timewarp Effects” on page 570.

For reference information on traditional (source-side) motion effects, which create new clips with 
changed rates of play, see “Motion Effects” on page 474.

Timewarp: 0% To 100% and 100% to 0%

Parameter categories Border; Foreground; Grid (not available for all project types)

Illustrations

Top: outgoing image (left) and incoming image (right)
Bottom, left to right: middle of effect for Bottom Centered, Centered Zoom, 
and Right to Left

0% to 100% is a template for the Timewarp effect that ramps motion in a sequence from 0% (freeze frame) 
to 100% (full speed). 100% to 0% is a template for the Timewarp effect that ramps motion in a sequence 
from 100% (full speed) down to 0% (freeze frame). These two effects are the inverse of one another.

Apply the effect to a sequence in the Record monitor, and customize it using the Motion Effect Editor. For 
more information, see “Understanding FluidMotion Timewarp Effects” on page 186.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All parameters and controls appear in the Motion Effect Editor. For more 
information, see “Motion Effect Editor Reference” on page 171.
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Timewarp Effects
Timewarp: FluidFilm 2:3 Cadence and FluidFilm Progressive

Illustrations

Speed Graph and Position Graph default settings for 0% To 100%

Speed Graph and Position Graph default settings for 100% To 0%

FluidFilm 2:3 Cadence is a template for the Timewarp effect that lets you create a film look from interlaced 
video sources. Use this effect in NTSC projects.

FluidFilm Progressive is a template for the Timewarp effect that lets you create a film look from interlaced 
video sources. Use this effect in PAL projects.

n You can also use the templates as a starting point to create a video look from sources originally shot 
on film by switching the input and output format values.

Apply the effect to a sequence in the Record monitor, and customize it using the Motion Effect Editor. For 
more information, see “Understanding FluidMotion Timewarp Effects” on page 186.

Apply to Single-layer segments

Real-time status Non-real-time

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All parameters and controls appear in the Motion Effect Editor. For more 
information, see “Motion Effect Editor Reference” on page 171.
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Timewarp Effects
Timewarp: Pulldown Insertion and Pulldown Removal

Pulldown Insertion is a template for the Timewarp effect that inserts 2:3 pulldown into a sequence. 
Pulldown Removal is a template for the Timewarp effect that removes 2:3 pulldown from a sequence. 
These two effects are the inverse of one another.

Source material without 2:3 pulldown has the cadence AA BB CC DD, where each letter represents a field. 
Pulldown Insertion uses the cadence AA BB BC CD DD. Using Pulldown Insertion slows the source 
material to 4/5 (80% speed).

Source material with 2:3 pulldown has the cadence AA BB BC CD DD, where each letter represents a 
field. Pulldown Removal uses the cadence AA BB CC DD. Using Pulldown Removal speeds up the source 
material to 5/4 (125%).

Apply the effect to a sequence in the Record monitor, and customize it using the Motion Effect Editor. For 
more information, see “Understanding FluidMotion Timewarp Effects” on page 186.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All parameters and controls appear in the Motion Effect Editor. For more 
information, see “Motion Effect Editor Reference” on page 171.

Illustrations

Speed Graph and Position Graph default settings for Pulldown Insertion

Speed Graph and Position Graph default settings for Pulldown Removal
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Timewarp Effects
Timewarp: Reverse Motion

Timewarp: Speed Boost and Speed Bump

Reverse motion is a template for the Timewarp effect that creates a reverse motion effect at 100% speed.

Apply the effect to a sequence in the Record monitor, and customize it using the Motion Effect Editor. For 
more information, see “Understanding FluidMotion Timewarp Effects” on page 186.

Apply to Single-layer segments

Real-time status Real-time

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All parameters and controls appear in the Motion Effect Editor. For more 
information, see “Motion Effect Editor Reference” on page 171.

Illustration

Speed Graph and Position Graph default settings for Reverse Motion

Speed Boost and Speed Bump are templates for the Timewarp effect. Speed Boost starts out at half speed, 
reaches approximately double speed at the midpoint, and returns to half speed at the end. Speed Bump 
starts out at full speed, slows to approximately half speed at the midpoint, and returns to full speed at the 
end.

Apply the effect to a sequence in the Record monitor, and customize it using the Motion Effect Editor. For 
more information, see “Understanding FluidMotion Timewarp Effects” on page 186.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All parameters and controls appear in the Motion Effect Editor. For more 
information, see “Motion Effect Editor Reference” on page 171.
486



Timewarp Effects
Timewarp: Timewarp

Illustrations

Speed Graph and Position Graph default settings for Speed Boost

Speed Graph and Position Graph default settings for Speed Bump

Apply the effect to a sequence in the Record monitor, and customize it using the Motion Effect Editor. For 
more information, see “Understanding FluidMotion Timewarp Effects” on page 186.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All parameters and controls appear in the Motion Effect Editor. For more 
information, see “Motion Effect Editor Reference” on page 171.
487



Title Effects
Timewarp: Trim to Fill

Title Effects
You create Title effects with the Title tool or with Marquee and save them to bins as Title clips. Titles 
can incorporate text, graphic objects, imported graphics, and video. You edit a Title clip into a 
sequence on its own video layer above all other material. Media Composer keys the title over the 
underlying video layers.

Title Effects: Crawling Title and Rolling Title

Trim to Fill is a preset effect using the Timewarp effect that changes the playback speed to a constant rate. 
You can change the rate by trimming the clip.

Apply the effect to a clip in the Timeline. Media Composer displays the current speed in the Timeline along 
with the clip name. The default speed is 100%. To change the speed, enter Trim mode and trim the effect 
shorter (faster) or longer (slower). When you perform the trim operation you are trimming the effect, not 
the clip. The beginning and ending frames (and the number of source frames) remain the same. 

n You can achieve a similar result using the Fit to Fill check box for traditional Motion effects or the 
Fit to Fill button on the Command palette. However, the Trim to Fill effect lets you access the higher 
quality Blend rendering options available for Timewarp effects.

For more information, see “Understanding FluidMotion Timewarp Effects” on page 186.

Apply to Single-layer segments

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories All parameters and controls appear in the Motion Effect Editor. For more 
information, see “Motion Effect Editor Reference” on page 171.

By default, crawling titles scroll from right to left on the screen, while rolling titles scroll from the bottom 
to the top of the screen. For more information, see “Creating Rolling and Crawling Titles” on page 330.

Apply to A segment above other video layers

Real-time status Non-real-time

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Open with Title Tool or Marquee (Edit Title button); Foreground;  Position; 
Scroll Position; Crop; Grid (not available for all project types)
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Xpress 3D Effects
Title Effects: Title

Xpress 3D Effects
Xpress 3D effects provide a limited set of parameter categories for creating basic 3D effects.

For information on creating titles, see “Creating Titles” on page 296.

Apply to A segment above other video layers

Promotes to 3D

Bit depth processing 8-bit and 16-bit

RGB processing Available

Parameter categories Open with Title Tool or Marquee (Edit Title button); Foreground; Scaling; 
Position; Crop; Grid (not available for all project types)

Xpress 3D effects provides basic 3D PIP and 3D shape effects. Four effects are available.

• 3D Ball

• 3D PIP

• 3D Page Fold

• 3D Slats

Once you apply one of the effects, you can switch to another shape by making a selection from the menu 
in the Shape parameter category, or you can switch to 3D PIP by turning off the Shape parameter 
category.

Apply to Transitions, single-layer segments, or multilayer segments, depending on 
circumstances

Real-time status Real-time in most circumstances.

For more information on real-time playback for 3D effects, see “Real-Time 
Playback of 3D Effects” on page 285.

Promotes to 3D Warp (for the complete set of 3D parameter categories)

Bit depth processing 8-bit and 16-bit. 16-bit requires the use of the HQ (Highest Quality) button in 
the Effect Editor. For more information, see “Rendering 3D Effects Using the 
HQ (Highest Quality) Option” on page 141.

RGB processing Available for most parameter categories. For more information, see “3D Effect 
Parameters” on page 573.

Parameter categories For all effects: Shape; Target; Border (3D); Foreground (3D); Background 
Color (3D)

3D PIP, 3D Page Fold, and 3D Slats effects: Crop (3D)

3D PIP and 3D Ball effects: Scaling (3D); Position (3D)

3D PIP effect: Axis; Rotation; Shadow; Trail
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Comparison of Similar Effects
Comparison of Similar Effects
Four effect categories have similar results: Box Wipe, Conceal, Push, and Squeeze. Examples of 
these effects are shown here to assist you in using these effects.

Top Left to Bottom Right Box Wipe effect

Top Left to Bottom Right Conceal effect

Top Left to Bottom Right Push effect

Top Left Squeeze effect
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18 Effects Parameter Reference

This chapter provides reference information for all effect parameters in Media Composer.

• Effect parameter controls that you use to define colors are described in “Color Parameter 
Controls” on page 491. Color controls appear in a number of 2D and 3D effect parameter 
categories.

• Effect parameter categories that are common to multiple 2D effects across at least two effect 
categories are listed in “Common 2D Effect Parameters” on page 492.

• Effect parameter categories that are unique to a single 2D effect category are listed by the effect 
category, as follows:

- “Film Effects Blowup Parameter” on page 501

- “Generator Effect Parameters” on page 501

- “Illusion FX Effect Parameters” on page 510

- “Image Effect Parameters” on page 530

- “Key Effect Parameters” on page 550

- “Motion Effect Parameters” on page 565

- “Reformat Effect Parameters” on page 568

- “FluidMotion Edit Parameters for Timewarp Effects” on page 570

- “Rolling Title and Crawling Title Effect Parameters” on page 572

• Effect parameter categories for 3D effects are listed in “3D Effect Parameters” on page 573.

Effect parameters are keyframeable unless otherwise noted in this chapter. You can set keyframeable 
parameters to different values at different points in an effect’s duration to alter the effect over time. If 
a parameters is not keyframeable, you cannot change its value over the duration of an effect.

Color Parameter Controls
Many effect include parameter controls that let you select a color, for example, to color a border or a 
background. These controls let you define a color in three ways:

• You can use your operating system’s color controls (the Windows Color dialog box or the 
Macintosh Colors panel).

• You can use an eyedropper tool to select a color from an image.

• You can use parameter sliders to define a color. Depending on the effect, the sliders might use 
hue, saturation, and luminance values to define a color, or they might use red, green, and blue 
values.



Common 2D Effect Parameters
Examples of color parameter controls: with hue, saturation, and luminance sliders (left) and with red, green, and blue 
sliders (right). The Other Options button and the Color Preview window are highlighted in each example.

Common 2D Effect Parameters
This section describes, in alphabetical order, 2D effect parameters that are common to multiple 
effects across at least two effect categories.

Acceleration

Acceleration adjusts the speed of an effect over time by having the effect ease in and ease out of 
every keyframe. This gives the effect a more natural appearance. This parameter is not 
keyframeable.

The overall speed of an effect depends on its duration, which in turn depends on the length of the clip 
in the sequence. To slow down or speed up the movement of an effect, change the length of the clip or 
use add edits to limit the portion of the clip affected by the effect.

The slider controls ease in and ease out motion. Values range from 0 (no ease in and ease out motion, 
so the effect maintains a constant speed throughout its path) to 100 (maximum ease in and ease out 
motion).

Parameter Description

Other Options button Opens the Windows Color dialog box or the Macintosh Colors panel for precise color 
selection. For more information, see “Adjusting a Color Parameter for an Effect” on 
page 74.

Color Preview 
window

Displays the currently selected color, and provides access to the eyedropper tool for 
selecting a color from an image. For more information, see “Adjusting a Color Parameter 
for an Effect” on page 74.

Hue Identifies the hue or tint of the color. Hue is measured as values on a color wheel ranging 
from 0 to 255. The start (0) and end (255) values are both red.

Sat (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, where 0 is no 
chrominance and 255 is a fully saturated color.

Lum (luminance) Specifies the brightness of the color. Values range from 0 to 255, where 0 is black and 255 
is full brightness or white.

R (red) Specifies the red component of an RGB color definition. Values range from 0 (no red) to 
255 (maximum amount of red).

G (green) Specifies the green component of an RGB color definition. Values range from 0 (no green) 
to 255 (maximum amount of green).

B (blue) Specifies the blue component of an RGB color definition. Values range from 0 (no blue) to 
255 (maximum amount of blue).
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Common 2D Effect Parameters
Background Color

Background Color sets the color for the background in effects that display a background, for 
example, a Fade to Color effect. For more information on the parameter controls, see “Color 
Parameter Controls” on page 491.

For information on the 3D equivalent of this parameter category, see “Background Color (3D)” on 
page 575.

The Avid Pan & Zoom effect and the Illusion FX Pattern Generator effect have Background 
parameters that provide similar capabilities to the Background Color parameters. For more 
information, see “Background” on page 533 and “Pattern Generator Effect Background, Number, 
and Circle Parameters” on page 522.

Border

Border lets you specify the color, softness, and width of a border, for example, on the incoming 
image in a transition. Some effects also include Blend Color parameters for blending border color.

For information on the 3D equivalent of this parameter category, see “Border (3D)” on page 575.

The Border parameter category for Illusion FX effects has different parameters that are described in 
“Border Parameter for Illusion FX Effects” on page 510.

Parameter Description

Color and Blend 
Color subcategories

Let you set the border color and the border blend color. For more information on the 
parameter controls, see “Color Parameter Controls” on page 491.

Width Specifies the width of the border. Values range from 0 (no border) to 100 (widest border).

Soft (softness) Blends the border with the background image, giving the border a soft appearance. Values 
range from 0 (no softness) to 255 (maximum softness).

Fixed Border Turns off the Blending option. For PlasmaWipe effects, Fixed Border lets you specify 
whether the border can change shape during the effect. For the Frame and Border 
PlasmaWipe effects the border is used to create the effect.
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Common 2D Effect Parameters
Brush

Brush enables you to define the shape, size, and softness of the brush for creating brush strokes on an 
image. You can also customize the shape and rotate the head of the Brush tool to create a variety of 
new effects. This parameter is not keyframeable.

Brush is available in the following effects: Image: Paint Effect, Image: Scratch Removal, Image: Spot 
Color Correction (Media Composer | Symphony Option Only), Key: AniMatte, FluidMotion Edit for 
Timewarp Effects.

Crop

Crop removes video from the top, bottom, left, and right edges of the video.

For information on the 3D equivalent of this parameter category, see “Crop (3D)” on page 577.

Parameter Description

Path Controls the percentage of paint or the matte that is visible from the initial point of pressure to 
the completion of the brush stroke. Values range from 0 (no paint visible) to 100 (entire stroke 
visible). Unlike other Paint Effect parameters, you can adjust Path only after you finish painting.

Soft (softness) Adjusts the softness of the brush head. Values range from 0 (hard center) to 100 (softest overall 
head).

Size Adjusts the size of the brush head. Values range from 0 to 100 pixels.

Shape buttons Changes the brush head to a new shape.

Spin Lets you rotate the brush head 360 degrees in the clockwise and counterclockwise directions. 
Values range from -360 degrees (maximum clockwise rotation) to 360 degrees (maximum 
counterclockwise rotation). The default position is 0 degrees.

Parameter Description

T (top) Removes video from the top of the inner or incoming video. Values range from 0 (top of the 
screen) to 999 (bottom of the screen).
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Common 2D Effect Parameters
Custom Grid

In Matrix Wipe, Sawtooth Wipe, and some Shape Wipe effects, you can use a grid to define the 
position or progress of certain effects over time. You define the grid by clicking the More Options 
button to open a dialog box, and then either selecting a standard preset grid or entering a custom 
number of rows and columns. The minimum number of rows and columns is 2 x 2, and the default 
number is 8 x 6.

Feathering

Feathering adds soft edges to a painted object or a matte key. Adding a soft edge can make a 
composited object look more natural against the background.

Feathering is available in the following effects: Image: Blur Effect and Mosaic Effect, Image: Paint 
Effect, Image: Scratch Removal, Image: Spot Color Correction (Media Composer | Symphony 
Option Only), Key: AniMatte, and FluidMotion Edit for Timewarp Effects

B (bottom) Removes video from the bottom of the inner or incoming video. Values range from –999 (top of 
the screen) to 0 (bottom of the screen).

L (left) Removes video from the left side of the inner or incoming video. Values range from 0 (left side of 
the screen) to 999 (right side of the screen).

R (right) Removes video from the right side of the inner or incoming video. Values range from –999 (left 
side of the screen) to 0 (right side of the screen).

Parameter Description
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Common 2D Effect Parameters
Foreground

Foreground sets the relative amount of the effect to be displayed over time. The set of available 
parameters varies depending on the effect.

For information on the 3D equivalent of this parameter category, see “Foreground (3D)” on page 579.

Parameter Description

Bias Increases control over the dissipation of pixels around the edges of a painted object or matte. 
Adjusting bias is especially effective when you trace an element on the screen with the Paint 
Effect.

Values range from 0 (feathers pixels starting at the outside edge) to 100 (feathers pixels 
starting at the inner portion of the edge). The default value of 50 feathers pixels starting at 
the center portion of the edge.

Hor (horizontal) 
and Vert (vertical)

Lets you select the dominant direction in which feathering of an object or matte appears.

Hor (horizontal) extends feathering in both the positive and negative directions along the X 
axis (right to left and left to right on the screen). Vert (vertical) extends feathering in both the 
positive and negative directions along the Y axis (upward and downward on the screen). 
Values range from 0 pixels (no feathering) to 63 pixels (maximum feathering).

Fixed Aspect Gangs the Hor and Vert sliders together so that they move in unison when you drag either 
one. Horizontal is the dominant direction.

Anti-alias Decreases the jagged appearance of a selected object’s edges. Use anti-aliasing in 
combination with feathering to improve the appearance of an object’s edges.

Parameter Description

Level Controls the opacity of the foreground image. Values range from 0 (transparent) to 100 
(opaque).

For PlasmaWipe effects, Level controls the amount of the effect at any given point. As you 
increase the value, the effect reveals more incoming video.

Swap Sources Swaps the image source for the foreground and background layers of the effect.

Reverse 
Animation

Reverses the entire effect, including the direction of movement as well as the incoming and 
outgoing sources.

This maintains the shot continuity while reversing the movement. This option effectively 
creates a mirror image of the sequence of keyframes for the effect as they appear in the Effect 
Preview monitor’s position bar.

The Reverse Animation parameter is only available for certain effects that do not use advanced 
keyframes. To reverse an effect that uses advanced keyframes, for example an edge wipe, use 
the Reverse Keyframes shortcut menu command in the Effect Editor. For more information, see 
“Reversing Advanced Keyframes” on page 110.
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Common 2D Effect Parameters
Grid

Grid defines the Effect Grid associated with an effect. Grid parameters set in the Effect Editor 
override settings in the Grid Settings dialog box for that effect only. This parameter is not 
keyframeable, and is not available in all project types.

Invert Key Reverses the key as follows:

• With a Chroma Key effect, displays the key color regions while showing the background 
image source through the foreground image area.

• With a Luma Key effect, displays the background image source through the darker areas 
rather than the lighter areas of the foreground image source.

• With a Matte Key effect, effectively reverses the black and white areas of the alpha channel 
so that foreground and background are reversed.

Show Alpha Displays the grayscale alpha channel used to apply the key effect to the foreground and 
background source. This lets you examine problem areas of the key while making adjustments.

Parameter Description

Parameter Description

Enable button Turns the local Grid effect on or off . If you disable the local Grid effect, Media Composer 
uses the global settings defined in the Grid Settings dialog box.

Type menu Selects one of the following grid types:

• Square

• Standard Film

• Academy

The Academy grid includes a safety margin on the left that is used for adding the 
optical sound track.

• Super 35

• Anamorphic

Fields Determines the number of tick marks along the grid axes as well as the number of visible 
grid points. Values range from 8 to 32.

Sub (subfields) Determines the snap-to-grid feature between visible grid points. The value determines 
how many jumps are in between each visible point. Values range from 0 (turns off the 
snap-to-grid feature) to 10 (provides 10 jumps between each visible point).
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Common 2D Effect Parameters
Magic Mask

Magic Mask lets you apply effects across a series of frames, using the chroma and luma values as the 
criteria for edge detection. After you pick a color with the eyedropper, you can adjust the Hue, Sat, 
and Lum sliders to fine-tune the color selection.

Magic Mask is available in the following effects: Image: Paint Effect, Image: Spot Color Correction 
(Media Composer | Symphony Option Only), Key: AniMatte.

Source Scan Size Applies to film projects, where an optical house scans film for the addition of visual 
effects. Values range from 720 to 9999 for Horizontal and from 243 to 9999 for Vertical.

Source Grid Offset Move the grid on the image. The Inset slider shrinks the grid proportionally. Values are set 
to approximately 15% of the current values in the Source Scan Size sliders.

Transfer menu Specifies how the film was transferred to video as follows:

• Full Aperture — The transfer includes everything that is visible in the frame.

• Academy — The transfer does not include the sound track area on the left side of the 
film.

Parameter Description

Parameter Description

Color controls Let you select a color from the video background and then refine it. For more information on the 
parameter controls, see “Color Parameter Controls” on page 491.

To colorize your effect, use the controls in the Paint Effect’s Color parameter category in 
conjunction with one of the Paint Effect modes.

Gain When you use the Paint Effect, Gain increases or decreases the range of pixels surrounding the 
color you pick that Magic Mask enables you to modify in conjunction with your selected paint 
mode. Gain includes or excludes pixels surrounding the color you pick that falls within a 
specified color range, or tolerance.

When you use the AniMatte effect, Gain increases or decreases the effect of Magic Mask on 
pixels that are contiguous to your color selection within the borders of a matte key. Gain applies 
color correction to pixels that fall within the specified color range, or tolerance, of the color you 
pick with the eyedropper.

The tolerance you adjust with the Gain slider is relative to the RGB values of the color you 
picked.

Values range from 0 to 63 pixels. Decreasing the value lessens the color range and includes 
fewer pixels contiguous to the matte key or color selection. Increasing the value expands the 
range and includes more pixels surrounding the matte key or color selection. 

Soft (softness) Increases or decreases the amount of softness applied to a color selection and contiguous pixels 
that fall within a specified tolerance. The tolerance you adjust with the Soft slider is relative to 
the RGB values of the color picked in the selection. Values range from 0 to 63.
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Common 2D Effect Parameters
Position

Position sets the horizontal and vertical position of the effect.

For information on the 3D equivalent of this parameter category, see “Position (3D)” on page 583.

Some other effects have position parameter categories that differ from the standard Position 
parameter category. These variations are described in the following topics:

• “Position” on page 531 (for the Avid Pan & Zoom effect)

• “14:9 Letterbox Position H Parameter” on page 569 (for the 14:9 Letterbox Reformat effect)

• “Rolling Title and Crawling Title Effect Parameters” on page 572 (for Rolling and Crawling 
Titles)

Scaling

Scaling resizes the effect by adjusting height and width.

For information on the 3D equivalent of this parameter category, see “Scaling (3D)” on page 585.

Parameter Description

X Moves the video from side to side. Values range from –3000.0 to 3000.0. Negative values 
move the image to the left. Positive values move the image to the right. 

Y Moves the video up and down. Values range from –3000.0 to 3000.0. Negative values 
move the image to the top. Positive values move the image to the bottom.

Tracking Lets you use tracking data to control the position of the effect. For more information, see 
“Effects and Effect Parameters That Use Tracking Data” on page 243.

By default, when Tracking is enabled, Media Composer maps a tracker named Point A to 
the T1 tracker selector.

The Axis menu lets you to use the data for both X and Y axes or for a single axis only. For 
more information, see “Limiting the Effect of Position Tracking Data to a Single Axis” on 
page 268.
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Tracking

Lets you use tracking data to control the effect. When you enable an individual selector, Media 
Composer maps a tracker to that selector. Trackers are named Point A, Point B, and so on. For 
Intraframe effects, you can only enable trackers when an Intraframe object is selected. For more 
information, see “Motion Tracking and Stabilization” on page 240.

Transition Parameters

Transition parameters let you define the length and position of a transition effect. They appear at the 
bottom of the Effect Editor and are active for all transition effects. Transition parameters are not 
keyframeable.

Transition Effect Alignment button (left, with menu open below) and Transition Effect Duration box (right) in the Effect 
Editor

Parameter Description

X Stretches or compresses the width of the effect. Values range from 0 to 400, where 100 
indicates 100% scaling (normal size).

Y Stretches or compresses the height of the effect. Values range from 0 to 400, where 100 
indicates 100% scaling (normal size).

Fixed Aspect Gangs the X and Y sliders together so that they move in unison when you drag either one. 
When Fixed Aspect is enabled, you cannot change the aspect ratio of the effect.

Tracking Lets you use tracking data to scale the effect. For more information, see “Effects and Effect 
Parameters That Use Tracking Data” on page 243.

By default, when Tracking is enabled, Media Composer maps two trackers named Point A and 
Point B to the two tracker selectors.
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Film Effects Blowup Parameter
Blowup lets you enlarge and resposition the image.

Generator Effect Parameters
This section contains reference summaries for the effect parameters that are unique to the Generator 
effect category.

Parameter Description

Transition Effect 
Alignment

Specifies the start of the transition effect relative to the cut point in the sequence. The 
following menu options are available:

• Ending at Cut — The transition effect starts a number of frames before the cut 
defined by the duration, such that the effect completes at the cut point in the video.

• Centered on Cut — The transition is centered on the cut so that half the effect occurs 
before the cut point and half occurs after the cut point in the sequence.

• Starting at Cut — The transition effect starts immediately after the last frame of the 
outgoing video is displayed.

• Custom Start — Lets you specify the number of frames before and after the cut to be 
included in the effect.

The icon on the Transition Effect Alignment button shows the alignment status at the 
currently selected cut point. If the cut point does not have a transition effect, the icon is a 
vertical bar. If the cut point has an existing transition effect, the icon indicates the 
alignment of the transition effect.

Transition Effect 
Duration

Specifies the length of time that the effect will span the transition. The format (for 
example, 1:00 is 1 second and 0 frames) is determined by the Transition Effect Duration 
setting you select at the top of the Effect Preview window.

Parameter Description

Field Controls the size of the image. Values range from 0 (leaves the image size unchanged) to 12 
(increases the image to the maximum size).

X Pos (X position) Lets you position the image horizontally on the screen. Values range from -24 to 24, where 0 
is unchanged.

Y Pos (Y position) Lets you to position the image vertically on the screen. Values range from -18 to 18, where 0 
is unchanged.
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SubCap Effect Parameters

SubCap parameters control the text and appearance of subtitles or captions. For illustrated examples 
of the use of SubCap effect parameters, see “Examples of SubCap Effect Parameter Adjustments” on 
page 379. SubCap effect parameters are not keyframeable.

Category Control Description

Edit Global 
Properties

Opens the Global Properties dialog box, which lets you add information to a 
caption effect, manage parameter stylesheets, and synchronize effect 
parameters and information across all effects on a track or all effects in a 
sequence. For more information, see “Adding Information to a SubCap Effect” 
on page 373, “SubCap Effect Global Properties” on page 505, “Working with 
SubCap Effect Stylesheets” on page 378, and “Synchronizing SubCap Effect 
Parameters and Information” on page 375.

Bypass Effect Turns the display of the subtitle on or off.

Caption Files Import Caption 
Data

Opens the “Select a file that contains caption data” dialog box, which lets you 
import caption data from an EBU N19 or a DS caption file. For more 
information, see “Importing a Caption File” on page 372.

Export Caption 
Data

Opens the “Export caption data to the specified file” dialog box, which lets 
you export caption data to an EBU N19 or a DS caption file. For more 
information, see “Exporting SubCap Effect Data to Caption Files” on 
page 376.

Text 
Appearance

Color Sets the color of the text. For more information on the parameter controls, see 
“Color Parameter Controls” on page 491.

Opacity Sets the opacity of the text. Values range from 0 (fully transparent) to 1 (fully 
opaque) in 0.1 increments.

Font Face Sets the font used for the text. If you need support for Unicode characters, 
select a font that is Unicode-enabled.

Font Size Sets the size of the text font in vertical pixels (scan lines). Values range from 0 
to 999.

n If caption objects are very large (for example, if you are working with a 
very large font size), you might experience performance limitations, for 
example, during real-time playback.

Line Weight If Basic Outline is selected in the Outline menu, extends the outline into the 
text characters, making the outline thicker and the text characters thinner. If 
No Outline is selected in the Outline menu, varies the thickness of the text 
characters. Values range from 0 to 999.

Outline Weight Controls the thickness of the outline outside the text characters. The higher the 
value, the thicker the outline becomes and the further it extends beyond the 
edges of the text characters. Values range from 0 to 999.
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Outline menu Select Basic Outline to add an outline to text characters. Use the Line Weight 
and Outline Weight thumbwheels above the Outline menu to control the 
thickness of the outline. Use the Color control below the Outline menu to set 
the color of the outline.

Select No Outline, then adjust the Line Weight thumbwheel to vary the 
thickness to text characters without using a differently colored outline.

n Style sheets created in previous releases of Avid editing applications do 
not include the properties that control outlines. You must resave existing 
style sheets to add outline properties to them.

Color Sets the color of the outline surrounding text characters. For more information 
on the parameter controls, see “Color Parameter Controls” on page 491.

Text Shadow Sets the type of shadow used for the text. The options are:

• No Shadow

• Standard Shadow

• Custom Shadow

If you select Standard Shadow, Media Composer applies a default shadow 
offset and direction. The shadow appears a little below and to the right of the 
text.

If you select Custom Shadow, use the Radius and Angle sliders to control the 
offset and direction of the shadow:

• Radius controls the shadow offset. Values range from 0 (no offset) to 1 
(maximum offset) in 0.1 increments.

• Angle controls the direction of the shadow. Values range from 0 to 6.3 in 
0.1 increments, where both 0 and 6.3 place the shadow directly to the right 
of the text and 3.1 (the slider’s midpoint) places the shadow directly to the 
left of the text.

The shadow color is calculated automatically based on the hue and opacity set 
for the text.

Text 
Alignment

Sets the alignment of the text (Left, Center, or Right) within its background 
box.

Box 
Appearance

Color Sets the color of the background box. For more information on the parameter 
controls, see “Color Parameter Controls” on page 491.

Opacity Sets the opacity of the background box. Values range from 0 (fully 
transparent) to 1 (fully opaque) in 0.1 increments.

Box Style Sets the style for the background box. The options are:

• One Box — a single box surrounds the entire caption text, even if the text 
appears in multiple rows.

• Separate Boxes for Each Row — each row of text has its own background 
box.

Category Control Description
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Anchor Box to Controls the position of the box with respect to the text. The options are:

• Anchor to Bottom of Text — the bottom of the box is anchored to the 
bottom of the text. As more text is typed into a multi-row caption, the text 
and the box expand up the screen from the anchor position.

• Anchor to Top of Text — the top of the box is anchored to the top of the 
text. As more text is typed into a multi-row caption, the text and the box 
expand down the screen from the anchor position.

Justify Anchor Controls the horizontal location of the anchor with respect to the box. The 
options are:

• Anchor Left — the anchor is positioned at the left corner of the box (either 
top or bottom, depending on the value set in the Anchor Box to control).

• Anchor Center — the anchor is positioned at the center of either the top or 
bottom edge of the box (depending on the value set in the Anchor Box to 
control).

• Anchor Right — the anchor is positioned at the right corner of the box 
(either top or bottom, depending on the value set in the Anchor Box to 
control).

Anchor 
Position

Controls the location of the anchor for the text and its background box. This 
anchor point displays in the Effect Preview monitor and you can also position 
it by dragging it directly in the monitor. For more information, see “Adjusting 
SubCap Effect Parameters” on page 375.

The X slider controls the horizontal location of the anchor; the Y slider 
controls the vertical location of the anchor. Values range from –999 to +999, 
where 0 is the center of the screen.

Box Width Controls how the width of the background box is determined. The options are:

• Fixed Width (Clip) — the width of the box is fixed at the size set by the 
Box Width thumbwheel. Caption text overflows the box and is not visible 
when it exceeds the width of the box.

• Fixed Width (Wrap) — the width of the box is fixed at the size set by the 
Box Width thumbwheel. Caption text wraps to a new line when it exceeds 
the width of the box.

• Each row as wide as widest — the box for each line of text is the width of 
the widest line of text.

• Each row as wide as needed — the box for each line of text is as wide as it 
needs to be to accommodate that line of text.

Use the Box Width thumbwheel to set a fixed width for the background box. 
Values range from 0 to 2000.

Category Control Description
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SubCap Effect Global Properties

Number of 
Rows of Text

Controls how many rows of text are allowed for the caption. The options are:

• As Many Rows as Needed — allows as many rows as are needed to 
accommodate the caption text and observe other settings such as box 
width.

• Exactly N Rows — sets an exact number of rows. If there is more text for 
the caption than can fit in the number of rows, the overflow text is not 
visible. If there is not enough text to fill the number of rows, one or more 
empty rows display.

• At Most N Rows — sets a maximum number of rows. If there is more text 
for the caption than can fit in the number of rows, the overflow text is not 
visible. If there is not enough text to require the maximum number of 
rows, Media Composer uses only the number of rows needed for the text .

Use the Row Count thumbwheel to set an exact or a maximum number of 
rows. Values range from 1 to 25.

Padding Adds extra pixels of padding between the edges of the background box and the 
edges of the text it contains. Use the Vertical slider to add padding to the top 
and bottom of the box, and the Horizontal slider to add padding to the sides of 
the box. Values range from 0 to 999.

Row Spacing Adjusts the line spacing between rows of text. Values range from –10 to 50, 
where 0 represents no change to the default line spacing for the font. Negative 
values move rows of text closer together. Positive values move rows of text 
further apart.

Caption Text Edit Master 
Caption List

Opens the Master Caption List dialog box, which lets you view and edit all of 
the captions in the current sequence. For more information, see “Editing Text 
in the Master Caption List” on page 374.

Caption 
text box

Displays the caption text and lets you enter caption text. For more information, 
see “Entering Caption Text Directly in the Effect Editor” on page 372.

Tab Option Description

Contacts Publisher Enter up to 32 characters of text that describe the publisher of 
the content, for example a company name.

Country of Origin Select a country name from the list. (Media Composer converts 
the name to a standard country code in a .stl file.)

Editor’s Name
Editor’s Contact Details
Translator’s Name
Translator’s Contact Details

Enter up to 32 characters of text in each of these text boxes to 
record information about the editor and translator for the 
content. For example, you might enter an e-mail address or 
telephone number in the Contact Details text boxes.

Custom Enter up to 576 characters of text in the text box that records 
any custom information that you want to include with the effect.

Program Revision Date
Creation Date

Enter dates to track the original creation date and the latest 
revision date for the content.

Category Control Description
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Timecode Burn-In Effect Parameters

Timecode Burn-In parameters control the content and appearance of the timecode displays. 
Timecode Burn-In effect parameters are not keyframeable.

Language Select a language from the list. (Media Composer converts the 
language name to a standard language code in a .stl file.)

Original Program Title
Original Episode Title
Translated Program Title
Translated Episode Title

Enter up to 32 characters of text in each of these text boxes to 
record information about the titles of the program and episode.

n The character limits for the information categories in the Contacts, Custom, and Program tabs are 
imposed by the EBU N19 (.stl) caption file standard.

Stylesheets Displays a list of caption parameter stylesheets, and lets you 
manage and apply stylesheets. For more information see 
“Working with SubCap Effect Stylesheets” on page 378.

Synchronize Displays a list of all SubCap effect parameters and information 
categories and lets you define how changes to these parameters 
and categories propogate in a sequence. For more information, 
see “Synchronizing SubCap Effect Parameters and 
Information” on page 375.

Tab Option Description

Category Description

Display 1, 
Display 2, 
Display 3

Let you add up to three timecode displays to the video. Click the Enable button for the category 
to activate the display.

Each Display category contains Reader and Type menus, and Timecode Display and 
Appearance subcategories, as described in the following rows of this table.
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Reader menu Selects the basic type of timecode or other information for the display. The following options 
are available:

• Timecode

• Source Timecode

The timecode of the source clip at the current location. If there are multiple clips on different 
tracks in the timeline, you can use the Source Track menu to select the clip whose timecode 
you want to display, as described in the Timecode Display row of this table.

• Edgecode (if available for film-originated material)

• Source Edgecode (if available for film-originated material)

The edgecode of the source clip at the current location. If there are multiple clips on 
different tracks in the timeline, you can use the Source Track Number menu to select the clip 
whose edgecode you want to display, as described in the Timecode Display row of this table.

• Frames

• Source Clip Name

The name of the source clip at the current location. If there are multiple clips on different 
tracks in the timeline, you can use the Source Track menu to select the clip whose name you 
want to display, as described in the Timecode Display row of this table.

• Sequence Name

• Source Bin Column, Sequence Bin Column

The information from the bin column you select. Select the bin column name you want to 
use from the Column Name menu that appears below the Display Label and Display Fields 
buttons. To display a custom, user-defined bin column, select either Custom Property or 
Enhancement from the Column Name menu, and then type the name of the custom column 
in the text box that appears below the Column Name menu.

• Other Counters

Select Other Counters to display a submenu, the Bin Timecode Column. Select this submenu 
to display auxiliary timecodes and film related options.

• Timeline Clip Text

Select Timeline Clip Text. The comments will appear with the clip in the Record monitor. 
The effect will not show anything on clips where there are no comments.

Category Description
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Type menu Selects an option to control how Media Composer calculates the timecode to display. These are 
equivalent to options available in the Tracking Information menus above the monitors (for more 
information, see “Tracking Format Options” in the Help).

Depending on your selection in the Reader menu, options in the Type menu might not be 
relevant or might result in an unchanged display. For example, if you select Frames in the 
Reader menu, the Start and Absolute options yield the same display.

The following options are available:

• Current

• End

• Duration

• Mark IN

• Mark OUT

• I/O

• Remaining

• Absolute

Display Label If this option is selected, the display begins with a label identifying the timecode format, for 
example, Mas TC1 01:00:01:16. If this option is deselected, the display shows only the 
timecode itself, for example, 01:00:01:16.

Display Fields If this option is selected, the display shows the field number, for example, 01:00:01:16.2 for 
field-based media.

Local Frame 
Count

You can choose this option to display a frame count for the effect in feet and frames (35mm 
4perf). 

Start Counting 
From

When working with third party vendors, some user’s want the ability to refer to the first frame of 
a segment as a frame other than frame 0. The Burn-In effect provides the option to set the 
starting frame count.

Category Description
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Timecode 
Display

Provides additional controls for selecting the format or source of the information that appears in 
the timecode displays. The controls vary depending on the selection you make in the Reader 
menu, as follows:

• If Timecode, Source Timecode, Edgecode, or Source Edgecode is selected in the Reader 
menu, a Timecode Format menu appears that lets you select the timecode format when 
multiple timecode formats are available for the material. For more information, see 
“Displaying Timecodes in a 24p or 25p Project” in the Help.

• If Edgecode or Source Edgecode is selected in the Reader menu, a Film Controls 
subcategory appears, containing a Film Type menu that lets you select the film type. In most 
circumstances you can use the “default film type” option. However, depending on the 
information available in your bins and your selection in the Film and 24p Settings dialog box 
for a film project, you might have more than one ink number format that you can display.For 
more information, see “Film Shoot Specifications” and “Film and 24P Settings” in the Help.

• If Source Timecode, Source Edgecode, or Source Clip Name is selected in the Reader menu, 
a menu appears that lets you select the track in the Timeline that is the source of the 
timecode or clip name information. You can select Current Track, which refers to the track 
the Timecode effect is on, or any other video or audio by its track name, for example, V3.

• If Frames is selected in the Reader menu, a Local Frame Count button appears below the 
Display Label and Display Fields buttons. Select Local Frame Count to display the frame 
number for the current clip. Deselect Local Frame Count to display the frame number for the 
sequence.

• If Sequence Name is selected in the Reader menu, the Timecode Display category does not 
contain any controls.

Appearance Each Display category and the Notes Track category contain an Appearance subcategory. The 
Appearance subcategory contains the following subcategories and controls:

• Position — Use the X and Y sliders to set the position of the display’s anchor point within 
the video frame. You can also position the display directly in the monitor by dragging the 
anchor point (located at the top left corner of the display).

• Font Size — Use the thumbwheel to set the font size used for the display’s text.

The font size value is in absolute pixels, based on the font’s metrics. The relative size of the 
display’s text changes when you switch between SD and HD because HD resolutions have 
more vertical pixels than SD resolutions. Text that is relatively large and readable in SD 
becomes considerably smaller if, for example, you switch the project type to an HD format. 
If you need to switch resolutions and need your timecode display to maintain the same 
relative size, render the effect.

• Text — Use the color controls to set the color of the text (you can use the R, G, and B 
sliders, or use the Other Options button or the eyedropper to pick a color, as described in 
“Adjusting a Color Parameter for an Effect” on page 74). Use the Text Opacity slider to set 
the opacity of the text — values range from 0 (fully transparent) to 1 (fully opaque) in 0.1 
increments. Use the Line Weight thumbwheel to control the width of the black outline 
around text characters (when Use Text Outline is selected), or to add thickness to the text 
characters (when Use Text Outline is deselected).

• Background — Use the color controls to set the color of the rectangular background for the 
display (you can use the R, G, and B sliders, or use the Other Options button or the 
eyedropper to pick a color, as described in “Adjusting a Color Parameter for an Effect” on 
page 74). Use the Border Opacity slider to set the opacity of the rectangular background — 
values range from 0 (fully transparent) to 1 (fully opaque) in 0.1 increments.

Category Description
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Illusion FX Effect Parameters
This section contains reference summaries for the effect parameters that are unique to the Illusion FX 
effect category.

Border Parameter for Illusion FX Effects

The Border parameter category is available for the following Illusion FX effects: Crystal, FluidBlur, 
FluidColorMap, FluidMorph, Kaleidoscope, Melt, Particle Blast, Particle Orbit, Particle Wind, 
Radial Blur, Ripple, Rollup, Shear, Sphere, Swirl, Twist, and Wave.

Use the Left, Right, Top, and Bottom sliders to prevent black edges of the source clip from warping 
into the effect.

Color Mix Effect Input Parameters

Crystal Effect Input Parameters

Text Lets you enter a text annotation in the text box, for example, a comment that you want to display 
in a review version of a sequence. This category also contains an Appearance subcategory for 
controlling the look of the notes track, as described in the previous row of this table.

The anchor point for the notes track is always visible in the monitor. The display itself appears 
as soon as you type text in the text box.

Category Description

Parameter Description

Color Level Sets the amount of color to add. Values range from 0 (no color) to 100 (maximum color).

Color controls Selects the color. For more information on the parameter controls, see “Color Parameter 
Controls” on page 491.
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Film Grain Effect Input Parameters

Flare Effect Input Parameters

Parameter Description

Size Sets the radius of the polygons in pixels.

Jitter Sets the randomness of the shape of the polygons. A value of 0 creates regular hexagons — the 
higher the value, the more random the shapes.

Random Seed Sets the base number Media Composer uses to calculate all random values. Each value results in 
a different random effect. This parameter is not keyframeable.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.

Parameter Description

Level Sets the amount of graininess.

Size Sets the size of the individual grain elements.

Color Simulates the slight color and luminance imperfections in film footage caused by the chemical 
processes used to transfer the negative to the film. The default setting applies a balanced 
combination of color and luminance imperfections. Higher values add more color imperfections 
and fewer luminance imperfections. Lower values add more luminance imperfections and fewer 
color imperfections.

Field Mode Causes the grain pattern to update every field.

Hilite Grain Adds grain to the brighter areas of the image.

Shadow Grain Adds grain to the darker areas of the image.
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FluidBlur Effect Input Parameters

Parameter Description

Brightness Sets the brightness of the flare. Values range from 0 (no flare) to 100 (maximum brightness).

Size Sets the diameter of the flare ring.

Width Sets the distance between the inner and outer edges of the flare ring.

Amount Sets the amount of distortion to the flare ring (0 is no distortion).

Random Seed Sets the base number Media Composer uses to calculate all random values. Each value results in 
a different random effect. This parameter is not keyframeable.

X, Y Sets the center of the flare ring.

Parameter Description

Blur Amount Sets the level of blur for objects that are moving.

The amount of blur ramps linearly from 0 to the Blur Amount value as the pixel 
motion increases from the Lower Motion Threshold value to the Upper Motion 
Threshold value. The faster an object moves, the more it is blurred.

Lower Motion 
Threshold, 
Upper Motion Threshold

Media Composer does not blur objects moving less than the Lower Motion Threshold 
number of pixels between frames or fields or more than the Upper Motion Threshold 
number of pixels between frames or fields. Media Composer blurs objects whose 
movement falls between the two values by the Blur Amount.

Trail Instructs Media Composer to add an amount from the previous frame’s (or field’s) 
blur to the current frame. This produces smooth movement, especially as objects move 
along curved paths.

Sharpen Leading Edge Lets you keep the front edge of an object crisp and clear while other portions are 
blurred.

Progressive Source If your sources are progressive, enabling Progressive Source produces smoother 
results. Use this option if your footage was captured or converted to progressive 
footage (that is, not interlaced). This option has no effect in 24p projects because 
Media Composer assumes that you are using progressive footage.
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FluidColorMap Effect Input Parameters

FluidMorph Effect Source and Input Parameters

Source Menu

Parameter Description

Min Motion Threshold, 
Max Motion Threshold

Objects moving less than the Min Motion Threshold number of pixels between frames 
(or fields) have the minimum saturation and luminance. Objects moving more than the 
Max Motion Threshold number of pixels between frames (or fields) have the 
maximum saturation and luminance. The amount of saturation depends on the 
Constant Saturation value.

Brightness and color saturation increase as the motion of an object increases from the 
minimum threshold value to the maximum threshold value. The faster an object 
moves, the brighter and more color saturated it becomes.

Constant Saturation Controls how much the Min Motion Threshold and Max Motion Threshold values 
affect the color saturation (these values always control the luminance of the image). 
When the Constant Saturation value is low, the Min Motion Threshold and Max 
Motion Threshold values strongly affect saturation as well as luminance. When the 
Constant Saturation value is high, the values affect saturation to a lesser degree. If you 
set Constant Saturation to the maximum value, motion has no effect on color 
saturation.

Progressive Source If your sources are progressive, enabling Progressive Source produces smoother 
results. Use this option if your footage was captured or converted to progressive 
footage (that is, not interlaced). This option has no effect in 24p projects because 
Media Composer assumes that you are using progressive footage.

Option Description

Still->Still Media Composer takes snapshots of the last frame of outgoing video and the 
first frame of incoming video and creates an output that is a morph of the two 
images.

Stream->Stream Your application creates the output by morphing the two clips, frame by 
frame.

Stream->Still Your application creates the output by morphing each frame of the outgoing 
video with thefirst frame of incoming video.
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Input Parameters

Iris Effect Input Parameters

Still->Stream Your application creates the output by morphing the last frame of the outgoing 
video with each frame of the incoming video.

Option Description

Parameter Description

Feature Match When Feature Match is selected, Media Composer attempts to match features between the 
two clips when it creates the morph for each frame.

When Feature Match is deselected, Media Composer creates the morph based on the 
brightness of the two images.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter is not 
keyframeable.

Progressive Source Use this option if your footage was captured or converted to progressive footage (that is, not 
interlaced). If your sources are progressive, enabling Progressive Source produces smoother 
results. This option has no effect in 24p projects because Media Composer assumes that 
you are using progressive footage.

Parameter Description

Amount Sets the proportion of each clip to be displayed. Values range from 0 (displays all of the 
foreground clip) to 100 (displays all of the background clip). Typical keyframing has a value of 
0 at the first keyframe and 100 at the last keyframe.

Softness Sets the size of the area over which the pixels are faded from the foreground clip to the 
background clip.

X, Y Sets the center of the iris wipe.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter is not 
keyframeable.
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Kaleidoscope Effect Input, Center, and Offset Parameters

Input Parameters

Center Parameters

Offset Parameters

Parameter Description

Symmetry Sets the number of mirrors.

Angle Sets the angle of the mirrors.

Scale Sets the scale of the image.

Parameter Description

 X Sets the horizontal location of the center of the mirrors.

Y Sets the vertical location of the center of the mirrors.

You can also set the center of the mirror by clicking and dragging the crosshair marker within the image.

Parameter Description

 X, Y Use the X and Y sliders to set the offset from the original source area.

You can also click the corresponding marker, and drag within the image.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.
515



Illusion FX Effect Parameters
Lightning Effect Generation, Core, and Glow Parameters

Generation Parameters

Core Parameters

Glow Parameters

Parameter Description

 Amount Sets the proportion of the lightning to be displayed. Values range from 0 (no 
lightning) to 100 (complete lightning bolt). Typical keyframing has a value of 0 at the 
first keyframe and 100 at the last keyframe.

Branch Probability Sets the likelihood that the lightning has few or many branches. A value of 0 displays 
no branches. The higher the value, the more branches are likely.

Random Seed Sets the base number upon which all random values are calculated. Each value results 
in a different random effect. This parameter is not keyframeable.

Render Mode menu Click to set the quality of the rendered lightning:

• Quick — use to view just the motion of the lightning.

• Standard — use to view the full lightning without anti-aliasing while editing the 
animation.

• Anti-aliased — use to ensure that fine branches do not break up.

Parameter Description

Width Sets the radius of the core in pixels.

Color controls Selects the color for the core of the lightning. For more information on the parameter controls, 
see “Color Parameter Controls” on page 491.
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Melt Effect Input Parameters

Motion Blur Effect Input Parameters

Parameter Description

Width Sets the radius of the glow in pixels.

Color controls Selects the color for the glow surrounding the lightning. For more information on the 
parameter controls, see “Color Parameter Controls” on page 491.

Parameter Description

Bleed Changes the melt image to a more dramatic effect.

Melt Up Reverses the direction of the melt.

Amount Sets the progression of the effect. A value of 0 has no effect, and all of the foreground clip 
shows. The higher the value, the more of the foreground clip melts away to reveal the 
background clip. Typical keyframing has a value of 0 at the first keyframe and 100 at the last 
keyframe.

Strength Sets the strength of the distortion. The higher the value, the greater the distortion.

Random Seed Sets the base number upon which all random values are calculated. Each value results in a 
different random effect. This parameter is not keyframeable.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter is not 
keyframeable.

Parameter Description

Amount Sets the length of the blur.

Direction Sets the direction of the blur. A value of 0 degrees is 3 o’clock. Positive values move 
counterclockwise.
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Pagecurl Effect Input Parameters

The following table describes the possible Pagecurl parameter combinations and shows an example 
of the results.

Parameter Description

Turn Left Controls the direction of the page curl. For examples, see the following table. This parameter 
is not keyframeable.

Reverse When Reverse is selected, incoming video peels on. When Reverse is deselected, outgoing 
video peels off. For examples, see the following table. This parameter is not keyframeable.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. For examples, see the 
following table. This parameter is not keyframeable.

Parameter 
Values Result Parameter Values Result

Turn Left: Off

Reverse: Off

Swap Sources: Off

Outgoing video peels off

Turn Left: Off

Reverse: Off

Swap Sources: On

Incoming video peels off

Turn Left: On

Reverse: Off

Swap Sources: Off

Outgoing video peels off

Turn Left: On

Reverse: Off

Swap Sources: On

Incoming video peels off

Turn Left: Off

Reverse: On

Swap Sources: Off

Incoming video peels on

Turn Left: Off

Reverse: On

Swap Sources: On

Outgoing video peels on

Turn Left: On

Reverse: On

Swap Sources: Off

Incoming video peels on

Turn Left: On

Reverse: On

Swap Sources: On

Outgoing video peels on
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Particle Blast Effect Input Parameters

Particle Orbit Effect Input Parameters

Parameter Description

Amount Sets the progression of the effect. The larger the difference in the Amount value between 
keyframes, the faster the effect happens.

Size Sets the radius of the particles.

Spacing Sets the space between the center of the original position of the particles. This parameter 
is not keyframeable.

Front Speed Controls whether the particles in the center of the blast start to move before the particles at 
the outside edges.

Front Randomness Allows particles nearest the center to move at different speeds.

Speed Sets the speed at which particles move apart.

Speed Randomness Allows particles to move at different speeds to give a more natural effect.

Acceleration Controls how quickly a particle reaches the full speed of the blast. The higher the value, the 
more quickly the particle reaches full speed.

Bumpiness Adds a shadow to the edge of the particles.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter is not 
keyframeable.
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Particle Orbit Effect Parameter Example

When you use this effect as a transition effect, Avid recommends the following parameter changes:

• At the first keyframe, set initial Amount and Bumpiness values to 0 so the transition begins 
smoothly.

• Add a keyframe to increase the Amount value during the transition. For example, change the 
value from 0 to 40.

• At the same keyframe, set the Size value. For example, reduce Size from 10 to 0.

• (Option) At the same keyframe, increase Bumpiness. Increasing Bumpiness gives additional 
texture to the particles. For example, change the value from 0 to 100.

The following illustration shows four frames from a transition effect using the values in the example.

Parameter Description

Amount Sets the progression of the effect. The larger the difference in the Amount value between 
keyframes, the faster the effect happens.

Size Sets the radius of the particles.

Spacing Sets the space between the center of the original position of the particles. This parameter is 
not keyframeable.

Bumpiness Adds a shadow to the edge of the particles.

Speed Sets the speed at which particles orbit.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter is not 
keyframeable.
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Particle Wind Effect Input Parameters

Parameter Description

Amount Sets the progression of the effect. The larger the difference in the Amount value between 
keyframes, the faster the effect happens.

Size Sets the radius of the particles.

Spacing Sets the space between the center of the original position of the particles. This parameter 
is not keyframeable.

Front Speed Controls whether the particles near the front edge (where the wind first hits) start to move 
before the particles at the outside edge.

Front Randomness Allows particles nearest the front to move at different speeds.

Speed Sets the wind speed.

Speed Randomness Allows particles anywhere within the effect to move at different speeds, giving a more 
natural effect.

Acceleration Controls how quickly a particle reaches the full speed of the wind. The higher the value, the 
more quickly the particle reaches full speed.

Angle Sets the source direction of the wind. A value of 0 degrees is 3 o’clock. Positive values 
move counterclockwise.

Bumpiness Adds a shadow to the edge of the particles.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter is 
not keyframeable.
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Pattern Generator Effect Background, Number, and Circle Parameters

Background Parameters

Number Parameters

Parameter Description

Pattern Type menu Sets the pattern to be used:

• Solid color

• EBU bars (75%)

• Color bars (75%)

• Color bars (100%)

• EIA bars

• SMPTE bars

• Color ramps

• Cross ramp

• Grid

If you select the Grid option, the background color is black if Base Color has 50% 
or greater luminance, or white if Base Color has less than 50% luminance.

Axis menu Determines whether color bars are drawn horizontally (X axis) or vertically (Y axis).

Color controls Sets the color of the clip (when the Pattern Type is set to Solid Color) or of the grid 
lines (when the Pattern Type is set to Grid). The background color of the grid is black 
if Base Color has 50% or greater luminance, or white if Base Color has less than 50% 
luminance. For more information on the parameter controls, see “Color Parameter 
Controls” on page 491.
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Circle Parameters

Pinch Effect Input Parameters

Parameter Description

Number Offset Sets the offset of the number from the current frame number.

Opacity Sets the opacity of the number.

Text Size Sets the size of the number.

Stroke Width Sets the width of the number stroke.

Color controls Sets the color of the number. For more information on the parameter controls, see 
“Color Parameter Controls” on page 491.

Position Sets the horizontal (X) and vertical (Y) position of the center of the number.

Parameter Description

Size Sets the radius of the circle.

Width Sets the width of the circle outline.

Opacity Sets the opacity of the circle.

Color controls Sets the color of the circle. For more information on the parameter controls, see “Color 
Parameter Controls” on page 491.

Position Sets the horizontal (X) and vertical (Y) position of the circle.

Parameter Description

Amount Sets the progression of the effect. The larger the difference in the Amount value between 
keyframes, the faster the effect happens.

Size Sets the diameter of the affected area.

Position Sets the horizontal (X) and vertical (Y) center of the effect.
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Radial Blur Effect Input Parameters

Random Blend Effect Input Parameters

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.

Parameter Description

Parameter Description

Zoom Sets the scaling of the blur. Smaller values zoom in and larger values zoom out.

Angle Sets the rotation of the blur.

n This effect can take a long time to render. The greater the angle, the longer the 
rendering takes.

Position Sets the horizontal (X) and vertical (Y) center of the effect.

Render Mode 
menu

Determines whether just the center marker shows, or how the effect is rendered. Locate shows 
the center marker — use this option while setting up the center.

• Locate

• Render Low Quality

• Render Medium Quality

• Render High Quality

Parameter Description

Amount Sets the amount of blend.

Random Scale Sets the amount of randomness. This allows Media Composer to blend different 
portions of the image at different rates.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter 
is not keyframeable.
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Ripple Effect Motion, Generation, and Illumination Parameters

Motion Parameters

Generation Parameters

Illumination Parameters

Parameter Description

Amount Sets the progression of the effect. The larger the difference in the time value between 
keyframes, the faster the effect happens.

Wave Speed Sets how fast the waves move.

Ripple Spread Sets the width of the ripple from the inner ring to the outer ring.

Reflections When Reflections is selected, waves reflect off the edges of the image, as though hitting a wall.

Parameter Description

Strength Sets the height of the waves.

Length Sets the distance between the wave peaks.

Number of Ripples Sets the number of ripples.

Random Seed Sets the base number upon which all random values are calculated. Each value results in a 
different random effect. This parameter is not keyframeable.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.
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Rollup Effect Input Parameters

Shear Effect Input Parameters

Parameter Description

Color controls Sets the color of the light. For more information on the parameter controls, see “Color 
Parameter Controls” on page 491.

Angle Sets the source direction of the light. A value of 0 degrees is 3 o’clock. Positive values move 
counterclockwise.

Parameter Description

Amount Sets the proportion of each clip that displays. Values range from 0 (displays all of the 
foreground clip) to 100 (displays all of the background clip). Typical keyframing has a value 
of 0 at the first keyframe and 100 at the last keyframe.

Curl Size Sets the size of the roll.

Direction Sets the direction of the rollup. A value of 0 degrees is 3 o’clock. Positive values move 
counterclockwise.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter is not 
keyframeable.
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Sparkler Effect Generation, Movement, Core, and Glow Parameters

Generation Parameters

Parameter Description

Amount Sets the proportion of each clip that displays. Values range from 0 (displays all of the 
foreground clip) to 100 (displays all of the background clip). Typical keyframing has a 
value of 0 at the first keyframe and 100 at the last keyframe.

Min Width, Max Width Sets the minimum and maximum possible width of the slats.

Width Randomness Controls the variety of sizes of slats. Media Composer creates slats of various widths 
in between the minimum and maximum width value.

Spread Sets the randomness of when individual strips start moving. A value of 0 causes all 
strips to start at the same time.

Angle Sets the direction of the effect. A value of 0 degrees is 3 o’clock. Positive values move 
counterclockwise.

Random Seed Sets the base number upon which all random values are calculated. Each value results 
in a different random effect. This parameter is not keyframeable.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not 
keyframeable.

Swap Sources Specifies whether to apply the effect to incoming or outgoing video. This parameter 
is not keyframeable.

Parameter Description

Birth Rate Sets the number of sparks generated every frame.

Lifetime Sets (in frames) how long each spark lives.

X, Y Sets the center of the effect.

Link Speed If you keyframe the center of the effect, Link Speed causes Media Composer to add the 
movement of the center to the movement of the sparks.

Length Sets the cumulative exposure of the sparks. For example, a value of 3 produces an image that 
looks as though you left a virtual camera shutter open for the last three frames.

Speed Bias X, 
Speed Bias Y

Sets the bias to the direction of the sparks. Media Composer adds these values to the initial 
random directions.
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Movement Parameters

Core and Glow Parameters

Sphere Effect Input Parameters

Parameter Description

Speed Sets the value around which the speed of the sparks is randomized.

Gravity Sets the attraction of the sparks downward or upward. The greater the value, the more the sparks 
are attracted downward.

Air Resistance Sets the air resistance. The higher the value, the less the sparks radiate outward.

Wind X, Wind 
Y

Sets a virtual directional wind, which affects the trajectory of the sparks. The Air Resistance 
value must be greater than 0 for Wind to have an effect.

Turbulence Adds randomness to the movement of the sparks.

Parameter Description

Core Radius Sets the radius of the core in pixels.

Glow Radius Sets the radius of the glow in pixels.

Color controls Sets the color of the core or glow. For more information on the parameter controls, see 
“Color Parameter Controls” on page 491.
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Swirl Effect Input Parameters

Twist Effect Input Parameters

Parameter Description

Amount Sets the scale of the distortion. Negative values distort the image inward. Positive values distort 
it outward.

Size Sets the diameter of the circle as a normalized proportion of the vertical size of the image.

X, Y Sets the center of the effect.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.

Parameter Description

Amount Sets the scale of swirl. Negative values swirl the image counterclockwise. Positive values 
swirl it clockwise.

Size Sets the diameter of the circle as a normalized proportion of the vertical size of the image.

X, Y Sets the center of the effect.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not keyframeable.

Parameter Description

Amount Sets the amount of twist.

X, Y Sets the center of the effect.

Axis menu Click to set whether the twist applies horizontally (X axis) or vertically (Y axis).

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not 
keyframeable.
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Wave Effect Input Parameters

Image Effect Parameters
This section contains reference summaries for the effect parameters that are unique to the Image 
effect category.

Avid Pan & Zoom Effect Parameters

Import Image

The Import image button opens a file selection dialog box that lets you specify the image file for the 
Pan & Zoom effect. For more information, see “Using Avid Pan & Zoom” on page 230. This 
parameter is not keyframeable.

Parameter Description

Amount Sets the scale of swirl. Negative values swirl the image counterclockwise. Positive 
values swirl it clockwise.

Minimum Size, 
Maximum Size

Sets the minimum wavelength and the maximum wavelength.

Horizontal Factor, 
Vertical Factor

The amount of horizontal distortion and vertical distortion. Values range from 0 (no 
distortion) to 100 (maximum distortion).

Number of Waves Sets the number of waves. Wave effects are superimposed upon each other.

Speed Sets the progress of the effect.

Random Seed Sets the base number upon which all random values are calculated. Each value results 
in a different random effect. This parameter is not keyframeable.

Anti-alias Sets whether or not transformed areas are smoothed. This parameter is not 
keyframeable.
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Display Menu

The Display menu lets you choose how you view the image as you work on it. For more information, 
see “Controlling Your View of an Avid Pan & Zoom Image” on page 231. This parameter is not 
keyframeable.

Display Options

These parameters are not keyframeable.

Size

The Zoom Factor slider in the Size category controls how far you zoom into or out from the source 
image. Values range from 0.1 to 20. At 0.1, Media Composer scales down the image to one-tenth the 
size of the original. At 1, Media Composer applies no magnification to the source image. At 20, 
Media Composer scales up the image to 20 times the size of the original. The larger the Zoom Factor, 
the smaller the field of view rectangle appears when you use Source mode. For more information, see 
“Adjusting the Field of View for an Avid Pan & Zoom Image” on page 232.

Position

You control pan either by using the X and Y Position parameters or by dragging the field of view 
across the source image. The Position parameters refer to the center of the field of view. A Position of 
0, 0 centers the field of view over the center of the image. For more information, see “Adjusting the 
Field of View for an Avid Pan & Zoom Image” on page 232.

Option Description

Source Shows you the entire image scaled to fit inside the Effect Preview monitor. Use Source 
as you draft the effect.

Target Shows you the results of your pan and zoom settings. Use Target for previewing your 
moves.

Option Description

Show Safe Action Show Action Safe selects or deselects the display of the safe action area. 
When Show Action Safe is selected, the safe action area appears as a 
rectangle superimposed on the field of view.

Use Subres in Preview Use a lower resolution of the image during preview. Note that this option 
does not apply when rendering.
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Velocity

The Avid Pan & Zoom effect uses Velocity In and Velocity Out at each keyframe to modify apparent 
camera speed as it pans across the image between keyframes. It modifies changes in the Zoom Factor 
setting in the same way. For more information, see “Modifying Apparent Camera Speed for an Avid 
Pan & Zoom Effect” on page 233.

Path Menu

The Path menu selects the interpolation option for Position parameter changes at keyframes. For 
more information, see “Controlling Path Changes at Keyframes for an Avid Pan & Zoom Effect” on 
page 235. This parameter is not keyframeable.

Parameter Description

Velocity In Controls the rate of movement from the selected keyframe to the midpoint between the 
selected keyframe and the next keyframe (the first half of the time between keyframes).

• Linear — Makes no modification to the pan and zoom movement. Apparent camera 
movement begins immediately with no ease in.

• Constant — Does not use the keyframe’s Position parameters to calculate the speed of the 
effect, but uses the keyframe’s Position parameters to determine the path of the effect (the 
pan) and the keyframe’s Zoom Factor to calculate the zoom between the selected keyframe 
and the next keyframe.

When you select Constant for Velocity In, Media Composer automatically selects Constant 
for Velocity Out.

• Ease In — Modifies movement by providing a slight acceleration at the beginning of the 
time between the selected keyframe and the next keyframe.

Velocity Out Controls the rate of movement from the midpoint between the selected keyframe and the next 
keyframe to the next keyframe (the second half of the time between keyframes).

• Linear — Makes no modification to the pan and zoom movement . Parameters change at a 
constant rate up to the next keyframe.

• Ease Out — Modifies the pan and zoom movement by providing a slight deceleration into 
the next keyframe.

• Constant — Does not use the keyframe’s Position parameters to calculate the speed of the 
effect, but uses the keyframe’s Position parameters to determine the path of the effect (the 
pan) and the keyframe’s Zoom Factor to calculate the zoom between the selected keyframe 
and the next keyframe.

When you select Constant for Velocity In, Media Composer automatically selects Constant 
for Velocity Out.

• Hold — At the midpoint between the selected keyframe and the next keyframe, the image 
freezes (pan and zoom movement stop). Movement resumes at the next keyframe. The 
effect disregards the Velocity In value of the next keyframe. If you have Background set to 
Video, the background continues to update.
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Filtering Menu

Filtering controls the method by which the effect renders, which determines the quality of the 
rendered result. The options let you trade off the clarity or sharpness of the resized image and the 
speed at which the effect renders. This parameter is not keyframeable.

The following table ranks the Filtering menu options from fastest render and lowest quality image to 
slowest render and highest quality image. For more information, see “Setting a Rendering Option for 
an Avid Pan & Zoom Effect” on page 236.

Background

These parameters are not keyframeable.

Option Description

Linear Creates straight-line changes from one keyframe to the next.

Spline Smooths out changes at keyframes to create a more natural movement. A Spline path is 
smooth through all points. If you move a point the effect recalculates the entire path.

n If you combine a Spline path with Constant velocity, when you move a keyframe, 
the path recalculation might result in a change to the velocity of the effect. For 
more information, see “Velocity” on page 532.

Option Description

Real-Time Renders most quickly but creates a draft-quality image. Media Composer 
always uses this option during uncompressed play.

Triangle Creates fairly soft images.

Quadratic Creates slightly sharper images than Triangle filtering.

Cubic Creates sharper images than Quadratic filtering although still fairly soft.

B-Spline Catmull Creates results similar to Cubic filtering when you zoom out (shrink the image) 
by a large amount. Creates a sharper image than Cubic filtering when you:

• Stay close to the original size of the image (little zooming in or zooming 
out).

• Zoom in past the source image resolution.

Gaussian Creates an image that is relatively soft but sharper than B-Spline Catmull.

Avid High Qual Creates sharp images when you zoom out.

Avid Ultra Qual Creates extremely sharp images when you zoom out, but has the longest 
rendering time.
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Advanced

The Advanced category provides controls for the rare case in which an image for Avid Pan & Zoom 
comes from a video source. These parameters are not keyframeable.

Cache Menu

The Cache menu gives you control over the amount of memory Media Composer uses to store your 
images for playback. (A full resolution image is always used for rendering.) This parameter is not 
keyframeable.

Parameter Description

Background Menu Click to select what the effect uses outside the field of view if your image does not fill 
the entire screen.

Color — Lets you select a color using the color controls.

Video — Uses the video from the segment upon which you placed the Avid Pan & 
Zoom effect.

Color controls Selects a background color. For more information on the parameter controls, see 
“Color Parameter Controls” on page 491.

Parameter Description

Source Has Square 
Pixels

When this option is selected (the default), the Avid Pan & Zoom effect produces rectangular 
pixels. When this option is deselected, Media Composer makes no changes to pixel shape.

For more information, see “Adjusting for Source Image Pixel Aspect Ratio and Color Levels 
in an Avid Pan & Zoom Effect” on page 238.

Source Levels Controls how the effect treats the color levels in the image.

• RGB — Use this option (the default) for images with a black level of 0 and a white level 
of 255. Most images you import (except those from a video source) use these values. 
Media Composer maps colors in the source image to video black and white levels, which 
are 16 and 235 respectively.

• 601 — Use this option for images from a video source, where the black level is 16 and 
the white level is 235. 601 refers to the ITU-R-601 standard for video black and white 
levels. When this option is selected, Media Composer makes no adjustment to color 
levels.
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Render Mode

If you are working in a progressive project, click the Progressive check box in the Render Mode 
parameter category. Selecting this option creates a smoother animation when using progressive 
frames. For more information, see “Setting a Rendering Option for an Avid Pan & Zoom Effect” on 
page 236. This parameter is not keyframeable.

Blur Effect Blur Parameters

Blur lets you blur a selected area with horizontal and vertical controls. This is useful for distorting or 
disguising part of an image. You can also create this effect using the Paint Effect by selecting Blur 
mode in the Mode parameter category. For more information, see “Paint Effect Mode Parameters” on 
page 540.

Color Effect Parameters

Luma Adjust Parameters

Luma Adjust lets you manipulate the brightness and contrast of the image.

Option or Action Description

Free Current Cache Frees all memory used for image storage and then reverts to Image Resolution. 
Select this option to free up memory after you render the clip.

Free All Caches Frees the caches for all instances of the plug-in in that sequence.

Parameter Description

Opac. (opacity) Controls the relative strength of the blur. Values range from 100 (maximum blur) to 0 
(minimum blur).

Blur Visible Lets you add a keyframe and have the blurred area suddenly “pop” onto the screen at the 
position marked by the keyframe. You must have at least three keyframes to create this 
effect.

Fixed Aspect Allows you to lock X and Y to the same values.

Hor (horizontal) 
and Vert (vertical)

Defines the horizontal and vertical dimensions of the blurred area.
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Luma Range Parameters

Luma Range parameters let you adjust the range of brightness from black to white.

Parameter Description

Bright
(brightness)

Changes the brightness of the image. Values range from –100 to +100, where 0 indicates no 
change, –100 darkens the image, and +100 brightens the image.

Left to right: original image (Brightness=0), adjustment to Brightness -50, adjustment to Brightness 
+50

Cont
(contrast)

Controls the contrast of light and dark areas in the image. Values range from –100 to +100, 
where 0 indicates no change, -100 minimizes contrast, and +100 maximizes contrast.

Left to right: original image (Contrast=0), adjustment to Contrast -50, adjustment to Contrast +50

Invert Reverses the image’s brightness, such that the brightest parts become the darkest and the 
darkest parts become the lightest.

Parameter Description

Fast Menu 
button

Selects values for mapping video to alpha ranges.

• 16 to 235 — This option is the default for video images.

• 0 to 255 — This option lets you map normal video to alpha ranges. This is useful if you want 
to expand a high-contrast image to the full dynamic range. For example, use this value when 
you want to convert video to alpha for Matte Key effects.

n When you change the Luma Range to 0 to 255, Media Composer attempts to go from 0 to 
255 but the Low Clip and High Clip values in the Luma Clip parameter category clip these 
values. If you want to “open up” the image to the full dynamic range, you need to change 
the Low Clip value to 0 and the High Clip value to 255.

W Point 
(white point)

Lets you set the white point in the image. All pixels with that value become white, and all pixels 
with higher values are clipped to white. The default is 235 (the broadcast value for white).
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Luma Clip Parameters

Luma Clip parameters let you determine the levels at which Media Composer limits the brightness or 
darkness in the image.

Chroma Adjust Parameters

Chroma Adjust parameters let you alter the hue and saturation levels of the image.

B Point 
(black point)

Lets you set the black point in the image. All pixels with that value become black, and all pixels 
with lower values are clipped to black. For example, you could use the eyedropper to select a 
shadow on the floor and change it from gray to black, clipping everything below that shade to 
black. The default is 16 (the broadcast value for black).

n Black point control does not change the Black setup level. To adjust the Black setup level, 
use the Video Output tool. For more information, see “Basic Video Output Calibration” in 
the Help.

Gamma Lets you adjust the midtones in an image without affecting the extreme white or black values. If 
you lower the value you darken midtones and bring the image closer to black. If you raise the 
value you lighten the midtones and bring the image closer to white.

For example, a person shot in front of a window in daylight might be very dark, almost in 
silhouette. You can use gamma correction to increase the midtones without changing the blacks 
or whites. Values range from –100 to +100 with 0 being no change.

The W Point, B Point, and Luma Clip sliders control the number of shades of gray in an image. 
The Gamma point moves the distribution of the shades closer to black (negative values) or closer 
to white (positive values).

Parameter Description

Parameter Description

High Clips brightness values. No pixel in the image can be brighter than the High value. The default is 
235 (the broadcast value for white).

Low Clips darkness values. No pixel in the image can be darker than the Low value. The default is 16 
(the broadcast value for black).

You do not normally adjust these value when preparing video for broadcast. They let you adjust 
the brightness and contrast (using other controls in the Color Effect) while still maintaining legal 
broadcast values for black and white.
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Color Style Parameters

The Color Style parameters let you create posterized or solarized looks for the image.

Parameter Description

Hue Causes all hues in the image to rotate around the color spectrum. Values are measured as 
degrees on a color wheel from –180 to +180, where 0 does not change the hue. For example, a 
value of –20 makes skin tones look more green, while a values of +20 makes skin tones look 
more red.

You can use a console command to reverse the range and match the behavior of a previous 
version of Media Composer that uses the opposite range. For example, if you open a sequence 
created in a previous version, enter ChromaHueReverse in the Console so that any color 
adjustment using the Hue parameter matches that created by the original setting. To return to 
the default setting, type the command again.

If the command is enabled, the following message appears in the console when you start Media 
Composer: Reversing Software Color Effect Chroma Adjust Hue is enabled.

Sat (saturation) Varies the saturation of all colors in the image. Values range from –100 to +100, where -100 
removes all saturation (the image displays as grayscale) and +100 maximizes saturation. Zero 
is the default.

Invert Reverses the colors in both Hue and Saturation so that all colors display as their complement.

Parameter Description

Post (posterization) Posterization lets you limit the number of colors in the image by controlling the number of 
luminance steps that display. This gives the image a graphic appearance. Values range from 
0 to 25, where 0 displays all colors and 25 displays the least number of colors.

Left to right: original image , adjustment to Posterization 10, adjustment to Posterization 20
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Color Gain Parameters

The Color Gain parameters allow individual control of color gain for each of the three color 
components: red, green, and blue. Values range from 0 to 200, where 100 leaves the color unchanged, 
values lower than 100 increase the amount of the color, and values higher than 100 increase the 
amount of the color.

Mosaic Effect Mosaic Parameters

Mosaic lets you create a tiled effect for a selected area with horizontal and vertical controls. This is 
useful for distorting or disguising part of an image. You can also create this effect using the Paint 
Effect by selecting Mosaic mode in the Mode parameter category. For more information, see “Paint 
Effect Mode Parameters” on page 540.

Solar (solarization) Solarization lets you make the lightest pixels in the image dark to achieve a partial 
inversion of the luminance. The value defines a threshold, and Media Composer inverts 
values above the threshold. Values range from 0 to 255, where 0 is normal luminance and 
255 inverts all luminance values in the image. Values of 0 to 127 display the lightest pixels 
in the image as dark. Values of 128 to 255 display the lightest pixels as dark and the darkest 
pixels as light, which gives the appearance of a film negative.

Left to right: original image , adjustment to Solarization 100, adjustment to Solarization 200

Parameter Description

Parameter Description

Opac. (opacity) Controls the relative strength of the effect. Values range from 0 (least amount of distortion) 
to 100 (greatest amount of distortion).

Mosaic Visible Lets you add a keyframe and have the distorted area suddenly “pop” onto the screen at the 
position marked by the keyframe. You must have at least three keyframes to create this 
effect.

Hor (horizontal) 
and Vert (vertical)

Defines the horizontal and vertical dimensions of the distorted area.
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Paint Effect Mode Parameters

Mode parameters and options affect the overall nature of the Intraframe editing you perform using 
the Paint Effect. This parameter is not keyframeable.

A Mode parameter is also available in FluidMotion Edit and is described in “FluidMotion Edit 
Parameters for Timewarp Effects” on page 570.

Paint Effect Modes

The Paint Effect provides modes that you can use to paint with a variety of styles. When you click a 
painting tool for the first time, the default setting is Solid mode, which enables you to paint an 
opaque object on the video background with a brush stroke.

The illustrations in the following table show the same image in every case. This enables you to 
compare the different modes easily but does not necessarily illustrate the most common use of each 
mode.

Parameter Description

Fast menu Provides different mode options for Intraframe editing. For information about the available 
modes, see “Paint Effect Modes” on page 540.

Opac. (opacity) Sets the transparency level of a painted object created with the Paint Effect. Values range 
from 0 (makes a painted object transparent) to 100 (makes an object opaque).

Object Visible Lets you add a keyframe to a segment or transition and have a painted object or matte 
suddenly “pop” onto the screen at the position marked by the keyframe. You must have at 
least three keyframes to create this effect. 

Hor (horizontal),
Vert (vertical)

These parameters are available for the Clone, Scratch Removal, Mosaic, Blur, and Unsharp 
Mask modes. When you use one of these parameters with the Clone and Scratch Removal 
modes, it controls the horizontal or vertical position of the painted object in the frame relative 
to its original position. When you use one of these parameters with the Mosaic, Blur, and 
Unsharp Mask modes, it controls the extent of the tiling, blurring, or sharpening effect in the 
horizontal or vertical direction.

Amt (amount) This parameter is available for the Darken and Lighten modes. It controls the extent of the 
darkening or lightening effect.

Angle This parameter is available for the Gradient and Emboss modes. It controls the direction of 
the gradient or the extrusion effect.

Frame/Field Controls which frame or field is the source for clean replacement material when you are 
working in Scratch Removal mode. For more information, see “Scratch Removal Effect 
Scratch Parameters” on page 548.

Offset Fast menu Defines the position from which the Frame or Field parameter is measured when you are 
working in Scratch Removal mode. For more information, see “Scratch Removal Effect 
Scratch Parameters” on page 548.
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Mode Description

Solid Applies paint as a solid color superimposed on the video background.

Solid mode with Opacity set to 75%

Erase Removes paint from a frame. (Inverts the key in an AniMatte effect.)

A rectangular object in Erase mode that removes paint from the oval object beneath it

Outline Creates an outline that is useful for tracing images in a frame.

Clone Duplicates an area from a frame and applies it to another area of the frame.

An oval object in Clone mode that has been moved from higher in the image, taking an area of the 
upper part of the image with it

Colorize Tints the selected area using the value in the Color parameter category.
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Hue Changes the hue in a selected area using the value of the Hue slider in the Color parameter 
category without affecting the saturation and luminance levels.

Saturation Changes the saturation in a selected area using the value of the Sat slider in the Color parameter 
category without affecting the luminance levels and the hue.

Luminance Changes the luminance in a selected area using the value of the Lum slider in the Color 
parameter category without affecting the saturation levels and hue.

Darken Only Reduces the luminance levels in a selected area only if the result would be darker than the 
background color.

Light areas are darkened in the selected oval while darker areas of the trees remain unaltered

Mode Description
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Lighten Only Increases the luminance levels in a selected area only if the result would be lighter than the 
background color.

The reverse of the example for Darken Only. Dark areas in the selected oval are lightened while light 
areas, mainly the dirt roads, remain unaltered.

Darken Reduces the luminance levels in a selected area using the value of the Amount slider.

Luminance in the selected oval is reduced by 50.

Lighten Increases the luminance levels in a selected area using the value of the Amount slider.

Luminance in the selected oval is increased by 50.

Add Adds color to the colors in a selected area using the value of the Color parameter category.

Mode Description
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Subtract Removes color from the colors in a selected area using the value of the Color parameter 
category.

Invert Inverts the RGB values of the colors in a selected area.

Mosaic Applies a tile effect to a selected area with horizontal and vertical controls, which distorts or 
disguises the area.

Blur Blurs a selected area with horizontal and vertical controls, which distorts or disguises the area.

Mode Description
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Median Takes the nine values surrounding each pixel, ranks them, and replaces the pixel with the value 
in the middle, creating a slight softening effect. Median filters are often used to remove noise 
from an image.

Unsharp Mask Sharpens a selected area of an image to create more defined edges with horizontal and vertical 
controls.

Gradient Dissipates the paint in a gradient. Use the Angle slider to set the direction of dissipation. 100% 
of the value in the Color parameter category appears at one end of the gradient, 0% at the other 
end.

Emboss Creates a three-dimensional extrusion effect in a selected area. Use the Angle slider to adjust the 
direction of the extrusion.

Scratch 
Removal

Replaces scratched or otherwise flawed areas of a frame with clean material from a nearby 
source. For more information, see “Understanding Scratch Removal” on page 411.

Mode Description
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Paint Effect Color Parameters

Use these controls in conjunction with one of the Paint Effect modes to colorize your selection. For 
more information on the parameter controls, see “Color Parameter Controls” on page 491. This 
parameter is not keyframeable.

Safe Color Limiter Parameters

422 Safe Parameter

422 Safe controls how the effect handles chroma sub-sampling when limiting colors, offering a 
choice between performance and guaranteed accuracy.

When 422 Safe is deselected (the default value), effect processing is fast. However, depending on the 
image, a small number of transient pixel values might exceed your safe color ranges. When 422 Safe 
is selected, effect processing is slower, but every pixel in every frame is guaranteed to be within your 
safe color ranges.

Color Adjust Adjusts the brightness, contrast, hue, and saturation of the selected area. Inverts the chroma and 
luma values of the selected area. For more information, see “Color Effect Parameters” on 
page 535 and “Chroma Adjust Parameters” on page 537.

Luma Range Adjusts the range of brightness from black to white and the position of the midtone point with 
respect to the white and black points. For more information, see “Luma Range Parameters” on 
page 536.

Luma Clip Limits the brightness or darkness values in the selected area. For more information, see “Luma 
Clip Parameters” on page 537.

Color Style Adjusts the selected area to create posterization and solarization effects. For more information, 
see “Color Style Parameters” on page 538.

Color Gain Provides individual adjustments of the three color channels (red, green, and blue). For more 
information, see “Color Gain Parameters” on page 539.

Color Match Provides the same Color Match control that appears in the Color Correction tool. Lets you 
adjust the color automatically in the selected area using selected input and output color values.

Click the Enable Color Match button to activate the color match for the selected area.

Click the Use NaturalMatch™ button to enable the NaturalMatch feature.

For more information on the Color Match control and the NaturalMatch feature, see “Using the 
Color Match Control” on page 634.

Mode Description
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In many situations, you can leave 422 Safe turned off. If you know that every pixel throughout your 
material must be guaranteed safe, turn 422 Safe on. Alternatively, you can leave 422 Safe turned off 
while you edit and adjust effects, then turn it on before you render or output your finished sequence 
to guarantee that every pixel in your output is color safe.

Source Monitor Analysis Menu

The Source Monitor Analysis menu determines whether the effect analysis display appears in the 
Source monitor. For more information, see “Using the Safe Color Limiter Analysis Display” on 
page 746.

Composite/Luma Levels Parameters

Composite/Luma Levels controls how limits for composite signal and luminance are measured and 
set. For more information, see “Understanding the Safe Color Limiter Effect” on page 745.

Control Description

Highlight Out of Range 
Colors

The effect analysis display appears in the Source monitor and highlights pixels with 
out of range color values.

Source Monitoring – Off The effect analysis display does not appear and the Source monitor reverts to the 
normal display of Source footage.

Control Description

Enable button When the Enable button is turned on, the effect limits the video so that it is within the limits 
for composite or luminance set with the Composite L, Composite H, Luma L, and Luma H 
sliders. When the Enable button is turned off, the effect does not take account of the 
composite or luminance limits.

Composite L Controls the lower limit for the composite signal. For example, if Composite L is set to -20 
IRE, any pixels with a lower composite value are modified so that their composite value is 
no lower than -20.

Composite H Controls the upper limit for the composite signal. For example, if Composite H is set to 110 
IRE, any pixels with a higher composite value are modified so that their composite value is 
no higher than 110.

Composite units Controls the unit of measurement used for composite limits. IRE measures in IRE units, and 
mVolts measures in millivolts.

Luma L Controls the lower limit for luminance. For example, if Luma L is set to 7.5 IRE, any pixels 
with a lower luminance value are modified so that their luminance value is no lower than 7.5.

Luma H Controls the upper limit for the luminance signal. For example, if Luma H is set to 100 IRE, 
any pixels with a higher luminance value are modified so that their luminance value is no 
higher than 100.

Luminance units Controls the unit of measurement used for luminance limits:

• 8 Bit — Measures on a scale from 0 to 255.

• % — Measures on a percentage scale. Percentage values can be lower than 0 or higher 
than 100.

• IRE — Measures in IRE units.

• mVolts — Measures in millivolts.
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RGB Levels Parameters

RGB Levels controls how limits for RGB color gamut are measured and set. For more information, 
see “Understanding the Safe Color Limiter Effect” on page 745.

Scratch Removal Effect Scratch Parameters

Scratch controls the position and appearance of replacement material that you use to cover scratches 
and other flaws.

Frame/Field slider (top) and Frame Processing button (bottom) in the Scratch parameter category

Control Description

Enable button When the Enable button is turned on, the effect limits the video so that it is within the 
limits for RGB color levels set with the RGB Gamut L and RGB Gamut H sliders. 
When the Enable button is turned off, the effect does not take account of the RGB 
color level limits.

RGB Gamut L Controls the lower limit for RGB color gamut. For example, if RGB Gamut L is set to 
16 using 8 Bit units, any pixels with a lower red, green, or blue level are modified so 
that their red, green, and blue levels are no lower than 16.

RGB Gamut H Controls the upper limit for RGB color gamut. For example, if RGB Gamut H is set to 
235 using 8 Bit units, any pixels with a higher red, green, or blue level are modified so 
that their red, green, and blue levels are no higher than 235.

RGB Gamut units Controls the unit of measurement used for RGB gamut limits:

• 8 Bit — Measures on a scale from 0 to 255.

• % — Measures on a percentage scale. Percentage values can be lower than 0 or 
higher than 100.

• IRE — Measures in IRE units.

• mVolts — Measures in millivolts.

Parameter Description

Opac. (opacity) Controls the opacity of the replacement material used in a Scratch Removal effect. Values 
range from 0 (transparent) to 100 (opaque).

Object Visible Lets you add a keyframe to a Scratch Removal effect and have replacement material 
suddenly “pop” onto the screen at the position marked by the keyframe. You must have at 
least three keyframes to create this effect. 

Hor (horizontal) Defines the position of the replacement material relative to the shape you have drawn on 
the horizontal axis of the frame. Negative values indicate the number of pixels the 
replacement material is to the left of the shape, positive values the number of pixels to the 
right. The default value is 0.
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Spot Color Correction Effect Color Match Parameters (Media 
Composer | Symphony Option Only)

Color Match lets you correct color in the area you have isolated using the drawing tools by replacing 
the Input color value with the Output color value and adjusting all the other color values in the area 
proportionally.

For example, if you want to match the skin tones in an area of the image isolated using the drawing 
tools with skin tones in another area of the image (or in another image), you can use the Color Match 
control to pick the two colors and automate the color adjustment.

You can also use the Color Match control within the Paint Effect by selecting Color Match mode in 
the Mode parameter category. For more information, see “Paint Effect Mode Parameters” on 
page 540.

Vert (vertical) Defines the position of the replacement material relative to the shape you have drawn on 
the vertical axis of the frame. Negative values indicate the number of pixels the 
replacement material is above the shape, positive values the number of pixels below. The 
default value is 0.

Frame/Field 
parameter slider

Defines which nearby frame or field is the source of the replacement material. To select 
frame or field processing, use the Frame Processing button.

If Frame Processing is selected, the slider is labeled Frame and is calibrated in one-frame 
increments from –5 to +5. If Frame Processing is deselected, the slider is labeled Field and 
is calibrated in one-field increments from –10 to +10.

For more information, see “Understanding Scratch Removal” on page 411.

Values represent an offset from the reference point defined in the Offset Fast menu.

A value of 0 indicates the frame or field that is the reference point. A positive value 
indicates a later frame or field than the reference point. A negative value indicates an 
earlier frame or field than the reference point. The default value of –1 provides an instant 
correction when you are working with the normal two-frame effect created by the Scratch 
Removal button.

Offset Fast Menu 
button

Defines the reference or zero point for the Frame or Field slider. The following three 
choices are available:

• Relative — The Frame or Field slider is set relative to the frame containing the shape 
that covers the flaw.

• From Start — The Frame or Field slider is set relative to the first frame of the segment. 
This is the default.

• From End — The Frame or Field slider is set relative to the last frame of the segment.

Frame Processing 
button

Lets you select frame or field processing when you are working with two-field media. The 
button does not appear when you are working with single-field material. For more 
information, see “Selecting Frame or Field Processing When Using Scratch Removal” on 
page 414.

Parameter Description
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Key Effect Parameters
This section contains reference summaries for the effect parameters that are unique to the Key effect 
category.

Key Effects Key Parameters

Key selects the primary key color to be replaced by video in the Chroma Key and Luma Key effects. 
This parameter is not keyframeable

AniMatte Effect Mode Parameters

Mode parameters and options affect the overall nature of the Intraframe editing you perform using 
the AniMatte effect. A Mode parameter is also available in FluidMotion Edit and is described in 
“FluidMotion Edit Parameters for Timewarp Effects” on page 570.

Parameter Description

Color Match Input and 
Output color swatches

Define the color values that control the Color Match correction. Use the Input (left) 
swatch to define the color that you want to replace, and the Output (right) swatch to 
define the good color that you want to use as a replacement.

(Symphony Option) For more information on using the Color Match control, see 
“Using the Color Match Control” on page 634.

Use NaturalMatch Enables the NaturalMatch feature, which intelligently replaces color hue in the area of 
the image you have isolated using the drawing tools while retaining the saturation and 
luminance characteristics of that area.

(Symphony Option) For more information, see “Understanding NaturalMatch” on 
page 639.

Parameter Description

Color controls Define the key color. For more information on the parameter controls, see “Color 
Parameter Controls” on page 491.

Gain Specifies how much of the foreground and the background video displays. Values range 
from 0 (shows only the foreground) to 63 (replaces all the foreground video with the 
background video).

Soft (softness) Determines how the bordering colors along the edge of the key appear. Colors that border 
the luminance or chroma specified for the key display as a blend of the foreground and 
the background video. The higher the Softness value, the more of the background video 
is blended in the border colors. Use the Soft slider to improve the appearance of the 
edges of the keyed areas.
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Chroma Key Profile, Secondary Key, and Spill Suppression Parameters

Profile Parameter

Profile provides a graphical representation of the foreground level and acceleration applied to effect 
keyframes:

• Foreground level affects the opacity of the effect. The greater the opacity, the closer to the top of 
the Profile graph the keyframe appears.

To adjust the foreground level, select the appropriate keyframe indicator, then click the round 
white keyframe indicator that appears on the Profile graph, and drag it up or down to increase or 
decrease the opacity of the foreground image.

• Acceleration affects the rate of movement into and out of keyframes. The greater the 
acceleration, the more rounded the lines appear in the Profile window. You can adjust 
Acceleration with the Acceleration slider only. For more information, see “Acceleration” on 
page 492.

Secondary Key Parameters

Secondary Key selects a second background color to key out. For example, the floor in a blue-screen 
shot or a green-screen shot might be a shade slightly different from the background. You can select 
the floor color as your secondary color and key it out. This parameter is not keyframeable.

Parameter Description

Fast menu Provides the following two modes for the AniMatte effect:

• Key In — For two-track video effects, displays the image on the higher track (foreground) 
within the matte selection while revealing the image on the lower track (background) 
outside the matte selection. For single-track matte wipes, displays the incoming segment 
within the matte selection.

• Key Out — For two-track video effects, displays the image on the lower track 
(background) within the matte selection while revealing the image on the higher track 
(foreground) outside the matte selection. For single-track matte wipes, displays the 
outgoing segment within the matte selection.

Opac. (opacity) Controls the transparency level of the image within the border of a matte or wipe created with 
the AniMatte effect. Values range from 0 (transparent) to 100 (opaque).

Object Visible Lets you add a keyframe to a segment or transition and have a painted object or matte suddenly 
“pop” onto the screen at the position marked by the keyframe. You must have at least three 
keyframes to create this effect. 
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For a description of each parameter, see “Key Effects Key Parameters” on page 550.

Spill Suppression Parameters

Spill Suppression neutralizes the selected color without affecting the luminance. The spill color 
changes to a grayscale, allowing it to blend more easily with the foreground image. This parameter 
is not keyframeable

Use the Spill Suppression key color to fix the following problems:

• Remove background color spill from the foreground image. Color spill occurs when the 
background color is present in the foreground image due to backdrop reflection.

• If the foreground object retains an outline of the chroma key color, you can use Spill Suppression 
to reduce the color effect in the outline.

For a description of each parameter, see “Key Effects Key Parameters” on page 550.

RGB Keyer Parameters

Key Color Parameters

Key Color selects a color for the chroma key. For more information on the parameter controls, see 
“Color Parameter Controls” on page 491. (The RGB Keyer uses the V (value) control for defining 
color rather than the Luminance control used in many other effects.) This parameter is not 
keyframeable

Chroma Key Parameters

Chroma Key lets you fine-tune the key effect. This parameter is not keyframeable.
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Matte Control Parameters

Matte Control lets you fine-tune the edges of the matte used in the chroma key. This parameter is 
not keyframeable.

Color Correction Parameters

Color Correction lets you perform post-key color correction of the foreground elements in the 
Chroma Key effect. Because the foreground and background elements are often shot at different 
times and locations, post-key color correction is especially useful for maintaining the key while 
matching the visual characteristics of the foreground to the background. This parameter is not 
keyframeable.

Parameter Description

Gain Adjusts the threshold of the key. Values range from 0 to 100.

Soft (softness) Softens the edge of the key. Values range from 0 to 100.

Show Alpha Displays the grayscale alpha channel used to apply the key effect to the foreground and 
background sources. Viewing the alpha channel directly lets you examine problem areas of the 
key while making adjustments.

Spill Suppresses the spill from the key color onto foreground objects that often occurs due to color 
reflection in the scene. Values range from 0 to 100.

Level Controls transparency of the foreground elements against the key background.

Reverse Inverts the key.

Parameter Description

Blur Uses a box filter to blur the matte for the key. Values range from (a blurring of 0 pixels) to 100 (a 
blurring of 10 pixels).

Erode Decreases or “erodes” the outer edges of the blurred matte key.

Parameter Description

Hue Specifies the hue or tint of the foreground elements. Hue is measured as values on a color wheel 
ranging from –180 to +180.

Sat 
(saturation)

Specifies the amount or intensity of the color. Values range from –100 to +100.
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SpectraMatte Parameters

Bypass Parameter

Bypass toggles the SpectraMatte effect on and off. When it is selected, you see the original 
foreground image in the Effect Preview monitor. When it is deselected, you see the composite of 
foreground and background created by the effect. Use Bypass, for example, when you want to use the 
eyedropper to select the key color from the blue or green screen part of the foreground image.

Bypass on (left) and off (right)

Key Color Parameters

Key Color defines the color from the foreground image that you want to replace with the background 
image. For more information on the parameter controls, see “Color Parameter Controls” on page 491.

The SpectraMatte effect uses the color you select as the basis for defining a range of color values to 
use in the key. In the SpectraGraph display, this range appears as a wedge keyed out of the CbCr 
swatch. For an explanation of how this wedge is calculated, see “How the SpectraMatte Effect 
Calculates Key Color Values” on page 199.

Matte Analysis Parameters

Matte Analysis lets you display and customize analytical views of the SpectraMatte effect. The 
controls do not have any impact on the finished look of the effect.

Bright 
(brightness)

Specifies the brightness level. Values range from –100 to +100.

Cont 
(contrast)

Controls the contrast of light and dark areas in the picture. Values range from –100 to +100, 
where a value of 0 indicates the image is unchanged. A negative value reduces contrast. A 
positive value increases contrast.

Parameter Description
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Parameter Description

Show Alpha Shows the alpha matte currently being generated by the effect in the Effect Preview monitor. 
This lets you check the effect of your parameter adjustments, such as the Matte Processing 
parameters that change the edges of the matte. For more information on the alpha matte 
display, see “Understanding SpectraMatte Analysis Displays” on page 197. This parameter 
is off by default.

Foreground image (left) and Show Alpha display (right)

SpectraGraph Shows the SpectraGraph display, which shows the color values in the foreground image 
superimposed on a CbCr color swatch, in the Effect Preview monitor. For more information 
on the alpha matte display, see “Understanding SpectraMatte Analysis Displays” on 
page 197. This parameter is off by default.

If Show Alpha is also selected, SpectraGraph displays an alpha matte for the CbCr color 
swatch, which can help you see the superimposed color data more clearly.

SpectraGraph display (left) and SpectraGraph with Show Alpha display (right)
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Chroma Control Parameters

Chroma Control changes how color values are calculated in the key by adjusting various aspects of 
the shape and edge of the key color wedge in the SpectraGraph display.

SpectraGraph 
Source Monitor 
menu

Controls how effect information displays in the Source monitor.

• Source Monitoring - Off — the Source monitor does not display an analysis view.

• SpectraGraph in Source Monitor — shows the SpectraGraph display in the Source 
monitor. This is the default menu selection.

• Alpha in Source Monitor — Shows the alpha matte display in the Source monitor.

SpectraGraph 
Brightness

Controls the brightness of the CbCr color swatch in the SpectraGraph display, which can 
help you see the superimposed color data more clearly. Values range from 0 to 100.

SpectraGraph Brightness = 0 (left) and 100 (right)

Parameter Description
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Parameter Description

Tolerance Controls the range of hues in the key color. In the SpectraGraph display, the Tolerance 
value is visible as the width or spread of the key color wedge. Values range from 0 to 180 
and represent the angle between the two sides of the wedge. The default value is 90.

 Tolerance = 45 (left) and 135 (right)

Key Sat (saturation) 
Line

Controls the saturation level at which keying begins. In the SpectraGraph display, the Key 
Sat Line value creates a line perpendicular to the center line of the key color wedge. This 
line modifies the shape of the wedge by blunting its point, which has the effect of retaining 
color values on the inside of the line in the foreground image — that is, low saturation 
color values across the full hue range defined by the key color wedge.

Values range from 0 to 100, where 0 places the line at the location of the Key Saturation 
value and 100 places the line at the location of the Key Color. The default value is 0.

Left: examples of Key Sat Line values — Key Sat Line = 50 (top) and Key Sat Line = 100 (bottom)
Right: diagram of the effect of the Key Saturation Line (highlighted) on a key wedge (gray area). 
The small squares indicate the Key Saturation value (near the center crosshair) and the Key Color 
value (inside the wedge)
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Key Saturation Controls the saturation level at which keying begins. In the SpectraGraph display, the Key 
Saturation value is the point of the key color wedge. Higher Key Saturation values move 
the wedge out from the center of the CbCr swatch. Unlike the Key Sat Line parameter, Key 
Saturation does not change the basic shape of the key wedge.

Values range from 0 to 100, where 0 is zero saturation (the center of the CbCr swatch) and 
100 is the same saturation value as the key color. The default value is 0.

Left: examples of Key Saturation values — Key Saturation = 50 (top) and Key Saturation = 99 
(bottom)
Right: diagram of the Key Saturation value (the small square at the point of the wedge)

Parameter Description
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Inner Softness Controls the extent of the blend gradient by adjusting where the gradient begins to increase 
from 0 (full transparency of foreground values). In the SpectraGraph display, this is visible 
because this changes where the solid black area of the key color wedge ends and the 
blended area begins.

Values range from 0 to 100. The higher the value, the narrower the softness gradient, and 
the more color values near the edges of the key color wedge are completely keyed out 
rather than blended between foreground and background. When Inner Softness is 0, the 
gradient extends inwards from the edges of the wedge all the way to the Key Color value. 
When Inner Softness is 100, the gradient extends only a small percentage of the way from 
the edges of the wedge towards the Key Color value. The default value is 10.

Left to right: Inner Softness = 0, 10 (the default), and 100

Outer Softness Controls the extent of the blend gradient by adjusting where the gradient begins to decrease 
from 1 (full opacity of foreground values). In the SpectraGraph display, this is visible as a 
change in where the solid color area outside the key color wedge ends and the blended area 
begins.

Values range from -100 to +100. Negative values increase the range of color values that are 
fully opaque in the foreground image and reduce the extent of the blend gradient. Positive 
values reduce the range of color values that are fully opaque in the foreground and increase 
the extent of the blend gradient.

Left to right: Outer Softness = -100, 0 (the default), and 100

Alpha Offset Controls the position of the blend gradient by adding an offset to the blend gradient values. 
Unlike Inner Softness and Outer Softness, which alter the extent of the blend gradient by 
moving either its inner or outer edge, Alpha Offset shifts the entire gradient. This 
effectively expands or contracts the whole key color wedge.

Values range from -100 to +100. Negative values expand the key color wedge. Positive 
values contract the key color wedge.

 Alpha Offset = -50 (left) and 50 (right)

Parameter Description
559



Key Effect Parameters
Luma Control Parameters

Luma Control adjusts the key based on the luminance characteristics of pixels in the foreground 
image.

Opacity Controls the overall opacity level of the foreground image. Values range from 0 
(transparent) to 100 (opaque).

 Opacity = 100 (left) and 65 (right)

Parameter Description

Parameter Description

Enable Luma Curve Turns the Luma Curve parameter on or off. When Enable Luma Curve is selected, the 
SpectraMatte effect uses the luminance graph in the Luma Curve advanced keyframe 
display to adjust the key.
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Luma Curve Modifies the alpha value of blended pixels by adding an offset based on their luminance. 
Media Composer uses a graph that you create in the advanced keyframe graph area for the 
Luma Curve parameter to calculate the offset.

For example, you can use this parameter to increase the transparency level of very bright 
pixels so that they are more completely keyed out while leaving darker pixels unaffected. 
The Luma Curve parameter only applies to pixels in the foreground image that are already 
blended (neither fully opaque nor fully transparent) as a result of the chroma parameter 
settings in the effect.

The parameter works by repurposing the advanced keyframe graph. The horizontal axis 
becomes a luminance scale, while the vertical axis represents the alpha offset. You add 
adjust points on the graph you create a curve that defines the alpha offset across the 
luminance range. For information on working with the advanced keyframe graphs, see 
“Understanding Keyframes” on page 80.

The following illustration shows three points on a Luma Curve advanced keyframe graph. 
The left and right points represent luminance values of zero luminance and full brightness 
respectively, while the center point represents a luminance value roughly half-way 
between. The first two points are set to a positive offset of 75, while the third is set to an 
offset of 0. The resulting curve interpolates offset values across the full luminance range. 
The offset remains at 75 for all pixels darker than the luminance midpoint, then gradually 
decreases to 0 across the range of pixels above the luminance midpoint. As a result, darker 
foreground pixels become much less transparent (if they were already partially 
transparent), while the brightest pixels are unchanged.

The Luma Curve graph can have as many points as necessary to define the curve you need, 
and does not need to be a specific width. The outside two points on the graph always 
represent the luminance limits, regardless of their exact horizontal location.

Values range from -100 to +100. Negative values increase the transparency of affected 
pixels, while positive values decrease the transparency. A value of -100 makes an almost 
fully opaque pixel fully transparent. A value of +100 makes an almost fully transparent 
pixel fully opaque.

Parameter Description
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Matte Processing Parameters

Matte Processing adjusts the alpha matte that the effect uses to generate the key by blurring or 
softening. This is primarily used as a way to improve the look of the edges of a key.

Suppress Shadow Lets you remove shadows cast by foreground subjects onto areas of key color such as blue 
or green screens by increasing the saturation value of pixels for the purposes of calculating 
the key. The darker the pixel, the more the saturation value is increased. The change in 
saturation value is used only while calculating the key and does not affect the appearance 
of the image.

Values range from 0 to 100. The higher the value, the more saturation is boosted for the 
purposes of calculating the key.

In the SpectraGraph display, the impact of the Suppress Shadow parameter is clearly seen 
in the superimposed color data. As the Suppress Shadow value increases, color values 
move outward into areas of higher saturation, with darker values moving further than 
brighter ones.

The following illustration shows the display for a Suppress Shadow setting of 80. Color 
values have moved out from the center to areas of higher saturation. Darker pixels have 
moved furthest and have “overtaken” lighter pixels.

Parameter Description

Parameter Description

Matte Blur Controls the amount of blurring that is applied to the matte.

Values range from 0 to 100, where higher values result in a greater degree of blurring. The 
default value is 0.

Use the menu to control how the blurring applies:

• Blur — Adds blurring to both the inside and the outside of the matte edge.

• Erode — Adds blurring to the inside of the matte edge only.

• Dilate — Adds blurring to the outside of the matte edge only.

Left to right: example of an Alpha Matter before blurring, and menu settings of Blur, Erode, and Dilate 
(the Blur value is set to 50 in all cases)
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Spill Parameter

Spill removes key color that has been reflected onto the foreground subject from the blue or green 
screen background.

Spill correction works by replacing color values that might be affected by spill with color values that 
are unaffected. For example, if green is the key color, some greenish-blue color values are replaced 
by blue color values.

You control the range of color values that are affected using the two Spill parameter controls. For 
details of the effect of each parameter, see the following table. In combination, the two parameters 
establish a zone around the key color wedge where spill correction takes place. Color values within 
the zone are replaced by color values on the “safe” side of the zone (away from the key color wedge), 
as shown by the red arrows in the following illustration.

In most cases, you should make relatively subtle corrections using the Spill parameters. If you correct 
too large a range of values, you correct color values that do not need adjustment and change the look 
of the entire foreground image in an undesirable way.

The following illustrations show examples of the effect of spill correction in the SpectraGraph 
display.

Soften Alpha 
Saturation

Softens alpha values where edges of the key color wedge meet. In the SpectraGraph display, this 
is visible as a slight rounding off of the point where two edges meet in the key color wedge. The 
default value is On. Turning Soften Alpha Saturation off changes the alpha value of a small range 
of color values and might improve the look of the edges of some keys.

Soften Alpha Saturation on (left) and off (right)

Parameter Description
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NoSpill correction (both Spill parameter values are 0). Greenish colors are visible near the edges of the key color wedge. 
(The wedge is adjusted so that it has no blend gradient to simplify the image andclarify these examples.)

Spill correction with Spill Saturation = 100 and Spill Angle Offset = 0. The correction is most evident in the blues, where 
greenish-blue values near the edges of the key color wedge have been replaced with bluer values.

Spill correction with Spill Saturation = 100 and Spill Angle Offset = 30. The correction is now much more obvious, with all 
greenish values completely eliminated. Although a correction like this certainly eliminates all spill, it is likely to be too 
extreme for many images, effectively performing a bad color correction. Here, for instance, pale blue and yellow color 
values have also been lost.
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Motion Effect Parameters
This topic contains reference summaries for effect parameters that are unique to traditional (source-
side) motion effects.

Freeze Frame Parameters

You access the Freeze Frame parameters from the Clip menu. For more information, see “Creating a 
Traditional Freeze Frame Effect” on page 155. These parameters are not keyframeable.

Parameter Description

Spill Saturation Controls the saturation level at which spill correction begins. In the SpectraGraph display, this 
parameter defines the point of the spill correction zone that surrounds the key color wedge, as 
shown in the following illustration.

Values range from 0 to 100, where 0 is the current Key Saturation parameter value and 100 is 0 
saturation (the center point of the CbCr swatch).

Diagram of the spill correction zone surrounding the key color wedge. The location of the Spill 
Saturation value is highlighted.

Spill Angle 
Offset

Controls the range of colors that undergo spill correction by changing the spread of the spill 
correction zone.

Values range from 0 to 100. The offset is added on either side of the zone. The default spread 
of the zone is the same as that of the key color wedge, that is, the value set by the Chroma 
Control Tolerance parameter. For example, if Tolerance is set to 90 and Spill Angle Offset is 
set to 20, 20 degrees are added on either side of the default angle, and the final angle between 
the two sides of the spill correction zone is 130 degrees.

Diagram of the additional angles set by the Spill Angle Offset parameter (highlighted), which extend 
the spread of the zone defined by the Chroma Control Tolerance parameter.

In most cases, you should limit Spill Angle Offset adjustments to the lower end of the value 
range. Larger adjustments usually result in unwanted color correction of the foreground image.
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Variable Speed and Strobe Motion Parameters

Variable Speed and Strobe Motion parameters appear in the Motion Effect dialog box. To open the 
Motion Effect dialog box, use the procedure in “Creating Traditional Motion Effects” on page 154. 
For more information, see “Creating a Traditional Variable Speed Effect” on page 156 and “Creating 
a Traditional Strobe Motion Effect” on page 159. These parameters are not keyframeable.

n If a Strobe Motion effect becomes unrendered because it has been trimmed to a longer duration, the 
effect does not play and you must render it again.

To indicate reverse motion at full play rate, slow or fast, enter a negative play rate or a percent.

Parameter Description

Duration Specifies the length of the Freeze Frame clip. 

To enter a custom duration:

1. Select Composer > Freeze Frame > Other.

2. In the dialog box, type a custom duration, and then click OK.

Two Field 
Freeze Frames

Determine how Media Composer creates the Freeze Frame media when you are working 
in two-field resolutions (for example, 20:1, 3:1, 2:1, or uncompressed).

• Using Duplicated Field — Uses a single field. This option reduces the vertical 
resolution of the image by one-half, resulting in a lower quality image.

• Using Both Fields — Uses both fields. This option is especially useful when there is 
motion in the footage.

• Using Interpolated Field — Creates a second field by combining scan line pairs from 
the first field in the original media. This might result in a slightly softer look to the 
freeze frame.
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Parameter Description

Variable Speed • Duration n Frames — The duration of the effect in frames. Doubling the number of 
frames causes the frame rate to be half the current rate.

• Rate n FPS — The rate of speed in frames per second (fps) at which the video is 
played. Normal speed is 30 fps for NTSC video, 25 fps for PAL video.

• % Speed — The percent of speed at which the video is played. Normal speed 
is 100%.

• Fit To Fill — Sets the Variable Speed parameters, so the duration of the motion 
effect matches the IN to OUT duration marked in the sequence.

Strobe Motion • Update every n frames — Specifies the update rate in frames for the Strobe Motion 
effect. For example, entering a rate of 5 causes every fifth frame to display in the 
Strobe Motion effect.
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Reformat Effect Parameters
This section contains reference summaries for effect parameters that are unique to the Reformat 
effect category.

Render 2-Field Motion 
Effect Using

These options are available for two-field media in interlaced projects only.

• Duplicated Field — Uses a single field. For two-field media, this reduces the 
information stored by half because it drops one field of the image, resulting in a 
lower quality image. For single-field media, this is usually the best choice because 
of its speed (the other options do not improve effect quality for single-field media).

Rendering is faster than for any other option.

• Both Fields — Uses both fields. For example, the first two frames of a half-speed 
(50%) slow motion effect repeat the original Frame 1 (both fields) twice. This option 
is good for shots without inter-field motion and still shots. With footage that 
includes inter-field motion, this method might result in minor shifting or bumping of 
the image because it disturbs the original order of fields: a Field 1 appears both 
before and after the corresponding Field 2.

Rendering is relatively fast. For best results, use evenly divisible frame rates with 
this option.

• Interpolated Field — Creates a second field by combining scan line pairs from the 
first field in the original media. This option calculates the motion effect at the field 
level rather than the frame level. Because Media Composer considers all fields and 
does not disturb the original order of fields, the smoothest effect results. This 
method is best for video-originated material or film-originated material transferred 
at 24 fps.

Rendering takes longer using this option than for effects created using either 
Duplicated Field or Both Fields. The rendering time is similar to that needed for 
VTR-Style.

• VTR-Style — Creates a second field by shifting selected video fields of the original 
media by a full scan line. This option also creates the motion effect at the field level 
rather than the frame level, but because pixels are not filtered, the final image is 
sharper than that created by the Interpolated Field option. The image might display 
some slight jitter at certain speeds. This technique is similar to that used by high-
quality professional video decks when playing footage at less than normal speed.

Rendering takes longer using this option than for effects created using either 
Duplicated Field or Both Fields. The rendering time is similar to that needed for 
Interpolated Field.

• Ignore Render Setting — If a specific motion effect type is set in the Motion Effects 
Render Using option of the active Render setting, Media Composer automatically 
selects that motion effect type, makes all other motion effect type options 
unavailable, and displays the Ignore Render Setting check box. Select the Ignore 
Render Setting check box to temporarily override the active Render setting and 
make all four motion effect types available.

Target Drive Click to select a drive on which to store the rendered effect.

Parameter Description
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14:9 Letterbox Position H Parameter

Shifts the image horizontally. Drag the slider to the left to shift the image to the left. Drag the slider 
to the right to shift the image to the right.

Pan and Scan Aspect Ratios and Actions Parameters

Aspect Ratios Parameters

The Aspect Ratios parameter sets the Source and Target aspect ratios. For more information, see 
“Selecting the Source and Target Aspect Ratios for the Pan and Scan Effect” on page 223. These 
parameters are not keyframeable.

Actions Parameters

The Actions parameter category lets you control certain aspects of the Pan and Scan effect. These 
parameters are not keyframeable.

Parameter Description

Source Fast menu Specifies the aspect ratio of the source media. Supported source aspect ratios are:

• 1.33 (4:3)

• 1.66

• 1.78 (16:9)

• 1.85

• 2.35

• 15:9 anamorphic

• 16:9 anamorphic

Target Fast menu Specifies the aspect ratio to which Pan and Scan conforms the media. Supported target 
aspect ratios are: 

• 1.33 (4:3)

• 16:9 anamorphic

Parameter Description

Establish Origin Saves the current Scaling and Position values as a customized default setting. For more 
information, see “Setting an Origin in the Pan and Scan Effect” on page 226.
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FluidMotion Edit Parameters for Timewarp Effects
FluidMotion Edit provides tools to correct artifacts (distorted areas) that might appear in a Timewarp 
effect when you select the FluidMotion rendering option. The following illustration shows the default 
FluidMotion Edit display in the Effect Editor.

n The Feathering and Brush parameters function similarly for FluidMotion Edit as they do for the 
AniMatte effect and Paint Effect. For more information, see “Feathering” on page 495 and “Brush” 
on page 494.

For information on adjusting a parameter with a thumbwheel, see “Changing a Parameter with a 
Slider in the Effect Editor” on page 73.

Display Parameters

Display gives you control over how Media Composer represents the motion information for 
manipulation. This parameter is not keyframeable.

Subdivide Effect Divides a Pan and Scan effect into a series of segments based on the segment boundaries on 
the video tracks below the Pan and Scan track. For more information, see “Subdividing the 
Pan and Scan Effect” on page 226.

Reset to Origin Resets the Scaling and Position values to the current customized Origin values. If you have 
not established an origin, Reset to Origin resets the values to the default values for the 
current Target aspect ratio. For more information, see “Setting an Origin in the Pan and 
Scan Effect” on page 226.

Parameter Description
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Mask Parameters

Mask defines the width of a border around an image. FluidMotion does not use masked-out border 
pixels when creating new images. Use Mask to eliminate artifacts on the edge of an image caused by 
the black borders that are often present around the edges of NTSC and PAL images. This parameter 
is not keyframeable.

Mode Parameters

Mode appears in FluidMotion Edit and in the Intraframe editing tools. For more information on the 
Mode parameter category for the Intraframe editing tools, see “Paint Effect Mode Parameters” on 
page 540. This parameter is not keyframeable.

Parameter Description

Fast menu Selects which image appears in the Effect Preview monitor and the way in which 
Media Composer displays motion vectors.

• Color Warp 50% — Displays the image (frame or field) that Media Composer 
creates halfway between outgoing Image A and incoming Image B as a grayscale 
image with a color overlay. Color in the overlay represents the speed (saturation) 
and direction (hue) of each pixel’s motion between Image A and Image B.

• Warp 50% — Displays the image (frame or field) that Media Composer creates 
halfway between outgoing Image A and incoming Image B.

• Image A — Displays outgoing frame or field A.

• Image B — Displays incoming frame or field B.

Show Vectors When Show Vectors is selected, Media Composer displays the motion vectors in an 
overlay. Deselect Show Vectors to see the underlying image.

Motion Color Threshold Sets the range of motion that appears in the Color Warp display.

• Min (minimum) — Sets the minimum relative speed to display.

• Max (maximum) — Sets the maximum relative speed to display.

Parameter Description

T (top), B (bottom)
L (left), R (right)

Set the top, bottom, left, and right edges of the Mask area. The limits of the Mask 
appear as a blue frame in the Effect Preview monitor.
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Rolling Title and Crawling Title Effect Parameters
Position Parameters

Crawling titles have a Y parameter in the Position parameter category. Use this parameter to move a 
crawling title up or down in the frame.

The number range refers to the position of the title relative to the middle of the screen:

• At 0, the middle of the title is aligned with the middle of the screen.

• At –999 (the slider at its leftmost position), the bottom of the title aligns with the top of the 
screen, so the title is completely off screen above the image.

• At 999 (the slider at its rightmost position), the top of the title aligns with the bottom of the 
screen, so the title is completely off screen below the image.

Rolling titles have an X parameter in the Position parameter category. Use this parameter to move a 
rolling title left or right in the frame.

Parameter Description

Fast menu Determines how FluidMotion applies Vector X and Vector Y values to motion vectors 
in the area you are editing.

• Set Vector — Replaces motion vectors in the area you are editing with Vector X 
and Vector Y.

• Add Vector — Uses Vector X and Vector Y as an offset to the values calculated by 
FluidMotion, and applies the result in the selected region.

• Erase — Sets the motion vectors in the selected region to 0,0 (no motion).

Opac. (opacity) Appears only in Erase mode. Sets the relative weight given by FluidMotion Edit to the 
adjustments you make to motion vectors in Erase mode.

At 0 opacity, FluidMotion Edit does not apply your adjustments. At 100 opacity, 
FluidMotion Edit completely replaces its motion vectors with your motion vectors. At 
levels between 0 and 100, FluidMotion Edit modifies the original motion vectors by 
an amount based on a percentage of the motion vectors you define.

Object Visible Deselect Object Visible to remove the display of the object you drew and reveal the 
effects of your adjustments to the region. Select Object Visible to see the object 
superimposed on the image.

Vector X

Vector Y

The Set Vector and Add Vector commands use the Vector X and Vector Y values to 
calculate motion vectors. You can:

• Use the eyedropper to sample vectors in an area of the image.

The Color Preview window and the values of Vector X and Vector Y change as 
you move the eyedropper over the image.

• Use the thumbwheels to set values for Vector X and Vector Y.
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The number range refers to the position of the title relative to the middle of the screen:

• At 0, the middle of the title is aligned with the middle of the screen.

• At –999 (the slider at its leftmost position), the right edge of the title aligns with the left of the 
screen, so the title is completely off screen to the left.

• At 999 (the slider at its rightmost position), the left edge of the title aligns with the right of the 
screen, so the title is completely off screen to the right.

Scroll Position Parameters

Crawling titles have an X parameter in the Scroll Position parameter category. Use this parameter to 
move the crawling title left or right in the frame.

The number range refers to the position of the crawling title relative to its overall length, where 0 
represents the point at which the left edge of the crawling title is aligned with the left edge of the 
screen. The highest negative number (the slider at its leftmost position) places the left edge of the 
crawling title off the right side of the screen. The highest positive number (the slider at its rightmost 
position) places the right edge of the crawling title off the left side of the screen.

Rolling titles have a Y parameter in the Scroll Position parameter category. Use this parameter to 
move the rolling title up or down in the frame. The number range refers to the position of the roll 
relative to its overall length, where 0 represents the point at which the top of the roll is aligned with 
the top of the screen. The highest negative number (the slider at its leftmost position) places the top 
of the roll off the bottom of the screen. The highest positive number (the slider at its rightmost 
position) places the bottom of the roll off the top of the screen. 

To reverse the direction of a roll or crawl, adjust the keyframes to reverse the slope of the keyframe 
graph (so that it slopes down rather than up).

c If you select all keyframes when changing the scroll position on a rolling or crawling title, all 
keyframes will be set to that position and the title will no longer move. Make sure you select the 
appropriate keyframes.

3D Effect Parameters
This section describes all 3D parameter categories, in alphabetical order.

Effect parameters are keyframeable unless otherwise noted. You can set keyframeable parameters to 
different values at different points in an effect’s duration to alter the effect over time. If a parameters 
is not keyframeable, you cannot change its value over the duration of an effect.

3D parameter categories support RGB processing of color space information unless otherwise noted. 

For information on the hierarchical order in which Media Composer applies 3D parameters, see 
“Understanding 3D Parameter Hierarchy” on page 574. For an explanation of how to change a 
parameter, see “Using the Effect Editor” on page 68. For information on which 3D parameter 
categories are available in each 3D effect, see “Effects Reference” on page 451.
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Understanding 3D Parameter Hierarchy

Media Composer processes 3D effects parameters in a specific order. Knowing the order can help 
you understand why something looks a particular way or why an object behaves the way it does on a 
motion path.

The hierarchy of 3D effects parameters (from higher to lower) is as follows:

• Lower parameters in the hierarchy, for example, Crop, do not affect higher parameters, for 
example, Rotation. In an effect that has both rotation and cropping, for example, the same four 
edges are always cropped the same way no matter what angle you select for the rotation.

• Higher parameters always take into account lower parameters in the hierarchy when processing. 
For example, before Media Composer rotates an object, it looks to see where the object is 
positioned in the frame to display the correct 3D point of view with the new angle.

• The final effect is always the same no matter the order in which you change parameters. 
However, effects are easier to control if you build them from the bottom of the hierarchy up. If 
you rotate an object, for example, and then move the axis (a lower parameter), your object might 
jump off the screen. It is better to move the axis first, and then rotate the object.

• Parameters operate as 2D, 3D, and post-transformation. All these choices affect the 3D path of 
the object differently. 2D parameters, such as Scaling, are lower in the hierarchy and do not 
affect the path through space. 3D parameters, such as Position, directly affect the shape of the 
motion path. Post-transformation parameters, such as Target, move the entire path.

Axis

Axis moves the center of rotation relative to the image. There is no fixed rotation axis with an image. 
The axis is independent of the image and is movable. For example, you can place the rotation axis in 
the center of the image, on the edge, or off the picture. To move the center of rotation off the image, 
you might find it useful to zoom out and activate the wire-frame handles. For more information, see 
“Effect Editor Controls” on page 69.

Axis parameter category (left) and Axis button (right)

Target Higher

Perspective

Position

Rotation

Axis

Scaling

Crop Lower
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Background Color (3D)

Use Background Color to replace the bottom video track with a background color. For more 
information on the parameter controls, see “Color Parameter Controls” on page 491.

You can achieve interesting effects on a two-track sequence by using a background color for the 
bottom track and a Luma Key effect on the top track.

Border (3D)

Border places a border around the image. The default border color is black for Plain borders and 
shades of gray for other border types. You can blend the foreground video with the background video 
if you turn on Border, use a zero width, and adjust the Soft parameter. You cannot change the border 
type and border color between keyframes.

Border supports RGB processing for the Plain border style only. If you select any other style from the 
Type menu, RGB processing is no longer available.

Parameter Description

X Moves the center of rotation along the X axis (right or left). Values range from –3000.0 to 
3000.0, where 0 is the center of the X axis.

Y Moves the center of rotation along the Y axis (up or down). Values range from –3000.0 to 
3000.0, where 0 is the center of the Y axis.

Z Moves the center of rotation along the Z axis (towards or away from the viewer). Values 
range from –3000.0 (farthest away) to 3000.0 (closest), where 0 is the center of the Z axis 
(the plane of the video screen).

Parameter Description

Other Options button Opens the Windows Color dialog box or the Macintosh Colors panel for precise color 
selection. For more information, see “Adjusting a Color Parameter for an Effect” on 
page 74.

Hue Identifies the border color. Hue is measured as values on a color wheel ranging from 0 
to 255. The start (0) and ending (255) values are both red.

Sat (saturation) Specifies the amount or intensity of the color. Values range from 0 to 255, where 0 is 
no chrominance and 255 is a fully saturated color.
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Corner Pin

Corner pinning is a way of positioning a 3D effect in a foreground video track over an object in a 
background video track. For example, you might want to have the foreground video appear to be 
playing on a TV screen in the background video.

Color controls Define the color. For more information on the parameter controls, see “Color 
Parameter Controls” on page 491.

Type menu Selects a border style.

• Plain

• Metal

• Bevel 1

• Bevel 2

• 3D Frame

• Round

• Video

Wid (width) Changes the width of the border. Values range from 0 (no border) to 100, where 50 is 
the default.

Sft (softness) Changes the softness of the border edge. Values range from 0 (hard edge) to 255 (a 
very soft edge), where 0 is the default. Border softness blends the border with the 
background image, giving the border a soft appearance.

Parameter Description

Parameter Description

Corner 
subcategories

Each subcategory pins one corner of the image, as follows:

• Corner 1 — top left corner of the untransformed image.

• Corner 2 — top right corner of the untransformed image.

• Corner 3 — bottom right corner of the untransformed image.

• Corner 4 — bottom left corner of the untransformed image.

If the image is cropped, Media Composer uses the corners of the cropped image.

X, Y Pins the corner along the horizontal (X) or vertical (Y) axis.
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Corner Tracking

Lets you use tracking data to control the effect. When you enable a selector, Media Composer maps a 
tracker to that selector. Trackers are named Point A, Point B, and so on. For more information, see 
“Motion Tracking and Stabilization” on page 240.

Corner Tracking appears in tracking-enabled 3D Warp effects and Intraframe effects only. For 
Intraframe effects, you can enable trackers only when an Intraframe object is selected. Tracking is 
also an option under the Position (3D), Rotation, and Scaling (3D) parameter categories.

Crop (3D)

Crop trims the edges of an image.

Crop is at the bottom of the 3D parameter hierarchy, so it always crops the same four edges of the 
object regardless of the object’s orientation. Cropping works only in 2D space so that 3D parameters 
such as Rotation and Position, which are higher in the hierarchy, take effect later in the processing. 
You do not need to adjust cropping before the other parameters, but it is often difficult to crop edges 
after other 3D transformations. For more information on the 3D parameter hierarchy, see 
“Understanding 3D Parameter Hierarchy” on page 574.

Crop parameter category (left) and Crop button (right)

Defocus

Defocus gives you the ability to blur the image or to blur individual layers of a matte effect. You can 
use Defocus to create an effect in which the incoming media “fades in” to focus.

When you enable Defocus, the default command is Internal and default values are 10 for Horz 
(horizontal) and Vert (vertical). This produces a slight softening effect.

Parameter Description

T (top) Crops the top edge of the image. Values range from –999 (bottom) to 999 (top).

L (left) Crops the left edge of the image. Values range from –999 (left) to 999 (right).

B (bottom) Crops the bottom edge of the image. Values range from –999 (bottom) to 999 (top).

R (right) Crops the right edge of the image. Values range from –999 (left) to 999 (right).
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Defocus supports RGB processing for all defocus types except Key Blur. If you select Key Blur from 
the Type menu, RGB processing is no longer available.

Erode/Expand

Erode/Expand controls the blending of the edges on 3D Warp effects. This parameter is not 
keyframeable.

RGB processing is not available for Erode/Expand.

Command Description

Type menu Click to select the type of defocus that Media Composer applies. Key Only, FG and 
Key, and KeyBlur are available only on three track effects such as Matte keys and 
Titles promoted to 3D.

The following options are available:

• Internal — blurs the entire image.

• FG (foreground) Only — blurs only the foreground of a two-track or three-track 
effect.

• Key Only — blurs only the key in a three-track effect.

• FG and Key — blurs both the foreground and the key in a three-track effect.

• Key Blur — uses alpha channel values as a template for blurring the foreground 
image.

When you select Key Blur, Media Composer blurs the foreground in proportion to 
the opacity of the matte. Black matte values cause no blurring, while white matte 
values cause maximum blurring.

You might use this effect to selectively blur part of a foreground image, such as a 
face, by creating a moving matte for the area of the image you want to appear 
blurred. Use the Offset parameter to control how much of a blur Defocus applies 
to the face. You could also use a KeyBlur matte to create a soft-focus area around 
a foreground subject.

Horz (horizontal), 
V (vertical)

Increases or decreases horizontal or vertical blur. Values range from 0 to 15, where 0 
represents no change.

When the Type menu is set to Internal, the default value is 10 for both parameters. 
When the Type menu is set of FG Only, Key Only, or FG and Key, the default value is 
0 for both parameters. When the Type menu is set to Key Blur, these parameters do 
not appear.

Offset Increases or decreases the relative amount of blurring that Defocus applies. Values 
range from –100 (minimum blur) to 100 (maximum blur). When the value is 0, Media 
Composer makes no further adjustment to the foreground after it applies the KeyBlur 
option. This parameter is only available when the Type menu is set to Key Blur.
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Foreground (3D)

The Foreground parameter category lets you choose a key type and then control how Media 
Composer handles the foreground of the key. The parameters that appear in the category vary 
depending on the key type you select.

Parameter Description

Filter Specifies how many pixels on each side of the edge are smoothed. Values range from 
1 to 7 (1 pixel on each side to 7 pixels on each side).

Center Controls the amount of erosion or expansion Media Composer applies to the edges. 
Erosion shrinks the edges, and expansion enlarges the edges. Values range from 0 
(maximum erosion) to 255 (maximum expansion). 

Soft (softness) Controls the slope of the edges. Values range from 0 (a vertical slope — no softness) 
to 255 (maximum softness).
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Parameters Common to All Key Types

Additional Parameters for Luma Key Key Type

Parameter Description

Type menu Lets you select one of the following key types:

• Full Key — Use to create dissolves (using the Opac parameter) or to switch an 
effect from one video track or segment to another (using the Swap Sources 
button).

This is the default option. You cannot rotate the key independently of the image.

• Luma Key — Use to replace portions of the foreground video with the 
background video based on brightness or luminance.

Media Composer replaces the corresponding portions of the foreground video 
with background video. For information about the 2D version of this effect, see 
“Key: Luma Key” on page 470.

• Chroma Key — Use to replace one part of the video image with another video 
image based on color.

Media Composer replaces the key color in the video on the higher track with the 
video from the lower track. You often use chroma keys with a foreground image 
shot in front of a highly saturated color screen.

For guidance on how to adjust a 3D Chroma Key, see “Suggested Workflow for 
Adjusting a Chroma Key” on page 581. For information about the 2D version of 
this effect, see “Key: Chroma Key” on page 470.

• SpectraMatte Key — Use this option to access all the parameters of the high-
quality SpectraMatte chroma key effect.

For information on the effect parameters available for the SpectraMatte key 
effect, see “Key: SpectraMatte Effect” on page 472.

This parameter is not keyframeable.

Opac. (opacity) Modifies the transparency of the foreground image. Values range from 0 
(transparent) to 100 (opaque).

Invert Inverts the key. Portions of the foreground that were visible are now invisible and 
vice versa.

Swap Sources Switches the foreground and background sources for the effect.

Reverse Animation Causes the entire effect to be reversed, including the direction of movement as well 
as the incoming and outgoing sources.

Show Alpha Displays the grayscale alpha channel Media Composer uses to apply the key effect to 
the foreground and the background source. This lets you examine problem areas of 
the key while making adjustments.

Parameter Description

Thresh (threshold) Identifies either the brightness threshold for the foreground image or the center of 
the luma range.

Soft (luma softness) Lets you soften the edge of the cutoff line. Pixel values slightly above or below the 
threshold are included, depending on the softness value.
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Additional Parameters for Chroma Key Key Type

Suggested Workflow for Adjusting a Chroma Key

1. Use the eyedropper to select a hue.

For best results, pick a color that is well within the field of color.

2. Adjust H Tol. (hue tolerance) to replace the hue with the background.

3. If low-saturation grays are keyed out (for example, portions of faces or clothing), try adjusting S 
Low (low saturation) to put them back into the foreground.

4. Use L Soft (luminance softness) to fine-tune the edges of the key.

Typically the L Tol. and L Soft settings do not need adjustment.

n You can use the Spill Suppression parameter to correct spill for a Chroma Key. See “Spill 
Suppression” on page 590.

Lum Range (luminance 
range)

Turns the Range slider on or off.

Range When Lum Range is not active, the Thresh value is a cutoff point. All brightness 
values above the Thresh value display (you see the foreground). Values below the 
Thresh value do not display (you see the background).

When Lum Range is active, Thresh becomes the median point of a range that you 
adjust using the Range parameter. This lets you leave in a specific range of 
brightness values.

Parameter Description

Parameter Description

Color subcategory Identifies the color that Media Composer replaces with video from the lower track. 
For more information on the parameter controls, see “Color Parameter Controls” on 
page 491.

H Tol. (hue tolerance) Controls how many similar shades of the hue Media Composer replaces with the 
background (the bottom video track). Use this option when the ranges of luminance 
and saturation of the chroma key color are too wide.

H Soft (hue softness) Lets you soften edges that are too aliased or sharp.

S Low (low saturation) Lets you remove low saturation colors by raising the lower limit. For example, 
sometimes portions of clothing or faces might contain subtle variations of a hue. To 
keep these portions of the image visible, you can try adjusting the S Low value.

L Tol. 
(luminance tolerance)

Specifies a tolerance level — Media Composer retains everything below the level.

L Soft 
(luminance softness)

Softens the key created by L Tol.

Lum Range (luminance 
range)

Turns the Range slider on or off.

Range Lets you set a luminance range within which values are retained.
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Highlight

Highlight lets you to enable automatic highlighting for shapes and adjust the intensity of automatic 
highlighting, or adjust the highlights for manual highlighting and Rev (reverse) manual highlighting. 
You can use manual highlights even when a shape is not active. The default manual highlight creates 
a blurred disk in the center of the image.

RGB processing is not available for Highlight.

Highlight Color

 Highlight Color adds color to the highlighted portion of a 3D effect. For more information on the 
parameter controls, see “Color Parameter Controls” on page 491.

RGB processing is not available for Highlight Color

Lowlight Color

Lowlight Color adds color to the shadowed portion of a 3D effect. For more information on the 
parameter controls, see “Color Parameter Controls” on page 491.

Parameter Description

Soft (softness) Controls the softness of the highlight’s edge. Values range from 0 (hard edge) to 100 
(a very soft edge), where 50 is the default softness.

Inty (intensity) Controls the brightness of the highlight. Values range from 0 to 100, where 50 is the 
default intensity.

Rad (radius) Controls the size of the highlight. Values range from 0 to 100, where 50 is the default 
radius.

Angle Rotates the highlight. Values range from –180 degrees to 180 degrees, where 0 is the 
default angle.

Aspct (aspect ratio) Changes the shape of the highlight from a perfect circle (0) to an oval or a band. 
Values range from –100 to 100, where 0 is the default. The –100 band is at right angles 
to the 100 band.

X Moves the center of the highlight from left to right. Values range from –999 to 999, 
where 0 is the default. Positive values move the highlight to the right.

Y Moves the center of the highlight from top to bottom. Values range from –999 to 999, 
where 0 is the default. Positive values move the highlight up.
582



3D Effect Parameters
RGB processing is not available for Lowlight Color.

Perspective

Perspective moves the perspective point (where parallel lines appear to converge) along the screen’s 
X, Y, and Z axes. This changes the way the image is visually projected onto the video screen.

Position (3D)

Position moves an image in 3D space. For information about the 2D version of this effect, see 
“Position” on page 499.

Parameter Description

X Moves the projected screen image farther to the left or right. Values range from –999 
to 999, where 0 is the default.

Y Lets you view the image from a higher or lower angle. Values range from –999 to 999, 
where 0 is the default.

Z Moves the perspective point closer to or farther from the observer. Perspective 
increases as the point moves inward and decreases as the point moves outward from 
the screen. Moving the perspective point in Z changes the amount of foreshortening 
on an image that is rotated around the X or Y axis.

Parameter Description

X Moves the image along the screen’s X axis (horizontally). Values range from –3000.0 to 
3000.0, where 0 is the zero-point of the X axis. Negative values move the image to the left 
and positive values move the image to the right.

Y Moves the image along the screen’s Y axis (vertically). Values range from –3000.0 to 
3000.0, where 0 is the zero-point of the Y axis. Negative values move the image down and 
positive values move the image up.
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Rotation

Rotation rotates the image around the X, Y, or Z axes.

Z Moves the image closer to or farther from the viewer along the Z axis. Values range from –
3000.0 to 3000.0, where zero is the zero-point of the Z axis. Negative values move the 
image away from the viewer and positive values move the image toward the viewer.

n For an illustration of the XYZ coordinate system, see “Understanding 3D Geometry and 
Degrees of Rotation” on page 285.

Position Tracking subcategory

Tracker Selector 
menu

Lets you select the tracker Media Composer uses to control the Position parameter. By 
default, when Position Tracking is enabled, Media Composer maps a tracker named Point A 
to the T1 tracker selector.

Axis menu Lets you use the data for both X and Y axes or for a single axis only. For more information, 
see “Limiting the Effect of Position Tracking Data to a Single Axis” on page 268.

Stabilize Tracking Enables tracking for stabilizing the image. For more information, see “Stabilizing an Image” 
on page 270

Parameter Description

Parameter Description

Z Rotates the image around the Z axis (clockwise or counterclockwise). Values range 
from –720 to 720, where 0 is the default.

X Rotates the image around the X axis. Values range from –720 to 720, where 0 is the 
default.

Y Rotates the image around the Y axis. Values range from –720 to 720, where 0 is the 
default.

n A value of 720 degrees lets you spin the image more than once between two keyframes. For more 
information, see “Understanding 3D Geometry and Degrees of Rotation” on page 285.

Rotation Tracking subcategory

Tracker Selector 
menus

Lets you select the tracker Media Composer uses to control the Rotation parameter. By 
default, when Rotation Tracking is enabled, Media Composer maps a tracker named Point A 
to the T1 tracker selector and a tracker named Point B to the T2 tracker selector.

Stabilize 
Tracking

Enables tracking for stabilizing the image. For more information, see “Stabilizing an Image” 
on page 270.
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Scaling (3D)

Scaling resizes the image or effect. For information about the 2D version of this effect, see “Scaling” 
on page 499.

Scaling parameter category (left) and Scale button (right)

Shadow

Shadow places a shadow beneath an image, and lets you adjust the shadow’s offset and transparency.

n Shadow, Trail, and Stamp are mutually exclusive, so you can have only one enabled at a time.

Parameter Description

X Controls the width of the image by stretching or compressing it along the X axis 
(horizontally). Values range from 0 to 400, where 100 indicates 100 percent scaling 
(normal size).

Y Controls the height of the image by stretching or compressing it along the Y axis 
(vertically). Values range from 0 to 400, where 100 indicates 100 percent scaling 
(normal size).

Fixed Aspect When Fixed Aspect is enabled, the aspect ratio of the image is locked so you cannot 
move the X and Y sliders independently. Media Composer gangs the X and Y sliders 
and they move together to maintain the selected aspect ratio.

Scale Tracking subcategory

Tracker Selector menus Lets you select the tracker Media Composer uses to control the Scaling parameter. By 
default, when Scale Tracking is enabled, Media Composer maps a tracker named 
Point A to the T1 tracker selector and a tracker named Point B to the T2 tracker 
selector.

Stabilize Tracking Enables tracking for stabilizing the image. For more information, see “Stabilizing an 
Image” on page 270

Parameter Description

Opac. (opacity) Changes the shadow’s opacity from 0 (transparent) to 100 (opaque), where 50 is the 
default.
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Shape

3D shape effects let you map the foreground video channel to various geometric shapes. You can 
create either a Page Fold, a Ball, or a Slats shape effect. Each shape effect displays a set of 
parameters specific to that shape in the Shape category. You can also adjust the effect with any of the 
other available 3D effects parameters.

Each shape effect contains a default template that makes use of the standard shape parameters. For 
example, when you first apply a Page Fold shape effect, Media Composer creates a simple page curl. 
You can adjust the parameters as needed.

RGB processing is not available for Shape.

For additional information about working with 3D Shape effects, see “Considerations for 3D Shape 
Effects” on page 589.

The following illustration shows the three available shapes and the parameters available in the Shape 
parameter category for that shape.

Top to bottom: Page Fold, Ball, and Slats Shape types

X Changes the shadow’s horizontal offset. Values range from –100 to 100, where 50 is 
the default.

Y Changes the shadow’s vertical offset. Values range from –100 to 0, where –50 is the 
default.

Parameter Description
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Common Parameters for Shapes

Additional Parameters for the Page Fold Shape

Parameter Description

Type menu Select one of the following shapes:

• Page Fold — Treats the foreground video channel like a page in a book being 
turned to reveal another page beneath. You can see the video on either side when 
you rotate the image or curl the edges. The portion of the image that folds over is 
referred to as the flap.

• Ball — Lets you treat the video as a rubbery, rectangular sheet stretched around a 
sphere. If the radius of the sphere is very large, the corners of the sheet curve along 
the surface like a rubber patch on a ball. If the radius is small, the corners 
disappear, wrapping completely around the sphere’s surface.

• Slats — Splits the image into alternating bands of video that enter the screen from 
opposite directions.

This parameter is not keyframeable.

Highlight menu Controls highlighting. Select one of the following:

• Auto Highlight — Lets Media Composer control the highlighting. You need to 
enable highlighting in the Highlight parameter category in order for highlights to 
appear. You can also vary the intensity of the highlight in the parameter category. 
Media Composer positions the shape automatically. This option does not apply to 
the Ball shape.

• Manual Highlight — Lets you use the Highlight parameter category to control the 
highlighting. In this case, you need to set parameters such as the angle, aspect 
ratio, and radius. For more information, see “Highlight” on page 582.

• Reverse Manual Highlight — Reverses the effect of manual highlighting you set 
up.

Parameter Description

Curl Controls the distance the page rolls up by specifying how far the rolling up has 
progressed. Values range from 0 to 100, where 0 represents no rollup.

To take the page from a flat, centered image to one that is completely off the screen, 
animate the Curl value from 0 to 100 and keep the Radius parameter at its default 
value.

Radius Controls the tightness of the curl or fold. Values range from 0 to 100, where 15 is the 
default.

Angle Controls the direction of the curl or fold. Values range from –180 degrees to 180 
degrees, where 45 degrees is the default. For illustrations of common angle values, see 
“Considerations for 3D Shape Effects” on page 589.
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Additional Parameters for the Ball Shape

Additional Parameters for the Slats Shape

Tuck and Flap menu Controls aspects of the appearance of the flap (the portion of the image that folds 
over). Select one of the following:

• Tuck Over — Folds the flap over the top. This is the default option.

• Tuck Under — Folds the flap under the top.

• Show Top Only — Shows the top without the flap.

• Show Bottom Only — Shows the flap (bottom) without the top.

n For additional tips on using this parameter, see “Considerations for 3D Shape 
Effects” on page 589.

Parameter Description

Parameter Description

Radius Changes the size of the ball. Values range from 0 to 100.

Curve Gives the ball a 3D effect. A value of 0 looks like a flat circle (you can use this as a 
Circle Wipe). Higher values give more depth to the ball’s shape. Values range from 0 
to 100.

X Pos (X position) Moves the shape to the right or left in relation to the image. The values range from –
999 to 999, where 0 is the center of the image. Values increase to the right and 
decrease to the left.

Y Pos (Y position) Moves the shape up or down in relation to the image. Values range from –999 to 999, 
where 0 is the center of the image. Values increase as you go down and decrease as 
you go up.

Aspct (aspect ratio) Changes the shape from perfectly round to a distorted shape. Values range from –100 
to 100, where 0 is a circle.

Angle Rotates the axis of the shape. This effect is visible only when the aspect ratio is not 
zero. Values range from –180 to 180.

Shape Tracking Lets you use a tracker to control changes to the Ball shape over time. Select a tracker 
from the Tracker Selector menu.

Parameter Description

Ampl (amplitude) Controls the distance the shape moves. Increase the amplitude to take the effect off the 
screen.

Angle Changes the line along which the video pieces move. Values can range from –180 to 
180. Use 0 for horizontal and 90 for vertical.

Freq (frequency) Controls how many copies of the shape appear on the screen.

n When you experiment with Slats, start with a Frequency value of 1 and an Amplitude of 0. This makes it 
easier to see how changes in these values affect the image. Change the Amplitude slider to make the slats 
move in opposite directions.

Offset Repositions the shape on the image.
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Considerations for 3D Shape Effects

Shape Effects and the Location of the Position Indicator

When you apply a shape effect, what you see in the Effect Preview monitor depends on the location 
of the position indicator in the clip. If the position indicator is at the start or end of the clip it might 
look as if the effect is missing.

Softening the Edges of a Page Fold

To soften the edges of a Page Fold effect, enable the Border parameter and adjust the Soft slider. You 
can soften a border of zero width. For more information, see “Border (3D)” on page 575.

Examples of Page Fold Angle Values

The following illustration shows how Media Composer interprets several angle values for the Page 
Fold. Experiment with incremental angle values and with changing angle values at different 
keyframes.

Examples of Page Fold angles. Top, left to right: -45 degrees, 45 degrees, 135 degrees, -135 degrees. Bottom, left to 
right: -90 degrees, 0 degrees, 180 or -180 degrees, 90 degrees.

While you are experimenting with angle and offset values, it is useful to scale down the top video 
layer. This lets you see the full effect as the video peels off the screen. For example, scaling 75 
percent in both X and Y axes displays the page fold as a Picture-in-Picture effect.

Controlling the Image on the Flap of a Page Fold

Use the Show Top Only and Show Bottom Only commands in the Tuck and Flap menu when you 
want to control the image in the flap or top. You commonly use these with two video channels. One 
channel shows the top and the other shows the bottom (the flap).

Sk Amp 
(skew amplitude)

Weaves the image through the slats. Think of this as weaving a “video cloth” through 
a loom.

Sk Angl (skew angle) Rotates the image through the slats.

Parameter Description
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For example, if you want an opaque top and a partially transparent flap, set a transparency value for 
the video channel containing Show Bottom Only. Use the Opac. slider in the Foreground parameter 
category to adjust transparency.

Show Top Only and Show Bottom Only are also useful when you want to apply an effect such as 
Defocus on just the flap or the top.

Limitations of Ball Shape Effects

The following limitations apply to Ball shapes:

• You cannot apply the Z perspective to a Ball.

• The X and Y direct manipulation handles do not work for a Ball. Use the parameters in the 
Rotation parameter category instead.

Once you use the sliders to rotate a Radial effect in X or Y, no direct manipulation other than XY 
position works. To regain access to the direct manipulation Z handle, reset the X and Y Rotation 
sliders to 0.

Skew

Skew moves or tilts an image in the X or the Y direction.

Spill Suppression

Spill Suppression replaces one color with another color. You can use Spill Suppression to correct 
spill in keys or, in Symphony Option, for spot color correction.

Parameter Description

X Skews the image along the X axis. The orientation of the top and bottom edges remains fixed, 
while the left and right edges are tilted along the X axis into a parallelogram. Values range from –
999 to 999, where 0 represents no change.

Y Skews the image along the Y axis. The orientation of the left and right edges remains fixed, while 
the top and bottom edges are tilted along the Y axis into a parallelogram. Values range from –999 
to 999, where 0 represents no change.
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Stamp

Stamp lets you put a video or graphic element into an independent Stamp buffer that allows the 
image to remain on screen after the effect’s segment has ended. You cannot render Stamp effects. For 
more information, see “Creating a Stamp” on page 294.

RGB processing is not available for Stamp.

Two of the most common uses for Stamp are:

• Real-time title builds.

Reveal multiple text, graphic, and video elements and stamp them over or under the foreground 
image when they come to rest. Once the image is stamped, you can add more layers.

• Video montage.

Bring in a variety of video images, where each one stays in place as you continue to add new 
ones.

n The Stamp, Shadow, and Trail parameters are mutually exclusive, so you can enable only one at a 
time.

Parameter Description

Target Color and 
Replace Color 
subcategories

Set the target and replacement colors. For more information on the parameter controls, see 
“Color Parameter Controls” on page 491.

Use Key Color Uses the chroma key color as the color to replace.

Gain Spill Suppression affects contiguous pixels that fall within the specified color range, or 
tolerance, of the color you select. You adjust the tolerance with the Gain slider. Values range 
from 0 to 63.

Decreasing the Gain decreases the color range and includes fewer pixels contiguous to the 
color selection. Increasing the Gain expands the range and includes more pixels surrounding 
the color selection.

Soft (softness) Determines how colors contiguous to the selected color are processed in the effect. Colors 
that border the selected color are displayed as a blend of the original color and the 
replacement color. The higher the softness value, the more of the replacement color is 
blended with the original color. Use the Soft slider to improve the appearance of the edges of 
the keyed areas. Values range from 0 to 63.

Parameter Description

Stamp Image Lets you add the stamp on one or more keyframes.

Clear Lets you clear the stamp buffer of everything in it.
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Target

Target changes the X,Y positioning and sizing and lets you maintain the current perspective.

Target is a post-transformation parameter. It is at the top of the hierarchy and affects objects after all 
the other parameters have affected it. If an object is rotated and has perspective added to it, Target 
moves the object without changing the relationship of the other parameters. Think of it as moving the 
entire 3D world where point of view does not change.

You can use Target in many cases as a global parameter. If you create an effect and want the whole 
effect to move higher across the frame or to appear inside another frame, such as a television on a set, 
use Target to move it. It is also good for offsetting another track slightly if you want to use a black 
graphics image as a drop shadow.

Trail

Use Trail to add a trail to an effect as it moves across the screen. You do not see the trail when you 
step through the effect because it is a cumulative effect. You cannot render a Trail effect.

RGB processing is not available for Trail.

Opac. (opacity) Changes the stamp’s opacity. Values range from 0 (transparent) to 100 (opaque), 
where 100 is the default.

Foregnd. On Top 
(foreground on top)

Switches the image in the Stamp buffer to the background. If Foregnd. On Top is not 
enabled, the Stamp buffer is always in the foreground.

Parameter Description

Parameter Description

X Moves the image along the screen’s X axis (horizontally). Values range 
from – 3000.0 to 3000.0, where 0 is the default.

Y Moves the image along the screen’s Y axis (vertically). Values range 
from – 3000.0 to 3000.0, where 0 is the default.

Size Scales the image and maintains the aspect ratio. Values range from 0 to 400, 
where 100 is the default scale of 100 percent.

Parameter Description

Decay Changes the rate of the trail’s decay, or dissipation, during the effect’s motion. Values 
range from 0 (a quick decay) to 100 (a slower decay), where 75 is the default.
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Use Sparkle Instructs Media Composer to paint a trail with sparkles. When Use Sparkle is 
deselected, Media Composer paints a trail by using the image itself.

Parameter Description
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19 Understanding Color Correction Mode

This chapter provides an overview of the color correction capabilities of Media Composer, and 
information on how to control and customize the Color Correction user interface.

• Overview of Color Correction

• Reasons for Making Color Corrections

• Entering and Exiting Color Correction Mode

• The Color Correction Monitors

• The Color Correction Tool

• Working with Color Correction Effect Templates

• (Media Composer | Symphony Option) Displaying Color Correction Information in the Timeline

• (Media Composer | Symphony Option) Understanding Color Correction Indicator Lines in the 
Timeline

Overview of Color Correction
Media Composer’s color correction features let you adjust the color characteristics of video material 
that you have edited into a sequence. Color corrections, like effects, do not change your original 
master clips or media files in any way. You can modify or remove color corrections at any time. If 
you correct a segment in one sequence, that correction does not affect the same video material in any 
other sequence.

Color Correction Mode

You make most color corrections by entering Color Correction mode and adjusting controls in the 
Color Correction tool. Each control affects a specific aspect of the color in an image (for example, 
saturation) so these controls are like parameter controls for effects in the Effect Editor. Some color 
correction controls look very similar to effect parameter controls, while others have a more 
specialized appearance suitable for precise color adjustment. For more information, see the 
remainder of this chapter.

Automatic and Manual Color Correction

You can make either automatic or manual corrections. Automatic corrections are simpler to use 
because Media Composer calculates and makes the adjustments needed to correct a problem in an 
image for you. Manual corrections require you to have a more detailed understanding of the color 
correction controls but allow for more precision and creativity. For more information, see 
“Performing Color Corrections” on page 626.



Overview of Color Correction
(Media Composer | Symphony Option) Color Correction Relationships

You can color correct a single segment in a sequence, and you can also color correct multiple 
segments in a sequence at once by choosing a relationship for the correction. For example, you might 
need to lighten all the material from one camera, so you would correct every segment in the sequence 
that came from the source tape for that camera. Other relationship options include correcting every 
segment from a particular master clip, or every segment on an entire video track in the sequence.

You can also manage color corrections that you have made using relationships in a variety of ways. 
You can update a sequence to apply existing color corrections to newly added segments, merge 
different versions of a color-corrected sequence, convert color corrections in a sequence to segment-
only relationships, and remove groups of corrections from a sequence. For more information, see 
“(Media Composer | Symphony Option) Understanding Relationship Color Corrections” on 
page 604 and “(Media Composer | Symphony Option) Managing Color-Corrected Sequences” on 
page 715.

(Media Composer | Symphony Option) Primary and Secondary Color Correction

You can make either primary or secondary color corrections. Primary color corrections change the 
color characteristics of every pixel in the image you are correcting (or in some cases every pixel 
within a specific luminance range that you can define). Secondary color corrections change the color 
characteristics of a specific color range within an image. For example, you can change the color of a 
single object from green to blue without altering any other part of the image. For more information, 
see “Performing Color Corrections” on page 626.

Keyframing Color Corrections

You can animate most color correction adjustments using advanced keyframes. For more 
information, see “Keyframing Color Corrections” on page 696.

The Color Correction Effect

You can perform some kinds of color corrections by applying the Color Correction effect from the 
Image category in the Effect Palette. For more information, see “Using the Color Correction Effect” 
on page 707.

(Media Composer | Symphony Option) Color Correction Effects

You can make some kinds of color corrections by applying one of the color correction effects, as 
follows:

• Apply the Color Correction effect from the Image category in the Effect Palette to quickly make 
automatic corrections to one or more segments without even entering Color Correction mode. 
For more information, see “Image: Color Correction” on page 466.

• Apply adjustments made with the Color Correction tool as Color Correction effects, which 
allows you flexibility to make some kinds of corrections that you cannot make using 
relationships. For more information, see “(Media Composer | Symphony Option) Applying a 
Color Correction Effect from the Color Correction Tool” on page 711.

• Apply the Color Effect from the Image category in the Effect Palette to use a subset of the color 
correction controls in an effect that is keyframeable and that you can promote to advanced 
keyframes. For more information, see “Image: Color Effect” on page 466.

• Apply the Spot Color Correction effect from the Image category in the Effect Palette to color 
correct a specific part of an image that you identify using Intraframe drawing tools. For more 
information, see “(Media Composer | Symphony Option) Spot Color Correction” on page 748.
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Playback and Rendering of Color Corrections

You can play color corrections in real time in the desktop monitors or on a Client monitor, subject to 
the same real-time playback constraints that affect the playback of other effects on your system. For 
more information, see “Real-Time Playback of Video Effects” on page 122.

Depending on the model of Media Composer, your hardware configuration, and the complexity of 
your sequence, you might need to render some or all of your color corrections before you can export 
your sequence or perform a digital cut. For more information, see “Basics of Effects Rendering” on 
page 41.

Safe Colors

You can set safe limits for color characteristics, for example, to ensure that the colors in your 
program meet a particular broadcaster’s standard for broadcast. Media Composer displays warnings 
when your images exceed these limits, and you can make corrections to solve the problem. For more 
information, see “Safe Colors” on page 737.

Reasons for Making Color Corrections
Before you can make good color corrections, you need to determine which color problems are 
present in your video material or decide why you might alter existing color values.

The two most common color problems are:

• Poor contrast (or a lack of a full range of tones).

For example, parts of an image that should be black are only dark gray. If an image does not have 
a good range of tones, details do not stand out sharply.

• Poor color balance (or a color cast).

For example, parts of an image that should be pure white are instead pinkish, or parts that should 
be pure blue are instead greenish-blue.

The automatic color correction controls are designed specifically to correct these two problems.

Apart from correcting for these two problems, the other main reasons to alter color values in your 
video material are:

• To make the color characteristics of adjacent segments in a sequence match.

For example, adjacent segments in a sequence might have been shot under slightly different 
lighting conditions, or using two cameras with different color balance settings.

• To achieve a particular artistic or editorial effect.

For example, you might want to slightly brighten or darken a whole sequence, or increase 
saturation to make a scene seem warmer, or alter color balance to make it seem as though a scene 
is lit by evening sunlight.

• (Symphony Option) To change the color characteristics of one area in an image without altering 
the rest of the image.

For example, you might need to change the color of a single object such as an article of clothing.

For a more complete introduction to the process of analyzing the color in your video and deciding 
how to adjust it, including illustrated examples of typical corrections, see “Color Correction 
Techniques” on page 723.
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Entering and Exiting Color Correction Mode
You need to enter Color Correction mode to access the color correction controls that you use for most 
color correction work.

To enter Color Correction mode, do the following:

t Click the Color Correction Mode button, for example, in the Timeline palette.

To exit Color Correction mode, do the following:

t Click a mode button other than Color Correction, for example, the Effect Mode button.

The Color Correction Monitors

The monitor window in Color Correction mode displays three monitors that let you compare several 
shots and analyze your images as you correct.

The Client monitor is also an important tool for color correction work.

Understanding Color Correction Monitors

In Color Correction mode, the monitor window contains three monitors. By default, the center 
monitor shows the frame at the current location of the position indicator, while the left and right 
monitors show the last frame of the segment preceding the current segment, and the first frame of the 
segment following the current segment. This arrangement lets you compare the color characteristics 
of adjacent shots in your sequence. The following illustration shows a typical default display.

When you move the position indicator to another segment in the Timeline, all three monitors update 
to show the new arrangement of previous, current, and next shots.
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Example of default update behavior in the monitor window. Left: the position indicator is on segment B in the Timeline, 
and the three monitors display segments A, B, and C. Right: the position indicator has moved to segment C, and the 
three monitors have updated so that they now display segments B, C, and D.

In most respects, the monitors in Color Correction mode work like other monitors in Media 
Composer. For example, operations such as activating monitors, showing and hiding the video, 
displaying timecode information, and using the position bar are the same. For more information, start 
with “Viewing and Marking Footage” in the Help.

The monitor window in Color Correction mode displays wide-screen 16:9 video as well as standard 
format 4:3 video in the monitors, depending on your project’s aspect ratio setting. For more 
information, see “Changing the Aspect Ratio for an SD Project” in the Help.

You can customize image display in each of the three monitors by selecting from the monitor’s 
Source menu. For more information, see “Customizing Image Display in Color Correction Monitors” 
on page 598.

Customizing Image Display in Color Correction Monitors

You can customize the type of image that displays in each monitor in Color Correction mode. For 
example, you can display segments other than the default previous, current, and next segments, or 
you can display the entire sequence in one monitor. You can also replace video image display with a 
waveform or vectorscope display to help you analyze images as you correct.

To configure the display in a monitor:

t Click the monitor’s Source menu, and select one of the commands described in “Source Menu 
Commands in Color Correction Monitors” on page 598.

Source Menu Commands in Color Correction Monitors

Command Description

Empty Displays no image (black).

Entire Sequence Makes the entire sequence available in the monitor. This is useful when you want to 
compare shots from many different places in a sequence. For example, you can 
display the current segment and the next segment in two monitors for immediate 
shot-to-shot comparison and display the entire sequence in the third monitor so that 
you can quickly navigate to any other part of the sequence you want to view. When 
you change the current segment, the entire sequence updates to that segment.

n You can use the Play Loop button in the Command palette to play the whole 
sequence in the active monitor even if the monitor is not set to Entire 
Sequence. For more information, see “Using the Play Loop Button in Color 
Correction Mode” on page 602.
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Adjusting the Dual Split Image Display in Color Correction Monitors

You can use the Dual Split button below a monitor to split the image display so that it shows the 
image before and after the current color correction adjustments are applied. For more information, 
see “Using Monitor Buttons in Color Correction Mode” on page 600.

Media Composer supports the display of this split-screen view in the Client monitor as well as in the 
monitor window.

When Dual Split is on, the uncorrected image appears on the left and the image with currently active 
corrections applied appears on the right.

Reference Locks the current frame (the frame the position indicator is on) in the monitor. When 
the other monitors update as you navigate in the Timeline, this frame continues to 
display as a reference. This is useful if you want to use a specific place in your 
sequence as a reference against which to compare all other shots, for example, a 
segment that contains optimal skin tones.

n If you use the right monitor to display a reference image and keep the current 
segment in the center monitor, you can use the Escape key to switch between 
these two monitors. For more information, see “(Media 
Composer | Symphony Option) Switching Between Current and Reference 
Monitors Using the Escape Key” on page 601.

To lock the current frame as a reference, right-click in the monitor window or the 
Color Correction tool, and select Reference Current.

Current Displays the current segment. This option is not available in the Source menu if 
another monitor is already set to Current.

Previous Displays the segment immediately before the current segment.

Next Displays the segment immediately after the current segment.

Second Previous Displays the segment two segments before the current segment.

Second Next Displays the segment two segments after the current segment.

Waveform and 
Vectorscope commands

These commands configure the monitor as a Waveform monitor or Vectorscope 
monitor. Media Composer displays the information for the currently active monitor. 
For more information, see “Working with the Waveform Monitors and Vectorscope 
Monitor” on page 700.

• Quad Display

• RGB Histogram

• RGB Parade

• Vectorscope

• Y Waveform

• YC Waveform

• YCbCr Histogram

• YCbCr Parade

Command Description
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Uncorrected image (left, with triangular adjustment handles) and corrected image in a monitor with Dual Split active in 
Color Correction mode

To resize the box that contains the split-screen image:

t Drag one of the box’s triangular handles in the monitor.

Using Monitor Buttons in Color Correction Mode

Some of the buttons beneath the monitors in Color Correction mode have the same functions as they 
do in other modes. Several other buttons perform functions specific to color correction.

Left to right: Dual Split button, Go to Previous Uncorrected Shot button, Go to Next Uncorrected Shot button, and 
Remove Effect button below a monitor in Color Correction mode

To move to the previous or next segment on the active track that does not already have a color 
correction applied:

t Click the Go to Previous Uncorrected Shot or Go to Next Uncorrected Shot button.

To remove the color correction on the current segment:

t Click the Remove Effect button.

To split the monitor display and show the image both with and without the correction applied:

t Click the Dual Split button.

To turn off Dual Split display:

t Click the Dual Split button.

(Media Composer | Symphony Option) Controlling Frame Display in the 
Monitor Window

You can control the behavior of the Go to buttons in the monitor window (Go to Previous Shot, Go to 
Next Shot, Go to Previous Uncorrected Shot, and Go to Next Uncorrected Shot) by selecting options 
in the Composer Settings dialog box.

You can instruct Media Composer to jump to the first frame of the relevant segment (the default 
setting), the last frame, or the frame that is marked with a marker. For more information, see 
“Composer Settings: FF/REW Tab” in the Help.
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Although the default first-frame behavior is acceptable in many circumstances, the availability of the 
Stop at Markers option makes it possible to mark a reference frame for each segment in your 
sequence before you begin color correction. As you move around in your sequence, you always see 
the reference frame in the monitors.

n You can add markers while in Color Correction mode if you map the Add Marker button to the 
keyboard or use the Command palette in Active mode. However, you cannot change Composer 
settings while in Color Correction mode.

To control frame display with markers:

1. In Source/Record mode, add a marker to your chosen reference frame for each segment of the 
sequence.

For more information, see “Using Markers” in the Help.

n To navigate successfully in the sequence while in Color Correction mode, you must place a marker in 
every segment. You should not have more than one marker in any segment.

2. Select File > Settings, click the User tab and double-click Composer.

The Composer Settings dialog box opens.

3. In the Move tab, select Stop at Markers, and then click OK.

4. Enter Color Correction mode, for example, by clicking the Color Correction Mode button in the 
Timeline palette.

As you use the Composer Window buttons to move around in your sequence, the Composer 
window changes to display the frame marked by the marker in each segment.

(Media Composer | Symphony Option) Switching Between Current and 
Reference Monitors Using the Escape Key

You can use the Escape key to switch quickly between the center and right monitors in the Composer 
window (and also to switch the display in a Client monitor).

This is particularly useful if you set up your monitors so that the current segment is in the center 
monitor and a reference frame is in the right monitor. You can easily check your current correction 
against your reference frame using a single keystroke.

For more information on the Client monitor and color correction, see “The Client Monitor in Color 
Correction Mode” on page 602. 

To switch between current and reference monitors by using the Escape key:

1. If your center monitor is not already set to display the current segment, click the monitor’s 
Source menu and select Current.

2. If your right monitor is not already set to display a reference frame, do the following:

a. If your left monitor is set to display a reference frame, click the monitor’s Source menu and 
select an option other than Reference, for example, Previous.

b. In the center monitor or the Timeline, navigate to the frame you want to use as a reference.

The frame displays in the center monitor.

c. Right-click in the center monitor and select Reference Current.
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The reference frame displays in the right monitor and the right monitor’s Source menu 
changes to Reference.

3. Press the Escape key.

The right monitor becomes active and the reference frame displays in the Client monitor.

4. Press the Escape key again.

The center monitor becomes active and the current frame displays in the Client monitor.

Using the Play Loop Button in Color Correction Mode

The Play Loop button has a specialized function in Color Correction mode. The Play Loop button 
does not appear in the monitor window but does control the playback of material in the monitors. You 
can access the Play Loop button from the Play tab of the Command palette or from the keyboard if 
you map it to a keyboard location.

When you click the Play Loop button, Media Composer plays the whole sequence in the active 
monitor, starting from the current position of the position indicator. Playback is not limited to the 
current segment alone, regardless of the Source menu command selected for the monitor. This is 
useful whenever you want to view the whole sequence quickly without switching monitors or making 
a new Source menu choice.

(Media Composer | Symphony Option) Reviewing Color-Corrected Clips 
with the Edit Review Button

The Edit Review button has a specialized function in Color Correction mode. Media Composer plays 
the current clip along with parts of the previous and next clips. This lets you quickly review the color 
correction on a clip in the context of the adjoining clips.

The Edit Review button does not appear in the monitor window, but you can access the Edit Review 
button from the Play tab of the Command palette or from the keyboard if you map it to a keyboard 
location.

When you click the Edit Review button, Media Composer plays part of the previous clip, all of the 
current clip, and part of the next clip. When playback is complete, the position indicator returns to its 
location in the current clip before you clicked the button.

The amount of material Media Composer plays from the previous and next clips is determined by the 
current Preroll and Postroll settings in the Play Loop tab of the Trim Settings dialog box. For more 
information on trim settings, see “Trim Settings” in the Help.

The Client Monitor in Color Correction Mode

If you have a Client monitor connected to Media Composer, you can see your corrections in the 
Client monitor. The dual split display also appears in the Client monitor when you have Dual Split 
selected for the current monitor. It is a good idea to use a Client monitor to view your color correction 
work because a Client monitor displays video colors more accurately than your computer screen.
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The Color Correction Tool
In Color Correction mode, you adjust color using the Color Correction tool. The Color Correction 
tool is also where you control how much and what kind of material you are correcting at any one 
time.

Controls in the Color Correction tool are organized in tabs. The default display shows the controls in 
the Hue Offsets tab within the HSL (Hue, Saturation, Luminance) tab. The controls in this tab 
provide one set of tools to correct contrast and color balance problems.

The other two available tabs (the Controls tab within the HSL tab, and the Curves tab) provide 
additional sets of controls. For complete information on all color correction controls and other 
features in the Color Correction tool, see “The HSL (Hue, Saturation, Luminance) Group” on 
page 641, and “The Curves Group” on page 670.

The following illustration shows the Color Correction tool in its default configuration.

Components of the Color Correction tool in its default configuration. Top left: group tabs. Top right: Color Correction Tool 
buttons. Bottom, left to right: subdividing tabs, slider controls and Enable buttons, Color Match control and Color 
Correction buckets.

(Symphony Option) The Color Correction tool contains controls for making different types of color 
correction. The main components of the Color Correction tool are:

• The Correction Type menu, which lets you choose a relationship to control which segments in 
your sequence are affected by a correction, or lets you choose to use a Color Correction effect. 
For more information on the Correction Type menu, see “(Symphony Option) Selecting 
Correction Types” on page 604.

• Tabs and subtabs that organize groups of controls that you use to make different types of 
corrections. Four of these groups of controls let you perform primary color corrections, while the 
fifth group lets you perform secondary color corrections. 

• Additional buttons that let you switch to Effect mode, access Color Correction settings, add 
comments to color corrections, set Safe Color warning values, and save color corrections as 
templates in the Effect Palette.

The following illustration shows the Color Correction tool in its default configuration.
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Components of the Color Correction tool in its default configuration. Top, left to right: Correction Type button, group tabs, 
and Color Correction Tool buttons. Bottom left: subdividing tabs. Bottom center: slider controls and Enable buttons. 
Bottom right: Color Match control, Color Correction buckets, and Automatic Color Correction buttons.

(Symphony Option) Selecting Correction Types

The Color Correction tool has a Correction Type button that lets you select the type of color 
correction you want to make. Selecting a correction type is one of the first and most important steps 
you take when making any color correction in the Color Correction tool.

When you move the position indicator to a segment that has color correction, the Correction Type 
button changes to indicate the type of correction that is applied to that segment. If you click the 
Correction Type button, the correction type for the segment is highlighted in the Correction Type 
menu.

To select a correction type:

t Click the Correction Type button, and select the type you want.

The options available in the Correction Type menu fall into two categories:

- Relationship color corrections: All but one of the options let you select a relationship so that 
you can apply a correction to a group of related clips in one operation. For more information, 
see “(Media Composer | Symphony Option) Understanding Relationship Color Corrections” 
on page 604 and “(Media Composer | Symphony Option) Options for Relationship Color 
Corrections” on page 605.

- Color Correction effect corrections: The last option lets you make a color correction using 
the Color Correction effect. Some situations require a Color Correction effect rather than a 
relationship color correction to make a correction. For more information, see “Using the 
Color Correction Effect” on page 707.

(Media Composer | Symphony Option) Understanding Relationship Color 
Corrections

Relationship color corrections define the scope of any correction you make. For example, if all the 
material from one source tape in your project needs the same color correction because the camera 
had poor white balance, you can make that correction to every segment in a sequence that you 
captured from that source tape in one operation.

Relationship color corrections also distinguish between Source corrections and Program corrections. 
You can make both a Source correction and a Program correction on a segment, which lets you make 
two different correction passes on the same material. A common use of this feature is to make color 
corrections for different purposes at different stages in your editing workflow. For example, you 
might make a set of corrections specifically to correct problems with the color in your source 
footage, and then later make a separate set of corrections to make final adjustments for artistic or 
editorial purposes. The terms “Source” and “Program” reflect this kind of workflow.
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The Color Correction tool uses color coding on both the Correction Type button and the active Color 
Correction tabs to indicate the type of correction you are applying or the type of correction that 
currently exists for a segment:

• Green indicates Source corrections.

• Blue indicates Program corrections.

• Gray indicates a Color Correction effect correction.

Relationship color corrections appear in the Timeline with green dots, indicating that they play in real 
time, subject to the playback capabilities and constraints of your system. Like any other effect, you 
might need to render a relationship color correction to ensure real-time, full-quality playback in some 
circumstances. For more information, see “Real-Time Playback of Video Effects” on page 122.

Media Composer processes relationship color corrections before all other effects, with the exception 
of Timewarp effects. (Media Composer processes Timewarp effects first to ensure that they do not 
become unrendered when you apply a color correction.) This processing order can determine how 
you choose to apply color corrections in combination with other effects, and is one of the factors that 
might require you to use a Color Correction effect rather than a relationship color correction. For 
more information, see “Using the Color Correction Effect” on page 707.

You can also apply a Source Segment or a Program Segment correction to the material between 
marked IN and OUT points. For more information, see “Customizing Color Correction Mode 
Settings” on page 614.

You can apply a relationship correcton and a color correction effect on the same segment. This results 
in two distinct corrections. Media Composer processes the relationship correction first, and its result 
is the input to the color correction effect. This approach differs from applying one correction on the 
Source side and another on the Program side, when Media Composer makes a single adjustment 
using the merged values from the Source and Program sides.

(Media Composer | Symphony Option) Options for Relationship Color 
Corrections

Relationship Description

Src (Source) Tape Corrects the current segment and all other segments in the sequence 
that use material from the same source tape.

Src (Source) Clip Name Corrects the current segment and all other segments in the sequence 
that have the same clip name. (This relationship ignores clip name 
extensions — .new and any subsequent characters — created during 
decomposing and batch capturing.) For more information on using this 
option, see “(Media Composer | Symphony Option) Using the Source 
Clip Name Relationship” on page 606.

Master Clip Corrects the current segment and all other segments in the sequence 
that use material from the same master clip.

Sub Clip Corrects the current segment and all other segments in the sequence 
that use material from the same subclip.

Src (Source) Segment Corrects only the current segment (the segment the position indicator is 
on in the Timeline).
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(Media Composer | Symphony Option) Using the Source Clip Name 
Relationship

The Source Tape, Master Clip, and Sub Clip relationships are usually sufficient to let you make any 
Source color corrections to groups of related clips.

When you move a sequence from another Avid editing application, however, a common workflow 
involves decomposing the sequence and recapturing. This destroys the original clip relationships by 
creating a new master clip (with a .new.xx extension) for every segment in the sequence. For more 
information, see “Recapturing and Decomposing” in the Help.

The Src (Source) Clip Name relationship is designed to let you make related corrections after 
decomposing and recapturing by referencing the clip name. It applies a correction to the current 
segment and to any other segment that has the same clip name. The Source Clip Name relationship 
ignores the clip name extensions that are created during the decomposing and recapturing cycle.

As long as the clip names are consistent, this relationship effectively lets you color correct by the 
original master clip relationship even though that relationship is not directly available to you. If you 
use the Source Clip Name relationship in this way, check the clip names before color correcting and 
ensure that they are consistent. If you find names that are in conflict, you can rename them so that the 
Source Clip Name relationship can reference them correctly.

(Media Composer | Symphony Option) Converting Relationship Color 
Corrections

You can convert one kind of Source relationship correction to another, or one kind of Program 
relationship correction to another.

You cannot directly convert a Source relationship correction to a Program relationship correction, or 
a Program relationship correction to a Source relationship correction. However, you can use Media 
Composer’s color correction effect template capabilities to make a conversion of this kind indirectly.

To convert a Source relationship correction to another Source relationship correction, or a 
Program relationship correction to another Program relationship correction:

1. Move the position indicator to the segment that carries the correction you want to convert.

2. Click the Correction Type button, and choose a new type from the menu.

To convert a Source relationship correction to a Program relationship correction, or a Program 
relationship correction to a Source relationship correction:

1. Move the position indicator to the segment that carries the correction you want to convert.

2. Save the adjustment values for the existing correction as a template, for example, by dragging 
from the Color Correction Effect Template button to a bin.

3. Click the Remove Effect button to remove the existing correction.

4. Click the Correction Type button and select the new correction type you want.

Prog (Program) Track Corrects the current segment and all other material on that segment’s 
track.

Prog (Program) Segment Corrects only the current segment.

Relationship Description
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5. Drag the color correction effect template that you saved in step 2 from the bin to the monitor 
displaying the current segment.

For more information on working with color correction effect templates, see “Working with 
Color Correction Effect Templates” on page 618.

Understanding the Group and Subdividing Tabs

Media Composer provides two groups of color correction controls, the HSL (Hue, Saturation, 
Luminance) group and the Curves group. The controls for each group are organized in a group tab. 
The HSL group tab has two further subdividing tabs on the left side of the tool that subdivide the 
controls for that group. The Curves group has no subdividing tabs. The following illustration shows 
the group and subdividing tabs.

Tabs in the Color Correction tool: HSL (left) with Controls and Hue Offsets subdividing tabs below, and Curves (right)

You can make both automatic and manual adjustments using one or both groups of controls. If you 
make adjustments in both groups, you can turn either group on or off independently to control which 
adjustments are active. When you view the sequence or render the Color Correction effect, Media 
Composer applies the adjustments from the active groups to create the final appearance. For more 
information on the interaction between the two groups, see “Understanding Interaction Between 
Color Correction Groups” on page 610.

Each group uses a different kind of control for making adjustments. The HSL group provides 
controls for adjusting attributes such as hue, saturation, gain, and gamma. The Curves group lets you 
manipulate points on a graph that control the relationship between input and output color.

For detailed information on adjusting color using the controls within the color correction groups, see 
“Performing Color Corrections” on page 626.

(Symphony Option) The Color Correction tool uses a tabbed design to arrange its controls and to 
indicate their relationship to one another. At the top level of the hierarchy are five tabs that contain 
the controls for each main color correction group. Within some of these group tabs are one or more 
additional sets of tabs, arranged vertically on the left side of the tool, that subdivide the controls for 
that group.

n You can hide any of the top-level tabs (along with their subdividing tabs) so that they do not appear 
in the Color Correction tool. This is useful if you normally use only a small number of the tabs. For 
more information, see “Customizing Color Correction Mode Settings” on page 614.

Group tabs in the Color Correction tool. Top: a Source correction type is selected, so the Correction Type button and the 
active tab are green. Bottom: a Program correction type is selected, so the Correction Type button and the active tab are 
blue.
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Subdividing tabs on the left side of the Color Correction tool, shown in relation to the higher level HSL group tab. The 
active tabs are green. Names on the inactive tabs appear dimmed.

For more information on the organization of each group and the controls within each tab, see 
“Performing Color Corrections” on page 626.

Displaying Group and Subdividing Tabs

To display a color correction group tab:

t Click the tab in the area containing the group name.

n Do not click the Enable button when you want to display a color correction group tab.

Click the named area of a tab to display it

The tab is highlighted, and the specific controls for that tab appear. For Symphony Option, the 
tab name is highlighted and colored based on the correction type, and the specific controls for 
that tab appear.

The following illustrations show how the display changes when the Curves tab is clicked.

Before clicking the Curves tab to display it. The Curves tab name appears dimmed, and the active HSL tab appears 
blue.
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After clicking the Curves tab to display it. The Curves tab appears blue, and the curves controls are now visible in 
the tab.

To switch between group tabs using the keyboard:

t Press the Page Up key or the Page Down key.

To display an HSL subdividing tab:

1. Click the HSL group tab in the area containing the group name.

2. Click the subdividing tab in the area that contains the subdivision name.

The subdividing tab is highlighted, and the specific controls for that tab appear.

(Symphony Option) To display a subdividing tab:

1. Click the group tab in the area containing the group name.

2. Click the subdividing tab in the area that contains the subdivision name.

The tab name is highlighted and colored based on the correction type, and the specific controls 
for that tab appear.

3. (Option) If necessary, click the second-level subdividing tab in the area that contains the second-
level subdivision name.

You need this step when you want to display the second-level subdividing tabs within the 
Controls and Luma Ranges subdivisions of the HSL group.

(Symphony Option) To display a group or subdividing tab using a Tab button:

1. Enter Color Correction mode, for example, by clicking the Color Correction Mode button in the 
Timeline palette.

2. Select Tools > Command Palette.

3. Click the CC tab.

4. Select Active Palette.

5. Click the Tab button with which the group or subdividing tab is associated.

For information on associating group and subdividing tabs with Tab buttons, see “(Media 
Composer | Symphony Option) Associating Group and Subdividing Tabs with Tab Buttons” on 
page 610.

In the Color Correction tool, the tab is highlighted, and the specific controls for the tab appear.

n You can also map the Tab buttons to any mappable key on your keyboard or to any mappable button 
location in the user interface. For more information, see “The Command Palette” in the Help.
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(Media Composer | Symphony Option) Associating Group and Subdividing 
Tabs with Tab Buttons

The Command palette contains twelve Tab buttons that you can use to provide one-click access to 
specific tab displays. For example, if you adjust the Luma Ranges graphs frequently as part of your 
color correction work, you can configure three Tab buttons to display the three Luma Ranges tabs 
(Highlights, Midtones, and Shadows).

To associate a Color Correction tab with a Tab button:

1. In the Color Correction tool, click the tab that you want to map to a Tab button.

For example, click the Highlights tab within the Luma Ranges tab within the HSL group to 
assign that specific subdividing tab.

2. Select Tools > Command Palette.

The Command palette opens.

3. Click the CC tab.

The Color Correction buttons appear, including the twelve Tab buttons.

Color Correction tab buttons in the CC tab of the Command Palette

4. At the bottom of the Command palette, select Active Palette.

5. Alt+click (Windows) or Option+click (Macintosh) the Tab button with which you want to 
associate the Color Correction tab.

Understanding Interaction Between Color Correction Groups

It is important to understand how the color correction groups work together. Media Composer applies 
adjustments that you make in each group cumulatively to the current segment and its related material. 
If you make an adjustment in one group and then make another in a different group, the image shows 
the cumulative effect of both adjustments.

This behavior provides you with a great deal of flexibility. For example, if you are unhappy with 
some of your adjustments, you can disable the group that contains those adjustments or reset its 
controls to default settings without disrupting other adjustments. For example, in Symphony Option, 
you can use one group of controls to make relatively broad initial adjustments and then switch to 
another group to fine-tune your correction. If you are unhappy with some of your finer adjustments, 
you can disable that group or reset its controls to default settings without disrupting the initial group.

The following illustration shows an example of this kind of control over color correction groups. 
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Example of control over Color Correction groups. The Green and Blue ChromaCurve graphs are adjusted, but the 
Curves tab is turned off (the Enable button is off in the tab at the top), so the graph adjustments do not currently apply to 
the segment. Because the HSL tab is turned on, any adjustments in the HSL tab do currently apply to the segment, even 
though the HSL controls are not currently visible.

(Symphony Option) You effectively have up to five layers of correction available for a Source 
correction, and potentially another five if you also apply a Program correction to the same segment. 
For more information on enabling, disabling, and resetting the groups, see “Working with the Enable 
Buttons” on page 611.

n If you make adjustments in both groups, keep in mind how the cumulative adjustments affect the final 
image. In Symphony Option, if you make adjustments in multiple groups, keep in mind how the 
cumulative adjustments affect the final image. Adjustments might accumulate, or cancel each other 
out, in ways that you do not want. Keep each stage of your correction distinct, and do not duplicate 
the same adjustment in both groups.

Working with the Enable Buttons

In the Color Correction tool, each group tab, subdividing tab, and individual control has an Enable 
button. In Symphony Option systems, in the Color Correction tool, each group tab, each subdividing 
tab and individual control within each group, and each color vector within the Secondary group has 
an Enable button. These buttons provide an immediate visual guide to the status of the controls while 
you are making corrections. They also let you turn controls on and off in various combinations and 
quickly reset controls to their default values.

You cannot reset controls that are not currently displayed. If you Alt+click (Windows) or 
Option+click (Macintosh) the Enable button for a tab whose controls are not currently displayed, you 
display the controls but do not reset them. Alt+click (Windows) or Option+click (Macintosh) the 
button again to reset the controls.
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n Adjustments to the Gain, Gamma, and Setup controls in the Hue Offsets subtab of the HSL tab enable 
both the Hue Offsets and the Controls subtabs. This behavior is not consistent with the normal 
interaction between Enable buttons but is necessary to ensure that color corrections conform 
correctly if you move your project to a Symphony Option system. To turn off adjustments to the Gain, 
Gamma, and Setup controls you must disable the controls individually by clicking one or more of 
their Enable buttons, or you must disable the entire HSL tab by clicking the HSL tab Enable button.

To turn a control or tabbed group of controls on, do one of the following:

t Click the Enable button for the control or tabbed group of controls.

t Adjust any individual control that is linked to the Enable button.

The Enable button highlights, and the control or tabbed group of controls becomes active. Media 
Composer includes the adjustments in that control or group of controls when calculating the 
corrected color.

To turn a control or tab off:

t Click the Enable button for the control or tab.

The Enable button is no longer highlighted.

To reset a control or a tabbed group of controls to its default values:

1. Display the control or group of controls you want to reset.

2. Alt+click (Windows) or Option+click (Macintosh) the Enable button for that control or group of 
controls.

All controls linked to that button return to their default values.

Understanding Interaction Between Enable Buttons

The Enable buttons in the Color Correction tool are linked in a hierarchical relationship that mirrors 
the relationship of the tabs themselves. When you change the status of an Enable button, the change 
can affect several levels of the hierarchy.

(Symphony Option) When you turn on an individual control, for example, you automatically turn on 
all related Enable buttons at higher levels in the hierarchy. By enabling an individual slider in the 
HSL group, you enable not only the button for that slider but also the buttons for all the associated 
tabs, up to and including the HSL group tab itself. The following illustration shows an example of 
this behavior.

Example of the Enable button hierarchy in the Color Correction tool. When the Enable button for the Hue slider is turned 
on, the Master tab, Controls tab, and HSL tab Enable buttons are also turned on.
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When you Alt+click (Windows) or Option+click (Macintosh) an Enable button to reset controls, you 
automatically reset all controls at a lower level in the hierarchy. For example, if you Alt+click 
(Windows) or Option+click (Macintosh) the Enable button for the Red ChromaCurve™ graph in the 
Curves tab, only that one control resets to its default value. However, if you Alt+click (Windows) or 
Option+click (Macintosh) the Enable button for the Curves tab, all the controls in the Curves tab 
reset to their default values.

When you turn an Enable button off, Media Composer stops including controls below that button in 
the hierarchy when it calculates the corrected color for the segment. Individual controls below that 
button retain their values and can be reactivated at any time. Their Enable buttons remain 
highlighted.

n (Symphony Option) A small number of controls in the Color Correction tool appear in more than one 
tab as a convenience for users who prefer to remain in a single tab whenever possible, but their 
enable behavior remains tied to the tab that is their primary home. For example, several HSL slider 
controls also appear in the Curves tab. If you adjust one of these sliders in the Curves tab, you turn 
on the Enable buttons for the HSL > Controls > Master tab hierarchy.

(Symphony Option) In the following illustration, the Curves tab Enable button is turned off, so none 
of the adjustments in the Curves tab apply to the correction. Individual controls inside the tab retain 
their values, so you can reactivate them by clicking the Curves tab Enable button again.

Using the Color Correction Tool Buttons

In addition to the Enable buttons, and specific control buttons within groups, the Color Correction 
tool has a group of buttons on the right side that control several important operations. 

Color Correction Tool buttons. Left to right: Effect Mode button, Color Correction Effect Template button, Correction Mode 
Settings button, Safe Color Settings button, Comments button.

Use these buttons to:

• Switch to Effect mode.

For more information, see “Displaying the Effect Editor with Color Correction Mode” on 
page 697.

• Create Color Correction effect templates.

For more information, see “Working with Color Correction Effect Templates” on page 618.
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• Customize the operation of color correction.

For more information, see “Customizing Color Correction Mode Settings” on page 614.

• Set Safe Color limit values.

For more information, see “Safe Colors” on page 737.

• Add comments to color-corrected segments.

For more information, see “Adding Comments to Color Correction Effects” on page 617.

Customizing Color Correction Mode Settings

You can customize the appearance and behavior of Color Correction mode by selecting options in the 
Correction Mode Settings dialog box. For example, you can control which group tabs display.

To customize Color Correction mode:

1. Do one of the following:

t In the Color Correction tool, click the Correction Mode Settings button.

t Select File > Settings, click the User tab and double-click Correction.

The Correction Mode Settings dialog box opens.

2. Select the options you want, as described in “Correction Mode Settings” on page 614.

3. Click OK.

Correction Mode Settings

Tab Option Description

Tabs HSL

Channels

Levels

Curves

Secondary

(Symphony Option) Define which group tabs appear in the Color 
Correction tool. Select the groups that you want to display in the Source 
tab.

Units RGB

Hue

Saturation/Gain

Luma

Composite

(Symphony Option) Define the unit of measurement used for each 
adjustment type in the Color Correction tool. The following units of 
measurement are available in one or more of the menus:

• 10 Bit: Measures the adjustment on a scale from 0 to 1024.

• 8 Bit: Measures the adjustment on a scale from 0 to 255.

• Percent: Measures the adjustment on a percentage scale from 0 to 100.

• IRE: Measures the adjustment in IRE units.

• mVolts: Measures the adjustment in millivolts.

• Degree: Measures the adjustment on a scale of degrees that represent a 
position on the color wheel. 0/360 represents the existing hue. 180 
represents the opposite hue on the wheel (inverts the hue).
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n (Symphony Option) The RGB value for a color in the Color Correction tool is not identical to the RGB 
value for the same color in a graphics application such as Adobe Photoshop®. For example, the 10-bit 
RGB values for reference black and reference white are 288 and 726 respectively. The 8-bit RGB values 
for reference black and reference white are 16 and 235 respectively.

n The 10-bit and 8-bit options for RGB units provide different measurement scales for the adjustment, but 
do not change the degree of precision for the correction. For more information, see “(Media 
Composer | Symphony Option) How Color Correction Handles Color Space and Bit Depth” on 
page 617.

Levels Solid Histograms (Symphony Option) When this option is selected, the histograms in the 
Levels tab of the Color Correction tool display as solid forms. When this 
option is deselected, the histograms display as a line graph.

Solid Histogram selected (left) and deselected (right)

Color Histograms When this option is selected, histograms that represent a single color 
channel display in the color of that channel. For example, histograms in 
the Red tab display in red.

Dynamic 
Histograms

(Symphony Option) When this option is selected, histograms update on-
the-fly as you move other color correction controls. This provides instant 
feedback on your adjustments, but the updating process might not always 
be smooth due to system processing limitations.

When this option is deselected, histograms do not update until you release 
the controls you are adjusting.

Use Full Ranges (Symphony Option) When this option is selected, some histograms redraw 
to display the full 10-bit range of level values on the horizontal axis. The 
option applies to the Red, Green, Blue, and Master histograms. You then 
have additional headroom and footroom available for making adjustments 
beyond the normal range of values. 

This is sometimes useful when dealing with extreme color deficiencies in 
analog video material, such as very low RGB levels. It is not usually 
necessary to use full ranges with digital material because digital video has 
built-in headroom and footroom limits.

Tab Option Description
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Features Secondary Vectors (Symphony Option) Controls which color vectors appear on the input 
vector color wheel in the Secondary group. Select one of the following 
values:

• Show All

• Show Standard

• Show Custom

• Show Enabled

For more information and illustrations of these options, see “Customizing 
the Display of Secondary Color Correction Vectors” on page 684.

Features Saved Color Labels (Symphony Option) Controls how custom colors are named in bins. For 
information on saving custom colors, see “Saving Custom Colors to a 
Bin” on page 640.

• None: Media Composer does not supply a name.

• RGB: Media Composer uses the 8-bit values for the red, green, and 
blue components as the name.

• Name: Media Composer uses the name from the standard HTML 
color scheme that most closely matches the color you are saving.

• Name and RGB: Media Composer uses both the Name and the RGB 
information. This is the default option.

Use Marks for 
Segment Correction

(Symphony Option) When this option is selected, Media Composer 
applies either Source Segment or Program Segment color correction to all 
segments between marked IN and OUT points. If the IN and OUT points 
are in the middle of segments, Media Composer includes the whole 
segments when it makes the correction.

This option is deselected by default.

Eyedropper 3 x 3 
Averaging

When this option is selected, Media Composer calculates the color value 
to pick by averaging the values of a 3 x 3 sample of pixels centered on the 
eyedropper’s position. This is often useful for picking up a color 
accurately by sight because it compensates for shifts in color value from 
one pixel to another. When this option is deselected, the system selects the 
color value of the exact pixel at the eyedropper’s position.

Show Eyedropper 
Info

When this option is selected, the numerical RGB values appear on the 
color swatches in the Color Match controls.

Eyedropper Picks 
from Anywhere in 
Application

When this option is selected, the eyedropper can pick a color from 
anywhere in Media Composer’s interface, for example the swatch for a 
custom color in a bin.

Show ChromaWheel 
and ChromaCurve 
Graphs

(Symphony Option) When this option is selected, Media Composer 
displays color backgrounds for the ChromaWheels in the Hue Offsets tab 
of the HSL group and for the ChromaCurve graphs in the Curves tab. 
These backgrounds can make it easier to understand the effect that an 
adjustment has on an image.

When this option is deselected (the default option), Media Composer does 
not display the color backgrounds. You might prefer to use this option 
when you are working since it lets you assess color in your video images 
without interference from other brightly colored on-screen elements.

Tab Option Description
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(Media Composer | Symphony Option) How Color Correction Handles Color 
Space and Bit Depth

When Media Composer makes some color correction adjustments, it converts the YCbCr color 
information in the media stored on disk into RGB color information (a better format for many color 
corrections) and then converts the information back to the original format for playback and storage. 
This round-trip conversion takes the color information from an 8-bit or 10-bit YCbCr color space 
into a 12-bit RGB color space and then back to 8-bit or 10-bit YCbCr. The 12-bit RGB color space 
that Media Composer uses is designed to preserve color information as fully as possible during this 
process. Clipping of the original color values is virtually eliminated, and round-off errors from the 
two conversions are minimized.

The options for measuring units available in the Correction Mode Settings dialog box are a 
convenience that lets you make adjustments using the units that are most useful or familiar to you. 
When Media Composer makes the color correction adjustments, it always uses the 12-bit RGB color 
space and always works with the same degree of accuracy.

Adding Comments to Color Correction Effects

You can add comments to color-corrected segments to assist you in your work. For example, you 
might want to briefly note the type of adjustment for a segment or to make notes during a preliminary 
correction pass of ideas for adjustments to perform later during a final pass.

The Comments button indicates whether a comment is present on a segment.

If the position indicator is on a segment that has a comment, the icon on the Comments button is 
yellow.

If the position indicator is on a segment that has no comment, the icon on the Comments button is not 
yellow.

To add a comment to a segment:

1. In Color Correction mode, move the position indicator to the segment to which you want to add 
a comment.

For information on entering Color Correction mode, see “Entering and Exiting Color Correction 
Mode” on page 597.

2. In the Color Correction tool, click the Comments button.

The Comments dialog box opens.

AutoCorrect Defines the automatic color corrections Media Composer makes when 
you apply the Color Correction effect from the Effect Palette. For more 
information, see “AutoCorrect Options” on page 710.

Tab Option Description
617



Working with Color Correction Effect Templates
3. Type your comment in the text window, and click OK.

To remove a comment:

1. In Color Correction mode, move the position indicator to the segment from which you want to 
remove the comment.

For information on entering Color Correction mode, see “Entering and Exiting Color Correction 
Mode” on page 597.

2. In the Color Correction tool, click the Comments button.

The Comments dialog box opens.

3. Click Remove.

To view or edit a comment in the Comments dialog box:

1. In Color Correction mode, move the position indicator to the segment for which you want to 
view the comment.

For information on entering Color Correction mode, see “Entering and Exiting Color Correction 
Mode” on page 597.

2. In the Color Correction tool, click the Comments button.

The Comments dialog box opens and displays the text of the comment.

3. (Option) To edit the comment, click in the text window and make your edits using standard word 
processing procedures.

To display comments in the Timeline:

t Click the Timeline Fast Menu button, and select Clip Text > Comments.

Your Color Correction comments appear in the Timeline.

Working with Color Correction Effect Templates
Media Composer offers the following versions of Color Correction effect templates:

• A number of Color Correction Presets

• (Symphony Option) The Automatic Effect Templates feature saves recent corrections 
automatically and lists them in the Effect Palette.

• The Color Correction buckets provide an easily accessible location within the Color Correction 
tool for the short-term storage of Color Correction effect templates.

• The Color Correction Effect Template button lets you create a template for any color correction 
and save it to a bin in the same way that you save other kinds of effect templates. The Save 
Correction button in the CC tab of the Command palette performs the same function.
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Like templates for other effects, Color Correction effect templates save all the adjustment values for 
a color correction so you can apply those values quickly to another segment. You can apply all the 
values at once by dragging the template into the monitor containing the current segment, or you can 
apply the values for the controls in a single tab in the Color Correction tool by dragging the template 
onto the tab that contains the group of controls you want to change.

You can also apply a Color Correction effect template to multiple segments at once by selecting the 
segments and then double-clicking the effect template icon in the bin or in the Effect Palette. To do 
this, you must be in editing or Effects mode.

You can also save custom colors to bins. For more information, see “Saving Custom Colors to a Bin” 
on page 640.

Color Correction Presets

A number of color correction presets are included in the effects library. The effects library contains 
several color correction preset effects that you can apply directly to clips in a sequence. Select 
Tools > Effect Palette and choose Color Correction Presets.

How Color Correction Effect Templates Save Settings

When you create a Color Correction effect template, Media Composer saves all the Color Correction 
settings for the segment. For Symphony Option, this is true whether Media Composer creates the 
template automatically or you save it manually to a bin or a bucket. Media Composer remembers 
both the values set for each control and the status of each Enable button.

Templates that you sve to a bin or a bucket do not update when you make new adjustments to the 
segment. To save new adjustments, you must save a new template to a bin or a bucket.

(Symphony Option) Automatic templates update when you make new adjustments on the same 
segment. For example, when you make only a single adjustment, the template contains the value of 
that adjustment. If you make another Source side adjustment to the same clip, the template updates to 
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include the value of the new adjustment. In contrast, templates that you save to a bin or a bucket do 
not update when you make new adjustments to the segment. To save the new adjustments you must 
save a new template to a bin or a bucket.

(Symphony Option) If you make multiple corrections on the same segment (for example, a Source 
correction and a Program correction), the template includes all those adjustments. When you apply 
the template globally by dragging it into the active monitor, you apply all corrections that the 
template includes.

(Symphony Option) Since this behavior might lead to confusing results, ensure taht you keep Source 
and Program color corrections completely separate. In general, use Program corrections only for final 
adjustments, which you often make across a whole track. For more information on keeping Source 
and Program corrections separate, see the note at the end of “General Workflow for Making Color 
Corrections” on page 626.

n You can specify which settings you apply in a template by dragging the template to the active tab in 
the Color Correction tool. This changes only those settings contained within that tab. Using this 
method, you can, for example, apply settings one tab at a time without applying any other settings 
that are also in the template.

n (Symphony Option) If you make a Source color correction on a clip and then make a Program 
correction, Media Composer saves a second template in the Effect Palette list. This second template 
is a duplicate. The two templates are identical in the information they contain — each contains both 
the Source and the Program information — and if you apply either to a new segment you apply all the 
saved information.

(Media Composer | Symphony Option) Using Automatic Effect Templates

Media Composer saves the most recent color corrections you have made in a sequence (up to a limit 
of 16 corrections) and makes them available in the Effect Palette. This provides you with 
automatically created templates for all your most recent corrections. You can quickly apply any one 
of these templates to another segment in the sequence by dragging it or simply by highlighting it in 
the Effect Palette and pressing Enter (Windows) or Return (Macintosh).

The Effect Palette lists all color-corrected sequences that are loaded in the Record monitor at the 
bottom of the scrollable list of effect categories. The effect categories list might therefore contain 
effect categories, bins that contain saved effects, and color-corrected sequences. 

The following illustration shows an effect categories list containing all three of these items.

Automatic color correction effect templates in the Effect Palette. The Effect Palette lists the templates in order of creation, 
with the newest at the top.
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When you select a color-corrected sequence in the effect categories list of the Effect Palette, a list of 
templates for the most recent corrections that you have made to that sequence appears in the right 
side of the Effect Palette.

Media Composer names each template using either the clip name of the segment on which it was 
originally made or, if a comment is associated with that segment, the text of the comment. For more 
information on comments, see “Adding Comments to Color Correction Effects” on page 617.

The templates are listed in the Effect Palette based on their creation time, with the most recently 
created template at the top of the list. The templates are also numbered to indicate the order of their 
creation, with the most recently created template always numbered “1.”

The list is limited to the 16 most recent corrections. If the list already contains 16 templates, Media 
Composer removes the oldest template from the list when you make a new correction.

Saving a Color Correction Effect Template to a Bin

You can save a Color Correction effect template to a bin using either the Color Correction Effect 
Template button in the Color Correction tool or the Save Correction button in the CC tab of the 
Command palette.

Color correction templates that you save to a bin are saved permanently, unlike templates you save to 
a bucket, which are not saved beyond the current working session. For Symphony Option, color 
correction templates that you save to a bin are saved permanently, unlike templates you save to a 
bucket, which are not saved beyond the current working session, or automatic templates, which are 
deleted when you have made 16 more recent corrections.

To save a Color Correction effect template to a bin:

1. In Color Correction mode, ensure that the position indicator is in the segment that contains the 
settings you want to save.

For information on entering Color Correction mode, see “Entering and Exiting Color Correction 
Mode” on page 597.

2. Do one of the following:

t Click the Color Correction Effect Template button, press and hold the mouse button, and 
then drag the effect icon to a bin.

t With Active Palette selected in the Command palette, click the Save Correction button in the 
CC tab.

t If the Save Correction button is mapped to a key, press that key.

A new effect template appears in the bin, containing all the color correction adjustment values 
for the segment. The new effect template is identified in the bin by its effect icon. By default, 
Media Composer names the template using the clip name of the segment. Effect icons for open 
bins also display in the Effect Palette.

3. (Option) To rename the template, click the template name and type a new name.

To permanently save a color correction effect template currently stored in a bucket:

t Click the color correction icon in the bucket and drag it to a bin.

For more information, see “Saving a Color Correction Effect Template to a Bucket” on page 622.
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Saving a Color Correction Effect Template to a Bucket

The Color Correction tool contains eight buckets, located below the Color Match control, that you 
can use to save Color Correction effect templates for the duration of a working session. You can then 
apply the template quickly to any segment.

The buckets are initially labeled C1 through C8. When you fill a bucket with a Color Correction 
effect template, a Color Correction icon appears on the bucket.

Color Correction effect templates that you save to buckets do not remain from one session to another. 
When you end your session, Media Composer deletes the templates. However, you can save an effect 
template from a bucket permanently by dragging it to a bin. For more information, see “Saving a 
Color Correction Effect Template to a Bin” on page 621.

n The Color Correction buckets are also available as buttons in the CC tab of the Command Palette. 
You can map these buttons to any mappable key on your keyboard or to any mappable button location 
in the user interface. For more information, see “The Command Palette” in the Help.

Examples of Color Correction buckets. Left: all buckets empty. Right: buckets C1 and C2 filled.

To save a Color Correction effect template in a bucket:

1. In Color Correction mode, ensure that the position indicator is in the segment that contains the 
settings you want to save.

For information on entering Color Correction mode, see “Entering and Exiting Color Correction 
Mode” on page 597.

2. Alt+click (Windows) or Option+click (Macintosh) the bucket in which you want to save the 
template.

You can click any one of the eight buckets to save to it. Empty buckets have a label that begins 
with the letter “C,” for example, C5. Buckets that already contain a template have a Color 
Correction icon. If you Alt+click (Windows) or Option+click (Macintosh) a bucket that already 
contains a template, you overwrite the previous template with the new adjustment values.

Media Composer saves the values as a template. If the bucket was previously empty, a Color 
Correction icon replaces the “C” label on the bucket.

Clearing Color Correction Effect Templates from Buckets

You can clear a Color Correction effect template from a bucket without having to overwrite the 
template with a new one.

To clear a Color Correction bucket of its saved correction during an editing session:

t Move the position indicator to any uncorrected segment in the Timeline and then Alt+click 
(Windows) or Option+click (Macintosh) the bucket.

Media Composer clears the template information from the bucket. A label beginning with the 
letter “C,” for example, C3, replaces the Color Correction icon on the bucket.
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Applying Color Correction Effect Templates

To apply all adjustment values in a Color Correction effect template to the current segment, do 
one of the following in Color Correction mode:

t Click the effect icon for the template in the bin, the Effect Palette, or the Color Correction 
bucket, and drag it to the monitor containing the current segment. For Symphony Option, click 
the effect icon for the template in the bin, the Effect Palette, or the Color Correction bucket, and 
drag it to the monitor containing the current segment or to the segment in the Timeline.

For information on entering Color Correction mode, see “Entering and Exiting Color Correction 
Mode” on page 597.

n For tips on working with templates in the Effect Palette, see “Saving a Color Correction Effect 
Template to a Bin” on page 621.

t Select the template in the bin or the Effect Palette, and then press Enter (Windows) or Return 
(Macintosh).

t Click the appropriate Color Correction bucket.

t If you have mapped the Color Correction bucket to the keyboard, press the appropriate key.

Media Composer applies all the Color Correction adjustments in the template to the segment that 
is the current location of the position indicator. 

To apply adjustment values from a Color Correction effect template selectively to a single tab 
of color correction controls:

1. In the Color Correction tool, click the tab to which you want to apply the template.

2. Click the effect icon for the template in the bin, the Effect Palette, or the Color Correction 
bucket, drag it to the tab, and drop it anywhere in the tab.

The controls in that tab update to reflect the values in the template. Other color correction 
controls are not affected.

If you apply template settings to a subdividing tab in the HSL group, the image in the monitor 
does not reflect those settings until you enable the HSL group tab. For Symphony Option, if you 
apply template settings to a subdividing tab (for example, the Controls tab in the HSL group), the 
image in the monitor does not reflect those settings until you enable the group tab (for example, 
the HSL tab).

If you apply a saved Color Correction effect template to a segment that already has a color 
correction, you overwrite the existing correction. The existing Color Correction settings are lost. 
In Symphony Option, if the existing correction is itself saved as a template, the template might 
also be lost (depending on the scope of the existing correction). Make sure you want to replace 
the existing correction before you apply a saved Color Correction effect template to a clip that 
already has a correction. You can use the Undo command to undo the effect of a Color 
Correction effect template. However, once the Undo command is no longer available, you cannot 
recover the original Color Correction settings.

To apply all adjustment values in a Color Correction effect template to multiple segments:

1. In editing or Effect mode, select the segment to which you want to apply the Color Correction 
effect template.

For more information, see “Applying Effects From the Effect Palette” on page 27.

2. Open the bin that contains the Color Correction effect template.

3. Double-click the Color Correction effect template icon in the bin or in the Effect Palette.
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Media Composer applies the Color Correction effect template to each of the selected segments.

(Media Composer | Symphony Option) Color Correction Effect Templates 
and Relationship Type Selections

If you save a relationship color correction effect to a bin as an effect template, Media Composer saves 
the relationship type of the original effect as part of the template. However, depending on how you 
apply the effect template to another segment, the new color correction might use the relationship type 
of the template, or it might use the currently selected relationship in the Correction Type menu. You 
should choose one of the following methods for applying a color correction effect template based on 
whether you need the relationship type of the template or the relationship type currently selected in 
the Correction Type menu.

• When you apply the effect template by dragging it to a segment in the Timeline, the new color 
correction uses the relationship type of the template.

• When you apply the effect template by dragging it to the Current monitor in the Composer 
window, the new color correction uses the relationship type of the template. However, Media 
Composer also adds a Color Correction Effect icon to the clip. This is a duplicate of the color 
correction that you can remove.

• When you apply the effect template by double-clicking it in the bin or by dragging it to an 
individual tab in the Color Correction tool, the new color correction uses the relationship type 
currently selected in the Correction Type menu.

• When you apply a color correction saved in a bucket by clicking the bucket, the new color 
correction uses the relationship type currently selected in the Correction Type menu.

(Media Composer | Symphony Option) Displaying 
Color Correction Information in the Timeline

The Timeline works the same way in Color Correction mode as it does in other modes. You can move 
the position indicator from one place to another in your sequence, select and deselect tracks, and 
perform other normal Timeline operations.

The Timeline has one control that is specific to color correction — the Color Correction command in 
the Timeline Fast menu. When you select Color Correction, the Timeline displays indicator lines to 
show which segments have relationship color corrections. For more information on color correction 
indicator lines in the Timeline, see “(Media Composer | Symphony Option) Understanding Color 
Correction Indicator Lines in the Timeline” on page 625.

To display color correction information in the Timeline:

t Click the Timeline Fast Menu button, and select Color Correction.

The Timeline display updates to show the color correction indicator lines.
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(Media Composer | Symphony Option) Understanding 
Color Correction Indicator Lines in the Timeline

A segment in the Timeline that has Source color correction is marked with a green line at the bottom 
of the segment. A segment that has Program color correction is marked with a blue line at the top of 
the segment. For information on displaying or hiding color correction indicator lines in the Timeline, 
see “(Media Composer | Symphony Option) Displaying Color Correction Information in the 
Timeline” on page 624.

The appearance of the indicator line indicates the relationship that applies to the correction on that 
segment. A dotted line indicates a correction that applies only to that segment (Source Segment or 
Program Segment relationship). A solid line indicates a correction that applies beyond the individual 
segment (Source Tape, Source Clip Name, Master Clip, Sub Clip, or Program Track).

Color Correction indicator lines are available in the Timeline in all modes, but they might be most 
useful while you are working in Color Correction mode as a guide to which segments have already 
received either Source or Program adjustment.

As effects that normally play in real time, all relationship color corrections appear with green dots in 
the Timeline unless they are rendered. These dots continue to display in the Timeline even if the 
Color Correction option is dselected in the Timeline Fast menu.

Examples of color correction indicator lines in the Timeline. Top: blue lines indicate Program color corrections and green 
lines indicate Source color corrections. Bottom: the dotted green line on the right indicates that the correction applies to 
this segment only, and the solid green line on the left indicates that the correction applies beyond this individual segment.
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20 Performing Color Corrections

This chapter describes procedures for making color corrections, and includes complete descriptions 
of all controls in the Color Correction tool.

• General Workflow for Making Color Corrections

• Using Automatic Color Corrections

• Using the Color Match Control

• The HSL (Hue, Saturation, Luminance) Group

• The Channels Group

• (Media Composer | Symphony Option) The Levels Group

• The Curves Group 

• (Media Composer | SymphonyOption) The Secondary Group

• Keyframing Color Corrections

• Working with the Waveform Monitors and Vectorscope Monitor

• Applying Color Corrections to an Entire Sequence

• Using the Color Correction Effect

• Shape-Based Color Correction (Symphony Option)

General Workflow for Making Color Corrections
The color correction tools in Media Composer give you a great deal of flexibility when you make 
color corrections. Your exact workflow depends on your individual methods, your degree of 
familiarity with the color correction controls, and the requirements of your project. However, the 
basic steps to take when making a correction are similar for all users.

The following steps outline a typical color correction operation. You can change the order in which 
you perform or repeat steps to meet your particular needs.

n In general, do not make Source relationship corrections and Program relationship corrections as 
part of the same corrective operation, or use Program corrections for your first color correcting 
pass. If you do, you lose flexibility and control for later stages of your project and you reduce the 
power of the color correction tools. Even if you expect to need only one color correction pass, you 
should make that pass using Source relationships. If your needs for the project change, you can still 
make a second set of corrections using Program relationships.

1. In Source/Record mode, load the sequence.

2. Enter Color Correction mode.

3. (Option) If necessary, adjust Correction Mode Settings to suit the requirements of your project 
and editing style.



Using Automatic Color Corrections
For more information, see “Understanding Color Correction Mode” on page 594 and 
“Customizing Color Correction Mode Settings” on page 614.

4. Preview the material in the sequence to develop a sense of the kinds of corrections that you need 
and your approach to making them.

For example, you might look for a shot to use as a reference for your adjustments and lock that 
shot in one of the monitors. In Symphony Option, you might also make decisions about the 
Source or Program relationships that you want to use as you work. 

n You might prefer to preview extensively and plan your corrections in advance. If you have more color 
correcting experience, you might prefer to work by moving back and forth frequently between making 
corrections and assessing the material on which they are working.

5. Make sure that the Record Track button for the track on which you want to make corrections is 
the topmost selected button in the Track Selector panel in the Timeline.

You can color correct any number of tracks, including nested tracks by stepping into the nest. 
However, you can correct only one track at a time. Color correction is applied to the topmost 
selected track in a sequence.

6. Use the monitor window buttons or the position indicator in the Timeline to move to a segment 
you want to correct.

7. (Symphony Option) Select a relationship to control the scope of the corrections, or choose to 
apply a Color Correction effect correction.

Depending on your circumstances, you might use the same relationship throughout the sequence, 
or you might select different relationships for different segments. For more information, see 
“(Symphony Option) Selecting Correction Types” on page 604.

8. Click the appropriate tabs in the Color Correction tool to display the controls you want to use to 
make the correction.

For more information, see “Understanding the Group and Subdividing Tabs” on page 607.

9. Use the automatic color correction features or adjust the color correction controls manually until 
you are satisfied with the correction.

Remember that you can make successive adjustments using several different groups of controls 
and selectively turn them on and off while you assess their effect on the segment. You can use the 
Dual Split button in the monitors to view corrected and uncorrected images side by side.

10. (Option) Use the advanced keyframe interface in the Effect Editor to animate the correction.

For more information, see “Keyframing Color Corrections” on page 696.

11. (Option) Add a comment for the correction.

12. Repeat steps 5 through 11 for each segment you want to correct.

13. When you are satisfied with the corrections throughout the sequence, exit Color Correction mode 
and return to other editing operations.

Using Automatic Color Corrections
The Color Correction tool lets you make automatic color corrections to correct contrast problems, 
balance color, or remove color casts by identifying areas of an image that should be color neutral.
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Using Automatic Color Corrections
You can also apply up to three automatic color corrections in a single operation by selecting options 
in the AutoCorrect tab of the Correction Mode Settings dialog box and applying the Color Correction 
effect from the Effect Palette to one or more segments in a sequence. 

The Color Match control also corrects automatically by adjusting an image so that a poor color value 
matches a better one. You select the colors on which you want Color Match to operate using an 
eyedropper. For more information, see “Using the Color Match Control” on page 634.

Understanding Automatic Color Correction

Automatic color correction simplifies the work of correcting common color problems in video 
images. When you use an automatic color correction, Media Composer analyzes the existing color 
characteristics of an image and adjusts color correction controls to either eliminate or significantly 
reduce a specific color problem.

You often want to begin your color correction work by using automatic color corrections. Automatic 
corrections are especially useful when you do not have time for detailed manual adjustments, if you 
only need to correct basic color problems such as color casts, or if you lack experience with the 
manual controls in the Color Correction tool.

Automatic color correction adjusts controls in the Color Correction tool just as you would when 
making manual corrections, so you can make additional adjustments manually if you need to fine-
tune a correction. Also, automatic color corrections can help you learn how to recognize color 
problems in images and what kinds of adjustments you might make to correct images manually. For 
example, if the Auto Balance automatic correction in the Hue Offsets subdividing tab adjusts an 
image by adding yellow in the ChromaWheels, then Media Composer determined that the image has 
a blue color cast.

Automatic color corrections operate within normal limits for legal video levels. For example, an 
automatic color correction does not make an adjustment that takes a significant area of an image 
beyond legal luminance levels.

Considerations When Using Automatic Color Correction

Although automatic color corrections are much simpler to learn and perform than manual 
corrections, practice and experience still improves your ability to correct a range of images with 
different color characteristics. If one set of automatic corrections does not produce good results, 
remove it and try a different combination. Remember also that some images might require manual 
correction in addition to or instead of automatic correction.

The following tips and suggestions can help you to achieve the best possible results when using 
automatic color correction:

• The Auto Contrast correction is most useful for images that should have areas of strong highlight 
(white or close to white) and areas of strong shadow (black or close to black). If you make an 
Auto Contrast correction on an image that does not need a full tonal range (many close-ups fall 
into this category), the correction might introduce too much contrast. When an image requires 
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Using Automatic Color Corrections
strong highlights but not strong shadows (or the reverse), you can use the Auto White or the Auto 
Black button to set the white or black point without making the overall range of tones too 
extreme.

• When you perform both an Auto Contrast and an Auto Balance correction, the order in which 
you perform the two corrections affects the final quality. For most images, you achieve the best 
results by doing the following:

- In the Hue Offsets subdividing tab of the HSL tab, use Auto Contrast first, and then use Auto 
Balance.

- In the Curves tab, use Auto Balance first, and then use Auto Contrast.

• There is usually no gain in performing an automatic correction more than once on the same 
image, even if you make the second correction in a different group from the first. For example, 
after you perform an Auto Balance in the Curves tab, you do not usually see any improvement in 
the color balance of the image if you perform a second Auto Balance either in the Curves tab or 
in the Hue Offsets subdividing tab of the HSL tab.

• If an Auto Contrast and Auto Balance combination improves an image but some color cast 
remains, you can often fine-tune the correction using one or more of the Remove Color Cast 
buttons.

• Automatic corrections you make in the Hue Offsets subdividing tab of the HSL tab and those 
you make in the Curves tab do not produce identical results for most images, and sometimes 
produce very different results. This is because the methods for calculating the corrections are 
different and the controls in the two tabs operate differently. Automatic corrections in the Curves 
tab often work well for correcting basic problems caused by incorrect camera color balancing. 
Automatic corrections in the Hue Offsets subdividing tab of the HSL tab are often better for 
more extreme problems such as bad lighting conditions. However, there are no rules that cover 
all situations. If automatic correction in one color correction group does not yield good results, 
remove it and try a correction in the other group.

Adjusting Contrast and Balance Automatically

You can adjust the contrast and balance the color automatically for an image simply by clicking 
buttons. An automatic contrast adjustment expands the tonal range of the image, which usually 
improves sharpness and detail. An automatic balance adjustment evens out the influence of the 
different color channels in the image, which usually greatly reduces or even eliminates any color cast.

Automatic contrast and balance buttons appear in the Color Correction tool as shown in the following 
illustrations.

(Symphony Option) Left to right: Auto Black button, Auto Contrast button, and Auto White button in the HSL > Controls > 
Master tab

Left to right: Auto Balance button, Auto Black button, Auto Contrast button, and Auto White button in the HSL > Hue 
Offsets tab

Auto Balance button (center) and Auto Contrast button (right) in the Curves tab
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Using Automatic Color Corrections
To make an automatic color correction in the Hue Offsets tab:

1. Enter Color Correction mode, for example, by clicking the Color Correction Mode button.

2. In the Timeline, ensure that the Record Track button for the video track on which you want to 
make corrections is the topmost selected track.

3. In the Timeline or in the monitor window, navigate to the segment you want to correct.

4. (Symphony Option) In the Color Correction tool, if the Correction Type menu does not show Src 
Segment as the selected relationship, click the Correction Type menu and select Src Segment.

Alternatively, you could select a different relationship. 

5. In the Hue Offsets tab of the Color Correction tool, click one of the Automatic Color Correction 
buttons.

For more information, see “Automatic Color Correction Buttons in the Hue Offsets Tab” on 
page 630.

To make an automatic contrast or balance adjustment in the Curves tab:

1. Enter Color Correction mode, for example, by clicking the Color Correction Mode button.

2. In the Timeline, make sure that the Record Track button for the video track on which you want to 
make corrections is the topmost selected track.

3. In the Timeline or in the monitor window, navigate to the segment you want to correct.

4. In the Curves tab of the Color Correction tool, click either the AutoBalance or the AutoContrast 
button.

Media Composer analyzes the currently selected frame in the segment and adjusts the 
appropriate color correction controls.

Automatic Color Correction Buttons in the Hue Offsets Tab

The following table describes the automatic color correction buttons available in the Hue Offsets tab 
of the Color Correction tool.

Option Description

Auto Balance Makes adjustments to the Red, Green, and Blue curves to balance the colors 
in the image. This eliminates any color cast for most images.

Auto Contrast Makes an adjustment to the Master curve to maximize the tonal range in the 
image. The brightest areas of the image become as bright as possible and the 
darkest areas of the image become as dark as possible.

Button Icon Description

Auto Balance Balances the colors in the image (eliminating any color cast for most images). Adjusts 
all three ChromaWheel controls.

Auto Black Makes the darkest areas of the image as dark as possible. Adjusts the Setup slider 
control. 

Auto Contrast Maximizes the tonal range in the image, making the brightest areas of the image as 
bright as possible and the darkest areas of the image as dark as possible. Adjusts the 
Gain and Setup slider controls.
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Understanding the Remove Color Cast Buttons

You can remove a color cast automatically by clicking a Remove Color Cast button and using an 
eyedropper to identify an area in your image that you want to be color neutral (white, black, or a 
shade of gray). Media Composer analyzes the current color characteristics of the area you select and 
then adjusts color correction controls to make that area color neutral. For step-by-step instructions, 
see “Using the Remove Color Cast Buttons” on page 632.

Remove Color Cast buttons provide more precise control over color cast removal than Auto Balance 
buttons because their adjustments are limited either by luminance range or by the impact that they 
have on existing curve graphs. However, Remove Color Cast buttons are only useful when you are 
working with an image that has areas that should be color neutral.

Remove Color Cast buttons appear in the Color Correction tool as shown in the following 
illustrations.

Remove Color Cast button below a ChromaWheel color wheel in the HSL > Hue Offsets tab

Remove Color Cast button in the Curves tab

Each ChromaWheel Remove Color Cast button is associated with the wheel above it. When you use 
the button, you application adjusts only that wheel, so only the parts of the image that fall within the 
luminance range controlled by that wheel change. You choose which ChromaWheel to adjust based 
on the luminance level of the area you want to identify, as follows:

• To make white or light gray areas of an image color neutral and remove a cast throughout the 
lightest part of the image, use the Remove Color Cast button below the Highlights 
ChromaWheel.

• To make mid-gray areas of an image color neutral and remove a cast throughout the midtones of 
the image, use the Remove Color Cast button below the Midtones ChromaWheel.

• To make black or dark gray areas of an image color neutral and remove a cast throughout the 
darkest parts of the image, use the Remove Color Cast button below the Shadows ChromaWheel.

The Curves tab Remove Color Cast button works by adding a point to each of the Red, Green, and 
Blue curves that makes the area you identify with the eyedropper color neutral. You can use the 
Curves tab Remove Color Cast button repeatedly to identify multiple areas that you want to be color 

Auto White Makes the brightest areas of the image as bright as possible. Adjusts the Gain slider 
control.

n The four automatic color correction commands described in this table are also available as buttons in 
the CC tab of the Command Palette. You can map these buttons to any mappable key on your keyboard or 
to any mappable button location in the user interface. For more information, see “The Command 
Palette” in the Help.

Button Icon Description(Continued)
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neutral. Each new use adds another point to each of the three curves. (You can add new points up to 
the 16 point limit. However, once several points are distributed along the curve, further points are 
unlikely to improve the image significantly). 

The effect of each added point on the image as a whole varies depending on the shape of the entire 
curve. In general, each new point affects the image most in areas with similar luminance values to the 
area you identify with the eyedropper, and affects the image least in areas with very different 
luminance values.

Using the Remove Color Cast Buttons

To use a Remove Color Cast button:

1. Enter Color Correction mode, for example, byclicking the Color Correction Mode button.

2. In the Timeline, make sure that the Record Track button for the video track on which you want to 
make corrections is the topmost selected track.

3. In the Timeline or in the monitor window, navigate to the segment you want to correct.

4. Do one of the following:

t Click the Remove Color Cast button below a ChromaWheel in the Hue Offsets subdividing 
tab of the HSL tab.

t Click the Remove Color Cast button in the Curves tab.

The button appears highlighted.

5. Drag the pointer into the image.

The pointer changes to an eyedropper.

6. Continue to drag the eyedropper until it is over the part of the image you want to become color 
neutral, and then release the mouse button.

Media Composer analyzes the part of the image you have identified and adjusts the controls to 
remove the color cast.

Correcting Color Automatically Using the Color Correction Effect

You can use the Color Correction effect in the Effect Palette to apply up to three automatic color 
corrections at one time simply by applying the effect to selected segments just like any other Avid 
effect.

Because you do not have to use any controls in the Color Correction tool, or even enter Color 
Correction mode, this is the simplest way to correct basic color problems on any or all of the 
segments in your sequence.

For more information on working with the Color Correction effect, see “Using the Color Correction 
Effect” on page 707.

You determine which automatic color corrections Media Composer makes by setting options in the 
AutoCorrect tab of the Correction Settings dialog box. A common setting that often solves most 
basic color problems applies two automatic corrections, one to correct contrast and one to correct 
color balance. The procedure in this topic describes how to set up this setting. For information on the 
full range of options for the type and number of automatic corrections that you can set, see “Selecting 
AutoCorrect Options” on page 709.
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To set basic AutoCorrect options:

1. Do one of the following:

t In the Settings list User tab, double-click Correction.

t In the Color Correction window, click the Correction Mode Settings button.

The Correction Mode Settings dialog box opens.

2. Click the AutoCorrect tab.

3. Click the First Correction menu and select HSL Auto Contrast

4. Click the Second Correction menu and select HSL Auto Balance

5. Ensure that the Third Correction menu is set to Nothing.

To correct a single segment with the Color Correction effect:

1. Select Tools > Effect Palette.

2. In the Effect Palette, click the Image category.

3. Click the Color Correction Effect icon, and drag it to the segment in the Timeline to which you 
want to apply corrections.

To correct multiple segments with the Color Correction effect:

1. In Source/Record mode or Effect mode, select the segments in the Timeline that you want to 
correct.

For more information on selecting multiple segments, see “Selecting and Deselecting Segments” 
in the Help.

2. Select Tools > Effect Palette.

3. In the Effect Palette, click the Image category.

4. Double-click the Color Correction Effect icon.
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Using the Color Match Control
Each Color Correction group includes a Color Match control. This control lets you quickly make a 
correction by selecting input and output colors from your images, from the Windows Color dialog 
box, or from the Macintosh® Colors panel. If “Eyedropper Picks from Anywhere in Application” is 
selected in the Correction Mode Settings dialog box, you can also select colors from any other 
location within Media Composer, such as a custom color swatch saved in a bin.

When you use the Color Match control, Media Composer replaces the input color value with the 
output color value and adjusts all the other color values in the image proportionally. Media Composer 
also automatically adjusts the other controls in the group to reflect the change. You can set the 
combination of color channels or components Media Composer uses to determine the match by 
making menu selections.

For example, if you want to replace the blue sky tone in one image with that in another to match the 
two shots, you can use the Color Match control to pick the two colors and automate the color 
adjustment. For more information, see “Making a Correction with the Color Match Control” on 
page 634 and “Match Type Options” on page 636.

When you are working in the Curves group, the Color Match control also includes the 
NaturalMatch™ feature. NaturalMatch lets you replace the hue values in an image with new output 
values without distorting the saturation and luminance values in the image. For more information, see 
“Understanding NaturalMatch” on page 639 and “Color Match Example Using NaturalMatch” on 
page 640.

You can also save colors to a bin as custom colors that you can drag into the Color Match control at 
any time. If “Eyedropper Picks from Anywhere in Application” is selected, you can also select a 
custom color from its swatch in the bin using the eyedropper. For more information, see “Saving 
Custom Colors to a Bin” on page 640.

Because the Color Match control can display the RGB color values for any point in an image, it is 
also useful as an information palette that lets you check how far the colors in an area of an image 
depart from the color values you want to achieve. For more information, see “Getting RGB 
Information Using the Color Match Control” on page 641.

n (Symphony Option) Slightly different versions of the Color Match control also appear as effect 
parameters in the Spot Color Correction effect and the Paint Effect. For more information on spot 
color correction, see “(Media Composer | Symphony Option) Spot Color Correction” on page 748.

Making a Correction with the Color Match Control

The following illustration shows the Color Match control.

Components of the Color Match control: input color swatch (top left), output color swatch (top right), Match Type button 
(center), Match Color button (bottom)
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To make a correction using the Color Match control:

1. If you have not already done so, enter Color Correction mode, for example, by clicking the Color 
Correction Mode button.

2. In the Color Correction tool, click the tab that includes the Color Match control with which you 
want to work.

For more information on the Color Correction tool tabs, see “Understanding the Group and 
Subdividing Tabs” on page 607.

3. (Option) If necessary, select either of the following options in the Correction Mode Settings 
dialog box:

For complete information on the Correction Mode Settings dialog box, see “Customizing Color 
Correction Mode Settings” on page 614.

4. Select the input color (the color to be replaced):

a. Move the pointer over the input color swatch.

The pointer changes to an eyedropper.

b. Press and hold the mouse button, and then drag the eyedropper to the area of the image in the 
monitor from which you want to select an input value.

The input color swatch in the Color Match control updates as you move the pointer in the 
image.

If “Eyedropper Picks from Anywhere in Application” is selected in the Correction Mode 
Settings dialog box, you can select an input color from another location in Media Composer 
using the eyedropper. Also, you can pick from the Windows Color dialog box or the 
Macintosh Colors panel by double-clicking the input color swatch. However, you usually 
want to select your input color from the current segment.

c. Release the mouse button to complete the selection.

The input color appears in the input color swatch.

5. Select the output color:

a. Move the pointer over the output color swatch.

The pointer changes to an eyedropper.

b. Press and hold the mouse button, and then drag the eyedropper to the area of the image in the 
monitor from which you want to select an output value.

Option Description

Eyedropper 3 x 3 
Averaging

When this option is selected, Media Composer calculates the color value to 
pick by averaging the values of a 3 x 3 sample of pixels centered on the 
eyedropper’s position. This is often useful for picking up a color accurately 
by sight because it compensates for shifts in color value from one pixel to 
another. When this option is deselected, Media Composer selects the color 
value of the exact pixel at the eyedropper’s position.

Eyedropper Picks 
from Anywhere 
in Application

When this option is selected, you can pick colors from anywhere in Media 
Composer using the Color Match eyedroppers. For example, you can pick a 
target color for a Color Match correction, such as a desirable skin tone, from 
the swatch that appears beside a custom color saved in a bin or from one of 
the ChromaWheels.
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The output color swatch in the Color Match control updates as you move the pointer in the 
image.

You usually select your output color from an image other than the current segment, such as 
the next segment or a reference frame. If “Eyedropper Picks from Anywhere in Application” 
is selected in the Correction Mode Settings dialog box, you can select an input color from 
another location in Media Composer, such as a custom color swatch in a bin. You can also 
double-click the output color swatch and select a color from the Windows Color dialog box 
or the Macintosh Colors panel. These alternatives are useful for selecting a saved “ideal” 
replacement color such as a completely neutral gray or an optimal skin tone. For more 
information on using the Windows Color dialog box or the Macintosh Colors panel, see 
“Adjusting a Color Parameter for an Effect” on page 74.

c. Release the mouse button to complete the selection.

The output color appears in the output color swatch.

6. Click the Match Type button, and select a Match Type to determine the type of match Media 
Composer makes.

The options available in the Match Type menu depend on the group in which you are working. 
For more information on Match Type options, see “Match Type Options” on page 636.

7. Click the Match Color button to make the correction.

Media Composer adjusts the current segment and resets the group controls to reflect the 
adjustment. The corrected image displays in the monitor that contains the current segment.

Match Type Options

The options available in the Match Type menu reflect the way in which color is handled in the group 
in which you are working. The following table describes the options available in the Match Type 
menu.

Group Description

HSL 
(Controls tab)

• H + S + L: Media Composer matches based on the hue, saturation, and luminance of the 
color you select in the output color swatch.

• Hue: Media Composer matches based on only the hue of the color in the output color 
swatch.

• Saturation: Media Composer matches based on only the saturation of the color in the 
output color swatch.

• Luminance: Media Composer matches based on only the luminance of the color in the 
output color swatch.

HSL 
(Hue Offsets tab)

• Highlight: Media Composer matches based on both the hue and the saturation across the 
highlights portion of the tonal range.

• Midtones: Media Composer matches based on both the hue and the saturation across the 
midtones portion of the tonal range.

• Shadows: Media Composer matches based on both the hue and the saturation across the 
shadows portion of the tonal range.
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(Media Composer | Symphony Option) HSL Group (Controls Tab) Match Type Options

The following table describes the Match Type options for the HSL group in the Controls tab.

(Media Composer | Symphony Option) HSL Group (Hue Offsets Tab) Match Type Options

The following table describes the Match Type options for the HSL group in the Hue Offsets tab.

Curves • Master: Media Composer matches based on the luminance of the color in the output color 
swatch.

• R + G + B: Media Composer matches based on the values of all three color channels of 
the color in the output color swatch.

• NaturalMatch: Switches the NaturalMatch feature on and off. Choose NaturalMatch to 
select or deselect the NaturalMatch feature.

When this command is selected, all the match types in the Curves group use the 
NaturalMatch feature when making a correction and match types appear in the Color 
Match control with the extension (Nat). For more information on NaturalMatch, see 
“Understanding NaturalMatch” on page 639.

Group Description

Option Description

H + S + L Media Composer matches based on the hue, saturation, and luminance of the color in the output 
color swatch.

Hue Media Composer matches based on only the hue of the color in the output color swatch.

Saturation Media Composer matches based on only the saturation of the color in the output color swatch.

Luminance Media Composer matches based on only the luminance of the color in the output color swatch.

H + S Media Composer matches based on both the hue and the saturation of the color in the output 
color swatch.

H + L Media Composer matches based on both the hue and the luminance of the color in the output 
color swatch.

S + L Media Composer matches based on both the saturation and the luminance of the color in the 
output color swatch.

Option Description

Master Media Composer matches based on both the hue and the saturation across the full tonal range.

Highlights Media Composer matches based on both the hue and the saturation across the highlights portion 
of the tonal range as defined in the Luma Ranges tab.

Midtones Media Composer matches based on both the hue and the saturation across the midtones portion of 
the tonal range as defined in the Luma Ranges tab.

Shadows Media Composer matches based on both the hue and the saturation across the shadows portion of 
the tonal range as defined in the Luma Ranges tab.
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(Media Composer | Symphony Option) Channels Tab Match Type Options

The following table describes the Match Type options for the Channels tab.

(Media Composer | Symphony Option) Levels Tab Match Type Options

The following table describes the Match Type options for the Levels tab.

(Media Composer | Symphony Option) Curves Tab Match Type Options

The following table describes the Match Type options for the Curves tab.

Option Description

Master Media Composer matches based on the luminance of the color in the output color swatch.

R + G + B Media Composer matches based on the values of all three color channels of the color in the output 
color swatch.

Red Media Composer matches based on only the value of the Red color channel of the color in the 
output color swatch.

Green Media Composer matches based on only the value of the Green color channel of the color in the 
output color swatch.

Blue Media Composer matches based on only the value of the Blue color channel of the color in the 
output color swatch.

R + G Media Composer matches based on the values of the Red and Green color channels of the color in 
the output color swatch.

R + B Media Composer matches based on the values of the Red and Blue color channels of the color in 
the output color swatch.

G + B Media Composer matches based on the values of the Green and Blue color channels of the color in 
the output color swatch.

Option Description

Black Point Media Composer adjusts the black point of the image to the brightness value of the color in the 
output color swatch.

Gray Point Media Composer adjusts the gray point of the image to the brightness value of the color in the 
output color swatch.

White Point Media Composer adjusts the white point of the image to the brightness value of the color in the 
output color swatch.

Option Description

Master Media Composer matches based on the luminance of the color in the output color swatch.

R + G + B Media Composer matches based on the values of all three color channels of the color in the 
output color swatch.

Red Media Composer matches based on only the value of the Red color channel of the color in the 
output color swatch.
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(Media Composer | Symphony Option) Secondary Tab Match Type Options

The following table describes the Match Type options for the Secondary tab.

Understanding NaturalMatch

Color matching is often complicated by differences in lighting between one shot and another. For 
example, you might want to match the skin tone in Shot A, which is in shadow, with that in Shot B, 
which is brightly lit. To achieve a natural-looking correction, you need to replace the hue of Shot A, 
but preserve the luminance and saturation characteristics that suggest shadow.

NaturalMatch solves this problem by making calculations that compensate for the luminance and 
saturation qualities of the original image. The correction Media Composer makes when you use 
NaturalMatch adopts the new hue value, preserves the original luminance value, and adjusts the 
saturation value in relation to the other values. NaturalMatch lets you use the quick correction 
method offered by the Color Match control even when images show significant differences in 
lighting.

Green Media Composer matches based on only the value of the Green color channel of the color in the 
output color swatch.

Blue Media Composer matches based on only the value of the Blue color channel of the color in the 
output color swatch.

R + G Media Composer matches based on the values of the Red and Green color channels of the color 
in the output color swatch.

R + B Media Composer matches based on the values of the Red and Blue color channels of the color 
in the output color swatch.

G + B Media Composer matches based on the values of the Green and Blue color channels of the color 
in the output color swatch.

NaturalMatch Select NaturalMatch to select or deselect the NaturalMatch feature.

When this command is selected, all the match types in the Curves and Secondary groups use 
NaturalMatch when making a correction and match types appear in the Color Match control 
with the extension (Nat). For more information on NaturalMatch, see “Understanding 
NaturalMatch” on page 639.

Option Description

Option Description

Hue Media Composer matches based on only the hue of the color in the output color swatch.

Saturation Media Composer matches based on only the saturation of the color in the output color swatch.

H + S Media Composer matches based on both the hue and the saturation of the color in the output 
color swatch.

NaturalMatch Select NaturalMatch to select or deselect the NaturalMatch feature.

When this command is selected, all the match types in the Curves and Secondary groups use 
NaturalMatch when making a correction and match types appear in the Color Match control 
with the extension (Nat). For more information on NaturalMatch, see “Understanding 
NaturalMatch” on page 639.
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Color Match Example Using NaturalMatch

The following illustrations show an example of the use of the Color Match control and the 
NaturalMatch feature to correct color from shot to shot.

Top left: uncorrected image. This image is very gray and shows poor skin tones. The RGB values at the center of the 
man’s forehead are R: 61, G: 62, B: 66 — an almost completely neutral gray.
Top right: reference image. This image shows much better color, including good skin tones (RGB values of R: 110, G: 70, 
B: 56) and a better color for the canvas of the tent. You can use the Color Match control to make the color characteristics 
of the two shots match better. A Color Match that uses values from the center of the foreheads in each image and that 
uses NaturalMatch automatically generates Curves adjustments for all three color channels.
Bottom: corrected image. Further corrections (for example, to improve contrast ratio) are still possible, but the image 
improves dramatically after the color match. The skin tones and the color of the tent in the background now match the 
reference image well.

Saving Custom Colors to a Bin

You can save a color that you select in the Color Match control as an item in a bin. For example, you 
might want to save a skin tone that you want to match throughout your sequence. You can then load 
that color back into the Color Match control whenever you need to make a match based on that color.

To save a color to a bin:

1. In the Color Match control, Alt+drag (Windows) or Option+drag (Macintosh) the swatch that 
contains the color you want to save to a bin.

While you drag, the pointer changes to a hand, and a rectangular outline appears.

The color appears in the bin as a rectangular color swatch icon. Media Composer assigns the 
color a name based on the current Saved Color Labels settings in the Correction Mode Settings 
dialog box. For more information, see “Customizing Color Correction Mode Settings” on 
page 614.
640



The HSL (Hue, Saturation, Luminance) Group
Examples of custom color swatches as they appear in a bin

2. (Option) If you want to rename the custom color, click the existing name in the bin and type a 
new name.

To load a custom color into the Color Match control, do one of the following:

t Drag the color icon from the bin to the appropriate color swatch in the Color Match control.

t If “Eyedropper Picks from Anywhere in Application” is selected in the Correction Mode 
Settings dialog box, select the saved color from its swatch in the bin using the Color Match 
eyedropper.

Getting RGB Information Using the Color Match Control

By default, the color swatches in the Color Match control display the RGB values for the selected 
color. This makes the Color Match control useful as an information palette to check the exact RGB 
value of a sample area in your image.

For example, if you have an area in your image that you know should appear white, you can sample 
that area using the Color Match eyedropper and check how far its RGB values depart from a true 
white. If the values are R:231, G:217, B:229, then you know that you need to add a little green to 
achieve white (the image has a magenta cast). If you want this area in the image to be exactly 
reference white (R,G,B:235), you know that you also need to adjust the white point slightly to 
increase the RGB values.

The HSL (Hue, Saturation, Luminance) Group
The HSL (Hue, Saturation, Luminance) group provides controls that let you alter attributes such as 
hue, saturation, gain, and gamma. These controls resemble those found in the Video Input tool and in 
the Color Effect.

The HSL group also lets you specify an offset for the hue of an image, which is especially useful for 
correcting a color cast. For example, when an object in an image that should be a neutral gray appears 
tinged with a color, you can use the offset adjustment to restore the correct gray color.

You can make Hue Offset adjustments in three different luminance ranges — highlights, midtones, 
and shadows. This gives you more precise control over color cast corrections. In Symphony Option, 
you can define the exact scope of each of these ranges and get visual confirmation of which parts of 
an image fall in each range. You can also invert both the chrominance and luminance values in an 
image with a single click, and set clipping values for both the High and Low ends of the luminance 
range.

The HSL controls can correct a wide range of problems. If you are comfortable working with the 
HSL group and gain some experience using it, you might be able to make most of your common 
corrections without needing to use any other tools.
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Making Corrections Using the Controls Tab in the HSL Group

The Controls tab of the HSL group includes sliders for making adjustments to hue, saturation, and 
luminance values. It also includes the Color Match control for making adjustments automatically, 
based on selected input and output color values. For more information, see “Using the Color Match 
Control” on page 634. In Symphony Option, it also includes automatic color correction buttons. For 
information, see “Using the Color Match Control” on page 634 and “Using Automatic Color 
Corrections” on page 627.

The following sample Symphony Option illustration shows the Controls tab.

To make a correction using the Controls tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. (Symphony Option) Click the Correction Type button and select a correction type.

For more information, see “(Symphony Option) Selecting Correction Types” on page 604.

c. Click the HSL tab.

d. On the left side of the Color Correction tool, click the Controls subdividing tab.

2. (Symphony Option) Click the Controls subdividing tab in the first vertical group on the left side 
of the Color Correction tool.

3. (Symphony Option) Click the appropriate subdividing tab in the second vertical group on the left 
side of the Color Correction tool.

This tab selection determines the brightness range across which your adjustments apply. The 
following table describes the available options.

n By default, highlight, midtone, and shadow ranges represent equal one-third subdivisions of the full 
brightness range. You can customize these ranges using the controls in the Luma Ranges tab. For 
more information, see “(Media Composer | Symphony Option) Understanding the Luma Ranges 
Tab” on page 651.

Tab Description

Master Adjustments apply to the whole image.

Highlights Adjustments apply to the brightest parts of the image only.

Midtones Adjustments apply to the midrange of brightness values only.

Shadows Adjustments apply to the darkest parts of the image only.
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4. Make your adjustments by doing one of the following:

t Adjust one or more of the individual sliders or buttons.

For more information, see “Using the Sliders in the Controls Tab of the HSL Group” on 
page 643 and “Controls Tab Reference” on page 643.

t Use the Color Match control to make a correction by selecting input and output colors.

For more information, see “Using the Color Match Control” on page 634.

t (Symphony Option) Use the automatic color correction buttons.

For more information, see “Adjusting Contrast and Balance Automatically” on page 629.

Using the Sliders in the Controls Tab of the HSL Group

The following illustration shows the components of the HSL controls.

Components of a control in the Controls tab. Left to right: Enable button, text box, direction button, slider, direction button

For information on using the Enable button for a control to turn the control on or off or to reset the 
control to its default value, see “Working with the Enable Buttons” on page 611.

To adjust the HSL sliders, do one of the following:

t Type a value in the text box, and then press Enter (Windows) or Return (Macintosh).

t Drag the slider.

t Click one of the direction buttons to change the value in small increments.

t Click one of the direction buttons, and press and hold the mouse button to change the value 
quickly over a large range.

To change the numerical value of a control by small increments:

t Click in the text box, and then press the Up Arrow key to increase the value or the Down Arrow 
key to decrease the value.

To use the mouse scroll wheel to change values for a control:

1. Click the slider or click in the text box.

2. Do one of the following:

t Use the scroll wheel to change the value in small increments.

t Press and hold the Shift key and use the scroll wheel to change the value in increments of -
10 or +10.

Controls Tab Reference

The following table describes the individual controls available in the Controls tab of the HSL tab.
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Control Description

(Symphony Option) 
Invert Chroma 
(Master subdividing 
tab only)

Replaces the color value of every pixel in the image with the opposite color value on the 
color wheel. This is the equivalent of setting the Hue control to 180 or –180.

Hue Shifts the hues in the image around the color wheel. Values range from –180 to 180, 
where 0 is the default and causes no change in the image. A value of 120 shifts red to 
blue, and a value of –120 shifts red to green. In Symphony Option, in the Master 
subdividing tab, a value of 120 shifts red to blue, and a value of –120 shifts red to green.

Saturation Specifies the amount or intensity of color. Values range from 0 to 200, where 100 
represents no change to the image, 0 represents complete desaturation (monochrome 
image), and 200 represents maximum saturation.

This control is also available in the Curves tab as Master Saturation. In Symphony 
Option, when you adjust the Master Saturation slider in the Curves tab, you enable the 
HSL > Controls > Master tab hierarchy.

Brightness Adjusts the luminance of the image by shifting the luminance value of every pixel by the 
value set in the control. Values range from –100 to 100, where –100 subtracts 100 from 
the luminance value of every pixel, and 100 adds 100 to the luminance value of every 
pixel.

The effect of the Brightness control is very similar to that of the Setup control (on the 
Hue Offsets tab). One important difference, however, is that the Brightness control 
interacts with the Contrast control, while the Setup control interacts with the Gain and 
Gamma controls. If you make a Contrast adjustment, it is better to adjust luminance 
further using the Brightness slider. If you make an adjustment using the Gain or Gamma 
controls, it is better to adjust luminance further using the Setup control.

Contrast Increases or decreases the amount of contrast in the image. Values range from –100 to 
100, where –100 represents no contrast (all pixels mapped to neutral gray) and 100 
represents maximum contrast.

(Symphony Option) 
Invert Luma 
(Master subdividing 
tab only)

Reverses the brightness level of every pixel in the image. Dark areas become light, and 
light areas become dark.

(Symphony Option) 
Gain

Adjusts the gain or white point for the image. Values range from 0 to 200, where 100 
represents the unchanged image.

The main difference between Brightness and Gain is that Brightness adjusts by adding to 
the luminance value of every pixel, while Gain makes an adjustment based on a 
percentage of the original luminance.

(Symphony Option) 
Gamma

Adjusts the midpoint of the luminance range. Values range from 0.1 to 10, where 1 
represents the unchanged image. Lowering the value darkens the midtones and brings the 
image closer to black. Raising the value lightens the midtones and brings the image 
closer to white.
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Understanding the Hue Offsets Tab

The Hue Offsets subdividing tab of the HSL group contains controls for adjusting hue and saturation 
values at the same time using ChromaWheel™ color wheels and linked text boxes. These controls are 
especially well-suited for correcting color casts in images. For more information, see “Understanding 
ChromaWheel Color Wheels” on page 646 and “Using the ChromaWheel Crosshair Pointers” on 
page 649.

n The ChromaWheel color wheels provide controls similar to the physical controllers on traditional 
color correction equipment, so experienced colorists might use them as their preferred controls for 
many color adjustments.

The Hue Offsets tab also contains slider controls for adjusting Gain, Gamma, and Setup. These 
sliders offer one of the best ways to control the tonal range of your images. For more information, see 
“Hue Offsets Tab Reference” on page 649.

The Hue Offsets tab also contains automatic color correction buttons and a Color Match control. For 
more information, see “Using Automatic Color Corrections” on page 627 and “Using the Color 
Match Control” on page 634.

The following illustrations shows the Hue Offsets tab.

(Symphony Option) 
Setup

Adjusts the setup or black point for the image. Values range from –255 to 255, where 0 
represents the unchanged image.

The effect of the Setup control is very similar to that of the Brightness control. One 
important difference, however, is that the Setup control interacts with the Gain and 
Gamma controls, while the Brightness control interacts with the Contrast control. If you 
make an adjustment using the Gain or Gamma controls, it is better to adjust luminance 
further using the Setup control. If you make a Contrast adjustment, it is better to adjust 
luminance further using the Brightness slider.

n In Symphony Option, the Master subdividing tab Gain, Gamma, and Setup sliders are also available in 
the Curves tab as the Master Gain, Master Gamma, and Master Setup sliders. When you adjust any of 
these sliders in the Curves tab, you enable the HSL tab, the Controls subdividing tab, and the Master 
brightness subdividing tab.

Clip Low
Clip High

Sets the Low clip and the High clip for the image. All pixels with the Low clip value or 
less are clipped to black. All pixels with the High clip value or more are clipped to white. 
The default settings for these controls are 16 and 235 on an 8-bit scale (the normal 
broadcast values for black and white).

Invert Chroma Replaces the color value of every pixel in the image with the opposite color value on the 
color wheel. This is the equivalent of setting the Hue control to 180 or –180.

Invert Luma Reverses the brightness level of every pixel in the image. Dark areas become light, and 
light areas become dark.

Control Description
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ChromaWheel color wheels (left), slider controls (center), Color Match control (right), and automatic color correction 
buttons (across the bottom) in the HSL > Hue Offsets tab.

(Symphony Option) ChromaWheel color wheels (left), Color Match control (right), and automatic color correction buttons 
(across the bottom) in the HSL > Hue Offsets tab.

Understanding ChromaWheel Color Wheels

The ChromaWheel color wheels let you make adjustments across the same luminance ranges as the 
Controls tab. The wheels appear in the following order from left to right: Shadows, Midtones, and 
Highlights. In Symphony Option, the wheels appear in the following order from left to right: 
Shadows, Midtones, Highlights, and Master.

ChromaWheel Displays

The ChromaWheel color wheels show outlines that resemble the design of a vectorscope monitor, 
overlaid on full-color depictions that show the color represented by each area of the wheel. In 
Symphony Option, the ChromaWheel color wheels display as graphical outlines that resemble the 
design of a vectorscope monitor. Colors are oriented in the same manner as in a vectorscope monitor, 
with red near the top. Axes indicate the offset in degrees from the 0° point, which corresponds with 
red.

In Symphony Option, you can display color backgrounds in the ChromaWheels that help you to 
understand the effect of an adjustment as you work. For more information, see “Customizing Color 
Correction Mode Settings” on page 614.

n The Hue Offsets color wheels create a familiar environment for users by duplicating the general 
appearance of a vectorscope monitor. They are not calibrated in the same way as a vectorscope 
monitor.

ChromaWheel Crosshair Pointers

Each ChromaWheel control contains a crosshair pointer that identifies the currently selected point on 
the wheel. Each pointer has a distinctive appearance to help you distinguish them from one another. 
The following table shows the pointers.
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How ChromaWheels Work

A ChromaWheel color wheel is a circular graph that represents hue and saturation values. Hue values 
are mapped around the circumference of the wheel, with colors in the same positions that they 
occupy on a vectorscope. Red is at the 0° point on the wheel, and cyan is at the 180° point.

As you move around the wheel counterclockwise from red to cyan, you move through positive degree 
values. For example, green is at +120°. As you move around the wheel clockwise from red to cyan, 
you move through negative degree values. For example, blue is at –120°

Saturation values are mapped along the radius of the wheel. The center point of the wheel represents 
zero saturation (neutral gray), while the edge of the wheel represents maximum saturation. As you 
move out from the center of the wheel, you shift from less to more saturation. Saturation values range 
from 0 (zero saturation) to 100 (maximum saturation).

When you pick a specific point on the wheel, you select an exact combination of hue and color 
intensity to add to your image. You can select a gray with a slight yellow tinge near the center of the 
wheel, for example, or an intensely saturated blue at the outer edge.

A ChromaWheel color wheel: hue changes as you move around the wheel, saturation increases from the center of the 
wheel toward the edge, and the graphical outline shows the degree values for measuring hue

When you use a ChromaWheel, you use a basic principle of color theory — you can cancel out one 
color in an image by adding an equal amount of the opposite color on the wheel. For example, to 
remove a red cast, add some cyan. To remove a yellow cast, add some blue. You do not even need to 

ChromaWheel Type Pointer

Shadows

Midtones

Highlights

(Symphony) Master
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remember which colors are opposite when you have the color wheel as a control. Simply add some 
color from the opposite side of the wheel from the color you want to remove, and then fine-tune your 
adjustment until you are satisfied with the result.

Making Corrections Using the Hue Offsets Tab

To make a correction using the Hue Offsets tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. (Symphony Option) Click the Correction Type button and select a correction type.

For more information, see “(Symphony Option) Selecting Correction Types” on page 604.

c. Click the HSL tab.

d. Click the Hue Offsets subdividing tab.

2. (Symphony Option) Click the Hue Offsets subdividing tab in the first vertical group on the left 
side of the Color Correction tool.

3. Make your adjustments by doing one or more of the following:

t Click one or more of the automatic color correction buttons.

For more information, see “Adjusting Contrast and Balance Automatically” on page 629.

t Use one or more of Remove Color Cast buttons below the ChromaWheels.

For more information, see “Using the Remove Color Cast Buttons” on page 632.

t Use the Color Match control to calculate an offset automatically, based on input and output 
colors.

For more information, see “Using the Color Match Control” on page 634.

t Drag the crosshair pointer on the appropriate ChromaWheel.

As you move the pointer in the wheel, the Hue and Amount text boxes update to display 
numerical values for the adjustment. For more information, see “Using the ChromaWheel 
Crosshair Pointers” on page 649.

t Type values in the Hue and Amount text boxes for the appropriate ChromaWheel to set the 
offset you want. You must press Enter (Windows) or Return (Macintosh) after typing a value 
for it to take effect.

Hue values range from –180° to 180° where 0° is the position of red on the wheel. Amount 
values range from 0 to 100. When you change the Hue and Amount values, the pointer on 
the ChromaWheel updates to represent the adjustment.

t Change the Hue or Amount value in small increments by clicking in the text box, and then 
pressing the Up Arrow key to increase the value or the Down Arrow key to decrease the 
value.

t Use the mouse scroll wheel to change the Hue or Amount values by clicking in the text box, 
then using the scroll wheel to change the value in small increments. Press the Shift key and 
use the scroll wheel to change the value in increments of -10 or +10.

t Adjust one or more of the Gain, Gamma, and Setup controls. 

For more information, see “Using the Sliders in the Controls Tab of the HSL Group” on 
page 643 and “Hue Offsets Tab Reference” on page 649.

4. Fine-tune your adjustments until you are satisfied with the result.
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Remember that you can make adjustments on more than one ChromaWheel and turn them on 
and off individually to assess their effect on the image.

Using the ChromaWheel Crosshair Pointers

To move the crosshair pointer in a ChromaWheel color wheel:

1. Click anywhere in the wheel, and press and hold the mouse button.

The standard mouse pointer disappears, and the crosshair pointer is dynamically linked to the 
mouse.

2. Drag the crosshair pointer around in the wheel until you are satisfied with the adjustment, and 
then release the mouse button.

For more precise control over the movement of the crosshair pointer in the central area of the 
wheel, press and hold the Shift key while performing the actions in this procedure.

Hue Offsets Tab Reference

The following table describes the individual controls available in the Hue Offsets tab of the HSL tab.

(Media Composer | Symphony Option) Examples of Hue Offsets Settings

The following illustrations show the effect on an image of several adjustments that use the Master 
Hue Offsets ChromaWheel color wheel.

Control Description

Gain Adjusts the gain or white point for the image. Values range from 0 to 200, where 100 represents 
the unchanged image.

The main difference between Brightness (on the Controls tab) and Gain is that Brightness 
adjusts by adding to the luminance value of every pixel, while Gain makes an adjustment based 
on a percentage of the original luminance.

This control is also available in the Curves tab as Master Gain.

Gamma Adjusts the midpoint of the luminance range. Values range from 0.1 to 10, where 1 represents 
the unchanged image. Lowering the value darkens the midtones and brings the image closer to 
black. Raising the value lightens the midtones and brings the image closer to white.

This control is also available in the Curves tab as Master Gain.

Setup Adjusts the setup or black point for the image. Values range from –255 to 255, where 0 
represents the unchanged image (no offset).

The effect of the Setup control is very similar to that of the Brightness control (on the Controls 
tab). One important difference, however, is that the Setup control interacts with the Gain and 
Gamma controls, while the Brightness control interacts with the Contrast control. If you make 
an adjustment using the Gain or Gamma controls, it is better to adjust luminance further using 
the Setup control. If you make a Contrast adjustment, it is better to adjust luminance further 
using the Brightness slider.

This control is also available in the Curves tab as Master Gain.
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n These examples use the Master wheel because it operates across the entire luminance range and 
alters the image in ways that are easy to see and understand. You have more precise control of 
corrections if you use the Shadows, Midtones, and Highlights wheels to make adjustments in specific 
luminance ranges.

This original image has a yellow cast. The swatch to the left shows the sample RGB values for an 
area of the ladder. There is relatively less blue than red or green in the grays of the image. You might 
want to restore the metal objects in the image to a more neutral gray or even change the look and 
mood of the image by creating a different cast. The Hue Offsets ChromaWheel color wheels provide 
a way to do this easily.

This adjustment alters the original image by introducing just enough blue to make the grays in the 
image neutral. The RGB values in the ladder now show almost equal amounts of red, green, and blue. 
The adjustment corrects the yellow cast by moving the crosshair pointer in the opposite direction 
from yellow on the wheel.
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This adjustment adds more blue to the original image. Metal objects in the image are now distinctly 
blue-gray, and the sample values from the ladder show more blue than red or green.

This adjustment adds a large amount of blue to the original image. The metal objects now look very 
blue, and the grain elevators are so saturated in blue that they have lost a lot of detail. You might not 
want to make such an extreme adjustment except when you need a deliberately unrealistic look, but it 
demonstrates how much you can change an image with a single adjustment of a ChromaWheel color 
wheel.

(Media Composer | Symphony Option) Understanding the Luma Ranges Tab

The Luma Ranges tab lets you view and customize the luminance ranges that you use to define the 
highlights, midtones, and shadows in other parts of the HSL group. You make these adjustments on a 
Luma Ranges graph.

You can view your images in three different ways while you are working in the Luma Ranges tab. 
You can view the uncorrected image, the image with all active corrections applied, or a three-tone 
preview that uses white, gray, and black to indicate the three luminance ranges.
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You might use the Luma Ranges tab to adjust the three luminance ranges before you make other HSL 
adjustments. Alternatively, you might make HSL adjustments that affect the different ranges and then 
use the Luma Ranges tab to fine-tune the brightness ranges to which those adjustments apply. For 
example, you can make an adjustment that you like in the Highlights wheel of the Hue Offsets tab 
and then fine-tune the range of pixels to which that adjustment applies using the Luma Ranges tab.

The following illustration shows the Luma Ranges tab with the Highlights subdividing tab displayed.

Controls in the Luma Ranges tab: Preview buttons (top left), text boxes (bottom left), and the Luma Ranges graph (right)

(Media Composer | Symphony Option) Understanding the Luma Ranges 
Graph

The Luma Ranges graph shows curves for each of the three luminance ranges: highlights, midtones, 
and shadows. You can always see all three curves, but you can only adjust the curve that is active as 
defined by your subdividing tab.

The graph plots brightness values from 0 to 255 on the horizontal axis and percentage values on the 
vertical axis. Media Composer defines a luminance range as the area in the graph where the curve for 
that range is highest in the graph. The following illustration shows this arrangement for the default 
curves.

Graph of the default luminance ranges: Shadows (left), Midtones (center), and Highlights (right)

To adjust a curve, you move a control point on the curve up or down on the graph. This results in 
more or less of the curve being highest in the graph, which enlarges or reduces the luminance range 
for that curve. 

For example, if you raise the highlights curve near the center of the graph and drop the midtones 
curve in the same area, you expand the highlights range toward the middle of the full luminance 
range and contract the midtones range into a smaller area. The following illustration shows this 
adjustment.
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Example of modifed luminance ranges: reduced Midtones range (left), and expanded Highlights range (right)

To fine-tune luma range adjustments, you should understand the role of all three curves in defining 
exactly how Media Composer treats each level of brightness. At any point on the brightness scale 
(the horizontal axis of the graph), percentage values are plotted for all three ranges — shadows, 
midtones, and highlights. Though a luminance range is broadly defined by which curve is highest in 
the graph, each brightness level is affected more precisely by all three ranges in the relative 
percentage amounts shown on the graph. 

For example, in the default Luma Ranges settings, brightness level 175 is defined as 50% highlight, 
50% midtone, and 0% shadow. Brightness level 215 is defined as 95% highlight, 5% midtone, and 
0% shadow. If you make adjustments to the highlights luminance range elsewhere in the HSL tab, 
those adjustments are dominant in controlling pixels of brightness 215 but share control of pixels of 
brightness 175 equally with the midtones adjustments.

With some practice, you can control the relative impact of your adjustments in different luminance 
ranges very precisely.

(Media Composer | Symphony Option) Adjusting Luminance Ranges

To adjust luminance ranges:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

For more information, see “(Symphony Option) Selecting Correction Types” on page 604.

c. Click the HSL tab.

2. Click the Luma Ranges tab in the first vertical group of subdividing tabs on the left side of the 
Color Correction tool.

3. Click one of the following tabs in the second vertical group of subdividing tabs on the left side of 
the Color Correction tool:

Tab Description

Highlights Displays the Luma Ranges graph with the highlights curve 
available for editing.

Midtones Displays the Luma Ranges graph with the midtones curve 
available for editing.

Shadows Displays the Luma Ranges graph with the shadows curve available 
for editing.
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4. Select one of the following options to control how your image displays in the active monitor:

You can switch back and forth between these settings as you work to assess your adjustments.

5. Adjust the active curve by adding and adjusting control points using the procedures in “(Media 
Composer | Symphony Option) Manipulating Luminance Range Curves” on page 654.

(Media Composer | Symphony Option) Manipulating Luminance Range 
Curves

To add a control point to a curve:

t Click the curve at the point where you want to add the point.

A new control point appears with a circle around it to indicate that it is the active point.

To select a control point:

t Click the control point.

A circle appears around the control point.

To move a control point, do one of the following:

t Click the point on the graph, and drag it until the curve is in the position you want.

t Type values in the In and Out text boxes to define the position of the point on the graph. You 
must press Enter (Windows) or Return (Macintosh) after typing a value for it to take effect.

To move a selected control point by small increments:

t Click in the In or Out text box, and then press the Up Arrow key to increase the value or the 
Down Arrow key to decrease the value.

To use the mouse scroll wheel to move a selected control point:

1. Click in the In or Out text box.

2. Do one of the following:

t Press and hold the Ctrl key, and use the scroll wheel to change the value in small increments.

t Press and hold the Ctrl and Shift keys (or the Ctrl and Alt keys), and use the scroll wheel to 
change the value in increments of -10 or +10.

To delete a control point:

t Click the point to select it, and then press the Delete key.

(Media Composer | Symphony Option) Examples of Three-Tone Previews

The following illustrations show sample three-tone previews for a typical video image and for a test 
monochrome gradient.

Option Description

Input Displays the uncorrected image in normal color.

Three-tone Displays the uncorrected image using white, gray, and black to represent 
the highlights, midtones, and shadows luminance ranges.

Output Displays the image in normal color with all active corrections applied.
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Top, left to right: an original monochrome gradient image, the image in three-tone preview using default luma range 
settings, and the image in three-tone preview with an expanded luma range.
Center, left to right: a video image, the image in three-tone preview using default luma range settings, and the image in 
three-tone preview with an expanded luma range.
Bottom: the Luma Ranges graph used to create the expanded midtones range.

The Channels Group
The Channels group provides controls that let you redefine each output color channel (red, green, 
blue) by blending different input color components in various proportions. 

You can work with components from both the RGB (red, green, blue) and the YCbCr (luminance, red 
chroma, blue chroma) color spaces. Because you can blend up to four input components to create 
each output color channel, the Channels group offers very precise control over the final composition 
of each color channel.

The Channels group also lets you preview the individual color channels in monochrome. This is 
useful for checking the amount of contrast or noise in each channel.

The Channels group is particularly useful for identifying a color channel that is deficient in some way 
— lacking in contrast, or noisy, for example — and repairing it by “borrowing” from another color 
channel. For some kinds of images, this is the only way to improve the appearance significantly.

For example, you might preview the input channels for a segment and notice that, although the 
master input shows acceptable overall contrast, the green channel is clipped to white and has 
therefore lost contrast in the highlight range. You cannot “unclip” these green highlights by working 
in the existing green channel because the brightness value of all the pixels in the highlight range is 
the same (or very nearly so). The best solution to this problem is to blend a percentage of one of the 
other channels into the green channel to reintroduce some contrast and detail. You might redefine the 
green channel as 80% green and 20% red to solve the problem.
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As in other groups, you can use the Color Match control to set the blending controls automatically, 
based on selected input and output colors. For information on the Color Match control, see “Using 
the Color Match Control” on page 634.

The following illustration shows the Channels tab in its default configuration.

Making Corrections Using the Channels Tab

To make corrections using the Channels tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

For more information, see “(Symphony Option) Selecting Correction Types” on page 604.

c. Click the Channels tab.

2. Preview the input image by selecting an input type in the Preview pane:

For more information on previewing options, see “Considerations When Working with Color 
Components” on page 658.

3. Adjust the blend for each channel in the Channel Blending pane.

For more information on using the Channel Blending pane, see “Using the Channel Blending 
Pane” on page 657.

4. Preview the output image by selecting an output type in the Preview pane:

Input Type Description

Red Input Displays the uncorrected red channel in monochrome.

Green Input Displays the uncorrected green channel in monochrome.

Blue Input Displays the uncorrected blue channel in monochrome.

Master Input Displays the complete uncorrected image in color.

Output Type Description

Red Output Displays the red channel in monochrome with the 
Channel Blending pane adjustments applied.

Green Output Displays the green channel in monochrome with the 
Channel Blending pane adjustments applied.
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5. Repeat steps 2 through 4 as necessary until you are satisfied with the result.

Remember that you can switch between Preview options at any time and that you can use the 
Enable buttons to turn each channel blending formula on and off or to reset it to its default 
values. For more information, see “Working with the Enable Buttons” on page 611.

Using the Channel Blending Pane

The Channel Blending pane contains a set of four text boxes and buttons for each of the three RGB 
color channels. Each button lets you select a component type to blend into the channel. Each text box 
lets you define the percentage of the component to use. You use these controls in combination to 
create a formula for the corrected color channel.

Components of a Channel blending control: left to right, Enable button, Channel text box, and Component Type button

To select a component type:

t Click the Component Type button, and select a type from the menu.

For information on the available options, see “Component Type Options in the Channels Tab” on 
page 658.

To adjust the amount of a component in the blend:

t Type a value in the text box for the component, and then press Enter (Windows) or Return 
(Macintosh). 

Values range from –200% to 200%. To set a component so that it has no impact on the blend, use 
a value of 0%.

For more information, see “Considerations When Working with Color Components” on 
page 658.

To change a component value by small increments:

t Click in the text box for the component, and then press the Up Arrow key to increase the value or 
the Down Arrow key to decrease the value.

To use the mouse scroll wheel to change a component value:

1. Click in the text box for the component.

2. Do one of the following:

t Press and hold the Ctrl key, and use the scroll wheel to change the value in small increments.

t Press and hold the Ctrl and Shift keys (or the Ctrl and Alt keys), and use the scroll wheel to 
change the value in increments of -10 or +10.

Blue Output Displays the blue channel in monochrome with the 
Channel Blending pane adjustments applied.

Master Output Displays the complete image in color with the 
Channel Blending pane adjustments applied.

Output Type Description
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Component Type Options in the Channels Tab

The following table describes the component type options available in the Channels tab of the Color 
Correction tool.

Considerations When Working with Color Components

When one of your color channels has a problem that you want to correct by blending, look for 
another color component that can correct the problem while minimizing any unwanted changes. In 
general, look for a component that exhibits less of the specific problem you want to correct but that 
otherwise looks similar to the problem channel.

You do not have to restrict your component choices to the same color space (RGB or YCbCr). In fact, 
it is common practice in advanced color correction to borrow from a different color space. For 
example, if a green channel is noisy in the highlight range, you might find that the Cb (blue chroma) 
component has less highlight noise but is otherwise similar in its brightness distribution to the green 
channel. You can blend a percentage of Cb into the green channel to reduce the noise without greatly 
disturbing other aspects of the channel.

You can preview the full range of color components available by temporarily redefining one of the 
existing channels. For example, if you want to see what the Cb component looks like in comparison 
to your problem green channel, you can redefine the red channel as 100% Cb. Then you can switch 
back and forth between the Red Input and Green Input previews to compare the two.

n The total of the percentages you set for a channel does not need to be 100. The percentage values 
simply indicate relative proportions of one component as opposed to others.

(Media Composer | Symphony Option) Examples of Channel Blending 
Settings

The following illustrations show two representative Channel Blending settings for the red channel.

Option Description

Red The input red channel.

Green The input green channel.

Blue The input blue channel.

Luma The luminance channel in the component video signal.

Cr The red chroma channel in the component video signal.

Cb The blue chroma channel in the component video signal.

Offset A constant value that adjusts all the other values in the formula.

Invert This option subtracts the component from the overall formula instead of adding it. Select 
one of the other options, and then select Invert to invert it. A minus sign (–) appears after 
the component name when it is inverted. This has the same effect as entering a negative 
value for a component: 20% Green – is the same as –20% Green.
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The following detailed example shows how an individual channel is altered by blending. 

The Blue Input monochrome preview shows that the blue channel lacks contrast. Blending 25% of 
the green channel information into the blue channel (as shown in the illustration of the controls) 
introduces somewhat more contrast into the blue channel.

The effect on the Master image in this case is not dramatic, and might or might not be desirable, 
depending on your project needs. There is a little extra detail in the lower half of the image, but the 
color characteristics have changed so that the image is less intensely yellow. This probably improves 
the look of the sky, but it reduces the strength of the yellow color in the sunflowers.

Top: Blue Input preview (left) and Blue Output preview (right). Center: blending settings. Bottom: Master Input preview 
(left) and Master Output preview (right).

(Media Composer | Symphony Option) The Levels 
Group

The Levels group lets you control the relative brightness or darkness of an image by defining the 
white point, gray point, and black point of video material.
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You can work with the master channel (red, green, and blue combined) or with each of the color 
channels. You can also control the white and black points only for the luminance range and for the 
composite signal to ensure your sequence is within legal limits. If you make adjustments in the 
master channel and in one or more of the other channels, the final output is the cumulative result of 
all the adjustments.

There are four ways to define the white, gray, and black points. You can:

• Type numerical values.

• Adjust sliders on a histogram control.

• Move control points on a ChromaCurve graph.

• Use the Color Match control to set points automatically, based on selected input and output 
colors.

For information on the Color Match control, see “Using the Color Match Control” on page 634.

The main use of the Levels group is to rebalance the color or luma range. The group provides precise 
control over the amount of contrast and detail visible in the video image, especially when you work 
with the individual color channels. The Levels group is a more refined and specialized version of the 
Gain, Gamma, and Setup controls in the HSL tab.

You might want to extend the range of contrast and detail in an image that lacks a full range (either in 
one color channel or across all the color channels), or you might want to deliberately reduce detail in 
part of the range (perhaps to expand another part of the range that is more important in the image). 
You might also want to adjust the gray point with respect to the black and white points in order to 
rebalance the midtones without significantly affecting the highlights and shadows.

It is important to understand the difference between enhancing detail with the Levels group and 
enhancing detail with a blending adjustment in the Channels group. If the green channel is clipped to 
white, it does not contain enough information to contribute much detail and you must repair it by 
borrowing contrast from another color component in the Channels group. If the green channel 
contains an acceptable range of tones but they are shifted toward the highlight end of the brightness 
range, resetting the black point in the Levels group improves contrast and detail by spreading the 
available information over a bigger range.

The following illustration shows the Levels tab in its default configuration.

Components of the Levels tab: left to right, Input histogram, ChromaCurve graph, Output histogram, Color Match control

Understanding Input and Output Levels Adjustments

Adjustments in the Levels tab change the relationship between input and output values for your 
image. You can make adjustments on both the input and the output side, and understanding the 
differences between input and output adjustments is important.
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Examples of Black Point Input and Output Adjustments

A typical default setup for the Levels tab shows the following values on both the input and the output 
side:

The black point and white point values represent normal, safe limits for video broadcast.

An adjustment on the input side changes the range of input values being mapped to the same range of 
output values. For example, if you move the black point up to 60, Media Composer maps all values 
of 60 or less to the output value of 16. As a result, input values between 60 and 235 are now mapped 
to the full output range of 16 to 235 (176 input steps on the 8-bit scale are mapped to 220 output steps 
on the 8-bit scale). This adjustment clips some black values, but spreads the remaining input values 
over a greater range. Depending on the exact nature of the image, this might improve contrast and 
detail.

The input and output values for this adjustment are as follows:

The following illustrations show the effect of this adjustment for a monochrome gradient and a video 
image.

Example of a Levels adjustment that changes the Input Black Point value to 60 (all other values are defaults): unadjusted 
images (top) and adjusted images (bottom)

Black Point Gray Point White Point

16 128 235

Black Point Gray Point White Point

Input 60 128 235

Output 16 128 235
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An adjustment on the output side changes the total range of output steps available. For example, if 
you leave the input points unchanged and change the output black point to 60, you deliberately 
reduce the range of values in the image (220 input steps are mapped to only 176 output values). The 
input and output values for this adjustment are as follows:

The following illustrations show the effect of this adjustment for a monochrome gradient and a video 
image.

Example of a Levels adjustment that changes the Output Black Point value to 60 (all other values are defaults): 
unadjusted images (top) and adjusted images (bottom)

Examples of Gray Point Input and Output Adjustments

Gray point adjustments work in a similar way to black and white point adjustments except that output 
gray point changes do not change the total output range. If you change the input gray point to 100 but 
keep all other values at their default setting, Media Composer maps input values from 16 to 100 to 
output values from 16 to 128, and input values from 100 to 235 to output values from 128 to 235. 
This brightens the image somewhat. The input and output values for this adjustment are as follows:

The following illustrations show the effect of this adjustment for a monochrome gradient and a video 
image. In the adjusted monochrome gradient, the mid-gray value moves toward the left.

Black Point Gray Point White Point

Input 16 128 235

Output 60 128 235

Black Point Gray Point White Point

Input 16 100 235

Output 16 128 235
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Example of a Levels adjustment that changes the Input Gray Point value to 100 (all other values are defaults): 
unadjusted images (top) and adjusted images (bottom)

If you change the output gray point to 100, you perform the opposite correction. Media Composer 
maps input values from 16 to 128 to output values from 16 to 100, and input values from 128 to 235 
to output values from 100 to 235. This darkens the image somewhat. The input and output values for 
this adjustment are as follows:

The following illustrations show the effect of this adjustment for a monochrome gradient and a video 
image.

Black Point Gray Point White Point

Input 16 128 235

Output 16 100 235
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Example of a Levels adjustment that changes the Output Gray Point value to 100 (all other values are defaults): 
unadjusted images (top) and adjusted images (bottom)

Making Corrections Using the Levels Tab

To make corrections using the Levels tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

For more information, see “(Symphony Option) Selecting Correction Types” on page 604.

c. Click the Levels tab.

2. Click the appropriate subdividing tab on the left side of the Color Correction tool.

n Controls in the Composite and Luma tabs work slightly differently from those in the other Levels 
tabs. For more information on working with the Composite and Luma tabs, see “Working with the 
Composite and Luma Tabs in the Levels Tab” on page 668.

3. Adjust the Levels controls until you are satisfied with the result.

Tab Description

Composite Lets you adjust high and low points for the composite signal to ensure 
that your sequence remains within legal composite limits.

Luma Lets you adjust levels based on luminance values only.

Red Lets you adjust levels for the red channel only.

Green Lets you adjust levels for the green channel only.

Blue Lets you adjust levels for the blue channel only.

Master Lets you adjust levels for all three color channels.
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For more information, see “Understanding the Levels Tab Controls” on page 665.

Understanding the Levels Tab Controls

The Levels controls are dynamically linked to one another. When you adjust one of the controls, the 
adjustment is reflected in all other appropriate controls. For example, if you change the input black 
point value in the text box, the histogram slider and the control point for black on the ChromaCurve 
graph change.

Understanding Histograms

A histogram is a graphical representation of the color values of all the pixels in an image. The 
horizontal axis of the graph represents color values and the vertical axis represent the number of 
pixels. For example, if an image contains 120 pixels of color value 30, then a bar 120 units high 
appears at the 30 point along the horizontal axis. A background grid indicates the quartile points on 
each axis.

Histograms provide an easily understood summary of the color range of an image. If an image is 
mostly dark, the bars of its histogram are concentrated at the low end. If an image contains only a 
small number of discrete color values, its histogram shows discrete spikes for each of those values. 
The following illustrations show several examples of histogram patterns.

Histogram example 1: In the image, large areas are very dark, and the remainder of the brightness range is relatively 
evenly distributed. The histogram shows a sharp spike at the very low end, a concentration of values in the lowest 
quartile of the graph, and a relatively even distribution in the rest of the range.

Histogram example 2: In the image, there are more dark values than light, but the distribution of values is less extreme 
than in example 1. The histogram shows a more rounded peak at the low end than example 1, fewer extremely low 
values, and relatively more midtone values.
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Histogram example 3: In the image, there are very large highlight areas in the background and on the chicks. Most of the 
rest of the image is relatively, but not extremely, dark. The histogram shows sharp spikes at the high end, relative 
concentration in the low to middle range, and few values in the middle to high range.

Understanding ChromaCurve Graphs

A ChromaCurve graph shows the relationship of input values (on the horizontal axis) to output values 
(on the vertical axis). The graph in the Levels tab has three control points for manipulating black, 
gray, and white points. A background grid indicates the quartile points on each axis.

The following illustration shows the Levels tab Curve graph.

Default Levels tab ChromaCurve graph with control points for white (top), gray (center), and black (bottom)

The default curve (before you make any adjustments) is an ascending 45 degree straight line, because 
input and output values are the same across the entire range. (In the previous illustration, the line of 
the graph is horizontal for the extreme low and high values because of standard video limiting. Media 
Composer maps all input values of 16 an d below to an output value of 16, and all input values of 235 
and above to an output value of 235.)

An adjustment that moves part of the line below the 45 degree angle makes the output values for that 
part of the image lower than the input values. An adjustment that moves part of the line above the 45 
degree angle makes the output values for that part of the image higher than the input values.

If you make an extreme adjustment to a curve so that it becomes a horizontal line, you are converting 
all input values to the same output value.

For example, in the following illustration, Media Composer maps all input values to an output value 
of 128. When you make this adjustment across all three color channels, the result is a uniform, mid-
gray image.
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When you make less extreme adjustments, Media Composer calculates a true curve based on the 
values of the control points and their positions with respect to one another. For example, if you move 
the control point for gray, the white point and black point remain in the same positions. Media 
Composer calculates intermediate values along the curve based on the relative position of the new 
gray point with respect to the white and black points. The following illustration shows this behavior 
for a typical gray point adjustment.

ChromaCurve graph for a typical gray point adjustment. Because of the exact position of the gray point, the curve is 
steeper near the black point and somewhat shallower near the white point. The adjustment therefore boosts values in the 
lower half somewhat more than in the upper half. One benefit of this is that values near the white point receive some 
adjustment but are not clipped to white.

Using the Controls in the Levels Tab

To set black, white, and gray points with the histogram sliders:

t Click the appropriate triangular slider below the histogram, and drag it to its new position.

Sliders below a histogram control: Black Point (left), Gray Point (center), and White Point (rigtht)

For example, if you want to move the input black point toward gray, click the Black Point slider 
and move it to the right.

When you adjust the input controls, the input histogram does not update. The input histogram 
always shows the distribution of values for the uncorrected image. The appropriate text box, the 
ChromaCurve graph, and the output histogram do update.
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To set black, white, and gray points with the histogram text boxes, do one of the following:

t Type a numerical value in the appropriate text box, and then press Enter (Windows) or Return 
(Macintosh).

Text boxes below a histogram control: Black Point (left), Gray Point (center), and White Point (rigtht)

For example, if you are working with 8-bit values and you type 50 in the In Black Point text 
box, you set the black point to 50 on a scale from 0 to 255.

t Click in the appropriate text box, and then press the Up Arrow key to increase the value or the 
Down Arrow key to decrease the value by small increments.

To set black, white, and gray points with the mouse scroll wheel:

1. Click the appropriate slider or click in the appropriate text box.

2. Do one of the following:

t Press the Ctrl key and use the scroll wheel to change the value in small increments.

t Press the Ctrl and Shift keys (or the Ctrl and Alt keys) and use the scroll wheel to change the 
value in increments of -10 or +10.

To adjust a control point in the ChromaCurve graph:

t Click a control point, and drag it to a new position.

When you click a control point, a circle appears around it to indicate that it is selected.

Working with the Composite and Luma Tabs in the Levels Tab

The Composite tab shows histograms that represent the levels in the composite image before and 
after correction. The Luma tab shows histograms that represent the luminance levels in the image 
before and after correction. They are useful for checking whether your color-corrected images are 
within the composite and luminance limits you need to meet and for adjusting levels to meet those 
limits.

The Composite tab displays unit information in either IRE units or millivolts, depending on which 
option you select in the Correction Mode Settings dialog box. The Luma tab displays unit 
information in a broader range of unit types. For more information, see “Customizing Color 
Correction Mode Settings” on page 614.

You can make only black point and white point adjustments in the Composite and Luma tabs. By 
adjusting these two points, you can bring any values that exceed your composite or luminance limits 
back into an acceptable range.

The following illustration shows the controls for the Composite histogram and Curve graph.
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Composite histogram and ChromaCurve graph: only Black Point and White Point controls appear

You can use the Composite and Luma tabs together with the Safe Color feature to ensure that your 
images remain within limits. If you set the Safe Colors feature to warn you when material exceeds 
composite and luminance limits, parts of the image that exceed the limit appear orange in the 
histograms and you can use these warnings to guide your adjustments. 

Examples of Levels Adjustments

The following illustrations show some common levels adjustments. The first example adjusts white, 
black, and gray points to create a small but significant change in the amount of contrast available in 
the image. The second example adjusts only the gray point to greatly increase the amount of visible 
detail.

Unadjusted image (top left), adjusted image (top right), and adjustment display in the Levels tab.

This example enhances the contrast between the white building exterior and the black building 
interior toward which the car is driving. The adjustment sets the input black point to 19 and the input 
white point to 206, which increases the contrast range. These settings leave the entire image a little 
dark and lacking in detail, so the adjustment also changes the gray point to place more of the overall 
tonal range between gray and white. The final image shows strong contrast between the lightest and 
darkest areas and sharp highlights around the letters in the foreground.
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Unadjusted image (top left), adjusted image (top right), and adjustment display in the Levels tab.

This examples uses a gray point adjustment to substantially increase the proportion of the tonal range 
that lies between gray and white. This reveals a lot more detail in the image, such as the lettering on 
the wall at the extreme right.

The Curves Group
The Curves group contains four ChromaCurve graphs that let you control color and luminance by 
placing up to sixteen control points on a graph and then adjusting the points. For more information on 
ChromaCurve graphs and how they operate, see “Understanding ChromaCurve Graphs” on 
page 671.

(Symphony Option) The ChromaCurve graphs in the Curves tab are similar to those in the Levels tab, 
except that they let you add up to 16 control points. With 16 control points, you can control color 
with great precision in the Curves tab because you can adjust many different subdivisions of the 
brightness range. As in the Levels tab, you can control the master channel or any individual color 
channel.

(Symphony Option) By default, ChromaCurve graphs in the Curves tab display as a graph line 
plotted through a set of control points. You can also choose to display color backgrounds in the 
Curves tab ChromaCurve graphs that help you to understand the effect of an adjustment as you work. 
For more information, see “Customizing Color Correction Mode Settings” on page 614.

The Curves tab also contains four slider controls — Master Saturation, Master Gain, Master Gamma, 
and Master Setup. These sliders work in exactly the same way as the Saturation, Gain, Gamma, and 
Setup sliders in the HSL group, so you can make some HSL-type adjustments without leaving the 
Curves tab. When you adjust any of these sliders, you enable the equivalent slider in the HSL group 
and the tab hierarchy containing it. For more information on the function of these controls, see 
“Controls Tab Reference” on page 643 and “Hue Offsets Tab Reference” on page 649.
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The Curves tab also contains automatic color correction buttons that adjust one or more of the 
ChromaCurve graphs automatically, and the Color Match control, which lets you automatically add 
or modify a control point based on selected input and output colors. For more information, see 
“Using Automatic Color Corrections” on page 627 and “Using the Color Match Control” on 
page 634.

For examples showing how various curves affect an image, see “Examples of ChromaCurve Graph 
Adjustments” on page 675.

The following Symphony Option sample illustration shows the Curves tab.

Understanding ChromaCurve Graphs

A ChromaCurve graph shows the relationship of input values (on the horizontal axis) to output values 
(on the vertical axis). A background grid indicates the quartile points on each axis.

The following illustration shows the Red ChromaCurve graph.

The default curve (before you make any adjustments) is an ascending 45 degree straight line, because 
input and output values are the same across the entire range. The control points for the two ends of 
the curve are set by Media Composer, but you can change their location.

If you make an adjustment that moves part of the line below the 45 degree angle, you make the output 
values for that part of the image lower than the input values. If you make an adjustment that moves 
part of the line above the 45 degree angle, you make the output values for that part of the image 
higher than the input values.

If you make an extreme adjustment to a curve so that it becomes a horizontal line, you are converting 
all input values to the same output value of 128. When you make this adjustment across all three 
color channels, the result is a uniform, midgray image.
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When you make less extreme adjustments, Media Composer calculate a true curve in the graph based 
on the values of the control points and their positions with respect to one another.

In each of the Red, Green, and Blue ChromaCurve graphs, the background color indicates what color 
in the image changes when a curve passes through that part of the graph. The upper left corner of the 
graph is the color of the graph name (red, green, blue) and represents complete saturation in that 
color. The lower right corner of the graph is the complementary color (cyan, purple, yellow). The 
upper right corner is white and the lower left corner is black.

The Master ChromaCurve graph controls overall luminance in the image. The grayscale tone of its 
background indicates the luminance range that is affected by that part of the graph but does not 
directly indicate the result of an adjustment. Adjustments that move parts of the graph above the 
default 45 degree angle make those areas of the image brighter. Adjustments that move parts of the 
graph below the default 45 degree angle make those areas of the image darker.

For examples showing how various curves affect an image, see “Examples of ChromaCurve Graph 
Adjustments” on page 675.

Making Corrections Using the Curves Tab

To make corrections using the Curves tab:

1. If you have not already done so:

a. Move the position indicator to the segment you want to correct.

b. (Symphony Option) Click the Correction Type button and select a correction type.

For more information, see “(Symphony Option) Selecting Correction Types” on page 604.

c. Click the Curves tab.

2. Do one or more of the following:

t Use one or more of the automatic color correction buttons to adjust the ChromaCurve 
graphs.

For more information, see “Adjusting Contrast and Balance Automatically” on page 629 and 
“Using the Remove Color Cast Buttons” on page 632.

t Use the Color Match control to adjust the ChromaCurve graphs.

For more information, see “Using the Color Match Control” on page 634.

t Adjust the ChromaCurve graphs manually, either by clicking and dragging to add and move 
control points or by entering values in the Input and Output text boxes, until you are satisfied 
with the results.
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For more information, see “Adjusting ChromaCurve Graphs” on page 673.

t Adjust the Master Saturation, Master Gain, Master Gamma, or Master Setup slider controls.

For more information, see “Controls Tab Reference” on page 643 and “Hue Offsets Tab 
Reference” on page 649.

Adjusting ChromaCurve Graphs

You can have sixteen control points in a Curves tab ChromaCurve graph. Graphs must always have at 
least two control points. Media Composer sets default control points such that input and output 
values are the same across the entire range of colors.

To add a control point:

t Click the curve line in the graph at the point where you want the new point to appear.

A new control point appears with a circle around it to indicate that it is the active control point.

To select a control point:

t Click the control point you want to select.

A circle appears around the control point to indicate that it is the active control point.

Active control point (top) and inactive control point (bottom)

To move a control point, do one of the following:

t Click the control point and drag it to the location on the graph where you want to place the point.

The curve updates as you drag the control point.

t Type input and output values for the position of the control point in the Input and Output text 
boxes below the ChromaCurve graph. You must press Enter (Windows) or Return (Macintosh) 
after typing a value for it to take effect.
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Selected control point at 100 on the input (horizontal) axis and at 69 on the output (vertical) axis

t Click in one of the text boxes, and then press the Up Arrow key to increase the value or the Down 
Arrow key to decrease the value by small increments.

t Click in one of the text boxes, then use the mouse scroll wheel to change the value by small 
increments.

t Click in one of the text boxes, then press the Shift key and use the mouse scroll wheel to change 
the value by increments of -10 or +10.

To delete a control point:

1. Select the control point you want to delete.

A circle appears around the control point.

2. Make sure the pointer is over the ChromaCurve graph that contains the control point you want to 
delete.

3. Press the Delete key.

n A curve requires at least two control points. If you have only two control points set in a ChromaCurve 
graph, you cannot delete one.

To anchor part of a curve so it does not move when you make other adjustments:

1. Place two control points at either end of the part of the curve you want to anchor.

2. Place a third control point very close to the point that separates the portion of the curve you want 
to anchor from the portion of the curve you want to adjust.

3. Place a fourth control point on the portion of the curve you want to adjust.

Example of anchoring part of a curve. The bottom two control points define the part of the curve you want to anchor. 
The third point (immediately above the second) lets the rest of the curve adjust. Drag the fourth point (selected) to 
adjust the upper part of the curve.

When you drag the new control point to adjust the curve, the portion of the curve between the 
first two control points does not move.
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ChromaCurve Graphs and the Color Match Control

When you use the Color Match control in the Curves tab, a gray crosshair marker appears in each 
appropriate ChromaCurve graph to mark the intersection of the input value defined by the input color 
swatch in the Color Match control and the output value defined by the output color swatch.

When you click the Match Color button, Media Composer adds a new control point and updates the 
ChromaCurve graphs to reflect the color match. If you are not using NaturalMatch or if you have not 
adjusted the ChromaCurve graphs previously, the new control point appears at the location of the 
crosshair marker. If you are using NaturalMatch or if you have already adjusted the ChromaCurve 
graphs, Media Composer makes a more complex calculation to reflect the input saturation and 
luminance values or to take earlier ChromaCurve graph adjustments into account. In these cases, the 
new control point does not appear at the location of the crosshair marker.

The following illustrations show this behavior both before and after you click the Match Color 
button.

The crosshair marker on the Green ChromaCurve graph (left) represents the values for Green in the color swatches 
(center) — Input 131, Output 105. Because R+G+B is selected as the Match Type, similar crosshair markers appear in 
the Red and Blue graphs also. When you click the Match Color button, Media Composer creates a new control point and 
updates the curve to reflect the color match (right). For this example, NaturalMatch is selected and the calculation is not 
complicated by other control points, so the new point is created at the exact location of the crosshair marker. The Green 
input and output values from the color swatches appear in the Input and Output text boxes below the graph.

Examples of ChromaCurve Graph Adjustments

The following illustrations show a series of simple adjustments that use the Red ChromaCurve graph 
in the Curves tab. You can compare the results of these adjustments to learn how curves control color 
across different parts of the brightness range.

Each example shows the new corrected image, the curve that produces it, and one other image from 
the series for comparison.
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In each example, the background color behind the control point represents the color change to the 
image. In the first example, the curve passes through the darker cyan area, which reduces reds in the 
darker parts of the image. In the second example, the curve passes through the lighter cyan area, 
which reduces reds in the lighter areas of the image.

Uncorrected image (left) and result of adjustment 1 (right)

Adjustment 1 reduces red primarily in the shadows range (the lower part of the curve). Much of the 
red tone is lost from the background grass, the shirt, and the lower red signpost. The shirt loses much 
of its detail. The higher red signpost is relatively less desaturated, however, and some of the red 
highlights are still present on the clouds in the top right.
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Image from adjustment 1 (left) and result of adjustment 2 (right)

Adjustment 2 reduces red primarily in the highlights range (the upper part of the curve). The 
differences between this adjustment and adjustment 1 are most apparent in the lower signpost, which 
retains more redness and detail, and in the background, where the crop in the lower right retains more 
red tones, but the clouds in the top right have lost their red highlights.

Image from adjustment 2 (left) and result of adjustment 3 (right)
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Adjustment 3 reduces red more evenly across the entire luminance range but with the largest change 
in the midtones. The differences between this adjustment and adjustment 2 are subtle. The strong 
midtone reduction in red is most noticeable in the skin tones, which appear more gray than in either 
adjustment 1 or adjustment 2. However, adjustment 3 retains both some detail in the lower signpost 
and some of the red highlights on the clouds.

Image from adjustment 3 (left) and result of adjustment 4 (right)

Adjustment 4 boosts red evenly across the entire luminance range but with the largest change in the 
midtones. Here the difference from adjustment 3 is obvious throughout the image. The most extreme 
differences appear in the midtone range, for example, in the hands.
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Image from adjustment 4 (left) and result of adjustment 5 (right)

Adjustment 5 boosts red primarily in the highlights range. The most noticeable difference is in the 
crop in the background. In adjustment 4, which boosts red more in the lower ranges, the crop looks 
more orange. In adjustment 5, which boosts red very little in the shadows range, the crop looks more 
yellow-green.

Image from adjustment 5 (left) and result of adjustment 6 (right)
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Adjustment 6 boosts red primarily in the shadows range. In comparison with adjustment 5, there is 
much more red and orange in the darker parts of the image (for example the crop in the lower right 
and the lower part of the shirt). The clouds, however, have much less of a red highlight.

(Media Composer | SymphonyOption) The Secondary 
Group

Secondary color correction lets you adjust parts of an image defined by hue and saturation values in 
real time. You can make secondary adjustments to a single segment or to multiple segments that you 
define by setting Source or Program relationships.

Secondary color correction works best when the range of colors that you want to change in an image 
is isolated in the area or object that you want to change and does not appear elsewhere in the image. 
For example, you can use secondary color correction to change the look of a sky as long as the blue 
tones of the sky are not present elsewhere in the image.

If you want to change the colors in part of an image without affecting any other part of the image in 
any way, you can use the Spot Color effect or certain modes in the Paint Effect to isolate part of the 
image using drawing tools, and then color correct that part only. For example, if a clip shows three 
red cars and you want one of the cars to be a different color, you could use the Spot Color effect. For 
more information, see “(Media Composer | Symphony Option) Spot Color Correction” on page 748.

The following illustration shows a typical example of a secondary color correction. The original 
color of the turban is changed with virtually no alteration to the color characteristics of other parts of 
the image.

Before (left) and after (right) a typical secondary color correction

Understanding Secondary Color Correction

The Secondary group provides controls for making hue and saturation adjustments to as many as 
twelve distinct parts of the full color range in an image.

Secondary color correction is most useful for images in which the following two circumstances 
apply:

• You want to change the color characteristics of some parts of the image without altering the rest 
of the image in any way.

• The parts of the image that you want to change have hue and saturation values that are absent or 
nearly absent from the rest of the image.
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For example, you might have a shot of a person wearing a bright yellow scarf. After earlier stages of 
color correction, you like the look of the image, but the scarf remains too bright. You can use 
secondary color correction to select the bright yellow of the scarf and then make an adjustment to 
change the yellow color. Media Composer only adjusts the bright yellow pixels in the image. As long 
as no other parts of the image are bright yellow, the correction changes the color of the scarf and 
preserves the rest of the image untouched.

The following illustration shows the Sec (Secondary) tab in its default configuration.

Secondary Color Correction Workflow

The workflow for secondary color correction differs slightly from that for other color correction 
groups because you make corrections in two distinct stages. In the first stage, you define the range of 
color in the image that you want to alter using the Input Vector controls, the Color Selection buttons, 
or the Color Match control. In the second stage, you change the hue and saturation values of the 
defined range of color using the Output Vector controls or the Color Match control.

The following procedure lists the main steps involved in making a secondary color correction and 
provides cross-references to detailed information on each step.

1. In Color Correction mode, ensure that you have selected the track in which you want to make the 
correction. 

2. Click the Sec (Secondary) tab.

3. Select a correction type to control the scope of the correction.

For more information, see “(Symphony Option) Selecting Correction Types” on page 604.

4. Move the position indicator to the segment you want to correct.

5. Select a predefined color vector as a starting point for defining the color range you want to 
correct.

For more information, see “Understanding Secondary Color Correction Vectors” on page 682 
and “Selecting Vectors” on page 687.

1 Output Vector controls 5 Selected Vectors panel

2 Input Vector controls 6 Color Match control

3 Input Vector color wheel 7 Color Selection buttons

4 Output Vector color wheel 8 Color Correction buckets

1 

2 3 4 5

6

7

8
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6. Adjust the input values of the vector until it corresponds to the color range you want to correct.

For more information, see “Adjusting Input Vector Values” on page 687.

7. (Option) As an alternative to steps 5 and 6, use the Color Selection buttons to select, enable, and 
adjust an input color vector based on colors that you sample from the image.

For more information, see “Using the Color Selection Buttons” on page 690.

8. Correct the color range you have defined by adjusting the output values of the vector.

For more information, see “Adjusting Output Vector Values” on page 693.

You can also use the Color Match control to quickly make a correction based on input and output 
color values that you select, and then fine-tune the correction using Input and Output Vector controls. 
For more information, see “Using the Color Match Control for Secondary Corrections” on page 694.

Understanding Secondary Color Correction Vectors

Secondary color correction uses the concept of color vectors. A vector is a subset of the full color 
range in an image. When you work in the Secondary group, you select a predefined vector as a 
starting point, adjust the vector so that it represents the exact color range you want to correct, and 
then change the color characteristics of that vector.

Standard and Custom Vectors

Media Composer provides twelve predefined color vectors. The first six are standard vectors that 
represent the following major colors: Green, Yellow, Red, Magenta, Blue, Cyan. The remaining six 
are custom vectors that represent more narrowly defined colors. Custom vectors are useful starting 
points for common corrections (for example, blues that you can easily customize to define the sky 
color in an image).

Vector Display in Color Wheels

The Secondary tab displays vectors graphically in color wheels similar to the ChromaWheel color 
wheels in the Hue Offsets tab of the HSL group. In these displays, the full wheel represents the 
complete range of possible hue and saturation values, and each vector appears as a distinct area 
within the wheel. For more information on the color wheels and how they represent hue and 
saturation values, see “Understanding ChromaWheel Color Wheels” on page 646.

The following illustration shows a color wheel that displays all the available color vectors.

Each vector has a boundary line and a center point. The center point marks the base hue and 
saturation values for the vector, while the boundary line indicates the range of hue and saturation 
values that the vector contains. Center points for standard vectors are filled circles. Center points for 
custom vectors are crosshairs.
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The hue range of a vector is represented by the arc of the wheel that it covers, and the saturation 
range of a vector is represented by the part of the wheel’s radius that it covers.

The exact range of values in a vector is also related to its shape. Standard vectors always appear as 
wedges — they have no upper saturation limit, and their hue ranges are constant regardless of the 
saturation level. Custom vectors always appear as ellipses — their saturation ranges are fully 
adjustable, and their hue ranges scale with the saturation level.

The following illustrations show how to interpret the hue and saturation ranges of a vector from its 
color wheel display.

Examples of hue ranges. Top: detail of the standard Red vector, which extends for 30 degrees of arc — 15 degrees 
either side of pure red. A narrower arc reduces the vector to a smaller range of reds. A wider arc expands the vector to 
include more yellow and magenta hues. Center, left to right: Red vectors of the standard width (30 degrees of arc), of 
reduced width (10 degrees of arc), and of expanded width (60 degrees of arc). Bottom, left to right: the color ranges 
defined by each of the three vectors in the center, with the rest of the color wheel shown as grayscale.
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Examples of saturation ranges. Top: detail of a custom vector (number 3 in the Selected Vectors panel), which has a 
default saturation value of 35 and saturation width of 40. Its range excludes extremely low saturation levels and a wide 
range of high saturation levels. A smaller saturation width would reduce the range of color intensity included in the vector. 
A larger saturation width would expand the range of color intensity. Center, left to right: Custom vectors of the default 
saturation width (40), of reduced width (15), and of expanded width (80). Bottom, left to right: the color ranges defined by 
each of the three vectors in the center, with the rest of the color wheel shown as grayscale.

Customizing the Display of Secondary Color Correction Vectors

To customize a vector display:

1. Open the Correction Mode Settings dialog box by doing one of the following:

t Select File > Settings, click the User tab and double-click Correction.

t In the Color Correction tool, click the Correction Mode Settings button.

The Correction Mode Settings dialog box opens.

2. Click the Features tab.

3. Click the Secondary Vectors menu, and then select an option.
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Secondary Vectors menu in the Features tab of the Correction Mode Settings dialog box

For more information, see “Options for Secondary Color Correction Vector Display” on 
page 685.

4. Click OK.

Options for Secondary Color Correction Vector Display

The following table describes available options in the Secondary Vectors menu in the Features tab of 
the Correction Mode Settings dialog box.

Option Description Display in Color Wheels

Show All Shows all twelve vectors in the color wheels 
of the Secondary tab.

Show Standard Shows the six standard vectors (Green, 
Yellow, Red, Magenta, Blue, Cyan) in the 
color wheels of the Secondary tab. This 
setting also shows custom vectors that are 
enabled. This is the default setting.
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Understanding the Selected Vectors Panel

The Selected Vectors panel provides controls that let you select or enable individual vectors. 

In addition, the Selected Vectors panel contains the following options:

• Invert Last Vector: When this option is selected, Media Composer inverts the effect of the 
enabled vector furthest to the right in the Selected Vectors panel. When you invert a vector, you 
apply the adjustment to all parts of the image except those parts defined by the vector. For more 
information, see “Inverting a Vector” on page 695.

• Isolate: When this option is selected, Media Composer isolates the selected vector in the image 
by displaying all other parts of the image as grayscale.

You can use Isolate both as a preview feature and as an effect in its own right. While you are 
making a secondary color correction, you can select Isolate to see the extent of a vector more 
clearly. If you leave Isolate selected as part of a finished secondary color correction, you create a 
special secondary color correction that isolates one color range while displaying the rest of the 
image as grayscale. For more information, see “Isolating the Selected Vector” on page 692.

The following illustration shows the Selected Vectors panel with the Green vector selected.

Components of the Selected Vectors panel in the Secondary tab. Top to bottom: vector names (standard on the left, 
custom on the right), color swatches, Enable buttons, and the Invert Last Vector and Isolate check boxes.

The color swatches for each vector in the Selected Vectors panel update in real time to provide a 
visual indication of the defined color range for the vector. The following illustrations show this 
behavior for the Red vector color swatch.

Show Custom Shows the six custom (elliptical) vectors in 
the color wheels of the Secondary tab. This 
setting also shows standard vectors that are 
enabled.

Show Enabled Shows only those vectors that are currently 
enabled in the Selected Vectors panel. The 
illustration shows the Red standard vector 
and one custom vector.

Option Description Display in Color Wheels
686



(Media Composer | SymphonyOption) The Secondary Group
Default Red vector color swatch (left) and Red vector color swatch after hue is adjusted to +20 degrees (toward 
magenta)

Selecting Vectors

You must select a vector to make an adjustment. Any adjustments that you make using controls in the 
Secondary tab apply to the currently selected vector.

To select a vector, do one of the following:

t Click the center point of the vector in the color wheel.

t Click the vector’s color swatch in the Selected Vectors panel. 

For more information, see “Understanding the Selected Vectors Panel” on page 686.

t Use the syringe to define an input vector.

Media Composer automatically selects, enables, and adjusts the appropriate vector based on the 
colors you sample. For more information, see “Using the Color Selection Buttons” on page 690.

A white box appears around the color swatch for the selected vector in the Selected Vectors 
panel, and the selected vector appears highlighted in the color wheels.

Enabling, Disabling, and Resetting Vectors

You can enable and disable vectors in any combination using Enable buttons. Enable buttons for 
vectors function in the same way as Enable buttons elsewhere in the Color Correction tool. You can 
also use a vector’s Enable button to quickly reset the vector to its default values. For more 
information on Enable buttons, see “Working with the Enable Buttons” on page 611.

To enable or disable a vector, do one of the following:

t Click the vector’s Enable button in the Selected Vectors panel.

t Use the syringe to define an input vector.

Media Composer automatically selects, enables, and adjusts the appropriate vector based on the 
colors you sample. For more information, see “Using the Color Selection Buttons” on page 690.

Enable buttons are gray when the associated vector is disabled.

To reset a vector:

t Alt+click (Windows) or Option+click (Macintosh) the vector’s Enable button in the Selected 
Vectors panel.

Media Composer resets the vector to its predefined values.

Adjusting Input Vector Values

Secondary color correction lets you adjust vector values using several different kinds of controls. You 
can also use Isolate to select a preview display that makes it easy to see what parts of an image are 
included in a vector.

To adjust an input vector:

1. Select the vector you want to adjust.

For more information, see “Selecting Vectors” on page 687.
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2. Adjust the vector by doing one or more of the following:

t Manipulate the vector directly in the Input color wheel by dragging its center point.

As you drag the center point around in the color wheel, the Hue and Saturation sliders 
update to show the current hue and saturation values, and the vector’s color swatch updates 
in the Selected Vectors panel to show the currently selected color.

t Adjust the input sliders.

For more information, see “Input Vector Sliders” on page 688.

t Select colors from the image using the syringe and eyedroppers.

For more information, see “Using the Color Selection Buttons” on page 690.

You might want to lock the vectors at some stage in the adjustment process to prevent the output 
image from showing premature color changes while you fine-tune your input vector. For more 
information, see “Locking Vectors While Adjusting an Input Vector” on page 689.

3. As you make your adjustments, use the Isolate feature to verify what parts of the image are 
currently defined by the vector. For more information, see “Isolating the Selected Vector” on 
page 692.

Input Vector Sliders

The Input Vector sliders work in exactly the same way as other sliders in the Color Correction tool, 
for example, those in the HSL group. For more information, see “Using the Sliders in the Controls 
Tab of the HSL Group” on page 643.

The following table describes the individual sliders available for input vectors.

Control Description

Hue Shifts the hue value for the center point of the vector around the color wheel. On the 
default Degree unit scale, 0 (the center point of the slider) represents red and –180 or 180 
(the end points of the slider) represents cyan.

Saturation Shifts the saturation value for the center point of the vector between the center and the 
outer edge of the color wheel. On the default Percent unit scale, 0 represents no saturation 
(the center of the wheel) and 100 represents full saturation (the outer edge of the wheel).

Hue Width Sets the hue range of the vector. On the default Degree unit scale, values represent the 
number of degrees of arc that the vector covers on the color wheel. The Hue value is the 
midpoint of the arc. For standard vectors, values range from 0 to 180. For custom vectors, 
values range from 0 to 100.

Saturation Minimum 
(standard vectors)

Saturation Width 
(custom vectors)

For standard vectors, sets the minimum saturation value for the vector. Pixels in the image 
below the saturation minimum are not included in the vector even if their hue value is 
within the vector’s hue width.

For custom vectors, sets the saturation range of the vector. On the default Percent scale, 
values represent the saturation range as a percentage of the maximum saturation width. 
For example, a vector with Saturation Width 40 extends across 40% of the full saturation 
range. Pixels in the image outside this saturation range are not included in the vector even 
if their hue value is within the vector’s hue width.
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Locking Vectors While Adjusting an Input Vector

You can lock the Hue and Saturation controls for Input and Output vectors together. When you lock 
the vectors, any changes you make to the Input Hue and Saturation values (either by adjusting the 
sliders or by dragging the vector in the vector wheel display) are matched by equivalent changes to 
the Output Hue and Saturation values.

Locking vectors lets you avoid the impression that you are correcting your image prematurely (and 
inaccurately). The image in the monitor does not show any false color changes while you are 
manipulating the Input vector. This is especially useful if you are demonstrating corrections for a 
client, who might be confused by seeing inaccurate color changes while you are setting up an input 
vector.

A typical workflow for making a secondary color correction using Lock Vectors might include the 
following steps:

1. Define an initial color range for the Input vector, for example by using the Syringe.

2. Turn on Lock Vectors, and fine-tune the hue and saturation values for the Input vector, for 
example by dragging the Input Hue and Saturation sliders.

Because the input and output vectors are locked together, the adjustments do not change the 
output colors in the monitor.

3. Turn off Lock Vectors, and adjust the Output vector until the color range provides the finished 
color you want.

4. (Option) If you need to fine-tune the whole correction further but do not want to change the color 
shift that you have established from Input to Output values, turn on Lock Vectors and shift the 
vectors slightly by dragging in the vector wheel display.

To lock Input and Output Hue and Saturation controls together:

t Click Lock Vectors (below the Hue and Saturation sliders).

Softness Sets a softness value for the vector. Values range from –255 to 255.

Positive values blend the corrected color into areas of the image beyond the limits of the 
defined input vector. The higher the value, the further into adjacent color values the blend 
extends.

Negative values blend the uncorrected color into parts of the area defined by the input 
vector. The higher the value, the more of the uncorrected color is retained in the input 
vector area.

When Softness is set to 0, the correction has a hard edge at the limit of the defined input 
vector. The default Softness setting of 30 creates a soft edge without extending the 
corrected color significantly outside the defined input vector.

For illustrations of the effect of various Softness settings, see “Examples of Softness 
Adjustments” on page 690.

Control Description
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Examples of Softness Adjustments

Softness is an important control for fine-tuning the effect of a secondary correction on an image. You 
can control the appearance of the transitional areas between a corrected part of the image and the rest 
of the image. You can also quickly compensate for inaccuracies in the input vector definition by 
expanding or contracting the color range over which the correction has an effect.

The following illustrations show the effect of a range of Softness adjustments on a test image.

Top: original image (left), and adjusted image with Softness set to 0 (right). The image is a radial gradient from green to 
red, and the adjustment shifts the Hue on the default Green vector by 180 degrees on the color wheel. This change the 
strongly green area near the center of the image to magenta.
Bottom: The same adjustment as it appears with Isolate selected in the Secondary tab so that the limits of the 
adjustment are easy to see. When Softness is set to 0 (left), the correction has a hard edge, and no blended color 
appears outside the area defined by the input vector. When Softness is set to the default value of 30 (right), the 
correction blends slightly into adjacent areas of the image. The outside edge appears green because the uncorrected 
color is dominant in the blend at the edge of the area affected by the correction.

Further examples of Softness adjustments. Left to right: Softness is set to 128, to 255 (maximum positive value), to -128, 
and to -255 (maximum negative value). As positive values increase, the correction expands into more of the surrounding 
color and the blend from magenta back to green is more easily visible. At the maximum positive value, the correction 
affects an area substantially larger then the area defined when Softness is 0, but the area that is 100% corrected color 
(magenta) remains the same. As negative values become more negative, the blended area retreats within the limits of 
the original input vector. At the maximum negative value, almost all of the original input vector is affected by a blend of 
uncorrected and corrected color.

Using the Color Selection Buttons

You can use the Color Selection buttons to select, enable, and adjust a vector by sampling colors from 
an image. Three sampling tools let you define an initial color vector and then fine-tune the vector by 
adding to or subtracting from the defined color range.
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You can use the Color Selection buttons together with the Color Match control to quickly perform a 
complete secondary color correction. For more information, see “Using the Color Match Control for 
Secondary Corrections” on page 694.

You can also use the Color Selection buttons to refine the definition of an existing vector by sampling 
colors within or adjacent to that vector.

The following illustration shows the Color Selection buttons.

Left to right: Syringe button, Add to Selection button, and Subtract from Selection button in the Secondary tab

Defining a Vector with the Syringe

To define a vector using the syringe:

1. Click the Syringe button to highlight it.

n The Syringe button remains selected until you explicitly turn it off by clicking it or by clicking one of 
the other Color Selection buttons. You can perform repeated operations with the syringe without 
having to reactivate it for each operation.

2. Move the pointer over the image in the active monitor.

The pointer changes to a syringe.

3. Drag the tip of the syringe over the area of color you want to sample.

Media Composer samples every color value that the tip of the syringe passes over. The input 
color swatch in the Color Match control updates as you drag the syringe to show the most 
recently sampled color. 

Try to cover the area that you want to sample as fully as possible, but take care not to stray 
outside that area. Remember that you can make further refinements to the vector after 
completing the initial selection.

4. When you have finished sampling, release the mouse button.

Media Composer does the following:

- Selects and enables the closest vector to the range of colors you have sampled.

- Adjusts the Input Vector values for the vector so that it includes the full range of colors that 
you sampled with the syringe.

- Sets the Output Vector values to match the Input Vector values.

- Automatically selects Isolate so that the vector you have defined is visible in the monitor. 
For more information, see “Isolating the Selected Vector” on page 692.

5. (Option) Refine the vector definition.

For more information, see “Refining a Vector Definition with the Add to Selection and 
Subtract from Selection Buttons” on page 692.
691



(Media Composer | SymphonyOption) The Secondary Group
Refining a Vector Definition with the Add to Selection and 
Subtract from Selection Buttons

You can refine the definition of a vector by adding or subtracting colors that you sample using the 
Add to Selection and Subtract from Selection buttons. You can use these buttons to refine any vector, 
regardless of how you originally defined it.

When Media Composer calculates revised vector areas based on selections made with the Add to 
Selection and Subtract from Selection eyedroppers, it is constrained by the geometric limits of the 
vector (wedge-shape for standard vectors and ellipse for custom vectors). As a result, you might 
include or exclude more colors than you expect. The Color Selection buttons are excellent tools for 
quickly adjusting a vector to approximately the area you require, but you might still need to fine-tune 
the vector using the sliders to achieve a precise match with the color range you want to correct.

To refine a vector using the Add to Selection and Subtract from Selection buttons:

1. Select the vector that you want to refine.

2. Click the Add to Selection or Subtract from Selection button to highlight it.

Add to Selection button (left) and Subtract from Selection button (right)

n The Add to Selection or Subtract from Selection button remains selected until you explicitly deselect 
it by clicking it or by clicking one of the other Color Selection buttons. You can perform repeated 
operations with the eyedropper without having to reselect it for each operation.

3. Move the pointer over the image in the monitor.

The pointer changes to an eyedropper.

4. Click the color you want to add to or subtract from the vector.

Media Composer updates the vector to include or exclude the color you have selected.

5. (Option) If you select too much color with the Add to Selection eyedropper or subtract too much 
with the Subtract from Selection eyedropper, select Edit > Undo or press Ctrl+Z (Windows) or 
Command+Z (Macintosh) to undo the effect of that selection on the vector.

Isolating the Selected Vector

You can isolate the selected vector in an image. Media Composer displays those parts of the image 
that fall within the selected vector in color, with the rest of the image in grayscale. This makes it easy 
to see which parts of an image are included in a selected vector while you are making corrections.

If you want to use Isolate only as a preview feature that lets you see the extent of vectors clearly, you 
must remember to deselect Isolate when you finish making the correction.

If you want to use Isolate as a special Color Correction effect that isolates parts of an image in color 
while displaying the rest of the image in grayscale, leave Isolate selected when you finish making the 
correction.

To isolate the selected vector:

1. Ensure that the position indicator is in the segment that you want to isolate.

2. Select Isolate in the Selected Vectors panel of the Secondary tab.
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The active monitor changes to isolate the selected vector.

3. Make input and output adjustments to the vector until you are satisfied with the look of the 
correction.

4. Do one of the following:

t To leave the areas of the image outside the vector grayscale, leave Isolate selected.

t To return the image to a full-color display, deselect Isolate.

Isolate shows the effect of any output adjustment you have made to the vector. If you have made 
output adjustments and want to see a preview that shows only the input color range, disable the 
Output Vector Hue and Saturation sliders by clicking their Enable buttons.

The following illustration shows a typical image and its appearance when Isolate is selected. For 
more illustrated examples of the effect of isolating a vector, see “Examples of Inverted and 
Isolated Images” on page 121.

Left to right: original image, corrected image with Isolate selected, and corrected image in full color. The Isolate 
preview shows the effect of an adjustment that changes the pale blue robe to match the green color of the shoes in 
the top left corner of the original image. Areas of the image not affected by the correction display as grayscale. The 
preview lets you see which additional areas of the image the adjustment affects and confirm which areas it does not 
affect — for example, the blue jacket in the bottom right. The color view of the correction shows that a few small 
areas of the image apart from the robe are changed by the correction, but that most of the image apart from the 
robe retains its original color.

Adjusting Output Vector Values

Because input adjustments define the extent of the vector, only hue, saturation and luminance values 
are adjustable for output. To change the color characteristics of a vector, you only need to define a 
new combination of hue, saturation, and luminance values.

You might make an output vector adjustment that causes saturation levels to exceed the RGB Gamut 
limits in the Safe Color Settings dialog box. Depending on the current settings in the Safe Color 
Settings dialog box, Media Composer might ignore the excess value or display a warning. For more 
information, see “Safe Colors” on page 737.

To adjust output vector values:

1. Select the vector you want to adjust.

2. Adjust the output vector values by doing one of the following:

t Manipulate the vector directly in the Output color wheel.

As you drag the center point around in the color wheel, the Hue and Saturation sliders 
update to show the current hue and saturation values.

t Adjust the output sliders.
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The Output Vector Hue and Saturation sliders are identical to their Input Vector equivalents. For 
more information, see “Input Vector Sliders” on page 688.

The Output Vector Luminance slider changes the luminance value for the final color. Values for 
the Luminance slider range from –10 to +10, where –10 reduces the luminance by 10% of the 
full black-to-white luminance range, and +10 increases the luminance by 10% of the full black-
to-white luminance range.

As you adjust the output values, the active monitor updates to show the effect of the correction 
on your image. If Isolate is selected, the monitor shows the corrected areas of the image in color 
and the unaffected areas of the image as grayscale.

3. Do one of the following:

t To have the areas of the image outside the vector continue to display as grayscale, ensure 
that Isolate is selected.

t To have the image appear as a full-color display, ensure that Isolate is deselected.

Using the Color Match Control for Secondary Corrections

You can use the Color Match control to make secondary color corrections based on color values that 
you sample from images or select from the Windows Color dialog box or the Macintosh Color 
Picker. If necessary, you can refine the input and output vectors after the color match to achieve the 
precise correction that you want.

You can use the Color Match control together with the syringe to perform a secondary color 
correction based on a range of sampled color values. In most circumstances, this is the best method 
for achieving a good correction when the hue and saturation values of the area you want to correct are 
somewhat varied. This method also shows the selected vector before you complete the match, which 
makes it easier to check that you have a well-defined input vector.

You can also use the Color Match control to make a secondary color correction with the same basic 
methods that you use to make Color Match corrections in the other Color Correction tabs. In this 
case, Media Composer applies the match to a predefined range of colors centered on the single color 
value that you sample, and you cannot see the input vector until the color match is complete. Though 
generally less precise and less controllable than the first method, this technique might produce 
acceptable results quickly if you need to correct an area of uniform color.

To make a secondary color correction using the Color Match control and the syringe:

1. Select, enable, and define the input vector using the syringe.

For more information, see “Defining a Vector with the Syringe” on page 691.

Media Composer automatically selects Isolate.

2. Select the output color using the standard Color Match eyedropper.

For more information, see “Making a Correction with the Color Match Control” on page 634.

3. Click the Match Type button, and select a Match Type to determine the exact nature of the match 
Media Composer makes.

For more information on the options available in the Secondary group, see “Match Type 
Options” on page 636.

4. Click the Match Color button.

Media Composer adjusts the output values for that vector, deselects Isolate, and displays the 
corrected image in the monitor that contains the current segment.
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5. (Option) Refine the vectors using the Input Vector and Output Vector sliders until you are 
satisfied with the correction.

To make a secondary color correction with the Color Match control only:

1. Select the input color using the standard Color Match eyedropper.

For more information, see “Making a Correction with the Color Match Control” on page 634.

2. Select the output color using the standard Color Match eyedropper.

3. Click the Match Type button, and select a Match Type to determine the exact nature of the match 
Media Composer makes.

For more information on the match types available in the Secondary group, see “Match Type 
Options” on page 636.

4. Click the Match Color button.

Media Composer selects and enables a vector, adjusts the input and output values for that vector 
based on the sampled colors, and displays the corrected image in the monitor that contains the 
current segment.

5. (Option) Refine the vectors using the Input Vector and Output Vector sliders until you are 
satisfied with the correction.

Inverting a Vector

You can invert a vector to apply a correction to every part of the image except for the area defined by 
the vector. The most common use of this technique is to isolate an object in its original color while 
altering the color of every other part of the image. For example, you might want to partially 
desaturate most of the image while retaining full color in the areas defined by the vector.

You can only invert one vector in each correction, and that vector is always the enabled vector 
farthest to the right in the Selected Vectors panel. In the common case of using inversion to isolate 
one object in color, the vector that you invert is likely to be the only vector you need to adjust. If you 
do make adjustments to multiple vectors in a segment, ensure that the inversion applies to the vector 
you want by making that vector the enabled vector farthest to the right in the Selected Vectors panel.

To invert a vector:

1. Select the vector, and make input adjustments to it using standard methods.

2. Select Invert Last Vector in the Selected Vectors panel.

Media Composer selects all parts of the image not defined within the vector. If you are working 
with Isolate selected, the display updates to show the area defined by the vector as grayscale and 
the rest of the image in color.

3. Adjust the output hue and saturation values for the vector.

4. Ensure that Isolate is selected or deselected as necessary to produce the final effect that you 
want.

For more information, see “Isolating the Selected Vector” on page 692.

Examples of Inverted and Isolated Images

The following illustrations show the effects of Isolate and Invert Last Vector on a typical image. If 
you use these two features alone or in combination, you can achieve a wide range of special Color 
Correction effects in which one area of the image stands out from the rest.
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Top: original image. Bottom, left to right: Isolate selected (the selected vector displays in color), Isolate selected and a 
correction made to the selected vector, Invert Last vector selected and a correction made to all parts of the image other 
than the selected vector, Isolate and Invert Last Vector both selected (the selected vector displays as grayscale and the 
rest of the image displays in color).

Understanding How Multiple Vectors Interact

If you correct more than one vector in the Secondary group, Media Composer applies the corrections 
cumulatively to the image when it plays back. The order of application moves from left to right 
across the Selected Vectors panel.

If the color ranges of vectors overlap, the final result in the image is the cumulative result of all the 
corrections for the overlapping vectors. For example, if you use the Green vector to change a green 
object in the image to yellow, and then adjust the Yellow vector so yellow objects become red, your 
original green object is red in the final image.

Keyframing Color Corrections

You can use the advanced keyframes interface in the Effect Editor to animate most color correction 
adjustments. You can:

• Manipulate many color correction parameters in the Effect Editor using sliders or parameter 
Enable buttons.

• Add and adjust keyframes for many color correction parameters in keyframe graphs, using the 
same methods you use for advanced keyframes in other effects.

• View keyframe markers in the position bar below the Current monitor in Color Correction mode.

• Automatically add keyframes by moving the position indicator below the Current monitor and 
then adjusting any keyframeable color correction parameter.

• Check how your animated color corrections are working by scrubbing through clips in Color 
Correction mode. Color correction parameter controls and graphs update as you scrub to show 
the parameter values at each point in the clip.

You can also adjust effects other than color corrections in the Effect Editor while in 
Color Correction mode.
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To support keyframing, color corrections in the current version of Media Composer store parameter 
information differently from color corrections created in some older versions. You must promote 
color corrections in sequences that were created with these older versions to work with them in the 
current version. For more information, see “Updating and Reverting Existing Effects in Sequences” 
on page 34.

Displaying the Effect Editor with Color Correction Mode

You have several options for using buttons to display the Effect Editor with Color Correction mode.

An alternative approach, particularly if you need to work frequently with the Effect Editor in Color 
Correction mode, is to save the Color Correction workspace in a configuration that includes the 
Effect Editor.

To open the Effect Editor when you are in Color Correction mode:

t Click the Effect Mode button.

The most convenient locations for the Effect Mode button when you are in Color Correction 
mode are the top right corner in the Color Correction tool and the Timeline palette.

The Effect Editor opens.

n When you are in Color Correction mode, the Effect Mode button simply opens the Effect Editor. It 
does not display the standard Effect Mode layout, including the Effect Preview monitor.

To close the Effect Editor when you are in Color Correction mode:

t Click the Effect Editor’s Close button.

The Effect Editor closes.

n When you are in Color Correction mode and the Effect Editor is open, you cannot close the Effect 
Editor by clicking the Effect Mode button again.

To enter Color Correction mode from Effect mode:

t Click the Color Correction Mode button, for example, in the Timeline palette.

The Color Correction mode layout appears and the Effect Editor remains open.

To enter the standard Effect Mode layout from Color Correction mode:

t Click the Effect Mode button.

To create a Color Correction workspace that includes the Effect Editor:

1. Select Windows > Workspaces > Color Correction.

2. Click the Effect Mode button.

3. Size and position the Effect Editor according to your preference.

4. Select Windows > Workspaces > New Window.

The New Workspace Setting dialog box opens.
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5. Type a name for the new workspace in the Workspace Name text box.

6. Click OK.

The new workspace appears in the Workspaces menu.

7. (Option) Map the Color Correction workspace menu command to your keyboard.

For more information, see “Mapping Menu Commands” in the Help.

Keyframeable Color Correction Parameter Reference

The following table explains which color correction parameters are keyframeable and the extent of 
the control available for them in the Effect Editor.

Parameter Types Description

All parameters in the HSL > 
Controls tab

(Symphony Option) All 
parameters with slider controls 
in the Secondary tab

These parameters are fully adjustable and keyframeable in the Effect Editor.

Slider controls appear in the Effect Editor, so you can adjust each parameter 
either in the Effect Editor or in the Color Correction tool. Controls and Enable 
buttons in the Effect Editor and in the Color Correction tool are ganged 
together, so changes in one are immediately represented in the other.

You can also display keyframe graphs for these parameters, and add and 
manipulate keyframes using normal advanced keyframe techniques.

All parameters in the HSL > 
Hue Offsets tab

These parameters are fully keyframeable in the Effect Editor, as described in 
the previous row of this table.

Each ChromaWheel in the Color Correction tool is represented as two sliders 
in the Effect Editor, one for the Hue and the other for the Hue Amount.

n Advanced keyframe graphs use a larger range of numerical values for Hue parameters than the Color 
Correction tool. In the Effect Editor, values range from -360 degrees to +360 degrees. In the Color 
Correction tool, values range from -180 degrees to +180 degrees. Hue adjustments in the Effect Editor 
might display with different numerical values from those in the Color Correction tool, even though the 
color represented is the same. For example, a value of +340 in the Effect Editor displays as -20 in the 
Color Correction tool — the two numerical values are just different ways to represent the same angle on a 
color wheel.

All parameters in the Curves tab

(Symphony Option) All 
parameters in the Levels and 
Curves tabs

You can enable and disable these parameters in the Effect Editor. You can also 
keyframe these parameters in their keyframe tracks. However, because these 
parameters require specialized controls, you cannot open keyframe graphs or 
adjust the parameter values directly in the Effect Editor. Make your 
adjustments in the Color Correction tool.
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Working with Keyframes in the Color Correction Monitor

Keyframe markers display in the position bar below the Current monitor in Color Correction mode. 
In general, these keyframe markers behave like those you see in the position bar below the Effect 
Preview monitor when in Effect mode. For example, you can:

• Click keyframe markers to select them.

• Delete selected keyframes.

• Alt-drag (Windows) or Option+drag (Macintosh) keyframe markers to move them.

You cannot add keyframes manually in the Color Correction monitor (as you can in the Effect 
Preview monitor using the Add Keyframe button). However, you can add keyframes automatically 
once you add an initial keyframe in the Effect Editor.

n Complex color corrections with many parameter adjustments might result in many keyframe markers 
in the Color Correction monitor that are hard to distinguish. In many cases when your color 
corrections are complex, it is easier to identify and manipulate the keyframe markers in the Effect 
Editor.

To automatically add keyframes to color corrections in the Color Correction monitor:

1. Add a keyframe in the Effect Editor using normal advanced keyframe techniques.

For example, if you want to adjust the Hue control in HSL > Controls, or have already made a 
first adjustment to that parameter, you need to add a keyframe to that parameter in the Effect 
Editor.

Consider adding a starting keyframe to more than one parameter, for example, to all of the 
parameters in the group you want to adjust. You then have a starting point for further adjustments 
to any parameter. You can use the Remove Redundant Keyframes command when you complete 
your adjustments to remove any keyframes that have no effect on the finished appearance.

2. If necessary, adjust the appropriate color correction parameter in either the Effect Editor or the 
Color Correction tool to set the parameter value for the keyframe you created in step 1.

3. In the Effect Editor or in the position bar below the Current Color Correction monitor, Ctrl-click 
(Windows) or Command+click (Macintosh) the keyframe added in step 1 to deselect it.

4. In the position bar below the Current Color Correction monitor, move the position indicator to 
the location where you want to set a new keyframe.

5. Make an adjustment to the appropriate parameter in the Color Correction tool.

A new keyframe appears below the Current Color Correction monitor at the location of the 
position indicator. If you scrub in the monitor, you see how the animated color correction 
changes the image over time and how the parameter control moves over time in the Color 
Correction tool.

(Symphony Option) Parameters 
in the Secondary tab that simply 
turn on or off (Invert Last Vector, 
Isolate)

All parameters in the HSL > 
Luma Ranges and Channels tabs

These parameters are not keyframeable and do not appear in the Effect Editor.

Parameter Types Description
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6. Repeat steps 3 through 5 to create additional keyframes as necessary.

Depending on where you added keyframes in step 1, you might also need to return to the Effect 
Editor to add a first keyframe for any parameter you want to adjust that does not yet have any 
keyframes.

7. (Option) When you complete all your adjustments, use the Remove Redundant Keyframes 
command in the Effect Editor to remove any keyframes that have no effect on the finished 
appearance.

For more information, see “Removing Redundant Keyframes” on page 92.

Working with the Waveform Monitors and Vectorscope 
Monitor

The waveform and vectorscope commands in the Source menu configure the monitor to graphically 
display color information about your sequence. Media Composer displays the information for the 
currently active monitor.

A waveform indicates the brightness of the image. The higher the green trace goes on the scale, the 
brighter that part of the image is. 

Waveform monitors display all the information for the current field or frame overlaid in the 
waveform. Each left-to-right trace in the waveform represents one scan line. If you see a bright object 
on the left side of the image, you see its peak on the left side of the waveform. A bright object in the 
top left of the image produces the same waveform if it is in the bottom left of the image.

Displaying a Waveform Monitor or Vectorscope Monitor

To display a Waveform monitor or Vectorscope monitor:

1. Click in the monitor for which you want to display color information.

The monitor becomes the active monitor.

2. In one of the other monitors, click the Source menu and select a waveform or vectorscope 
command.

The monitor displays the selected waveform or vectorscope information.

For more information, see “Waveform and Vectorscope Commands” on page 700 and “Using the 
Waveform and Vectorscope Information” on page 706.

Waveform and Vectorscope Commands

The following table describes the waveform and vectorscope commands available in the Source 
menu for monitors in Color Correction mode.
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Command Descripton

Quad Display Displays the following waveform and vectorscope information in a single monitor 
(clockwise from the top left corner): 

• YC Waveform

• Vectorscope

• RGB Histogram

• RGB Parade

For information on each display, see its individual entry in this table.

RGB Histogram Displays a graph that shows which RGB values in the image appear most frequently. The 
darkest values of red, green, and blue in the image appear as peaks on the left of the graph, 
and the brightest values appear as peaks on the right. The height of a peak indicates the 
number of pixels of that value. The width of a peak indicates how many pixels in the image 
have similar values.

For example, if the blue histogram has many tall peaks at the left side, the image has many 
pixels with low blue values. However, these pixels might appear in the image as many 
different colors because they might have any red and green values.

For information on using the RGB Histogram display, see “Using the Waveform and 
Vectorscope Information” on page 706.
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RGB Parade Displays waveforms of the RGB components side by side. Because video cameras capture in 
RGB, this display helps to show camera problems. You can also use it for general reference 
to the three primary colors.

RGB signals combine to create all other colors. A white area in the image appears as peaks 
in all three waveforms at the same relative location. A high red level does not mean a red 
image unless the green and blue levels are low.

RGB Parade incorporates any safe color limits you have set. Media Composer displays RGB 
values in white when the values fall outside the RGB Gamut limits. For more information on 
color limits, see “Safe Color Limits with Waveform and Vectorscope Information” on 
page 743.

For information on using the RGB Parade display, see “Using the Waveform and 
Vectorscope Information” on page 706.

Vectorscope Displays chroma information without luma information as a circular graph where the center 
represents no chroma and chroma increases as the trace moves away from the center. 

All white, black, and gray parts of the image appear at the center. Areas with more saturation 
appear further out from the center. Images with an overall color cast produce a vectorscope 
trace that is generally off-center. Colors created by various positive and negative 
combinations of Cb and Cr appear around the circle.

Small squares mark the location of standard color bar vectors. Inner squares represent the 
proper values for 75% color bars, and outer squares represent 100% color bars.

For information on using the Vectorscope display, see “Using the Waveform and 
Vectorscope Information” on page 706.

Command Descripton
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Y Waveform Displays a Waveform monitor with luma information. Luma is the brightness of an image 
without regard to color.

The scale on the left is a digital level scale using a 256-step (eight-bit) range; 16 is the level 
for black, and 235 is the level for white.

The scale on the right shows the amount of white in the image as a percentage; 0% represents 
black, and 100% represents white.

Parts of an image can have values outside the 0% to 100% range. The digital video standard 
allows for headroom and footroom so you can correct a mistake in level in the 
postproduction process. The minimum is digital 0 or –8%, and the maximum is digital 255 
or 108%. 

n Some external software or hardware processing can clip a signal that is outside the 
0% to 100% range.

Y Waveform incorporates any safe color limits you have set. Media Composer displays 
Luma values in white when the values fall outside the Luminance limits. For more 
information on color limits, see “Safe Color Limits with Waveform and 
Vectorscope Information” on page 743.

For information on using the Y Waveform display, see “Using the Waveform and 
Vectorscope Information” on page 706.

Y Waveform 
HDR 1000 and 
Y Waveform 
HDR 10000

Displays a Waveform monitor with luminance information with respect to HDR (High 
Dynamic Range). 

If you choose the Y Waveform HDR 1000, the scale on the left displays luminance values in 
nits from 0 to 1000. If you choose the Y Waveform HDR 10000, the scale displays 
luminance values in nits from 0 to 10000.
Note: The SDR (Standard Dynamic Range) Rec709 standard of 100 nits is around 50% of 
the HDR 10,000 nits level.

Command Descripton
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YC Waveform Displays composite video information. Composite video has the C (chroma) waveform, 
which is derived from Cb and Cr components, riding on the Y (luma) waveform. The Y trace 
is green and the C waveform is a cyan (blue-green) envelope around the green trace. Because 
the C signal of composite video has equal positive and negative energy, the cyan bands are at 
an equal distance above (Y+C) and below (Y-C) the green waveform.

The left side of the YC Waveform shows a scale marked either for NTSC or PAL, depending 
on your project.

NTSC black is 7.5 IRE (except in Japan), and NTSC white is 100 IRE.

PAL black is 0 millivolts (mV), and PAL white is 700 mV.

n This tool does not display actual composite video output. It is an accurate software 
model of a perfect encoder. If you convert your material to composite form, you see 
similar results.

The scale on the right shows the amount of white in the image as a percentage — 0% 
represents black, and 100% represents white.

A red edge on the display indicates composite video values above or below these limits. In 
addition, YC Waveform incorporates any safe color limits you have set. Media Composer 
displays Composite values in yellow and Luma values in white when the values fall outside 
the safe color limits. For more information on color limits, see “Safe Color Limits with 
Waveform and Vectorscope Information” on page 743.

For information on using the YC Waveform display, see “Using the Waveform and 
Vectorscope Information” on page 706.

Command Descripton
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YCbCr Histogram Displays a graph showing which YCbCr values in the image appear most frequently. The 
height of a peak indicates the number of pixels of that value. The width of a peak indicates 
how many pixels in the image have similar values.

The upper bar of the histogram represents Y values. The darkest values are on the left and the 
brightest values on the right. An image with good contrast shows a good spread of values 
from darkest to lightest.

An image with a great variety of colors appears as a wide spread in the Cb and Cr 
histograms. If they extend too far from the center, there is too much saturation.

For information on using the YCbCr Histogram display, see “Using the Waveform and 
Vectorscope Information” on page 706.

YCbCr Parade Displays waveforms of Y, Cb, and Cr side by side. The Y in YCbCr is the same luma that the 
Y Waveform shows. In this display, the Y waveform shows in white on the left side.

Cb and Cr are color difference signals that represent just the color information of a signal 
with the luma removed. Cb and Cr values can be negative or positive. For images that are 
black and white, Cb and Cr are zero, and you see a flat white line halfway up the two right 
bands. As they increase, Cb and Cr show in the colors representing those vectors. The more 
the values increase, the more saturated are the colors used to display them. Positive Cb is 
represented by blue hues, and negative Cb is represented by yellow hues. Positive Cr is 
represented by red hues, and negative Cr is represented by cyan hues. 

If the Cb or Cr waveforms are not centered, the cause might be a color cast to the image.

For information on using the YCbCr Parade display, see “Using the Waveform and 
Vectorscope Information” on page 706.

Command Descripton
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Applying Color Corrections to an Entire Sequence
Using the Waveform and Vectorscope Information

The following are examples of the ways you can use the waveform and vectorscope information:

• Aligning levels of sources using test patterns.

If you capture some color bars from your source footage, you can measure them and set the color 
correction you need to restore the video levels to the way the program was created. Import the 
Test Patterns from the SupportingFiles folder of Media Composer to become familiar with the 
proper Waveform, Parade, and Vectorscope readings. Histograms are not as useful on test 
patterns. For example, with 75% color bars, the Y+C envelope for the yellow and cyan bars 
should match the 100% white level.

• Identify problems with source video.

Typical problems include:

- Color levels too high or too low (see “Safe Color Limits with Waveform and 
Vectorscope Information” on page 743).

- Missing channels in YCbCr or RGB, indicating an equipment problem or a damaged cable.

- Clipping in YCbCr, RGB, or YC channels. The trace appears chopped at a certain level. If 
this appears at a level below the maximum, it occurred before the footage was captured.

- Images imported at the wrong level settings. If you import images at RGB levels of 0–255 
that you should have imported at 601 levels of 16–235, the images lack contrast. If the 
images have too much contrast, with levels exceeding the 0% and 100% markings, the 
opposite is likely. 

With experience, you learn how to read not only test patterns but actual content on the instruments. 
This lets you:

• Match scene brightness across a cut in Y Waveform.

• Put your flesh tones along a certain hue axis in the vectorscope.

• Watch the spread of the Y histogram to identify a good contrast range without clipping.

• Watch the top of the YC Waveform to ensure you do not have too much bright chroma.

• Fix white balance and black balance problems by identifying and centering those vectorscope 
traces.

n Waveform and vectorscope monitors show you the values of only one frame or field at a time. Move 
around in the clip to find the most extreme levels or those most representative of the scene.

You can also use the information in the Waveform monitors and Vectorscope monitor to monitor safe 
color limits. For more information, see “Safe Color Limits with Waveform and 
Vectorscope Information” on page 743.

Applying Color Corrections to an Entire Sequence
You can apply a single color correction to an entire sequence by adding a video track above all other 
video tracks and selecting the Record Track button for that track. This is a simple and flexible way to 
make a final color adjustment to an entire program. For example, you might want to brighten all of 
your material slightly, or increase saturation a little to create a warmer look, or tint your whole 
program.
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Using the Color Correction Effect
Once you make a color adjustment, Media Composer fills the entire length of the empty track with 
filler material and applies a Color Correction effect. The filler in this case is not opaque material but 
simply a container for the Color Correction effect. The result is that you see the color adjustment 
applied to whatever combination of images and effects exists in the lower video tracks.

n In most situations, do not use this technique to make automatic color corrections, because Media 
Composer bases the color correction for the entire sequence on its analysis of the single frame that is 
active when you make the correction. This does not result in a good correction for the whole 
sequence unless all of the segments in it have very similar color characteristics. A better method for 
applying automatic color corrections to the entire sequence is to select every segment and then apply 
a Color Correction effect from the Effect Palette. For more information, see “Correcting Color 
Automatically Using the Color Correction Effect” on page 632.

To apply a color correction effect to an entire sequence:

1. In Source/Record mode, add a new video track to the sequence.

For more information, see “Adding and Deleting Tracks” in the Help.

2. Enter Color Correction mode, for example, by clicking the Color Correction Mode button.

3. Ensure that the Record Track button for the topmost video track is selected.

4. Make one or more color adjustments in the Color Correction tool.

Filler material and a Color Correction effect appear in the topmost video track.

Using the Color Correction Effect
The Color Correction effect appears in the Image category of the Effect Palette. Any Color 
Correction effect templates in open bins also appear in the Effect Palette. Because Media Composer 
automatically applies a Color Correction effect in the Timeline when you make a correction, you 
apply Color Correction effects from the Effect Palette only for the following special purposes:

• To quickly apply automatic color corrections to one or more segments in a sequence. 

• To apply a Color Correction saved as an effect template to one or more segments in a sequence. 
For more information, see “Working with Color Correction Effect Templates” on page 618.

Once you render a Color Correction effect, you can move the sequence to a system without color 
correction and the rendered correction plays successfully. In a system without color correction 
capability, a Color Correction effect is an unknown effect. The effect icon appears blank in the 
Timeline, and you cannot make any adjustments to it.

(Symphony Option) In addition to color corrections made using relationships, you can also apply 
color corrections using the Color Correction effect.

The Color Correction effect is the only way to make some types of corrections, and it is important to 
understand the situations that call for a Color Correction effect rather than a relationship color 
correction. For more information, see “(Media Composer | Symphony Option) When to Use the 
Color Correction Effect” on page 708.
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Using the Color Correction Effect
You can apply the Color Correction effect in two different ways:

• You can apply it from the Color Correction tool by selecting CC Effect as the correction type. 
For more information, see “(Media Composer | Symphony Option) Applying a Color Correction 
Effect from the Color Correction Tool” on page 711.

• You can apply it from the Effect Palette, in the same way as any other effect. When you apply the 
Color Correction effect from the Effect Palette, Media Composer makes the automatic color 
corrections set in the AutoCorrect tab of the Correction Mode Settings dialog box. You can then 
make further color adjustments in the Color Correction tool if you need to do so. For more 
information, see “Correcting Color Automatically Using the Color Correction Effect” on 
page 632.

Once you apply a Color Correction effect, you can work with it in much the same way as any other 
effect. For example, you can save it as an effect template, or delete it using standard methods for 
deleting effects.

n You can apply a relationship correcton and a Color Correction effect on the same segment. This 
results in two distinct corrections. Media Composer applies the relationship correction first, and its 
result is the input to the Color Ccorrection effect.

This approach differs from applying two corrections by applying one on the Source side and another 
on the Program side. In this case, a single correction is made using the merged values from the 
Source and Program sides.

(Media Composer | Symphony Option) When to Use the Color Correction 
Effect

You need to use a Color Correction effect rather than a relationship color correction in the following 
situations:

• When you want to apply multiple automatic corrections in a single operation.

• When you want to apply a color correction in combination with certain other effects.

For example, if you have two layers of video with a Picture-in-Picture on the top layer, you 
cannot color correct the entire video composite (foreground and background together) using a 
relationship correction. However, if you nest a Color Correction effect on top of the Picture-in-
Picture, you can correct foreground and background at the same time. This behavior is a result of 
the fact that relationship color corrections are processed before most other effects. For more 
information, see “(Media Composer | Symphony Option) Understanding Relationship Color 
Corrections” on page 604.
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Using the Color Correction Effect
Example of relationship corrections and a Color Correction effect combined with another effect on multiple layers. 
Top left, original setup before color corrections. Top right, relationship correction on bottom track (only bottom track 
has chroma inverted). Bottom left, relationship correction on top track (only top track has chroma inverted). Bottom 
right, Color Correction effect nested on top of Picture-in-Picture (entire composite has chroma inverted).

• When you want to apply a color correction to filler.

You cannot apply relationship color corrections to filler. A common example of the use of a color 
correction on filler is when you add a new video track above all other tracks and then add a Color 
Correction effect to that track. This provides a way to apply an overall color correction that 
affects every layer beneath it (for example, adding a little brightness to an entire sequence as a 
final color correction step). The Program Track relationship color correction, in contrast, affects 
the whole of any one track in a sequence.

Example of a Color Correction effect applied to filler on a top track, above multiple other tracks

Selecting AutoCorrect Options

You control how Media Composer makes automatic corrections when you apply the Color 
Correction effect from the Effect Palette by choosing options in the AutoCorrect tab of the 
Correction Mode Settings dialog box.
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Using the Color Correction Effect
To set AutoCorrect options:

1. Do one of the following:

t Select File > Settings, click the User tab and double-click Correction.

t In the Color Correction window, click the Correction Mode Settings button.

The Correction Mode Settings dialog box appears.

2. Click the AutoCorrect tab.

3. Select an option from each of the three menus to define the first, second, and third automatic 
color correction that Media Composer makes when you apply the Color Correction effect from 
the Effect Palette.

For detailed information on the options, see “AutoCorrect Options” on page 710.

AutoCorrect Options

The following table describes the available options in the AutoCorrect tab of the Correction Mode 
Settings dialog box.

Working with the Color Correction Effect

You can work with a Color Correction effect in the same way that you work with any other effect that 
you apply from the Effect Palette and that appears in the Timeline with an effect icon.

Option Description

Nothing Makes no adjustment. For example, if you only want to make two automatic 
corrections when you drag the Color Correction effect from the Effect Palette, set 
the Third Correction menu in the AutoCorrect tab to Nothing.

HSL 
Auto Balance

Makes adjustments to the three ChromaWheels to balance the colors in the image. 
This is the equivalent of clicking the Auto Balance button in the Hue Offsets 
subdividing tab of the HSL tab.

HSL 
Auto Black

Adjusts the Setup slider in the Hue Offsets subdividing tab of the HSL tab to make 
the darkest areas of the image as dark as possible. This is the equivalent of clicking 
the Auto Black button in the Hue Offsets subdividing tab of the HSL tab.

HSL 
Auto Contrast

Adjusts the Gain and Setup sliders in the Hue Offsets subdividing tab of the HSL tab 
to maximize the tonal range in the image. This is the equivalent of clicking the Auto 
Contrast button in the Hue Offsets subdividing tab of the HSL tab.

HSL 
Auto White

Adjusts the Gain slider in the Hue Offsets subdividing tab of the HSL tab to make 
the brightest areas of the image as bright as possible. This is the equivalent of 
clicking the Auto White button in the Hue Offsets subdividing tab of the HSL tab.

Curves 
Auto Balance

Makes adjustments to the Red, Green, and Blue curves to balance the colors in the 
image. This is the equivalent of clicking the Auto Balance button in the Curves tab.

Curves 
Auto Contrast

Makes an adjustment to the Master curve to maximize the tonal range in the image. 
This is the equivalent of clicking the Auto Contrast button in the Curves tab.
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Using the Color Correction Effect
You can save the effect as a template by entering Effect mode, clicking the effect icon in the Effect 
Editor, and dragging it to a bin in the standard way. You can then apply the template to other 
segments in the sequence or to other sequences. This is useful for applying a Color Correction Effect 
template quickly to multiple segments. For more information, see “Working with Effect Templates” 
on page 36.

You can also delete the effect in the standard way by selecting it in Effect mode and pressing the 
Delete key. For more information, see “Deleting Effects in a Sequence” on page 30.

If color corrections that you did not apply from the Effect Palette are in the same segment — 
indicated by colored lines if Color Correction is selected in the Timeline Fast menu — you cannot 
delete those corrections in Effect mode. To remove those color corrections, you must enter Color 
Correction mode and use the Remove Effect button.

(Media Composer | Symphony Option) Applying a Color Correction Effect 
from the Color Correction Tool

You can apply a Color Correction effect in the Color Correction tool, and then make any combination 
of color correction adjustments that are available in the Color Correction tool.

When you apply a Color Correction effect from the Color Correction tool, Media Composer does not 
apply the automatic corrections set in the AutoCorrect tab of the Correction Mode Settings dialog 
box.

To apply a Color Correction effect from the Color Correction tool:

1. If you have not already done so, move the position indicator to the segment you want to correct.

2. Click the Correction Type button and select CCEffect.

3. Make the color adjustments you want in one or more of the Color Correction tool’s tabs.

Once you make an adjustment, the Color Correction effect appears on the segment.

The Color Info Tool

The Color Info tool allows you to see the RGB values for the pixels located under the pointer on the 
screen. This is helpful if you want to see a color value without having to go to Color Correction 
Mode.

To use the Color Info Tool:

1. Select Tools > Color Info Tool.

The Color Info Tool opens.

2. Move your pointer. The values in the Color Info tool display the color info for the pixels located 
under the pointer.
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Using the Color Correction Effect
3. Right-click (Windows) or Control-click (Mac) the Color Info Tool window.

The follow options appear:

4. Choose the color information you want displayed:

You can also access the Color Info tool by clicking the Color Info button in the Color Correction 
Tool.

Shape-Based Color Correction (Symphony Option)

Media Composer includes tools that allow you to perform shape-based color correction. 

Performing a Shape- Based Color Correction

You use the Color Correction tool to access the tools for performing the shape-based color correction. 

Option Description

Active only for video monitors When selected, moving the pointer over the 
source or record monitors will display color 
information in the Color Info tool. When 
deselected, moving the pointer anywhere on your 
screen will display color information in the Color 
Info tool.

Show video color after apply Display Color 
Space

You can choose to see the color values before and 
after applying a Display Color Space option 
(LUT) 

RGB 8 bit Measures on a scale from 0 to 255.

RGB 10 bit Measures on a scale from 0 to 1024.

RGB Percent Measures on a percentage scale. Percentage 
values can be lower than 0 or higher than 100.

IRE Measures in IRE units.

mVolts Measures in millivolts.
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Using the Color Correction Effect
To perform a shape-based color correction:

1. Load the sequence in the Timeline.

2. Click the Color Correction Mode button in the Timeline to access the Color Correction tool.

3. Select CC Effect from the color correction relationship pulldown options in the Color Correction 
tool.

4. Use the shape tools in the Color Correction tool to mark the area you to want to color correct. 

Shape based tool options and Show Alpha Icon top right

5. Note the following:

- Shapes - selects the shape layer that allows you to use the shape based tools to color correct 
portions of the material in the sequence. 

- Base - sets the base layer that allows you to make color corrections to the material in the 
sequence.

- Show Alpha Icon - when selected displays the alpha.

- Serial Mode - when selected, any changes you have made to the base will be included when 
you are performing a shaped based color correction.

- Show Result - when selected, shows the composite result of the base+ shape layer (the final 
result).

- Invert Alpha - when selected displays the inverted alpha.
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Using the Color Correction Effect
- Softness - Use the slider to add softness to the selected shape. Each shape can have a 
different softness.

6. Using the color correction tool options, such as Hue, Saturation, Brightness, etc, make your color 
corrections.

7. Once you are satisfied with the corrections throughout the sequence, exit Color Correction mode.

You can also use the Effect Editor to make additional edits including Tracking.

a. Click on tracker to track the area.

b. Select the shape you want to attach a tracker to.

c. Select the tracker from the list of created trackers.

n Different shapes can be connected to different trackers. For details on creating trackers, see “Setting 
Up an Effect for Tracking” in the Help
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21 (Media Composer | Symphony Option) 
Managing Color-Corrected Sequences

This chapter provides information on how to manage sequences once you have applied color 
correction to them.

• Updating Color-Corrected Sequences

• Merging Color-Corrected Sequences

• Color Correction Merging Example

• Flattening Color-Corrected Sequences

• Removing Color Corrections

For information on how color-corrected sequences conform between Symphony Option and certain 
other Avid editing applications, see “Conforming Sequences with Color Correction” in the Help.

Updating Color-Corrected Sequences
The Update Correction command lets you make color corrections to a sequence and then edit 
additional material into the sequence without having to repeat much of your color correction work. 
When you return to Color Correction mode, Media Composer can apply existing color corrections to 
the new segments, based on their relationship to the existing material. Media Composer updates any 
color corrections based on Source Tape, Clip Name, Master Clip, or Sub Clip relationships, or based 
on Program Track relationships. 

For example, a sequence might contain several segments from the same source tape. When you first 
perform a Source color correction pass, you correct these segments simultaneously using the Source 
Tape relationship. Later, you edit new segments from the same source tape into the sequence. You 
can return to Color Correction mode and use the Update Correction command to apply the color 
correction from the original segments to the new segments automatically.

The following illustration shows the stages of this process for a simple sequence.

Top: sequence before the new edit. Segment A is corrected using the Source Tape relationship. Segment B is corrected 
using the Source Segment relationship.
Middle: sequence after the new edit. Segment C is the new segment. It uses material from the same source tape as 
segment A.
Bottom: sequence after updating. Color correction is automatically applied to segment C based on its Source Tape 
relationship with segment A.

A B C

A B

A B C



Merging Color-Corrected Sequences
To update a color-corrected sequence:

1. In Source/Record mode, edit new material into a previously color-corrected sequence.

2. Click the Color Correction Mode button, for example, in the Timeline palette.

3. Right-click in the Color Correction tool, and select Update Correction.

The Update Color Correction dialog box opens.

4. Select the Source and Program relationships you want Media Composer to use when deciding 
which segments to update.

By default, all available relationships are selected.

5. Select Create New Sequence if you want Media Composer to create a new copy of the sequence 
and update that copy.

n If you deselect Create New Sequence, Media Composer updates the existing version of the sequence. 
Avid recommends that you create a new sequence when updating. You then retain the previous 
version as a backup. If you update an existing version of a sequence and want to return to the 
previous version, select Edit > Undo.

6. Click OK.

Media Composer updates the sequence and adds color correction to the appropriate new 
segments. If you have selected Create New Sequence, a new sequence appears in the bin with the 
title [OldTitle].Copy 1. You can rename the sequence to indicate more clearly that it is an 
updated version.

Merging Color-Corrected Sequences
You might want to work with two versions of a sequence at the same time. For example, an editor 
might work on one copy of a sequence while a colorist continues to make color adjustments on 
another copy. You can merge the two sequences to reflect the changes made on both copies.

The Merge Correction command merges any color corrections based on Source Tape, Clip Name, 
Master Clip, Segment, or Sub Clip relationships, or based on Program Track or Segment 
relationships, into the latest version of the edited sequence.
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Merging Color-Corrected Sequences
For example, if the editor adds new segments from source tape 1, and a color correction exists for that 
tape, Media Composer applies the correction to the new segments when the merge takes place. This 
is true whether the color correction was made before the editor began work or whether the color 
correction is made to the sequence while the editor is working with a copy of it.

You can also control which of the two copies Media Composer prefers if there is a conflict between 
the two copies when merging.

For an illustrated example of a typical merging workflow, see “Color Correction Merging Example” 
on page 719.

To work with two copies of a sequence and then merge the corrections:

1. Create a first version of your sequence.

2. (Option) Click the Color Correction Mode button, for example, in the Timeline palette, and make 
initial color adjustments to the sequence.

3. Save the sequence, and then create one or two copies of the sequence.

The way you handle copies of the sequence depends on the requirements of your workflow. You 
need only two versions of the sequence — the original and one copy. For example, the colorist 
might keep the original while the editor works on the copy. However, it might be safer to keep 
the original as a backup and work with two new copies.

For more information on saving and copying a sequence, see “Bin Procedures” in the Help.

n Name your copies clearly. For example, if you create two copies and also keep the original, you 
might use the extensions .Editor, .Colorist, and .Original to distinguish the three versions.

4. Continue to work on the two copies independently.

5. When you are ready to merge the two copies, enter Source/Record mode, for example, by 
clicking the Source/Record button.

6. Load one copy of the sequence into the Source monitor and the other into the Record monitor.

You can load a copy into either monitor. The only difference is that Media Composer merges into 
the sequence in the Record monitor unless you instruct it to create a new sequence for the merge 
in step 11.

7. Click the Color Correction Mode button, for example, in the Timeline palette.

8. Right-click in the Color Correction tool, and select Merge Correction.

n The Merge Correction command is unavailable in the Color Correction tool shortcut menu and you 
cannot select it until you load versions of a sequence in both the Source monitor and the Record 
monitor and enter Color Correction mode. 

The Merge Color Correction dialog box opens.
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Merging Color-Corrected Sequences
9. Select the Source and Program relationships you want Media Composer to use when deciding 
which segments to update in the merging process.

You can merge Color Correction that was created using the Source Segment or Program 
Segment relationship. Color corrections using Source or Program segment relationships will be 
merged using the Segment’s source and timecode. In order for the merge to take place, there 
must be overlap with the source and timecode of the segments. If more than one segment in the 
source monitor overlaps the source and timecode of a segment in the record monitor, then the 
segment with the most overlap in will be used.

When merging into segments without any color correction relationships, Segment relationship 
merge is tried before other relationships when the Segment check box is checked in the Merge 
Color Correction dialog box.

Therefore, clips without any relationship correction in the record monitor will get Segment 
relationship color correction before Tape if there is any overlap with source and timecode. 
Segments that already have a relationship color correction on them will not have their type of 
relationship changed. For example, a segment will not change from Source Tape to a Source 
Segment and merges will only occur with segments in the source monitor with the same color 
correction relationship.

Segment relationships are not selected by default.

10. Click the “In case of conflict” menu, and select an option to control how the system resolves 
conflicts between the two copies of the sequence:

11. Select Create New Sequence if you want Media Composer to create a new copy of the sequence 
and merge into that copy.

Option Description

Prefer Source Sequence Resolves conflicts by preferring the information in the sequence 
you loaded into the Source monitor.

Prefer Record Sequence Resolves conflicts by preferring the information in the sequence 
you loaded into the Record monitor.

Prefer Latest Resolves conflicts by preferring the most recent information. 
This is the default setting.
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If you deselect this option, Media Composer merges the two copies into the sequence that is 
currently in the Timeline. This is the sequence that you loaded into the Record monitor before 
entering Color Correction mode.

12. Click OK.

Media Composer merges the two existing sequences, based on the options you have selected. 
The merged sequence appears in the Timeline.

Color Correction Merging Example
The following example illustrates the capabilities of the Merge Color Correction command.

The original sequence has seven segments that are derived from four different source tapes. For 
simplicity, the segments have equal lengths (one second). The following illustration shows the 
original sequence before any color correction.

Original sequence: the numbers on the segments indicate the source tape from which each segment comes

The sequence now receives some initial color correction to the material from source tapes 2 and 4. 
The following illustration shows the sequence after this initial color correction work.

Sequence after initial color correction: segments from source tapes 2 and 4 have Source Tape corrections

At this point in the workflow, an editor continues to work on a copy of the sequence, and a colorist 
makes more color corrections to the original version of the sequence.

The editor makes the following changes:

• Replaces the fifth segment with another clip from source tape 2.

• Adds a new segment from source tape 4 near the end of the sequence.

• Trims the second segment to double its length.

Editor’s copy of sequence after further editing. Left to right, lengthened segment after trimming, replacement segment 
from source tape 2, and new segment from source tape 4.

The colorist modifies his or her version of the sequence by adding Source Tape correction for source 
tape 1.

Colorist’s copy of sequence after further correction: Source Tape correction is added for source tape 1

2 1 2 3 1 4 1

2 1 2 3 1 4 1

422 1 2 3 4 1

2 1 2 3 1 4 1
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Flattening Color-Corrected Sequences
The editor’s copy of the sequence is now out-of-date with respect to the colorist’s corrections. It 
contains segments from source tapes 1, 2, and 4 that need to use the Source Tape corrections for those 
tapes. When the two sequences merge, the editor’s sequence is correctly updated.

Top to bottom: Editor’s copy, merged sequence, and colorist’s copy
Left to right on merged sequence: segment reflecting editor’s trim and colorist’s Source Tape correction for tape 1, new 
segments reflecting original Source Tape corrections for tapes 2 and 4, segment reflecting colorist’s Source Tape 
correction for tape 1

Flattening Color-Corrected Sequences
You might want to convert a color-corrected sequence so that all the color corrections become 
segment-only relationships. This lets you readjust the color correction in a single segment, even if it 
was previously corrected as part of a broader relationship, without affecting any other segments. You 
can define by relationship which groups of segments are converted to segment-only relationships.

The following illustrations show this process for a simple sequence.

Top — before flattening: segments A and C are corrected using a Source Tape relationship. You cannot adjust the 
Source color correction for one segment without affecting the other.
Bottom — after flattening: all three segments now have a segment-only relationship. You can adjust each segment 
individually without changing any other segment.

To flatten a color-corrected sequence:

1. Click the Color Correction Mode button, for example, in the Timeline palette.

2. Right-click in the Color Correction tool, and select Flatten Correction.

The Flatten Color Correction dialog box opens. The dialog box indicates the number of segments 
that are available for flattening in each relationship category.

422 1 2 3 4 1

2 1 2 3 1 4 1

422 1 2 3 4 1

A B C

A B C
720



Removing Color Corrections
3. Select the Source and Program relationships you want Media Composer to use when deciding 
which segments to flatten.

By default, all available relationships are selected.

4. Select Create New Sequence if you want Media Composer to create a new copy of the sequence 
and flatten segments on that copy.

n If you deselect Create New Sequence, Media Composer flattens the existing version of the sequence. 
Avid recommends that you create a new sequence when flattening. You then retain the version that 
has not been flattened as a backup. If you flatten an existing version of a sequence and want to return 
to the previous version, select Edit > Undo.

5. Click OK.

Media Composer converts the segments you have selected to segment-only relationships. If you 
have selected Create New Sequence, a new sequence appears in the bin with the title 
[OldTitle].Copy 1. You can rename the sequence to indicate more clearly that it is a flattened 
version.

Removing Color Corrections
You can remove the color correction on a specific segment at any time by clicking the Remove Effect 
button in the Composer window while in Color Correction mode.

You can also remove groups of corrections with the same associated relationship using the Remove 
Correction command. This is useful for removing all corrections, or large numbers of corrections, at 
the same time.

To remove corrections using the Remove Correction command:

1. Click the Color Correction Mode button, for example, in the Timeline palette.

2. Right-click in the Color Correction tool, and select Remove Correction.

The Remove Color Correction dialog box opens. The dialog box indicates the number of 
segments in the sequence for each relationship category.

3. Select the Source and Program relationships you want Media Composer to use as the criteria for 
removing segments.

By default, all relationships are selected.
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4. Select Create New Sequence if you want Media Composer to create a new copy of the sequence 
and remove segments only from that copy.

n If you deselect Create New Sequence, Media Composer updates the existing version of the sequence. 
Avid recommends that you create a new sequence when removing groups of corrections. You then 
retain the previous version as a backup. If you remove corrections from the existing version of a 
sequence and want to return to the previous version, select Edit > Undo.

5. Click OK.

Media Composer removes color correction for all segments affected by the relationships you 
have selected. If you have selected Create New Sequence, a new sequence appears in the bin 
with the title [OldTitle].Copy 1. You can rename the sequence to indicate more clearly that it is a 
version from which some corrections have been removed.
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22 Color Correction Techniques

This chapter provides an introduction to color correction techniques. It suggests some general 
principles to keep in mind when you are assessing footage and making color corrections, and then 
presents examples of corrections to shots with typical color problems.

• Guiding Principles for Color Correction

• Examples of Color Correction Problems

Guiding Principles for Color Correction

One useful way to think about the color correction process is to define the overall goals of the 
process. Another, slightly more practical and detailed, is to break down the typical color correction 
workflow into clearly defined stages of adjustment. The following topics use these two approaches to 
provide you with a set of guiding principles for color correction.

Goals of Color Correction: Restoration and Adaptation

You can think of color correction as having two main goals:

• Restoring the original look of the scene.

• Adapting the look of the scene to meet the demands of the project.

In some cases, color correction is complete when you have met the first goal. Often, however, there is 
some departure from the restored look to achieve shot-to-shot consistency or to convey creative 
concepts. So when you apply color corrections to any particular shot you usually have two different 
contexts in mind: the original scene at the time the camera captured it and the final situation of the 
shot within a program that has particular creative or communicative aims.

Restoring the Original Look

The first task in color correction is to restore the original look of the scene, that is, to make the image 
match as closely as possible what an observer standing beside the camera would have perceived 
when the scene was shot.

This is important because viewers typically have little tolerance for images that have unrealistic color 
values. For example, when a skin tone departs from our normal expectations of what skin should look 
like, we notice. Even when the final image is intentionally a distortion of reality, it is useful to restore 
the original look before you make subsequent alterations.

The color characteristics of a given shot can depart from the look of the original scene for a number 
of reasons. At the time of shooting, the camera might not be correctly balanced or the scene might be 
imperfectly lit. During transfers (from film to tape, from one tape to another, or from tape to captured 
media), inconsistencies in materials, processing methods, or calibration might alter the colors.



Guiding Principles for Color Correction
When you work on an uncorrected shot, you should make intelligent decisions about what the scene 
originally looked like and then adjust the shot accordingly. Although you probably were not present 
when the scene was shot, you can accomplish this with sufficient accuracy using the following two 
basic guidelines.

• The human visual system generally maximizes the tonal range available in a scene. For example, 
in low light we adjust to perceive a greater range of dark tones.

• The human visual system generally perceives color accurately and compensates for color casts. 
For example, we perceive a white shirt as white even if it is being illuminated by slightly pink 
light.

Generally, you can restore the original look of a shot (or at least create an acceptable approximation 
of the original look) by opening up the tonal range as much as reasonably possible and by ensuring 
that colors look accurate. For more detailed information on how to achieve this with adjustments, see 
“Correcting Tonal Range” on page 725 and “Neutralizing Color” on page 726.

Adapting the Original Look

An adaptive adjustment deliberately departs from the original look of the scene in some way. For 
example, you might lighten one shot to make it match another. In this case, you are departing from 
the original look in order to achieve shot-to-shot consistency in your sequence. A more dramatic 
adaptive adjustment might be to apply a gold tint to an entire sequence for an advertising spot or to 
apply extreme adjustments such as posterization or chroma inversion for a music video.

It is good practice to make restorative adjustments before you begin adaptive adjustments. You can 
then build on an image that has good color characteristics. Most viewers can probably perceive the 
difference between a restored, well-balanced image with a strong blue tint applied and an unrestored, 
poorly lit image with a strong blue tint applied (and prefer the former).

(Media Composer |  Option) Remember that Media Composer can apply two levels of color 
correction and that some kinds of adaptive adjustments, especially if they are to apply equally to 
every shot in a sequence, are best applied as Program relationships. However, if your correcting work 
involves only restoration and simple matching for consistency from shot to shot, it is probably better 
to do all your work as Source relationship corrections. This keeps your color corrections simple and 
preserves the Program relationship option for any final adjustments that you might want to make.

Stages of Color Correction

A typical color correction for a shot might include the following main stages of adjustment:

• Correcting the tonal range (or contrast ratio).

• Neutralizing color casts.

• Achieving consistency between the shots in a sequence.

• Achieving a final look.

Different kinds of projects lead to different emphases among these stages and might even make some 
unnecessary. Different working habits also affect how you handle these stages. A more experienced 
colorist might work in a manner that blurs the distinctions between them. A beginner might prefer to 
keep them distinct and achieve an acceptable result for each one before moving on to the next.
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Guiding Principles for Color Correction
Correcting Tonal Range

Correcting the tonal range usually requires two steps. First, you reset the white and black points to 
make the range of values between the lightest part of the image and the darkest part of the image as 
large as possible. Second, you adjust the gray point to control how much of the total tonal range falls 
above and how much below the middle value.

Setting White and Black Points

Setting the white point and the black point is simple when a shot includes an area that should 
obviously be very light and another area that should be very dark. You look for what should be the 
lightest area of the image and adjust controls until it becomes as light as possible, and then do the 
same for the area that needs to be black. You can dramatically improve the quality of shots taken 
using insufficient or excessive light just by making white and black point adjustments.

In some cases, however, the shot should have a smaller brightness range (for example, when the 
whole scene was originally in shadow or was shot at sunset). In such cases, you need to be careful to 
expand the range as much as possible without making parts of the image unrealistically light or dark.

Do not clip any significant part of the image. You want the range between your lightest value and 
your darkest value to be as large as possible, but you don’t want to lose detail by reducing all your 
very light values to white or all your very dark values to black. 

Do not use intense reflected spots of light — speculars — to judge where your white point should be. 
If you do so, you define white by an artificial standard that probably occurs in only a tiny fraction of 
the image. A true white object such as an item of clothing might appear dull and gray by this 
standard.

You have a number of choices for controls to use to make white point and black point adjustments, 
including the Gain and Offset sliders in the Hue Offsets subdividing tab of the HSL group and the 
Master curve in the Curves tab. You can set all of these controls automatically using the Auto Black, 
Auto Contrast, and Auto White buttons. If necessary, you can begin with an automatic correction and 
then fine-tune the adjustment manually.

() You have a number of choices for controls to use to make white point and black point adjustments, 
including the Gain and Setup sliders in the HSL tab and the various controls in the Levels tab.

Adjusting the Gray Point

Once you establish the range from the brightest part of the image to the darkest part, you can adjust 
the gray point if necessary. When you make a gray point adjustment, you define how much of the 
overall tonal range is between black and midgray, and how much is between midgray and white. 

The most obvious effect of a gray point adjustment is that it either lightens or darkens the overall 
look of the image. Large adjustments of the gray point toward either the black point or the white 
point are almost always undesirable because they leave the whole image much too dark or too light.

Smaller, well-chosen gray point adjustments, however, are useful for fine-tuning the overall 
brightness of the image. Also, because a gray point adjustment expands the tonal range on one side of 
the midpoint and contracts it on the other, it can be useful for improving contrast and detail overall. 
For example, some images look better if more contrast is available in the range between gray and 
white, even though this reduces the contrast between gray and black.

The main control for making gray point adjustments is the Gamma slider in the HSL group.
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Guiding Principles for Color Correction
Neutralizing Color

Neutralizing color returns the colors in an image to the colors that a viewer would have perceived 
when standing beside the camera. Most film or video images depart from that ideal to some degree.

One way to think about neutralizing color is to imagine working on a project where every shot 
includes a large card that we know is a perfectly neutral midgray color when viewed in ideal lighting 
conditions. If you can correct each image so the card appears midgray when your audience views the 
final program, all other colors in the images should be correct also.

You cannot normally have such a perfect measuring device in your images, but you can select one 
area of each image as a target for your color neutralizing adjustments. If you focus on getting the 
color in that area right, color in the rest of the image should fall into place. In some images, there 
might be an object or area that should be neutral gray, or nearly so, and you can use that area as your 
principal target as you make adjustments. In fact, this is exactly how you make corrections to remove 
color casts using the Remove Color Cast buttons. In other images, you might not have any gray color 
at all, but you will probably have some other area where even a small departure from neutral color is 
noticeable. Human skin is the most common example. Or you might choose to focus on an area 
where you know the true color, such as a person’s hair.

In addition to identifying parts of your image on which to concentrate your attention, it is useful to 
establish how the uncorrected image departs from neutral color before you attempt to correct it.

Sometimes this is obvious. You cannot mistake an image with an extreme pink or yellow cast. When 
the problem is more subtle, you can sample a few areas with the Color Match eyedropper to get 
information about the color characteristics of the image. Areas that should be white or black are 
particularly helpful, since these are easily identifiable colors that should have nearly identical values 
for red, green, and blue. If the red value is higher than the other two, the image has a red cast. If red 
and green are higher than blue, the image has a yellow cast.

You can neutralize color using different controls in the Color Correction tool. For example, you can 
use the Curves tab to adjust the proportions of each color. Or you can use the Hue Offsets 
ChromaWheel controls, which let you quickly locate the sector of the wheel that represents the color 
cast in the image, and then adjust in the opposite direction to that color. You can make either of these 
adjustments automatically using the Auto Balance buttons, and then fine-tune manually if necessary.

(Symphony option) You can neutralize color using many different controls in the Color Correction 
tool. For example, you can use the Curves tab to adjust the proportions of each color. You can use the 
Hue and Saturation sliders in the Highlights, Midtones, and Shadows tabs of the HSL group. Or you 
can use the Hue Offsets color wheels, which let you quickly locate the sector of the wheel that 
represents the color cast in the image, and then adjust in the opposite direction to that color. Except 
when a color problem is extreme, you are usually more successful when neutralizing color if you 
make adjustments in individual colors or in specific brightness ranges rather than in the Master 
controls.

The more experienced you become as a colorist, the better you get at judging even subtle color 
problems by eye and knowing intuitively what kinds of adjustments to make.
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Guiding Principles for Color Correction
Achieving Shot-to-Shot Consistency

The most common reason for departing from the look of the original shot is to achieve simple shot-
to-shot consistency in the finished program. If a scene in a drama that is supposed to take place at one 
time is shot over two days, and lighting conditions have changed from one day to the next, you 
probably want to adjust all the shots so they appear to be taking place at the same time.

Adjustments for shot-to-shot consistency are straightforward in most cases. You simply need to 
compare shots in the Composer window and then adjust them to match. If you have already adjusted 
tonal range and neutralized color well, a small change to relative brightness might be all that you 
need. 

Depending on the requirements of your project, you might choose to make adjustments for shot-to-
shot consistency as Source or as Program relationship corrections. If you have made a lot of earlier 
Source relationship adjustments and you know you do not need to make overall adjustments for a 
finished look, you might choose to move to Program relationships to make shot-to-shot corrections. 
If you expect to need Program relationships for significant finishing adjustments that apply across all 
the segments in your sequence, you should stay with Source relationships when making shot-to-shot 
adjustments.

Color Correction Mode Pre-roll and Post-roll Playback

When you are in Color Correction mode, you can use the Segment Preview button to play a number 
of seconds of the previous clip and a number of seconds of the next clip. This allows you to see the 
colors in context of the scene. The default for the Pre-roll and Post-roll is 3 seconds.

To use Segment Preview to review your color corrections:

1. Enter Color Correction mode and make a color correction.

2. Click the Segment Preview button.

The last 3 seconds of the previous clip is played, followed by the entire current clip, followed by 
the first 3 seconds of the next clip.

3. Continue to make corrections and then use the Segment Preview button to review the corrections.

4. (Optional) If you want to change the default value of 3 seconds for pre-roll and post-roll, select 
File > Settings and click the User tab. Click Corrections and click the Preview tab and enter a 
new value. 

5. Click OK.
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Examples of Color Correction Problems
Achieving a Final Look

Some projects might require final adjustments to create a finished look. For example, you might 
slightly increase saturation across the whole sequence to create richer-looking colors or slightly 
darken all the shots to enhance a mood of tension or suspense. In certain circumstances, you might 
make substantial changes to the color values of the whole sequence or remove color entirely from 
some parts of it.

One way to make final corrections of this kind is to apply color correction to a filler track that is the 
topmost track in the Timeline. You usually make final corrections of this kind as Program 
relationship corrections by correcting entire program tracks or extended parts of sequences defined 
by IN and OUT points. It is not possible to generalize about which controls to use to make such 
adjustments. You might need to use any combination of color correction controls. The only effective 
preparation for such work is practice using the Color Correction tool and a good understanding of the 
more specific corrections discussed in the sections above. 

Examples of Color Correction Problems
The original images in the following examples require corrections to improve tonal range and to 
neutralize color casts.

Each example provides the following information:

• An analysis of the original image.

• Step-by-step descriptions of the corrections with illustrations (including split-screen displays in 
some instances).

• Sample RGB values that illustrate the results of the corrections.

• Suggestions for alternative ways to achieve similar results with the Color Correction tool.

These examples are intended as aids to learning, not as inflexible instructions for making corrections 
or models of what a perfect correction looks like. Each example shows only one possible way of 
making a correction and one possibility for a corrected image. As you develop your own color 
correcting skill and judgment, you might prefer to use different combinations of controls and to aim 
for a slightly different final look.
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Examples of Color Correction Problems
Example 1

Analysis of Original Image 

Uncorrected image

This image has two obvious problems. First, it lacks contrast and detail because it does not have a full 
tonal range. A correction will improve sharpness and detail in areas such as the shirt and the man’s 
hair. Second, the image has a strong yellow-green cast. This leads in particular to a very unnatural 
skin tone.

Step 1: Contrast Correction

The first step of this correction adjusts the Contrast slider in the () Master Controls tab of the HSL 
group. This adjustment, which sets the Contrast slider value to 11, illustrates one of the simplest 
ways to affect the tonal range of an image. Despite its simplicity, the correction improves the image 
noticeably. Compare the look of the man’s hair on either side of the split-screen dividing line.
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Examples of Color Correction Problems
Split screen: uncorrected image and image after Contrast correction

Step 2: ChromaWheel Correction

The second step of this correction removes the color cast by making a single adjustment on the 
Midtones ChromaWheel control on the Hue Offsets tab of the HSL group. In Symphony, the second 
step of this correction removes the color cast by making a single adjustment on the Master Hue 
Offsets ChromaWheel control in the HSL group. Because the image is obviously too green, the 
correction moves the crosshair pointer away from the green sector of the wheel. The adjustment 
shown is Hue:–94, Amount:11. This places the crosshair between the magenta and blue parts of the 
wheel, opposite a point between green and yellow. This successfully restores a good skin tone and 
reveals the man’s shirt to be blue.

A sampling of an area of the man’s shirt before and after the corrections shows the following RGB 
values:

• Before — R:37, G:56, B:61

• After — R:14, G:26, B:55

These numbers reinforce the nature of the corrections. The hue offset adjustment reduces the red and 
green levels significantly while preserving the amount of blue in the image.
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Examples of Color Correction Problems
Split screen: uncorrected image and image after both corrections

Alternative Techniques

There are several alternate ways to make the tonal range adjustments to this image. You could use the 
Gain, Gamma, and Setup sliders as an alternative to the basic adjustment on the Contrast slider. You 
could also use the Master ChromaCurve graph in the Curves tab.

(Symphony option) This example uses simple corrections that apply across the full luminance range. 
You could also correct this image by making individual adjustments in different ranges such as 
highlights and shadows. For an illustration of this approach, see “Example 2” on page 731. You 
could make the contrast adjustments using the Gain, Gamma, and Setup sliders as an alternative to 
the one adjustment on the Contrast slider. You could also make the contrast adjustment by using the 
controls in the Levels tab.

Example 2

Analysis of Original Image 

The highlight areas of this image (primarily the shirts) are not particularly bright, and the shadow 
areas (such as the underside of the cap brim) could be darker. Rebalancing white and black will 
improve contrast and sharpen the image throughout. Also, the image has a red cast, apparent in the 
slightly pink tone of the shirts. A good color-neutralizing correction will remove that cast without 
taking too much red out of the skin tones. Because the skin tones are relatively good in the image 
already, corrections should not disturb the midtones very much, so the corrections in this example 
occur primarily in the highlights and shadows luminance ranges.
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Examples of Color Correction Problems
Step 1: Master Controls Tab Corrections

The first step of this correction adjusts the Gain and Saturation sliders in the Master Controls tab. 
Gain is increased to 103.70, Saturation to 106.17. This brightens the whole image slightly and 
intensifies color throughout to correct the dull look of the original.

Step 2: Highlights Controls Tab Corrections

The second step is a large adjustment to the Gain slider in the Highlights Controls tab that increases 
the value to 148.15. This brightens the highlight areas considerably and brings much more sharpness 
and contrast into the lighter areas of the cap and into the shirt in the lower right corner.

Step 3: Shadows Controls Tab Corrections

The third step makes adjustments in the Shadows Controls tab. The adjustment values are Saturation: 
66.67, Setup: –9. This makes the darkest areas of the image more nearly black and further contributes 
to the building of contrast in the image.
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Examples of Color Correction Problems
Step 4: ChromaWheel Correction

The fourth step neutralizes the color cast in the highlights range with a large adjustment in the 
Highlights ChromaWheel. The adjustment values are Hue:–167.76, Amount:41.32. This removes the 
pink look in the shirts (most apparent by comparing the shirt in the background between Step 3 and 
Step 4). Because the adjustment affects the highlights range only, it does not result in an extreme loss 
of the red component of the skin tones.

A sampling of the darkest shadow area of the cap before and after the corrections shows the 
following RGB values:

• Before — R:24, G:24, B:22

• After — R:14, G:15, B:17

These values confirm that the corrections in the shadows area result in shadows that are a more 
intense black. 

Split screen: uncorrected image and image after all corrections

Alternative Techniques 

The Curves tab is the only other part of the Color Correction tool that allows adjustments specific to 
luminance ranges. You could probably achieve a similar final result in the Levels tab, but the 
adjustments there work on individual color channels rather than on different luminance ranges.
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Examples of Color Correction Problems
Example 3

Analysis of Original Image 

Uncorrected image and reference image

In this example, two different cameras have been used to shoot the rock climbers. The second camera 
is correctly balanced and shows good color characteristics, but the images from the first camera show 
a strong blue cast and are too dark. Corrections can neutralize color and raise the brightness level in 
the first image so that it more nearly matches the second. You can use the image from the good 
camera as a reference for the corrections. In this example, the corrections use the Curves tab. One 
advantage of Curves tab adjustments is that you can make quite complex changes without having to 
alter many controls. The corrections in this example add and then move a single control point in each 
of two ChromaCurve graphs.

Step 1: Blue ChromaCurve Correction

The first step of this correction removes the excess blue in the image by adjusting the Blue 
ChromaCurve graph in the Curves tab. A control point is placed near the center of the curve because 
the adjustment must apply relatively evenly across the whole luminance range. The control point is 
then moved down to reduce blue. The input and output values for this adjustment are 142 and 104 
respectively. 
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Examples of Color Correction Problems
Split screen: uncorrected image and image after Blue ChromaCurve correction

Step 2: Master ChromaCurve Correction

The second step of this correction increases the brightness of the image by making an adjustment on 
the Master ChromaCurve graph in the Curves tab. The control point is placed three-quarters of the 
way up the curve and moved up and to the left. The input and output values for this adjustment are 
178 and 213 respectively. The resulting curve increases brightness throughout the image but 
increases it most in the highlights range. This creates more contrast in the lower three-quarters of the 
luminance range (in a ChromaCurve graph, contrast is greater where the curve is steeper).

Split screen: uncorrected image and image after both corrections

The following illustration compares the corrected image to the reference image from the good 
camera. You could still fine-tune to match the shots more precisely, but the images from the two 
cameras are now much closer to one another.
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Examples of Color Correction Problems
Reference image and corrected image

A sample of one of the climber’s white helmets before and after the correction and in the reference 
image shows the following RGB values:

• Before — R:113, G:139, B:211

• After — R:142, G:152, B:174

• Reference — R:146, G:174, B:185

Though these samples might not be from precisely the same part of the helmet in all three cases, they 
clearly confirm the nature of the correction. They indicate a relative gain in red and green levels, a 
reduction in blue levels, and a much closer match with the levels in the reference frame.

Alternative Techniques

You could make the Blue ChromaCurve graph correction in the Hue Offsets tab or even with a series 
of adjustments to the HSL sliders in the Controls tab. You could make the brightness and contrast 
adjustment in the HSL tab (using similar techniques to those in example 1).

You could make the Blue curve correction in the Hue Offsets tab, in the Blue Levels tab, or even with 
a series of adjustments to the HSL sliders in the Controls tab. You could make the brightness and 
contrast adjustment in the HSL tab (using similar techniques to those in examples 1 and 2), or by 
adjusting white and gray points in the Levels tab.
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23 Safe Colors

This chapter provides information about the Safe Colors feature of Media Composer.

• Overview of Safe Color Limits

• Safe Color Settings Options

• Understanding the Graphical View of Safe Color Settings

• Understanding Safe Color Warnings

• Managing Safe Color Warnings

• Making Adjustments to Achieve Safe Color Values

• Safe Color Limits with Waveform and Vectorscope Information

• Working with the Safe Color Limiter Effect

Overview of Safe Color Limits
Media Composer can warn you when the color values in your sequence fall outside of a range that 
you specify. Media Composer can also limit all or part of your sequence to the safe color range that 
you specify. Media Composer lets you set three different types of safe color limits — for the 
composite signal range, for the luminance range, and for the RGB gamut.

Typically, safe color limits are useful to ensure that your sequence stays within a range of values 
acceptable for broadcast or for additional processing such as DVD encoding, or more generally to 
ensure that colors display well on television screens.

Most broadcasting companies set specific limits for the composite signal and the luminance range. 
Programs that do not meet these limits are not normally accepted for broadcast. For example, a 
typical set of limits for broadcast in the United States might restrict the composite signal to a range 
from –20 IRE to 110 IRE and limit the maximum luminance to approximately 100 IRE..

n The composite signal for a program intended for broadcast should never exceed 120 IRE, which is 
the highest level that can be broadcast.

If you are working on a program intended for broadcast, you should determine what the safe limits 
for composite and luminance are and type them in the appropriate areas of the Safe Color Settings 
dialog box. You can then instruct Media Composer to warn you when those limits are exceeded. For 
more information, see “Safe Color Settings Options” on page 738.

RGB gamut refers to the intensity of each individual color channel — red, green, and blue. This 
measure of a safe color is less likely to be subject to specific broadcast standards, but it is still an 
important limit type. Colors that have extremely low or high gamut values might not display well on 
television screens. 



Safe Color Settings Options
Safe Color Settings Options
You set safe color limits and control how Media Composer applies those limits by selecting options 
in the Safe Color Settings dialog box. For information on how to open the Safe Color Settings dialog 
box and set limits and options, see “Managing Safe Color Warnings” on page 741.

The Safe Color Settings button in the Color Correction tool provides a visual indication of the status 
of the Safe Colors feature. If Warn is selected in one or more of the Actions menus, the icon on the 
Safe Color Settings button appears orange to indicate that at least some of the Safe Colors options are 
active. Otherwise, the icon on the Safe Color Settings button appears black.

The following table describes the available limit types, units of measurement, and types of action in 
the Safe Color Settings dialog box.

Option Description

Composite Defines safe color values for the composite video signal.

Luminance Defines safe color values based on brightness.

RGB Gamut Defines safe color values based on color range.

Units buttons Define the units of measurement for the three types of safe color values.

Click the Composite Units button and select either IRE or mVolts (millivolts).

Click the Luminance and RGB Gamut buttons and select from the following options:

• 8 Bit: Measures the adjustment on a scale from 0 to 255.

• % (percent): Measures the adjustment on a percentage scale. Percentage values can be 
lower than 0 or higher than 100..

• IRE: Measures the adjustment in IRE units.

• mVolts: Measures the adjustment in millivolts.

n The RGB value for a color in the Color Correction tool is not identical to the RGB 
value for the same color in a graphics application such as Adobe® Photoshop®. For 
example, the 8-bit RGB values for reference black and reference white are 16 and 
235 respectively.

Actions buttons Define how Media Composer implements the safe color settings. The top button controls 
both the Composite and the Luminance limit types. The bottom button controls the RGB 
Gamut limit type. 

Click an Actions button and select from the following options:

Ignore: Media Composer does not limit based on these settings. This is the default setting.

Warn: Media Composer provides warnings when these limits are exceeded. For more 
information on safe color warnings, see “Understanding Safe Color Warnings” on 
page 740.
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Understanding the Graphical View of Safe Color Settings
Understanding the Graphical View of 
Safe Color Settings

The Safe Color Settings dialog box provides a graphical display of the current limit values in relation 
to the default values. This lets you quickly check that your limits are consistent with one another and 
within an acceptable range without having to read all the numerical limit values and remember the 
default values.

The following illustration shows the location of this graph within the Safe Color Settings dialog box. 
All settings in this illustration are at their default values.

Safe Color Settings graph in the Safe Color Settings dialog box

The graph shows colored bars that represent the current low and high levels for each limit type. The 
colors are the same as those used to display safe color warnings in the monitors. It also displays gray 
vertical lines that represent the default high and low levels for each limit type.

The following illustrations present two graphs in detail — the first showing default levels and the 
second showing adjusted levels — and explain how to interpret the graphs.

Default Safe Color Settings values (top) and their representation in the Safe Color Settings graph (bottom). The colored 
bars represent (top to bottom) the Composite, Luminance, Red, Green, and Blue levels. Bars on the left indicate the low 
limit, while bars on the right indicate the high limit.
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Understanding Safe Color Warnings
Adjusted Safe Color Settings values (top) and their representation in the Safe Color Settings graph (bottom). Colored 
bars that extend past the gray lines toward the center of the graph indicate a setting that is more restrictive than the 
default. Colored bars that retreat from the gray lines toward the edges of the graph (as the top two bars on the right do) 
indicate a setting that is less restrictive than the default.

Understanding Safe Color Warnings
If you select the Warn option for one or more of the types of safe limit, Media Composer displays 
warnings when material exceeds the limits you have set. You select the Warn option using the 
Actions button (see “Managing Safe Color Warnings” on page 741).

Warnings appear in the monitors for all limit types — Composite, Luminance, and RGB Gamut. The 
warning indicators do not appear unless color levels exceed at least one of the limits currently set to 
Warn. Warnings appear in the Color Match control for RGB Gamut limits only.

n Safe color warnings appear when you exceed limits in either field of the frame if you are working 
with two-field media. To move through video material one field at a time and see safe color 
information for every field, use the Step Forward One Field button or the Step Backward One Field 
button. In Color Correction mode, these buttons are available on the Move tab of the Command 
palette. You can also map these buttons to your keyboard to use them quickly while using Color 
Correction mode.

Safe Color Warnings in the Monitor Window

When Media Composer is set to provide safe color warnings, warning information appears in the 
monitor window for any image whose color values are outside the safe range. You see an orange safe 
color warning triangle in the top left corner of the image, along with warning indicators for each of 
the safe color value types that are currently set to warn. Warning color bars appear in one of three 
places in a column:

• At the top (indicating a level that is too high)

• At the bottom (indicating a level that is too low)

• In the center (indicating a level that is within limits)

The following illustration shows a typical warning indicator display.
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Safe Color warning indicators for monitors. In this example, the Composite (yellow), Red, and Green levels exceed the 
current limits at the high end, while the Red and Green levels also exceed the current limits at the low end. The 
Luminance (white) and Blue levels are within limits.

If a warning indication displays in the monitor for an image, you can choose to leave the image with 
color values that exceed your safe limits, or you can make one or more color corrections to bring the 
levels back within safe limits. Once all levels are within safe limits, the warning triangle and warning 
indicators no longer display in the monitor.

For suggestions on specific correction steps you might take to bring color values within safe limits, 
see “Making Adjustments to Achieve Safe Color Values” on page 742.

Safe color warning information might also appear in the Color Match color swatches and in 
waveform and vectorscope displays. For more information, see below and “Safe Color Limits with 
Waveform and Vectorscope Information” on page 743.

Safe Color Warnings in the Color Match Control

If you select the Warn option for the RGB Gamut limit type, Media Composer displays warnings in 
the color swatches of the Color Match control when values exceed the limits you have set. If you use 
the eyedropper to select an input or output color that exceeds limits, a warning triangle appears 
beside the color information in the appropriate color swatch. The following illustration shows a 
swatch with typical Safe Color warnings.

In this example of a Color Match swatch for an intense white color, both the Red and Green levels exceed the High RGB 
Gamut setting of 235 and warning triangles appear. The Blue value remains just within the limit.

Managing Safe Color Warnings

You turn safe color warning on or off, and set the range of values Media Composer should consider 
safe, in the Safe Color Settings dialog box.

For more information about the Safe Color Settings dialog box, including information about safe 
color value ranges and unit types, and about the graphical display of safe color settings that appears 
at the bottom of the dialog box, see “Safe Color Settings Options” on page 738 and “Understanding 
the Graphical View of Safe Color Settings” on page 739.

The following illustration shows the Safe Color Setting dialog box.
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Making Adjustments to Achieve Safe Color Values
Units buttons (left) and Actions buttons (right) in the Safe Color Settings dialog box

To open the Safe Color Settings dialog box, do one of the following:

t Select File > Settings, click the Project tab and double-click Safe Colors.

t In the Color Correction tool, click the Safe Color Settings button.

To turn safe color warning on or off:

t Click one of the Actions buttons in the Safe Color Settings dialog box, and select Warn to turn 
safe color warning on or Ignore to turn safe color warning off.

The top Actions button controls Composite and Luminance warnings. The bottom Actions 
button controls RGB Gamut warnings.

To set a safe color value range for one of the value types (Composite, Luminance, or RGB 
Gamut):

1. Click the Units button for the value type you want to set in the Safe Color Settings dialog box, 
and select a unit of measurement for your values.

2. Type low and high values in the text boxes for the value type.

For example, you might enter values supplied by a broadcaster or encoder.

Making Adjustments to Achieve Safe Color Values
If some of your color levels exceed limits, you can return them to safe color values by adjusting the 
color correction controls in any combination. The following example procedures show how to make 
various adjustments using the Controls subdividing tab of the HSL group and the Curves group.

n You can also use the Safe Color Limiter effect to achieve safe color values automatically. For more 
information, see “Working with the Safe Color Limiter Effect” on page 745.

To bring luminance within safe limits:

1. Click the Controls subdividing tab in the HSL group.

The Controls tab opens.

2. Click the Enable button for the HSL group and the Controls subdividing tab.

3. Click the Enable button for Clip Low and Clip High controls to activate them.

4. Type 16 in the Clip Low text box, and press Enter (Windows) or Return (Macintosh).

5. Type 235 in the Clip High text box, and press Enter (Windows) or Return (Macintosh).

Media Composer clips Luma values to safe levels.
742



Safe Color Limits with Waveform and Vectorscope Information
To bring RGB values within safe limits:

1. In the Master ChromaCurve graph of the Curves tab, click the lower left control point to select it.

A circle appears around the point.

2. Under the Master ChromaCurve graph, type 16 in both the input text box and the output text box.

The control point moves to 16, 16. Media Composer adjusts RGB values under 16 up to 16.

3. In the Master ChromaCurve graph of the Curves tab, click the upper right control point to select 
it.

A circle appears around the point.

4. Under the Master ChromaCurve graph, type 235 in both the input text box and the output text 
box.

The control point moves to 235, 235. Media Composer adjusts RGB values above 235 down to 
235.

To bring composite levels within safe limits:

1. First adjust luminance and RGB levels using the previous procedures.

If composite levels do not fall within safe limits, continue with step 2.

2. Click the Curves tab.

3. If the composite high warning is on, do the following:

t In the Master ChromaCurve graph, Shift+click the upper right control point, and drag it 
down the curve until the composite high warning turns off.

4. If the composite low warning is on, do the following:

t In the Master ChromaCurve graph, Shift+click the lower left control point, and drag it up the 
curve until the composite low warning turns off.

Safe Color Limits with Waveform and 
Vectorscope Information

Broadcasters or distributors often issue safe color limits for video levels. Video levels outside safe 
color limits are generally known as “illegal” A program with illegal levels might be rejected on 
technical grounds or the image quality might suffer with further processing. You might want to set 
reasonable limits for yourself even if you are not aware of specific limits that you must meet.

In Y (luma only) waveforms, reference white of 100% corresponds to a digital level of 235, an NTSC 
level of 100 IRE, and a PAL level of 700 mV. White excursions up to 108% are technically possible.

In Y (luma only) waveforms, reference black of 0% corresponds to a digital level of 16, an NTSC 
level of 7.5 IRE, and a PAL level of 0 mV. Black excursions down to –8% are technically possible.

n With both white and black levels, further signal processing after output from Media Composer might 
clip the peaks in your material. In addition, delivery specifications might require you to limit the 
white peaks to a lower level and the black peaks to a higher level. 
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Use Y Waveform to see the black and white levels of your image. Sometimes, particularly with white 
levels, keeping the white peaks within the 100% limit does not produce a pleasing level for the rest of 
the image. This is particularly common with backlit subjects, where the sky or a window is in the 
background and the lighting on the foreground is insufficient. In these cases, you might want to 
adjust for the foreground and leave the background too bright. 

Chroma peaks are easiest to see on the vectorscope. The theoretical maximum is the circle around the 
outer edge, but to be safe you might like to keep vectors closer to the center than the 75% color bar 
squares. 

Saturated bright or dark colors might have very low or high luma values, together with a lot of 
chroma. Even if neither luma nor chroma alone is excessive, the combination can be illegal. For 
example, vivid yellow and cyan in an image can produce composite levels that are too high, and those 
from vivid blue might be unacceptably low. The YC Waveform is a good way to see how far these 
levels extend. In general, avoid levels above approximately 120 IRE or 850 mV, and those below –20 
IRE or –200 mV. 

n If you are producing a master for broadcast delivery, ask for delivery specifications. To ensure you 
meet particular standards, use a legalizer such as the Safe Color Limiter effect or a third-party AVX™ 
plug-in.

These instruments do not measure analog outputs. If your Avid editing system or other device uses 
analog connections, use an external Waveform monitor to verify levels.

The Y Waveform, YC Waveform, and RGB Parade displays incorporate any safe color limits you 
have set. The following table describes the colors used to represent various conditions. “Legal” 
means the value is within the safe color limits. “Illegal” means the value is outside (either above or 
below) the safe color limits.

Display Component Value Display Color

Y Waveform Luma Legal Green

Illegal White

YC Waveform Composite Legal Cyan

Illegal Yellow

Luma Legal Green

Illegal White

Composite or Luma Outside display boundaries Red

RGB Parade Red Legal Red

Illegal White

Green Legal Green

Illegal White

Blue Legal Blue

Illegal White
744



Working with the Safe Color Limiter Effect
Working with the Safe Color Limiter Effect
In addition to the safe color warning system, you can also limit colors to safe ranges by applying the 
Safe Color Limiter effect. The Safe Color Limiter effect modifies color and luminance values in 
video material to bring the material within the safe color limits you define. If you use the Safe Color 
Limiter effect, you do not have to make manual adjustments in the Color Correction tool to ensure 
that video is within limits.

Understanding the Safe Color Limiter Effect

The Safe Color Limiter effect has effect parameters that control high and low color limits for 
luminance, composite signal, and red, green, and blue color gamut. It also lets you change the units 
for measuring these limits. These parameters parallel the options available in the Safe Color settings.

When you first apply a Safe Color Limiter effect, its parameters default to the current limits in the 
Safe Color settings. In the simplest situation, you can set limits in the Safe Color settings that meet 
your needs (for example, luminance or composite signal standards set by a broadcaster), and then 
apply the Safe Color Limiter effect to the video material you need to limit. Without any further 
adjustment, the effect modifies the color and luminance values of any pixels in the video material that 
exceed your limits, ensuring that the video meets the required standards. For more information on 
safe color limit values and possible reasons for using them, see “Overview of Safe Color Limits” on 
page 737.

When you want to make adjustments to the safe color limits that a Safe Color Limiter effect is using, 
you do so using parameter controls in the Effect Editor. You can also view an analysis of the image in 
the Source monitor that makes it easy to see exactly which pixel areas in an image are outside the 
limits set for the effect. For more information, see “Using the Safe Color Limiter Analysis Display” 
on page 746.

The following information provides important additional details on how the Safe Color Limiter effect 
operates:

• The Safe Color Limiter automatically takes variations in broadcast formats into account, for 
example the differences between PAL and NTSC material, and the difference in the setup offset 
between NTSC and NTSC-J.

• Because the primary purpose of safe color limiting is to ensure that video is acceptable for SD 
broadcast, all limiting by the Safe Color Limiter effect is performed in the 601 color space. 
When you are working with HD material in the 709 color space, the Safe Color Limiter converts 
the material to the 601 color space to apply limiting, and then converts back to the 709 color 
space.

• Like many other Avid effects, the Safe Color Limiter effect supports both 8-bit and 16-bit 
processing. For more information, see “Using 16-Bit Processing Support for Rendered Effects” 
on page 138.

Applying the Safe Color Limiter Effect

A common scenario for applying the Safe Color Limiter effect is to apply it to filler on the top track 
in the Timeline so that the effect acts on the entire duration of the sequence. Depending on your 
needs, you might also want to apply a Safe Color Limiter effect to a single segment in a sequence, or 
to multiple selected segments.
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To apply the Safe Color Limiter effect:

1. Set the default safe color limits you want the Safe Color Limiter effect to use.

For more information, see “Managing Safe Color Warnings” on page 741.

2. (Option) If you want to apply the effect across the entire duration of the sequence, add a new 
video track in the Timeline, for example, by selecting Timeline > New > Video Track.

3. Do one of the following:

t If you are applying the Safe Color Limiter effect to the entire duration of the sequence, drag 
the effect from the Image category of the Effect Palette, and drop it on the empty top video 
track.

The top video track shows filler material with the Safe Color Limiter effect applied to it, and 
Media Composer limits all of the video material in the sequence according to the limit 
values you set in step 1.

t Apply the effect to one or more segments using standard methods, as described in “Applying 
Effects From the Effect Palette” on page 27.

Media Composer limits the video in the segment or segments to which you applied the effect 
according to the limit values you set in step 1.

By default, when the Effect Editor is open, the effect changes the display in the Source monitor 
to an analysis mode that highlights pixels in the image that fall outside the current safe color 
limits. For more information on using and understanding this display, see “Using the Safe Color 
Limiter Analysis Display” on page 746.

4. If necessary, enter Effect mode and adjust effect parameters in the Effect Editor.

For more information, see “Adjusting Effects” on page 31. You can adjust the low or high limit 
values for each limit type (composite, luminance, or RGB gamut). You can select the units used 
to measure the limit values. You can also turn the effect analysis display on or off. For reference 
information on all the Safe Color Limiter effect parameters, see “Image: Safe Color Limiter” on 
page 468.

Using the Safe Color Limiter Analysis Display

An effect analysis display appears by default in the Source monitor when you apply a Safe Color 
Limiter effect. The following illustration shows a typical display.
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Working with the Safe Color Limiter Effect
The effect analysis display has two layers. The background layer is a copy of the image with 
luminance reduced to allow the foreground information to stand out clearly. The foreground layer 
highlights those pixels in the image whose color values fall outside the limits currently being used by 
the effect — that is, pixels that are being modified by the effect.

The color scheme used for the highlighting is the same as that used for the safe color warning 
indicators that can appear in the monitors in Color Correction mode:

In the illustration above, the pixels highlighted in yellow have color values that fall outside the 
composite limits currently being used by the effect.

When you adjust the limit parameters in the Effect Editor, the analysis display updates. For example, 
if you adjust a limit parameter so that it permits a larger range of values, fewer pixels are highlighted 
in the analysis display.

n If a pixel in the image falls outside current limits for multiple limit types, the analysis display uses the 
color for only one of the types to highlight the pixel. As a result, for example, you might adjust the 
RGB gamut limits so that a pixel no longer has a blue highlight and find that the display highlights 
the pixel using yellow. This is because that pixel is still being limited by the composite limits.

Color Description

Yellow Indicates pixels that fall outside composite limits.

White Indicates pixels that fall outside luminance limits.

Red Indicates pixels that fall outside RGB gamut limits for red.

Green Indicates pixels that fall outside RGB gamut limits for green.

Blue Indicates pixels that fall outside RGB gamut limits for blue.
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24 (Media Composer | Symphony Option) 
Spot Color Correction

This chapter provides information on using the Spot Color Correction effect and using color 
adjustment modes in the Paint Effect.

• Understanding the Spot Color Correction Effect

• Making Corrections Using the Spot Color Correction Effect

• Using Paint Effect Modes for Color Adjustment

Understanding the Spot Color Correction Effect
The Spot Color Correction effect lets you make precise color adjustments to a part of an image that 
you define using the Intraframe drawing tools. 

For example, you can outline a figure in a shot or isolate a single object and then adjust the color of 
that figure or object without affecting the color of the rest of the image. You can use keyframes if 
necessary to adjust the effect over time.

Spot color correction is commonly used as a storytelling device that emphasizes part of an image by 
giving it distinct color characteristics. You can also make color corrections using spot color 
correction whenever you want a color adjustment to be restricted to only part of the image.

You can often correct the color in selected areas of an image more quickly and easily using the 
secondary color correction capabilities of the Color Correction tool. However, color corrections that 
define part of an image using drawing tools are sometimes the only way to isolate the exact area of an 
image that you need to correct. For more information on secondary color correction, see “(Media 
Composer | SymphonyOption) The Secondary Group” on page 680.

The following illustrations show two basic examples of spot color correction. In the first example, the 
background of the shot is outlined with a drawing tool and then desaturated and lightened, leaving 
the car as the only part of the image in color. Additional shapes are drawn within the main outline of 
the car to remove any color visible through the car’s windows. In the second example, the straw bale 
on the left is outlined with a drawing tool and then enhanced with color adjustments to give it a 
stronger golden-yellow appearance.



Making Corrections Using the Spot Color Correction Effect
You can also make color adjustments to Intraframe objects using various modes in the Paint Effect. 
For more information, see “Using Paint Effect Modes for Color Adjustment” on page 750. However, 
you can apply only one kind of adjustment to a selected area using the Paint Effect. Using the Spot 
Color Correction effect, you can enable several kinds of color adjustments at the same time.

Making Corrections Using the Spot Color Correction 
Effect

To make corrections using the Spot Color Correction effect:

1. Select Tools > Effect Palette.

The Effect Palette opens.

2. Click the Image category.

3. Click the Spot Color Correction Effect icon in the Effect Palette, and drag it to the segment you 
want to correct in the Timeline.

4. Click the Effect Mode button to enter Effect mode.

5. From the Effect Editor, select a drawing tool, such as the Polygon tool.

6. Use the drawing tool to define the area on the image that you want to correct.

For more information on working with the Intraframe drawing tools, see “Intraframe Editing” on 
page 382.

7. Adjust parameters in the Effect Editor until you are satisfied with the look of your correction.

For information on the parameters available, see “Image: Spot Color Correction (Media 
Composer | Symphony Option Only)” on page 469.
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8. (Option) If necessary, repeat steps 3 through 6 to define and adjust additional areas for 
correction.

9. (Option) If necessary, use keyframes to adjust the corrected areas over time so that they follow 
movements in the footage.

For more information on keyframing Intraframe objects, see “Intraframe Example: Animating a 
Matte Key Effect” on page 429.

10. Render the effect to play it back in real time.

Using Paint Effect Modes for Color Adjustment
The main difference between color correction using the Paint Effect and color correction using the 
Spot Color Correction effect is that you can use the Paint Effect to apply only one kind of color 
adjustment. For example, you can adjust the luma range of a selected area by selecting the Luma 
Range mode of the Paint Effect, but you cannot then make an adjustment to the red color channel 
using the Color Gain mode. The Paint Effect can apply only one mode to an object.

To make a correction to an area in an image using a Paint Effect mode:

1. Select Tools > Effect Palette.

The Effect Palette opens.

2. Click the Image category.

3. Click the Paint Effect icon in the Effect Palette, and drag it to the segment you want to correct in 
the Timeline.

4. Click the Effect Mode button to enter Effect mode. 

5. From the Effect Editor, select a drawing tool, such as the Polygon tool.

6. Use the drawing tool to define the area on the image that you want to correct.

For more information on working with the Intraframe drawing tools, see “Intraframe Editing” on 
page 382.

7. In the Mode parameter category, click the Fast Menu button, and select one of the following 
color adjustment modes:

- Luma Adjust

- Luma Range

- Luma Clip

- Chroma Adjust

- Color Style

- Color Gain

- Color Match

8. Adjust the parameters in the Mode parameter category until you are satisfied with the look of 
your correction.

For information on Paint Effect modes, see “Image: Paint Effect” on page 467.

9. (Option) If necessary, repeat steps 5 through 8 to define and adjust additional areas for 
correction.
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Using Paint Effect Modes for Color Adjustment
10. (Option) If necessary, use keyframes to adjust the corrected areas over time so that they follow 
movements in the footage.

For more information on keyframing Intraframe objects, see “Intraframe Example: Animating a 
Matte Key Effect” on page 429.

11. Render the effect to play it back in real time.
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25 Using Avid Artist Color

This section includes topics that provide information on configuring and using Avid Artist Color with 
Media Composer. Avid Artist Color employs the EUCON™ (Extended User Control) protocol, which 
allows for integrated control of Media Composer and EUCON-compatible devices. You can use the 
device with Media Composer to adjust the color characteristics of video material that you have edited 
into a sequence.

• Installing EuControl Software and Configuring the Avid Artist Color

• Using Artist Color

• Avid Artist Color Soft Keys

• Customizing Avid Artist Color Controls

• Avid Artist Color Controls

• Controller Application Sets

Installing EuControl Software and Configuring the Avid 
Artist Color

Artist Color uses the EUCON control protocol to manage the communication between the device and 
Media Composer. The EuControl application finds, links, and communicates all Avid Artist Series 
controllers on your network. You must install EuControl on your system before you can use Avid 
Artist Color with Media Composer.

For more information on installing and configuring EuControl, see the following topics:

• “Installing EuControl Software” on page 752

• “Configuring Avid Artist Series Controller Settings” on page 754

• “Configuring Ethernet Connections (Macintosh)” on page 754

• “Setting the IP Address” on page 755

• “Configuring EuControl Settings” on page 758

Installing EuControl Software

The EuControl application controls your Artist Series controller and communicates with Media 
Composer. You must install EuControl before you use any Artist Series controller.

If you want to connect your Artist Series controller to an Avid editing system that is part of an 
Avid ISIS shared storage environment, the following requirements apply:

• (Macintosh only) Avid recommends that you connect your Artist Series controller to the built-in 
Ethernet 1 port on your Macintosh system. If you have limits to the number of Ethernet 
connections you use — for a corporate network or for shared storage — you might need to set 
the service order for your Artist Series controller to a lower priority than your other Ethernet 
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connection. For more information on configuring your Ethernet connections, see “Configuring 
Ethernet Connections (Macintosh)” on page 729. You can change port assignments in the 
EuControl Settings application if necessary.

• Avid also recommends that you disable the network interface you use for your Artist Series 
controller in the ISIS Client Manager preferences. This prevents ISIS from trying to use the 
Ethernet port assigned to EUCON for your shared storage operations. For more information, see 
the Avid ISIS Client Guide that came with your ISIS product.

• Avid ISIS supports dual Ethernet connections to maximize bandwidth use and increase 
performance. Since your Artist Series controller must use one Ethernet port to connect to your 
Avid editing system, Avid does not support dual connection on Macintosh systems connected to 
an ISIS switch.

• Artist Series controllers do not support connection through a third-party Ethernet card.

To install EuControl:

1. Do one of the following:

t If you downloaded the latest software from the Avid Web site, double-click the installer.

t Insert the installation CD into your system, and double-click the installer.

2. Follow the on-screen instructions to install the software.

n Download the most current version of EuControl if prompted to do so during installation.

When installation completes, EuControl launches automatically.

3. You should check for updated firmware for your Artist Series controller by doing the following:

a. Do one of the following:

t (Windows) Double-click the EUCON icon in the notification area.

EUCON icon in the notification area

t (Macintosh) Click the EUCON icon in the dock, and then select Window > EuControl 
Settings.

The EuControl Settings dialog box opens.
753



Installing EuControl Software and Configuring the Avid Artist Color
b. Click the Surfaces tab, and then click Update Firmware.

If there is updated firmware for your Artist Series controller, EuControl automatically 
downloads it.

c. Follow the on-screen instructions to install the new firmware.

4. Shut down your system.

5. Connect your Artist Series controller. For information on setting up your Artist Series controller, 
see the documentation that came with your equipment.

Configuring Avid Artist Series Controller Settings

You use the Controller Settings dialog box to configure Media Composer so that it can communicate 
with your Artist Series controllers. 

To configure Media Composer for an Artist Series controller:

1. Select File > Settings, click the User tab and double-click Controller Settings.

The Controller Settings dialog box opens.

2. Select Controller > EUCON Controller.

3. Click OK.

Configuring Ethernet Connections (Macintosh)

You can connect your Artist Series controller to either the Ethernet 1 or Ethernet 2 port on your 
Macintosh system. By default, the EuControl application is configured to use Ethernet 1. You might 
need to change this configuration if your system connects to a corporate network or if it is part of a 
shared storage environment — for example, if you connect your Macintosh system to an Avid ISIS 
system.

The following procedure describes how to configure your network connections if you need to reserve 
one Ethernet port for a network or shared storage connection. You can use either Ethernet port for 
your Artist Series controller, but you should set the network priority for your network or storage 
connection higher than the priority for your Artist Series controller.
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To configure Ethernet ports on a Macintosh system:

1. Connect your Artist Series controller to either the Ethernet 1 or Ethernet 2 port on your 
Macintosh system.

2. Select the Apple menu > System Preferences.

3. In the Other area, click Euphonix.

The Euphonix dialog box opens.

4. Click the Network Interfaces menu and select either Ethernet 1 or Ethernet 2, depending on 
which Ethernet port you want to use for your Artist Series controller.

5. Close the Euphonix dialog box.

6. Select the Apple menu > System Preferences.

7. In the Internet & Wireless area, click Network.

The Network dialog box opens.

8. Click the Action menu and select Set Service Order.

The Service Order dialog box opens.

9. If the Ethernet connection you want to use for your corporate network or shared storage 
connection is not at the top of the network connections list, select that Ethernet connection and 
drag it to the top of the list. For more information on setting the service order, see the Apple Help 
for your Macintosh system.

10. Click Apply, and then close the Network dialog box.

Setting the IP Address

Avid Artist Series controllers typically use Dynamic Host Configuration Protocol (DHCP) to obtain 
its IP address, usually from a router. The controllers revert to link-local addressing to generate an IP 
address if a DHCP server is not found on the network — for example, when you connect a controller 
to a system using an Ethernet cable. You can override these methods of obtaining IP addresses by 
supplying a static IP address, which the devices use in all cases when turned on.
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n Avid does not recommend setting up static IP addresses unless you have experience in configuring 
network properties.

To set a static IP address (Avid Artist Control):

1. Press and hold the Page Left and Page Right keys while you press and release the Power button.

The Network Setup screen appears on the Touchscreen.

2. Touch Use DHCP (Obtain IP Address automatically).

The parameter is deselected, and the Touchscreen displays the IP Address and Subnet Mask 
fields.

3. Touch the first box of the IP Address field to select it, and then adjust its value by turning any of 
the eight knobs or the Jog wheel.

4. Repeat the previous step to adjust all values of the IP Address and the Subnet Mask fields.

5. Touch OK to save this static IP address. Turn off the controller and then turn it on to use the new 
IP address.

You can touch Cancel at any time to discard changes made to the IP address.
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To set a static IP address (Avid Artist Transport):

1. Press and hold the two soft keys on the left while you press and release the Power button. Hold 
down the soft keys until the Use DHCP screen appears in the display.

2. Turn the Jog wheel clockwise to change the Use DHCP value from yes (default) to no.

You can use the + (plus) and – (minus) keys instead of the Jog wheel to decrease or increase the 
value, respectively.

3. Press the Enter key to move the cursor to the next screen.

4. Do one of the following:

t Use the Jog wheel to set the value of the IP Address field.

t Press the + (plus) key or the – (minus) key on the numeric keypad to increment or decrement 
the value. You can also use the numeric keypad to enter the number directly.

5. Repeat step 3 and step 4 to adjust all values of the IP Address and the Subnet Mask fields.

You can press the Enter key to move the cursor forward until the first screen reappears to change 
a parameter to a different value.

6. Press the two soft keys on the left at the same time to save this static IP address. Turn off the 
controller and then turn it on to use the new IP address.

You can discard changes made to the IP address at any time by turning off the controller before 
saving your changes.

To set a static IP address (Avid Artist Mix):

1. Press and hold the Page Left and Page Right keys while you press and release the Power button.

The Use DHCP screen appears in the channel display for fader strip 1.

2. Turn the knob underneath the display clockwise to change the Use DHCP value from yes 
(default) to no.

You can use the SEL and ON keys instead of the knob to decrease or increase the value, 
respectively.

3. Press the Page Right key or the Top key to move the cursor to the next screen.
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4. Use the knob to set the value of the IP Address field.

5. Repeat step 3 and step 4 to adjust all values of the IP Address and the Subnet Mask fields.

You can press the Page Left key to move the cursor back to the previous field or screen to change 
a parameter to a different value.

6. Press the Page Left and Page Right keys at the same time to save this static IP address. Turn off 
the controller and then turn it on to use the new IP address.

You can discard changes made to the IP address at any time by turning off the controller before 
saving your changes.

Configuring EuControl Settings

Before you can use an Artist Series controller with Media Composer, you must configure the 
EuControl settings. You can connect your Artist Series controller to the EuControl application on 
your system so you can use it as a controller, connect additional workstations so they can access the 
controllers, and assign functions to buttons and keys on the Artist Series controller.

The EuControl application starts when you start your computer and runs in the background. Avid 
recommends that you make sure EuControl is running before you start Media Composer.

For a full description of configuration procedures and options, see the documentation that came with 
your Artist Series controller.

To connect an Artist Series controller to your system:

1. Connect your Artist Series controller to your system and turn on the power for the device.

2. Start Media Composer.

3. Do one of the following:

t (Windows) Double-click the EUCON icon in the notification area.

EUCON icon in the notification area

t (Macintosh) Click the EUCON icon in the dock, and then select Window > EuControl 
Settings.

EuControl Settings application opens. The All Surfaces list displays all available Artist Series 
controllers.
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4. Click the Automatically add: menu, and select one of the following:

t To add all controllers listed in the All Surfaces list — which lists all devices available on 
your subnet — select All Surfaces. This setting is useful when you are the only person 
running EuControl on your network.

t To add only those controllers listed in the My Surfaces, select My Surfaces Only. Since only 
one user at a time can control a surface, this avoids claiming surfaces needed by other users 
on your network.

The selected devices are connected to EuControl.

5. (Option) If you select My Surfaces Only and you want to specify additional controllers to 
connect to your EuControl application, select a controller in the All Surfaces list, and then click 
Add.

The controller appears in the My Surfaces list. You can rearrange the order of the controllers 
using the up and down arrows, and you can remove controllers from the list using the Remove 
button. You can also rename the controller, which allows you to easily identify multiple 
controllers in the My Surfaces list.

6. Click the Workstation tab.

The Workstations tab opens. The All Workstations list displays all systems on your subnet that 
have been configured for access to the available Artist Series controllers.
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7. (Option) If you want more than one workstation to access your Artist Series controllers, do the 
following:

a. Select the workstation in the All Workstations list and click Add.

b. Select the workstation in the My Workstations list and click Attach.

A check mark appears in the Attached column in the My Workstations list. The workstation can 
now access the Artist Series controllers connected to EuControl.

8. Close the EuControl Settings application.

Using Artist Color
You can use your Avid Artist Color media controller to perform color correction functions available 
in Media Composer in the Color Correction tool, including the following:

• Make hue, saturation, and luminance (HSL) corrections

• Apply automatic color corrections

• Toggle color corrections on and off, so you can see the effect of your corrections

• Adjust color and luminance using ChromaCurve graphs

• Save and apply color correction templates

• Make color correction adjustments on source stereoscopic clips

• (Symphony Option) Make adjustments using the Secondary group controls

These functions allow you to adjust color in your sequences using the controller rather than the 
controls, buttons, and graphs in the Color Correction tool. For example, you can use the center 
trackball to adjust the midtone hue offset for a segment in the Timeline, and then you can use the left 
Soft Knob to adjust the overall hue for the segment.

Some color correction functions are mapped to your Artist Color by default. If you want to access 
other editing functions, you can customize the controls by mapping other functions to the Soft Keys 
on your controller. For more information, see “Customizing Avid Artist Color Controls” on 
page 769.
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To enter and exit Color Correction mode with your Artist Color, do the following:

t Press the F1 (Enter/Exit Color Correction mode) button. Press the F1 button again to exit Color 
Correction mode.

The Artist Color either enters Color Correction mode or Source/Record mode.

Adjusting Avid Artist Color Controls

Some of the adjustments you make as you correct the color in your sequence might require fine 
control over the trackwheels, trackballs, and other controls on your Artist Color. You can adjust the 
sensitivity of these controls by accessing the Setup functions on your Artist Color controller.

To adjust the sensitivity of the Avid Artist controls:

1. Press the Nav button, and then press the Setup soft knob.

The LED display changes to show the control categories on the Artist Color.

2. Turn the appropriate soft knob to adjust the sensitivity on any of the following controls:

t Jog

t Shuttle

t Shuttle Stop

t Wheel

t Ball

t Knob

Using Avid Artist Color to Make HSL Corrections

The HSL group in the Color Correction tool provides controls that let you alter attributes such as hue, 
saturation, gain, and gamma. The HSL group also lets you specify an offset for the hue of an image, 
which you can use to correct a color cast. You can use the Soft Keys on the Artist Color to navigate 
between groups and subdividing tabs in the Color Correction tool, as well as to toggle your 
corrections on and off, remove a color correction effect, or undo an adjustment.

The Controls tab of the HSL group in the Color Correction tool includes sliders for making 
adjustments to hue, saturation, and luminance values. Using the Soft Knobs on the Artist Color, you 
can adjust master hue and saturation parameters, as well as brightness and contrast. You can also use 
the Reset buttons (R1 – R8) to reset adjustments to their original values.

Using the trackwheels you can adjust gain, gamma, and setup values, and you can use the trackballs 
to make Hue Offset changes in three different luminance ranges — highlights, midtones, and 
shadows. These controls give you precise control over color cast corrections without having to use 
the Color Correction tool. 

You can also toggle the color correction adjustments on and off so you can see how your changes 
affect your segment.

The following procedures describe how to use your Artist Color to make HSL adjustments, but they 
do not provide a detailed description of all of the color correction features available. For more 
information on HSL color correction procedures, see “The HSL (Hue, Saturation, Luminance) 
Group” in the Help. For more information on all of the controls available on your Artist Color, see 
“Controller Application Sets” on page 773.
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To make HSL adjustments with the Artist Color:

1. Move the position indicator to the segment in the Timeline you want to correct. You can use the 
navigation controls on the Artist Color to move the position indicator in the Timeline.

2. If your Artist Color does not display the HSL group functions, press the Nav button, and then 
press the left Soft Knob to activate the HSL group in the Color Correction tool.

The LED displays list the functions for the trackwheels and trackballs (top row) and the Soft 
Knobs (bottom row).

3. Turn the appropriate Soft Knob to adjust the master hue, color saturation, brightness, or contrast 
of your segment. You can press and hold the corresponding Reset button to reset your 
adjustments to their original values.

As you turn the knob, the LED display updates the value of the parameter. These values also 
display in the Color Correction tool.

4. Turn the appropriate trackwheel to adjust the setup, gamma, or gain of your segment. You can 
press and hold the corresponding Reset button to reset your adjustments to their original values.

As you turn the trackwheel, the LED display updates the value of the parameter.

5. Turn the appropriate trackball to adjust the hue offset for shadows, midtones, or highlights of 
your segment. You can press the corresponding Reset button to reset your adjustments to their 
original values.

As you turn the trackball, the ChromaWheel color wheel display in the Color Correction tool 
updates to reflect your changes. If the ChromaWheel display is not visible, you can press the F2 
(Next HSL Subtab) button to navigate to the correct tab in the Color Correction tool.

To see your segment with and without your color corrections, do the following:

t Press the F3 (Toggle Color Correction Effect (On/Off) button.

Using Avid Artist Color to Adjust the Curves Graphs

The Curves group contains four ChromaCurve graphs that let you control color and luminance by 
placing up to sixteen control points on a graph and then adjusting the points. Using the ChromaCurve 
graphs, you can control color with great precision in the Curves tab because you can adjust many 
different subdivisions of the brightness range.

The Curves tab also contains four slider controls — Master Saturation, Master Gain, Master Gamma, 
and Master Setup. These sliders work in exactly the same way as the Saturation, Gain, Gamma, and 
Setup sliders in the HSL group, so you can make some HSL-type adjustments without leaving the 
Curves tab. 

Using the controls on the Artist Color, you can add control points on the graphs and then use the 
trackwheels and trackballs to adjust the red, green, and blue point graphs. These graphs give you 
precise control over color and luminance adjustments without having to use the Color Correction 
tool. 

The following procedures describe how to use your Artist Color to make ChromaCurve graph 
adjustments, but they do not provide a detailed description of all of the color correction features 
available. For more information on Curves color correction procedures, see “The Curves Group” in 
the Help. For more information on all of the controls available on your Artist Color, see “Controller 
Application Sets” on page 773.
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To make HSL adjustments with the Artist Color:

1. Move the position indicator to the segment in the Timeline you want to correct. You can use the 
navigation controls on the Artist Color to move the position indicator in the Timeline.

2. If your Artist Color does not display the Curves group functions, press the Nav button, and then 
press the second Soft Knob to activate the Curves group in the Color Correction tool.

The LED displays list the functions for the trackwheels and trackballs (top row) and the Soft 
Knobs (bottom row).

3. Turn the appropriate Soft Knob to adjust the color saturation, brightness, or correction type of 
your segment. You can press the Soft Knob to reset your adjustments to their original values.

As you turn the knob, the LED display updates the value of the parameter. These values also 
display in the Color Correction tool.

4. Use the Reset buttons to set control points, and then turn the appropriate trackwheel to adjust the 
red, green, or blue hue of your segment. You can press and hold the corresponding Reset button 
to reset your adjustments to their original values.

As you turn the trackwheel, the LED display updates the value of the parameter.

5. Turn the appropriate trackball to modify the red, green, or blue point deviation on the 
ChromaCurve graph. You can press the corresponding Reset button to reset your adjustments to 
their original values.

As you turn the trackball, the ChromaCurve graph display in the Color Correction tool updates to 
reflect your changes. 

To see your segment with and without your color corrections, do the following:

t Press the F3 (Toggle Color Correction Effect (On/Off) button.

(Media Composer | Symphony Option) Using Avid Artist Color to Adjust 
Channels, Levels, and Secondary Corrections 

You can use the Artist Color to access the advanced controls in the Color Correction tool, including 
the following:

• The Channels group defines each output color channel (red, green, blue) by blending different 
input color components in various proportions. You can work with components from both the 
RGB (red, green, blue) and the YCbCr (luminance, red chroma, blue chroma) color spaces. The 
Channels group offers very precise control over the final composition of each color channel. For 
more information on using the Channels group, see “The Channels Group” in the Help.

• The Levels group controls the relative brightness or darkness of an image by defining the white 
point, gray point, and black point of video material. The main use of the Levels group is to 
rebalance the color or luma range. The group provides precise control over the amount of 
contrast and detail visible in the video image, especially when you work with the individual 
color channels. For more information on using the Levels group, see “The Levels Group” in the 
Help.

• The Secondary group adjust parts of an image defined by hue and saturation values in real time. 
You can make secondary adjustments to a single segment or to multiple segments that you define 
by setting Source or Program relationships. For more information on using the Secondary group, 
see “The Secondary Group” in the Help.
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The functions on the Channels and Levels Groups in the Color Correction tool currently are not 
mapped to the Artist Color controls. You can customize your default assignments for commonly-used 
controls (see “Customizing Avid Artist Color Controls” on page 769). You can also use Mouse mode 
to navigate the controls in the Color Correction tool from the Artist Color (see “Using Mouse Mode” 
on page 765).

For more information on the Secondary Group controls available for the Artist Color, see “Controller 
Application Sets” on page 773.

To make advanced adjustments with the Artist Color:

1. Move the position indicator to the segment in the Timeline you want to correct. You can use the 
navigation controls on the Artist Color to move the position indicator in the Timeline.

2. If your Artist Color does not display the group functions for the tab in the Color Correction tool 
that you want to use, press the Nav button, and then press the appropriate Soft Knob to activate 
the Channels, Levels, or Secondary group in the Color Correction tool.

The LED displays list the functions for the trackwheels and trackballs (top row) and the Soft 
Knobs (bottom row).

3. Turn the appropriate Soft Knob to make the color corrections on your segment. Not all controls 
in these groups are mapped to Soft Knobs.

As you turn the knob, the LED display updates the value of the parameter. These values also 
display in the Color Correction tool.

4. Turn the appropriate trackball to modify the appropriate color correction on your segment. Not 
all controls in these groups are mapped to trackwheels and trackballs.

To see your segment with and without your color corrections, do the following:

t Press the F3 (Toggle Color Correction Effect (On/Off) button.

Applying Automatic Color Corrections

The HSL group in the Color Correction tool allows you to make some color correction adjustments 
automatically in order to simplify the process of correcting basic problems. For a full description of 
automatic color correction functions, see “Using Automatic Color Corrections” in the Help.

To apply automatic color corrections with your Artist Color, do one of the following:

t With the HSL group functions active, press the F7 (Auto Black), F8 (Auto Contrast), or F9 (Auto 
White) button.

t With the HSL group functions active, press and hold the Shift button, and then press the F7 
(Auto Balance) button.

n Pressing the Shift button locks the button in the shift mode, which allows you to access a second 
function for most controls. Pressing and holding the Shift button activates a second function for the 
controls until you release the Shift button.

Using the Artist Color with Color Correction Effect Templates

You can use the Copy/Paste buttons on the Artist Color to save a Color Correction effect template as 
a bucket. Each bucket includes all parameter values for your color correction effect, and you can 
apply these values quickly to any segment in the Timeline. Color Correction effect templates saved as 
bucket are not saved when you close Media Composer. For more information on using Color 
Correction effect templates, see “Working with Color Correction Effect Templates” in the Help.
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To save a Color Correction effect template as a bucket:

1. Make sure that the position indicator is in the segment that contains the settings you want to save.

2. Press one of the Copy buttons (CG1, CG2, CG3, or CG4). You can access a second set of four 
Copy buttons by pressing and holding the Shift button.

All values of the selected controls are saved. The Paste button below the bucket is lit, indicating 
a saved bucket.

To clear a Color Correction effect template from a bucket, do the following:

t Move the position indicator to any uncorrected segment in the Timeline and then press the 
appropriate Copy button.

All values of the selected controls are cleared. The Paste button below the bucket is unlit, 
indicating an empty bucket.

To apply a Color Correction effect template saved as a bucket, do the following:

t Press the appropriate Paste button.

Using Mouse Mode

The Mouse Mode button changes the function of the center trackball so that you can use it to move 
the mouse pointer just as you do with a mouse device attached to your system. When you enter 
mouse mode, the two center Reset buttons supply the right-click and left-click functions of the mouse 
device. This allows you to move between tools and windows and access menu commands without 
having to leave the control surface.

n When you are not in Color Correction mode, you can use the Artist Color to move the mouse pointer 
as described in the following procedure without clicking the Mouse Mode button.

To control the mouse pointer using Avid Artist Color:

1. Click the Mouse Mode button.

The center trackwheel controls the position of the mouse pointer in the application.

2. Use the trackball to move the mouse pointer to the appropriate tool or menu.

3. Press the left Reset button above the center trackball to select the function you want. Press the 
right Reset button to perform a right-click operation.

Moving Through Footage with Artist Color

You can use your Artist Color to control how you move through footage, using the following 
methods:

• The Transport controls allow you to play, pause, rewind, and fast forward in your sequence.

- You can use the Play Reverse, Pause, and Play Forward buttons on your Artist Color to move 
through your footage as you do with J-K-L play in Media Composer. For more information 
on using the J-K-L keys, see “Playing Footage with the J-K-L Keys (Three-Button Play)” in 
the Help.

- You can use the Previous Clip and Next Clip to move between clips in the Timeline. Pressing 
the Shift button allows you to move to the previous or next uncorrected clips in your 
sequence.
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• Pressing or locking the Shift button allows you to navigate through the footage that displays in 
the three color correction monitors using the trackwheels and trackballs.

- The trackwheels allow for frame-by-frame positioning (jogging), depending on how fast you 
turn the wheel right (clockwise) or left (counterclockwise). Use the trackwheel when you 
want to locate a specific frame by jogging through footage.

- The trackballs alter the speed of playback by how far you turn the ball (shuttling). The more 
you turn the ball to the right, the faster the footage moves forward. To move through the 
footage in reverse, turn the ball to the left. When held in position, footage continues to move 
at a fixed rate. Use the trackball when you want to quickly shuttle through footage.

• When you are not in Color Correction mode, Transport controls allow you to play, pause, rewind, 
and fast forward in your sequence. You can also use the right trackwheel and trackball to jog and 
shuttle through your footage in the Record monitor and the left trackwheel and trackball to job 
and shuttle in the Source monitor. For more information on using the Artist Color without 
entering Color Correction mode, see 

The following table lists the transport controls available on the Avid Artist Color:

Editing Without Entering Color Correction Mode
You can use your Artist Color to perform some standard editing functions when you are not in Color 
Correction mode. When you exit Color Correction mode, you can set In and Out points, make Insert 
or Overwrite edits, enter or exit Trim mode, and make different kinds of trim edits.

Control Shift Control

Transport control assignments (left to right):

First row:

Previous clip Previous uncorrected clip — Moves to the previous 
uncorrected segment.

Next clip Next uncorrected clip — Moves to the next 
uncorrected segment.

Second Row:

Play Reverse Play reverse

Stop Stop

Play Play
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For a full list of editing commands available on the Artist Color controller when not in Color 
Correction mode, see “Source/Record Editing Controls” on page 781.

To perform basic edits with Artist Color:

1. If you currently are working in Color Correction mode, press F1 on the Artist Color controller to 
exit the mode.

2. Navigate through your footage by using one of the following sets of controls:

t Use the left trackwheel and trackball to navigate footage in the Source monitor.

t Use the right trackwheel and trackball to navigate footage in the Record monitor.

t Use the Play Reverse, Pause, and Play Forward buttons on your Artist Color to move 
through your footage.

3. Press the F2 button to set a Mark In point, or press the F3 button to set a Mark Out point.

You can press the F7 button to clear the Mark In and Out points.

4. Press the F4 button to create and Insert edit, or press the F5 button to create an Overwrite edit.

To perform a trim edit with Artist Color:

1. If you currently are working in Color Correction mode, press F1 on the Artist Color controller to 
exit the mode.

2. Press the Shift key to enable the trim controls.

3. Navigate to the transition you want to trim. You can use the right trackwheel and trackball to 
navigate the footage in your sequence.

4. Press the F5 button to enter Trim mode.

The transition nearest the position indicator is selected for dual-roller trimming.

5. (Option) Press the F2 or F3 button to move to the previous or next transition.

6. (Option) Press the F4 button to select the outgoing (A) side for trimming, or press the F6 button 
to select the incoming (B) side for trimming.

7. Do one of the following:

t To trim one frame to the right, press the F7 button.

t To trim one frame to the left, press the F8 button.

You can continue to press the F7 or F8 button to trim additional frames from the transition point.

Avid Artist Color Soft Keys
When EuControl opens for the first time, it includes a set of default Avid color correction editing 
functions mapped to the Artist Color buttons (the default mappings are called the “application set”). 
For a full list of the default color correction application sets used with Media Composer, see 
“Controller Application Sets” on page 773. To modify the button mappings, see “Customizing Avid 
Artist Color Controls” on page 769.

The Soft Keys tab in the EuControl application controls the soft key assignments. With Artist Color, 
you can access the soft keys with the circular buttons below the display.
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Artist Color can control multiple applications, each with its own soft key assignments. Since the 
EuControl application responds dynamically as you move between applications, soft key 
assignments might change in the Soft Keys tab as the active application changes. Changing the focus 
to the desired application and then to the EuControl application restores the current assignments. You 
can save your soft key assignments at any time while using the EuControl application.

n  Be sure to check that the proper application is active before you click Save, Restore, or Revert.

You can view the current Soft Key assignments by pressing the Show button (to the left of the Power 
button), which opens the EuControl application and displays the Soft Keys tab. Pressing the Show 
button again hides the EuControl application.

The Soft Keys tab displays the name of the active application above the option menus and the soft 
key assignments.

EuControl Settings: active application, option menus, Soft Key labels

The default EuControl button mappings include assignments for the color soft keys (Color SKs), 
which control the functions assigned to the nine buttons located below the display on Artist Color. 
Selecting Shift allows you to view a second set of Soft Key assignments. The section organizes the 
buttons in pages for HSL and Curves group functions. For Symphony Option, the section organizes 
the buttons in pages for HSL, Curves, and Secondary group functions. You can click the Page menu 
to select a different set of commands.:
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Customizing Avid Artist Color Controls
The Avid Artist Color includes three trackballs and trackwheels, nine soft keys, six soft knobs, copy/
paste keys, and transport controls. You can modify the default soft key functions of the controls on 
your Artist Color controller by mapping them to buttons and keyboard shortcuts in Media Composer. 
You can also add custom key sequences, EUCON commands, and pages to the surface controls.

The following procedure provides a generic description of how to customize your controller. For a 
full description of the customizations available, see the documentation that came with your Artist 
Color.

To change a function in the Artist Color controls:

1. In the EuControl application, click the Soft Keys tab.

2. Click the Section menu, and select Color SKs.

The Soft Keys tab displays the existing controls for the selected section.

3. Do one of the following:

t Select a button whose function you want to customize, and click Command.

t Double-click a button whose function you want to customize.

The Soft Key Command Editor opens.
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4. Specify the action you want to associate with the control button.

The Soft Key Command Editor organizes the default commands as they appear in the Command 
palette or in menus.

5. Close the Soft Key Command Editor.

The Soft Key tab updates and displays the new function.

6. Click Save.

7. Close the EuControl Settings application.

To add a function to the Artist Color controls:

1. In the EuControl application, click the Soft Keys tab.

2. Click the Section menu, and select Color SKs.

The Soft Keys tab displays the existing controls for the selected section.

3. If the display does not include any blank keys, click the Page menu and select a new page. You 
can also click the Add button to add a new page.

4. Do one of the following:

t Select a blank key and click Command.
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t Double-click a blank key.

The Soft Key Command Editor dialog opens.

5. Click Add and select one of the following:

- Key, to add menu commands or other application-specific commands that have keyboard 
shortcut equivalents

- EuCon, to add menu commands or other color correction-specific commands

6. In the Details column, select the function you want to associate with the new soft key.

EUCON commands automatically label the button but do not select an icon.

7. Close the Soft Key Command Editor.

The Soft Key tab updates and displays the new function.

Avid Artist Color Controls
The following illustration lists the location of device controls on the Avid Artist Color. The specific 
functions controlled by the Artist Color change depending on which group or subdividing tab of the 
Color Correction tool you activate, and if you press or lock the Shift or Nav button on the Artist 
Color.

1 3 4 5 6 7

8
9

10
11

12

13

14

2
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The following table describes the default functions of the controls for Avid Artist Color when used 
with Media Composer.

1 Application Change button 8 Soft Keys

2 Page buttons 9 Reset buttons

3 Soft Knobs 10 Nav button

4 Displays 11 Shift buttons

5 Bank buttons 12 Copy/Paste buttons

6 Show button 13 Transport buttons

7 Power button 14 Trackballs and Trackwheels

Control Function

Application Change 
button

Switches between the most recently used open applications. Press and hold 
the Page (left or right) button to cycle among all open applications.

Page (left and right) Changes the knob set functions by one page.

Display Displays functional information and controls, including the trackwheel and 
trackball labels, Soft Knob functions, parameter values, and Soft Key labels.

Soft Knobs Six continuously rotating knobs allow you to adjust color parameters or 
navigate tabs within the Color Correction tool. The knobs have a built-in 
switch allowing it to be pressed from the top to reset parameter values.

Bank (left and right) Moves the assigned functions for the trackballs, trackwheels, and Soft Knobs 
between tabs in the Color Correction tool.

Show Opens the EuControl application and displays the Soft Keys tab.

Power Turns the controller on or off.

Soft Keys Provide editing and navigation functions specified in the Soft Key pages in 
the display. Moving through the Soft Key pages with the Soft Key navigation 
buttons changes the functions assigned to the Soft Keys. Soft Key 
assignments change when you navigate to a new tab in the Color Correction 
tool.

Reset buttons Each trackball and trackwheel has a reset button to restore its default settings. 
The left button of each group resets the trackball, and the right button resets 
the trackwheel.

Nav button Allows you to access functions to navigation between tabs in the Color 
Correction tool.

Shift button Allow you to access additional functions specified in the application set for 
surface controls.

Copy/paste buttons Allow you to save Color Correction effect templates as buckets for the 
duration of your working session. The top row of buttons copy the current 
Color Correction parameter settings, and the bottom row of buttons apply the 
template to the selected segments.
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Controller Application Sets
The following sections include a list of the default key assignments (called an application set) for the 
Avid Artist Color when used with Media Composer. You can customize the key assignments for your 
controller by using the EuControl application and save your customizations in a separate application 
set. For more information, see “Customizing Avid Artist Color Controls” on page 769 or the user’s 
guide that came with your Artist Color. 

For more information, see the following reference topics:

• “HSL Base Controls” on page 773

• “Curves Base Controls” on page 776

• “Curves Bank 2 Controls (Media Composer | Symphony Option)” on page 778

• “Curves Base Controls” on page 776

• “Secondary Controls (Media Composer | Symphony Option)” on page 778

• “Secondary Page 2 Controls (Media Composer | Symphony Option)” on page 780

• “Source/Record Editing Controls” on page 781

HSL Base Controls

The following tables describe the default HSL controls on the Artist Color when working with Media 
Composer. Pressing and holding the Shift button, located at the lower corners of your Artist Color, 
allows you to access a second set of HSL controls. You can lock the controls in Shift mode by 
pressing and releasing either Shift button.

HSL Soft Knobs

Transport buttons Allow you to perform navigation functions specified in the application set.

Trackballs Three trackballs control adjustments in the color wheels and the curve 
graphs.

Trackwheels Allow you to adjust parameter values with the sliders in the tabs of the Color 
Correction tool.

Control Function

Control Shift Control

Soft knob assignments (from left to right):

Master Hue Left monitor display

Saturation Middle monitor display
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HSL Soft Keys

HSL Reset Buttons

Brightness Right monitor display

Contrast Clip low

Match type Clip high

Correction Correction type

Control Shift Control

Button Label Control Shift Control

Soft Key assignments (left to right):

F1 Toggle Color Correction and Source/Record 
mode

F2 Next HSL Subtab Next HSL Subtab

F3 Toggle Color Correction Effect (On/Off) Dual split

F4 Mouse mode Mouse mode

F5 Remove Effect Match

F6 Undo Redo

F7 Auto Black Auto balance

F8 Auto Contrast Invert Chroma

F9 Auto White Invert Luma

Button Label Control Shift Control

Reset button assignments (left to right):

R1 Enable/Reset Setup:

• Press to toggle Setup/Enable

• Press and hold to reset

N/A
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HSL Trackwheels and Trackballs

Trackwheels (outer ring) and trackballs (inner ring)

R2 Enable/Reset Shadow Hue:

• Press to toggle Setup/Enable

• Press and hold to reset

N/A

R3 Enable/Reset Gamma:

• Press to toggle Setup/Enable

• Press and hold to reset

N/A

R4 Enable/Reset Midtone Hue:

• Press to toggle Setup/Enable

• Press and hold to reset

N/A

R5 Enable/Reset Gain:

• Press to toggle Setup/Enable

• Press and hold to reset

N/A

R6 Enable/Reset Highlight Hue:

• Press to toggle Setup/Enable

• Press and hold to reset

N/A

Button Label Control Shift Control

Control Shift Control

Trackwheel assignments (left to right):

Setup Jog left monitor

Gamma Jog center monitor

Gain Jog center monitor

Trackball assignments (left to right):

Hue Offset Shadows Shuttle left monitor

Hue Offset Midtones Shuttle center monitor

Bank 1: Hue Offset Highlights 

Bank 2: Master Hue Offset

Shuttle right monitor
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Curves Base Controls

The following tables describe the default curves controls on the Artist Color when working with 
Media Composer. Pressing and holding the Shift button, located at the lower corners of your Artist 
Color, allows you to access a second set of Curves controls.

Curves Soft Knobs

Curves Soft Keys

Control Shift Control

Soft knob assignments (from left to right):

Master Saturation Cycles through the Source menu commands for the 
left monitor display

Master Setup Cycles through the Source menu commands for the 
middle monitor display

Master Gamma Cycles through the Source menu commands for the 
right monitor display

Master Gain

Match type

Cycles through the Correction Type menu Cycles through the Correction Type menu

Button Label Control Shift Control

Soft Key assignments (left to right):

F1 Toggle Color Correction and Source/Record 
mode

Toggle Curves tab enable

F2 Toggle Curve enable (hold to delete point)

F3 Toggle Color Correction Effect (On/Off) Dual split

F4 Mouse mode Mouse mode

F5 Remove Effect Remove Effect

F6 Undo Redo

F7 Auto Color Auto balance
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Curves Reset Buttons

Curves Trackwheels and Trackballs

Trackwheels (outer ring) and trackballs (inner ring)

F8 Auto Contrast Auto Contrast

F9 Match Match

Button Label Control Shift Control

Button Label Control Shift Control

Reset button assignments (left to right):

R1 New red point: Toggle red enable

R2 Toggle Curve enable (hold to delete point) N/A

R3 New green point: Toggle green enable

R4 Toggle Curve enable (hold to delete point) N/A

R5 New blue point: Toggle blue enable

R6 Toggle Curve enable (hold to delete point) N/A

Control Shift Control

Trackwheel assignments (left to right):

Red point curve position Jog left monitor

Green point curve position Jog center monitor

Blue point curve position Jog center monitor

Trackball assignments (left to right):

Red point deviation Shuttle left monitor

Green point deviation Shuttle center monitor
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Curves Bank 2 Controls (Media Composer | Symphony Option)

The following table describe the default curves controls on the Artist Color accessible when you 
press the Bank 2 button. Most of the Bank 2 controls are the same as the Curves base controls, except 
that you can control the master luminance curves with the right trackwheel and trackball.

Curves Trackwheels and Trackballs

Trackwheels (outer ring) and trackballs (inner ring)

Secondary Controls (Media Composer | Symphony Option)

The following tables describe the default Secondary controls on the Artist Color when working with 
Media Composer. Pressing and holding the Shift button, located at the lower corners of your Artist 
Color, allows you to access a second set of Secondary controls.

Secondary Soft Knobs

Blue point deviation Shuttle right monitor

Control Shift Control

Control Shift Control

Trackwheel assignments (left to right):

N/A Jog left monitor

N/A Jog center monitor

Master luminance curve position Jog center monitor

Trackball assignments (left to right):

N/A Shuttle left monitor

N/A Shuttle center monitor

Master luminance point deviation Shuttle right monitor
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Secondary Soft Keys

Secondary Reset Buttons

Control Shift Control

Soft knob assignments (from left to right):

In Vector Hue Left monitor display

In Vector Sat Middle monitor display

In Vector Width Right monitor display

In Vector Sat Minimum N/A

In Vector Softness N/A

Vector Select N/A

Button Label Control Shift Control

Soft Key assignments (left to right):

F1 Toggle Color Correction and Source/Record 
mode

Toggle Secondary tab enable

F2 Lock Vectors N/A

F3 Toggle Color Correction Effect (On/Off) Dual split

F4 Mouse mode Mouse mode

F5 Remove Effect Remove Effect

F6 Undo Redo

F7 Insert Last Vector N/A

F8 Isolate N/A

F9 Match Color Match

Button Label Control Shift Control

Reset button assignments (left to right):

R1 N/A Toggle red enable
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Secondary Trackwheels and Trackballs

Trackwheels (outer ring) and trackballs (inner ring)

Secondary Page 2 Controls (Media Composer | Symphony Option)

The following tables describe the default Secondary Soft Knob controls available on the Artist Color 
when you select Page 2 by pressing the Page button. All other Secondary controls available on Page 2 
replicate the Page 1 controls described in “Secondary Controls (Media Composer | Symphony 
Option)” on page 778.

Secondary Soft Knobs

R2 N/A N/A

R3 N/A Toggle green enable

R4 N/A N/A

R5 N/A Toggle blue enable

R6 N/A N/A

Button Label Control Shift Control

Control Shift Control

Trackwheel assignments (left to right):

N/A Jog left monitor

N/A Jog center monitor

N/A Jog center monitor

Trackball assignments (left to right):

Input Vector Hue and Saturation Shuttle left monitor

N/A Shuttle center monitor

Output Vector Hue and Saturation Shuttle right monitor
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Source/Record Editing Controls

The following tables describe the default editing controls available when Media Composer is not in 
Color Correction mode. You can also navigate footage without entering Color Correction mode (for 
more information, see “Moving Through Footage with Artist Color” on page 765).

Editing Soft Keys

Control

Soft knob assignments (from left to right):

Out Vector Hue

Out Vector Sat

Out Luma

N/A

Match Type

Correction Type

Button Label Control Shift Control

Soft Key assignments (left to right):

F1 Toggle Color Correction and Source/Record 
mode

Toggle Color Correction and 
Source/Record mode

F2 Mark In point Go to Previous Edit

F3 Mark Out point Go to Next Edit

F4 Insert edit Select A-side Trim

F5 Overwrite edit Enter Trim mode/Select AB sides 
for dual-roller trim

F6 Undo Select B-side Trim

F7 Clear Mark In/Out points Trim one frame right

F8 Zoom In Trim one frame left

F9 Zoom Out N/A
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Editing Trackwheels and Trackballs

Trackwheels (outer ring) and trackballs (inner ring)

Control Shift Control

Trackwheel assignments (left to right):

N/A Jog left monitor

N/A Jog center monitor

N/A Jog center monitor

Trackball assignments (left to right):

Input Vector Hue and Saturation Shuttle left monitor

N/A Shuttle center monitor

Output Vector Hue and Saturation Shuttle right monitor
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Index

Numerics
0% to 100% Timewarp effect 483
1:66 Mask Film effect 457
1:85 Mask Film effect 457
10 bit units for color correction 614
100% to 0% Timewarp effect 483

Add Keyframe button (Effect Editor, Effect Preview 
monitor) 89

Add Keyframe button (Effect Preview monitor) 61
Add Keyframe command (Keyframe track shortcut menu) 

89
Add Keyframes commands (Effect Editor shortcut menu) 

117
Add Keyframes to Active Group (Effect Editor shortcut 

menu) 93
Add Keyframes to Active Parameter (Effect Editor 

shortcut menu) 93
Add Keyframes to All Parameters (Effect Editor shortcut 
783

10-bit effects processing 124, 126
14:9 Letterbox Reformat effect 478
16:9 display

Color Correction monitors 597
in the Title tool 317, 317

16:9 Letterbox Reformat effect 478
16:9 Mask Film effect 457
16-bit effects rendering 138
24p or 25p editing projects

finding flaws from telecine transfer 411
3D effect parameters

overview of reference information 573
3D parameters

hierarchy of 574
3D Promote button (Effect Editor) 69
3D Warp Blend effect 452
3D Warp effect

applying 283
3rd-party plug-in effects 145
4 Corners Shape Wipe effect 479
4:3 Sidebar Reformat effect 478
422 Safe effect parameter (Safe Color Limiter effect) 546
601 levels option

Avid Pan & Zoom effect 534
8 bit units for color correction 614
8-bit effects processing 124

A
Acceleration effect parameter 492
Acceleration parameter 432
Achieving a final look with color correction 728
Achieving safe color limits 742
Achieving shot-to-shot consistency with color correction 

727
Actions effect parameters (Pan and Scan effect) 569
Activating

Render settings 134
Adaptive color correction guidelines 724
Adaptive deinterlacing

Timewarp and Motion Adapter effects option 170
Add Edit function

Submaster effects 215
Add Keyframe button 119

menu) 93
Add Keyframes to Enabled Groups (Effect Editor shortcut 

menu) 93
Add Keyframes to Open Graphs (Effect Editor shortcut 

menu) 93
Add Keyframes to Open Groups (Delete Keyframe Mode 

menu) 93
Add Page command (Object menu) 334
Add To Active Group command (Add Keyframe Mode 

menu) 93
Add To Active Parameter command (Add Keyframe Mode 

menu) 93
Add To All Parameters command (Add Keyframe Mode 

menu) 93
Add To Enabled Groups command (Add Keyframe Mode 

menu) 93
Add To Open Graphs command (Add Keyframe Mode 

menu) 93
Add To Open Groups command (Add Keyframe Mode 

menu) 93
Add to Selection button (Secondary tab in Color 

Correction tool) 692
Adding

comments to color corrections 617
highlights to 3D effects 582
keyframes to keyframe graphs 89
pages to a rolling or crawling title 334

Adjusting
colors for effects 74
effects 33
input values in color vectors 687
luminance ranges 653
output values in color vectors 693
Pan and Scan effect 228
Render settings 134
shadow softness in titles 343

Advanced effect parameters (Avid Pan & Zoom effect) 
534

Advanced keyframes
Add Keyframe Mode menu and Delete Keyframe 

Mode menu 93
adding 89
aligning 100
and nested effects 212
copying and pasting 103, 104
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deleting 91
described 80
Effect Editor shortcut menu 117
Effect Editor toolbar controls 114
Effect Preview monitor 88
extrapolating parameter values 112
hiding graph display 82
holding parameter values 112
interpolation options 106, 106
moving 98
nested effects 212
opening graphs and tracks 82

Pan and Scan effect 222
Submaster effects 215
title styles 353

Arrowheads in titles 336
Aspect ratio

Avid Pan & Zoom effect 232
controlling in 3D effects 585
fixed aspect 499
image size 592
image size control with Target parameters 592
Pan and Scan effect 221
Reformat effects 220
784

removing redundant 92
reversing 110
showing graph display 82
slipping 100
trimming effects with 110

Align Keyframe command (shortcut menu for keyframe 
track) 101

Align to Frame commands (Alignment menu) 344
Aligning

advanced keyframes 100
Alignment

of titles and objects 344
title text 327

Alpha channel
in 3D Matte Key effect 284
Matte Key effects 207
title creation with 321

Anamorphic Mask Film effect 457
Animation

imported 207
AniMatte effect 66
AniMatte effect (2D)

animating 429
applying 384
described 382
exporting as PICT file 410
matte wipe example 430
modes 387
rendering 383
using Magic Mask parameters 423

AniMatte Key effect 470
Anti-alias option (Blur and Mosaic effects) 433
Anti-aliased elements in title 321
Anti-aliasing

limitations with rolling titles and Acceleration effect 
parameter 492

Application sets
Avid Artist Series controllers 773

Applying
color correction effect templates 623
color correction to an entire sequence 706
Dissolve effects 48, 48, 49
Effect Palette Color Correction effect 632
effect templates 36
effects 27, 53, 53

Aspect Ratio effect parameters (Pan and Scan effect) 569
Auto Balance button (Color Correction tool) 629
Auto Contrast button (Color Correction tool) 629
Auto Size mode (Title tool) 332
Auto Size Mode command (Object menu) 332
AutoCorrect options (Correction Mode settings) 709
Automatic color correction

See Color correction
Automatic Color Correction effect templates

update behavior 619
using 620

Automatic color corrections
adjusting contrast and balance 629
considerations when using 628
differences between groups 628
order of corrections 628
overview 627, 628
removing color casts 631
setting AutoCorrect options 709

Avid
online support 14
training services 14

Avid Artist Color
adjusting sensitivity 761
application sets 773
automatic color corrections 764
Channels adjustments 763
ChromaCurve graphs 762
color correction effect templates 764
controls 771
Curves adjustments 762
customization 769
EuControl 752
HSL corrections 761
insert and overwrite edits 766
Levels adjustments 763
mouse mode 765
navigating through footage 765
Secondary corrections 763
soft keys 767, 769
Transport controls 765
trim edits 766

Avid Artist Series controller
Avid Artist Color 760
described 752
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Ethernet connections 754
EuControl 752
EuControl settings 758
IP addresses 755

Avid DS caption file format 368
Avid Pan & Zoom effect 230, 230, 231, 232, 233, 235, 

236, 236, 237, 238, 238
importing to 530
zooming 531

Avid Pan & Zoom effect parameters 530
Avid Pan & Zoom Image effect 465
Avid Pan and Zoom effect

examples of 660
guidelines for 725

Blend effects
3D Warp 452
Dip to Color 452
Dissolve 452
Fade from Color 452
Fade to Color 452
overview of reference information 452
Picture-in-Picture 453
Superimpose 453

Blend effects (3D)
785

See Avid Pan & Zoom effect
Avid Unity 124, 142
Avid Visual Extensions

See AVX
AVX (Avid Visual Extensions) plug-in effects 145

defined 15, 145
installing 146
locating folders (Macintosh) 146
locating folders (Windows) 147
memory usage 146
multiple tracks 149
promoting 148
troubleshooting 151
upgrading 148
user interfaces 150

Axes in rotation (3D) 285
Axis effect parameters 574

B
Background color

selecting 322
Background Color effect parameters 575
Background effect parameter (Avid Pan & Zoom effect) 

533
Background effect parameters 493
Background effect parameters (Illusion FX Pattern 

Generator effect) 522
Ball Shape effect 586

limitations 589
Bézier curves

described 396
manipulating 396

Bézier keyframe interpolation option 106
Bins

effect templates in 36
revising titles in 349
saving color correction effect templates in 621
saving custom colors to 640
titles in 355
viewing fast-saved titles in 347

Bit depth for effects processing 124, 126
Black lines

removing with the Effect Aperture setting 24
Black point adjustments

3D Warp 283
Blowup effect 66
Blowup effects parameter 501
Blowup Film effect 457
Blue dot 18
Blue tab (Levels group in Color Correction tool) 664
Blur effect (2D)

creating 433
described 382
parameters 432

Blur Effect Image effect 465
Blur effect parameters 535
Blur mode, Paint Effect example 425
Blurring images with Defocus parameters 577
Bold button (Title tool) 327
Bold command (Object menu) 327
Bold text

in titles 327
Border (3D) effect parameters 575
Border effect parameters 493
Border effect parameters (Illusion FX) 510
Bottom Centered Squeeze effect 482
Bottom Left Corner Peel effect 475
Bottom Left L-Conceal effect 472
Bottom Left Squeeze effect 482
Bottom Left to Top Right Box Wipe effect 454
Bottom Left to Top Right Conceal effect 454
Bottom Left to Top Right Push effect 476
Bottom Right Corner Peel effect 475
Bottom Right L-Conceal effect 472
Bottom Right Squeeze effect 482
Bottom Right to Top Left Box Wipe effect 454
Bottom Right to Top Left Conceal effect 454
Bottom Right to Top Left Push effect 476
Bottom to Top Box Wipe effect 454
Bottom to Top Conceal effect 454
Bottom to Top Peel effect 475, 475
Bottom to Top Push effect 476
Bottom to Top Squeeze effect 482
Box Wipe effects

Bottom Left to Top Right 454
Bottom Right to Top Left 454
Bottom to Top 454
Left Box 454
overview of reference information 454
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Right Box 454
Top Box 454
Top Left to Bottom Right 454
Top Right to Bottom Left 454

Brightness (luminance)
defined 491

Bring Forward button (Effect Editor) 408
Bring Forward command (Object menu) 344, 408
Bring to Front command (Object menu) 344, 408
Brush effect parameters 494
Brush effect parameters (FluidMotion Edit) 570
Brush tool

considerations when blending channels 658
examples of settings in 658
making corrections in 656

Character mapping in Title tool 367
Chroma Adjust 537
Chroma Adjust effect parameters 537
Chroma Control effect parameters (SpectraMatte effect) 

556
Chroma Key effect (3D)

creating 295
Chroma Key effect parameters (RGB Keyer effect) 552
Chroma Key Key effect 470
786

creating a custom shape for 389
painting with 388
saving a template 390

Buckets (Color Correction tool)
clearing templates from 622
saving templates to 622

Buttons
Bring Forward (Effect Editor) 408
Centered on Cut (Quick Transition dialog box) 57
Color Correction tool 613
Crawling Title (Title tool) 319, 332
Ending at Cut (Quick Transition dialog box) 57
mapping in Effect mode 62
Rolling Title (Title tool) 319, 332
Scratch Removal 415
Send Backward (Effect Editor) 408
Starting at Cut (Quick Transition dialog box) 57

Bypass effect parameter (SpectraMatte effect) 554

C
Cache effect parameters (Avid Pan & Zoom effect) 534
Caption file formats 368
Caption files

exporting from SubCap effect 376
importing into the SubCap effect 372

Captioning
See SubCap effect

Center Box Shape Wipe effect 479
Center effect parameters (Illusion FX Kaleidoscope effect) 

515
Centered on Cut button (Quick Transition dialog box) 57
Centered on Cut effect parameter 500
Centered Zoom Squeeze effect 482
Changing perspective of 3D effects 583
Channel Blending pane (Channels tab in Color Correction 

tool)
considerations when using 658
examples of settings in 658
using 657

Channels group (Color Correction tool)
described 655
function compared to Levels group 659

Channels tab (Color Correction tool)
Channel Blending pane 657

ChromaCurve graphs
described 665

ChromaCurve graphs (Curves group in Color Correction 
tool)

described 670, 671
making adjustments to 673
setting color background 614

ChromaWheel controls (HSL group in Color Correction 
tool)

correcting color cast with 646
crosshair pointers 649
setting color background 614
understanding 646

Chrominance
of Color Effect 537

Circle and Oval tool (Title tool) 306, 329
Circle effect parameters (Illusion FX Pattern Generator 

effect) 523
Circle Shape Wipe effect 479
Clear Monitor command (Clip Name menu in Source 

monitor) 357
Clear Renders command (Clip menu) 44
Clearing

color correction effect templates from buckets 622
rendered effects 44

Clearing a stamp 294
Client monitor 224

color correction with 602
Clock Shape Wipe effect 479
Close command (File menu)

exiting Title tool with 347
Collapse button 216
Collapsing layers with Submaster effect 216
Color

blending, in titles 338, 340
for Paint Effect 388
safe limits for titles 321, 323
selecting for titles 338, 340

Color adjustment for effects 74
Color background for titles 322
Color balance

automatic color correction of 629
Color casts

automatic color correction of 629, 631
correcting with ChromaWheel controls 646
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Color coding for effects 18
Color coding of playback information in Timeline 123
Color correction

See also listings by specific controls and concepts, for 
example, Automatic color correction or Custom 
colors

applying to entire sequence 706
automatic, applying from Effect Palette 632
automatic, from Effect Palette 632
automatic, with Color Correction effect 632
Client monitor, using for 602
examples of typical problems 728

Color correction guidelines
achieving a final look 728
achieving shot-to-shot consistency 727
adapting the original look of a shot 724
black point adjustments 725
correcting tonal range 725
gray point adjustments 725
neutralizing color 726
restoring an original look 723
stages of correction 724
white point adjustments 725

Color Correction Image effect 466
787

keyframeable parameters 698
marking reference frames with markers 600
overview 594
playing sequences with Play Loop button 602
processing of color spaces and bit depths 617
reasons for using 596
reviewing current clip using Edit Review button 602
scope of corrections 604
Timeline information, described 625
using Avid Artist Color 760
using IN and OUT marks with 614
workflow 626
workflow with decomposed and recaptured sequences 

606
Color Correction command (Timeline Fast menu) 624
Color Correction command (Workspaces menu) 597
Color Correction effect (Effect Palette)

applying 632
deleting 710
described 707
saving as a template 710

Color Correction effect parameters (RGB Keyer effect) 
553

Color Correction Effect Template button (Color 
Correction tool) 621

Color Correction Effect templates
applying 623
behavior with relationship color corrections 624
clearing from buckets 622
saving to buckets 622

Color Correction effect templates
automatic template update behavior 619
described 618
save behavior 619
using automatic templates 620

Color correction groups
Channels 655
color correction, displaying 607
Curves 670
described 607
displaying 608
HSL (Hue, Saturation, Luminance) 641
interaction between 610
Levels 659
Secondary 680

Color Correction mode
Composer Window in, described 597
customizing 614
Effect Editor in 697
entering and leaving 597

Color Correction Mode button (Timeline) 597
Color Correction monitor

keyframes 699
Color Correction monitors

16:9 display in 597
controlling frame display in 600
customizing image display 598
Dual Split display in 599
reference frame display in 598
Source menu in 598, 598

Color correction monitors
isolating a color vector in 692

Color Correction tool
accessing tabs with Tab buttons 610
Blue tab (Levels group) 664
buckets, clearing templates from 622
buckets, saving templates to 622
buttons 613
Channels tab 656
Composite tab (Levels group) 664, 668
Controls tab (HSL group), described 642
Controls tab (HSL group), using 642
customizing histogram display 614
described 603
displaying subdividing tabs 608
displaying tabs in 608
Enable buttons in 611
Green tab (Levels group) 664
Highlights tab (HSL group) 653
Hue Offsets tab (HSL group), described 645
Luma Ranges tab (HSL group) 651
Luma tab (Levels group) 664, 668
Master tab (Levels group) 664
Midtones tab (HSL group) 653
overview 603
Red tab (Levels group) 664
resetting controls in 611
selecting correction type 604
Shadows tab (HSL group) 653
tabs in 607
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turning controls on or off 611
Color Effect Image effect 466, 466
Color effect parameters (Paint Effect) 546
Color Gain effect parameters 539
Color Match control

3 x 3 averaging of pixels, using 634
correcting with 634
Curves tab, using in 675
described 634
displaying RGB values 641
example of use 640
in Spot Color Correction effect 549

Command palette 62
Comments

adding to color corrections 617
displaying in the Timeline 617

Comments button (Color Correction tool) 617
Comments command (Timeline Fast menu) 617
Comparison of similar 2D effects 490
Composer window

in Color Correction mode 597
Composite limits for broadcast 737
Composite tab (Levels group in Color Correction tool) 

664, 668
788

Match Type options for 636
Paint Effect, for spot color correction 750
safe color warnings in 740
secondary color correction, using for 694
secondary color correction, using with 694
syringe, using with for secondary color correction 694

Color Match control in Paint Effect mode 540
Color Match effect parameters (Spot Color Correction 

effect) 549
Color Mix Illusion FX effect 460
Color Selection buttons (Secondary tab in Color 

Correction tool) 690
Color spaces

using when blending color channels 658
Color Style effect parameters 538
Color swatches

in Selected Vectors panel 686
Color vectors

adjusting input values 687
adjusting output values 693
custom 682
customizing display in color wheels 684
described 682
display in color wheels 682
enabling 687
inverting 695
isolating in an image 692
locking 689
multiple, interactions between 696
repositioning in color wheels 687
resetting 687
selecting 687
standard 682
using input sliders 688

Color wheels
color vector display in 682
customizing display of color vectors in 684
repositioning color vectors in 687
Secondary group (Color Correction tool) 682

Color-corrected sequences
converting to segment-only relationships 720
flattening 720
merging 716
removing 721
updating 715

Composite/Luma Levels effect parameters (Safe Color 
Limiter effect) 547

Conceal effects
Bottom Left to Top Right 454
Bottom Right to Top Left 454
Bottom to Top 454
Left to Right 454
overview of reference information 454
Right to Left 454
Top Left to Bottom Right 454
Top Right to Bottom Left 454
Top to Bottom 454

Console window
AVX plug-in effect messages 151

Constant Velocity option
Avid Pan & Zoom effect 532

Contrast
automatic color correction of 629

Control points
Luma Ranges graphs 654
manipulating in ChromaCurve graphs 673

Control points in Intraframe objects
adding 402
deleting 402
described 396
moving 403
removing 402
selecting 403

Controller settings
Avid Artist Series controller 754

Controlling
playback quality of effects 126, 126
real-time effects playback 124

Controlling image sharpness with Defocus parameters 577
Controls tab (HSL group in Color Correction tool)

controls in 643
described 642
making corrections with 642

Converting
formats with Timewarp effect 194
relationship color corrections 606

Coordinate system for 3D effects 285
Coordinates display for effects 65
Copy command

for graphic objects 344
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for title elements (Edit menu) 344
Copying

advanced keyframes 103, 104
keyframes 119
tracking data 278

Core effect parameters (Illusion FX Lightning effect) 516
Core effect parameters (Illusion FX Sparkler effect) 528
Corner Pin effect parameters 576
Corner pinning an image 292
Correcting color

See Color correction
Correction Mode settings

Curve tool, for Intraframe editing 394
Curves

using to make Levels tab color corrections 667
Curves group (Color Correction tool) 670
Curves tab (Color Correction tool)

Color Match control 675
examples of adjustments in 675
making corrections in 672

Custom color vectors 682
Custom colors

customizing names of 614
saving to bins 640
789

AutoCorrect options 709
Correction Mode Settings button (Color Correction tool) 

614
Correction Mode Settings dialog box 632
Correction Type button (Color Correction tool) 604
Crawling Title button (Title tool) 319, 332
Crawling Title effect 488
Crawling titles

See also Rolling titles
See also Titles
adding pages 334
adding pages to 334
copying or moving objects to 334
creating 330
defined 330
deleting pages from 334
formatting text in 335
going to a page in 334
inserting a blank page into 334
Make Crawl command 333
page count limits for 330
resizing width of 333
scrolling through 333
setting marks in 360
setting text formatting for 332
trimming 360
typing text for 332
workflow options for 330

Creating
motion effects 154, 159
new Render settings 134
stamp 294
Timewarp effects 165
trackers 251, 252

Creating 3D effects
Corner Pin 292
cropped foreground 291
Page Curl transition 289
Stamp 294

Crop (3D) effect parameters 577
Crop effect parameters 494
Cropped foreground effect

3D example 291
Crosshair pointers in ChromaWheel controls 649
Crystal Illusion FX effect 460

Custom Grid effect parameters 495
Custom Start effect parameter 500
Customizing

color correction histogram display 614
Color Correction mode 614

Cut command
for title elements (Edit menu) 344

Cut list 66
with Previsualization Marker tool information 404

D
Decomposed and recaptured sequences

color correction workflow with 606
Default function buttons

Avid Artist Color 767
Defining

color correction units of measurement 614
Defocus effect parameters 577
Delete From Active Group command (Delete Keyframe 

Mode menu) 93
Delete From Active Parameter command (Delete 

Keyframe Mode menu) 93
Delete From All Parameters command (Delete Keyframe 

Mode menu) 93
Delete From Enabled Groups command (Delete Keyframe 

Mode menu) 93
Delete From Open Graphs command (Delete Keyframe 

Mode menu) 93
Delete From Open Groups command (Delete Keyframe 

Mode menu) 93
Delete Keyframe command (Keyframe track shortcut 

menu) 91
Deleting

effect media files 144
keyframes 119
keyframes from keyframe graphs 91
pages from rolling or crawling titles 334
tracking data points 264

Demoting
effects 34

Deselect All Keyframes command (shortcut menu for 
keyframe track) 96

Diamond Shape Wipe effect 479
Dip to Color Blend effect 53, 452
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Display effect parameter (Avid Pan & Zoom effect) 531
Display effect parameters (FluidMotion Edit) 570
Display rate

when processing effects 122
Displaying

color correction comments in the Timeline 617
color correction groups 607, 608
color correction information in Timeline 624
subdividing tabs in Color Correction tool 608
tabs in Color Correction tool 608
waveform and vectorscope monitors (color correction) 

700

function in Color Correction mode 602
Editing

segments with tracking data 276
title text 325
titles into sequence 356

EDL (edit decision list)
and fast-saved titles 347
Submaster effects 215
video mixdown 218

Effect categories
Blend 452
Box Wipe 454
790

Dissolve Blend effect 452
Dissolve effects 53
Dissolve Icons command (Timeline Fast menu) 23
Distribute Objects commands (Alignment menu) 344
Distributing titles 344
Drawing environment

preparation in Title tool 321, 323
Drawing tools (Title tool)

Arrowhead tool 336
Border Width 336
Box Corner tool 336
circles and ovals 306, 329
lines 306, 329
squares and rectangles 306, 329

Drop and Depth Shadow button (Title tool) 308, 309, 342
Drop shadows

3D effects 585
Dropped frames 17
Dual Split button (Color Correction Composer window) 

600
Dual Split button (Effect Editor) 69
Dual Split button (Effect Preview monitor) 61
Dual Split display

Color Correction mode 599
Duplicate command (Edit menu)

for title elements 344

E
Ease In and Ease Out Velocity options

Avid Pan & Zoom effect 532
EBU N19 caption file format 368
Edge Wipe effects

Horizontal 455
Horizontal Open 455
Lower Left Diagonal 455
Lower Right Diagonal 455
overview of reference information 455
Upper Left Diagonal 455
Upper Right Diagonal 455
Vertical 455
Vertical Open 455

Edit decision list (EDL)
See EDL (edit decision list)

Edit Review button

Conceal 454
Edge Wipes 455
Film 456
Generator 458
Illusion FX 459
Image 465
Key 469
L-Conceal 472
Matrix Wipe 473
Motion effects 474
Peel 475
PlasmaWipe 476
Push 476
Reformat 477
Sawtooth Wipes 478
Shape Wipe 479
Spin 481
Squeeze 482
Timewarp effects 483
Title effects 488
Xpress 3D 489

Effect Editor 68, 68, 69, 69, 72, 73, 74, 74, 74, 82, 82, 87, 
93, 114, 117, 244, 249

displaying in Color Correction mode 697
for adjusting titles 361
for Intraframe editing 385
nested effects 212
transition parameters 48

Effect Editor command (Tools menu) 36
Effect Grid 64, 64, 224

setting options 24
Effect Icons command (Timeline Fast menu) 23
Effect mode 32, 32
Effect Mode button 32
Effect Palette

applying effects 27
automatic color correction effect templates in 620
automatic color correction from 632
color coding 18
described 19
displaying 20
displaying effect templates 20
resizing 20

Effect Palette Color Correction effect
applying 632
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deleting 710
described 707
saving as a template 710

Effect parameters
3D, overview of reference information 573
422 Safe (Safe Color Limiter effect) 546
Acceleration 492
Actions (Pan and Scan effect) 569
Advanced (Avid Pan & Zoom effect) 534
Aspect Ratios (Pan and Scan effect) 569
Avid Pan & Zoom effect 530
Axis 574

Generation (Illusion FX Lightning effect) 516
Generation (Illusion FX Ripple effect) 525
Generation (Illusion FX Sparkler effect) 527
Generator 501
Glow (Illusion FX Lightning effect) 517
Glow (Illusion FX Sparkler effect) 528
Grid 497
Highlight 582
Highlight Color 582
holding values in keyframe graphs 112
Illumination (Illusion FX Ripple effect) 526
Illusion FX 510
791

Background 493
Background (Avid Pan & Zoom effect) 533
Background (Illusion FX Pattern Generator effect) 522
Background Color 575
Blur 535
Border 493
Border (3D) 575
Border (Illusion FX) 510
Brush 494
Brush (FluidMotion Edit) 570
Bypass (SpectraMatte effect) 554
Cache (Avid Pan & Zoom effect) 534
Center (Illusion FX Kaleidoscope effect) 515
changes at advanced keyframes 106
Chroma Adjust 537
Chroma Control (SpectraMatte effect) 556
Chroma Key (RGB Keyer effect) 552
Circle (Illusion FX Pattern Generator effect) 523
Color (Paint Effect) 546
Color Correction (RGB Keyer effect) 553
Color Gain 539
Color Match (Spot Color Correction effect) 549
Color Style 538
common 2D, overview of reference information 492
Composite/Luma Levels (Safe Color Limiter effect) 

547
Core (Illusion FX Lightning effect) 516
Core (Illusion FX Sparkler effect) 528
Corner Pin 576
Crop 494
Crop (3D) 577
Custom Grid 495
Defocus 577
Display (Avid Pan & Zoom effect) 531
Display (FluidMotion Edit) 570
Erode/Expand 578
extrapolating values with advanced keyframes 112
Feathering 495
Feathering (FluidMotion Edit) 570
Filtering (Avid Pan & Zoom effect) 533
FluidMotion Edit 570
for transitions 500
Foreground 496
Foreground (3D) 579
Freeze Frame 565

Image 530
Input (Illusion FX Color Mix effect) 510
Input (Illusion FX Crystal effect) 511
Input (Illusion FX Film Grain effect) 511
Input (Illusion FX Flare effect) 512
Input (Illusion FX FluidBlur effect) 512
Input (Illusion FX FluidColor effect) 513
Input (Illusion FX FluidMorph effect) 514
Input (Illusion FX Iris effect) 514
Input (Illusion FX Kaleidoscope effect) 515
Input (Illusion FX Melt effect) 517
Input (Illusion FX Motion Blur effect) 517
Input (Illusion FX Pagecurl effect) 518
Input (Illusion FX Particle Blast effect) 519
Input (Illusion FX Particle Orbit effect) 520
Input (Illusion FX Particle Wind effect) 521
Input (Illusion FX Pinch effect) 523
Input (Illusion FX Radial Blur effect) 524
Input (Illusion FX Random Blend effect) 524
Input (Illusion FX Rollup effect) 526
Input (Illusion FX Shear effect) 527
Input (Illusion FX Sphere effect) 529
Input (Illusion FX Swirl effect) 529
Input (Illusion FX Twist effect) 529
Input (Illusion FX Wave effect) 530
Key 550
Key (Chroma Key and Luma Key effects) 550
Key Color (RGB Keyer effect) 552
Key Color (SpectraMatte effect) 554
Lowlight Color 582
Luma Adjust 535
Luma Clip 537
Luma Control (SpectraMatte effect) 560
Luma Range 536
Magic Mask 498
Mask (FluidMotion Edit) 571
Matte Analysis (SpectraMatte effect) 554
Matte Control (RGB Keyer effect) 553
Matte Processing (SpectraMatte effect) 562
Mode (AniMatte effect) 550
Mode (FluidMotion Edit) 571
Mode (Paint effect) 540
Mosaic 539
Motion 565
Motion (Illusion FX Ripple effect) 525
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Movement (Illusion FX Sparkler effect) 528
Number (Illusion FX Pattern Generator effect) 523
Offset (Illusion FX Kaleidoscope effect) 515
Other Options (Avid Pan & Zoom effect) 530
overview of reference information 491
Path (Avid Pan & Zoom effect) 532
Perspective 583
Position 499
Position (3D) 583
Position (Avid Pan & Zoom effect) 531
Position (Rolling Title and Crawling Title effects) 572
Position H (14:9 Letterbox Reformat effect) 569

adjusting 33
adjusting in Quick Transition dialog box 51, 56, 57
adjusting in Timeline 57
Aperture settings 24
applying 27, 53, 53
applying dissolves 48, 48, 49
applying Intraframe 384
applying to multiple transitions 55
Avid Pan & Zoom 230, 230, 231, 232, 233, 235, 236, 

236, 237, 238, 238
AVX plug-in 145
AVX plug-in, upgrading 148
792

Profile 551
Reformat 568
Render Mode (Avid Pan & Zoom effect) 535
RGB Levels (Safe Color Limiter effect) 548
Rotation 584
Scaling 499
Scaling (3D) 585
Scratch (Scratch Removal effect) 548
Scroll Position H (Crawling Title effect) 573
Secondary Key (Chroma Key effect) 551
Shadow 585
Shape 586
Size (Avid Pan & Zoom effect) 531
Skew 590
Source (Illusion FX FluidMorph effect) 513
Source Monitor Analysis (Safe Color Limiter effect) 

547
Spill (SpectraMatte effect) 563
Spill Suppression (3D effects) 590
Spill Suppression (Chroma Key effect) 552
Stamp 591
Strobe Motion 566
SubCap 502
Target 592
Timecode 506
Title 572
Tracking 500, 577
Trail 592
Variable Speed 566
Velocity (Avid Pan & Zoom effect) 532

Effect Preview monitor 32, 34, 60, 61, 63, 63, 64, 67, 78, 
88, 244, 253

Effect templates 36, 53
displaying in Effect Palette 20

Effect templates for color correction
automatic template update behavior 619
described 618
save behavior 619
using automatic templates 620

Effects
See also Effects (2D)
See also Effects (3D)
16-bit rendering 138
2D, promoting to 3D 284
3D, real-time playback 285

bit depth for processing 124, 126
categories in Effect Palette 19
changing parameters at keyframes 119
changing position within 34
clearing rendered 44
color coding 18
Color Correction 707
deleting 30
deleting media files 144
demoting 34
differences by project type 21
dropped frames 17
fading 29
field processing 411
frame processing 411
Grid settings 24
HD projects 21
key 196, 202, 203, 205, 205, 207, 207, 213
layered 196
managing media files 142
mapping buttons 62
motion tracking 243
motion tracking examples 279
nested 209, 210, 210, 211, 212, 213
overview of reference information 451
overview of types 15
Paint (Image category) 750
Pan and Scan 221, 222, 223, 224, 226, 226, 227, 228, 

229
parameters 68, 69, 72, 73, 74, 74, 74
PlasmaWipe 436
playback capabilities 17, 40
playback with tracking data 269
playing 39, 39
position coordinates 65
preview with Render On-the-Fly 40
processing in real time 122
processing when using Scratch Removal 414
promoting 34
real-time and non-real-time 17
real-time playback 122, 123, 124, 124, 126, 126
Reformat 220
Region Stabilize 274, 276
rendering 41, 42
rendering options 135
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replacing existing 60
rerendering 46
resize handles 78
revealing media files 143
Safe Color Limiter (Image category) 745
Safe Color Limiter, adjusting 745
Safe Color Limiter, analysis display 746
Safe Color Limiter, applying 745
sizing to fit media 31
SpectraMatte 197, 197, 199, 200
Spot Color Correction (Image category) 748
Stabilization 248

Enlarged image
moving in Effect Preview monitor 67

Erode/Expand effect parameters 578
Error messages

Video Underrun 124
EuControl

configuration 758
installation 752, 752

Examples
black point adjustments 660
Channel Blending settings 658
correction with Color Match control 640
793

SubCap 368
Submaster 215, 216
Timeline View settings 23
Timewarp 163
Trim settings 24
wire frames 78

Effects (2D)
PlasmaWipe 436
promoting to 3D 284

Effects (3D)
adjustment handles 287
applying 283
applying 3D Warp 283
compatibility between Avid applications 283
coordinate system for 285
creating Chroma Key 295
creating Corner Pin 292
creating cropped foreground 291
creating Page Curl 289
creating Stamp 294
matte key 284
motion path in 287
overview 282
parameter adjustments 287
promoting from 2D 284
real-time playback 285
Xpress 3D Effect category 283

Effects Editing command (Toolset menu) 32
Effects Editing command (Workspaces menu) 27
Effects parameters

Blowup 501
Elastic command (shortcut menu for keyframe track) 110
Elastic keyframes 110
Ellipse Shape Wipe effect 479
Enable button (Effect Editor) 74
Enable buttons (Color Correction tool)

described 611
interactions between 612

Enable Tracker button (Tracking window) 246
Enabling

color vectors 687
Ending at Cut button (Quick Transition dialog box) 57
Ending at Cut effect parameter 500
Enlarge button (Effect Editor) 69, 78
Enlarge button (Effect Preview monitor) 61

correction with NaturalMatch 640
Curves tab color corrections 675
gray point adjustments 660
Hue Offsets color correction settings 649
inverted images in secondary color correction 695
isolated images in secondary color correction 692, 695
Levels tab color corrections 669
Luma Ranges three-tone previews 654
merging color-corrected sequences 719
softness adjustments (secondary color correction) 690
typical color correction problems 728

ExpertRender 123, 127, 127, 129, 130, 132, 134
ExpertRender commands (Clip menu) 129
Export Title command (File menu) 354
Exporting

AniMatte effect as a PICT file 410
caption files from SubCap effect 376
matte key as PICT file 410
titles as graphics files 354

Extrapolate command (shortcut menu for keyframe track) 
112

Extrapolate option for keyframe graph parameter values 
112

Eyedropper 74
3 x 3 averaging of pixels for color correction 614
3 x 3 averaging of pixels, using 634
adjusting a color with 340
Color Selection buttons, using with 692
in Color Match control 634
options for color correction 614
selecting a color with 388

F
Fade Effect button 29

fading titles with 360
Fade from Color Blend effect 53, 452
Fade to Color Blend effect 53, 452
Fading

effects 29
titles 360

Fast Forward button (Effect Preview monitor) 61
Fast Frame Display command (Special menu) 411
Fast Menu button (Effect Editor) 72
Fast Save option for titles 347
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Feathering
for Blur and Mosaic effects 432
for Intraframe effects 395
using 433

Feathering effect parameters 495
Feathering effect parameters (FluidMotion Edit) 570
Field parameter for Blowup effects 501
Field processing 411
Film Dissolve Film effect 458
Film effects

1:66 Mask 457
1:85 Mask 457

selecting 326
setting point size 326
substituting 317

Foreground (3D) effect parameters 579
Foreground effect parameters 496
Formatting

rolling or crawling titles 335
title text 325

Frame display
controlling in Color correction monitors 600

Frame processing 411
Freeze Frame command (Clip menu) 155
794

16:9 Mask 457
Anamorphic Mask 457
Blowup 457
Film Dissolve 458
Film Fade 458
Mask 457
overview of reference information 456

Film Fade Film effect 458
Film Grain Illusion FX effect 460
Film projects

position information 66
Filtering effect parameter (Avid Pan & Zoom effect) 533
Finding

tracking data points 264
Fit to Fill button 158
Fixed Aspect effect parameter 499
Fixed Aspect option

Blur effect 433
Mosaic effect 433

Fixed Aspect parameter
in 3D Target parameters 592

Fixed command (shortcut menu for keyframe track) 110
Fixed keyframes 110
Flare Illusion FX effect 460
Flatten Correction command (Color Correction shortcut 

menu) 720
Flattening

color-corrected sequences 720
Flaws 411
Flip Image effect 466
Flip-Flop Image effect 466
Flop Image effect 466
FluidBlur Illusion FX effect 464
FluidColorMap Illusion FX effect 464
FluidFilm 2:3 Cadence Timewarp effect 484
FluidFilm Progressive Timewarp effect 484
FluidMorph Illusion FX effect 464
FluidMotion 186, 187, 192, 193
FluidMotion Edit effect parameters

overview of reference information 570
FluidStabilizer 256, 270
Font Selection button (Title tool) 326
Fonts

compatibility between systems 317
installing 317

Freeze Frame effect 155
Freeze Frame effect parameters 565
Freeze Frame Motion effect 474
Freezing a rolling clip 156
Full Quality 10-bit command (Video Quality menu) 124, 

126
Function keys

using with title styles 351

G
Gain

with Color Effect 539
with key effects 550

Generating
tracking data 257

Generation effect parameters (Illusion FX Lightning 
effect) 516

Generation effect parameters (Illusion FX Ripple effect) 
525

Generation effect parameters (Illusion FX Sparkler effect) 
527

Generator effect parameters
overview of reference information 501

Generator effects
overview of reference information 458
SubCap 458
Timecode Burn-In 458

Global Properties reference for SubCap effect 505
Glow effect for titles 343
Glow effect parameters (Illusion FX Lightning effect) 517
Glow effect parameters (Illusion FX Sparkler effect) 528
Go to Next Uncorrected Shot button (Color Correction 

Composer window) 600
Go to Previous Uncorrected Shot button (Color Correction 

Composer window) 600
Graphics

imported 207
Graphics for titles

displaying grid for 321, 323
Graphics in titles

drawing 306, 329
Graphics tablet 387
Gray point adjustments

examples of 660
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guidelines for 725
Greek language

Title tool 367
Green dot 18

in Timeline 41
Green tab (Levels group in Color Correction tool) 664
Grid

for title alignment 321, 323
snapping to in Title tool 323

Grid button (Effect Editor) 63, 64
Grid display for effects 64
Grid effect parameters 497

HQ (Highest Quality) button (Effect Editor) 141
HQ button (Effect Editor) 69
HQ rendering 141
HSL (Hue, Saturation, Luminance) group (Color 

Correction tool) 641
HSL sliders (Color Correction tool)

described 643
making adjustments with 643

Hue
defined 491

Hue Offsets tab (HSL group in Color Correction tool)
ChromaWheel controls in 649
795

Grid Matrix Wipe effect 473
Group command (Object menu) 344, 408
Grouping and ungrouping

Intraframe objects 408
objects in titles 344

Groups
See Color correction groups

H
Halo effect for titles 343
Handles 31

for adjusting 3D effects 287
HD resolutions

behavior with AVX plug-ins 145
HDTV aspect ratio

in the Title tool 317, 317
Head Fade button 49
Hiding

advanced keyframe graph display 82
Hierarchy of 3D parameters 574
High-contrast images 207
Highest Quality (HQ) button (Effect Editor) 69
Highlight Color effect parameters 582
Highlight effect parameters 582
Highlights tab (HSL group in Color Correction tool) 653
Histogram

working with PlasmaWipe effects 442
Histograms

color correction, display options for 614
described 665
using controls 667

Hold command (shortcut menu for keyframe track) 112
Hold option for keyframe graph parameter values 112
Hold Velocity option

Avid Pan & Zoom effect 532
Hollow drag handles, for locked objects 344
Horizontal Bands Shape Wipe effect 479
Horizontal Blinds Shape Wipe effect 479
Horizontal Centered Squeeze effect 482
Horizontal Edge Wipe effect 455
Horizontal Open Edge Wipe effect 455
Horizontal Open Sawtooth Sawtooth Wipe effect 478
Horizontal Sawtooth Sawtooth Wipe effect 478
Horizontal zoom slider for keyframe graphs 84

described 645
examples of settings for 649
making corrections with 648

I
Illumination effect parameters (Illusion FX Ripple effect) 

526
Illusion FX

Background effect parameter for Pattern Generator 
effect 522

Border parameters 510
Center effect parameter for Kaleidoscope effect 515
Circle effect parameter for Pattern Generator effect 523
Core effect parameter for Lightning effect 516
Core effect parameter for Sparkler effect 528
Generation effect parameter for Lightning effect 516
Generation effect parameter for Ripple effect 525
Generation effect parameter for Sparkler effect 527
Glow effect parameter for Lightning effect 517
Glow effect parameter for Sparkler effect 528
Illumination effect parameter for Ripple effect 526
Input effect parameter for Color Mix effect 510
Input effect parameter for Crystal effect 511
Input effect parameter for Film Grain effect 511
Input effect parameter for Flare effect 512
Input effect parameter for FluidBlur effect 512
Input effect parameter for FluidColor effect 513
Input effect parameter for FluidMorph effect 514
Input effect parameter for Iris effect 514
Input effect parameter for Kaleidoscope effect 515
Input effect parameter for Melt effect 517
Input effect parameter for Motion Blur effect 517
Input effect parameter for Pagecurl effect 518
Input effect parameter for Particle Blast effect 519
Input effect parameter for Particle Orbit effect 520
Input effect parameter for Particle Wind effect 521
Input effect parameter for Pinch effect 523
Input effect parameter for Radial Blur effect 524
Input effect parameter for Random Blend effect 524
Input effect parameter for Rollup effect 526
Input effect parameter for Shear effect 527
Input effect parameter for Sphere effect 529
Input effect parameter for Swirl effect 529
Input effect parameter for Twist effect 529
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Input effect parameter for Wave effect 530
Motion effect parameter for Ripple effect 525
Movement effect parameter for Sparkler effect 528
Number effect parameter for Pattern Generator effect 

523
Offset effect parameter for Kaleidoscope effect 515
Source effect parameter for FluidMorph effect 513

Illusion FX effect parameters
overview of reference information 510

Illusion FX effects
Color Mix 460
Crystal 460

Stabilize 469
Submaster 469

Importing
caption files into the SubCap effect 372
to the Avid Pan & Zoom effect 530

Indent Rows command (Effect Editor shortcut menu) 117
Input color vectors

adjusting 687
sliders 688

Input effect parameters (Illusion FX Color Mix effect) 510
Input effect parameters (Illusion FX Crystal effect) 511
Input effect parameters (Illusion FX Film Grain effect) 511
796

Film Grain 460
Flare 460
FluidBlur 464
FluidColorMap 464
FluidMorph 464
Iris 463
Kaleidoscope 460
Lightning 460
Melt 463
Motion Blur 460
overview of reference information 459
Pagecurl 463
Particle Blast 463
Particle Orbit 463
Particle Wind 463
Pattern Generator 460
Pinch 460
Radial Blur 460
Random Blend 463
Ripple 460
Rollup 463
Shear 463
Sparkler 460
Sphere 460
Swirl 460
Twist 460
Wave 460

Image effect parameters
overview of reference information 530

Image effects
Avid Pan & Zoom 465
Blur Effect 465
Color Correction 466
Color Effect 466, 466
Flip 466
Flip-Flop 466
Flop 466
Mask 467
Mosaic Effect 465
overview of reference information 465
Paint 467
Resize 468
Safe Color Limiter 468
Scratch Removal 468
Spot Color Correction 469

Input effect parameters (Illusion FX Flare effect) 512
Input effect parameters (Illusion FX FluidBlur effect) 512
Input effect parameters (Illusion FX FluidColor effect) 

513
Input effect parameters (Illusion FX FluidMorph effect) 

514
Input effect parameters (Illusion FX Iris effect) 514
Input effect parameters (Illusion FX Kaleidoscope effect) 

515
Input effect parameters (Illusion FX Melt effect) 517
Input effect parameters (Illusion FX Motion Blur effect) 

517
Input effect parameters (Illusion FX Pagecurl effect) 518
Input effect parameters (Illusion FX Particle Blast effect) 

519
Input effect parameters (Illusion FX Particle Orbit effect) 

520
Input effect parameters (Illusion FX Particle Wind effect) 

521
Input effect parameters (Illusion FX Pinch effect) 523
Input effect parameters (Illusion FX Radial Blur effect) 

524
Input effect parameters (Illusion FX Random Blend effect) 

524
Input effect parameters (Illusion FX Rollup effect) 526
Input effect parameters (Illusion FX Shear effect) 527
Input effect parameters (Illusion FX Sphere effect) 529
Input effect parameters (Illusion FX Swirl effect) 529
Input effect parameters (Illusion FX Twist effect) 529
Input effect parameters (Illusion FX Wave effect) 530
Installing

AVX plug-in effects 146
Insufficient Source message 31, 288
Interaction between color correction groups 610
Interface

motion tracking 244
Interpolation options for keyframe graphs 106
Interrupting

Render On-the-Fly 40
rendering of effects 137

Intraframe editing
Brush tool 388
changing effect parameters 395
creating polygon shapes 392
Curve tool 394
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customizing Brush shape 389
described 382
drawing tools 387
examples of 423, 425, 427, 429, 430
graphics tablet 387
modes described 387
Oval tool 391
pen tool 387
Polygon tool 392
Previsualization Marker tool 404
Rectangle tool 391
rendering during 383

K
Kaleidoscope Illusion FX effect 460
Kerning

title text 328
Kerning button (Title tool) 328
Key Color effect parameters (RGB Keyer effect) 552
Key Color effect parameters (SpectraMatte effect) 554
Key effect parameters

overview of reference information 550
Key effect parameters (Chroma Key and Luma Key 

effects) 550
797

saving a brush template 390
summary of line and curve modification 401
using control points 402
using keyframes 408
using Selection tool 394
with Magic Mask 423

Intraframe objects
grouping and ungrouping 408
layering 408
locking and unlocking 408
moving 405
reshaping 405
rotating along Z axis 406
scaling 407

Invert Key option 496
Invert Last Vector feature (Secondary color correction)

described 686
examples of images using 695

Inverting
color effects 535
color vectors 695

Inverting keys
Full 579

IRE units for color correction 614
Iris Illusion FX effect 463
Isolate feature (Secondary color correction)

described 686
examples of images using 692, 695

Isolated images
examples of 692

Isolating
color vectors in an image 692

Isolating flaws for removal 415
Italic button (Title tool) 327
Italic command (Object menu) 327
Italic text

in titles 327

J
Join

in Intraframe objects 396
Justifying

title text 327

Key effects 196, 202, 203
AniMatte 470
Chroma Key 470
luma 205
Luma Key 470
Matte Key 205, 207, 207, 213, 471
overview of reference information 469
RGB Keyer 471
SpectraMatte 472

Key effects (3D)
3D matte keys 284

Keyboard shortcuts
saving titles with 347

Keyframe graphs 80, 82, 82, 83, 84, 84, 87, 87, 98, 103, 
104, 106, 106, 110, 112, 117

Keyframe tracks 80, 82
Keyframes

See also Advanced keyframes
adding in keyframe graphs 89
changing parameters 119
copying and pasting 119
creating 119
defined 80
deleting 119
for adjusting titles 361
moving 119
selecting 119
with Intraframe effects 408

Keyframes, advanced
Color Correction monitor 699
color correction parameters 698

L
Large Text command (Effect Editor shortcut menu) 117
Layered effects 196
Layering

Intraframe objects 408
titles 344

L-Conceal effects
Bottom Left 472
Bottom Right 472
overview of reference information 472
Top Left 472, 472
Top Right 472
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Leading
title text 329

Left Box Box Wipe effect 454
Left Centered Squeeze effect 482
Left to Right Conceal effect 454
Left to Right Peel effect 475
Left to Right Push effect 476
Left to Right Squeeze effect 482, 482
Letterboxing 220
Levels effect parameter

Avid Pan & Zoom effect 534
Levels group (Color Correction tool)

understanding 652
Luma Ranges tab (HSL group in Color Correction tool)

adjusting luminance ranges in 653
described 651
three-tone previews in 654
understanding graphs in 652

Luma tab (Levels group in Color Correction tool) 664, 668
Luminance

defined 491
of color effect 535

Luminance limits for broadcast 737
Luminance ranges
798

described 659
function compared to Channels group 659

Levels tab (Color Correction tool)
ChromaCurve graphs described 665
examples of adjustments in 669
examples of black point adjustments 660
examples of gray point adjustments 660
histograms, described 665
making corrections in 664
making curve adjustments 667
understanding input and output adjustments in 660
using histogram controls 667
working with controls in 665

Lightning Illusion FX effect 460
Limitations

playing fast rolling titles 360
Line tool (Title tool) 306, 329
Linear keyframe interpolation option 106
Linear Path option

Avid Pan & Zoom effect 532
Linear Velocity option

Avid Pan & Zoom effect 532
Lines

attribute options 336
in titles 306, 329

Locating AVX_Plug-Ins folder (Macintosh) 146
Locating AVX_Plug-Ins folder (Windows) 147
Lock command (Object menu) 344, 408
Lock Vectors button (Secondary tab in Color Correction 

tool) 689
Locked objects

hollow handles indicating 344
Locking and unlocking

Intraframe objects 408
objects in titles 344

Lower Left Diagonal Edge Wipe effect 455
Lower Right Diagonal Edge Wipe effect 455
Lowlight Color effect parameters 582
Luma Adjust effect parameters 535
Luma Clip effect parameters 537
Luma Control effect parameters (SpectraMatte effect) 560
Luma Key Key effect 470
Luma Range effect parameters 536
Luma Ranges graphs

control points on 654

adjusting 653

M
Macintosh Colors panel 74, 340

using with Color Match control 634
Magic Mask effect parameters 498
Magic Mask parameters (2D)

colorizing with 423
Magnified image

moving in Effect Preview monitor 67
Make Crawl command

for crawling titles 333
Mapping

trackers 251, 252
Mark IN and Mark OUT buttons

using in titles 360
Markers

controlling frame display in Color Correction mode 
600

Marks
using with color correction 614

Marquee Title tool
converting title styles to 352
described 298
opening 297
promoting titles to 362

Mask effect parameters (FluidMotion Edit) 571
Mask Film effect 457
Mask Image effect 467
Master clips

imported 207
Master tab (Levels group in Color Correction tool) 664
Match Frame button 156
Match Type menu

in Color Match control 636
Matrix Wipe effects

Grid 473
One-Way Row 473
overview of reference information 473
Speckle 473
Spiral 473
Zig-Zag 473

Matte Analysis effect parameters (SpectraMatte effect) 
554
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Matte Control effect parameters (RGB Keyer effect) 553
Matte key

exporting as PICT file 410
Matte Key effect (2D)

applying 427
promoting to 3D 284

Matte Key effect (3D)
using 284

Matte Key Key effect 471
Matte Processing effect parameters (SpectraMatte effect) 

562
Mattes

16:9 display in Color Correction mode 597
color correction, customizing image display 598
Pan and Scan effect 224
reference frame display in Color Correction mode 598
safe color warnings in 740
source menu in Color Correction mode 598, 598

Mosaic effect (2D)
creating 433
described 382
parameters 432

Mosaic Effect Image effect 465
Mosaic effect parameters 539
799

preparing for key effects 207
Media Creation tool 138
Media drives

speed limitations with real-time effects preview 123
Media files 142, 143, 144
Melt Illusion FX effect 463
Memory usage

Avid Pan & Zoom effect 238
Memory usage for AVX plug-in effects 146, 151
Menu commands

Add Page (Object menu) 334
Auto Size Mode (Object menu) 332
Bring Forward (Object menu) 408
Bring to Front (Object menu) 408
Copy to Page (Object menu) 334
Export Title (File menu) 354
Fast Frame Display (Special menu) 411
Group (Object menu) 408
Insert Page (Object menu) 334
Lock (Object menu) 408
Move to Page (Object menu) 334
Re-create Titles and Mattes (Clip menu) 365
Remove Page (Object menu) 334
Send Backward (Object menu) 408
Send to Back (Object menu) 408
UnGroup (Object menu) 408
Unlock (Object menu) 408

Merge Correction command (Color Correction shortcut 
menu) 716

Merging
color-corrected sequences 716
color-corrected sequences, example of 719

Midtones tab (HSL group in Color Correction tool) 653
Millivolt units for color correction 614
Mode effect parameters (AniMatte effect) 550
Mode effect parameters (FluidMotion Edit) 571
Mode effect parameters (Paint effect) 540
Modes

for Intraframe editing 387
Paint Effect, for spot color correction 750

Modes for Paint Effect 540
Modifying

ExpertRender results 132
rolling or crawling titles 335

Monitors

Motion Adapter effects
Adaptive deinterlacing option 170

Motion Blur Illusion FX effect 460
Motion Effect button 156
Motion Effect Editor 167, 171, 176, 177
Motion effect parameters

overview of reference information 565
Motion effect parameters (Illusion FX Ripple effect) 525
Motion effects

creating 154, 165
Freeze Frame 155, 474
freezing a rolling clip 156
overview 153
overview of reference information 474
playback 160
promoting to Timewarp 166
rendering 160, 163
reversing 566
sizing to fit 158
Strobe Motion 159, 474
Timewarp 163
traditional, playback of 474
Variable Speed 156, 158, 474

Motion path
Pan and Scan effect 227

Motion path editor 287
Motion paths for effects 78
Motion tracking

available effects and parameters 243
copying and pasting data 278
editing segments with tracking data 276
enabling 249
examples 279
generating data 257
interface 244
manipulating data points 264
offset tracking 258, 259, 260
overview 241
playback of effects 269
preparations for generating tracking data 249
reference frames 262
reusing data 277
selecting image areas 255
set-up 248, 253, 256
smoothing data 263, 264
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trackers 251, 252, 253
tracking data 260, 261
tracking engines 256
Tracking window 246, 246
workflow 242

Movement effect parameters (Illusion FX Sparkler effect) 
528

Moving
advanced keyframes 98
keyframes 119
perspective point of 3D effects 583
tracking boxes 253

adjusting 693
Oval tool for Intraframe editing 391

P
Page count limits

for rolling and crawling titles 330
Page Curl effect (3D)

as transition 289
Page Fold Shape effect 586

angle value examples 589
controlling image on flap 589
800

tracking data points 264
Multiformat titles 221
Multilayer effects (3D)

3D Matte Key 284
Multiple tracks in AVX plug-in effects 149
mVolt (millivolt) units for color correction 614

N
NaturalMatch

described 639
example of use 640

Nested effects 209, 210, 210, 211, 212, 213
changing the order of 212

Nesting Priority icon 212
New Title command (Clip menu) 297
New Tracker button (Tracking window) 246
New Video Track command (Clip menu) 356, 357, 358
NTSC (National Television System Committee) video

frame size and safe title/action guidelines 322
Number effect parameters (Illusion FX Pattern Generator 

effect) 523

O
Objects

aligning in the Title tool 344
locking and unlocking 344

Offset effect parameters (Illusion FX Kaleidoscope effect) 
515

Offset tracking 258, 259, 260
One-Way Row Matrix Wipe effect 473
Online support 14
OpenGL 124
Opening

keyframe graphs and tracks 82
Marquee 297
Title tool 297
Tracking window 246

Optical list 66
with Previsualization Marker tool information 404

Other Options (Avid Pan & Zoom effect) 530
Other Options button (Effect Editor) 69, 74
Outline/Path button (Effect Editor) 69
Output color vectors

softening edges 589
Page number display

in Title tool 334
Pagecurl Illusion FX effect 463
Paint Effect 66

Color Match control in 750
making spot color corrections with 750
mode options for spot color correction 750
modes 540

Paint Effect (2D)
applying 384
creating signature effect 391
described 382
example of Blur mode 425
modes 387
painting with Brush tool 388
parameters for 385
rendering 383
selecting color 388
using Magic Mask parameters 423

Paint Image effect 467
PAL (Phase Alternating Line) video

frame size and safe title/action guidelines 322
Pan & Zoom

See Avid Pan & Zoom effect
Pan and Scan effect 221, 222, 223, 224, 226, 226, 227, 228, 

229
Pan and Scan Reformat effect 478
Pan and Zoom

See Avid Pan & Zoom effect
Panning

Avid Pan & Zoom effect 232, 531
keyframe graphs 87

Parameters
Blur effect 433
Mosaic effect 433

Parameters (2D)
Acceleration 432
Blur effect 432
Feathering 432, 433
Mosaic effect 432
Paint Effect 385

Parameters (3D)
accessing 282
adjustment handles 287
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Target 592
Parameters for effects 68, 69, 72, 73, 74, 74, 74

See Effect parameters
Partial render 137
Particle Blast Illusion FX effect 463
Particle Orbit Illusion FX effect 463
Particle Wind Illusion FX effect 463
Paste command

for title elements (Edit menu) 344
Pasting

advanced keyframes 103, 104
keyframes 119

Play Preview button (Effect Preview monitor) 61
Playback

video effects 122, 123, 124, 124, 126, 126, 130
Playback capabilities for effects 40
Playback of effects

Submaster restriction 469
Playing

3D effects 285
effects 39, 39

Plug-in effects 145
Point size

setting for title text 326
801

Path
in effect motion 287

Path effect parameter (Avid Pan & Zoom effect) 532
Path effect parameter for Intraframe editing 494
Pattern Generator Illusion FX effect 460
Peel effects

Bottom Left Corner 475
Bottom Right Corner 475
Bottom to Top 475, 475
Left to Right 475
reference 475
Right to Left 475
Top Left Corner 475
Top Right Corner 475

Pen tool for intraframe editing 387
Perspective effect parameters 583
Picture-in-Picture Blend effect 453
Picture-in-Picture effect 78
Pinch Illusion FX effect 460
PlasmaWipe effects 476

applying 438
creating from a custom image 439
creating from an existing image 440
default values 446
folder structure 438, 445
frame and border effects 446
PAL and NTSC versions 439, 444
testing an animation 443
threshold point 436, 436
tips for adjusting 445, 446
using the Adobe Photoshop histogram 442
using the Adobe Photoshop Pencil tool 441
using the Level value 436
working with Adobe Photoshop 439
working with gradient images 439

Play button 39
Play button (Effect Editor) 69
Play button (Effect Preview monitor) 61
Play button (Motion Effect Editor) 171
Play Loop button 39

function in Color Correction mode 602
Play Loop button (Effect Editor) 69
Play Loop button (Effect Preview monitor) 61
Play Loop button (Motion Effect Editor) 171
Play Preview button 39

Point size button (Title tool) 326
Polygon shape creation 392
Polygon tool for Intraframe editing 392
Position (3D) effect parameters 583
Position bar 34
Position coordinates for effects 65
Position display for two-field media 63
Position effect parameter (Avid Pan & Zoom effect) 531
Position effect parameters 499
Position effect parameters (Rolling Title and Crawling 

Title effects) 572
Position Graph display button (Timewarp effect) 167
Position graph for Timewarp effects

activating 167
scale bars 169

Position H effect parameter (14:9 Letterbox Reformat 
effect) 569

Position information for film projects and effects 66
Posterization

of Color Effect 538
Post-key color correction 203
Precompute

for title effect clip 355
Preview command (Object menu) 321
Previewing

anti-aliased titles 321
video effects 122

Previsualization Marker tool
described 404
using 404
with cut list 404

Processing
effects in real time 122

Profile effect parameter 551
Program color correction

described 604
Progressive projects

Avid Pan & Zoom effect 236
Project window

managing title styles in 354
Projects

effects considerations 21
moving from Macintosh to Windows 317
moving from Windows to Macintosh 317

Promoting
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2D effects to 3D effects 284
AVX plug-in effects 148
effects 34
traditional motion effect to Timewarp 166

Pulldown Insertion Timewarp effect 485
Pulldown Removal Timewarp effect 485
Push effects

Bottom Left to Top Right 476
Bottom Right to Top Left 476
Bottom to Top 476
Left to Right 476
overview of reference information 476

14:9 Letterbox 478
16:9 Letterbox 478
4:3 Sidebar 478
overview of reference information 477
Pan and Scan 478

Region Stabilize effect 274, 276
Relationship color corrections

behavior with Color Correction effect templates 624
converting 606
described 604
using Source Clip Name 606

Relationships for color correction
802

Right to Left 476
Top Left to Bottom Right 476
Top Right to Bottom Left 476
Top to Bottom 476

Q
Quad Display command (Color Correction monitor Source 

menu) 598
Quick Transition button 53, 55
Quick Transition dialog box 51, 55, 56, 57

creating transitions 53
Quick Transitions 50
Quick Transitions custom bin 53
QuickTime 206

R
Radial Blur Illusion FX effect 460
Random Blend Illusion FX effect 463
Real-time moving mattes 206
Real-time playback of effects 122, 123, 124, 124, 126, 

126, 130
Real-Time Update command (Effect Editor shortcut 

menu) 117
Recalling

title styles 353
Re-create Titles and Mattes command (Clip menu) 365
Re-creating

titles 364
Rectangle tool for Intraframe editing 391
Red tab (Levels group in Color Correction tool) 664
Reduce button (Effect Editor) 69, 78
Reduce button (Effect Preview monitor) 61
Reference command (Color Correction monitor Source 

menu) 598
Reference Current command (Color Correction shortcut 

menu) 598
Reference frames

displaying in Color Correction monitors 598
marking with markers in Color Correction mode 600

Reference frames for motion tracking 262
Reformat effect parameters

overview of reference information 568
Reformat effects

described 595
Remove Color Cast buttons (Color Correction tool) 631
Remove Correction command (Color Correction shortcut 

menu) 721
Remove Effect button 30
Remove Effect button (Color Correction Composer 

window) 600
Remove Redundant Keyframes command (Keyframe 

track shortcut menu) 92
Removing

color corrections 721
redundant keyframes 92
titles from a sequence 359

Removing color casts
guidelines for 726

Render at Position command (Clip menu) 42, 46
Render Effect button 42
Render Effect button (Effect Editor) 69
Render In/Out command (Clip menu) 42, 46
Render Mode effect parameter (Avid Pan & Zoom effect) 

535
Render On-the-Fly 40
Render On-the-Fly command (Special menu) 40
Render Ranges command (Timeline Fast menu) 137
Render settings 134, 135, 138, 141
Rendered effects

viewing in bins 355
Rendering

16-bit effects processing 138
after real-time playback attempt 130
AniMatte effects 383
Avid Pan & Zoom effect 236, 236
AVX plug-in effects 151
clearing rendered effects 44
defined 17
during Intraframe editing 383
effects 41, 42
HQ effects 141
interrupting 137
motion effects 135
Paint Effect 383
partial 137
Submaster restriction 469
Timewarp effects 163, 174
titles 364
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using ExpertRender 129
Rendering on-the-fly

while trimming 24
Replacing

existing effects 60
title fill tracks 364
titles in a sequence 360

Repositioning
title text 324

Rerendering
effects 46

Reset Graph View command (shortcut menu for keyframe 

displaying with the Color Match control 641
Right Box Box Wipe effect 454
Right Centered Squeeze effect 482
Right to Left Conceal effect 454
Right to Left Peel effect 475
Right to Left Push effect 476
Ripple Illusion FX effect 460
Rolling Title button (Title tool) 319, 332
Rolling Title effect 488
Rolling titles

See also Crawling titles
See also Titles
803

track) 87
Resetting

Color Correction tool controls 611
keyframe graph view 87

Reshape tool for Intraframe effects 405
Resize handles for effects 78
Resize Image effect 468
Resizing

Effect Palette 20
keyframe graphs 84
rolling or crawling titles 333
title text 324
tracking boxes 253

Restorative color correction guidelines 723
Reusing

tracking data 277
Reveal File command (File menu) 143
Revealing

effect media files 143
Reverse Animation option 496
Reverse Motion Timewarp effect 486
Reversing

advanced keyframes 110
motion effects 156, 566

Reviewing
color-corrected clips 602

Reviewing a stabilized image 273
Revising

titles in a bin 349
titles in a sequence 362

Rewind button (Effect Preview monitor) 61
RGB gamut limit type

described 737
RGB Histogram command (Color Correction monitor 

Source menu) 598
RGB Histogram display (Color Correction monitors) 700
RGB Keyer Key effect 471
RGB Levels effect parameters (Safe Color Limiter effect) 

548
RGB levels option

Avid Pan & Zoom effect 534
RGB Parade command (Color Correction monitor Source 

menu) 598
RGB Parade display (Color Correction monitors) 700
RGB values

adding pages 334
creating 330
defined 330
deleting pages from 334
duration 360
formatting text in 335
going to a page in 334
inserting a blank page into 334
page count limits for 330
playback limitations 360
resizing width of 333
scrolling through 333
setting marks in 360
setting text formatting for 332
trimming 360
typing text for 332

Rollup Illusion FX effect 463
Rotation axes (3D) 285
Rotation effect parameters 584

S
Safe Color Limiter effect

adjusting 745
analysis display 746
applying 745
described 745

Safe Color Limiter Image effect 468
Safe Color Settings button 741
Safe Color Settings dialog box 741
Safe Colors

adjusting color to achieve safe limits 742
graphical view of settings 739
overview 737
setting options for 738, 741
understanding warnings 740
warnings in monitors 740
warnings in the Color Match control 740

Safe Colors button (Color Correction tool) 738
Safe Colors command (Object menu) 323
Safe Title Area/Global Grid command (Object menu) 322
Safe title/action area 63

for aligning objects 344
Title tool 322

Saturation
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defined 491
of colors in titles 321, 323

Save Title As command (File menu) 347, 349
Save Title command (File menu) 347
Save Title dialog box 347
Saving

color correction effect templates to buckets 622
effect templates 36
multiple titles 347
partially completed renders 137
title styles 351
titles, basic procedure 347

Isolate feature 686
overview 680
resetting color vectors 687
Selected Vectors panel 686
selecting color vectors 687
Softness 688
Subtract from Selection button 692
Syringe button 691
vectors, described 682
workflow 681

Secondary Key effect parameters (Chroma Key effect) 551
Segment
804

titles, overview 347
titles, with a keyboard shortcut 347
titles, with Fast Save option 347

Sawtooth Wipe effects
Horizontal Open Sawtooth 478
Horizontal Sawtooth 478
overview of reference information 478
Vertical Open Sawtooth 478
Vertical Sawtooth 478

Scaling
keyframe graphs 84

Scaling (3D) effect parameters 585
Scaling effect parameters 499
Scaling Intraframe objects 407
Scratch effect parameters (Scratch Removal effect) 548
Scratch removal

finding flaws from telecine transfer 411
frame or field processing 414
isolating flaws 415
parameter setting examples 421
removing flaws 416, 417
selecting clean material 411
using effect parameters 420
using IN and OUT points 419
using nearby frame or field 411
within single frame or field 411
workflow for 411

Scratch Removal button 415
Scratch Removal effect (2D)

described 382
Scratch Removal Image effect 468
Scroll Position H effect parameter (Crawling Title effect) 

573
Scroll thumbwheel for keyframe graphs 87
Scrolling

keyframe graphs 87
through rolling or crawling titles 333

Secondary color correction
Add to Selection button 692
avoiding false color changes while demoing 689
Color Match control, using for 694, 694
Color Selection buttons 690
enabling color vectors 687
examples of softness adjustments 690
Invert Last Vector feature 686

in Intraframe objects 396
Select Unrendered Title command (Bin menu) 347
Selected Vectors panel (Secondary tab in Color Correction 

tool)
color swatch update behavior 686
described 686

Selecting
correction type in Color Correction tool 604
keyframes 119
tracking data points 264

Selection tool
for grouping objects 344
for ungrouping objects 344
with Intraframe editing 394

Selection tool (Title tool)
defined 320
text options for titles 326
viewing attributes with 325

Send Backward button (Effect Editor) 408
Send Backward command (Object menu) 344, 408
Send to Back command (Object menu) 344, 408
Sequences

applying color correction to 706
flattening color-corrected 720
merging color-corrected 716
promoting and demoting effects 34
removing color corrections from 721
removing redundant keyframes 92
removing titles from 359
replacing titles in 360
title editing in 356
updating color-corrected 715

Set Bin Display command (Bin menu) 143, 355
Set Position To Keyframe command (Effect Editor 

shortcut menu) 117
Settings

Effect Aperture 24
Render 134
Title Styles 354

Settings list
Controller settings 754

Shadow Depth and Direction button (Title tool) 308, 309, 
342

Shadow effect parameters 585
Shadow softness
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adjusting in titles 343
viewing current setting 343

Shadows
title 308, 309, 342

Shadows tab (HSL group in Color Correction tool) 653
Shape effect parameters 586
Shape effects

Ball 586
effect visibility 589
location of position indicator 589
Page Fold 586
Slats 586

Softness effect parameter for borders 493
Solarization

of Color Effect 538
Source Anchor Frame for Timewarp effects 170
Source Clip Name relationship (Color Correction) 606
Source color correction

described 604
Source effect parameters (Illusion FX FluidMorph effect) 

513
Source Has Square Pixels option

Avid Pan & Zoom effect 534
Source menu (Color Correction monitors) 598, 598
805

Shape Wipe effects
4 Corners 479
Center Box 479
Circle 479
Clock 479
Diamond 479
Ellipse 479
Horizontal Bands 479
Horizontal Blinds 479
overview of reference information 479
Vertical Blinds 479

Sharpness of focus for 3D effects 577
Shear Illusion FX effect 463
Shelf keyframe interpolation option 106
Shortcuts

saving titles with keyboard 347
Show Add Keyframe Mode Menu command (Effect Editor 

shortcut menu) 117
Show Alignment Grid command (Alignment menu) 323
Show Alpha option 496
Showing

advanced keyframe graph display 82
Single-field step 68
Size effect parameter (Avid Pan & Zoom effect) 531
Size of effect

adjusting 592
Sizing

effects 31
Skew effect parameters 590
Slats Shape effect 586
Slider controls (Effect Editor) 73
Slip Keyframe command (shortcut menu for keyframe 

track) 102
Slipping

advanced keyframes 100
Slow motion effect 156
Smooth Selected Points button (Tracking window) 246
Snap to Grid command (Alignment menu) 323
Soft Keys (Avid Artist Series controllers) 769
Soft shadows

adding to titles 343
Soften Shadow command (Object menu) 343
Softness

examples of adjustments in secondary color correction 
690

Source mode
Avid Pan & Zoom 531

Source Monitor Analysis effect parameters (Safe Color 
Limiter effect) 547

Sparkler Illusion FX effect 460
Speckle Matrix Wipe effect 473
SpectraMatte effect 197, 197, 199, 200
SpectraMatte Key effect 472
Speed Boost Timewarp effect 486
Speed Bump Timewarp effect 486
Speed Graph display button (Timewarp effect) 167
Speed graph for Timewarp effects

activating 167
reference 176, 177
scale bars 169

Sphere Illusion FX effect 460
Spill effect parameters (SpectraMatte effect) 563
Spill Suppression effect parameters (3D effects) 590
Spill Suppression effect parameters (Chroma Key effect) 

552
Spin effects

overview of reference information 481
X Spin 481
Y Spin 481
Z Spin 482

Spiral Matrix Wipe effect 473
Spline keyframe interpolation option 106
Spline Path option

Avid Pan & Zoom effect 532
Spot Color Correction effect

described 748
making corrections with 749

Spot Color Correction Image effect 469
Square and Rectangle tool (Title tool) 306, 329
Squeeze effects

Bottom Centered 482
Bottom Left 482
Bottom Right 482
Bottom to Top 482
Centered Zoom 482
Horizontal Centered 482
Left Centered 482
Left to Right 482, 482
overview of reference information 482
Right Centered 482



Index

Top Centered 482
Top Left 482
Top Right 482
Top to Bottom 482

Stabalized image
adjusting 273

Stabilization 274
overview 270

Stabilize Image effect 469
Stabilized image

reviewing 273
Stabilizing images 270

Subdividing
Pan and Scan effect 226

Submaster effect 41, 127
Submaster effects 215, 216
Submaster Image effect 469
Substituting fonts 317
Subtitling

See SubCap effect
Subtract from Selection button (Secondary tab in Color 

Correction tool) 692
Superimpose Blend effect 453
Swap Sources option 496
806

Stages of typical color correction 724
Stamp (3D)

clearing 294
creating 294

Stamp effect parameters 591
Standard color vectors 682
Standard keyframes

See Keyframes
Starting at Cut button (Quick Transition dialog box) 57
Starting at Cut effect parameter 500
SteadyGlide 263, 264
Step Backward One Field button (Effect Preview monitor) 

61, 68
Step Forward One Field button (Effect Preview monitor) 

61, 68
Step In button (Timeline) 210
Step Out button (Timeline) 210
Stepping

two-field media 68
Stretch Points Mode button (Tracking window) 246
Stretching

tracking data points 267
Strobe Motion effect 159
Strobe Motion effect parameters 566
Strobe Motion Motion effect 474
Stylesheets

for SubCap effect 378
SubCap effect

adding information and custom data 373
adjusting parameters 375
applying 370
described 368
editing text in the Master Caption list 374
entering text in Effect Editor 372
exporting data to caption files 376
global properties 373, 375, 378
Global Properties reference 505
importing caption files 372
interaction with caption files 369
parameter adjustment examples 379
stylesheets 378
synchronizing parameters and information 375
Unicode text support 377

SubCap effect parameters 502, 506
SubCap Generator effect 458

Swapping effect tracks 579
Swirl Illusion FX effect 460
Syringe button (Secondary tab in Color Correction tool) 

691, 694

T
Tab buttons

accessing Color Correction tool tabs with 610
Tabs

Channels (Color Correction tool) 656
Color Correction tool, described 607
Color Correction tool, displaying 608
Composite (Levels group in Color Correction tool) 

664, 668
Controls (HSL group in Color Correction tool) 642
Highlights (HSL group in Color Correction tool) 653
Hue Offsets (HSL group in Color Correction tool) 645
Luma (Levels group in Color Correction tool) 664, 668
Luma Ranges (HSL group in Color Correction tool) 

651
Master (Levels group in Color Correction tool) 664
Midtones (HSL group in Color Correction tool) 653
Red, Green, and Blue (Levels group in Color 

Correction tool) 664
Shadows (HSL group in Color Correction tool) 653

Tail Fade button 49
Target effect parameters 592
Target mode

Avid Pan & Zoom 531
Target parameters (3D) 592
Templates

color correction, applying 623
color correction, described 618
color correction, save behavior for 619
for titles 350
saving Effect Palette Color Correction effects as 710

Templates, effect
See Effect templates

Text
copying and pasting into Title tool 324
creating in Title tool 324
title, editing 325
title, formatting 325
title, justifying 327
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title, kerning 328
title, leading 329
title, repositioning 324
title, resizing 324

Text formatting
setting for rolling and crawling titles 332

Text Justification buttons (Title tool) 327
Text tool (Title tool)

defined 320
Thai language

Title tool 367
Third-party plug-in effects 145

Trim to Fill 488
using control graphs 167

Title effect 489
Title effects

Crawling Title 488
overview of reference information 488
Rolling Title 488
Title 489

Title styles
applying 353
converting to Marquee 352
defined 351
807

Three-tone previews
examples of 654
Luma Ranges tab 654

Threshold point
PlasmaWipe effects 436, 436

Thumbwheel controls (Effect Editor) 73
Thumbwheels command (Effect Editor shortcut menu) 

117
Timecode Burn-In Generator effect 458
Timeline

adjusting effects 57
changing nested effect order 212
color coding for effects 18
color correction information, described 625
deleting effects 30
displaying color correction information 624
dragging titles into 357, 358
effect icon display 23
expanding nested effects 210
real-time playback information bars 123, 124

Timeline Settings dialog box 124
Timeline View Name button (Timeline) 23
Timewarp effect

creating 166
customizing 167

Timewarp effects
0% to 100% 483
100% to 0% 483
Adaptive deinterlacing option 170
converting formats 194
creating 165
described 163
FluidFilm 2:3 Cadence 484
FluidFilm Progressive 484
FluidMotion 186, 187, 192, 193
FluidMotion Edit effect parameters 570
overview of reference information 483
Pulldown Insertion 485
Pulldown Removal 485
reference for Motion Effect Editor 171
rendering 174
Reverse Motion 486
Source Anchor Frame 170
Speed Boost 486
Speed Bump 486

managing in Project window 354
recalling 353
saving 351
using function keys with 351

Title templates
creating and using 350

Title tool
16:9 display option 317
adjusting transparency in 338, 340
Auto Size mode 332
background options 322
blending colors in 338, 340
blending transparency in 338
character mapping 367
Color Picker 340
Crawling Title button 332
creating text 324
described 317
drawing graphics 306, 329
editing text 325
formatting text 325
opening 297
overview 316
pasting text into 324
preparing drawing environment 321, 323
repositioning text 324
resizing text 324
Rolling Title button 332
safe title/action area display 322
selecting fonts in 326
Selection tool, defined 320
setting color in 338, 340
setting point size in 326
setting transparency in 338, 340
Text tool, defined 320
toolbar overview 319
updating video background in 322
video tracks as background 322
working with shadows 308, 309, 342

Title Tool command (Windows menu) 297
Titles

See also Crawling titles
See also Rolling titles
adding pages to 334
adding shadows to 308, 309, 342
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adjusting in Effect Editor 361
adjusting using keyframes 361
aligning 344
applying styles 353
bold text in 327
color of background 322
copying or moving objects to 334
crawling, defined 330
creating a glow or halo effect 343
creating color background for 322
creating media for unrendered 365
creating rolling or crawling 330

typing rolling or crawling text for 332
unrendered 347
viewing Fast saved in bin 347
workflow options for crawling 330

Tonal range
automatic color correction of 629
guidelines for correcting 725

Toolbars
Title tool 319

Top Box Box Wipe effect 454
Top Centered Squeeze effect 482
Top Left Corner Peel effect 475
808

distributing 344
dragging into Timeline 357, 358
editing into a sequence 356
effect clips, described 355
exporting as a graphics file 354
fading 360
fast saving 347
fast-saved, and EDLs 347
formatting rolling or crawling 335
grouping and ungrouping 344
inserting a blank page into a rolling or crawling 334
italic text in 327
kerning of text in 328
layering of 344
locking and unlocking 344
managing fonts for 317
overview of creation 316
page count limits for rolling or crawling 330
previewing 321
promoting to Marquee 362
recalling styles 353
re-creating 364
removing from a sequence 359
rendering 364
replacing fill tracks 364
replacing in a sequence 360
resizing rolling or crawling width of 333
revising in a sequence 362
revising in bin 349
rolling or crawling, adding pages 334
rolling or crawling, deleting pages from 334
rolling or crawling, going to a page in 334
rolling, defined 330
saving 347
saving multiple 347
saving styles 351
saving with keyboard shortcut 347
saving, overview 347
scrolling through rolling or crawling 333
setting marks in rolling or crawling 360
setting text formatting for rolling or crawling 332
soft shadows with 343
splicing into a sequence 356
templates for 350
troubleshooting 365

Top Left L-Conceal effect 472
Top Left Squeeze effect 482
Top Left to Bottom Right Box Wipe effect 454
Top Left to Bottom Right Conceal effect 454
Top Left to Bottom Right Push effect 476
Top Right Corner Peel effect 475
Top Right L-Conceal effect 472
Top Right Squeeze effect 482
Top Right to Bottom Left Box Wipe effect 454
Top Right to Bottom Left Conceal effect 454
Top Right to Bottom Left Push effect 476
Top to Bottom Conceal effect 454
Top to Bottom Push effect 476
Top to Bottom Squeeze effect 482
Tracker Close button (Tracking window) 246
Tracker regions 259
Tracking boxes 255
Tracking button (Tracking window) 246
Tracking data 260, 261, 264, 267

copying and pasting 278
generating 257
preparing to generate 249
reusing 277
smoothing 264

Tracking effect parameters 500, 577
Tracking engines

described 256
Tracking information 63
Tracking window 246, 246

setting up tracking 256
Tracks

video, as background in Title tool 322
Tracks of video

gain levels 550
swapping 3D effects on 579
swapping background and foreground (3D) 288

Trail effect parameters 592
Training services 14
Transition Corner Display button 57
Transition Effect Alignment button 48
Transition Effect Alignment button (Effect Editor) 69
Transition Effect Duration box (Effect Editor) 69
Transition effect parameters 500

Centered on Cut alignment 500
Custom Start alignment 500
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Ending at Cut alignment 500
Starting at Cut alignment 500

Transition effects
Pan and Scan effect 229

Transition effects (3D)
with Page Curl (3D) 289

Transition parameters
using to apply dissolve effects 48

Transitions
creating with the Quick Transition dialog box 53

Transparency
adjusting in titles 338, 340

AVX plug-in effects 148
Upper Left Diagonal Edge Wipe effect 455
Upper Right Diagonal Edge Wipe effect 455
Use Tracking button (Effect Editor) 249
User interfaces for AVX plug-in effects 150

V
Variable Speed effect parameters 566
Variable Speed Motion effect 474
Vector-based objects

creating 396
809

blending in titles 338
setting for titles 338, 340

Transparency of effects
controlling with Foreground effect parameter 496

Triangular opener
keyframe graphs and tracks 82

Triangular opener (Effect Editor) 69
Trim Left 1 Frame button 119
Trim Left 10 Frames button 119
Trim Right 1 Frame button 119
Trim Right 10 Frames button 119
Trim to Fill Timewarp effect 488
Trimming

crawling titles 360
rendering on-the-fly 24
rolling titles 360
segments with tracking data 276

Troubleshooting 14
AVX plug-in effects 151
titles 365

True Type fonts 317
Twist Illusion FX effect 460
Two-field media

safe color warnings with 740
Typing text for rolling and crawling titles 332

U
UnGroup command (Object menu) 344, 408
Unicode text

in SubCap effect 377
Units of measurement

defining for Color Correction tool 614
Unlock command (Object menu) 344, 408
Unrendered titles

creating media for 365
saving 347

Update Correction command (Color Correction shortcut 
menu) 715

Update Position While Playing command (Effect Editor 
shortcut menu) 117

Update rate of Strobe effect 566
Updating

color-corrected sequences 715
Upgrading

described 396
Vectors

See Color vectors
Vectorscope command (Color Correction monitor Source 

menu) 598
Vectorscope display (Color Correction monitors) 700
Vectorscope monitor (Color correction)

displaying 700
Vectorscope monitors (Color Correction)

using to achieve safe color limits 743
Vectorscope monitors (Color correction)

described 700
guidelines for use 706

Velocity effect parameter (Avid Pan & Zoom effect) 532
Vertical Blinds Shape Wipe effect 479
Vertical Edge Wipe effect 455
Vertical Open Edge Wipe effect 455
Vertical Open Sawtooth Sawtooth Wipe effect 478
Vertical Sawtooth Sawtooth Wipe effect 478
Vertical zoom slider for keyframe graphs 84
Video

background, updating in Title tool 322
tracks, as background in Title tool 322
using as fill for titles and graphics 364

Video background
Avid Pan & Zoom effect 533

Video Background button (Title tool) 322
Video Display Settings dialog box 124
Video mixdown 218
Video Quality button and menu (Timeline bottom toolbar) 

126
Video Quality Menu button (Timeline bottom toolbar) 126
Video Underrun error messages 124

W
Warnings

in monitors 740
safe color 740
safe color, in Color Match control 740

Wave Illusion FX effect 460
Waveform commands (Color Correction monitor Source 

menu) 598
Waveform display (Color Correction monitors) 700
Waveform monitors (Color Correction)
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using to achieve safe color limits 743
Waveform monitors (Color correction)

described 700
displaying 700
guidelines for use 706

White point adjustments
guidelines for 725

Wide-screen display
in the Title tool 317, 317

Windows Color dialog box 74, 340
using with Color Match control 634

Wire frame

Effect Preview monitor 78
keyframe graphs 84

Z-Rotation 433
Z-rotation tool for intraframe effects 406
810

Pan and Scan effect 227
Wire frames for effects 78
Workflows

color correction 626
motion tracking 242
options for crawling titles 330
secondary color correction 681

X
X Only button (Effect Editor Position parameter) 268
X Spin Spin effect 481
X Y Z coordinate system 285
Xpress 3D effect category 283
Xpress 3D effects 489

Y
Y Only button (Effect Editor Position parameter) 268
Y Spin Spin effect 481
Y Waveform command (Color Correction monitor Source 

menu) 598
Y Waveform display (Color Correction monitors) 700
YC Waveform command (Color Correction monitor 

Source menu) 598
YC Waveform display (Color Correction monitors) 700
YCbCr Histogram command (Color Correction monitor 

Source menu) 598
YCbCr Histogram display (Color Correction monitors) 

700
YCbCr Parade command (Color Correction monitor 

Source menu) 598
YCbCr Parade display (Color Correction monitors) 700

Z
Z Spin Spin effect 482
Zig-Zag Matrix Wipe effect 473
Zoom Factor for Avid Pan & Zoom effect 531
Zoom to Curve Height button (Effect Editor keyframe 

graphs) 86
Zooming

Avid Pan & Zoom 232
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